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Welcome!
This is the Operation Manual for Propellerhead’s Reason Essentials music production software. The information in 
this manual is also available as html files in the built-in Reason Essentials Help system.

If you haven’t already, don’t forget to check out the Video Tutorials web site, which can be accessed from the Help 
menu in Reason Essentials.

Also, be sure to regularly check out the Propellerhead web site at www.propellerheads.se for the latest news!

About this chapter
The Introduction chapter describes some of the general conventions used throughout the Reason Essentials refer-
ence manual. It also contains instructions on how to utilize the Reason Essentials protection system.

About this manual
In this Operation Manual, all aspects of the Reason Essentials program are described in detail. The first chapters deal 
with general methods and techniques, e.g. how to connect audio sources, mix and record. Then follow descriptions of 
all rack devices in Reason Essentials.

About the Reason Essentials operating system 
versions
Propellerhead Reason Essentials comes in two platform versions: one for Windows (XP SP3, Vista or Windows 7) 
and one for Mac OS X 10.5.8 or later (10.6.3 or later together with Propellerhead Balance). The screenshots in this 
manual were taken from both platform versions of Reason Essentials. Since the program layout is more or less iden-
tical in the two versions, there shouldn’t be any problem following the instructions, regardless of which platform you 
use.

Conventions in the manual
This manual describes both the Windows and Mac OS X versions of Reason Essentials; wherever the versions differ 
this is clearly stated in the text.

Text conventions

The text conventions are pretty straightforward. The examples below describe when certain text styles are used:

D This style instructs the user to perform the task(s) described in the sentence.

! This text style means IMPORTANT INFORMATION. Read carefully to avoid problems!

q This text style is used for tips and additional info.

Key command conventions

In the manual, computer keyboard commands are indicated with brackets. For example:

D Hold down [Shift] and press [C].

However, some modifier keys are different on Windows and Mac computers. Whenever this is the case, the manual 
separates the commands with “(Win)” and “(Mac)” indications as in the following example: 

http://www.propellerheads.se
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D Hold down [Ctrl](Win) or [Cmd](Mac) and press [S] to save your song.

References to context menus

Whenever the manual instructs you to select an item from the “context menu”, it means that you should right-click (or 
[Ctrl]-click if you’re using a Mac with single-button mouse) on the specific area, section or device, and then select the 
item from the pop-up menu that appears - the context menu. The item list in context menus varies depending on 
where in the application you click. See “Context menus” for an overview of the context menus in Reason Essentials.

Frames and circles (call-outs)

In pictures throughout this manual there might be circles and/or rectangles highlighting certain areas or objects. 
These are indicated by filled lines according to the examples in the picture above. Sometimes these highlighting 
frames/circles might also be accompanied by descriptive texts. The different colors of the frames and texts are only 
to enhance the contrast to the background picture.

Dashed arrows

A dashed arrow in a picture indicates the directions in which the pointer (or other tool) should be dragged to perform 
the desired operation. The example in the picture above shows in which directions (up and down) to drag the pointer 
to change the knob’s setting.

Rack

Sequencer
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Authorization
Reason Essentials uses an authorization system designed to be as flexible as possible, while at the same time pro-
viding the best possible copy protection for the product. Here's how it works:

• The core of the authorization system is your license number, which is registered to your user account on the 
Propellerhead web site.

• You then use this license to authorize your Propellerhead hardware - either the Propellerhead Ignition Key 
USB stick or other hardware with the Ignition Key built-in, such as the Propellerhead Balance audio interface.
You can then use your Propellerhead audio interface (or Propellerhead USB stick) to run Reason Essentials in Au-
thorized Mode, anywhere and on any computer.

• If you don't have the Ignition Key hardware at hand, you can still run Reason Essentials in authorized mode, 
provided that you have a working internet connection. 
The program will then contact the Propellerhead web site and verify that Reason Essentials is registered to your 
user account.

• Finally, should you be without both your Ignition Key hardware and internet connection, you can run Reason 
Essentials in Demo mode.
This is also the mode you use if you are trying out the program, but haven't yet purchased it. In this mode, you can 
work as usual and even save your work. You cannot, however, open songs (except for demo songs) in demo mode 
(for details, see “Running Reason Essentials in demo mode”).

Registering and authorizing Reason Essentials
To be able to run Reason Essentials in authorized mode (see “Running Reason Essentials with the Ignition Key hard-
ware” and “Running Reason Essentials with Internet Verification”), the program must be registered to your account 
on the Propellerhead web site.

Here's how you register and authorize your copy of Reason Essentials.

! Note that a working internet connection is required to be able to perform the following steps.

1. Launch Reason Essentials.
When you start Reason Essentials for the first time, this window is displayed:
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2. Click on the Register and Authorize button.
The following dialog appears:

3. Connect your Ignition Key hardware to a free USB2.0 port on your computer. 
If you don't have the Ignition Key hardware at hand, but just want to register Reason Essentials, click "Proceed 
without Ignition Key hardware".

Reason Essentials will start the Authorizer, an application which manages authorizations and the Ignition Key 
hardware. This will guide you throughout the rest of the registration and authorization process:

4. Click the "Launch Browser" button.
The default Internet browser on your computer is launched and will direct you to the Reason Essentials registra-
tion and authorization page at the Propellerhead web site.

5. Enter your user name and password and log in on your Propellerhead account.
If you don't have an account already, click on the "Create account" link and follow the instructions to register a 
new account.

The following step depends on the situation:

6. If you haven't already registered Reason Essentials, you will be asked to do that: enter the license number and 
registration code found in the Reason Essentials box, then click the button below.

• If you have connected your Ignition Key hardware, the button will be called "Register and Authorize".
Your license will be registered and the Ignition Key hardware will be authorized with your license.

If your Reason Essentials license is already registered, it will be shown on the web page. Select it and click the but-
ton called "Authorize". This authorizes your Ignition Key hardware with your license.
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• If you don't have your Ignition Key hardware connected, the button will be called "Register".
Your license will be registered, allowing you to run Reason Essentials in authorized mode with Internet Verification. 
You can later return to authorize your Ignition Key hardware.

• If your Reason Essentials license is already registered, it will be shown on the web page. 
Select it and click the button called "Authorize". This authorizes your Ignition Key hardware with your license.

7. When you're done, go back to Authorizer and click Quit. 
Reason Essentials will restart automatically, and you will now be able to run the program in Authorized Mode.

Running Reason Essentials with the Ignition Key hardware 
If you launch Reason Essentials with an authorized Ignition Key hardware connected, the program will simply start 
without further ado.

q From now on, always connect your Ignition Key hardware before starting your computer and launching Reason 
Essentials. This way Reason Essentials will start up immediately, without the Application Authorization proce-
dure.

When you have an authorized Ignition Key hardware connected to your computer, it’s no longer necessary to have an 
Internet connection when running Reason Essentials.

Running Reason Essentials with Internet Verification
If you launch Reason Essentials without an authorized Ignition Key hardware connected, the following window ap-
pears:

1. Click on the "Run with Internet Verification" button.

! Note that this requires a working internet connection (and that your Reason Essentials license has been regis-
tered to your user account as described in “Registering and authorizing Reason Essentials”).

2. Enter the username and password for your Propellerhead account in the dialog that appears.
Reason Essentials launches in Authorized Mode.

• Should you at any point connect your authorized Ignition Key hardware, internet connection will no longer be 
required.
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• It is not possible to run two instances of Reason Essentials (on different computers) authorized to the same 
user account. Reason Essentials will then enter demo mode (see “Running Reason Essentials in demo 
mode”).
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Running Reason Essentials in demo mode
If you don't have a Reason Essentials license, or if you're without both your Ignition Key hardware and a working in-
ternet connection, you can run Reason Essentials in demo mode:
1. Launch Reason Essentials.

The following window appears:

2. Click on the "Run in Demo mode" button.
Reason Essentials launches in Demo Mode.

The Demo Mode alert lights up to the left on the Transport Panel:

Running Reason Essentials in Demo Mode allows you to perform all operations as in Authorized Mode, with two ex-
ceptions:

• You cannot export audio or bounce mixer channels to disk.

• You cannot open songs.
The only songs that can be opened in Demo Mode are the dedicated demo songs (file extension ".reedemo"). See 
“Opening a Reason Essentials Demo Song”.

If you disconnect your Ignition Key hardware or lose the Internet connection while running Reason Essentials with In-
ternet Verification, the program will automatically enter Demo Mode. You can continue working, and save your songs 
as usual. When you reconnect your Ignition Key hardware or reconnect to the Internet, Reason Essentials will auto-
matically revert to authorized mode and the Demo Mode alert will go out on the Transport Panel.
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Reassigning the Function Keys in Mac OS X
When you work with Reason Essentials, you will do a lot of navigating between the three main areas - the main mixer, 
the rack and the sequencer. The quickest way to switch between these areas is to use the function keys F5, F6 and 
F7 (see “Navigating between the areas” for details). Also, the F3, F4 and F8 keys are shortcuts for showing and hid-
ing the Recording Meter window, On-screen Piano Keys window and the Tool Window, respectively.

However, on many Macintosh models (especially MacBooks), the function keys double as hardware control buttons. 
For example, they might control the volume of the built-in speaker, the display brightness or keyboard backlight. To 
make these keys actually work as function keys for software such as Reason Essentials, you need to hold the "Fn" 
key while pressing them.

This can work perfectly OK, but to get the best workflow in Reason Essentials we recommend that you change this 
behavior, so that pressing e.g. the F5 key actually sends "F5" to Reason Essentials (and you hold down the Fn key to 
get the hardware control functions instead). Here is how you change this:
1. Open the System Preferences in Mac OS X and select the "Keyboard & Mouse" item.

The "Keyboard & Mouse" preferences are shown.

2. Select the "Keyboard" tab and make sure the checkbox "Use all F1, F2, etc. keys as standard function keys" is 
ticked.
Now you can use F3-F8 for controlling functions in Reason Essentials. To use hardware control features such as 
volume and display brightness, you need to hold down the "Fn" key before pressing the function keys.

Some function keys might also be pre-assigned to Mac OS X keyboard shortcuts, which will have priority over soft-
ware such as Reason Essentials. This is easily changed:

3. Click the “Keyboard Shortcuts” tab in the “Keyboard & Mouse” window.
The Keyboards & Mouse Preferences window shows a list of keyboard shortcuts assigned to system functions. 
For example, [Cmd]+[F5] is assigned to turn VoiceOver on or off. In Reason Essentials, this is the keyboard short-
cut for detaching the main mixer into a separate window.
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4. Scroll down to the "Turn VoiceOver on or off" item and either remove the tick from the checkbox or assign it to 
another keyboard shortcut.

5. Scroll down further to the "Spaces" item (keyboard shortcut F8) and either remove the tick from the checkbox 
or assign it to another keyboard shortcut.
In Reason Essentials [F8] is assigned to show/hide the Tool Window.

6. Now, you’re finished with the settings and can close the “Keyboard & Mouse” window.
From now on, the function keys and keyboard shortcuts will perform their intended functions in Reason Essentials.



Chapter 2
Common Operations 
and Concepts
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About this chapter
This chapter gives a basic overview of the Reason Essentials application and describes general methods and tech-
niques employed throughout the Propellerhead Reason Essentials software. It also explains the terminology used 
throughout the program, manuals and help files.

Areas, windows and basic navigation

Song window overview

A Reason Essentials Song window with its Main Mixer, Rack and Sequencer areas

The Reason Essentials graphical user interface is divided into three main areas:

• The Main Mixer
The Main Mixer is located at the top in the Reason Essentials Song window. Here are the channel strips for the au-
dio and instrument tracks in your song.

• The Rack
The Rack is where all sound and effects devices you use in your song are located. The Rack resembles a tradi-
tional hardware rack, where sound modules and effects units can be mounted.

• The Sequencer
The Sequencer is where you record your audio and instrument tracks. Here you can also record automation of de-
vice parameters in the Rack and of channel strip parameters in the Main Mixer. The Sequencer also incorporates 
the Transport Panel, where all sequencer transport controls are located.

The areas can be viewed together, as in the picture above, in pairs or separately - see “Navigating between the ar-
eas”. The areas can also be resized - see “Resizing”. 

Main Mixer

Rack

Sequencer

Transport Panel



COMMON OPERATIONS AND CONCEPTS 29

The Main Mixer

The Main Mixer with the Fader sections currently scrolled into view

In the Main Mixer, all channel strips of the Reason Essentials song are visible. You can scroll vertically in the Main 
Mixer by clicking and dragging inside the frame in the Channel Strip Navigator to the right. This way you will be able 
to access all channel strip parameters. If you have a lot of channels present you can also scroll horizontally by clicking 
and dragging the frame in the Mixer Navigator at the top.

By pressing function key [F5], or by clicking the Maximize Main Mixer Area button at the top right of the Channel 
Strip Navigator, you can maximize the Main Mixer to cover the entire Reason Essentials Song window. 

The Maximize and Detach buttons for the Main Mixer

Below the Maximize Main Mixer Area button is the Detach Main Mixer button. Clicking on this, or holding [Ctrl](Win) 
or [Cmd](Mac) and pressing [F5], will detach the Main Mixer and place it in a separate window. This is especially use-
ful if you are using multiple screens with your computer.

For more details about the Main Mixer, please refer to “The Main Mixer” chapter.
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The Rack

The Rack with two rack columns next to each other, and the Rack Navigator to the right

In the Rack, all instruments, effects and mixer channel devices of the Reason Essentials song are visible. You can 
scroll vertically and horizontally in the Rack by clicking and dragging the frame in the Rack Navigator. You could also 
click anywhere outside the frame in the Rack Navigator to immediately jump to the desired position. Alternatively, 
place the pointer on either of the wooden “side panels” in the rack, and click and drag in any direction. This way you 
will be able to access all devices in the rack.

By pressing function key [F6], or by clicking the Maximize Rack Area button at the top right of the Rack Navigator, 
you can maximize the Rack to cover the entire Reason Essentials Song window.

The Maximize and Detach buttons for the Rack

Below the Maximize Rack Area button is the Detach Rack button. Clicking on this, or holding [Ctrl](Win) or 
[Cmd](Mac) and pressing [F6], will detach the Rack Area and place in a separate window. This is especially useful if 
your are using multiple screens connected to your computer.

When you detach the Rack, the Transport Panel at the bottom of the Sequencer will be duplicated below the Rack in 
the new window. This way, you will be able to control the Sequencer transport functions without needing to change 
window.

For more details on how to work with the Rack, refer to “Working with the Rack”.

Rack
Navigator

Maximize Rack button

Detach Rack button



COMMON OPERATIONS AND CONCEPTS 31

The Sequencer

The Sequencer with a number of recorded audio tracks

To the left in the Sequencer, all tracks in the Reason Essentials song are listed in the Track List. By clicking on a 
track in the Track List you select the track for playback from a connected MIDI master keyboard and/or for recording.

At the top to the left are the Edit Mode button and the Toolbar, with various sequencer editing tools.

The big center section of the Sequencer is called the Edit/Arrangement Pane. Here is where all recorded sequencer 
data is displayed.

You can scroll and zoom in the Sequencer by using the Track Navigator to the right and the Song Navigator at the 
bottom of the Sequencer - see “Scrolling” and “Zooming in the Sequencer”.

By pressing function key [F7], or by clicking the Maximize Sequencer Area button at the top to the right of the Track 
Navigator, you can maximize the Sequencer to cover the entire Reason Essentials Song window. 

The Maximize button for the Sequencer

For more details about the sequencer, refer to “Sequencer Functions”.
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The Transport Panel

At the bottom of the Reason Essentials Song window is the sequencer Transport Panel. From here you control the 
sequencer transport functions, such as Rewind, Fast Forward, Stop, Play and Record. You can also set Tempo and 
Time Signature and various other parameters.

The Transport Panel is always available together with the Sequencer. If you have detached the Rack, a duplicate of 
the Transport Panel will be also present in the Rack window.

To the left on the Transport Panel are indicators for Audio In and Out levels, DSP Load, Disk Overload, Audio Calcu-
lation, Demo Mode and Automation Override status.

By clicking the small grey triangle button to the far upper right you can hide the Transport Panel if you like.

For more details about the Transport Panel, please refer to “Transport Panel details”.

The ReGroove Mixer

To the right of the Toolbar in the Sequencer is a big “G” button. Clicking this will bring up the ReGroove Mixer.

The ReGroove Mixer is used for adding advanced grooves to your instrument tracks in the Sequencer.

To hide the ReGroove Mixer, just click the “G” button again.

For more details about the ReGroove Mixer, please refer to “The ReGroove Mixer”.
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Navigating between the areas
By using the functions keys [F5], [F6] and [F7] you can quickly and easily navigate between the different areas of the 
Reason Essentials window. 

D Press [F5] to toggle between a maximized Main Mixer area and the previous view.

D Press [F6] to toggle between a maximized Rack area and the previous view.

D Press [F7] to toggle between a maximized Sequencer area and the previous view.

! If the Main Mixer and/or the Rack are detached in separate windows, you have to press [F5] to view the Main 
Mixer window, [F6] to view the Rack window and [F7] to view the Sequencer window. It’s not possible to toggle 
between views/windows by repeatedly pressing the same function key.

It’s also possible to press any of the [F5], [F6] and [F7] function keys simultaneously in different combinations to 
switch between combined area views. For example, pressing [F5] and [F6] simultaneously will bring up a combined 
maximized view of the Main Mixer and Rack areas in the Reason Essentials window. The Sequencer area will then 
automatically become minimized

Pressing all three function keys simultaneously, or holding [Ctrl](Win) or [Cmd](Mac) and pressing [F7], will bring up 
all areas together, equally sized. 

! Note that using three function keys simultaneously is not supported on all computer keyboards.

! If the Main Mixer and/or the Rack are detached in separate windows, pressing any of the [F5], [F6] and [F7] 
keys in combination will automatically attach the corresponding (detached) window(s).

To select an area for editing etc., simply click anywhere in the desired area. The selected area will then be surrounded 
by a thin blue rectangle.

Showing/hiding the Navigators
Deselecting “Show Navigators” on the Options menu will hide all navigators in all areas of the Reason Essentials 
song document window(s). These include the Mixer Navigator and Channel Strip Navigator in the Main Mixer, the 
Rack Navigator in the rack as well as the Track Navigator and Song Navigator in the sequencer.

Selecting “Show Navigators” on the Options menu will show all navigators in the Reason Essentials song document 
window(s).

Using several Reason Essentials Song windows
You can have several Songs open at the same time. Each Song will appear in a separate Song window, complete with 
Main Mixer, Rack, Sequencer and Transport Panel. Each Song window can be moved, minimized and resized using 
the standard Windows and Mac procedures.
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The Tool Window
The Tool Window is a floating window which features four tabs that contain short-cuts for creating devices, editing in 
the sequencer, editing grooves for the ReGroove mixer and sample editing functions. The Tool Window can be ac-
cessed from the Window menu.

D Open the Tool Window by selecting “Show Tool Window” from the Window menu. Alternatively, press [F8].
The [F8] key can be used for toggling between showing and hiding the Tool Window.

The Tool Window

• See “Creating devices” for information on how to use the “Device Palette” tab.

• See the “Note and Automation Editing” chapter for information on how to use the various functions of the “Se-
quencer Tools” tab.

• See “The ReGroove Mixer” chapter for information on how to use the functions of the “Groove Settings” tab.

• See the “Sampling” chapter for information on how to use the functions of the “Song Samples” tab.
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The On-screen Piano Keys window
The On-screen Piano Keys floating window features a virtual keyboard which lets you play instrument devices with-
out needing to have a MIDI master keyboard connected to your computer. The On-screen Piano Keys window can be 
accessed from the Window menu.

D Open the On-screen Piano Keys window by selecting “Show On-screen Piano Keys” from the Window menu. 
Alternatively, press [F4].
The [F4] key can be used for toggling between showing and hiding the On-screen Piano Keys window.

The On-screen Piano Keys window in “Mouse” mode

See “On-screen Piano Keys” for more information.
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General window techniques

Resizing

Adjustable dividers in the Reason Essentials Song window

Between each area in the Reason Essentials Song window are dividers that separate the areas from each other. 
Some of the dividers can be adjusted, making it possible to resize the areas. The horizontal dividers between the Main 
Mixer and Rack, and between the Rack and Sequencer can be adjusted, as well as the vertical divider to the left of 
the Rack Navigator in the Rack. Adjustable dividers have four (Windows) or one (Mac) small “dents” in the center.

When you place the mouse pointer on this type of divider, the pointer will change to a double-arrow symbol. Clicking 
and dragging these types of dividers makes it possible to resize the adjacent areas.
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Scrolling
Reason Essentials offers a few different options for scrolling in the different areas.

Scrolling with the Navigators

Navigators in the Reason Essentials Song window

Whenever there is information “outside” the visible screen area, you may want to scroll to the desired destination. The 
Reason Essentials Song window features a number of Navigators that can be used for scrolling. Navigators are pres-
ent by default in the Main Mixer, in the Rack and in the Sequencer.

The Main Mixer and the Sequencer have both horizontal and vertical Navigators. 

The Rack has only one Navigator which can be used for scrolling both vertically and horizontally (when using more 
than two rack columns next to each other). The Rack Navigator can also be resized by moving the vertical divider to 
the left of the Rack Navigator. Resizing the Rack Navigator will also resize the rack devices inside the Navigator, 
making them easier to distinguish.

D To scroll with a Navigator, click anywhere inside the frame in the Navigator and drag the frame to the desired 
position.
As the pointer enters the frame, it automatically switches to a hand symbol.

D Alternatively, click anywhere in the Navigator area to immediately jump to the desired position.

• At high zoom values in the Sequencer, you can hold [Shift] and drag the Song Navigator frame to scroll with 
greater precision.



COMMON OPERATIONS AND CONCEPTS38

Scrolling with the Hand tool

Scrolling with the Hand tool in the Rack

In the Rack and Sequencer, you can also use the Hand tool for scrolling the view.
1. In the Rack, place the pointer on either of the wooden side panels of a rack column.

The pointer will switch to a hand symbol.

2. Click and drag the rack vertically and/or horizontally to scroll in the rack, as shown in the picture above.
If you are using only a single rack column, it’s only possible to scroll vertically.

In the Sequencer you have to manually switch to the Hand Tool by selecting it from the sequencer Toolbar. With the 
Hand Tool selected, you can scroll in any direction on the Edit/Arrangement Pane. Refer to “Hand Tool” for more in-
formation.

Zooming in the Sequencer
In the Sequencer it’s possible to zoom in and out using the Track Navigator and Song Navigator. You can also use the 
Magnifying Glass Tool on the Sequencer Toolbar - see “Magnifying Glass Tool”. In addition to this, it’s also possible to 
set a zoom level for the audio recordings inside the Audio Clips.

q See also “Scrolling and zooming using a wheel mouse”.

Zooming vertically in the Sequencer

D To zoom in vertically in the Sequencer arrangement, and thus increase the Track height, click on the “+” mag-
nification button below the Track Navigator:

Increase the Track height by clicking the + magnification button below the Track Navigator

D To zoom out vertically, click on the “-” magnification button.

• When the Sequencer is in Edit Mode, individual vertical zoom controls become available.
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Waveform Zoom Mode

D Choose between three zoom modes for the audio recording(s) inside all Audio Clips.
Using the Small Waveform Zoom Mode is especially useful if you have recorded with the Clip Safe function (see 
“Recording using the Clip Safe function in Propellerhead Balance”) where the dynamic range can be quite wide. 

! The zoom modes only affect the visual presentation of the waveform, not the audio levels.

Zooming horizontally in the Sequencer

You can also zoom in and out horizontally in the Sequencer by using the Song Navigator.

D To zoom in horizontally, click on the “+” button to the left in the Song Navigator.

D To zoom out horizontally, click on the “-” button to the left in the Song Navigator.

D To zoom in and out horizontally, click and drag a Song Navigator handle sideways.
The pointer changes to a double arrow symbol and you can now zoom in by resizing the Song Navigator Frame.

D [Shift]-click on a Song Navigator handle and drag horizontally to zoom in and out symmetrically.

D By right-clicking (Win) or [Ctrl]-clicking (Mac) inside the Song Navigator frame you can both scroll (drag side-
ways) and zoom (drag up or down) simultaneously.

Scrolling and zooming using a wheel mouse
If you’re using a mouse equipped with a scroll wheel, this can be used for the following scrolling and zooming opera-
tions:

Scrolling in the Main Mixer with a wheel mouse

D Spin the scroll wheel to scroll vertically in the Main Mixer.

D Press [Shift] and spin the scroll wheel to scroll horizontally in the Main Mixer.

Scrolling in the Rack with a wheel mouse

D Spin the scroll wheel to scroll vertically in the Rack.

D Press [Shift] and spin the scroll wheel to scroll horizontally in the Rack.
Note that the Rack must have at least two rack columns next to each other for this to work.

Scrolling in the Sequencer with a wheel mouse

D Spin the scroll wheel to scroll vertically on the Edit/Arrangement Pane.

D Press [Shift] and spin the scroll wheel to scroll horizontally on the Edit/Arrangement Pane.

! Note that scrolling horizontally cannot be done when the Song Navigator frame is fully expanded.

Zooming in the Sequencer with a wheel mouse

D Press [Ctrl](Win) or [Cmd](Mac) and spin the scroll wheel to zoom in and out vertically on the Edit/Arrange-
ment Pane.

D Press [Ctrl]+[Shift](Win) or [Cmd]+[Shift](Mac) and spin the scroll wheel to zoom in and out horizontally on 
the Edit/Arrangement Pane.
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Editing parameters
Since a large part of Reason Essentials is laid out like “real” hardware devices, such as the Main Mixer, instrument 
and effect devices etc., almost all controls are designed like their real world counterparts - mixer faders, effect unit 
knobs, transport buttons, etc. How to adjust these controls is described in the following paragraphs.

Knobs
D To “turn” a knob, point at it, hold down the mouse button and drag up or down (as if the knob was a vertical 

slider).
Dragging upwards turns the knob clockwise and vice versa.

D If you press [Shift] and drag, the knob will turn slower, allowing for higher precision.
You can also adjust the knob precision with the “Mouse Knob Range” setting on the General page in Preferences. 
This dialog is opened from the Edit menu (or from the Reason Essentials menu if you are running Mac OS X).

D To reset a knob to its default value (usually zero, center pan or similar), press [Ctrl](Win) or [Cmd](Mac) and 
click on the knob.

Faders and sliders
D To move a fader or slider, click on the handle and drag in the fader/slider direction.

D You can also click anywhere on the fader/slider to instantly move the handle to that position.

D If you press [Shift] and drag, the fader/slider will move more slowly, allowing for higher precision.

D To reset a fader/slider to its default value (usually zero, 100, center pan or similar), press [Ctrl](Win) or 
[Cmd](Mac) and click on the fader/slider handle.
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Buttons

Many functions and modes are controlled by clicking buttons. Many of the buttons in Reason Essentials have a “built-
in” LED, or the button itself lights up, indicating whether the button is on or not.

Fold/Unfold buttons
Fold/Unfold buttons are distinguished by a small triangle at the top to the left on a device. Clicking on a Fold/Unfold 
button will unfold the device panel so that more controls are visible and can be accessed for editing on the screen.

On some devices, such as the RV7000 Advanced Reverb, there are more than one Fold/Unfold button. Clicking on 
the second Fold/Unfold button on the unfolded front panel will open up the Remote Programmer panel from which 
more parameters can be accessed:

The Fold/Unfold buttons on an RV7000 Advanced Reverb device

Click on the Fold/
Unfold Button to 
unfold the front panel.

Click on the second Fold/
Unfold Button on the 
unfolded panel to bring up 
the Remote Programmer.
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Multi Mode selectors
Some parameters allow you to select one of several modes. There are two different graphical representations of this 
in Reason Essentials.

The multi mode selector type below consists of a button with the different modes listed above it:

D Click the button to step through the modes or click directly on one of the modes printed on the panel, or click 
on the corresponding LED, to select mode. 
The currently selected mode is indicated by a lit LED.

The multi mode selector type below is a switch with more than two positions:

D To change mode, click and drag the switch, or click directly at the desired switch position (just as when adjust-
ing a slider).

Numerical controls
In Reason Essentials, numerical values are often displayed in numerical displays with “spin controls” (up/down arrow 
buttons) on the side. Some parameter values, such as oscillator and LFO waveforms, are displayed graphically in the 
displays. There are two ways of changing values in these types of controls:

D By using the up and down buttons on the spin controls.
To adjust a value in single steps, click on its up or down arrow button. To scroll a value continuously, click on an ar-
row button and keep the mouse button depressed.

D By clicking and holding the mouse button depressed in the actual display and then dragging the mouse up or 
down.
This allows you to make coarse adjustments very quickly.

or
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Alpha-numeric controls
In Reason Essentials, alpha-numeric values and/or device presets are displayed in alpha-numeric readouts with “spin 
controls” (up/down arrow buttons) on the side. There are two ways to change alpha-numeric/preset values:

D By using the up and down buttons on the spin controls.
To adjust a value or select a preset in single steps, click on the up or down arrow button. To scroll a value contin-
uously, click on an arrow button and keep the mouse button depressed.

D By clicking and holding the mouse button depressed in the actual alpha-numeric display and selecting from 
the list that appears.
This allows you to make coarse adjustments very quickly or to immediately change to a preset anywhere in the list.

q This type of control is used to select, e.g., patch and reverb algorithms and some oscillator waveforms.

or
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Numerical segment displays
In the numerical segment displays on the sequencer Transport Panel and in the sequencer Inspector, values can be 
edited in a number of different ways. The editing principle is exactly the same for the Transport Panel and Inspector 
displays, which is shown in the two examples below.

Transport Panel segment displays

The segment displays of the Transport Panel can be edited as shown in the following Tempo display examples. The 
Tempo display segments show (from left to right) BPM and 1/1000 BPM:

The other segment displays on the Transport Panel can be edited in the same way as described above.

Click the up/down arrow buttons to change tempo in steps of 1 BPM 
(the leftmost segment).

Click on the left display segment to select the “whole BPM” value. 
Then, either click and drag up or down or click on the up/down arrow 
buttons to change tempo in steps of 1 BPM.

Alternatively, type in the new tempo and press [Enter] on the computer 
keyboard.

You can also type in a number preceded by [+] or [-] to add or subtract 
the number from the current tempo value. Then, press [Enter] on the 
computer keyboard.

Click on the right display segment to select the “1/1000 BPM” value. 
Then, either click and drag up or down or click on the up/down arrow 
buttons to change tempo in steps of 1/1000 BPM.

Alternatively, type in the new tempo and press [Enter] on the computer 
keyboard.

You can also type in a number preceded by [+] or [-] to add or subtract 
the number from the current tempo value. Then, press [Enter] on the 
computer keyboard.

Double-click on the display, type in the new tempo and press [Enter] on 
the computer keyboard.
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Inspector segment displays

The segment displays in the Inspector can be edited as shown in the following Position display examples. The Posi-
tion display segments show (from left to right) Bars, Beats, 1/16th Note and Ticks:

The other segment displays in the sequencer Inspector can be edited in the same way as described above.

Tool Tips
If you hover with the mouse over a control on a device panel and wait a moment, a tool tip appears. The tool tip shows 
the name of the parameter associated with that control and its current value. This helps you fine-tune settings, set 
several parameters to the same value, etc.

D You can turn off the Tool Tips function by deactivating the option “Show Parameter Value Tool Tip” in the “Ap-
pearance” section on the General tab in Preferences.

Click the up/down buttons to change the value in 
steps of 1 Bar (the leftmost segment).

Click in the display to select either the Bar, Beat, 
1/16th note or Ticks segment. Then, click the up/
down buttons to change the value of the selected 
segment in steps of 1 unit.

Click in the display to select either Bar, Beat, 
1/16th note or Ticks. Then, click and drag the 
cursor up/down to change in steps of 1 unit.

Double-click in the display. Then, type in the 
desired value and press [Enter].

Click in the display to select either Bar, Beat, 
1/16th note or Ticks. Then, type in a number and 
press [Enter].

Alternatively, select a segment, type in a number 
preceded by a [+] to add or a [-] to subtract the 
number from the current value. Then, press [Enter].
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Context menus
Context menus are “tailored” to contain only menu items that are relevant to the current circumstances. Using the 
various context menus allows you to work more quickly and more efficiently with Reason Essentials.

D To bring up a context menu, right-click (Win) or [Ctrl]-click (Mac) on the desired object, section or area in Rea-
son Essentials.

The Mixer 14:2 device panel context menu

q If you are using a Mac with a two button mouse, you may want to set this up so that clicking the right mouse 
button generates a [Ctrl]-click. This way, you can right-click to bring up context menus.

The contents of the context menus depend on where you click. These are the primary types of context menus you will 
encounter in Reason Essentials:

Parameter context menus
If you click on an automatable control (a mixer parameter, a device parameter, a fader, etc.), the context menu will 
contain the following items:

• Functions for editing and clearing the recorded automation data for the control.

• Functions for associating computer keyboard commands and/or MIDI messages to the parameter.
This allows you to remote control parameters from a MIDI device or from the computer keyboard.
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Device context menus
If you click anywhere on a device in the Rack (but not on a parameter or display), the context menu will contain the 
following items:

The Mixer 14:2 device panel context menu

• Cut, Copy, Paste, Delete and Duplicate Device and Track items, allowing you to rearrange and manage the de-
vices in the rack.

• Commands for managing Device Groups.

• A duplicate of the Create menu, allowing you to create new devices.

• A “Go To” submenu, listing all devices connected to the current device. 
Selecting a device from the Go To submenu scrolls the rack to bring that device into view.

• Auto-routing and Disconnect functions.
This allows you to automatically route (connect) or disconnect a selected device in a logical way.

• Combine and Uncombine are used when you want to use the selected device in, or exclude it from, a Combina-
tor setup.

• A Browse Instruments item which lets you browse for sounds for a selected Instrument device.
This item is available only for Instrument devices.

• Additional device-specific items.
If the device is pattern-based, there will be various pattern functions (Cut/Copy/Paste, Clear, Shift, Randomize, 
etc.). These affect the currently selected pattern in the device.

If the device uses patches, there will be functions for managing patches.

Depending on the device there may also be various device-specific functions available. For example, the drum ma-
chine device has functions for manipulating the pattern for the selected drum sound only, etc.

• “Create Track for ...” and “Delete Track for ...” are used if you want to create a Sequencer Track for the selected 
device, or delete the Sequencer Track used for the device without deleting the actual device.

• The “Go To Track for ...” will scroll the corresponding Sequencer Track into view in the Sequencer.

• The “Lock Control Surface to this Device” lets you lock a connected control surface to the selected device.

• The “Track Color” item lets you select color for the associated Sequencer Track (and Main Mixer channel strip, 
if the selected devise is an Audio Track device).
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Main Mixer channel strip context menu
If you click anywhere on a channel strip in the Main Mixer (but not on a parameter or display), the context menu will 
contain the following items:

• Cut, Copy, Paste, Delete and Duplicate Channels and Track items, allowing you to rearrange and manage the 
channel strips in the Main Mixer.

• Commands for managing Device Groups.

• A duplicate of the Create menu, allowing you to create new devices.

• The “Create Send FX” lets you browse for an effects device, or Effect Combi patch, to connect and use as a 
send effect.
The send effect will be automatically connected to the first available Send FX connectors of the Master Section 
device in the Rack.

• The “Copy Channel Settings” item lets you copy groups of settings for the selected channel strip.
The groups that can be selected are: “Filters and EQ”, “Insert FX”, “FX Sends” and “All”.

• The “Paste Channel Settings” item appears if you have previously copied any channel settings and want to 
paste these to the selected channel strip.

• The “Browse Insert FX Patches” lets you browse for, and load, Effect Combi patches to the Insert FX section.

• The “Clear Insert FX” lets you remove any devices currently in the Insert FX area.

• The “Reset Channel Settings” resets all channel strip parameters to their default values.
It also automatically removes any used Insert FX devices from the channel strip.

• The “Set Remote Base Channel” item lets you set the remote base channel to the selected channel strip.
This is useful when you remote control channel strips from a control surface via MIDI.

• The “Lock Control Surface to this Device” lets you lock a connected control surface to the selected channel 
strip.

• The “Track Color” item lets you select color for the associated Sequencer Track (and Main Mixer channel strip, 
if the selected devise is an Audio Track device).

The Channel Strip context menu.
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Rack “background” context menu
If you click in an empty area of the rack, the context menu will contain the following items:

• A Paste Devices and Tracks item, allowing you to paste any copied or cut devices and tracks.

• A duplicate of the Create menu, allowing you to create new devices.

Main Mixer “background” context menu
If you click in an empty area of the Main Mixer, the context menu will contain the following items:

• A duplicate of the Create menu, allowing you to create new devices.

• The “Create Send FX” lets you browse for an effects device, or Effect Combi patch, to connect and use as a 
send effect.
The send effect will be automatically connected to the first available Send FX connectors of the Master Section 
device in the Rack.

Sequencer context menus
If you click in the Sequencer, the context menus will contain items related to editing tracks, clips and events. The 
available items will differ depending on in which section or lane you click (Track List, note lane, etc.), and depending 
on whether you click on a note or automation event or not. 

For example, the sequencer context menus contain functions for inserting or removing bars, deleting tracks, chang-
ing or deleting note and automation events.
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Undo and Redo
Virtually all actions in Reason Essentials can be undone. This includes creation, deletion and reordering of devices in 
the rack, parameter value adjustments, recording and editing in the sequencer etc. You can undo up to 30 actions.

D To undo the latest action, select “Undo” from the Edit menu, or hold down [Ctrl](Win) or [Cmd](Mac) and press 
[Z].

The action to be undone is indicated next to the Undo command on the Edit menu. For example, if your latest ac-
tion was to delete some device(s) from the rack, the Edit menu will display “Undo Delete Devices and Tracks”.

D To redo the last undone action (“undo the undo operation”), select “Redo” from the Edit menu, or hold down 
[Ctrl](Win) or [Cmd](Mac) and press [Y].
Similarly, the action to be redone is shown on the Edit menu.

About multiple Undos and Redos

The concept of multiple undos may require an explanation: You can undo up to 30 actions, or in other words, Reason 
Essentials has an Undo History with up to thirty steps.

Let’s say you have performed the following actions:
1. Created a Mixer device.

2. Created a synth device.

3. Adjusted the Attack parameter of the synth device.

4. Changed the panning for the synth device in the Mixer.

5. Adjusted the playback tempo on the Transport Panel.

After these five actions, the Undo History will look as follows:

If you now select Undo, your latest action (the tempo change) will be undone, and moved to a “Redo list”:

Selecting Undo again undoes the next action in the list (the panning adjustment):

| UNDO

5. Adjust tempo

4. Change pan

3. Adjust Attack

2. Create Synth Device

1. Create Mixer Device

| UNDO | REDO

4. Change pan

3. Adjust Attack

2. Create Synth Device

1. Create Mixer Device 5. Adjust tempo

| UNDO | REDO

3. Adjust Attack

2. Create Synth Device 4. Change pan

1. Create Mixer Device 5. Adjust tempo
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If you now select Redo, the most recently undone action will be redone. In this case, your panning adjustment will be 
performed again (and added to the Undo History again):

At this point, you still have the option to Redo the tempo change. But if you instead perform another action (e.g. 
change the level of the synth device in the mixer), this would become the action at the top of the Undo History - and 
the Redo list would be cleared.

You can no longer redo the “undone” tempo change!

| UNDO | REDO

4. Change pan

3. Adjust Attack

2. Create Synth Device

1. Create Mixer Device 5. Adjust tempo

| UNDO | REDO

5. Change level

4. Change pan

3. Adjust Attack

2. Create Synth Device

1. Create Mixer Device (Empty)
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Chapter 3
On-screen Piano Keys
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About this chapter
This chapter describes the functions of the On-screen Piano Keys window. 

The On-screen Piano Keys window enables you to play instrument devices using either your mouse or computer key-
board. This provides a simple and convenient way to input notes or chords when using the program without an at-
tached MIDI master keyboard.

Using the On-screen Piano Keys

Opening the Piano Keys window
D To open the window, select “Show On-screen Piano Keys” from the Windows menu, or press [F4].

Like the Tool window, the On-Screen Piano Key window “floats” on top of other windows, remaining visible most 
of the time.

• You can choose between two basic operational modes to enter notes; “Mouse” or “Computer Keys”.
Mouse Mode is for entering notes with the mouse, and Computer Keys Mode for using the computer keyboard to 
enter notes. The two modes are described separately below.

The respective buttons in the middle of the window are used to switch modes. 

Mode buttons.

• Regardless of mode, the On-screen Piano Keys window always follows Master Keyboard input.
This means that the Piano Keys will trigger the device associated with the track that has Master Keyboard Input. 
The Piano Keys input is merged with any attached keyboard/control surface input so you can use both simultane-
ously.

• The available note range is 10 octaves (C -2 to E 8).

• When the On-screen Piano Keys window is in Mouse mode, you can resize it by clicking and dragging the win-
dow frame according to standard procedures.
This is especially useful in “Mouse” mode, since you can adapt the window to show the desired note range.
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The Keyboard Navigator

This is present in both modes and shows the total key range. The green area indicates the key range available in the 
On-screen Piano Keys window. 

Keys that produce sound are indicated by a gray strip above the keyboard in the Keyboard Navigator. This is useful 
when playing a patch where only certain keys or key ranges produce sound, e.g. a REX file or a sampler patch. 

Setting Octave range

There are several ways to set the Octave range:

D Click the arrow buttons on either side of the Keyboard Navigator.
Each click will shift one octave up or down.

D Click and drag the green key range area in the Keyboard Navigator.

The current octave number is always shown for the leftmost key - by default the [A] key on the computer keyboard.

Mouse mode

When Mouse Mode is selected, the Piano Keys window will show a standard piano keyboard. 

D To enter notes, simply click on the keyboard with your mouse.
As described above, the record enabled track governs what instrument device is played. 

Keyboard Navigator

Available notes for the
currently selected instrument
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D The keys are velocity sensitive. The higher up on the key you click, the lower the velocity and vice versa. 
The velocity range is between 40 and 127.

Low and high note velocities.

D The keyboard octave range can be set using the arrow buttons at each side of the navigator keyboard.
Each C key is labeled with the octave number. You can also simply drag the green key range area to where you 
want. It will snap to octave ranges. 

D In Mouse Mode, the keyboard can be resized both vertically and horizontally.
Resizing horizontally extends or diminishes the key range. By resizing the window vertically you change the key 
size for the keyboard, as well as the key range.

Adding sustain

If you press [Shift] when entering notes, the notes will sustain, just like when using a sustain pedal.

Repeat and Hold functions

D The Repeat function will continuously repeat the last clicked note as quarter notes with a quarter note pause 
in between (at the current tempo).
This feature can be useful when tweaking synth parameters or browsing for patches. It is activated/deactivated by 
checking/unchecking the box.

D The Hold function will keep any keys you click on pressed down for as long as Hold is active. 
Hold is activated/deactivated by checking/unchecking the box.

Computer Keys mode

When Computer Keys Mode is selected, the On-screen Piano Keys window shows a graphic (partial) representation 
of a computer keyboard. The window cannot be resized in this mode.

Velocity=40

Velocity=127
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D In Computer Keys Mode you can play notes and chords using your computer keyboard.
The Computer Keys keyboard range is fixed to 18 notes (from C to F), although the octave range will give you ac-
cess to any notes within the ten octaves shown in the navigator. You can also click on the keys with your mouse 
to trigger notes. The numerical keys in the top row are not used to enter notes but to set velocity, see “Velocity”.

D The default layout of the Computer Keys logically reflects the layout of a piano keyboard’s black and white 
keys.
The first (leftmost) key represents C and so on up to F an octave above. By default, the [A]-key will play the first C, 
the [W]-key a C# and so on, according to piano keyboard standards. If you wish, you can customize the note to key 
assignment in the Preferences - Keyboard tab (see “Preferences - Keyboard”).

Octave range

D Press [Z] or [X] on your computer keyboard to shift one octave down or up, respectively.
There are also “Z” and “X” Octave buttons in the On-screen Piano Keys window that function in the same way.

See “Setting Octave range” for more ways of changing the Octave range.

Repeat and Hold functions

See “Repeat and Hold functions”.

Adding sustain

D Press [Shift] when entering notes to make the notes sustain, just like when using a sustain pedal.
There is also a Sustain button in the On-screen Piano Keys window that has the same functionality.

Velocity

In Computer Keys Mode, note velocity for notes you enter is set using the numerical keys in the top row. The currently 
set value is also shown in the Velocity value field. The numerical keys correspond to the following velocity values:

| Numerical key | Velocity value

1 1

2 14

3 28

4 42

5 56

6 70

7 84

8 98 (default)

9 112

0 127
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Velocity Variation

This feature will randomly vary the velocity values for the notes you enter. There are four modes; None (default), 
Light, Medium and Heavy. The degree of velocity variation is as follows.

| Item | Variation

None (default) 0

Light +/- 5%

Medium +/- 10%

Heavy +/- 25%



Chapter 4
Audio Basics
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About this chapter
This chapter contains some useful information about how audio is handled by Reason Essentials and how the audio 
is routed. Some of it may seem a bit technical, but we recommend that you read it to get the most out of Reason Es-
sentials.

How Reason Essentials communicates with your 
audio hardware 
Reason Essentials receives, generates and plays back digital audio - a stream of numerical values in the form of ones 
and zeroes. For you to be able to record and play back anything, the audio must be converted from analog to digital 
when recording, and from digital to analog when playing back through some kind of listening equipment (a set of 
speakers, headphones, etc.). 

This conversion is most often handled by the audio card installed in your computer, or by an external audio interface 
connected via USB or FireWire. To achieve the best possible performance, Reason Essentials requires that the audio 
card uses an ASIO driver on Windows systems. On Mac OS X systems, Reason Essentials supports Core Audio driv-
ers.

When you use the Propellerhead audio interface, its audio drivers were automatically installed during the installation 
of Reason Essentials from the Reason Essentials DVD. You don’t need to install any additional audio drivers.

To receive and deliver digital audio to the computer’s audio hardware, Reason Essentials uses the driver you have se-
lected in the Preferences dialog. In the Rack on screen, this connection is represented by the Hardware Interface 
(also known as the Hardware Device):

The Hardware Interface is always located at the top of the rack

! If you are using Reason Essentials as a ReWire slave, Reason Essentials will instead feed the digital audio to 
the ReWire master application (typically another audio sequencer program), which in turn handles the commu-
nication with the audio hardware. See “ReWire” for more details.

The Hardware Interface contains 64 input and 64 output “sockets”, each with an indicator and a level meter. There 
are also two Sampling Inputs that can be used for sampling audio to sampler devices. 16 input and 16 output sockets 
are shown on the main panel, and an additional 48+48 sockets are shown if the “More Audio” button is activated on 
the main panel. Each one of these indicators represents a connection to an input or output on your hardware audio 
interface (or a ReWire channel to another application if you are using ReWire).

However, the number of available inputs and outputs depends on the number of inputs and outputs on your hardware 
audio interface. For example, if you are using the Propellerhead Balance audio interface with 2 input and 2 output 
channels, only the first two inputs and outputs will be available. In the Hardware Interface, the indicators are lit green 
for all currently active and connected inputs and outputs. Activation of inputs and outputs on your hardware audio in-
terface is done on the Audio page in the Preferences dialog (see “Active Input and Output Channels”).

Inputs and outputs that are currently connected have green indicators. Available but un-connected inputs and out-
puts have yellow indicators and any connections made to unavailable inputs and outputs have red indicators.

In this case, Inputs 1 and 2 are available, but not connected in the Rack, Outputs 1 and 2 are available 
and connected, whereas Output 3 is unavailable, but connected on the back of the Hardware Interface.
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! You never have to connect any cables to the Audio In jacks of the Hardware Interface to be able to record au-
dio on sequencer tracks. This routing is made internally “in the background”, which means you just have to se-
lect audio interface inputs from the Audio Input drop-down list - see “Selecting audio input(s) and defining 
mono or stereo”.

Manual audio routing
In most cases, you will want to have the Main Mixer Master Section device connected to outputs 1 and 2 of the Hard-
ware Interface. This connection is made automatically as soon as you create a new Song document. However, there 
might be situations where you want to manually route audio to other outputs of the Hardware Interface.

To send the sound of a device in the Rack to a specific output, you route the device output to the corresponding Out-
put jack on the Hardware Interface. This is done by using the patch cables on the back of the rack, as described in 
“Manual routing”. If we flip the rack around, by pressing the [Tab] key, the Hardware Interface looks like this:

On the rear of the Hardware Interface, Inputs 1 and 2 are available but not connected, 
Outputs 1 and 2 are available and connected, whereas Output 3 is connected but unavailable.

! You never have to connect any cables to the Audio In jacks of the Hardware Interface to be able to record au-
dio on sequencer tracks. This routing is made internally “in the background”, which means you just have to se-
lect audio interface inputs from the Audio Input drop-down list in the sequencer Track List - see “Selecting 
audio input(s) and defining mono or stereo”.

Audio quality
The audio quality in a computer based recording system depends on two things:

• The quality of the software calculating the audio.
In our case, this is the Reason Essentials DSP (Digital Signal Processing) code.

• The quality of the hardware audio interface used for recording and playing back the sound.

Software

• Reason Essentials uses 32-bit floating point arithmetic for all internal audio operations, with 64-bit summing 
in the mix bus in the Main Mixer Master Section. 
This ensures the highest possible audio quality throughout the entire signal chain.

• Reason Essentials supports 16, 20, and 24 bit resolution for input and output audio.

• Reason Essentials supports all standard sample rates between 44.1 kHz and 192 kHz - as long as the audio in-
terface supports these sample rates.
Reason Essentials also supports lower sampling frequencies, but using a sample rate of less than 44.1 kHz is not 
recommended since it might affect the audio quality negatively.

• A number of digital audio techniques that reduce the risk of “aliasing”, background noise, unwanted distortion 
and “zipper noise” are implemented in Reason Essentials.
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Audio hardware

How good a hardware audio interface actually sounds depends on a number of things; its frequency range and fre-
quency response curve, the resolution (bit depth), the signal to noise ratio, the distortion under various circumstances, 
etc. Furthermore, some designs are more prone to disturbance from the other electronics in the computer than oth-
ers. Such disturbance might add hum or high pitched noise to the signal.

The only advice we can give is that if you are serious about sound, choose your audio hardware carefully, for example 
the Propellerhead Balance audio interface!

Audio settings
Sample rate and resolution are properties of digital audio which determine the quality of the sound. Generally, higher 
sample rate and resolution result in better audio quality (but also larger audio files and higher demands on computer 
performance and audio hardware). The table below shows some common sample rate/resolution combinations:

To cater for all different situations, Reason Essentials supports multiple sample rates and resolutions.

Sample Rate settings for recording and playback

Reason Essentials handles all internal audio processing in 32-bit floating point resolution, with 64-bit summing in the 
mix bus in the Main Mixer Master Section. However, the resolution of the input and output audio is determined by the 
hardware audio interface. That is, if you have a 24-bit audio card, such as the Propellerhead Balance audio interface, 
Reason Essentials will record and output audio in 24-bit resolution, and if you have a 20-bit audio card, audio will be 
recorded and played back in 20-bit resolution.

The recording and playback sample rate can be specified on the Audio tab in the Preferences dialog (accessed from 
the Edit menu (Win) or Reason Essentials menu (Mac)):

D Select the desired sample rate from the drop-down menu.
Note that the available options on this pop-up menu depend on which sample rates are supported by the audio 
hardware.

| Sample rate: | Resolution: | Comment:

44.1 kHz 16 bit This is the format used on standard audio CDs.

44.1 kHz –
192 kHz

24 bit These are formats used in professional studios and high-end recording 
equipment.
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! Reason Essentials supports multiple sample rates in the same song!

Reason Essentials allows import (or recording) of audio at any standard sample rate. If the original sample rate of 
a recording is different than the rate currently set for the audio card, Reason Essentials will automatically do a 
high-quality sample rate conversion.

First, a real-time sample rate conversion algorithm is used (allowing the audio to be played back immediately). 
Meanwhile, in the background, the program calculates a sample rate conversion of the highest quality, which will 
be used as soon as it is calculated. The CALC progress indicator on the transport panel lights up whenever the 
program is performing high quality calculations in the background:

The CALC progress indicator on the Transport Panel appears when Reason Essentials performs high quality audio calculation

Buffer Size settings

The Buffer Size can be adjusted on the Audio tab in the Preferences dialog (accessed from the Edit menu (Win) or 
Reason Essentials menu (Mac)):

D Select Buffer Size by clicking and dragging the slider sideways.

The trick here is to find the optimum relationship between audio quality, DSP Load and latency. Experiment with dif-
ferent Sample Rate settings in combination with different Buffer Size settings to get the best result.

A professional audio interface used together with a state-of-the-art computer should normally be able to handle a 
combination of a high sampling frequency (96 kHz) and a small Buffer Size (64-128 samples) without problems. A 
budget priced audio interface normally requires a lower sampling frequency (44.1 kHz) in combination with a little 
higher Buffer Size (256-512 samples).

The Propellerhead Balance interface can typically work with a small buffer size of 64 samples on a good computer.

See “About latency” for more information about buffer size and latency.

CPU Usage Limit settings

In the “Miscellaneous” section on the “General” page in Preferences, you can define an upper limit for the CPU us-
age. If the DSP Load should exceed this set limit, the Reason Essentials application will stop receiving and outputting 
sound. If this happens, you might have to change the audio settings (see “Sample Rate settings for recording and 
playback” and “Buffer Size settings”) - or remove tracks and/or devices from your song. By default, the “CPU Usage 
Limit” is set to 80%. This is where the CPU load usually starts to make the sound crackle and distort.
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About MultiCore Audio Rendering

Reason Essentials fully supports multicore audio rendering. This means that if your computer has multiple CPU 
Cores (Dual Core or Quad Core, for example), or multiple CPUs, Reason Essentials takes advantage of this to signif-
icantly enhance the performance. A higher system performance allows for more tracks and devices in your songs. 

If your computer has a multi-core CPU, or multiple CPUs, MultiCore Audio Rendering is active by default, as indicated 
on the “General” page in Preferences:

Master Tune setting

By default, Reason Essentials plays back a “middle A” at 440 Hz, which is the standard tuning in most instruments. 
However, if you are playing Reason Essentials together with other instruments, you may want to adjust the tuning:
1. Select “Preferences...” from the Edit menu (Win) or Reason Essentials menu (Mac).

2. Click the “Audio” tab.

3. Adjust the global tuning with the Master Tune slider or button controls.

D If you like, you can also adjust the Master Tune during playback.

! The Master Tune setting affects the tuning of all sound sources in Reason Essentials, including the Tuner func-
tion on the Audio Tracks. It also affects the tuning of the Redrum and Dr. Octo Rex loop player.
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About audio levels
When recording and playing back in Reason Essentials, you should keep an eye on the Audio In and Audio Out Clip 
indicators on the Transport Panel, or on the Hardware Interface and the Big Meter. You should also keep an eye on 
the clip indicators on the Main Mixer Master Section. If any of the clip indicators light up, the audio level is too high, 
resulting in clipping (digital distortion).

The Clip indicators on the Audio In and Audio Out meters on the Transport Panel

The Clip indicators in the Master Section of the Main Mixer

! Note that if you use the Propellerhead Balance audio interface when recording audio tracks in Reason Essen-
tials, you can use the unique Clip Safe function. The Clip Safe function allows you to heal clipped input signals! 
See “Recording using the Clip Safe function in Propellerhead Balance” for more information

! Note that the Main Mixer Master Section Clip indicators will only work if there are no other devices connected 
between the Master Section device and the Hardware Interface!

The Big Meter on the Hardware Interface

The Clip indicators will stay lit for a short 
moment, to make them easier to spot.

If the audio out level is, or has been, 
too high, the Clip indicators in the 
Master Section will stay lit until you 
click the “Reset” button.

Audio Out Clip indicators

Reset button

Channel Selection buttons 
for the “Big Meter”

The “Show Big Meter” button

Clip indicators

Reset
button

Channel Selection knob 
for the “Big Meter”
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D To remedy Audio In clipping, adjust the level at the input source, i.e. on the hardware audio interface or on the 
preamp connected to the hardware audio interface.

! When recording or sampling external audio signals, clipping cannot be adjusted in the Reason Essentials ap-
plication - it must be adjusted at the audio input source!

! When sampling audio internally from devices in the rack, you have to adjust the Output Level on the source de-
vice to make sure clipping doesn’t occur in the Hardware Interface.

D To remedy Audio Out clipping, lower the master level on the Mixer (or other device) that is connected to the 
Hardware Interface, until Audio Out clipping doesn’t light up on playback. 
You could also use the MClass Maximizer as an insert effect on the Master Section in the Main Mixer to ensure 
that clipping never occurs - see “The MClass Maximizer”.

D To get a better overview of the levels, bring up the Big Meter on the Hardware Interface, by clicking the “Big 
Meter” button on the front panel. Then, select the input or output pairs to view in the Big Meter by clicking on 
the corresponding channel selection button below each input or output pairs. Alternatively, select channel by 
turning the channel selection knob.
If the audio level is, or has been, too high, the Clip indicators on the Big Meter will stay lit until you click the Reset 
button, or select new audio channels for the Big Meter.

! In some situations, the Audio Out Clip indicator on the Transport Panel and the Output Clip indicators on the 
Reason Essentials Hardware Interface might light up if the metronome Click is active in the sequencer during 
playback (see “Click and Pre-count”). This is nothing to worry about and won’t cause any distortion in your 
song. To determine if the metronome is causing the clipping indication, just disable Click and see if the clip-
ping stops.

! Note that it doesn’t matter if the level meters on the individual devices (effects, MIxer channels, etc.) “hit the 
red”. Output clipping can only occur in the Hardware Interface.

The technical reason for this is that internally, Reason Essentials uses high resolution floating point processing, 
which ensures highest audio quality and virtually limitless headroom. In the Hardware Interface, the floating point 
audio is converted to the resolution used by the computer’s audio interface, and that’s where audio out clipping 
might occur.

If you are using multiple outputs

If you are using an audio interface with more than two outputs, you might want to have different devices connected 
to different outputs. If the Audio Out Clip indicator on the Transport Panel lights up, you should play back the section 
again while checking the Reason Essentials Hardware Interface. Each output socket has a level meter - if the red 
meter segment lights up, the output is clipping.

The indicator for Output 7 on the Hardware Interface indicates clipping

D If necessary, bring up the Big Meter and select the output pair where the clipping occurs. Lower the output 
level of the device connected to the clipping output, until no clipping occurs.

If you are using ReWire

If you are streaming audio to another application using the ReWire protocol, clipping can not happen in Reason Es-
sentials. This is because the conversion from floating point audio happens in the other audio application. See “Re-
Wire” for more information.

Output 7 indicates 
audio clipping.



AUDIO BASICS 67

System signal paths
Depending on the track types in the sequencer, the default signal chain varies. In this section we’re going to describe 
the default audio signal paths for Audio Tracks and Instrument Tracks.

Audio Track signal paths
When you’re recording and playing back audio that originates from an external source, like a guitar or a vocalist, the 
audio signal must first travel from the source, via a hardware audio interface, into the Reason Essentials application. 
Then, when played back, the audio travels from the Reason Essentials application, via the hardware audio interface, 
to a speaker system or similar. The figure below shows a schematic overview of the audio signal paths for a “stan-
dard” auto-routed Audio Track in Reason Essentials:

An Audio Track signal path in Reason Essentials
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Instrument Track signal paths
When you’re recording and playing back audio from an instrument device, like the ID8 Instrument device, the audio 
signal only has to travel only in one direction: from the Instrument device, via the hardware audio interface, to a 
speaker system or similar. The figure below shows a schematic overview of the audio signal paths for an auto-routed 
Instrument Track in Reason Essentials:

An Instrument Track signal path in Reason Essentials
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General information about audio and computers

About latency
On any personal computer system, there is a delay between the moment you input a sound, or “tell” the hardware to 
play a sound, and when you actually hear it. This delay is referred to as the “latency” of the design. This imposes a 
problem for any system where you want real-time user input to affect the sound.

Why is there latency?

All audio applications receive and generate their audio in chunks. These chunks are then passed on to the audio card 
where they are temporarily stored before being converted into regular audio signals. The storage place for these 
chunks are called “buffers” (an analogy would be a bucket brigade, where a number of people each have a bucket, 
and water is poured from one bucket to another to reach its final destination).

The smaller the buffers and the fewer they are, the more responsive the system will be (lower latency). The general 
rules regarding the buffer size are these:

• A small buffer size reduces the latency (the time it takes for the audio to “travel” from the audio interface in-
put(s) to the application and from the application to the audio interface output(s)).
However, a small buffer size also increases the DSP Load. Too small a buffer size setting could also make the 
sound crackle and distort.

• A large buffer size reduces the DSP Load (allowing for more tracks to be played back simultaneously) and also 
ensures good audio quality.
However, a large buffer size also increases the latency.

A high sample rate will also reduce the latency. However, this will also raise the demands on the computer and its 
software. If the system can’t cope with moving the data to and from the buffers fast enough, there will be problems 
that manifest themselves as glitches in audio playback.

To make things worse, audio playback is always competing with other activities on your computer. For example, a 
buffer size that works perfectly under normal circumstances might be too small when you try to open files during 
playback, switch over to another program while Reason Essentials is playing or simply play back a very demanding 
song.

What is acceptable?

On a regular PC, the latency can vary quite a lot. This is an effect of the fact that computers and their operating sys-
tems were created for many purposes, not just for recording and playing back audio. For multimedia and games, a la-
tency of a 100 ms might be perfectly acceptable, but for recording and playing back audio it is definitely not!

• PC audio cards running under Windows with a MME driver might at best give you a latency of around 160ms.

• The same card with a DirectX driver running under Windows provides at best around 40ms.

• A card specifically designed for low latency, with an ASIO driver under Windows, or a Core Audio driver under 
Mac OS X, can usually give you figures as low as 2-3 ms. This is definitely good enough for audio applications. 
That’s also why ASIO or Core Audio drivers are required to run Reason Essentials.

Reason Essentials’s built-in sequencer is not affected by latency

When Reason Essentials’s sequencer is playing back a song, the timing between notes and audio is perfect! Once 
playback of a Reason Essentials pattern or song is up and running, latency isn’t a consideration at all. The computer 
clocks the audio between the steps and does this with perfect quartz accuracy! The timing is immaculate!
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ReWire and Latency

When you run Reason Essentials as a ReWire slave, it is the other program, the ReWire master, that is responsible for 
actually rendering the audio and playing it back via the audio card. It means that any latency is present in the ReWire 
master.

! When Reason Essentials runs as a ReWire slave, what audio hardware you have, what audio driver you use, 
and the audio settings you have made in the Preferences dialog are of no importance at all! All audio hardware 
settings are then instead made in the ReWire host application. 

! Note, however, that you may have to adjust the “External Sync Offset” in Preferences if Reason Essentials is 
synced via MIDI from the host application (see “Synchronization considerations”).

For information on ReWire, see “ReWire”.

Reducing latency

There are a few general methods for making sure latency is as low as possible:

D Make sure you are using the latest version of the drivers for your hardware audio interface.

D Adjust the Sample Rate and Buffer Size parameters as described in “Audio settings”.

D Remove unnecessary background tasks on your computer.
This might be any background utility you have installed as well as networking, background internet activities etc.

D Optimize your songs.
You might run into situations where you have to raise the Output Latency setting to be able to play back a very de-
manding song on your computer. Another option would be to actually optimize the song. See “Optimizing Perfor-
mance” for details.

D Get a better audio interface.
This is only required if you find that you need to increase Output Latency because your audio card can’t really cope 
with the songs you try to play.

D Get a faster computer.
This is only required if you find that you need to increase Output Latency because your computer can’t really cope 
with the songs you try to play.

About processors
When you run Reason Essentials, the clock speed of the processor is a major factor determining how many audio 
tracks and devices you can use at the same time.

If you plan to buy a computer specifically for Reason Essentials, you could play it safe and choose a computer with at 
least an Intel P4, or equivalent AMD processor, running at 2.0 GHz or faster. MultiCore processors will give better 
performance and are highly recommended.

About RAM
Another important performance factor is the amount of installed RAM in the computer. Generally, one could say: the 
more the better, especially if you’re running several applications simultaneously. To run Reason Essentials, a mini-
mum of 1 GB RAM is required, but more is recommended for even better performance.
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About this chapter
This chapter describes the layout and general functions of the main sequencer. Recording, editing clips and events 
and arranging in the sequencer are described in detail in the chapters “Recording in the Sequencer”, “Audio Editing 
in the Sequencer”, “Note and Automation Editing” and “Arranging in the Sequencer”.

Introduction
The sequencer is where you record your songs. The sequencer can be used to record audio tracks as well as instru-
ment tracks, performance controllers, parameter automation and pattern automation.

Sequencer area overview

Arrange Mode and Edit Mode
Arrange Mode is the “normal view” where you are working with your song arrangement. This mode gives a good over-
view of the content of the tracks in your song. 

Edit Mode is where you edit the contents of the clips in your song. In Edit Mode the Edit Pane shows detailed infor-
mation about the content of one track (see “Tracks overview”), or lane (see “Lanes overview”) at a time and you can 
edit the events in individual clips (see “Clips overview”).

q When you open a note or audio clip by double-clicking it in Arrange Mode, the sequencer automatically 
switches to Edit Mode. However, if you double-click a parameter automation clip, it opens up for editing di-
rectly in Arrange Mode.

Edit/Arrangement
Pane

Toolbar
Track
List

Ruler

Inspector (context sensitive)

Audio Clips

Note Clips

Tracks

Edit Mode button Track Navigator

Transport Panel

Song Navigator

Lanes Automation Clips

Waveform Zoom Mode
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Arrange Mode

In Arrange Mode, all clips on all tracks can be viewed. Use this mode to get an overview of your arrangement, and 
when you want to perform clip-based editing such as rearranging whole sections of your song, etc.

Edit Mode

In Edit Mode, you get a close-up look at the recordings on a track. In Edit Mode, the Edit Pane can be divided into 
several horizontal edit rows, showing different types of events (notes, velocity, audio, parameter automation, etc.). This 
is the view mode of choice for fine editing the content of your recorded clips, and for drawing notes, performance 
controllers and other events manually.

Toolbar overview

The sequencer Toolbar features various sequencer editing tools as well as the Snap function. The tools can be used 
both in Arrange Mode and Edit Mode, with slightly different purposes in the respective modes. See “Toolbar details” 
for details about each tool.
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Track List overview

To the left in the sequencer, all tracks are listed in the Track List. Each track in the sequencer is associated with a 
specific device in the rack. By clicking on a device icon in the Track List you automatically set Master Keyboard Input 
(see “Setting Master Keyboard Input”) to the corresponding device in the rack for playing and/or recording.

Tracks overview

Most rack devices in a song automatically get their own dedicated track in the sequencer when you create the device. 
Each track can feature one or several lanes on which audio, note, performance controller, pattern and parameter au-
tomation events can be recorded - in clips. See “Track details” for more details about tracks.

Lanes overview

Each track consists of one (default) or several parallel lanes. The lanes can contain clips that feature note events or 
audio recordings, depending on track type. A track can also feature automation lanes that contain clips with parame-
ter automation events - or pattern automation for pattern based devices. See “Lane details” for more details about 
lanes.

Tracks

Lanes
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Clips overview

Note, audio, performance controller, pattern and parameter automation events are always contained in clips. A clip is 
basically a “container” for recorded data. Audio clips are displayed on the Edit/Arrange Pane as rectangular boxes 
with one or two graphical audio waves inside (mono or stereo). Note events are displayed in a “piano roll” fashion in 
the clip. Performance controllers and parameter automation events are displayed as continuous lines, and pattern 
events are displayed as repeated rectangles in the clips. See “Clip basics” for information about the different clip 
types.

Inspector overview

The context sensitive Inspector shows the properties of whatever is currently selected in the sequencer: clips, notes, 
automation events, audio comp rows and cuts etc. The properties of the selected item can be edited by changing the 
values in the various displays. See “About the Inspector” for more info.

Ruler overview

The Ruler is the song’s “time line”, measured in bars. In the Ruler, the Song Position Pointer indicates the current po-
sition in the song, i.e. in which bar the song is, or will begin, playing. The Ruler also shows the Left and Right Loop Lo-
cators as well as the Song End Marker. See “Ruler details” for more details.

Edit/Arrangement Pane overview

The big center section of the sequencer is called the Edit/Arrangement Pane. This is where all recorded events re-
side in clips - on one or more lanes on the respective track.

Audio Clips

Note Clips

Automation Clips
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Track Navigator overview

To the far right in the sequencer is the Track Navigator. With the Track Navigator you can scroll vertically in the Edit/
Arrange Pane. In the Track Navigator, you can also see which track is selected (dark background color) and which 
track has Master keyboard Input (red frame around the device icon). See “Scrolling” and “Zooming in the Sequencer” 
for more details.

Song Navigator overview

Below the Edit/Arrangement Pane is the Song Navigator. With the Song Navigator you can scroll and zoom horizon-
tally on the Edit/Arrangement Pane. The Song Navigator also features indicators for the Ruler’s Loop Locators, Song 
Position Pointer and Song End Marker. In the Song Navigator, all clips on all lanes are displayed as colored lines, in-
dicating their positions in the song. See “Scrolling” and “Zooming in the Sequencer” for more details.

Transport Panel overview

The Transport Panel features the sequencer transport controls (Rewind, Fast Forward, Stop, Play and Record) as well 
as controls for Tempo, Time Signature, Position, Time and Loop Locator placements and some other functions. See 
“Transport Panel details” for more details.
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Track details

Track definition
The tracks in the sequencer are where you record your audio, note and automation to create your songs. A track is al-
ways associated with a device in the rack (except for the Transport track). An icon with a picture of the associated 
device is shown in the Track List on the left hand side in the sequencer. In the Track List, the name of the associated 
device is shown, as well as icons and buttons related to the specific track. Each track can incorporate various lane 
types (depending on track type). To the right of the Track List - on the Edit/Arrangement pane - each track has its 
own dedicated area for recorded events.

In the picture below, six sequencer tracks are shown. From the top down are the Transport Track (which is always 
present and cannot be moved or deleted), two audio tracks, two instrument tracks associated with one ID8 instru-
ment device each, and one automation track for a Mix Channel strip.

Transport Track
Audio Tracks

Instrument Tracks

Automation Track
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The relationship between the track, the rack and the Main Mixer
A track in the sequencer is always associated with a device in the rack; i.e. there can never be a sequencer track with-
out an associated rack device (except for the Transport track). Audio Track devices and Mix Channel devices in the 
rack also have their corresponding channel strips in the Main Mixer. Mixer Channel strips can be considered “remote 
controls” for their corresponding rack devices. Depending on track type, the signal chain differs somewhat. The pic-
ture below shows the signal flow in four scenarios with three different track types:

Audio Track Instrument Track

Automation Track (of channel strip parameters) Automation Track (of device parameters)
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Audio track relationships

An audio track is always associated with an Audio Track device in the rack and its corresponding Audio Track chan-
nel strip in the Main Mixer. An Audio Track device can also house insert effects.

In the figure above, the audio track is associated with the Audio Track device in the rack, 
which in turn is controlled from the Audio Track channel strip in the Main Mixer. The audio track
features recorded audio and mixer automation.
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Instrument track relationships

An instrument track is always associated with an instrument device in the rack. The instrument device in the rack is, 
in most situations, connected to a Mix Channel device in the rack. The Mix Channel device in the rack is controlled 
from the corresponding channel strip in the Main Mixer. A Mix Channel device can also house insert effects.

In the figure above, the ID8 track is associated with the ID8 instrument device in the rack. The ID8 instrument 
device is connected to the ID8 Mix Channel device in the rack, which in turn is controlled from the ID8 
channel strip in the Main Mixer. The ID8 track features recorded MIDI notes and parameter automation.

Note that when you create an instrument, the connected Mix Channel device doesn’t automatically get a track in the 
sequencer. If you want to record Mixer Channel automation, you have to first create a separate sequencer track for 
the Mix Channel device. See “Automation (non-instrument) track relationships”.

The ID8 Track

Audio
ID8 Mix Channel device

ID
8 

M
ix

 C
h

an
n

el
 s

tr
ip

Control

MIDI and 
parameter
automation

ID8 device



SEQUENCER FUNCTIONS 81

Automation (non-instrument) track relationships

A pure automation track is always associated with a “non-instrument” device, i.e. a device which can’t receive MIDI 
Note information. Consequently, an automation track can only consist of parameter automation lanes. Examples of 
non-instrument devices are Mix Channel devices with their corresponding Mix Channel strips, effect devices, mixer 
devices and Spider Merger & Splitter devices. The picture below shows an example with an automated Mix Channel:

In the figure above, the Mix Channel automation track is associated with the Mix Channel device 
in the rack, which in turn is controlled from the channel strip in the Main Mixer.

The picture below shows an example with an automated MClass Equalizer device. Note that no mixer channel strip is 
involved in this situation since the automation only concerns a non-instrument device and not any Mix Channel de-
vice:

In the figure above, the Equalizer automation track is associated with the Equalizer device in the rack.
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Master Keyboard Input
The standard way of routing MIDI from a connected MIDI master keyboard or control surface to a device in the rack 
is to set the Master Keyboard Input in the sequencer. When MIDI is routed to a selected track in the sequencer, the 
notes and controller data are automatically echoed to the associated device in the rack.

• Setting Master Keyboard Input to an instrument track is necessary if you want to play notes on an instrument 
device from your MIDI master keyboard (and control the instrument device parameters via MIDI).
By locking additional MIDI keyboards to separate devices in the rack, you will be able to play and record on several 
sequencer tracks simultaneously, see “Locking a surface”.

• Setting Master Keyboard Input to an audio track is only necessary if you want to control the Main Mixer chan-
nel strip parameters via MIDI.

• Setting Master Keyboard Input to a “non-instrument” (parameter automation only) track is only necessary if 
you want to control the device’s parameters via MIDI.

Besides the standard routing described above, it’s also possible to lock certain rack devices to specific control sur-
faces. See “Locking a surface” for more details.

! If you have several MIDI keyboards/control surfaces locked to individual devices in the rack, it is possible to 
control and record on several tracks simultaneously!

Setting Master Keyboard Input

D To set Master Keyboard Input to a track and its associated device, click the device icon in the Track List.

Master Keyboard Input set to an instrument track

Master Keyboard Input set to an audio track

The device icon gets a keyboard symbol below it and a red border, indicating that the track and associated device 
has Master Keyboard Input. The track and device will now respond to incoming MIDI data from a connected MIDI 
keyboard/control surface. By default, setting Master Keyboard Input also automatically selects the track, which is 
indicated by the darker color of the track in the Track List. 

It’s also possible to set Master Keyboard Input and track selection independently from each other by selecting 
“Separated” on the “Keyboards and Control Surfaces” page in Preferences - see “Preferences – Control Surfaces”.

• Only one track at a time can have Master Keyboard Input. However, if you have locked additional MIDI key-
boards to specific devices in the rack via Remote (see “Locking a surface”), you will be able to play and record 
these together with the track that has Master Keyboard Input.
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The relationship between tracks, lanes, clips and events
A track is the top level in the sequencer Track List hierarchy. A track can consist of one or several parallel lanes. A 
lane can contain clips, which in turn can contain audio recordings, note events, performance controller events, param-
eter automation events or pattern events, depending on track type.

An instrument track with four note lanes featuring clips with note events.

• A device in the rack can never have more than one track in the sequencer.

• A clip is a “container” for various types of events (audio recordings, note, performance controller, parameter 
automation or pattern events).

Track types
These are the different track types:

• The Transport track.

The Transport track is always present at the top of the Track List and cannot be moved or deleted. The Transport 
Track can have a maximum of two lanes: one containing time signature automation, and the other containing 
tempo automation. See “Automating time signature” and “Editing tempo automation” for more details.

• Audio tracks

An audio track can only have a single audio lane containing clips with mono or stereo audio recordings. However, 
each audio clip can contain several recordings, i.e. different "takes". You can view and comp these takes in Edit 
Mode. See “Audio Editing in the Sequencer” for more details. An audio track can also have parameter automation 
lanes containing automation for the Audio Track Channel strip parameters in the Main Mixer.

Track

Lane

Lane

Lane

Lane

Clip

Clip

Clip

Clip

Note Events



SEQUENCER FUNCTIONS84

• Instrument tracks

Devices that can receive MIDI notes, such as the Combinator device, will automatically be assigned a record en-
abled track when created. On an instrument track you can create a number of separate note lanes that can incor-
porate clips containing a combination of note and performance controller events. Multiple lanes are perfect if you, 
for example, are recording a drum track and want to record each drum sound on a separate lane. An instrument 
track can also have a number of parameter automation lanes that can contain clips with instrument parameter au-
tomation events.

• Parameter automation (“non-instrument”) tracks

Tracks for devices that do not receive MIDI note data (e.g. effects and mixer devices and mixer channels in the 
Main Mixer) can only contain parameter automation lanes. These “non-instrument” devices are not automatically 
assigned a track when created. To automate parameters for non-instrument devices you need to manually create 
a track for these. The number of available lanes is limited by the number of parameters of each device. There can 
be one lane for each automatable parameter in the device.
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Track List elements
In the picture below, a Track List with four different tracks is shown. From the top down are the Transport Track 
(which is always present and cannot be moved or deleted), an Audio Track associated with an Audio Track device, an 
Instrument Track associated with an ID8 Instrument device and an Automation Track associated with the Mix Chan-
nel device connected to the ID8 Instrument device.

The Transport Track in the picture features two parameter Automation Lanes (for Time Signature and Tempo) that 
have been manually created for the track. The audio track features only a single audio lane. The ID8 1 track features 
four note lanes and has two parameter automation lanes added. The Mix Channel 1 track is associated with the Mix 
Channel 1 device and has three parameter automation lanes added.

Depending on track type, the elements shown in the Track List can vary. The only common element for all track types 
is the "Record Enable Parameter Automation" button which should be enabled when you want to record parameter 
automation for the associated device. This and the other track elements will be described in detail later in this chap-
ter.

Device Icons 
with names

Track Mute buttons

Track Solo buttons

Record Enable Parameter Automation buttons

Note Lanes

Parameter Automation 
Lanes

Parameter Automation 
Lanes

Parameter Automation 
Lanes

Transport Track

Audio Track

Instrument Track

Automation Track
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Creating tracks

Creating an audio track

An audio track can be created as follows:
1. Hold down [Ctrl](Win) or [Cmd](Mac) and press [T]. Alternatively, select “Create Audio Track” from the “Cre-

ate” menu or from the context menu in the Track List, rack or Main Mixer.

D Alternatively, click the “Create Audio Track” button on the “Devices” tab in the Tool Window.

2. An audio track is created in the sequencer and the associated Audio Track device is created in the rack. The 
Audio Track device’s channel strip is created in the Main Mixer.
By default, the audio track is set up in mono. You can easily change to stereo by selecting “Stereo Input” in the 
“Audio Input” drop-down list - see “Selecting audio input(s) and defining mono or stereo”. If you select “Stereo In-
put”, the Audio Track channel strip in the Main Mixer automatically switches to a stereo channel.

Audio Track

Audio Track device

A
u

d
io

 T
ra

ck
 C

h
an

n
el

 s
tr

ip

Control

Audio and mixer 
automation



SEQUENCER FUNCTIONS 87

Creating an instrument track

To create an instrument track, you need only create the instrument device. An instrument track is automatically cre-
ated when you create a device which can receive MIDI notes:
1. Select desired instrument type from the “Create” menu.

Alternatively, to select an Instrument patch and automatically load the patch into the appropriate device type, hold 
down [Ctrl](Win) or [Cmd](Mac) and press [I], or select “Create Instrument” from the “Create” menu to bring up the 
Patch Browser. Under Windows, you can also press [Insert] to open the Patch Browser. In the Patch Browser you 
can select and preview patches before loading them into the instrument.

D Alternatively, drag and drop or double-click the desired instrument device from the “Device Palette” tab on the 
Tool Window. Or, to bring up the Patch Browser, click the “Create Instrument” button on the “Device Palette” 
tab.

2. An instrument device is created in the rack and the associated track is automatically created in the sequencer.
In addition, a Mix Channel device for the instrument is automatically created in the rack and its channel strip is cre-
ated in the Main Mixer. All devices are automatically connected. The Mix Channel device automatically adapts its 
inputs to the created instrument type - if the instrument is in mono, the Mix Channel device will be in mono, and if 
the instrument has stereo outputs, the Mix Channel device will be in stereo.

! Note that no automation track is created for the Mix Channel device. This has to be manually created if you 
want to automate any of the Mix Channel strip parameters (see “Creating a parameter automation track for a 
non-instrument device”).
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Creating a parameter automation track for a non-instrument device

For non-instrument devices, such as effects devices and Mix Channel devices, you need to manually create a track if 
you want to record parameter automation. You can do that either by following the description below or by following 
either of the two last descriptions in “Creating/adding parameter automation lanes”.

The track creation procedure described below also applies if you have manually deleted a track for an instrument de-
vice or an Audio Track device and want to create a new track for the device:
1. Select the device by clicking on it in the rack.

A border around a device in the Rack indicates that it has been selected.

2. Select ”Create Track for (name of device)” from the Edit menu or the device context menu.

! Note that if a track already exists for the device, this menu item will not be available - a device can only have 
one track.

• The new track will be automatically associated with the device and will get the same name as the device.

D Another way of creating a parameter automation track is by holding [Alt](Win) or [Option](Mac) and clicking 
on a parameter on the device panel. Alternatively, select “Edit Automation” from the parameter context menu.

q If you press [Alt](Win) or [Option](Mac) when you create a non-instrument device, this will automatically create 
an associated automation track for the device.

RV7000 device

RV7000 device

TheRV7000 Automation Track
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Short-cut for creating a Mix Channel track or Audio track

A faster way of creating a track for a Mix Channel device, or to create a new audio track (if you deleted the original 
one), is to go via the corresponding mixer channel strips in the Main Mixer:
1. Scroll to the Main Mixer and locate the channel strip you want to create a track for.

2. [Shift]-click the SEQ (Goto Sequencer Track) button at the bottom of the channel strip.
A new track will be automatically created in the sequencer for the selected channel strip.

! If a track should already exist for the selected channel strip, [Shift]-clicking the SEQ (Goto Sequencer Track) 
button will only scroll the corresponding sequencer track into view, not create any new track.

Selecting tracks
D Select a track by clicking on it in the Track List.

A selected track gets a darker color.

q Selecting a track in the sequencer will automatically scroll the corresponding device into view in the rack.

• Selecting an audio track will set Edit Focus to its channel strip in the Main Mixer.

• Selecting another type of track (e.g. an instrument track) will set Edit Focus to the Mix Channel belonging to 
that device group. 
See “About Device Groups” for information about device groups.

D You can also select the next or previous track in the Track List list by using the up and down arrow keys on the 
computer keyboard.

! By default, selecting a track will automatically set Master Keyboard Input to that track. If you’d rather select 
tracks independent of the Master Keyboard Input selection, select “Separated” mode in the Preferences menu 
(“Keyboards and Control Surfaces” page). In “Separated” mode, you can select another track without auto-
matically changing Master Keyboard Input. To change Master Keyboard Input, click the device icon on the de-
sired track in the Track List.

D It is possible to select several tracks by using standard [Shift], or [Ctrl](Win) or [Cmd](Mac), selection tech-
niques.
This allows you to e.g. move or delete several tracks in one go.
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Moving tracks
D To move a track to another position in the Track List, click on the track handle (the leftmost area of the track) 

and drag the track up or down.
A red insertion line is shown, indicating where the track will be placed after releasing the mouse button. All clips on 
all lanes of the track will be moved along with the track.

You can use the same technique to move several selected tracks at once. Use standard [Shift]-select or use 
[Ctrl](Win) or [Cmd](Mac) to select non-adjacent tracks.

About sorting devices and channel strips according to the track order

Note that the order of the tracks in the sequencer Track List is totally independent from the device order in the rack 
- and from the channel strip order in the Main Mixer. However, it’s possible to re-order devices and channel strips ac-
cording to the track order in the Track List:
1. Select the tracks in the Track List you want to re-order devices and channel strips after.

2. Select “Sort Selected Device Groups” from the Edit menu or from the track’s context menu.
The associated devices and channel strips are now re-ordered, in the rack and Main Mixer respectively, according 
to the order of the selected tracks in the Track List.

! Note that the re-ordering only affects the devices and channel strips of the selected tracks - all other devices 
and channel strips will remain unaffected.

Deleting tracks
The most common scenario would probably be to delete a track together with its associated device(s). However, it’s 
also possible to delete only the track while keeping the associated device(s) in the rack.

Deleting tracks together with their associated devices

D To delete one or several tracks together with their associated devices in the Rack, select the tracks and then 
select “Delete Track(s) and Device(s)” from the Edit menu or from the track’s context menu. Alternatively, 
press [Delete] or [Backspace].
An alert appears which prompts you to confirm or cancel the deletion of the track(s) and device(s).

! If you're deleting the track for the Source Device or Mix Channel, and “Auto-group Devices and Tracks” on the 
Options menu is on, you will be asked if you want to delete the whole device group. If you hold down 
[Ctrl](Win) or [Cmd](Mac) while deleting, the whole device group will be deleted without the alert.

See “About Device Groups” for more information about device groups.
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Deleting tracks only

D To delete one or several tracks, select them and then select “Delete Track(s)” from the Edit menu or from the 
track’s context menu.
The tracks will be deleted without an alert but you can always use the Undo function. See “Undo and Redo”.

! If you delete an audio track, all recordings on that track will be removed!

If you have deleted a track for a device and want to create a new track for the device, follow the descriptions in “Cre-
ating a parameter automation track for a non-instrument device” or “Short-cut for creating a Mix Channel track or Au-
dio track”.

Duplicating/copying tracks and devices
As it is not possible for a specific instance of a device to have more than one track, you cannot copy or duplicate only 
a track. These operations will instead duplicate/copy both the track (including all clips on the track) and its associ-
ated device(s) (with all settings). The duplicated/copied devices are really just like separate devices but with the 
same name and settings as the original devices, although their names will have the extension “Copy” to differentiate 
them from the original.

To make copies of tracks and their associated devices, complete with all lanes and recorded clips, use any of the fol-
lowing methods:

! Note that if “Auto-group Devices and Tracks” on the Options menu is on, the entire device group(s) associated 
with the track(s) will be copied/duplicated when you perform the procedures described below.

See “About Device Groups” for more information about device groups.

D Hold down [Ctrl](Win) or [Option](Mac), click on the track handle and drag the selected track(s) to a new posi-
tion in the track list.

D Select “Duplicate Device(s) and Track(s)” from the Edit menu or from the track’s context menu.
To bring up the context menu, right-click (Win) or [Ctrl]-click (Mac) on the track in the Track List. The duplicated 
track(s) will be inserted below the original track.

D Select “Copy Device(s) and Track(s)” from the Edit menu or from the track’s context menu.
This allows you to insert the copied track(s) and device(s) by selecting “Paste” from the Edit menu or from the 
track’s context menu. The copied track(s) will be pasted below the currently selected track.

! Note that if “Auto-group Devices and Tracks” on the Options menu is off, duplicated/copied devices will not 
have auto-routed audio connections. To hear the duplicated devices, select the device and choose “Auto-route 
Device” on the Edit menu or context menu. Alternatively, flip the rack around and connect the audio outputs to 
available (or new) Mix Channel devices. You might also want to mute the original track to avoid double notes.

D To duplicate a selected audio track, with all recordings and mixer channel strip parameter settings, including 
any Insert FX, click the “New Alt” or New Dub” buttons on the Transport Panel - see “Duplicating audio tracks 
using the “Alt” function” and “Overdubbing audio using the “Dub” function”.

q If you hold down [Shift] and select Paste from the Edit menu or context menu, the copied device(s) will be 
auto-routed to an available mixer channel. If necessary, an additional Mix Channel will be automatically cre-
ated.
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Coloring tracks
A track can be assigned a color in the sequencer as follows:

D To assign a new color to a selected track, select “Track Color” from the Edit menu or from the track’s context 
menu and then select color from the palette.
The track color is shown in the track background in the Track List. The associated Audio Track device or Mix 
Channel device in the rack and its corresponding channel strip in the Main Mixer will also be assigned the new 
color. The selected track color will be reflected in all new clips you record or draw on this track. Any previously re-
corded clips on this track will not change color. To change color of previously recorded clips, refer to “Coloring 
clips”.

D To automatically set a new color for new tracks, make sure the “Auto-color New Sequencer Tracks” box in the 
Options menu is ticked.
The track color will be automatically selected from the palette when you create a new track.

Naming tracks
D Name, or rename, a track by double-clicking its name tag in the Track List, typing in a name and pressing [Re-

turn].
Note that naming/renaming a track also changes the name of the associated Source Device in the rack (and vice 
versa). Furthermore, renaming an audio track also changes the name of the associated Audio Track device in the 
rack as well as its corresponding channel strip in the Main Mixer. If you rename the track of a source device in a 
device group, its Mix Channel will get the same name. If you want a separate name for the Mix Channel, double-
click in the Mix Channel name tag, in the rack or Main Mixer, type in a new name and press [Return].

See “About Device Groups” for more information about device groups.

Folding tracks
To minimize the visible height of the track, and thus allow for a better overview of the tracks in the sequencer, it’s pos-
sible to fold tracks.

D To fold/unfold a track, click on the small triangle on the track handle.

An unfolded track

The same track folded

A folded track will not show the individual lanes in the Track List, and on the Edit/Arrangement Pane the clips are 
shown as horizontal strips. If the folded track has several lanes, all the clips on the lanes will be shown as vertically 
stacked strips on the Arrangement Pane. No events in the clips are shown.

D Basic clip operations (selecting, moving, copying etc.) are available also for folded tracks, although it is gener-
ally better to unfold a track if you want to edit its contents, as this gives you a better overview. 
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D To fold/unfold all tracks in the sequencer in one go, press [Alt](Win) or [Option](Mac) and click on a track han-
dle triangle.

q It’s also possible to fold/unfold only the parameter automation lanes on a track by clicking the triangle on the 
parameter automation tab. See “Parameter automation lane elements” for more details.

Muting tracks
To mute a track means to silence it, so that no data is sent from the track during playback. This can be useful when 
you are trying out different versions of an arrangement, for bringing elements in and out of the mix during playback.

D To mute a track, click the corresponding Mute (M) button in the Track List.
Everything present on the track will be muted.

A red “M” button in the Track List indicates that the track is muted.

D To unmute the track, click the “M” button again.

D Several tracks can have Mute active at the same time, in which case you can unmute them all by clicking the 
master “M” button at the top of the Track List.

q It’s also possible to mute individual lanes and individual clips on a track. Refer to “Muting lanes” and “Muting 
clips”.

Soloing tracks
To solo a track means that all tracks in the sequencer, except for the soloed track, are muted.

D To solo a track, click the corresponding Solo (S) button in the Track List. 
This mutes all other (un-soloed) tracks. Soloed tracks have green S buttons.

Here, the “Filter Chords” track is soloed (indicated by the green “S” button). 
All other tracks are automatically muted (indicated by red “M” buttons)

D To turn solo off, click the green “S” button again.

D Several tracks can have Solo active at the same time, in which case you can turn off Solo for all of them by 
clicking the master “S” button at the top of the Track List.
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Lane details
A track consists of one (default) or several parallel lanes. Depending on track type, the clips on the lanes can contain 
various types of events. A lane can also contain clips with performance controller and parameter automation events - 
or pattern selection for pattern based devices.

Audio lane

The audio lane is not distinguished by a separate lane tab in the Track List like the other lane types. This is simply be-
cause an audio track can only have a single audio lane. Consequently, all audio lane elements reside in the audio 
track section instead.

Audio lane elements

• Record Enable button
To the right of the Record Enable Parameter Automation button is the Record Enable button. Make sure this but-
ton is on (red) before recording audio on the track. By default, this is activated when you select an audio track. If 
you want to record several audio tracks at the same time you need to click their Record Enable buttons first.

• Monitor button
To the right of the Record Enable button is the Monitor button. Click this button to monitor the input signal of the 
track. The signal is monitored after the audio track channel strip which means that all channel strip parameters, in-
cluding any Insert FXs, will be monitored.

! The Monitor button activation/deactivation depends on the setting in the “Monitoring” section on the “Audio” 
page in Preferences. If “Manual” is selected, you will have to manually activate the Monitor button. If “Auto-
matic” is selected, the Monitor button is automatically activated when the Record Enable button is on.

• Enable Tuner button
To the left below the Device icon is the Enable Tuner button. Click the button to switch to Tuner mode. The Input 
Meter to the right will switch to a Tuner.

Audio track in Tuner mode

In Tuner mode, you can tune a connected instrument - an electric guitar, for example. See “Using the Tuner” for 
more info.

Audio Lane
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• Select Audio Input drop-down list
To the right of the Tuner button is the Select Audio Input drop-down list. Here, you select which audio input(s) to 
use for the track. See “Selecting audio input(s) and defining mono or stereo” for more info.

• Input Meter
The Input Meter shows the level(s) of the input signal(s). If the selected audio input is mono, the Input Meter dis-
plays a single LED bar. If the audio input is in stereo, the Input Meter displays two parallel LED bars. See “Setting 
input level(s)” for details about setting input levels.

Note lane

As the name implies, the note lane can contain clips that feature note events. Clips on a note lane can also contain 
performance controller events. One or several note lanes can be present on an instrument track.

Note lane elements

• Name
At the top to the left is the name of the lane. As soon as you create a note lane it will automatically be named 
“Lane n” where “n” is the number of the lane - in chronological order. You can change the name of the lane by dou-
ble-clicking in the name field, typing in a new name and then pressing [Return] on the computer keyboard.

! Note that depending on the current magnification of the Edit/Arrangement Pane, the note lane names could 
sometimes be hidden. To make the note lane names visible, increase the vertical magnification of the Edit/Ar-
rangement Pane, for example, by clicking the + magnification button below the sequencer Track Navigator.

Increase the vertical magnification by clicking the + magnification button below the Track Navigator

Note Lane
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• Record Enable button
Below the note lane name is the “Record Enable” button. Make sure this button is on (red) before recording on the 
lane. By default, the “Record Enable” button on the latest created/added note lane is automatically activated when 
you select an instrument track.

• Groove Select drop-down list
To the right of the “Record Enable” button is the “Groove Select” drop-down list. Here you can select a ReGroove 
channel for all clips on the lane. See more about ReGroove in “The ReGroove Mixer”.

• M (Mute) button
Clicking the “M” button will mute the playback from the lane.

• Activity bar
To the right of the “M” button is the note lane Activity bar. As soon as there is any note playing in a clip on the lane, 
the bar lights up in green. The note lane Activity bar also reflects the velocity of the played back notes.

• Delete (X) button
To the far right is the “Delete Note Lane” (X) button. Clicking this button will delete the lane (and all clips on it). If 
there are clips on the lane, a dialog appears prompting you to confirm deletion.

Parameter automation lane

An instrument track with two parameter automation lanes

Parameter automation is used for controlling changes of device parameter values in a song. You could, for example, 
automate a filter cutoff parameter and record filter sweeps at various positions in your song. These kind of parameter 
value changes are recorded on parameter automation lanes. 

Parameter automation lanes can exist in all track types and can contain clips with device and/or channel strip param-
eter automation. A track can have as many automation lanes as its device has automatable parameters. For Mix 
Channel and Audio Track devices, parameter automation could be used for any of their corresponding channel strip 
controls.

Parameter automation lane elements

• Fold/Unfold button
Parameter automation lanes in a track can be folded/unfolded, as a group, by clicking the small triangle on the 
handle to the far left on the parameter automation lane tab.

D To fold/unfold all parameter automation lanes on all tracks in the sequencer, hold down [Alt](Win) or 
[Option](Mac) and click on the triangle on a parameter automation lane tab.

• Name
The name of the automated parameter is displayed on the parameter automation lane tab. Since the name reflects 
the original device/channel strip parameter name, this cannot be changed.

Parameter Automation 
Lanes
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• On button
The “On” button is active by default and enables the automated parameter in the clip on the lane to have effect. 
You can switch off automation lanes by clicking the yellow “On” for a lane button so it goes dark. This will freeze 
whatever value the parameter had when switching off the automation lane. Clicking the button again reactivates 
the automation.

• Delete Automation Lane (X) button
To the far right is the “Delete Automation Lane” (X) button. Clicking this button will delete the lane (and all clips on 
it). If there are clips on the lane, a dialog appears prompting you to confirm deletion. See “Deleting parameter au-
tomation lanes” for alternative ways of deleting parameter automation lanes.

Pattern lane

A Redrum track featuring a pattern lane

A pattern lane can only exist in a track featuring a pattern based device, such as the Redrum Drum Module or the 
Matrix Analog Pattern Sequencer. A pattern lane can only contain clips with pattern Bank and pattern Number auto-
mation data. There can only be a single pattern lane per track.

Pattern lane elements

• Name
The name of the automated parameter is displayed on the pattern automation lane tab. Since the name reflects 
the original device parameter name, this cannot be changed.

• On button
Click the “On” button for the pattern automation in the clip on the lane to have effect. Deselecting “On” is the same 
as muting the pattern lane.

• Delete Pattern Lane (X) button
To the far right is the “Delete Pattern Lane” (X) button. Clicking this button will delete the lane (and all clips on it). 
If there are clips on the lane, a dialog appears prompting you to confirm deletion. See “Deleting pattern lanes” for 
alternative ways of deleting pattern lanes.

Pattern Lane
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Creating/adding lanes

Adding note lanes

You can add additional note lanes on an instrument track. This can be useful under the following circumstances:

• If you want to overdub notes or performance automation but don’t want to record in existing clips.

• If you want to record a series of takes on separate note lanes, to later decide which take is the “best” (or to 
edit together a composite).

• If you want to apply different ReGroove grooves to different parts of a track, or want different grooves on sep-
arate drums on a drum track.

You can create new note lanes for selected instrument tracks in the following ways:

D Select “New Note Lane” from the Edit menu or from the context menu.
A new note lane will be created and automatically record enabled.

D Click on the “New Note Lane” (Lanes +) button at the top of the Track List.

A new Note Lane will be created and automatically record enabled. 

D Click on the “Dub” button on the Transport Panel.

A new note lane will be created and automatically record enabled. See “Recording notes using the “Dub” and “Alt” 
functions” for more details.

D Click on the “Alt” button on the Transport Panel.

A new note lane will be created and automatically record enabled. At the same time, the previous note lane, or (if 
loop is activated and the Song Position Pointer is between the Left and Right Locators) the clips between the Left 
and Right Locators, will be muted. See “Recording notes using the “Dub” and “Alt” functions” for more details.

q Note that the “Dub” and “Alt” functions can also be used on-the-fly during recording without stopping the se-
quencer.
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Creating/adding parameter automation lanes

Parameter automation lanes can be created for all track types.

• During recording of a track, changing any parameter values on the device/channels strip will automatically cre-
ate a new parameter automation lane for each unique parameter. See “Recording parameter automation” for 
more details.

Do as follows to manually create a parameter automation lane on a selected track:

D Hold down [Alt](Win) or [Option](Mac) and click on a device parameter in the rack, or on a channel strip param-
eter in the Main Mixer. Alternatively, select “Edit Automation” from the parameter’s context menu.
A new parameter automation lane will be automatically created in the track for the corresponding device or chan-
nel strip. The automated parameter on the device in the rack or channel strip in the Main Mixer will get a green 
border, indicating that it has been automated.

! Note that if a track hasn’t already been created for the device/channel strip, it will be automatically created 
during this operation.

Other ways of creating/adding a parameter automation lane are as follows:
1. Click on the “Track Parameter Automation” drop-down list at the top of the Track List.

2. Select the parameter you want to automate from the list.
A new parameter automation lane is automatically created on the selected track.

If you click the Track Parameter Automation drop-down list again, any selected parameters will have a symbol to 
the left of the parameter name, indicating that an automation lane already exists for the parameter.

The automated parameters on the device in the rack or channel strip in the Main Mixer will get green borders, in-
dicating that they have been automated.

Alternatively, if you want to automate several parameters in one go:
1. Select “Parameter Automation” from the Edit menu or the context menu.

The Track Parameter Automation dialog opens up.

D If the parameters you want to automate aren’t visible in the dialog, uncheck the “Show Frequently Used Only” 
box to view all available device parameters that can be automated.
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2. Place a tick in the boxes for the parameters you want to automate and click OK.

3. One parameter automation lane for each of the selected parameters will show up on the track.
The automated parameters on the device in the rack or channel strip in the Main Mixer will get green borders, in-
dicating that they have been automated.

Creating a pattern lane

For pattern based devices such as the Redrum Drum Module and Matrix Analog Pattern Sequencer, a single pattern 
lane can be created on a selected track. Do either of the following:

D Click the “Create Pattern Lane” button at the top right of the Track List.

D Select “Create Pattern Lane” from the Edit menu or from the context menu.

D Hold down [Alt](Win) or [Option](Mac) and click on the “Pattern” button section of the device in the rack.

D Right-click (Win) or [Ctrl]-click (Mac) on the “Pattern” button section of the device in the rack and select “Edit 
Automation” from the context menu.

When you create a pattern lane, the bank buttons on the device in the rack get a green border to indicate that they 
have been automated.

D Clicking the Pattern and/or Bank buttons on the device during recording will automatically create a pattern 
lane. See “Recording pattern automation” for more details.

Deleting lanes

Deleting note lanes

A note lane can be deleted as follows:

D Click the “Delete Note Lane” (X) button on the lane tab in the Track List.
This will delete the lane (and all clips on it). If there are clips on the lane, a dialog appears prompting you to confirm 
deletion.

D To delete the lane without the dialog, hold down [Ctrl](Win) or [Cmd](Mac) and click the Delete Note Lane but-
ton.

Deleting parameter automation lanes

There are a number of different ways of deleting a parameter automation lane:

D Click the “Delete Automation Lane” (X) button on the lane tab in the Track List.
This will delete the lane (and all clips on it). If there are clips on the lane, a dialog appears prompting you to confirm 
deletion.

D To delete the lane without the dialog, hold down [Ctrl](Win) or [Cmd](Mac) and click the Delete Automation 
Lane button.
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Another way is this:

D Right-click (Win) or [Ctrl]-click (Mac) on the automated device parameter in the rack and select “Clear Automa-
tion” from the context menu.
The green border around the device parameter disappears and the corresponding parameter automation lane is 
deleted from the track.

Alternatively, do the following:
1. Select a track by clicking on it.

2. Click on the “Track Parameter Automation” drop-down list at the top of the Track List.

3. De-select the parameter you want to delete from the list.
All selected parameters will have a symbol to the left of the parameter name in the list indicating that it has been 
selected. Selecting a parameter with a symbol in the list will automatically delete the corresponding lane, with its 
clips, from the track. If there are clips on the lane, a dialog appears prompting you to confirm deletion.

The green borders that surrounded the automated parameters on the device/channels strip will also be removed.

Alternatively:
1. Select a track by clicking on it.

2. Select “Parameter Automation” from the Edit menu or from the context menu.
The Track Parameter Automation dialog opens up.

3. Uncheck the checked boxes for the parameter automation lanes you want delete and click OK.
The corresponding parameter automation lanes, with their clips, will be removed from the track. If there are clips on 
the lane, a dialog appears prompting you to confirm deletion. The green borders that surrounded the automated 
parameters on the device/channels strip will also be removed.
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Deleting pattern lanes

There are two ways of deleting a pattern lane:

D Click the “Delete Pattern Lane” (X) button on the lane tab in the Track List.
This will delete the lane (and all clips on it). If there are clips on the lane, a dialog appears prompting you to confirm 
deletion.

D To delete the lane without the dialog, hold down [Ctrl](Win) or [Cmd](Mac) and click the Delete Pattern Lane 
button.

Alternatively:

D Right-click (Win) or [Ctrl]-click (Mac) on the automated pattern section on the device in the rack and select 
“Clear Automation” from the context menu.
The green border around the device pattern section disappears and the corresponding pattern lane is deleted from 
the track.

Moving note lanes
A note lane has a “handle” and can be moved vertically together with all clips on the lane. Move a note lane to another 
position on the same track like this:
1. Click on the lane handle (the leftmost area of the lane).

2. Drag the note lane up or down and release at the desired destination.
Just as when moving tracks, a red insertion line is shown indicating where the note lane will be placed after you re-
lease the mouse button.

• It is also possible to move note lanes, with their clips, between tracks.

! Parameter automation lanes and pattern lanes cannot be moved since they are tightly connected with their as-
sociated devices However, you can move or copy clips from one lane to another.

Copying (duplicating) note lanes
You can copy (duplicate) one note lane at a time, together with its clips, by doing the following:
1. While pressing [Ctrl](Win) or [Option](Mac), click and drag a copy of the note lane to the desired destination.

The cursor gets a + sign next to it to indicate duplication. The destination of the duplicated note lane could be the 
same track or another track.

2. Release the mouse button.

! Parameter automation lanes and pattern lanes cannot be duplicated.
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Muting lanes

Muting a note lane

D To mute a note lane, click its “M” (Mute) button.

The note lane “M” (Mute) button

Muting a parameter automation lane

D To mute a parameter automation lane, click its “On” button so that it goes dark.

The parameter automation lane “On” button

Clip basics
Only the basic properties and functions pertaining to clips are described here. See “Arranging in the Sequencer” for 
in-depth details about what you can do with clips.

Clip types
Here are the different clip types:

• Note clips contain note events with velocity values. Note clips can also contain performance controller events.

• Parameter automation clips contain events for an automated device/channel strip parameter.
A parameter automation clip can easily be distinguished by the shape of its frame: the top right corner is “cut off”.

• Audio clips contain mono or stereo audio recordings.

• Pattern automation clips contain device bank+pattern number.

Parameter automation clip 
with automation events

Note clip with note and per-
formance controller events

Audio clip with audio 
recording (stereo or mono)

Pattern automation clips
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Toolbar details

The Sequencer Toolbar can be found to the top left in the Sequencer Area. From the Sequencer Toolbar you can se-
lect various sequencer editing tools.

Toolbar tools

Selection Tool

The Selection (arrow) Tool is the main tool for selecting and moving tracks, note lanes, clips and events and record-
ings in clips. It’s also used for resizing clips and events in clips. It is selected by default when a song is opened.

D You can also select the Selection Tool by pressing [Q] on the computer keyboard.

D Press [Alt](Win) or [Cmd](Mac) to momentarily switch from the Selection Tool to the Pencil Tool - or to the Cut 
(Razor) Tool when editing an open audio clip on the Edit Pane.

Pencil Tool

The Pencil Tool is used for manually drawing clips and events in clips. It can also be used to edit the velocity values 
of notes in open note clips.

D You can also select the Pencil Tool by pressing [W] on the computer keyboard.

D Press [Alt](Win) or [Cmd](Mac) to momentarily switch from the Pencil Tool to the Selection Tool.

Eraser Tool

The Eraser Tool is used for deleting clips and events.

D You can also select the Eraser Tool by pressing [E] on the computer keyboard.

D Press [Alt](Win) or [Cmd](Mac) to momentarily switch from the Eraser Tool to the Pencil Tool.

Razor Tool

The Razor Tool is used for splitting clips - and for creating cuts when comping audio clips in Edit Mode.

D You can also select the Razor Tool by pressing [R] on the computer keyboard.

D Press [Alt](Win) or [Cmd](Mac) to momentarily switch from the Razor Tool to the Pencil Tool - or to the Selec-
tion Tool when editing an open audio clip on the Edit Pane.
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Mute Tool

The Mute Tool is used for muting clips in the arrangement.

D You can also select the Mute Tool by pressing [T] on the computer keyboard.

D Press [Alt](Win) or [Cmd](Mac) to momentarily switch from the Mute Tool to the Razor Tool.

Magnifying Glass Tool

The Magnifying Glass Tool lets you zoom in and out both horizontally and vertically on the Arrangement Pane. The 
Magnifying Glass Tool offers a couple of possibilities:

D To zoom in with the Magnifying Glass Tool, click in the Arrangement Pane where you want the origin of mag-
nification.

D To zoom out with the Magnifying Glass Tool, hold down [Ctrl](Win) or [Option](Mac) and click.
You’ll notice that the “+” sign in the Magnifying Glass Tool changes to a “-” sign.

D You can also click and drag with the Magnifying Glass Tool to create a selection rectangle.
The view will then be zoomed in so that the selected area fills the entire Arrangement Pane.

D You can also select the Magnifying Glass Tool by pressing [Y] on the computer keyboard.

D Press [Alt](Win) or [Cmd](Mac) to momentarily switch from the Magnifying Glass Tool to the Hand Tool.

q It’s also possible to zoom in the Arrangement Pane by using the Sequencer Area Navigators as described in 
“Zooming in the Sequencer”.

Place the Magnifying Glass Tool in 
the Arrangement Pane and click.

After three clicks, the Arrangement Pane 
looks like this. The magnification is equal 
in vertical and horizontal directions

Place the Magnifying Glass Tool 
on the Arrangement Pane, click 
and drag to create a selection.

After releasing the mouse button, the zoomed selection fills up the 
Arrangement Pane. The magnification can be different in vertical and 
horizontal directions depending on the shape of the selection rectangle.
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Hand Tool

The Hand Tool is used for scrolling in the Edit/Arrangement Pane.

D Select the Hand Tool and click anywhere in the Edit/Arrangement Pane, keep the mouse button depressed 
and drag to desired view.

D You can also select the Hand tool by pressing [U] on the computer keyboard.

D Press [Alt](Win) or [Cmd](Mac) to momentarily switch from the Hand Tool to the + Magnifying Glass Tool.

D Press [Ctrl]+[Alt](Win) or [Cmd]+[Option](Mac) to momentarily switch from the Hand Tool to the - Magnifying 
Glass Tool.

q It’s also possible to scroll in the Edit/Arrangement Pane by using the Sequencer Area Navigators as described 
in “Scrolling with the Navigators”.

Alternate tools
For every tool mode described earlier, there is a so called alternate tool that can be momentarily selected by holding 
down [Alt](Win) or [Cmd](Mac) on the computer keyboard. Below is a summary of the alternate tools:

| Selected tool | Alternate tool

Selection tool Pencil tool

Pencil tool Selection tool

Eraser tool Pencil tool

Razor tool Pencil tool (Selection Tool when editing open audio 
clip on the Edit Pane)

Mute tool Razor tool

Magnifying Glass tool Hand tool

Hand tool + Magnifying Glass tool

Hand tool - Magnifying Glass tool by pressing [Alt]-[Ctrl](Win) or 
[Option]-[Cmd](Mac)
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Snap

The Snap function in the sequencer toolbar is used for “restricting” editing of clips and events to a user-selectable 
note value grid. When moving clips or events, the Snap function always works relative to the original position(s) of the 
clip(s) or event(s).

D Select the grid you wish to snap to by selecting the note value from the drop-down list:

D Activate the Snap function by pressing [S], or by placing a tick in the Snap checkbox:

! Note that you can select different Snap values for selected clips and for open clips (see “About separate Snap 
values for selected clips and for open clips”).

The Snap function effects the following operations:

• Moving the Song Position Pointer, Loop Locators and Song End Marker.
When you adjust the Locators with Snap activated, they will snap to the selected Snap value on an absolute grid.

• Moving clips and events, recordings and Comp Row cuts.
When you move objects with Snap activated, they will keep their relative distance to the Snap value positions.

• Drawing clips.
When you create clips with the Pencil tool, their start and end positions will snap to the selected note value posi-
tions on an absolute grid.

• Drawing events in open clips.
The Snap value determines the absolute grid points on which you can draw a note or an automation point. The 
Snap value also determines the shortest possible note length that you can draw.

• Splitting clips with the Razor tool.
The Snap value determines the absolute grid to which a clip can be split.

• Nudging clips, events and recording.
When you nudge clips, events or recordings with Snap activated, they will keep their relative distance to the Snap 
value positions.

• Creating Comp Row cuts
The Snap value determines the absolute grid to which you could add cuts in open audio clips.
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About separate Snap values for selected clips and for open clips

There are two different Snap settings, one for when a clip is open for editing in Edit Mode, and one for when no clip 
is open (e.g. in Arrange Mode). Typically, you would set a fine Snap value (e.g. 1/16) for open clips in Edit Mode and 
have the other Snap value set to “Bar” for convenient clip arranging in Arrange Mode. You can also choose to turn 
Snap off in either of these modes, independently of the other setting.

• The Snap value for editing is used whenever a note clip or automation clip is open (including when an automa-
tion clip is opened in Arrange Mode).
However, there’s one exception: If a note clip is open in Edit Mode and you click in the Clip Overview (see “Edit 
Mode elements”), the clip will remain open but the Snap value for arranging will be selected. This allows you to e.g. 
move or resize the clip in the Clip Overview just like in Arrange Mode, without closing it first.

Sequencer Toolbar keyboard shortcuts
Below is a complete list of the computer keyboard shortcuts for selecting tools on the sequencer Toolbar:

Ruler details
The Ruler is the song’s time line. In the Ruler, the Song Position Pointer indicates the current position in the song, i.e. 
in which bar the song is, or will start, playing. The Ruler also shows the Left (L) and Right (R) Loop Locators as well 
as the Song End Marker (E).

You can change the positions of the Song Position Pointer, Locators and Marker in the Ruler by clicking and drag-
ging them to desired positions in the Ruler. Note that you have to click and drag the “flags” in the Ruler - not the lines. 
The Song Position Pointer and Loop Locators can also be moved by typing in new positions in the respective Position 
displays in the Sequencer Transport Panel (see “Song Position” and “Left and Right Locator Position”). Another way 
of moving the Song Position Pointer is by using the Rewind and Fast Forward controls on the sequencer Transport 
Panel (see “Rewind and Fast Forward”).

| Function | Key command

Selection tool select [Q]

Pencil tool select [W]

Eraser tool select [E]

Razor tool select [R]

Mute tool select [T]

Magnifying Glass tool select [Y]

Hand tool select [U]

Snap On/Off [S]

Left (Loop) Locator

Song Position Pointer

Right (Loop) Locator

Song End Marker
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Transport Panel details
At the bottom of the Reason Essentials window is the sequencer’s Transport Panel. From here you control the se-
quencer transport functions. You can also set tempo, time signature and various other parameters.

Click On/Off

D Click this button to hear an audible metronome click as the sequencer plays.
The click will sound on every beat, with the first beat in every bar accented (higher pitched). See “Click and Pre-
count” for more details.

Pre(-count) On/Off

D Click the Pre button to hear a pre-count (count-in) click sound before recording. 
Pre-count will only be present before recording - not before regular playback. See “Click and Pre-count” for details 
about selecting number of pre-count bars etc.

Click Level

D Adjust the audio level of the metronome (and Pre-count) click by turning this knob.
See “Click and Pre-count” for more details.

Tap Tempo

Instead of setting the Tempo with the Tempo control (see below), you can manually tap in the desired tempo in real-
time.

D Click the Tap Tempo button repeatedly to set desired sequencer tempo.
The tempo is defined by averaging the time between a minimum of two clicks and a maximum of 16 clicks. The 
more clicks, the more “steady” the tempo. The time-out between two series of clicks is 2 seconds. The detectable 
tap tempo range is 30-999.999 BPM.

Song Position

The current song position is shown in the display. The song position is where the Song Position Pointer in the Ruler 
(see Ruler details) is at the moment. The display is divided into Bars, Beats, 1/16th Note and Ticks (there are 240 
Ticks for each 16th note) segments. You can edit the position of the Song Position Pointer, and thus change the 
song playback position, according to the descriptions in “Transport Panel segment displays”.

Tempo

Click On/Off

Pre-count Click On/Off

Click Level

Signature

Song Position

Time Rewind

Fast Forward

Stop
Play

Record

New Overdub

New Alternative take

Loop On/Off

Left Locator Pos

Right Locator Pos

Go to Right 
Locator

Go to Left Locator

Tap Tempo

Q Rec
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About subticks in the Song Position display

When editing notes and automation events in the sequencer you have a resolution of 240 ticks per 1/16th note, 
which allows for very accurate positioning. But for the Song Position Pointer, the internal resolution is even higher 
(15360 ppq) which means that the position can end up on a fraction of a tick, a so called subtick.

If the Song Position Pointer value is on a fraction of a tick, this is displayed with an asterisk (*) in the Tick section of 
the Song Position display.

D To adjust the Song Position Pointer to the closest tick value, press [Ctrl](Win) or [Cmd](Mac) and click on the 
asterisk in the display.
The Song Position Pointer will now adjust to the closest tick value and the asterisk disappears.

Time

The current position of the Song Position Pointer in the Ruler (see Ruler details) is shown in time format (hours, min-
utes, seconds and milliseconds) in the display. You can change the position in time of the Song Position Pointer, and 
thus change the song playback time position, according to the descriptions in “Transport Panel segment displays”.

Tempo

The current song tempo is shown in the display in BPM (Beats Per Minute) and 1/1000 of a BPM. You can edit the 
tempo according to the descriptions in “Transport Panel segment displays”. The Tempo range is 1.000-999.999 
BPM.

Signature

The current song time signature is shown in the display. You can edit the time signature according to the descriptions 
in “Transport Panel segment displays”. 

The available Signatures are: 1/2-16/2, 1/4-16/4, 1/8-16/8 and 1/16-16/16.

Rewind and Fast Forward

D Click on the Rewind or Fast Forward buttons to move the Song Position Pointer in steps of one bar (from its 
current position).

D To move the Song Position Pointer several bars at once, click and hold the mouse button depressed.

Instead of clicking the buttons, you can use the computer keyboard: 

D Press [4] on the numeric keypad for Rewind and [5] for Fast Forward.

D If you click and hold the Rewind or Fast Forward buttons, or press and hold the [4] or [5] keys, the positioning 
speed will be faster after the first 20 bars.

Play and Stop

D Click the Play button to start playback from the Song Position Pointer’s current position.

D Alternatively, press [Enter] on the numeric keypad on the computer keyboard.

D Click the Stop button to stop playback (or recording). 

D Alternatively, press [0] on the numeric keypad or [Shift]+[Return] on the computer keyboard.
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If you click the Stop button, or use the keyboard “Stop” commands, when the song is already stopped, the Song Po-
sition Pointer is moved according to the following rules:

• Clicking/pressing Stop the first time moves the Song Position Pointer to where playback was last started.

• Clicking/pressing Stop a second time moves the Song Position Pointer to the beginning of the song.

• If the Song Position Pointer already is at the beginning of the song, nothing happens.
This means you can always click twice on the Stop button in “stop mode”, to return to the beginning of the song.

D Press [Spacebar] on the computer keyboard to toggle between Play and Stop.

Record

D Click the Record button to begin recording on the selected track/lane in your song. 
Alternatively, press [*] on the numeric keypad or hold down [Ctrl](Win) or [Cmd](Mac) and press [Return] on the 
computer keyboard. If Pre-count has been activated (see Pre(-count) On/Off above), the recording will begin after 
the set number of pre-count bars.

! Nothing you play during the pre-count period will be recorded.

Dub and Alt

Clicking on any of these buttons will add additional audio tracks or note lanes for overdub purposes. Refer to “Over-
dubbing audio using the “Dub” function” and “Recording notes using the “Dub” and “Alt” functions” for more details 
about these functions.

Q Rec

D Click the Q Rec (Quantize during Recording) button to quantize notes as they are being recorded.
When the Q Rec button is on, all recorded MIDI notes will be quantized to the currently selected quantization grid. 
Refer to “Quantizing notes” for more information on quantization.

Loop On/Off

D Click the Loop button or press [L] to activate the Loop function.

When the loop function is activated, recording and playback will be continuously looped between the Left and Right 
Locators. Some general rules regarding loop mode are these:

• If the Song Position Pointer is to the left of (before) the Right Locator when playback is started, the song will 
play to the Right Locator and then immediately jump back and seamlessly continue from the Left Locator.

• If the Song Position Pointer is to the right of (after) the Right Locator when playback is started, the Locators 
will be ignored and the song will continue to play “un-looped”.

• If the Left Locator is to the right of the Right Locator, i.e. in “reversed” order, the song will play to the Right Lo-
cator and then immediately jump and seamlessly continue from the Left Locator, skipping the part of the song 
in-between the Locators. The song will then continue to play “un-looped”.

Left and Right Locator Position

The current positions of the Left and Right Locators in the Ruler (see Ruler details) are shown in the displays. The 
display is divided into Bar, Beat, 1/16th Note and Ticks (there are 240 Ticks for each 1/16th Note). You can change 
the positions of the Locators, and thus change the loop playback region, according to the descriptions in “Transport 
Panel segment displays”.
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Go to Left and Right Locators

D Click on the “L” or “R” button to move the Song Position Pointer to the Left or Right Locators respectively. 

D Alternatively, press [1] on the numeric keypad on the computer keyboard to move the Song Position Pointer to 
the Left Locator or [2] to move to the Right Locator.

Transport keyboard commands
Below is a complete list of the computer keyboard shortcuts for the Sequencer Transport functions:

! If you are using ReWire for remote controlling Reason Essentials, the transport functions can be handled by ei-
ther application. See “ReWire” for details.

| Function | Key command

Stop, Go to start position, 
Go to start of song

[0] on the numeric keypad or [Shift]+[Return]

Play [Enter] on the numeric keypad

Toggle Stop/Play [Spacebar]

Rewind [4] on the numeric keypad

Fast Forward [5] on the numeric keypad

Record [*] on the numeric keypad or
[Ctrl](Win) or [Cmd](Mac)+[Return]

Go to Left Locator [1] on the numeric keypad 

Go to Right Locator [2] on the numeric keypad

Go to the start of the song [.] on the numeric keypad

Go to next bar [8] on the numeric keypad

Go to previous bar [7] on the numeric keypad

Tempo up [+] on the numeric keypad

Tempo down [-] on the numeric keypad

Loop On/Off [/] on the numeric keypad or [L]

Click On/Off [C] or [9] on the numeric keypad

Pre-count On/Off [Ctrl](Win) or [Cmd](Mac)+[P]

Set the Left and Right Loop Locators to 
encompass selected clips and start play-
back in Loop Mode.

[P]
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About the Inspector

The Inspector, located above the Edit/Arrangement Pane, can be used for a number of different editing purposes 
pertaining to clips, events and recordings. The Inspector is context sensitive, meaning it will have different content 
and functionality depending on what is currently selected. How to edit using the Inspector is described in detail in the 
sections “Resizing clips using the Inspector”, “Moving clips using the Inspector”, “Editing recordings and cuts in the In-
spector” and “Editing notes and events in the Inspector”.

! When the Pencil Tool is selected, the Inspector isn’t visible. Instead, menus pertaining to Time Signature and 
Pattern Automation are displayed.

About subticks in the Position and Length displays
When editing notes and automation events in the sequencer you have a resolution of 960 ppq (240 ticks per 1/16th 
note), which allows for very accurate positioning. But when you record , the internal resolution is even higher (15360 
ppq) which means that notes and automation events can end up on a fraction of a tick, a so called subtick.

If the value is a fraction of a tick, this is displayed with an asterisk (*) in the Tick section of the Position or Length dis-
play.

D To adjust the clip or event position (or length) to the closest tick value, press [Ctrl](Win) or [Cmd](Mac) and 
click on the asterisk in the display.
The position or length value will now adjust to the closest tick value and the asterisk disappears.

! When it comes to audio editing, you will have access all the way down to the sub-tick level. This means there 
won’t be any sub-tick asterisks when editing audio.

About the “Match Values” function

The “Match Values” function in the Inspector can be used to match the positions, lengths and/or values of several se-
lected clips, notes, events or recordings to the position, length and/or value of the topmost (or leftmost) selected clip, 
note, event or recording. Refer to “Matching clips using the “Match Values” function”, “Matching audio values using 
the "Match Values" function” and “Matching notes or events using the “Match Values” function”.

Inspector (context sensitive)
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Chapter 6
Recording in the 
Sequencer
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About this chapter
This chapter describes the different recording techniques that you can use in Reason Essentials. The chapter covers 
both audio, notes and parameter automation recording. Before you read this chapter, it’s recommended that you are 
familiar with the basic sequencer functions and definitions described in the “Sequencer Functions” chapter. A lot of 
functions are common for all types of recording methods. These will be described first in this chapter. Later in the 
chapter we will go into functions specific to audio, notes and parameter automation recording.

General recording functions

Record enabling
Before you can start recording on a track in the sequencer, the track needs to be record enabled. There are two types 
of buttons for record enabling: the Record Enable button, which is used when recording audio clips and note clips, 
and the Record Enable Parameter Automation button, which is used when recording device/channel strip parameter 
automation and tempo automation:

Five tracks with their Record Enable and Record Enable Parameter Automation buttons

Activated Enable Record and Enable Record Parameter Automation buttons are indicated with a red color. Recording 
can be simultaneously enabled on an unlimited number of audio tracks (limited only by the computer’s processing 
and hard disk performance) - plus one note lane on an instrument track. However, if you have locked several MIDI 
keyboard controllers to specific instrument devices in the rack - using Remote (see “Locking a surface”) - you can re-
cord MIDI on these instrument tracks simultaneously. Recording of parameter automation can be simultaneously en-
abled on as many tracks as you like.

Record Enable buttons

Record Enable Parameter 
Automation buttons
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Record enabling an audio track

D To record enable an audio track, click on the Record Enable button on the audio track.
The Record Enable button goes red.

Selecting an audio track will automatically record enable the track if you have selected “Standard” mode in the 
“Master Keyboard Input” section on the “Keyboard and Control Surfaces” page in the Preferences dialog (see “The 
Master Keyboard Input setting”) - and if the Manual Rec button in the Track List is Off, see “About the Manual Rec 
function”.

Also, depending on the setting in the “Monitoring” section on the “Audio” page in Preferences, monitoring of the in-
put signal to the audio track may, or may not, be automatically activated - see “Monitoring”.

Record enabling multiple audio tracks

D If you want to record audio from separate audio inputs on several tracks at once, click the Record Enable but-
tons on all desired audio tracks in the Track List.
Each record enabled audio track will automatically unfold to show the Tuner button, the Select Audio Input drop-
down list and the Input Meter. When recording audio on several tracks simultaneously, it doesn’t matter which au-
dio track has Master Keyboard Input.

Multiple audio tracks record enabled for recording audio on several tracks at once

Record Enable button (On)

Record Enable buttons (On)
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Record enabling an instrument track

D To record enable an instrument track, click on the Record Enable button on a note lane on the instrument 
track.
The Record Enable button lights up red and the track has Master Keyboard Input.

If you have selected “Standard” mode in the “Master Keyboard Input” section on the “Keyboard and Control Sur-
faces” page in the Preferences dialog (see “The Master Keyboard Input setting”), selecting an instrument track will 
automatically set Master Keyboard Input to that track - if the Manual Rec button in the Track List is Off, see “About 
the Manual Rec function”. An instrument track that has Master Keyboard Input will automatically be record en-
abled, and will also be enabled for parameter automation recording, indicated by the red Record Enable Parameter 
Automation button.

D If you want to record on another note lane on the instrument track, just click the corresponding Record Enable 
button on the note lane.

! Only one note lane on one instrument track can have Record Enable active at a time, unless you have locked 
additional MIDI keyboard controllers to specific instrument devices in the rack (see “Locking a surface” in the 
Remote chapter). If you only have one MIDI keyboard controller (assigned as Master Keyboard), you can only 
record notes on one note lane at a time (see “Setting Master Keyboard Input”).

Record enabling several instrument tracks

If you have locked additional MIDI keyboard controllers to specific instrument devices in the rack (see “Locking a sur-
face” in the Remote chapter), the corresponding tracks for all these locked devices are automatically record enabled 
- if the Manual Rec button in the Track List is Off, see “About the Manual Rec function”. These additional record en-
abled tracks are displayed with a keyboard symbol below the device icon in the track list. and their Record Enable 
buttons are also automatically switched on. The track with Master Keyboard Input is still indicated with a red frame 
around its device icon.

The “Combinator 3” track with Master Keyboard Input and the “Combinator 1” and “Combinator 2” tracks controlled from additional 
MIDI keyboards locked to the corresponding devices in the rack.

D To manually enable/disable any additional record enabled instrument tracks that are locked to specific MIDI 
keyboard controllers, click the Record Enable buttons on a note lane on any of these the tracks.

Record Enable buttons

Record Enable Parameter 
Automation button

Record Enable buttons (On)
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About the Manual Rec function

The Manual Rec button in the Track List

The Manual Rec function in the Track List can be used if you don’t want automatic record enabling of a selected 
track. For example, when you are finished recording your audio tracks and want to proceed with recording channel 
strip parameter automation, you probably don’t want the audio tracks to be record enabled for audio.

D Click the manual Rec button to disable automatic record enabling of selected tracks.

The Manual Rec function activated

If you change your mind and want to record audio on an audio track, you have to manually record enable it by click-
ing its Record Enable button as described in “Record enabling an audio track”. Alternatively, switch off the Manual 
Rec button to enable the automatic record enabling again.

! The Manual Rec function affects both audio tracks and instrument tracks.

Record enabling parameter automation

Parameter automation can be recorded on all track types, on one track at a time or on multiple tracks simultaneously.

D Click on the Record Enable Parameter Automation button(s) on the desired track(s) in the Track List to enable 
parameter automation recording.
All tracks enabled for parameter automation recording will be indicated by red Record Enable Parameter Automa-
tion buttons. 

D Setting Master Keyboard Input to a track will also automatically enable parameter automation recording, indi-
cated by the red Record Enable Parameter Automation button.

Record enabling pattern automation

Pattern automation can be recorded on tracks associated with pattern based devices such as the Redrum Drum 
Computer, Dr. Octo Rex Loop Player or Matrix Analog Pattern Sequencer. Enabling pattern automation works in the 
same way as enabling regular parameter automation (see “Record enabling parameter automation”).

! Note that enabling the Record Enable Parameter button on a track featuring a pattern based device will also 
allow automation recording of other device parameters besides the Bank and Pattern select buttons. Any ad-
ditional device parameters will be recorded on separate parameter automation lanes just like with non-pattern 
devices.

The Manual Rec button

The selected track is not automatically 
record enabled anymore

Record Enable Parameter 
Automation button
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Click and Pre-count
During recording and playback it’s possible to have a metronome-style click sound to indicate the tempo of the song. 
In recording mode it’s also possible to have the metronome click sound appear a selectable number of bars before 
the start of the actual recording, a so called pre-count. Activation of click and pre-count are managed on the Trans-
port Panel:

The Click and Pre-count controls on the Transport Panel

Click

D Click the Click button to get an audible metronome click as the sequencer plays. Alternatively, press [C].
The click will sound on every beat, with the first beat in every bar accented (higher pitched).

Pre-count

D Click the Pre button to get a pre-count (count-in) click sound before the recording starts. Alternatively, press 
[Ctrl](Win)/[Cmd](Mac)+[P]
Pre-count will only be present before you record - not when you start regular playback.

D Select the number of pre-count bars by choosing “Number Of Precount Bars” in the Options menu.
You can choose between 1 to 4 bars.

Selecting number of pre-count bars

q Feel free to experiment with different pre-count settings. For up-tempo (faster) songs it’s generally more con-
venient to have a little longer pre-count (3 or 4 bars) whereas for slower songs it’s often sufficient with 1-2 
bars.
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Click Level

Adjust the audio level of the metronome click (and pre-count click) by turning the knob.

! Note that since the click sound is also routed via the selected audio card/interface on your computer - but not 
through the Reason Essentials mixer - the click sound will be summed to the rest of the sounds playing in your 
song. A high Click Level setting could therefore cause the Audio Output Meter on the Transport Panel, and the 
“Big Meter” in the Reason Essentials Hardware Interface, to indicate clipping. If this should occur, either lower 
the Click Level or deactivate Click to determine if it’s the click sound or the recorded sounds that cause clip-
ping.

Loop mode
In loop mode, the song is automatically looped between the Left and Right Loop Locators on the Edit/Arrangement 
Pane during playback and/or recording:

Loop mode activated by clicking the Loop button on the Transport Panel

The behavior when recording in loop mode differs depending on what you’re recording - audio, MIDI or parameter au-
tomation. Refer to “Recording audio in Loop mode”, “Recording notes in Loop mode” and “Recording parameter au-
tomation in Loop mode”.
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General recording procedure
The following description applies to all types of recording: audio, MIDI and parameter automation. For specific details 
of audio, MIDI and parameter automation recording, refer to “Recording audio”, “Recording notes”, “Recording perfor-
mance controller automation” and “Recording parameter automation”.
1. If desired, select Click and/or Pre-count according to the descriptions in “Click and Pre-count”.

2. Move the Song Position Pointer to the position in the Ruler where you want to start your recording (see “Ruler 
details”).

3. Click the Record button on the Transport Panel. Alternatively, press [*] on the numeric keypad, or hold down 
[Ctrl](Win) or [Cmd](Mac) and press [Return].
The Record button turns red. If Pre-count is enabled, wait for the set number of pre-count bars before starting to 
record audio, MIDI or parameter automation. During pre-count, nothing will be recorded.

During pre-count, only the Record button is active (red) and nothing will be recorded.

4. Start recording on the track.
As the recording begins, the Play button on the Transport Panel goes dark while the Record button remains red.

During recording, both the Play and Record buttons are active and any input data will be recorded.

If the lane is currently empty, a new clip is automatically created on the record enabled lane on the track. As the re-
cording progresses, the clip expands following the Song Position Pointer. The clips are shaded in red during re-
cording according to the picture below:

5. When you’re done recording, click the Stop button on the Transport Panel. Alternatively, press [Spacebar], [0] 
on the numeric keypad, or hold down [Shift] and press [Return].
The Record and Play buttons turn grey, the Song Position Pointer stops and the red shading of the clip(s) disap-
pears. The clip(s) show the recorded events as different types of graphical objects, depending on clip type.

! If nothing was recorded in a note clip, clicking Stop will automatically remove the empty note clip.

A note clip being recorded

An audio clip being recorded
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Undoing a recording
D If you’re not satisfied with the finished recording, you can select “Undo Record Track” from the Edit menu or 

select the clip on the Edit/Arrangement Pane and press [Delete] or [Backspace].
This will delete the clip and its contents.

Undoing while recording a note clip

D If you’re not satisfied with your ongoing recording of a note clip, press [Delete] or [Backspace].
This will delete the current note clip and all its contents and at the same time create a new clip starting at the cur-
rent song position. The sequencer will continue recording during the entire process.

! Note that this only works when recording note clips.

Recording tips

Lowering the Tempo during recording

If you are going to record complex/difficult takes, a good suggestion is to lower the song tempo during recording and 
then speed up the song to normal tempo again during playback. For audio tracks, Reason Essentials features very 
sophisticated functions for audio stretching. Audio stretch enables you to alter the song tempo up or down without 
changing the pitch of the recorded audio. See “About tempo changes and tempo automation of audio tracks” for 
more details. 

When recording MIDI, just lower the tempo when recording the difficult parts and speed up to normal tempo during 
playback.

Audio recording details

Setting up the audio track

Selecting audio input(s) and defining mono or stereo

D Select audio input(s) for the track from the Audio Input drop-down list.

Selecting audio inputs for the Audio Track

At the top of the drop-down list you can select whether you want to use mono or stereo inputs. Depending on your 
selection, the LED meter switches to a stereo or mono display. Further down in the drop-down list you can select 
the audio interface input(s) you want to use for the track.

• When you are using the Propellerhead Balance audio interface, selecting any of its input channels in the drop-
down list will automatically switch on the corresponding Ready LEDs on the Balance front panel. Also, if you 
have selected “Mono Input” in the Audio Input drop-down list, the Audio Track will show a CS (Clip Safe) sym-
bol to the right of the LED meter.



RECORDING IN THE SEQUENCER124

Setting input level(s)

Before you start recording audio on the track it’s important to set correct input level(s). The input signal should be 
loud enough to minimize noise and provide high quality, but not so loud that it causes clipping and distortion.

If you’re using a 24-bit audio interface (recommended), aim at having the level of the input signal around -12dB on 
the track Input Meter according to the picture below. For 16-bit audio interfaces you may want to raise the level an-
other couple of dB’s.

q To get a better view of the input levels, use the separate Recording Meter Window, see “The Recording Meter 
Window”.

! If you are using the Propellerhead Balance audio interface you can use the special Clip Safe function to protect 
your recordings from accidental audio input clipping, see “Recording using the Clip Safe function in Propeller-
head Balance”.

! Always adjust the input level at the source (e.g. the preamp connected to, or built-in in the audio interface).

! If the input signal level should exceed 0dB (red clipping LEDs to the right) on the track Input Meter at any time 
during recording, there could be audible distortion in the recording:

If the input level should clip, at any time, the red clipping LED(s) in the Input Meter will be constantly lit until you click 
on the Input Meter. This is to notify that there is, or has been, too loud an input signal present on the track.

! The input level cannot be adjusted using the Channel strip controls in the Main Mixer. The Channel strip con-
trols are used only for adjusting the level and characteristics of the monitored signal and/or the playback sig-
nal of an existing recording on the track.

Using the Clip Safe function with Propellerhead Balance

! Note that the Clip Safe function only works together with the Propellerhead Balance audio interface.

If you use the Propellerhead Balance audio interface together with Reason Essentials, you will have access to the 
Clip Safe function. The Clip Safe function lets you record a mono signal with an additional “invisible” headroom. This 
is done by using both AD converters in Propellerhead Balance for the same mono signal, with the second AD con-
verter dedicated to the additional headroom.

When recording with the Clip Safe function, Reason Essentials records the mono signal in parallel using both AD 
converters. The original AD converter records the signal at normal level and the second AD converter records the 
same signal “padded” at a lower level.

In practice this means that if the input signal should exceed the normal 0dB clipping level during recording, the pro-
gram will allow you to use the “padded” signal from the second AD converter and replace the clipped/distorted audio. 
The padded signal will be amplified in Reason Essentials so that its level accurately reflects the original recording 
level. In other words, the resulting signal will be just as loud as the original signal - but without any clipping or distor-
tion.

“Safe” input level ~ -12dB
(first yellow LEDs lit)

Audio clipping LED = distortion
(Clipping LED lit)
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Proceed as follows to activate the Clip Safe function:
1. Select “Mono Input” in the Audio Input drop-down list on the Audio Track and then select either “Balance 1/L” 

or “Balance 2/R”.

The CS (Clip Safe) symbol appears to the right of the level meter on the Audio Track.

2. Press the Clip Safe button on the Propellerhead Balance front panel.

The Clip Safe button on the Propellerhead Balance audio interface

A Clip Safe request signal is sent from the Balance interface to Reason Essentials. Depending on what audio in-
puts are selected on the record enabled Audio Track(s), the following happens:

• If the Balance 1/L or 2/R input is selected as audio input (Mono) on one single record enabled Audio Track, the 
Clip Safe LED on the Balance interface turns green and the CS symbol on the Audio Track is lit.
When the Clip Safe LED on the Propellerhead Balance audio interface is green, the Clip Safe function is enabled. 
If the 1/L input is selected as audio input (Mono), the Right channel on the Balance interface is used for the ad-
ditional headroom, and vice versa.

• If the Balance 1/L and 2/R inputs are selected as Stereo Input, the Clip Safe function is disabled and the Clip 
Safe LED on the Balance interface turns red. The CS symbol on the Audio Track also disappears.
The Clip Safe function requires both inputs to be available. Also, if the Balance 1/L (mono) and 2/R (mono) inputs 
are selected as audio inputs on other record enabled Audio Tracks, the Clip Safe function is disabled.

See “Recording using the Clip Safe function in Propellerhead Balance” for more information about using the Clip 
Safe function.

Monitoring

Monitoring means listening to the input signal of an audio track. Monitoring works according to the following princi-
ples:

• By default, monitoring is automatically enabled as soon as an audio track is record enabled.
This makes it possible to hear what you will be recording - before and during recording to disk.

• During playback of an audio track, monitoring is automatically disabled.
During playback, you will only hear the recorded signal - not any input signal.

q Note that you can manually activate or deactivate monitoring for a track by clicking the Monitor button on the 
Audio Track.

The input signal is monitored after the Channel strip and Master Section in the Main Mixer which means that all mixer 
parameters, including any Insert Effects, Dynamics etc., will also be applied to the monitored signal.
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! Note that the Main Mixer parameters will only affect the monitored (and/or played back) signal - they will not 
affect the signal being recorded on the Audio Track.

Depending on the technical specifications and/or settings in your hardware audio interface, the latency of the moni-
tored input could become a problem. If this is the case, it’s probably better to monitor the input signal before it 
reaches the Reason Essentials program, i.e. directly on the external audio interface/mixer/preamp. If you don't want 
to monitor through the Reason Essentials program you should select "External" or “Manual” in the Monitoring section 
on the Audio tab in the Preferences dialog:

D Select “Automatic” to select automatic monitoring of the Audio Track in Reason Essentials.
Each time you select and/or record enable an Audio Track in the Track List, monitoring in Reason Essentials will 
be automatically enabled. It’s possible to manually disable monitoring in this mode if you like.

D Select “Manual” to manually select if monitoring should be on or off.
This mode should be selected if you prefer to have manual control over monitoring, or when you are monitoring 
through external mixer or audio interface. In the latter case, you would select "Manual" mode and just don't click 
any monitor buttons.

D Select “External” to deselect automatic monitoring of the Audio Track in Reason Essentials.
When you select and/or record enable an Audio Track in the Track List, monitoring in Reason Essentials will be 
automatically disabled. It’s not possible to manually enable monitoring in this mode.

Using the Tuner

An audio track also features a built-in tuner function. The Tuner detects and displays the input pitch of a connected 
instrument - an electric guitar, for example.
1. Click the “Enable Tuner” button below the device icon to switch to Tuner mode. 

The Input Meter switches to a Tuner.

An audio track in Tuner mode

2. Play a note on the connected instrument and watch the Tuner. 
When the input pitch is detected, the Tuner lights up and indicates how far the pitch is from the displayed note 
value to the right of the Tuner. The center LED on the Tuner Meter indicates a perfectly tuned note pitch. The 
green arrow LEDs on either side of the Tuner Meter indicate how the connected instrument should be tuned. The 
left arrow LED means raise the pitch and the right means lower the pitch.

! Note that the input note needs to sustain for a little while before the pitch can be detected.

The “Monitoring” section 
on the Audio tab in the 
Preferences dialog
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The Recording Meter Window

The main purpose of the Recording Meter floating window is to provide a good overview of recording levels and/or 
tuner values when you are located some distance away from the computer screen. The Recording Meter mirrors the 
information from the input level meter and Tuner of the currently selected record enabled Audio Track.

D Toggle the Recording Meter window on and off by pressing [F3] or by selecting “Show/Hide Recording Meter” 
from the Windows menu.

D If you are using the Propellerhead Balance audio interface you can also press the Meter/Tuner button on the 
front panel to toggle the Recording Meter window on and off:

The Meter/Tuner button on the Propellerhead Balance audio interface

D Move the Recording Meter window by clicking on the window background and then dragging.

D If you have manually record enabled several Audio Tracks in the sequencer, you can choose which track to dis-
play in the Recording Meter window by clicking the right/left arrows on either side of the Audio Track name.
By default, the first record enabled Audio Track in the sequencer is displayed in the Recording Meter window.

D Click the pitchfork symbol in the Recording Meter window to bring up the Tuner for the selected Audio Track.
A large Tuner display is shown at the bottom of the Recording Meter window. 

See “Using the Tuner” for more information about the Tuner.
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Recording audio
! To minimize the song saving time, we strongly recommend saving the song before recording many or large au-

dio recordings.

1. Set up the audio track according to the descriptions in “Setting up the audio track”.

2. Record the track according to the descriptions in “General recording procedure”.

3. When the recording is finished, the audio clip on the track shows the recorded audio as one or two continuous 
waves inside the clip, depending on whether the input was in mono or stereo:

An audio clip with a stereo audio recording

Recording using the Clip Safe function in Propellerhead Balance

If you are recording using the Propellerhead Balance audio interface, you can utilize the Clip Safe function to protect 
your recordings from any accidental input signal clipping. The program can then take care of and heal any input sig-
nals that accidentally exceed 0dB.

See “Using the Clip Safe function with Propellerhead Balance” for more details.

! Note that the Clip Safe function can only be used when recording in mono (single audio input) and only on one 
record enabled Audio Track at a time.

Proceed as follows to set up and activate the Clip Safe function:
1. Select the desired Audio Track for recording.

2. Select audio input in the drop-down list.

! Note that you can only select the Balance In L or R (Mono Input) for the Clip Safe function to be available.

3. Press the Clip Safe button on the Balance front panel.
The Clip Safe LED on the Propellerhead Balance audio interface turns green. The CS indicator to the right of the 
input level meter on the Audio track is lit:

The Clip Safe LED on the Propellerhead Balance interface and the CS indicator on the Audio Track

4. Record the track according to the descriptions in “General recording procedure”.

Audio clip with stereo 
audio events

Clip Safe LED on
CS indicator on
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! We strongly recommend that you aim at -12dB maximum recording level, even if you are using the Clip Safe 
function. Recording high input levels will result in very loud audio on the track, which could be problematic to 
mix with the rest of the instrument tracks in your song.

When the Clip Safe function is active, the Input Meter on the Audio Track, as well as the level meter in the Record-
ing Meter window get their red LEDs replaced by yellow ones. The Recording Window also gets a Clip Safe sym-
bol to the upper right:

The Input Meter on the Audio track and the Recording Meter gets yellow LEDs instead of red ones.

5. When the recording is finished, the audio clip on the track shows the recorded audio as a continuous wave in-
side the clip.
The red vertical line(s) at the top of the of the audio clip indicate that Clip Safe was activated since the input level 
exceeded 0dB. The selected audio clip also gets an additional Heal (CS) button on its upper right hand side:

Audio recorded with the Clip Safe function active

6. Play back the track and hear where the signal clips.
You should hear this when the playhead passes over the red vertical line(s) in the audio clip. Sometimes, though, 
if the clipping is moderate it might not be audible.

7. To permanently heal the audio clip and use the Clip Safe audio in the recording, click the Heal (CS) button to 
the upper right-hand side of the audio clip. Alternatively, select “Heal Clip Safe Clips” from the Edit menu or 
audio clip context menu.
Now, the clipped/distorted audio have been replaced by the “padded” Clip Safe audio and the recording should 
not clip or distort anymore. The area above the audio clip disappears, as does the Heal (CS) button. 

q If you like, you can zoom out using the Waveform Zoom Level buttons to view the resulting waveform in its en-
tirety in the Audio Clip (see “Waveform Zoom Mode”).

D The healing operation can also be performed on several selected audio clips in one go. Just select the desired 
clips and click a Heal (CS) button on one of the clips.

D If you want to remove the Clip Safe parts and keep the clipped/distorted parts, just undo the healing operation 
using the standard [Cmd](Mac)/[Ctrl](Win)+Z command.

D If you want to permanently delete the Clip Safe audio and keep the clipped/distorted audio, select “Delete Clip 
Safe Audio” from the Edit menu or audio clip context menu.

• In Edit Mode, the audio clip will have the same graphical appearance (the clipped/distorted parts indicated by 
red vertical lines, plus the Heal (CS) button to the right in the Clip Overview).

Clip Safe applied for input signal exceeding -0dB

Heal button
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Recording audio in Loop mode
Recording audio in Loop mode is very useful if you want to record alternative takes of the same part of the song. For 
example, let’s say you want to sing a couple of takes of the chorus part of your song to later create The Perfect Cho-
rus by selecting the best parts of the different takes. 

! To minimize the song saving time, we strongly recommend saving the song before recording many or large au-
dio recordings.

Proceed as follows to record audio in Loop mode:
1. Set up the audio track according to the descriptions in “Setting up the audio track”.

2. Set the Left and Right Locators to span the chorus part of your song.

3. Enable the Loop function by pressing [L] or by clicking the Loop On/Off button on the Transport Panel:

Loop mode activated on the Transport Panel

4. Click the L button on the Transport Panel to move the Song Position Pointer to the Left Locator.

5. Record the track according to the descriptions in “General recording procedure”.

6. Start singing to record audio on the track.
When the Song Position Pointer has reached the Right Locator, the recording starts over from the Left locator 
again and you can now record a second take. The audio recorded in the previous take won’t be heard but is saved 
in the “background” on a Comp Row.

Continue recording for as many loop cycles as you like.

7. When the recording is finished, the audio clip on the track shows the last recorded audio take as one or two 
continuous waves inside the clip (depending on whether the input was in mono or stereo).
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8. Double-click on the audio clip to open it for editing.
The audio clip is opened in Edit Mode and automatically set to Comp Mode. There is one Comp Row for each re-
corded loop cycle (take): 

Audio recorded in Loop mode with 5 loop cycles (takes) recorded

From here, it’s easy to assign the best parts from the different takes and comp them into a final clip. See “Creating 
a comped audio clip” for details.

! If you have recorded using the Clip Safe function with the Propellerhead Balance audio interface, any clipped 
parts are displayed with vertical red lines above each Comp Row. If you decide to heal the audio clip using the 
Heal (CS) button or “Heal Clip Safe Clips” from the Edit menu or context menu of the selected audio clip, the 
recordings on all Comp Rows are healed in one go.

Overdubbing audio using the “Dub” function
Back in the tape recorder days, overdubbing was used to record additional takes on additional tracks on the same 
section of the tape, to create a complete arrangement. For example, recording a vocal chorus part could be done by 
overdubbing the singer three or four times on additional tracks. Overdubbing in Reason Essentials works in a similar 
way, but with much better control, and much better editing possibilities afterwards.

D After you have recorded the first take on an audio track, click the “Dub” button on the Transport Panel.
This will create a new audio track with a duplicate of the original audio track settings, including the channel strip 
settings (with insert effects etc.). Now, you can continue recording on the new audio track as described in “Re-
cording audio” and “Recording audio in Loop mode”. Afterwards, you can edit the new track completely indepen-
dently of the original track.

q The “Dub” function can also be used on-the-fly while recording.

Duplicating audio tracks using the “Alt” function
Closely related to the “Dub” function, described in “Overdubbing audio using the “Dub” function”, is the “Alt” function. 
This function can be used to create a new audio track with an identical copy of the selected audio track’s settings. 
The only difference between the “Alt” and “Dub” functions is that the Alt function will automatically mute the original 
audio track.

Audio Comp Rows with 
stereo recordings

Audio clip (latest take) 
with stereo recording
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D Select the audio track you want to duplicate and then click the “Alt” button on the Transport Panel.
This will create a new audio track with a duplicate of the original audio track settings, including the channel strip 
settings (with insert etc.). Now, you can continue recording on the new audio track as described in “Recording au-
dio” and “Recording audio in Loop mode”. Afterwards, you can edit the new track completely independently of the 
original track.

q The “Alt” function can also be used on-the-fly while recording.

Recording over or into an existing audio clip
If you start recording over an existing clip on an audio track, the new recording will incorporate (replace, but not 
erase) the previous recording in the clip. When you open the audio clip in Edit Mode afterwards, there will be one 
Comp Row for each of the takes, the same result as when recording audio in Loop mode (see “Recording audio in 
Loop mode”).

Let’s have a look at the following example:

In the picture below, we have the original audio clip spanning bars 1-8 on the track:

An audio track with an existing clip

Now, we want to redo (re-record) the part that spans bars 5-6. We place the Song Position Pointer at bar 5 and re-
cord 2 bars:

A new recording made on bars 5-6 on the audio track

The new recording is made over the original clip. The recording in the original clip has therefore been incorporated 
into the start of bar 5 to the end of bar 6.

New recording
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Now, let’s double-click on the clip to open it for editing in Edit Mode:

The new and original recordings (takes) in Edit Mode

The new recording has incorporated bars 5-6 of the original recording. However, the original recording in bars 5-6 
has been left totally unaffected. The entire original audio recording now resides on the “Take 1” Comp Row and the 
latest recording resides on the “Take 2” Comp Row. The resulting clip will now play back the “Take 1” recording in 
bars 1-4 and 7-8. Bars 5-6 will play back the “Take 2” recording.

See “Creating a comped audio clip” for details on how to extract parts from individual takes and comp into a final clip.

Recording audio from Mix Channel outputs
Besides recording external audio from the inputs of your audio interface, it’s also possible to record audio internally 
from the outputs of Mix Channel or Audio Track devices. Typical applications for this could be re-recording of an au-
dio track with effects applied, or recording when playing back an instrument or audio track while making live manip-
ulations of effects or parameters.

q If you want to record the audio from an Instrument track onto an audio track, without making any live manipu-
lations, you can also use the “Bounce Mixer Channels” function - see “Bouncing Mixer Channels”.

The example below describes how to capture and record the audio from an ID8 device, but the general method can 
be used for other recording scenarios as well:
1. Create an instrument track for the instrument device you want to record according to the descriptions in “Cre-

ating an instrument track”.
You won’t actually be recording on the instrument track in this situation. However, you will need the instrument 
track to be able to play the instrument device from your connected master keyboard.

2. Create an audio track according to the description in “Creating an audio track”.

Incorporated part of the original recording

New recording
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3. In the rack, locate the Mix Channel device connected to the ID8 instrument device and click its “Rec Source” 
button.
The “Rec Source” button on Mix Channel devices is used for real-time audio recording of devices connected to the 
Mix Channel device.

The “Rec Source” button on Audio Track devices are used for real-time re-recording of audio tracks.

Enabling the Rec Source button on the Mix Channel device in the rack.

4. Locate the audio track and select “Stereo Input” and “ID8 1” as input source in the “Select Audio Input” drop-
down list.
All Mix Channel and Audio Track devices that have their “Rec Source” button enabled will appear in the list. In this 
example, we only have the Rec Source button active on the “ID8 1” Mix Channel.

“Stereo Input” and “ID8 1” selected in the “Select Audio Input” drop-down list.

5. Select the instrument track, in this example the ID8 1, so that it has Master Keyboard Input (red frame around 
the device icon) and disable the “Record Enable” button.

Select the ID8 1 track and disable the Record Enable button.

6. Locate the audio track and record enable it by clicking the Record Enable button.

Engage Record Enable on the Disk Channel track.

! Don’t set Master Keyboard Input to the audio track - only click the “Record Enable” button on the audio track! 
This way, the ID8 1 instrument track will still have Master Keyboard Input.
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7. Play the master keyboard and set the input level to the audio track by adjusting the Level Fader on the ID8 1 
Mix Channel strip in the mixer.

Adjusting the instrument’s level to the audio track.

! A Volume setting of -0.0 dB on the instrument device and a Level Fader setting of -0.0 dB on its corresponding 
Mix Channel strip in the mixer is often the optimal setting to avoid audio signal clipping. As when recording ex-
ternal audio, it’s the track’s Input Meter that should be observed for any clipping.

8. Start recording audio on the audio track according to the description in “Recording audio”.

q By using the recording method described above, it’s also possible to record the audio from previously re-
corded note clips on instrument tracks.

Recording a mixdown of several audio tracks
Another useful feature is to record a real-time mixdown of several previously recorded audio tracks onto a new, ad-
ditional audio track. This is sometimes also referred to as recording stems or sub-mixes. Let’s say we have four back-
ing vocal tracks that we want to mix down and record on a new audio track. We can do this as follows:
1. Create a new audio track according to the description in “Creating an audio track”.

This is the track we’re going to use for recording the mixdown. We name the track “Mixdown” to make it easier to 
distinguish.

2. Locate the Master Section device in the rack and click its “Rec Source” button.

The “Rec Source” button on the Master Section device

This will allow you to record the output from the Master Section onto the new audio track.
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3. Locate the four backing vocal Audio Track devices in the rack, or their corresponding channel strips in the 
mixer, and click their “Solo” buttons.

The four backing vocal Audio Track devices soloed

Since we’re going to record the four backing vocal tracks through the outputs of the Master Section, we only want 
the backing vocal tracks to sound. All other tracks in the song should therefore be muted.

4. Select the “Mixdown” track in the sequencer and select “Stereo” and “Master Section” from the “Select Audio 
Input” drop-down list.

“Stereo” and “Master Section” selected as Audio Input source

Selecting “Stereo” makes it possible to pan the backing vocal tracks in stereo before recording on the mixdown 
audio track.

5. Adjust the parameters of each of the backing vocal track channel strips as desired.

q Don’t forget to set the panning of each of the tracks to spread them in the stereo panorama.
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6. Select the “Mixdown” track in the sequencer and click the “Rec” button on the Transport Panel to start record-
ing the mixdown.

Recording the mixdown of the four backing vocal tracks to the “Mixdown” track

q During recording, you might want to perform real-time adjustments of the backing vocal tracks’ channel strip 
parameters to create a “live” mix.

7. When you have recorded the mixdown, click “Stop” on the Transport Panel.
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8. Before you play back the song with the mixdown track, remember to un-solo the four backing vocal Audio 
Track devices/channel strips. Also, mute the four original backing vocal tracks in the sequencer to avoid “dou-
ble” sounds.

Playing back the Mixdown track with the original backing vocal tracks muted in the sequencer

q If you want to record several Mix Channels onto a single audio track, you can create a sub-mixer setup for this 
purpose - see “Creating a sub-mixer”.
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Note recording details
Note events can be recorded for instrument devices and are contained in note clips. Performance controller events, 
such as Mod Wheel, Pitch Bend and Aftertouch events, can also be recorded from instrument devices, and be con-
tained in note clips, but they are described separately in “Parameter automation recording details”.

Setting up the instrument track
To be able to record notes for an instrument on a track in the sequencer, you need only create an instrument track as 
described in “Creating an instrument track”. The instrument track will automatically have Master Keyboard Input and 
the note lane will automatically be record enabled. Since you will only be recording MIDI events on the instrument 
track - and no audio - there is no need to adjust audio levels etc. These can always be adjusted afterwards.

About “Quantize During Recording”

The Q Rec (Quantize During Recording) button on the Transport Panel

It’s possible to quantize MIDI notes as they are being recorded. This will automatically align the start positions of the 
recorded notes to a pre-defined grid. Refer to “Quantizing notes” for more details.

Recording notes
1. Set up the instrument track according to the description in “Setting up the instrument track”.

2. Record the track according to the description in “General recording procedure”.

3. When the recording is finished, the note clip on the lane shows the recorded note events in a piano-roll fashion 
inside the clip:

A note clip with note events

The note clip’s start and end boundaries will automatically snap to the closest bar to make it easier to arrange 
(move etc.) later on.

! If no MIDI events (notes and/or performance controllers) were recorded, the empty note clip will be removed 
from the lane after you have clicked Stop.

q It’s also possible to manually insert notes by drawing them with the Pencil tool. Refer to “Drawing notes”.

Recording notes in Loop mode
Recording on a note lane in Loop mode allows you to continuously add new notes in a defined section of your song:
1. Set up the instrument track according to the description in “Setting up the instrument track”.

2. Set the Left and Right Locators to span the desired part of your song.

Note clip with note events
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3. Enable the Loop function by pressing [L] or by clicking the “Loop On/Off” button on the Transport Panel:

Loop mode activated on the Transport Panel

4. Click the “L” button on the Transport Panel to move the Song Position Pointer to the Left Locator.

5. Record the track according to the description in “General recording procedure”.
When the Song Position Pointer has reached the Right Locator, the recording starts over from the Left Locator 
again and you can record additional notes. Any new recorded notes will be added to the previously recorded ones 
and all notes will be heard during the recording.

Continue recording for as many loop cycles you like.

Recording over or into an existing note clip
Recording over or into an existing note clip will simply add new note events to the previously recorded events in the 
note clip as described in “Recording notes in Loop mode”. However, If the new recording should start before the orig-
inal clip, and expand into the original clip, a new clip will be created and will engulf the original clip. Let’s have a look 
at the following example:

In the picture below, we have the original note clip spanning bars 4-13 on the track:

A note lane with an existing clip

Now, we’re going to record an intro which is going to span the first four bars:

A new note clip recorded on bars 1-4 on the same note lane

The new clip is partly recorded over the original clip. The part of the original clip that has been recorded over is incor-
porated in the new clip; the events from the original clip are now contained in the new clip, and the start of the original 
clip has been moved to bar 5, where the new clip ends.

! If you’re recording over or into a masked clip and the new clip engulfs masked events, the masked events will 
be permanently deleted! See more about masked events in “About masked recordings and events”.

q Another, perhaps more convenient, way of overdubbing on an instrument track is to create additional note 
lanes and record new clips on these using the New Dub or New Alt functions described in “Recording notes us-
ing the “Dub” and “Alt” functions”. This way, you will get a better overview of exactly what you added in each 
of your recordings.
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Recording notes using the “Dub” and “Alt” functions
A practical way of recording additional MIDI events on an instrument track is to use the “Dub” and “Alt” functions.

The “Dub” function

The “Dub” function creates additional record enabled note lanes on which you can record “overdubs”. This is the func-
tion to use when you want to add new notes in the same section of the instrument track but want the notes to end 
up in new clips on additional note lanes instead of in the original clip. All note lanes will play back together.

The “Dub” function used for creating two additional lanes for overdub purposes. Loop mode is Off.

The “Dub” function used for creating two additional lanes for overdub purposes in Loop mode.

q Creating a new note lane using the “Dub” button can also be done on-the-fly while recording.
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The “Alt” function

The “Alt” function creates additional record enabled note lanes on which you can record alternative takes. At the 
same time, the previous note lane will be muted. Only the most recently added note lane will play back.

! Note that if Loop is activated and the Song Position Pointer is between the Locators, the clips between the Lo-
cators will be muted (instead of the lanes).

Here are two examples where the “Alt” function has been used:

The “Alt” function used for creating two additional lanes for alternative takes. Loop mode is Off.

When using the “Alt” function with Loop mode off, the previous note lane will be automatically muted.

The “Alt” function used for creating two additional lanes for alternative takes in Loop mode.

When using the “Alt” function in Loop mode, the clips between the locators will be muted - not the entire note lane. If 
the locators are placed over an existing clip, as in the example above, clicking the “Alt” button in Loop mode will split 
the clip and mute the clip between the locators.

q Creating a new note lane using the “Alt” button can also be done on-the-fly while recording.

Muted note lanes

Muted note clip

Split and muted note clip
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Parameter automation recording details
In Reason Essentials, you can automate virtually any device and channel strip parameters and create completely au-
tomated mixes if you like. This is done by recording parameter events in the sequencer. It’s also possible to record se-
quencer Tempo automation (see “Tempo automation recording”).

Performance controllers vs. track parameter automation
Recording parameter automation can be done in two different ways; either as performance controller automation or 
as track parameter automation.

• Performance controller automation is automatically recorded together with note events in note clips on note 
lanes.
Any standard MIDI performance controllers that you apply when playing (Pitch Bend, Mod Wheel etc.) will be re-
corded as performance controller automation in the note clip. A clip on a note lane can contain any combination of 
note events and performance controller automation events. 

• Track parameter automation creates separate parameter automation lanes on a track, one for each automated 
parameter. 

Which method you should use depends on how you prefer to work. The main differences to take into account are the 
following:

• Performance controller automation allows you to contain the automation data in a note clip together with note 
events.
The key feature with performance controller automation is that it’s contained together with the notes in the note 
clip. Moving the note clip moves the performance controller automation as well. Therefore, if your controller 
changes are part of your "note performance" (e.g. Pitch Bend and Sustain Pedal), then you want them as perfor-
mance controllers (see “Recording performance controller automation”).

Filter sweeps played together with the notes etc. can also be recorded as performance controllers (see “Recording 
parameter automation into Note Clips”).

• If your parameter changes are for sound design or mixing purposes (e.g. a slow opening of a filter, a gradual 
change in level), they would probably work better as track parameter automation.
Track parameter automation is recorded on separate lanes on the track (one lane for each automatable parame-
ter). Track parameter automation clips can be moved individually, independent from any note clips. See “Recording 
parameter automation”.
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Recording performance controller automation
If you use any MIDI performance controllers when recording on a note lane, these are automatically added to the re-
corded clip. This makes sense as performance controllers are usually recorded at the same time you record notes, as 
a part of the performance. Standard MIDI performance controllers are Pitch Bend, Modulation Wheel, Sustain Pedal, 
Aftertouch, Breath Control and Expression.

D To record standard performance controller automation, just follow the descriptions in “Recording notes”.
When you have recorded performance controllers in the note clip, the clip will have automation curves visible in it 
along with the recorded note data.

Performance controllers are shown as curves in the note clip. In this picture, Mod Wheel, Pitch Bend and Sustain Pedal 
controllers have been used.

Green borders will appear around the automated device parameters to indicate that they are automated.

The Pitch Bend and Mod Wheel parameters have been automated, indicated by the green borders. 

! After you stop recording, you need to click Stop again, or click the “Automation Override” indicator above the 
audio meters on the Transport Panel, for the green automation borders to appear on the device panel.

The Automation Override indicator on the Transport Panel. 

The performance controller automation is shown differently in the clip depending on the type of controller used. 
Controllers with bipolar range (such as Pitch Bend) are shown as lines in the middle when at zero (no pitch bend) 
with curves travelling up or down from the zero value. Controllers with only positive values (such as Mod Wheel) 
have zero at the bottom of the clip with applied modulation shown as curves travelling up from the zero value. Con-
trollers with off/on values (such as Sustain Pedal) are shown as rectangular curves (on - duration- off).

• If you open a note clip Edit Mode (by double-clicking on the clip), the recorded performance data will show up 
on separate Performance Controller Edit Lanes on the Edit Pane.

Performance controller automation on separate Edit lanes in Edit Mode.

Performance Controller 
Edit Lanes
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q Note that you can record notes and performance controllers separately. I.e. you can first record notes on one 
note lane and then record performance controllers on another note lane on the same instrument track. The au-
tomation will be contained in note clips placed on a separate lane and can also be moved or muted separately.

! If several note lanes contain performance controller automation, the topmost lane has priority (see “About 
performance controller automation on multiple lanes”).

q It’s also possible to manually insert performance controller events by drawing events with the Pencil tool. Re-
fer to “Drawing parameter automation events”. 

Recording parameter automation into Note Clips
Besides the standard performance controllers (Pitch Bend, Mod Wheel etc.), you can choose to record automation of 
any type of instrument device parameter into a note clip:
1. Select “Record Automation into Note Clip” from the Options menu.

2. While recording on a note lane according to the description in “Recording notes”, tweak the parameter(s) you 
want to automate on the instrument device panel in the rack - or use a Remote MIDI controller (see “Remote - 
Playing and Controlling Devices”).
Any parameter you tweak on the device will be recorded as automation inside the note clip - just like Performance 
Controller automation.

Green borders will appear around the automated device parameters to indicate that they are automated.

! After you stop recording, you need to click Stop again, or click the “Automation Override” indicator above the 
audio meters on the Transport Panel, for the green automation borders to appear on the device panel.

q While this method is perfect for making a note clip self-contained, there are some trade-offs. If you use this 
method to record device parameters, you won’t have the same overview as with track parameter automation. 
You also won’t be able to later mute a separate parameter automation lane, or move to parameter lanes inde-
pendently.

! It is possible to have overlapping track parameter automation and automation inside a note clip for the same 
parameter. In such a case, the track parameter automation overrides the note clip automation. As soon as the 
track parameter automation clip ends, any automation inside the remaining part of the note clip takes over.

Recording performance controller automation over or into an 
existing clip
• If you record over a note clip with performance automation data and you adjust any of the performance con-

trollers used in the clip, the automation will be replaced with new performance events from this point onward 
until you stop recording.
However, if the new recording should start before the original clip’s start position, a new clip will be created which 
will incorporate the original clip. The new automation data will replace the existing one, but any existing note 
events will not be affected (see “Recording parameter automation over or into an existing clip” and “Recording 
over or into an existing note clip”).
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About performance controller automation on multiple lanes
If you have several active (un-muted) note clips with performance controller automation on different lanes of the 
same track, and these note clips overlap position-wise, the following rule applies:

• Performance controllers in clips on the topmost lane override performance controllers of the same type in 
other overlapping clips on lanes below:

The clip on Lane 2 has Mod Wheel automation, and the clip on Lane 1 also has Mod Wheel automation - plus 
Pitch Bend and Sustain Pedal automation and note events. The Mod Wheel automation affecting the notes will fol-
low the automation curve of the clip on Lane 2 for its duration. As soon as the clip on Lane 2 ends, the notes will 
be affected by the Mod Wheel automation in the clip on Lane 1.

Recording parameter automation
Parameter automation is the standard way to automate device and channel strip parameters. Each automated de-
vice/channel strip parameter will generate a separate automation lane on the track. It’s also possible to record auto-
mation of the Tempo on the Transport Panel. This is described in detail in “Tempo automation recording”.

Before you start recording parameter automation

Before you start recording automation of a device/channel strip parameter, you may want to set it to a suitable start 
value, what we call its “static value”. By static value we mean the value the parameter should have whenever it is not 
automated in the song. Here is why:

Let’s say you want to create a fade-out by recording a fader movement in a mixer channel strip. It’s a good idea to 
first set the fader to the correct static value (i.e. the value the fader should have before you start the fade-out). The 
same thing is true if you want to create a filter sweep somewhere in the song: first set the filter frequency to the value 
it should have elsewhere in the song, then record the filter sweep. This makes it possible to set up a static mix first, 
and then add some automated parameter changes anywhere in the song while maintaining the static values else-
where in the song.

You can think of the static value as a “default” or “fall-back” position for the duration of the song.

q You can change the static value at any time, by opening the automation clip in Edit Mode. See “Editing param-
eter automation in Edit Mode”.
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Parameter automation recording procedure

1. Make sure there is a sequencer track for the device you’re going to record parameter automation for.
For audio track devices and for instrument devices, a sequencer track is automatically created together with the 
device. For mix channel and effect devices, that might not necessarily have a sequencer track, the easiest way to 
create a track for parameter automation is by right-clicking (Win) or [Ctrl]-clicking (Mac) on the device/channel 
strip parameter and selecting “Edit parameter Automation” from the pop-up.

2. Set up the track for parameter automation recording according to the description in “Record enabling param-
eter automation”.
If the track has note lanes you may want turn off the “Record Enable” button for the active note lane (unless you 
plan to record notes and parameter automation simultaneously of course).

! Note that it is not necessary for the track to be selected, or for the track to have Master Keyboard Input, to be 
able to record parameter automation. The “Automation Record Enable” button is completely independent 
from Master Keyboard Input. However, if you want to adjust the parameters from a control surface or MIDI 
Controller keyboard, this is most easily done by setting Master Keyboard Input to the track - see “Setting Mas-
ter Keyboard Input”.

3. Record the track according to the description in “General recording procedure”.

4. Record the parameter automation by changing device/channel strip parameter(s) in the rack or in the mixer.
During recording, adjust the desired parameter(s), from the device panel or from a MIDI control surface. You can 
automate any parameter for the device - each parameter you tweak will automatically generate a separate param-
eter automation lane and a clip will be recorded on the corresponding lane from the point you changed the param-
eter.

5. When you’re done, click the “Stop” button on the Transport Panel to stop recording.
In Arrange Mode the parameter automation clip(s) on the lane(s) show the recorded parameter automation events 
as curves or lines inside the clip.

If you click the “Stop” button again, or click the “Automation Override” indicator on the Transport Panel, the auto-
mated parameters on the device(s) will be marked with green borders, indicating that they have been automated.

If you play back the recorded section again, the automated parameters will change automatically. Outside the clip 
boundaries, the parameters will have their original settings (the static values they had before you started record-
ing).

q It’s also possible to manually insert parameter automation events by drawing events with the Pencil tool. Re-
fer to “Drawing parameter automation events”. 

Recording parameter automation in Loop mode
Recording parameter automation events in Loop mode works similar to “non-looped” recording (see “Recording pa-
rameter automation”), except that for every new loop cycle any changed parameter value will replace the previously 
recorded value for the corresponding parameter.

Parameter automation clip 
with parameter events
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Recording parameter automation over or into an existing clip
Recording parameter automation events over or into an existing automation clip will simply replace the previously re-
corded automation events. However, If the new recording should start before the start position of the original auto-
mation clip, and expand into the original clip, the new clip will merge with the original clip. After the new clip ends, the 
parameter automation in the original clip will “take over”.

If you need to redo a section of the recorded automation in an existing clip, or simply record more automation for a 
parameter, proceed as follows:
1. Set up and start recording in the same way as described in “Parameter automation recording procedure”.

As long as you don’t change the parameter value, its automation data will be played back normally, and nothing will 
be changed.

2. At the desired position, adjust the parameter.
As soon as you start changing the parameter value, the Automation Override indicator will light up on the transport 
panel.

The Automation Override indicator on the Transport Panel. 

From this point on, the previously recorded automation values will be replaced with the new automation values. Au-
tomation recording is different from recording note events where nothing is erased when you record over previ-
ously recorded clips. A parameter automation “overdub” will replace any previous automation values at the same 
position for the duration of the recording. Automation clips logically cannot be “overdubbed” as a parameter cannot 
have more than one specific value at a given point in time.

3. When you’re done, click the “Stop” button on the Transport Panel to stop recording.
You have now replaced the automation values from where you started recording to where you stopped recording. 
The Automation Override indicator will still be lit but it will go off if you click Stop or Play on the Transport Panel.

D You can also click the “Automation Override” indicator during recording.

This “resets” the parameter to the previously recorded value and the automation recording will stop (making the 
previously recorded automation active again, from that position). You are still in record mode, so as soon as you ad-
just the parameter again, the Automation Override indicator will light up.
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Adjusting automated parameters during playback - “Live 
mode”
Even if you have automated a device/channel strip parameter, you can still “grab it” and adjust it during playback, 
overriding the recorded automation:
1. During playback, adjust an automated parameter.

The Automation Override indicator lights up on the Transport Panel. 

From this point onward, the recorded automation for the parameter is temporarily disabled.

2. To activate the previously recorded automation again, click the “Automation Override” indicator.
This returns the control of the parameter to the parameter automation lane in the sequencer.

q Note that you can also temporarily turn off automation for a parameter by clicking the “On” button (so that it 
goes dark) on the parameter automation lane in the sequencer (see “Muting a parameter automation lane”).

Recording parameter automation on multiple tracks
Although only one track can have Master Keyboard Input, it is possible to record enable any number of tracks for au-
tomation recording.

D Activate the Record Enable Parameter Automation button for all the tracks you wish to record automation for.
When recording is activated, all automation record enabled tracks will record track parameter changes from their 
respective devices in the rack. This is especially useful if you have assigned parameters on several devices to a 
single control on a MIDI control surface, or have multiple control surfaces controlling different devices in the rack 
while you’re recording. See “Remote - Playing and Controlling Devices” for details.
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Pattern automation recording details
If your song contains pattern based devices such as the Redrum Drum Computer, Matrix Analog Pattern Sequencer 
or Dr. Octo Rex, you probably want to use more than a single pattern throughout the song. To facilitate this you can 
record pattern changes in the sequencer.

Recording pattern automation
1. Before you start recording on the track, make sure the “Record Enable Parameter Automation” button is on 

(red).
You can disable the “Record Enable” button for the note lane for now as it won’t be needed.

2. Make sure that the “Enable Pattern”/”Enable Loop Playback” button is activated on the device in the rack.

The “Enable Pattern” buttons on the Redrum (top) and Matrix (bottom) devices

3. Set the desired start pattern on the pattern device.

4. Start recording on the track from the desired position.
When recording starts, the pattern device will automatically start. Although no clip will be created until you change 
pattern on the device for the first time, the start pattern is still being recorded.

5. During recording, change patterns with the “Bank” and “Pattern” buttons on the device panel.
As soon as a Pattern or Bank value is changed on the device, a pattern lane is automatically created on the track. 
On the lane, a pattern clip is automatically created and the pattern selection is recorded in the clip. Make sure you 
change the patterns slightly in advance - the actual pattern change will be recorded (and happen) on the next 
downbeat according to the sequencer time signature setting.

6. When you are done, click “Stop” on the Transport Panel to stop recording.
The automated pattern selection buttons on the device in the rack will marked with a green border, indicating that 
they have been automated. A pattern automation lane with pattern clips has also been created on the Edit/Ar-
rangement Pane.

Pattern automation clips on the pattern automation lane.

• Pattern automation has no “static value”. Patterns will only be played back where there are pattern clips on 
the lane. Where the pattern lane has no clips, the device will stop and no pattern will be played back.
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• Each pattern change will be recorded on a downbeat (at the start of a new bar in the sequencer).
You can move pattern changes to other positions by moving or resizing the pattern clips, see “Editing pattern au-
tomation”.

• You can “punch in” on recorded pattern changes, to replace a section of the pattern lane with new pattern au-
tomation events. This can be done the same way as described in “Recording parameter automation over or 
into an existing clip”.

• After recording the pattern changes, you can use the function “Convert Pattern Track to Notes”, to transfer the 
notes in the patterns to regular notes in the main sequencer.
This allows you to create unlimited variations by later editing the notes in Edit mode. See “The “Convert Pattern 
Automation to Notes” function”.

• On the Redrum, Matrix and Dr. Octo Rex devices, you could also use the “Copy Pattern/Loop to Track” func-
tion.
This function lets you convert a defined range of pattern clips into notes in a new note clip. See “Copy Pattern to 
Track”.

q You can also manually draw automation clips on the Pattern automation lane - see “Drawing pattern automa-
tion”

Tempo automation recording
In Reason Essentials it’s possible to record automation of the sequencer’s tempo. This means that a song can auto-
matically change tempo whenever you like. You can record tempo automation events on the parameter automation 
lanes on the Transport track.

Recording tempo automation
Automating tempo is done much in the same way as with other parameter automation. You record the tempo 
changes by changing the Tempo value on the Transport Panel. When you later play back, audio clips will automati-
cally be stretched to follow the tempo changes (unless you have disabled stretch for the clips - see “About disabling 
Stretch for audio clips”). Note clips and automation clips will always follow tempo changes.

To record tempo automation, do as follows:
1. Set the desired song tempo in the Tempo display on the Transport Panel.

This will be your static value, i.e. the tempo of the song wherever there is no clip present on the tempo automation 
lane.

2. Press [Alt](Win) or [Option](Mac) and click in the Tempo display on the Transport Panel.
This will both select the Transport track and create a Tempo automation lane at the same time. The Tempo display 
will also be marked with a border, indicating that the Tempo parameter has been automated.
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3. Start recording in the sequencer and record the tempo changes by changing the value in the Tempo display.
Either click on the up/down buttons to change tempo in BPM steps, or click and drag up/down in either of the dis-
play segments to change tempo in BPM steps or 1/1000 BPM steps.

q You can also manually draw Tempo automation events in the parameter automation clip, using the Pencil tool 
- see “Drawing tempo automation events”.

or

or



Chapter 7
Arranging in the 
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About this chapter
This chapter describes how you can arrange and work with the clips in your song. The chapter covers audio, note and 
parameter automation clip arrangement. 

Before reading this chapter, it’s recommended that you are familiar with the sequencer functions and definitions de-
scribed in the “Sequencer Functions” and “Recording in the Sequencer” chapters.

Clip handling
Clip arrangement in the sequencer is done mainly in Arrange Mode - but could also be done in Edit Mode, if the clips 
you’re arranging are on the same lane. The descriptions in this chapter refer to arrangement in Arrange Mode, unless 
otherwise stated.

Selecting clips
D To select any type of clip in Arrange Mode, just click on it.

A selected clip is indicated with a thick black border with Clip Resize handles on either side. In Edit Mode, the Clip 
Resize handles appear in the Clip Overview area.

Selected clips in Arrange Mode

D To de-select clips, just click anywhere on the Arrange Pane background.

Inspector displays for selected clips

In the sequencer Inspector, the Position and Length displays shows the start position and length of the selected clip. 
For selected audio clips, three additional displays are shown: Fade In, Fade Out and Level. If several clips are se-
lected, the displays show the values for the earliest (or topmost) selected clip in the song.

The Inspector displays for a selected Audio Clip

Clip Resize handles
Audio clip

Parameter automation clipNote clip

Pattern clip
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• Clip Position display
The clip Position display shows at what position in the song the clip begins. The display readout is divided into Bar, 
Beat, 1/16 Note and Ticks (1/16th note=240 Ticks). The position can be edited according to the descriptions in 
“Moving clips using the Inspector”.

• Clip Length display
The clip Length display shows the length of the clip. The display readout is divided into (from left to right) Bar, 
Beat, 1/16 Note and Ticks. The length can be edited according to the descriptions in “Resizing clips using the In-
spector”.

• Fade In and Fade Out displays (audio clips only)
The Fade In and Fade Out displays for selected audio clips show the Fade In and Fade Out times for the audio in 
the clip. The readout is divided into 1/16 Note and Ticks. The Fade times can be edited as described in “Inspector 
segment displays”.

• Level display (audio clips only)
The Level display for selected audio clips shows the level of the audio in the clip. The readout is divided into dB 
and 1/100 dB. The level can be edited as described in “Inspector segment displays”.

Selecting multiple clips

In Arrange Mode, several clips can be selected, e.g. for cutting, copying, pasting, deletion, moving or resizing pur-
poses.

D Press [Ctrl](Win) or [Shift](Mac) and select the clips.
Under Windows, you can also press [Shift] and click to select a range of clips on the same lane.

D Draw a selection rectangle with the Selection Tool (arrow) on the Arrange Pane background.

Click, hold and draw a rectangle with the Selection Tool to select multiple clips

All clips that are touched by the selection rectangle will be automatically selected when the mouse button is re-
leased. 

D If you hold down [Shift] when you select clips with the selection rectangle technique, any previously selected 
clips will remain selected. 
This allows you to make multiple, non-contiguous selections: first select some clips, then hold [Shift] and select 
some more clips, and so on.

D Use the “Select All” function on the Edit menu or on the clip context menu to select all clips in the song.
Alternatively, hold down [Ctrl](Win) or [Cmd](Mac) and press [A].
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• You can also select multiple clips in the Clip Overview area in Edit Mode - if the clips are on the same lane.

Two selected clips in the Clip Overview area in Edit Mode.

Selecting clips with the arrow keys

Another way of selecting clips on the Arrange Pane is to use the arrow keys on the computer keyboard. 

D Press the Left or Right arrow keys to select the previous or next clip on the lane.

D Press the Up or Down arrow key to select the closest clip on the lane above or below. 

D Hold down [Shift] and use the left/right arrow keys to make multiple selections on the same lane.

Setting audio clip Level and Fades
Besides the Clip Resize handles, a selected audio clip also has Fade In and Fade Out handles plus a Clip Level han-
dle. These can be edited at any time, either by using the handles as described below, or using the Inspector as de-
scribed in “Fade In and Fade Out displays (audio clips only)” and “Level display (audio clips only)”:

A selected audio clip in Arrange Mode

Fade In and Fade Out Handles

D Click and drag these handles horizontally to introduce a fade in and/or fade out of the audio in the clip. 
The Fade settings can be set individually for each audio clip in the song. The fading is non-destructive and can be 
changed at any time. If Snap is activated (see “Snap”), the set Snap value is taken into account when setting the 
fade time(s).

Clip Level Handle

D Click and drag this handle vertically to adjust the audio level in the audio clip. 
The Level can be set individually for each audio clip in the song. The Level setting is non-destructive and can be 
changed at any time.

Clip Fade handles

Clip Level handle
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Deleting clips
D To delete a clip, select it and press [Delete] or [Backspace] or select “Delete” from the Edit or context menu.

You can also draw selection rectangles with the Selection tool, encompassing several clips and delete them all at 
once. The same rules apply as when selecting clips (see “Selecting clips”).

! If you delete an audio clip which contains recordings that are not used elsewhere in the song, those audio re-
cordings will be permanently deleted! However, if you accidentally erase an audio clip, you can always use the 
“Undo” function.

Deleting clips with the Eraser tool

You can also use the Eraser tool to delete clips on the Arrange Pane. The Eraser tool can be used in two ways: you 
can click on single clips or you can make a selection rectangle encompassing several clips:

D Select the Eraser Tool and click on the clip you want to delete.

Select the Eraser Tool and click on the clip you want to delete

Alternatively, if you want to delete multiple clips:

D Select the Eraser Tool, click and hold the mouse button and draw a selection rectangle on the Edit/Arrange 
Pane background.

Click, hold and draw a rectangle with the Eraser Tool to erase multiple clips

All clips that are touched by the selection rectangle will be deleted once you release the mouse button.
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Resizing (masking) clips
All clip types can be resized by clicking and dragging either of the Clip Resize handles on the selected clip(s). This 
can be done both in Arrange Mode and in Edit Mode. In Edit Mode, the Clip Resize handles appear in the Clip Over-
view area.

A selected note clip

If you resize a clip and make it smaller, any recordings or events that now lie outside the clip boundaries will not 
sound, or have any effect, when played back. However, they are not deleted - just masked. If you make the clip larger 
again, the recordings or events that were masked will become visible and will play back again. See “About masked re-
cordings and events”.

If you enlarge an unmasked clip, nothing special will happen except that the clip “window” becomes larger.

• If you resize an audio clip which uses Fade In and/or Fade Out, the fade slopes will follow along, unaffected, 
with the clip boundaries.

Resizing multiple clips

It’s possible to resize several clips by first selecting the clips, and then dragging a Clip Resize handle on one of the 
selected clips. All selected clips will be resized by the same amount.

Resizing clips using the Inspector

Another way of resizing clips is to change the clip length(s) in the Inspector. This can be done in the following way:

D Select one or several clips on the Arrange Pane and then change the Length value in the Inspector by clicking 
on the up/down arrow buttons.
In the example below, we expand the clip lengths by 2 bars by clicking the up arrow button twice.

All selected clips become 2 bars longer.

q See “Inspector segment displays” for more details on how to edit in the Inspector displays.

• If the Tick segment in the Length display shows an asterisk (*), it means that the value is a fraction of a Tick - a 
subtick. See “About subticks in the Position and Length displays” for more info.

Clip Resize handles
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About masked recordings and events
A note or parameter automation clip which contains masked events is indicated by white corners on the left, right or 
both clip boundaries:

The position of the white corners indicate on which side of the clip boundary the masked events exist:

! Audio clips don’t indicate if they contain masked recordings.

Masked recordings in audio clips

If you resize an audio clip and make it smaller, the masked part of the recording will be silent during playback. If you 
open a masked audio clip, the part of the recording that will actually play back is shown in the Clip Overview area. The 
masked part of the recording will appear grayed out on a Comp Row:

An open audio clip before and after masking

Masked events to the right of the clip

Masked events to the left of the clip

Masked events on both sides of the clip

Masked part of the recording

Clip start Clip end Clip start Clip end
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Masked events in note and parameter automation clips

In the picture below is an open note clip in Edit Mode with notes and performance controller events, before and after 
resizing the clip:

After resizing the clip from 8 to 4 bars, all events that begin in bars 5-8 are now masked and won’t play back. All 
masked events will still be there - and follow along with the clip if the clip should be moved, cut or copied.

Masked events will be a blue color on the Note Edit Lane, to indicate that they won’t play back. The first three-note 
chord in the masked area is still an orange color. That’s because the notes begin in bar 4 (just before the downbeat) 
and thus will play back in their entirety, also after resizing the clip.

Masked performance controller events, parameter automation events and pattern automation events will be inactive 
- but could still affect the masked clip (see “About masked performance controllers and automation events” below). 
Outside a masked clip, the controller/parameter/pattern values will default to their Static Values in the masked area 
(see “Static Value Handles”).

! Note that just switching to Edit Mode won’t show masked events. A clip has to be opened before you can view 
these events. You can remove all masked note and parameter automation events using the “Crop Events to 
Clips” function on the Edit menu (see “The “Crop Events to Clips” function”).

Masked 
events

An 8-bar note clip with notes and 
performance controller events

The same note clip resized to 4 bars

Clip start Clip startClip end Clip end
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About masked performance controllers and automation events

Masked performance controller and parameter automation events just outside a clip can still affect the clip, since 
they affect the curve shape. The example below shows a masked note clip with Mod Wheel performance controller. 

The first Mod Wheel automation event to the right of the masked part of the clip determines the direction of the au-
tomation curve from the last event in the unmasked area. These types of automation events are not blue, but black 
and white, just like unmasked events.

The result in this example is that the Mod Wheel value will continue to rise all the way to the end of the masked clip, 
at which point the value will drop down to the Static Value - in this case “0”.

The “Crop Events to Clips” function

There may be situations when you want to delete all masked events, i.e. events located outside the left and/or right 
clip boundaries. This function only works for note and parameter automation clips and will delete all masked notes 
that begin in the masked clip section, plus any performance controller or parameter automation events:
1. Reduce the size of the clips to your liking.

2. Select one or several clips and choose “Crop Events To Clips” from the Edit menu or from the context menu.

3. After the cropping operation, all events outside the clip have been deleted.

Tempo scaling clips
It is possible to tempo scale the content of clips, i.e. make the clip play back at faster or slower tempos. This can be 
achieved in two different ways: 

• By manually “stretching” selected clip(s)

• By editing the tempo scaling numerically in the Tool Window.

! Tempo scaling can be applied to all clip types, except for Time Signature automation clips. 

! Note that Pattern Automation Clips will only be resized - the pattern tempo in the source device will NOT be 
scaled but will still be synced to the main sequencer tempo!

Below, we will describe how to use the scale tempo “tool” to manually “stretch” clips. Numerical tempo scaling in the 
Tool Window is explained in “Scale Tempo” in the “Note and Automation Editing” chapter.

Masked event which still affects the clip
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1. Select one or several clips, either on the arrangement pane in Arrange Mode, or in the Clip Overview in Edit 
Mode.

2. With the Arrow Tool selected, hold down [Ctrl](Win) or [Option](Mac) and place the mouse cursor over one of 
the Clip Resize handles.
When you reach any of the Clip Resize handles, the arrow symbol switches to a “scale tempo” arrow.

3. Hold down [Ctrl](Win)/[Option](Mac) and click and drag the cursor sideways in either direction to scale the 
tempo of the clip contents.
In this example, we make the “stretched” clip four bars longer by dragging the right clip handle one bar to the right.

Now, all clips have been tempo scaled and the clip content have been stretched to match the new clip length. Note 
that the content of all selected clips have been scaled proportionally. The Pattern Clip has only been resized, 
though. The pattern tempo in the source device has NOT been scaled.

For more details about tempo scaling audio clips, refer to “Tempo scaling Clips” in the “Audio Editing in the Se-
quencer” chapter.
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Moving clips

Moving clips within the same lane

D To move a clip, drag and drop it to the desired destination on the lane. 
It’s also possible to select and move several clips by dragging and dropping them to the desired destination. If the 
Snap function is selected (see “Snap”), you will only be able to move the clip(s) in steps of the selected Snap value.

D You can also use the “Cut” and “Paste” functions on the Edit menu or context menu to cut the selected clip(s) 
and then paste them at the current Song Position Pointer position (see “Cutting, Copying and Pasting clips”).

Nudging clip positions

You can use the left and right arrow keys on the computer keyboard to “nudge” the positions of selected clips in a 
couple of different ways:
1. Select the Snap value by which you want to nudge the clip(s).

2. Press [Ctrl](Win) or [Cmd](Mac) and use the Left and Right arrow keys to move the clip position back or for-
ward by the set Snap value.
It doesn’t matter if Snap is on or off - the clip will always be moved in steps of the set Snap value.

D Press [Ctrl]+[Alt](Win) or [Cmd]+[Option](Mac) and use the left and right arrow keys to move the clip position 
back or forward in Tick increments.
There are 240 ticks per 1/16 note so this is very fine editing - check the tick positions in the inspector when you 
nudge because typically you won’t “see” the position changes unless you’re working at a high zoom level.

D Press [Ctrl]+[Shift](Win) or [Cmd]+[Shift](Mac) and use the left and right arrow keys to move the clip position 
back or forward in Beat increments.

Moving clips using the Inspector

Another way of moving clips is to change the clip position in the Inspector. This can be done in the following way:

D Select one or several clips on the Arrange Pane. Then, change the Position value in the Inspector, either by 
clicking on the Up/Down spin controls, or by using any of the methods described in “Inspector segment dis-
plays”.
In this example, we move the clips position 2 bars forward by clicking the “Up” spin control twice.

All selected clips are moved forward by 2 bars.

• If the Tick segment in the Position display shows an asterisk (*), it means that the value is a fraction of a Tick - 
a subtick. See “About subticks in the Position and Length displays” for more info.
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Moving clips between lanes

You can move clips between lanes, either on the same track or between lanes on different tracks:

D Click and drag the clip(s) to the desired position on the new lane.
The set Snap value is taken in to account if the function is activated (see “Snap”). It’s also possible to move several 
selected clips in one go.

D Hold down [Shift] when you drag the clip(s), to restrict the clips to vertical movement.

! If you want to move several clips in the Windows version of Reason Essentials, press the [Shift] key after you 
have pressed the mouse button, otherwise pressing [Shift] will select or deselect clips, and that’s not what we 
want here.

! For a successful result, it’s important that the source and destination lanes are of the same, or similar, type 
(see “About alien clips” below).

About alien clips

An alien clip is a clip containing types of event, or different parameter range/resolution, other than that the lane is in-
tended for. For example, if we move a note clip from a note lane to a parameter automation lane, the note clip would 
become alien and won’t play back on the automation lane:

If a note clip is moved from a note lane to a parameter automation lane, for example, the clip becomes alien.

An alien clip can be distinguished by its red stripes, which indicate that the clip is currently inactive. If you place the 
cursor over an alien clip, a tool tip appears with detailed information:

Tool tip for an alien note clip

• A parameter automation clip can also become alien if it is moved to a parameter automation lane for a param-
eter with a different range or resolution.
In most cases, you can resolve this by first selecting the clip and then selecting “Adjust Alien Clips to Lane” from 
the Edit menu or from the context menu.

For example, if a parameter automation clip for a parameter that has a bipolar (-64 to 63) value range is moved to 
a parameter automation lane with a unipolar (0 to 127) value range, it will become alien. Selecting “Adjust Alien 
Clips to Lane” from the Edit menu or context menu will adjust the parameter automation events of the clip to fit the 
range of the parameter on the destination lane.

Moving clips with performance controller automation to another track

If you move note clips that contain performance controller automation events to another track (for a different type of 
instrument device), there are a few things to note:
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• If you have only recorded standard performance controllers (Pitch Bend, Mod Wheel and Sustain pedal) in the 
note clip, these will usually translate without any problems when moved to another device track.
Be aware that all devices do not respond to all performance controllers.

• If you have recorded non-standard controller parameters for a device in the note clip using the “Record Auto-
mation into Note Clip” option (see “Recording parameter automation into Note Clips”) some automated pa-
rameters may not have an equivalent parameter in the target device.
In such cases the automation data for an incompatible controller will simply be ignored.

• Parameters common to most instrument devices (filters, envelopes etc.) will be transferred to the target device 
whenever applicable.

About overlapping clips
If you move or resize clips so that the clips overlap each other, the following rules apply:

• Clips or sections of clips that are hidden (overlapped) will not play back.
Any lane can only play back a single clip at a time - if you want to mix two clips, put them on separate lanes (note 
clips) or on separate tracks (audio clips). See “Adding note lanes” and “Duplicating/copying tracks and devices”.

• The clip with the latest start position have priority (and will be played back).
This means if a shorter clip is placed “in the middle” of a longer clip, as in the picture below, the sequencer will play 
the beginning of the long clip, then the shorter overlapping clip and then the end of the long clip.

! If both clips start at the same position and have the same length, the clip which was moved last will sound. 
Consequently, the “hidden” clip won’t play back at all.

Duplicating clips
D To duplicate selected clips, hold down [Ctrl](Win) or [Option](Mac), then click with the Selection Tool and drag 

a copy of the clip(s) to the desired destination.
As you begin dragging, the cursor displays a “+” sign next to it to indicate duplication.

• It’s also possible to duplicate only a part of one or several clips by using the Razor Tool as described in “Dupli-
cating a part of one or several clips”

Cutting, Copying and Pasting clips
You can move or duplicate clips using the “Cut”, “Copy” and “Paste” commands on the Edit menu or the context 
menu. When you paste, the clips will end up at the current song position, on their original lane(s). 

If you paste a clip into another Reason Essentials song document, the pasted clip will be placed on the track with edit 
focus, if possible. Typically, you can just select a track in the other document, place the song position pointer where 
you want, and paste the clip(s) onto the selected track.

New tracks will be created when necessary. Since all tracks must have a device associated with them, the new tracks 
will be associated with empty Combinator devices. You can then use the Patch browser on the Combinator to select 
a suitable patch and device type. The above rules also apply when pasting alien clips and parameter automation clips.
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Using Cut/Copy and Paste to repeat clips

When you cut or copy clips, the song position will automatically move to the end of the selection (or, if Snap is acti-
vated, to the closest Snap value position after the end of the longest clip). This allows you to quickly repeat a section 
of clips in the following way:
1. Make sure the sequencer is stopped.

2. Activate Snap (see “Snap”) and set the Snap value to “Bar” (or to the length of the section you want to repeat).

3. Select the clips you want to repeat.
Since you can select clips on several tracks , this is a quick way to copy entire song sections.

4. Select “Copy” from the Edit menu or context menu, or hold down [Ctrl](Win) or [Cmd](Mac) and press [C].
The song position is moved to the closest snap value after the end of the longest clip in the selection (provided 
that the sequencer is stopped).

5. Select “Paste” from the Edit menu, or hold down [Ctrl](Win) or [Cmd](Mac) and press [V].
The copied section is pasted in, and the song position is moved to the end of pasted selection.

6. Paste again, as many times as you want to repeat the selection.

Naming clips
1. You can name an individual clip by selecting it and then selecting “Add Labels to Clips” from the Edit menu or 

context menu.
A text field is opened.

2. Type in a name for the clip and then press [Return]. 

When adding labels to several selected clips in one go, they will all receive generic names according to the clip type 
(e.g. “untitled note clip”). Double-clicking on a label in a clip opens the text field where you can type in the label text.

Renaming clips

D To rename a clip, double-click on the label, type in a new name and press [Return].

Removing labels from clips

D To remove labels from clips, select them and choose “Remove Labels From Clips” from the Edit menu or con-
text menu.
Alternatively, double-click on the clip label, press [Backspace] or [Delete] and then press [Return].

Coloring clips
D You can color selected clips independently of track color by selecting “Clip Color” from the Edit menu or the 

context menu and then choosing a color from the palette on the sub-menu.
All selected clips will be colored according to the selected color. If you record new clips on the lane, they will be 
colored according to the set track color.
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Splitting clips
You can split clips using the Razor Tool in Arrange Mode. To split a single clip, proceed as follows:
1. Select the Razor Tool and place it where you want to split the clip.

On the Razor Tool’s left edge is a cross-hair which indicates where the split will take place. If activated, the Snap 
setting is taken into account (see “Snap”).

2. Click with the Razor Tool to split the clip at the cross-hair’s position.
The clip is now split into two separate clips.

A vertical line appears where the clip is split

! Recordings and events in a split clip will always remain intact, e.g. notes in a note clip will not be split even if 
they span over the split point.

It’s also possible to split clips on all tracks in a song:
1. Place the Razor Tool’s cross-hair on the Ruler where you want to split the clips on all tracks and lanes of the 

song.

2. Click in the Ruler to split the clips on all tracks and lanes at the current position.
Clips on tracks and lanes - including tracks and lanes that might not be visible - on the Arrange Pane will also be 
split.

You can also cut out a section of one or several clips in one go to:
1. Place the Razor Tool on the Arrange Pane background close to where you want to split the clips.

2. Click and drag with the Razor Tool to select the split section - on one or several lanes.

3. Release the mouse button to split the clips.

If you want to “cut” out a section of all clips on all tracks in the song, this can be done as follows:
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1. Place the Razor Tool’s cross-hair on the Ruler where you want to split the clips on all tracks of the song.

2. Click and drag the Razor Tool in either direction on the Ruler to make a range selection.

3. Release the mouse button to split the clips on all tracks and lanes in the song.

! Clips on tracks and lanes that might be scrolled out of view on the Arrange Pane will also be split.

Duplicating a part of one or several clips

By using either of the methods described above, it’s also possible to duplicate the “split” section of the clip(s) and 
then move them to a new destination. Here’s how:

D With the Razor Tool selected, hold down [Ctrl](Win) or [Cmd](Mac) and drag to create a duplicate of the “cut 
out” section of the clip(s). Then, use the Selection Tool to move the duplicated clip(s) to a new destination.
The original clips will remain uncut, just as they were before the operation.

Joining clips
Separate clips on the same lane can be joined into one clip. You can also join clips that aren’t directly adjacent on the 
lane, or clips that overlap each other.
1. Select the clips you wish to join.

2. Select “Join Clips” from the Edit menu or from the clip context menu. Alternatively, hold down [Ctrl](Win) or 
[Cmd](Mac) and press [J].

A single clip is created. If there was a gap between the clips before the operation, this area will be empty - the 
original positions of all events in the original clips will be preserved in the joined clip.

• Only clips on the same lane can be joined.
It’s possible to select several clips on several lanes, but only selected clips on the same lanes will be joined.

• You can also join selected clips that have other non-selected clips in-between them.
The non-selected clips in-between will then overlap and mask the joined clip at their current positions.
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! If you join note or parameter automation clips that contain masked events in the area(s) between the clips, the 
masked events will be permanently deleted! This is to make the resulting clip play back the same as the origi-
nal clips did before joining. (See “Masked events in note and parameter automation clips”).

! If you join overlapping note or parameter automation clips, the events in the clip which lies on top will replace 
and permanently delete the events in the overlapped region of the “hidden” clip.

About joining audio clips

Joining audio clips basically works in the same way as joining note and parameter automation clips - except when it 
comes to joining overlapping audio clips. What happens if you join overlapping audio clips is that the clips will be 
placed on separate Comp Rows - and be automatically comped to a “final” clip. No recording will be deleted. Let’s 
have a look at the example in the picture below:

As you can see, the entire audio recording in the original clip is preserved - only masked where the overlapping clip 
is located. If you change your mind afterwards, you will still be able to access the entire original recording.

• If overlapping clips have different Clip Levels, the Comp Row Levels will change to these levels after joining.
The Clip Level in the joined clip will be set to -0 dB.

• If overlapping clips use Fade In and/or Fade Out and the clips overlap in the Fade In/Out area(s), the Fade(s) 
will be removed after joining.
Also, if you join audio clips that aren’t directly adjacent, any Fade Out in the first clip and Fade In in the second clip 
will be removed.

• Any Cut Crossfades used in comped audio clips will be preserved after the joining.

The “joined” audio clip open in Edit Mode

The original audio clip (blue) with an overlapping 
audio clip (yellow) selected in Arrange Mode

The two audio clips joined into a single 
audio clip in Arrange Mode

Masked part of the original clip

The original clip

The overlapping clip

The “joined” clip
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Muting clips
Clips can be muted as follows:

D Select the Mute Tool from the Toolbar and click on the clips you want to mute.

Muted clips are indicated with gray stripes, borders and events:

Muted clips

D Select the clips and then select “Mute Clips” from the Edit menu or from the clip context menu. Alternatively, 
select the clips and press [M] on the computer keyboard to toggle mute on/off.

Unmuting clips

Muted clips can be unmuted as follows:

D Click on muted clips with the Mute Tool.

D Select muted clips with the Arrow Tool and select “Unmute Clips” from the Edit menu or context menu - or 
press [M].

! Muted clips cannot be joined with other clips.

! Muted note clips will not be included when using the “Merge Note Lanes on Tracks” function described in the 
“Merging clips on note lanes” section.

Merging clips on note lanes
Several note lanes on a track can be merged into a single note lane:
1. Select the track with the note lanes you wish to merge.

A selected instrument track with separate note lanes.
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2. Select “Merge Note Lanes on Tracks” from the Edit menu or from the context menu.
The clips on all note lanes will be merged on the topmost note lane.

The same instrument track after merging.

• If there are time gaps between the clips on the lanes, several clips will be created on the merged note lane.

• Muted note lanes or muted clips on the track will not be included in the merge.

• It’s also possible to select several tracks and merge the note lanes on each individual track, all in one go.

Matching clips using the “Match Values” function

The “Match Value” function in the Inspector can be used for matching the positions or lengths of several selected 
clips to the position and/or length of the topmost selected clip (or leftmost if the clips are on the same lane).

Matching clip positions

To match clip positions:
1. Select a couple of clips on the Arrange Pane.

2. Click the “Match Values” button to the right of the Position display to move all selected clips to the start posi-
tion of the topmost clip - or leftmost clip, if the clips are on the same lane.

All selected clips are moved to the start position of the topmost selected clip.

! Note: If you match the position of several clips on the same lane, they will all start at the same position, and 
thus overlap.
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Matching clip lengths

Another Match Value function in the Inspector can be used to match the lengths of several selected clips to the 
length of the topmost (or leftmost if on the same lane) selected clip:
1. Select a couple of clips on the Arrange Pane.

2. Click the “Match Values” button to the right of the Length display to resize all selected clips to the length of 
the topmost clip - or leftmost clip, if the clips are on the same lane.

All selected clips are resized to a length of 6 bars - the same as the topmost selected clip.

Matching audio clip levels and fades

In addition to Position and Length matching, audio clips can have their Fades and Levels matched:
1. In Arrange Mode, select a couple of audio clips.

2. Click the “Match Values” buttons to the right of the respective Fade displays and/or Level display to match to 
the values of the topmost clip - or leftmost clip if the clips are on the same lane.

After having clicked all three Match Values buttons, all selected audio clips get the same Fade and Level values as 
the topmost selected audio clip.
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Inserting bars
The “Insert Bars Between Locators” function on the Edit menu, or context menu, can be used for inserting empty bars 
between the Left and Right Locators. All clips that intersect the locator positions on all tracks after the Left Locator 
are split and moved to the Right Locator to make room for the inserted bars.

Different tracks with lanes before and after insertion of 4 extra bars between bars 13-17

Removing bars
The “Remove Bars Between Locators” function on the Edit menu, or context menu, removes all events between the 
Left and Right Locators. All clips that intersect the locator positions will be cut (when necessary), and the cut section 
(between the locators) will be removed. All clips that originally were located to the right of the Right Locator will then 
be moved to the Left Locator, closing the gap.

Different tracks with lanes before and after removal of 4 bars starting at bar 13

! Any removed note and parameter automation events between the Left and Right Locators will be deleted!
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About removing bars that contain audio recordings
As opposed to note and parameter automation events, audio recordings in removed bars will not be deleted. Instead, 
they will be placed on a Comp Row and masked. If we open the second audio clip in the previous example in Edit 
Mode, we can see that the audio recording in the removed bars has been moved forward and masked:

“Removed” recording moved forward 
on the Comp Row and maskedThe audio clip in Arrange Mode before and after removal 

of four bars (yellow frame) between the locators.

The audio clip in Edit Mode after removal 
of four bars



Chapter 8
Audio Editing in the 
Sequencer
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About this chapter
This chapter describes how to edit audio clips after you have recorded them in the sequencer. General sequencer 
functions, recording, note and automation editing, and arranging in the sequencer are described in detail in the chap-
ters “Sequencer Functions”, “Recording in the Sequencer”, “Note and Automation Editing” and “Arranging in the Se-
quencer”.

The Edit Mode
After you have recorded your audio clips, you might want to adjust levels, trim starts and ends and add fades etc. If 
you have recorded several takes in your audio clips, or several cycles in Loop Mode, you can also cut out segments 
of the various takes and compile (comp) them into a final “perfect” audio clip.

The Edit Mode in the sequencer is where you perform editing of audio recordings. It’s the same Edit Mode as when 
editing notes and parameter automation - it only has a different look and different functionality for audio clips.

D To enter Edit Mode, click the Edit Mode button in the top left corner of the sequencer.

Edit Mode with an open audio clip.

D Exit Edit Mode by clicking the Edit Mode button again.

D Toggle between Arrange Mode and Edit Mode by pressing [Shift]-[Tab] or by holding down [Ctrl](Win) or 
[Cmd](Mac) and pressing [E].
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Opening audio clips for editing

Opening an audio clip from Arrange Mode

In Arrange Mode, audio recordings are displayed as one or two (mono or stereo) waves in an audio clip. The selected 
audio clip in the pictures below contains a stereo recording.

D Open an audio clip by double-clicking it, or by selecting it and pressing [Return].
The sequencer automatically switches to Edit Mode.

Double-clicking an audio clip in Arrange Mode...

...opens it for editing in Edit Mode.

D To exit and return to Arrange Mode, press [Esc] or click the Edit Mode button.

q If a single audio clip is selected in Arrange Mode, switching to Edit Mode by clicking the Edit Mode button will 
automatically open the clip.
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Opening an audio clip from Edit Mode

In Edit Mode, clips can be closed or open. If you have several audio clips on the track, only one clip can be open at a 
time. Closed clips in Edit Mode are only displayed in the Clip Overview area at the top of the Edit Pane:

D To open an audio clip in Edit Mode, double-click it in the Clip Overview area, or select it and press [Return].

Double-clicking a closed audio clip in the Clip Overview area in Edit Mode...

...opens it for editing.

Closing an audio clip

D To close an open audio clip, either click outside the clip in the Clip Overview, or switch back to Arrange Mode.

D Alternatively, press [Esc] to close the clip. 
If you opened the clip from Arrange Mode, [Esc] will also switch back to Arrange Mode.

Clip Overview
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Edit Mode elements for audio clips
When an audio clip is open for editing, its contents are shown on the Edit Pane below the Clip Overview area. An 
open audio clip can have one or several Comp Rows on which the audio recordings reside. The number of Comp 
Rows depends on how you recorded your audio clip. If you only recorded once in the clip, there will only be one single 
Comp Row. If you have recorded several times in the same clip, or several cycles in Loop Mode, there will be one 
Comp Row for each take, or cycle.

There are vertical zoom controls for resizing the Clip Overview area and the Comp Row area. You can also scroll in 
the Comp Row area by using the scroll bars on the right hand side of the Edit Pane.

Single Mode elements

Unedited audio clips are usually set to Single Mode when opened. The only exception is clips with several takes re-
corded in Loop mode, which instead are set to Comp Mode (see “Comp Mode elements”). In Single Mode, only the re-
cording on the topmost Comp Row is played back. This is how an open audio clip could look in Single Mode:

An open audio clip in Single Mode.

• Clip Overview
The Clip Overview area at the top shows the clips on the selected audio track. In the Clip Overview area, selected 
audio clips are displayed in the same fashion as in Arrange Mode, i.e. with Clip Resize Handles, Level Handle and 
Fade Handles. You can select one or several audio clips in the Clip Overview and perform clip-based editing (e.g. 
moving and resizing) - just like in Arrange Mode.

• Single Mode and Comp Mode Selectors
Click on these selectors to switch between Single Mode and Comp Mode (see “Comp Mode elements”) for the se-
lected clip.

• Clip Resize Handles
By clicking and dragging either of the handles, you can change the position and length of the clip.

Clip Resize Handles

Comp Row Level Fader

Clip Overview

Comp Row with recording

Vertical Zoom buttons

Vertical Zoom buttons

Single Mode Selector

Comp Mode Selector

Clip Level Handle

Fade In
Handle

Fade Out
Handle

Comp Row Handle
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• Fade In and Fade Out Handles
Click and drag these handles horizontally to introduce a fade in and/or fade out of the audio in the clip. The fading 
is non-destructive and can be changed at any time. If Snap is activated (see “Snap”), the set (Arrange Mode) Snap 
value is taken into account when moving the Fade Handles.

• Clip Level Handle
Click and drag this handle vertically to adjust the audio level of the recordings in the clip. The level adjustment is 
non-destructive and can be changed at any time.

• Comp Row
Depending on how you recorded the audio clip, there can be one or several Comp Rows, containing one audio re-
cording each. Comp Rows can be described as “virtual tracks” in the sense that you can have many parallel Comp 
Rows in an audio clip but only play back from one Comp Row at a time (see “Creating a comped audio clip”). In 
Single Mode, only the audio recording on the topmost Comp Row will play back.

• Comp Row Handle
If the are several Comp Rows in the audio clip, it’s possible to rearrange the order of the Comp Rows by clicking 
and dragging the Comp Row Handle vertically.

• Comp Row Level Fader
Use the Comp Row Level Fader to adjust the volume of the recording on the corresponding Comp Row. This is es-
pecially useful in Comp Mode, when you want to trim and balance the levels of the recordings on several Comp 
Rows.

Comp Mode elements

Audio clips can also be edited in Comp Mode. Comp Mode can be used if you have recorded several takes in an au-
dio clip and want to cut out sections of the various takes and comp into a final clip (see “Creating a comped audio 
clip”). This is how an already comped audio clip could look like in Comp Mode:

A open audio clip in Comp Mode.

Comp Rows

Comp Mode

Cut Handles

Cut Crossfade Zones

Silence Row

Segment Focus Indicator

Cut Row

Cut Lines
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From the top down in the preceding picture, the Edit Pane contains the following elements:

• Cut Row
The area between the Clip Overview and the topmost Comp Row is called the Cut Row. This is where the Cut Han-
dles are placed.

• Segment Focus Indicator
The gray Segment Focus Indicator appears if you click on the Cut Row, or if you double-click on a Comp Row. A 
Segment is the area between two Cuts. The Segment Focus Indicator shows which segment currently has edit fo-
cus. Edit focus is required for editing using keyboard short-cuts (see the “Keyboard Commands” pdf document).

• Cut Crossfade Zones
When you have comped an audio clip by creating cuts and assigning different Comp Rows to the resulting seg-
ments, it’s possible to set individual crossfades between the segments. This makes it possible to get smooth tran-
sitions between the audio recordings in the different segments. Any crossfades are indicated by boxes. The widths 
of the boxes indicate the crossfade times.

• Cut Handles and Cut Lines
Each cut in a comped audio clip is indicated by a Cut Handle and a Cut Line. The Cuts indicate where the playback 
changes from one segment to another (in most situations from one Comp Row to another). You can edit the Cut 
positions by clicking and dragging any of the Cut Handles or Cut Lines sideways.

• Silence Row
In Comp Mode, the Silence Row becomes available. The Silence Row can be used for inserting silent segments in 
the comped audio clip, e.g. removing breath noise between vocal phrases.

• Comp Rows
All of your audio recordings reside in Comp Rows. Depending on how you recorded the audio clip, there might be 
one or several Comp Rows, each containing one audio recording. The most recent take is on the topmost Comp 
Row. In Comp Mode, the colored part(s) of each Comp Row (or Silence Row) will play back. All Comp Rows used 
in the clip have colored Comp Row Handles. Any unused Comp Rows in the clip are indicated by gray Comp Row 
Handles.
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The relationship between Clips, Comp Rows and Recordings
In Edit Mode, the contents of an open audio clip are displayed on the Comp Row(s) on the Edit Pane:

An audio clip in Single Mode with four Comp Rows, with the topmost Comp Row playing back.

An audio clip in Comp Mode with alternating playback from four Comp Rows.

• A recorded audio clip, or an audio clip containing imported audio, consists of one or several Comp Rows.
The number of Comp Rows and their position can be unique for each individual audio clip. Any edits you make in 
an audio clip will never interfere with other clips in the Song.

• On each Comp Row there is a single Recording, i.e. the audio data that you have recorded or imported.
If the clip was recorded in one single take, it will have a single Comp Row. If the clip was recorded in several takes 
one after another, or recorded in Loop Mode, it will contain one Comp Row for each take or loop. Also, if you im-
ported audio files to a clip, each audio file will end up on a separate Comp Row.

Comp Rows with one 
Recording each

Audio Clip in the 
Clip Overview area

Single Mode

Silence Row

Audio Clip in the 
Clip Overview area

Comp Rows with one 
Recording each

Comp Mode
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• Only one Comp Row can play back at a time.
In Single Mode, only the topmost Comp Row will play back. In Comp Mode, you can alternate the playback be-
tween the Comp Rows by assigning regions of the different Comp Rows to different Segments in the Clip. What 
you hear when you play back an audio clip is displayed in the Clip Overview area at the top on the Edit Pane. (The 
Clip Overview area displays the same content as the Clip in Arrange Mode.)

An audio clip in Single Mode with four Comp Rows, with the topmost Comp Row playing back

An audio clip in Comp Mode with alternating playback from four Comp Rows

• The Comp Row configuration, and the Recordings on the Comp Rows, are unique to each individual audio clip.
This means that you could move Comp Rows up or down on the Edit Pane, change Comp Row Levels and Cross-
fades, or move Recordings back and forth on the Comp Rows, without affecting any neighboring audio clips.

• If you duplicate a Clip, or a Comp Row with its Recording, you can freely edit the duplicated Clip, Comp Row or 
Recording without affecting the original.
However, the actual audio data is not duplicated. Reason Essentials features a very sophisticated internal audio 
management system which re-uses Recordings throughout the entire Song whenever necessary. This means that 
the Song file size won’t increase when you duplicate audio clips or Comp Rows.

Played back Comp Row

Audio Clip in the 
Clip Overview area

Unused (silent)
Comp Rows

Single Mode

Audio Clip in the 
Clip Overview area

Played back Segments 
of assigned Comp Rows

Unused (silent) Comp Row

Comp Mode
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Edit Mode window handling

Resizing, zooming and scrolling

D The Magnifying Glass tool can be used for zooming in and out (see “Magnifying Glass Tool”).

D The Hand tool can be used for scrolling the view in any direction (see “Hand Tool”).

D Use the Song Navigator to scroll and zoom horizontally (see “Areas, windows and basic navigation”).

D Click on a Song Navigator Handle and drag horizontally to zoom in and out horizontally (see “Areas, windows 
and basic navigation”).

D Shift-click on a Song Navigator Handle and drag horizontally to zoom in and out horizontally, symmetrically 
(see “Areas, windows and basic navigation”).

D Right-click (Win) or Ctrl-click (Mac) inside the Song Navigator frame and drag up or down to zoom in and out 
and scroll at the same time (see “Areas, windows and basic navigation”).

D Use the Track Navigator to scroll vertically in the Track List (see “Areas, windows and basic navigation”).

D Click the Zoom buttons below the Track Navigator to zoom in and out vertically (see “Areas, windows and ba-
sic navigation”).

• For extensive editing, you may want to maximize the Sequencer and/or detach the Main Mixer and Rack so 
that the sequencer covers the entire computer screen. Refer to “Areas, windows and basic navigation”.
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Audio editing tools
When editing audio, some of the Toolbar tools have different functionality than when editing note and automation 
clips. There are also some additional tools that are unique to audio editing.

Razor (Cut) Tool
When editing audio in Comp Mode, the Razor Tool on the sequencer Toolbar is used for creating Cuts. When you 
place the Razor Tool over the Comp Rows, Silence Row or Cut Row, it changes into a “Cut Tool”.

q With the Selection Tool selected, hold down [Alt](Win) or [Cmd](Mac) to temporarily switch to the Cut Tool.

D Click with the Razor Tool on a Comp Row to assign the recording to the right of the cursor to a new Segment.

Assigning the recording on the “Take4” Comp Row to a new segment

See “Adding Cuts” for more details on how to use the Cut Tool.

The Razor Tool can also be used for assigning a complete Segment, with a start and end Cut, by clicking and drag-
ging (swiping) the Razor Tool horizontally on the desired Comp Row. See “Adding Segments” for more details on how 
to swipe with the Cut Tool.

Speaker Tool
It’s possible to audition individual recordings on Comp Rows, without needing to start playback of the sequencer. This 
is very useful when you’re going to select what Comp Rows to use in the clip. Do like this:
1. Make sure the Speaker Tool is selected and place the cursor at the position on the Comp Row you would like 

to audition.
The cursor switches to a speaker symbol with crosshairs next to it.

Auditioning a recording on a Comp Row

2. Click and hold the mouse button depressed for as long as you want to listen.
The playback starts at the current crosshairs position and proceeds for as long as you keep the mouse button de-
pressed. The playback position is indicated by a vertical moving line on the auditioned Comp Row.

! Note that auditioning recordings on Comp Rows will play back the unprocessed sound of the recording - 
bypassing the settings in the Main Mixer.

q Using the Speaker Tool, it’s possible to audition recordings anywhere on any Comp Rows. The Comp Row 
doesn’t have to be selected - it’s even possible to audition recordings on masked Comp Row segments.
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Editing audio clips
In this section we will describe audio editing procedures that are common for Single Mode and Comp Mode. Comp 
Mode specific procedures are described in “Editing audio in Comp Mode”.

Selecting a Comp Row for playback in Single Mode
Unedited audio clips are usually set to Single Mode when opened. In Single Mode, only the topmost Comp Row will 
play back. It’s also possible to change Comp Row Levels and Recording Offsets in Single Mode. The picture below 
shows an open audio clip in Single Mode. The clip consists of four separate takes, each on a separate Comp Row. 
When played back, the recording on the “Take 4” Comp Row will play:

A open audio clip in Single Mode with four recorded takes

If you want to change which Comp Row should play back in Single Mode, proceed as follows:
1. Click the Comp Row Handle of the Comp Row you want to play back and drag to the top.

A red insertion line is shown, indicating where the Comp Row will be placed after you release the mouse button. 
Make sure the red insertion line is above the topmost Comp Row to enable playback of the moved Comp Row.

The “Take 2” Comp Row is moved to the top to enable it for playback

2. Release the mouse button.
Now, the “Take 2” Comp Row will play back instead when the sequencer is started.



AUDIO EDITING IN THE SEQUENCER 187

Selecting Comp Rows
D To select a Comp Row, e.g. for moving, cutting, copying, duplication or deletion, click (don’t double-click!) with 

the Selection Tool anywhere on the Comp Row, or on the Comp Row Handle.
The selected Comp Row is shown in a darker color:

The selected Comp Row is shown in a darker color

D Select multiple Comp Rows by holding down [Ctrl](Win) or [Cmd](Mac) and clicking with the Selection Tool.

D Select a range of Comp Rows by holding down [Shift] and clicking with the Selection Tool on the first and last 
Comp Row in the desired range.

! Don’t double-click on a Comp Row to select it. Double-clicking on a Comp Row will automatically assign the 
recording on it to the segment at the current click position.

Deleting Comp Rows
D Select one or several Comp Rows (see “Selecting Comp Rows”) and then press [Backspace] or [Delete], or se-

lect “Delete” from the Edit menu or context menu.

D Alternatively, select the Eraser Tool and click anywhere on the Comp Row you wish to delete.
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Moving Comp Rows
Moving Comp Rows up or down on the Edit Pane can be useful and make it faster and easier and to access the de-
sired Comp Rows when editing a comped clip. Let’s say you have recorded six takes but you’re only going to edit 
takes 1, 3 and 5. In this case, it could be more practical to have these Comp Rows right below one another at the top 
of the Edit Pane.

D To move a single Comp Row up or down, click and hold the Comp Row Handle and drag vertically.
A red insertion line is shown, indicating where the Comp Row will be placed after you release the mouse button.

Moving a Comp Row.

D To move several Comp Rows in one go, select them and then click and hold one of the selected Comp Row 
Handles and drag to the new destination.
A red insertion line is shown, indicating where the Comp Rows will be placed after you release the mouse button. 
Note that if you move non-adjacent Comp Rows, they will be placed as a group (adjacent) on the Edit Pane.

D To move Comp Rows between clips, use the cut/copy and paste functions described in “Cutting, copying and 
pasting Comp Rows”.

D Moving Comp Rows sideways is the same as changing the Recording Offsets - see “Adjusting the Recording 
Offset” for more details.

Duplicating Comp Rows
Duplicating Comp Rows can be useful if you want to re-use the same part of a take several times in a comped clip. 
Duplicate the Comp Row and then adjust the Recording Offset (see “Adjusting the Recording Offset”) in the dupli-
cated Comp Row to access the same part of the recording in another segment of the comped clip. Duplicating Comp 
Rows will not use up any more space on your hard disk, so you can do this as many times as you like.

D To duplicate one or several Comp Rows, select them and then select “Duplicate Comp Rows” from the Edit 
menu or context menu.
The duplicated Comp Rows will be placed below the lowest selected Comp Row. Note that if you duplicate non-
adjacent Comp Rows, they will be placed as a group (adjacent) below the lowest selected Comp Row.

D You can also duplicate a Comp Row and assign the duplicated Comp Row to a new segment in one go. With 
the Razor (Cut) Tool selected, hold down [Ctrl](Win) or [Option](Mac) and click, or swipe, on a Comp Row to 
assign a new segment to a duplicate of the recording on a new, additional Comp Row.

q See “Moving a snare hit” for a practical example of how to use this function.
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Cutting, copying and pasting Comp Rows
To move recordings between clips, you can cut or copy and paste Comp Rows as follows:
1. Select one or several Comp Rows and then hold [Ctrl](Win) or [Cmd](Mac) and press [X] to cut or [C] to copy 

the Comp Rows to the clipboard memory.
Alternatively, select “Cut” or “Copy” from the Edit menu or context menu.

2. Open the audio clip into which you want to paste the Comp Row(s).
This can be in the same song or a different one.

3. To paste the cut or copied Comp Rows, hold down [Ctrl](Win) or [Cmd](Mac) and press [V] - or select “Paste” 
from the Edit menu or context menu.
The pasted Comp Rows will be placed at the top of the Edit Pane. Note that if you paste non-adjacent Comp 
Rows, they will be placed below each other, starting at the top of the Edit Pane.

! If you paste Comp Rows into another song, the actual audio recordings will be added to that song as well and 
consequently increase the file size.

Adjusting the Comp Row Level
1. Click on the Comp Row to select it

The Comp Row is shown in a darker color to indicate it’s selected.

2. Adjust the level, either by clicking and dragging the Comp Row Level Fader, or by adjusting it in the Level (dB) 
display in the Inspector.
The Level (dB) display is divided into dB and 1/100th of a dB.

Adjusting the audio level of the recording in Single Mode

D It’s also possible to edit the entire Clip Level in Edit Mode by clicking and dragging the Clip Level Handle in the 
Clip Overview.
Any level adjustments you make on the Comp Row and in the Clip Overview are summed.
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Adjusting the Recording Offset
In some situations you might want to move, or nudge, the recording on a Comp Row to make it play back exactly 
when you want. Maybe you just need to fine tune the position by a couple of Ticks. Recording Offset adjustments can 
be made both in Single Mode and in Comp Mode:
1. Click on the Comp Row to select it.

2. Either click and drag the recording horizontally, or adjust the position in the Recording Offset display in the In-
spector.
The Recording Offset display is divided into Bars, Beats, 1/16th notes, Ticks and Subticks. There are 240 Ticks 
for each 1/16th note and 16 Subticks for each Tick.

Adjusting the offset (position) of a recording on a Comp Row

You can also nudge the Recording Offset of the selected recording by using the arrow keys on the keyboard.

D To nudge the recording in Snap value steps, hold [Ctrl](Win) or [Cmd](Mac) and press the left/right arrow keys.
Note that Snap doesn’t have to be activated for this to work.

D To nudge the recording in steps of Ticks, hold [Ctrl]+[Alt](Win) or [Cmd]+[Opt](Mac) and press the left/right ar-
row keys.

D To nudge the recording in steps of Beats, hold [Ctrl]+[Shift](Win) or [Cmd]+[Shift](Mac) and press the left/
right arrow keys.

q To make it easier to find the exact positions in the recording, you can audition the recording at desired posi-
tions (see “Speaker Tool”).

q See “Moving a snare hit” for a practical example on how to adjust the Recording Offset.

Delete Unused Recordings
After you have edited your audio clips, there might be unused recordings left on the Comp Row(s) that you don’t plan 
on using. To reduce the file size of your song, you can choose to delete all unused recordings in one or several audio 
clips.

D Select the clip(s) in the Clip Overview area in Edit Mode, or select the clip(s) in the Arrangement, and then se-
lect “Delete Unused Recordings” from the Edit menu or context menu.
All recordings that are not used in the clip(s) will be permanently deleted.

• If a clip is in Single Mode, only the top Comp Row will be played back - all other Comp Rows are per definition 
"unused". However, there may still be Cuts and assigned Segments among these Comp Rows, visible and au-
dible if you switch the clip to Comp Mode.
As a safety measure, if you use the “Delete Unused Recordings” function on such a clip, you will be asked to con-
firm that you really want to remove all Comp Rows other than the topmost one.

• After deleting audio recordings, you need to use the "Save and Optimize" function on the File menu to mini-
mize the Song file size - see “Saving and optimizing a Song”.

The “Recording Offset” display shows the offset of the 
recording on the selected Comp Row relative to the Clip 
Position. If you move the recording on the selected Comp 
Row back or forth, the Offset Display will update. 
Similarly, if you resize the Clip by changing its start 
position (left Clip Handle), the Offset Display will also 
update. However, If you resize the clip using its right Clip 
Handle, or move the entire clip, all recordings on all Comp 
Rows will follow along and the Recording Offset will 
remain unaffected.
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Bounce Clip(s) to New Sample(s)
You can bounce one or several Audio Clips to new Song Samples. You can then edit the samples in the Edit Sample 
window and then load into a sampler device for playback. Proceed as follows:

D Select the clips in the Clip Overview area in Edit Mode, or select them in the Arrangement, and then select 
“Bounce Clip(s) to New Sample(s)” from the Edit menu or context menu.
The Audio Clips are bounced to new Song Samples and named according to the Audio Clip name (if the clip was 
named) or according to the Audio Track name with serial numbers. The bounced Audio Clips then end up as sam-
ples on the Song Samples tab in the Tool Window. Refer to “Sampling” for more details about sampling and sam-
ple editing.

About the “Bounce Clip to Disk” function

The “Bounce Clip to Disk” function on the Edit menu and clip context menu allows you to export the audio of a se-
lected clip to disk as a single WAV or AIFF file. This might be useful if you want to process an audio clip in an external 
application and then re-import the clip to the track again. See “Bouncing Audio Clips” for more details.
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Normalizing Clips
Normalizing means increasing the overall audio level so that the loudest peak in the sound touches 0 dB. Normalizing 
can be made on any Audio Clips, regardless of if they are in Single Mode or Comp Mode.
1. Select the Audio Clip(s) in the Arrangement, or in the Clip Overview in Edit Mode.

A comped audio clip selected in the Clip Overview in Edit Mode

2. Select Normalize Clips from the Edit menu or context menu.

A new Comp Row is automatically created at the top and named after the Audio Track, with the extension “normal-
ized”. The new Comp Row contains the “bounced” normalized audio and the Audio Clip has also switched to Single 
Mode. The original audio is preserved on their original Comp Rows.

! Only the audio within the Audio Clip boundaries will be normalized. Any masked audio will be disregarded.

! Note that normalizing a clip that contains audio that already use the full headroom (touches 0 dB) won’t have 
any effect.
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Reversing Clips
Reversing an audio clip means playing it backwards, from the end to the start. Reversing can be made on any Audio 
Clips, regardless of if they are in Single Mode or Comp Mode.
1. Select the Audio Clip(s) in the Arrangement, or in the Clip Overview in Edit Mode.

A comped audio clip selected in the Clip Overview in Edit Mode

2. Select Reverse Clips from the Edit menu or context menu.

A new Comp Row is automatically created at the top and named after the Audio Track, with the extension “re-
versed”. The new Comp Row contains the “bounced” reversed audio and the Audio Clip has also switched to Sin-
gle Mode. The original audio is preserved on their original Comp Rows.

! Only the audio within the Audio Clip boundaries will be reversed. Any masked audio will be disregarded.

Tempo scaling Clips
Besides the automatic time stretching function applied when you change the Tempo in the main sequencer, there is 
a Scale Tempo function which can be applied to scale the tempo of one or several clips. The Scale Tempo function 
works in the same way for audio clips, note clips and parameter automation clips. However, it might be interesting to 
see what happens when you tempo scale an audio clip.
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1. Open an audio clip in Edit Mode.
In this example we use a comped clip with four Comp Rows and a number of Cuts. The tempo scaling works ex-
actly the same way, regardless of Single/Comp Mode, or number of Comp Rows, though.

2. With the Arrow Tool selected, hold down [Ctrl](Win) or [Option](Mac) and place the mouse cursor over one of 
the Clip Resize handles.
When you reach any of the Clip Resize handles, the arrow symbol switches to a “scale tempo” arrow.

3. Hold down [Ctrl](Win)/[Option](Mac) and click and drag the cursor sideways in either direction to scale the 
tempo of the clip.
In this example, we make the clip one bar longer by dragging the right clip handle one bar to the right.

Now, the audio clip has been tempo scaled and the audio recordings have been stretched to match the new clip 
length. Note that the distance between the Cuts, as well as the lengths of the recordings on all Comp Rows have 
been expanded proportionally.

The Scale Tempo function can also be applied to clips numerically in the Tool Window, see “Scale Tempo”.
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Editing audio in Comp Mode
In this section we will describe procedures that are specific to audio editing in Comp Mode. At the end of this section 
is a detailed example on how to use the various procedures to create a complete comped audio clip - see “Creating 
a comped audio clip”. General audio editing procedures are described in “Editing audio clips”.

Adding Cuts
D Place the Razor Tool on the Comp Row which contains the recording you want to assign, and click.

A new Cut Handle is added on the Cut Row. The recording to the right of the Cut Line on the Comp Row is as-
signed to a new Segment:

Assigning the recording on the “Take4” Comp Row to a new Segment

D Click with the Razor Tool on the Silence Row to assign silence to a new Segment to the right of the cursor.

D Click with the Razor Tool on the Cut Row to create a new Cut without changing the currently assigned record-
ing.
A new Cut Handle is added on the Cut Row. The previous recording assignment is retained throughout the new 
segment.

• If you hold down [Ctrl](Win) or [Option](Mac) and click with the Razor tool on a Comp Row, this will first create 
a duplicate of the Comp Row. Then, the duplicated Comp Row will be assigned to the new Segment.
You can then adjust the timing (Recording Offset) or level of the duplicated Comp Row as needed, without affect-
ing any segments playing the original Comp Row.

! Note that Snap is taken into account (if activated).

q A quick way to toggle Snap on or off is to press [S].

q For a practical example on how to add Cuts, see “Creating a comped audio clip”.

q It’s also possible to assign a complete Segment, with a start and end Cut, by swiping with the Cut Tool on the 
Comp Rows - see “Adding Segments”.
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Adding Segments
The Razor Tool can be used for assigning a complete Segment, with a start and end Cut, by clicking and dragging 
(swiping) the Razor Tool horizontally on the desired Comp Row.

D Swipe (click-hold and drag) with the Razor Tool to assign a part of a Comp Row to a new segment.

D To insert a new Segment in an existing Segment, swipe with the Razor Tool on a Comp Row or on the Cut Row.
Swiping on a Comp Row will automatically assign the recording on that Comp Row to the new segment. Swiping 
on the Cut Row will insert a new segment but won’t change the recording assignment. The result after inserting a 
new segment in an existing segment is three separate segments. Swiping over an existing Cut will remove that 
Cut.

• If you hold down [Ctrl](Win) or [Option](Mac) and click or swipe with the Razor tool on a Comp Row, this will 
first create a duplicate of the Comp Row. Then, this duplicated Comp Row will be assigned to the new Seg-
ment.
You can then adjust the timing (Recording Offset) or level of the duplicated Comp Row as needed, without affect-
ing any segments playing the original Comp Row. See “Moving a snare hit” for a practical example.

! Note that Snap is taken into account (if activated).

q A quick way to toggle Snap on or off is to press [S].

q For a practical example on how to add a Segment, see “Creating a comped audio clip”.

Adding Crossfades to Cuts
To add a crossfade zone to a Cut (between two Segments), proceed as follows:

D Select a Cut Handle and then drag the Cut Crossfade Handle to the right.

The crossfade slopes are indicated by curves on the assigned Segments. The longer the crossfade time, the flatter 
the curves.

D To remove a crossfade, simply drag the Cut Crossfade Handle all the way to the left.

Place the Razor Tool on the desired start position on a 
Comp Row and swipe...

...and release where you want the segment to 
end

Click and drag the Cut Crossfade Handle... ...to introduce a crossfade between the segments
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Deleting Cuts
D To delete a Cut, click on the left Cut Handle and press [Backspace] or [Delete], or select “Delete” from the Edit 

menu or context menu.
The segment to the right of the deleted Cut will be deleted. The segment to the left of the deleted Cut will expand 
and replace the deleted segment:

D Alternatively, select the Eraser Tool and click on the Cut Handle.

Moving Cuts
Moving Cuts has a similar effect to resizing a clip, i.e. you select what part of the recording on the Comp Row should 
be active for playback. Recordings outside the active segment on the Comp Row will be masked (silent) but not af-
fected in any other way.

D To move a Cut, click and hold its right Cut Handle, or Cut Line, and drag it horizontally in either direction.
The segment to the left of the Cut Line will be resized. The segment to the right of the resized segment will now 
have a new start position:

! Recordings in the segments will not be moved back or forth - only masked according to the current positions 
of the Cut Handles/Lines. Any Cut Crossfades will also move along with the Cut Handles/Lines.

! Two Cuts can never exist on the same position. If you drag a Cut to the position of another Cut and release the 
mouse button, the moved Cut will disappear. If you do this by mistake, you can always use the Undo function.

D To move a Cut and have the recording on the Comp Row move along with the Cut, select the Comp Row and 
the Cut Handle using the standard [Ctrl]-click (Win) or [Shift]-click method. Then, click and drag the Cut to the 
desired position.

! Note that Snap is taken into account (if activated).

• It’s also possible to use the Inspector to move Cuts numerically - see “Editing recordings and cuts in the In-
spector”.

Click on a Cut Handle to select it Press [Backspace] or [Delete] to delete the 
segment to the right of the Cut Handle

Click on a Cut Handle to select it Drag the Cut Handle to horizontally to move it
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Changing Comp Row assignments
When you have created a comped audio clip, you might later want to change which Comp Rows are assigned to play:

D Choose the Selection Tool and double-click on the Comp Row that contains the recording you want to assign 
to the Segment.
Make sure you double-click in the area between the desired Segment’s Cut Lines.

You can also use keyboard commands to change comp row assignments and segment focus as follows:

D Hold down [Ctrl](Win) or [Cmd](Mac) and press the up/down arrow keys to select which Comp Row that 
should be assigned.

D To change Segment focus, hold down [Ctrl]+[Alt]+[Shift](Win) or [Cmd]+[Option]+[Shift](Mac) and press the 
left/right arrow keys.
This will move the Segment Focus Indicator between the segments. Note that you can still change comp row as-
signments using this keyboard command together with the up/down arrow keys.

The Segment Focus Indicator shows which segment has currently focus

Double-click on the Comp Row you want to 
assign to the segment

The segment will now play back this 
recording instead

Cut Row

Segment Focus Indicator
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Bounce Clip(s) to New Recording(s)
A very nice way to “clean up” among the recordings in a comped audio clip is to bounce the clip to a new recording. 
What happens is that the audio recordings in all segments of the comped clip, including any Cut Crossfades and in-
dividual Comp Row Levels, are combined into a single recording on an additional Comp Row. After the clip has been 
bounced to a new recording, you can delete the unused recordings to reduce the file size. Bouncing clips to new re-
cordings can be made for one or several selected audio clips:

D Select the clip(s) in the Clip Overview area in Edit Mode, or select the clip(s) in the Arrangement, and then se-
lect “Bounce Clip(s) to New Recording(s)” from the Edit menu or context menu.
A new “combined” recording is created on a new Comp Row, which is created above the other Comp Rows on the 
Edit Pane. The new Comp Row is assigned the suffix “(bounced)”.

As the clip is bounced, the Edit Mode view automatically switches from Comp Mode to Single Mode. If you play 
back the clip now, you will only hear the bounced recording on the topmost Comp Row. However, the clip will 
sound exactly the same as before the bounce.

If you’re happy with the result and don’t plan to edit the clip any further, you can use the “Delete Unused Record-
ings” function to delete the recordings on the original Comp Rows and reduce the file size (see “Delete Unused 
Recordings”). If file size is not an issue, you can keep the original takes in the clip. This way you can switch to 
Comp Mode at any time if you need to edit the comp.

q The “Bounce Clip to New Recording” function is very useful if you have imported a large audio file and only 
want to use a part of it. You can bounce the part of the clip you want use to a new recording and then delete 
the remaining unused part on the Comp Row to reduce the file size.

q It’s also possible to bounce Audio Clips to disk and to a Sample - see “Bouncing Audio Clips” and “Bounce 
Clip(s) to New Sample(s)”.

Select the clip in the Clip Overview Select “Bounce Clip to New Recording” to create a new 
combined recording on an additional Comp Row
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Creating a comped audio clip
If you have recorded more than one loop cycle of audio in Loop Mode (see “Recording audio in Loop mode”), or re-
corded over or into an existing audio clip (see “Recording over or into an existing audio clip”), each recording has 
been placed on a separate Comp Row. If you like, you can now select the best parts (segments) of the recordings on 
the various Comp Rows and create a final “comped” audio clip. All editing described below is non-destructive and can 
be changed at any time:
1. Open the audio clip.

If the clip was recorded in Loop Mode, it will automatically open in Comp Mode (see Step 2 below). If the clip 
wasn’t recorded in Loop Mode, it will open in Single Mode. Each take has generated a separate Comp Row, each 
with a separate recording on it. The latest take, on the topmost Comp Row, is the one that will play back in Single 
Mode.

An audio clip with four separate takes recorded

2. If needed, click the Comp Mode button to switch to from Single Mode to Comp Mode.
The Cut Row and Silence Row now appear above the topmost Comp Row.

3. Find the best parts of the recordings in the different Comp Rows.
Audition the recordings on the Comp Rows to decide which recordings to use at what position in the comped clip. 
Select the Speaker Tool and click-hold at desired positions on the different Comp Rows (see “Speaker Tool” for 
details).

Comp Rows with audio 
recordings

Audio clip (latest take)

Silence Row
Cut Row
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q If you’re using the Selection Tool, you can temporarily switch to the Speaker Tool by holding down 
[Alt]+[Shift](Win) or [Cmd]+[Shift](Mac).

4. Double-click with the Selection Tool on the Comp Row you want to use first in the clip.
In this example, we decide to use the recording on the “Take 2” Comp Row:

Double-click on the “Take 2” Comp Row to assign it to the first segment of the clip

5. Select the Razor Tool in the Sequencer Toolbar - or, with the Selection Tool still selected, hold down [Alt](Win) 
or [Cmd](Mac).
We want the recording on the “Take 2” Comp Row to play until beat 3 of Bar 7. After beat 3 of bar 7 we want the 
clip to be silent to get rid of some background noise that could be heard when we recorded without playing any-
thing. Therefore, place the Razor Tool on the Silence Row at Beat 3 of bar 7 and click:

Now, you have assigned the recording on the “Take 2” Comp Row from the beginning of the clip to beat 3 of bar 
7. At the same time you have assigned the Silence Row to a second segment of the clip.

6. Use the Audition Tool to find a suitable recording to assign to a new segment in the clip.
We found a good recording that we want to use on the “Take 4” Comp Row between beat 3 and 4 of bar 8 until 
beat 1 of bar 11.

Place the Razor Tool on the Silence Row at 
beat 3 of bar 7...

...and click to assign the Silence Row to the 
second segment of the clip 
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7. Assign a complete segment by swiping with the Razor Tool.
Swipe with the Razor Tool on the “Take 4” Comp Row from beat 3 and 4 of bar 8 until beat 1 of bar 11:

Now the recording on the “Take 4” Comp Row is assigned to a third segment in the clip. Two new Cut Handles 
have been added: one at the beginning of the swiped segment and one at the end.

8. Assign a recording to the last segment of the clip.
We used the Audition Tool and found that the recording on the “Take 1” Comp Row was just what we were looking 
for to play through to the end the of the clip. Since a fourth segment was already created when you swiped in the 
previous step, you just need to double-click with the Selection Tool on the “Take 1” Comp Row, to the right of the 
last Cut Line, to assign the recording to the fourth segment:

Double-click on the “Take 1” Comp Row, to the right of the last Cut Line, 
to assign it to the last segment in the clip

Place the Razor Tool between beat 3 and 4 of bar 8 on 
the “Take 4” Comp Row and swipe...

...and release at beat 1 of bar 11
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9. To eliminate any clicks that might occur between the recordings in the different segments of our clip, let’s in-
troduce some crossfades.
Crossfades can be applied by first selecting a Cut Handle and then clicking with the Selection Tool and dragging 
the Cut Crossfade Handles that appear above the selected Cut Handle:

The crossfade slopes are indicated by curves on the assigned Segments. The longer the crossfade time, the flatter 
the curves.

Repeat the procedure for the other Cut Crossfade Handles in the clip if needed.

q If you want to set the same crossfade time for several Cuts, select the Cut Handles and use the “Match Value” 
function in the Inspector (see “Matching Cut Crossfades”).

10.Finally, you might want to trim the audio levels of the different recordings on the Comp Rows in the clip.
Click with the Selection Tool and drag the Comp Row Level Faders on the respective Comp Row to achieve a bal-
anced audio level throughout the clip. The Comp Row level adjustments can be made anytime during the creation 
of the comped audio clip.

Adjusting the individual Comp Row audio levels

q If you want to set the same level for several Comp Rows, select the Comp Rows and use the “Match Value” 
function in the Inspector (see “Matching Comp Row Levels”).

When you’re satisfied with your comped clip, you might want to use the "Bounce Clip to New Recording" function to 
create a single recording that plays back your comp (see “Bounce Clip(s) to New Recording(s)”).

This helps you keep things organized and can be a way to create a "snapshot" of your current comp, for comparison 
while you continue to fine-tune the edits.

If you're finished with a comp and want to keep the file size down, you can use "Bounce Clip to New Recording" to-
gether with the "Delete Unused Recordings" function to permanently remove all original takes (see “Delete Unused 
Recordings”).

Click and drag the Cut Crossfade Handle... ...to introduce a crossfade between the segments



AUDIO EDITING IN THE SEQUENCER204

Audio and tempo matching

Matching an imported audio clip to the song tempo
Audio files created by the Export or Bounce functions in Reason Essentials include information about their original 
tempo. When you import such an audio file, it will automatically be stretched to fit the tempo in the new song.

However, if you have imported an audio clip which has a steady, but unknown, tempo, you can adjust the imported clip 
to the song tempo. You can either use the Clip Tempo Scaling function to manually “stretch” the audio clip as de-
scribed in “Tempo scaling Clips”. 

Another way is to disable the automatic stretch for the audio clip and then adjust the sequencer tempo to match the 
clip. This is done in two steps: first you adjust the song tempo to the imported audio clip without Stretch enabled and 
then adjust the song tempo back to original - with Stretch enabled on the audio clip:
1. Select the clip containing the imported audio file and choose “Disable Stretch” from the Edit menu or context 

menu.
Disabling Stretch makes the audio recording in the clip play back at the same tempo regardless of song tempo in 
the sequencer.

Disabling Stretch on a clip containing an imported audio recording

2. Start the sequencer and adjust the sequencer Tempo, up or down, to match the tempo of the audio recording 
in the clip.
If necessary, enable the metronome click in the sequencer to get an audible tempo reference. Continue adjusting 
the tempo of the song until it matches the tempo of the audio recording.

3. Adjust the length of the clip so that it plays the entire audio file (or as much as you want).

4. Select the clip and select "Bounce Clip to New Recording" from the Edit menu or context menu.
The new recording will sound the same, but include information about the tempo you set in step 2.

5. With the audio clip still selected, choose “Enable Stretch” from the Edit menu or context menu.
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6. Adjust the song tempo back to the original BPM.
As you adjust the song tempo, the tempo of the audio recording will follow along accordingly - without affecting 
the original pitch of the recording. This is done by stretching the audio. Reason Essentials does this automatically 
in two parallel steps: a real-time “preview” stretch so that you can instantly hear the result of your tempo changes, 
then a high quality stretch “in the background” to further improve the sonic results. As soon as high quality stretch 
is in progress, the “Calc” indicator on the Transport Panel shows a progress bar:

The CALC progress bar appears when Reason Essentials performs high quality stretching of audio

Since the high quality stretch is performed in the background, you can still continue to work with your song without 
any interruption. When the high quality stretch data has been calculated, the Calc indicator goes out and the high 
quality audio data will be heard on playback.

Moving a snare hit
Let’s say you have recorded live drums on a couple of audio tracks. The tempo is OK throughout the song, but there 
was a single snare hit that came a little late. In this situation you would only need to move this single snare hit to get 
the drums right. The following example shows how to do this:
1. Open the clip which contains the “off beat” snare hit.

Zoom in so you can see the individual snare hits clearly. (In between the “main” snare hits, there are some ghost 
notes as well.)

The first and third snare hits are right on the beat whereas the second hit is a little late

2. Switch to Comp Mode and select the Razor Tool.

First hit Second hit Third hit
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3. Hold down [Ctrl](Win) or [Option](Mac) and copy and swipe the region surrounding the second snare hit.
Make sure there is some silence before and after the swiped region.

Copy and swipe around the second snare hit

When you release the mouse button, a duplicate of the Comp Row will be created and the swiped region will au-
tomatically be assigned to a new segment:

The swiped region duplicated on a new Comp Row and assigned to a new segment

First hit Second hit Third hit

First hit Second hit Third hit

Duplicated Comp Row



AUDIO EDITING IN THE SEQUENCER 207

All we need to do now is to adjust the position of the second snare hit so that it is on the beat.

4. Adjust the position of the second snare hit, either by clicking and dragging the Recording on the duplicated 
Comp Row slightly to the left, or by selecting the Comp Row and nudging the Recording with the arrow keys, or 
by changing the Recording Offset value in the Inspector.

Adjusting the Recording Offset on the duplicated Comp Row to align the second snare hit to the beat

Now, the second snare hit has been moved forward and aligned with the beat, without affecting the rest of the 
snare hits on the track. 

By using this method, you can adjust individual hits anywhere throughout the track. Just remember to duplicate the 
original Comp Row for each of the adjustments you need to make. Then, make the Recording Offset adjustments 
on the duplicated Comp Rows.

q You can duplicate Comp Rows in a clip as many times as you like without increasing the Song file size. Reason 
Essentials features a very sophisticated audio management system which re-uses the audio data internally.

First hit Second hit Third hit
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Editing audio using the Inspector
The Inspector can be used for editing audio recordings numerically.

Editing recordings and cuts in the Inspector
If you select a Comp Row, the two displays change to show the Recording Offset and Comp Row Level:

If you select a Cut Handle in Comp Mode, two displays appear, showing the Cut Handle’s Position and Crossfade 
time:

D Edit the values by clicking on a segment in a display and then dragging up/down, using the up/down spin con-
trols, or typing in new values. Snap is not taken into account. 
See “Inspector segment displays” for details on how to edit in the Inspector displays.

Editing multiple recordings or multiple cuts in the Inspector

When you edit values for several selected Comp Rows or objects (Cut Handles etc.), the changes will always be rel-
ative. For example, if you change the Recording Offset or Level when several Comp Rows are selected, the record-
ings will all be changed by the same amount; their relative values will be retained.

• If several Comp Rows are selected, the displays will show the values for the topmost selected Comp Row.

• If several Cut Handles are selected, the displays will show the Position and Crossfade values for earliest Cut 
Handle in the clip.

• If several Comp Rows, or several Cut Handles, are selected and any of their values differ, Match Value buttons 
appear next to the corresponding display.
For Cut Handles, only Crossfade values can be matched - not the Positions. See “Matching audio values using the 
"Match Values" function”.

• If Comp Rows and Cut Handles are selected in combination (e.g. for moving Cuts and recordings together as a 
group), no displays are shown in the Inspector.

Matching audio values using the "Match Values" function

The Match Values buttons appear as red ‘=’ signs

The “Match Values” function in the Inspector can be used for matching Recording Offsets and Comp Row Levels of 
several selected Comp Rows to the offset/level of the topmost selected Comp Row. It can also be used for matching 
Cut Crossfade values of several selected Cut Handles to the Crossfade value of the Cut Handle with the earliest start 
position in the clip.
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Matching Recording Offsets

Matching Recording Offsets is useful if you want to make sure that the Recordings on multiple Comp Rows start at 
the exact same position.
1. Select more than one Comp Row and then place the Selection Tool on the Recording Offset Match Value but-

ton.

Three selected Comp Rows (the three topmost)

The topmost Comp Row has the Recording Offset set to 2 beats.

2. Click the Match Value button to the right of the “Recording Offset” display.
The Recording Offsets on all selected Comp Rows have now been moved to 2 beats.

The Recording Offsets of the recordings on the three topmost Comp Rows have been moved to 2 beats
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Matching Comp Row Levels

Here’s an example showing how to match Comp Row Levels:

D Select several Comp Rows and then click the Level Match Value button.

The Levels on the three selected Comp Rows are matched and adjusted to -19.90 dB.

Matching Cut Crossfades

Matching Cut Crossfades is a time-saving function if you want to apply the same Crossfade times to several Cuts 
throughout the clip. If you want to eliminate any clicks between segments in your comped clip, you could apply a Cut 
Crossfade to the first Cut and then match the other Cuts to get the same Crossfade times in one go:

D Select several Cut Handles and click the Cut Crossfade Match Value button.

The Crossfades of the selected Cuts are matched and adjusted to the Crossfade times of the earliest selected Cut



Chapter 9
Note and Automation 
Editing



NOTE AND AUTOMATION EDITING212

About this chapter
This chapter describes how to edit note and parameter automation events after they have been recorded in the se-
quencer. It also describes how to manually create note and automation events in clips. General sequencer functions, 
recording, editing audio and arranging in the sequencer are described in detail in the chapters “Sequencer Func-
tions”, “Recording in the Sequencer”, “Audio Editing in the Sequencer” and “Arranging in the Sequencer”.

The Edit Mode
After you have recorded in note clips or parameter automation clips, you might want to edit and correct any mistakes 
you made during the recording. For example, if you accidentally hit the wrong key or used the Mod Wheel too exten-
sively when you recorded a note clip, there is no need to redo the recording. Individual notes and parameter automa-
tion events can easily be edited and corrected in a number of different ways.

Edit Mode in the sequencer is used to perform detailed editing of note and automation events.

D To enter Edit Mode, either double-click a note or automation clip in Arrange Mode or click the Edit Mode but-
ton in the top left corner of the sequencer.

Edit Mode selected with a note clip open for editing.

D Exit Edit Mode by clicking the Edit Mode button again, or by clicking the “Back” button to the left of the Ruler.

Click the Edit Mode button or the Back button to revert to Arrange Mode.

D Toggle between Arrange Mode and Edit Mode by pressing [Shift]-[Tab] or by holding [Ctrl](Win) or [Cmd](Mac) 
and pressing [E].
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Selecting what to edit
The Edit Mode shows the contents of a single track at a time on the Edit Pane. On instrument tracks, only one note 
lane can have edit focus at a time.

• If a track is selected when you enter Edit Mode, the contents of the note lane with edit focus will be shown.
Also, all parameter automation lanes will be shown at the bottom of the Edit Pane. If a single clip was selected on 
the note lane with edit focus when you switched to Edit Mode, it will automatically be opened. If no clip was se-
lected, the events will be grayed out. To be able to edit or draw notes and/or automation events, you need to open 
the clip, for example by double-clicking it (see “Opening note and automation clips for editing”).

• If the selected track has multiple note lanes, the contents of the currently selected note lane will be shown.
To switch edit focus between note lanes, click on the note lane handle in the Track List.

A note lane handle

• You can change track and note lane edit focus at any time, by clicking in the Track List.
This way you can stay in Edit Mode and change edit focus between different tracks and note lanes, without having 
to go back to Arrange Mode.

Opening note and automation clips for editing

Open a note clip for editing

Note clips can contain both note events - with velocity values - and performance controller events. By default, perfor-
mance controllers include Mod Wheel, Pitch Bend, Sustain Pedal, Aftertouch, Expression and Breath Controller. 
However, the controller configuration can easily be changed (see “Creating new performance controller automation 
lanes” and “Deleting performance controller automation lanes”).

In Arrange Mode, note events are displayed in a “piano roll” fashion whereas performance controllers are displayed as 
curves or lines in the clip. In Arrange Mode, it’s not possible to distinguish one performance controller from another 
since all controllers are displayed together in the clip. The note clip in the picture below contains note events and 
Mod Wheel and Pitch Bend performance controller events:
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D To edit the events in a note clip, open the clip by double-clicking it, or select it and press [Return].
Opening a note clip in Arrange Mode automatically switches the sequencer to Edit Mode.

Double-clicking a note clip in Arrange Mode...

...opens it for editing in Edit Mode. An open clip in Edit Mode is highlighted.

D Double-click on a closed (grayed out events) note clip in Edit Mode to open it for editing in Edit Mode.
You can double-click in the Clip Overview, Note Edit Lane or any of the Performance Controller Edit Lanes (if any).

D To close a clip, press [Esc], click outside the open clip in the Clip Overview, or click the Edit Mode or Back but-
ton.
If you opened the clip from Arrange Mode, pressing [Esc] will automatically switch the sequencer back to Arrange 
Mode.

Open a parameter automation clip for editing

A parameter automation clip contains automation events for a single parameter.

D Double-click on a parameter automation clip in Arrange Mode to open it for editing in Arrange Mode.
The parameter automation lane expands in height to make it easier to edit the automation events. Now you can 
edit the parameter automation events without needing to switch to Edit Mode. This is very practical if you want to 
perform quick editing of automation events.

A parameter automation clip before and after opening it in Arrange Mode

D To close an open parameter automation clip in Arrange Mode, press [Esc] or click anywhere on another lane.

See “Editing parameter automation in Arrange Mode” for information on how to edit parameter automation events in 
Arrange Mode.
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D Double-click on a parameter automation clip in Edit Mode to open it for editing in Edit Mode.

A parameter automation clip before and after opening it in Edit Mode

D To close an open parameter automation clip in Edit Mode, press [Esc] or click anywhere on another lane.

See “Editing parameter automation in Edit Mode” for information on how to edit parameter automation events in Edit 
Mode.

Edit Mode elements
In Edit Mode, a note clip is divided into various Edit Lanes which are used for editing different types of events and val-
ues (i.e. note events, velocity values and performance controller automation events). At the bottom, any parameter au-
tomation lanes on the track will also be shown. The different Edit Lanes can be resized by adjusting the horizontal 
dividers between the lanes. You can also scroll and zoom on each Edit Lane by using the scroll bars and Vertical 
Zoom tools on the right hand side of the Edit Pane.

The picture shows three note clips in Edit Mode. The center clip is open for editing and therefore highlighted. Adjacent (closed) 
clips on the same lane are visible but the events are grayed out.

Clip Resize Handles

Note Edit Mode Selector

Vertical Zoom tools

Vertical Zoom tools

Performance Controller 
Automation Selector

Velocity Edit Lane

Performance Controller 
Edit Lanes

Static Value Handles

Clip Overview

Note Edit Lane

Parameter Automation 
Lanes

Vertical Zoom tools

Back button
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From the top down in the picture above, the Edit Pane contains the following elements:

• Back button
Click the Back button to exit Edit Mode and return to Arrange Mode.

• Clip Resize Handles
By clicking and dragging either of the handles, you can change the position and length of the clip.

• Clip Overview
The Clip Overview shows the note clips of the note lane which has edit focus. You can select one or several clips 
in the Clip Overview and perform clip-based editing (e.g. moving and resizing) - just like in Arrange Mode.

• Note Edit Mode Selector
To the right of the Note Edit Lane, below the Vertical Zoom tools, is the Note Edit Mode Selector. Click to choose 
between Key Edit, Drum Edit or REX Edit Mode. Depending on selected mode, the Note Edit Lane will display dif-
ferently. See more about the different modes in “Note Edit Modes”.

• Performance Controller Automation Selector
Each performance controller you used when recording the note clip has its own separate Performance Controller 
Edit Lane. You can add or delete performance controller edit lanes from the clip using this selector. See the “Cre-
ating new performance controller automation lanes” and “Deleting performance controller automation lanes” for 
more details.

• Note Edit Lane
Here you can edit the notes of one open clip at a time. Note events are displayed as orange horizontal “boxes” in 
a piano roll fashion on the Note Edit Lane. The left side of each box indicates Note On (key down) and the right 
side Note Off (key up). The color intensity of each box indicates the velocity for the corresponding note. Depend-
ing on selected Note Edit Mode (see “Note Edit Modes”), the contents of the Note Edit Lane will display differently.

• Velocity Edit Lane
The Velocity Edit Lane shows the velocity values for each of the recorded notes. Velocity values are automatically 
recorded together with notes. See more about editing velocity values in “Editing note velocity”.

• Performance Controller Edit Lanes
On the Performance Controller Edit Lanes are the performance controller events for Mod Wheel, Pitch Bend, Sus-
tain Pedal etc. Performance controller events are automatically distributed on separate lanes for each recognized 
controller during recording. Even though performance controllers belong to separate note clips, they will affect all 
active parallel note lanes on a track. See “Automation editing” for details on how to edit performance controller 
events.

• Parameter Automation Lanes
Any recorded parameter automation will be shown in separate clips, on separate Parameter Automation Lanes. 
Parameter automation clips don’t “belong” to the note lane or to any note clips, and will not be opened together 
with note clips. Double-clicking on a parameter automation clip will open it for editing. See “Automation editing”.

• Static Value Handles
The Static Value Handles to the left of the Performance Controller Edit Lanes and Parameter Automation Lanes 
indicate to what value the automated controller/parameter will default to where there are no clips on the lane. Ba-
sically, this value reflects the parameter’s initial value, before it was automated. You can easily change a parame-
ter’s Static Value by dragging the Static Value Handle up or down. See “Automation editing” for more details.
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Edit Mode window handling

Resizing, zooming and scrolling

D You can resize or hide Edit Lanes by dragging the dividers between them.

Where applicable, individual zoom controls and scrollbars are available to the right of each Edit Lane. 

D The Magnifying Glass tool can be used for zooming in and out (see “Magnifying Glass Tool”).

D The Hand tool can be used for scrolling the view in any direction (see “Hand Tool”).

D Use the Song Navigator to scroll and zoom horizontally (see “Areas, windows and basic navigation”).

D Click on a Song Navigator Handle and drag horizontally to zoom in and out horizontally (see “Areas, windows 
and basic navigation”).

D Shift-click on a Song Navigator Handle and drag horizontally to zoom in and out horizontally, symmetrically 
(see “Areas, windows and basic navigation”).

D Shift-click or Right-click (Win) or Ctrl-click (Mac) inside the Song Navigator and drag up or down to zoom in 
and out horizontally, symmetrically (see “Areas, windows and basic navigation”).

D Use the Scrollbars to scroll vertically in the respective Edit Lanes.

D Click the Zoom buttons to the right to zoom in and out vertically in the respective Edit Lanes.

• For extensive editing, you may want to maximize the sequencer and/or have it in a separate window covering 
the entire computer screen. Refer to “Areas, windows and basic navigation”.

Note Edit Modes
When you switch to Edit Mode, the device used on the selected instrument track determines which Note Edit Mode 
is selected. For instrument tracks associated with synth devices such as the ID 8 device, for example, Key Edit Mode 
is automatically selected. For Redrum tracks Drum Edit Mode is selected and for Dr. Octo Rex tracks the REX Edit 
Mode is automatically selected.

In all three Note Edit Modes, the note events are shown as “boxes”, with the note length indicated by the width of the 
box and the velocity values indicated by the color intensity of the box (the darker the color, the higher the velocity). 
The basic note editing procedures are the same for all three Note Edit Modes.
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D You can manually change Note Edit Mode by clicking the Note Edit Mode button in the upper right corner of 
the Note Edit Lane and selecting another mode from the pop-up menu.

Selecting Note Edit Mode

The selected Note Edit Mode is automatically remembered for each note lane on a track. The next time you switch 
to Edit Mode, the correct Note Edit Mode will be recalled for that note lane.

Key Edit Mode

Key Edit Mode

Key Edit Mode is best suited for viewing and editing notes recorded for instrument devices, such as the ID 8. The pi-
ano keyboard to the left indicates the notes values, covering the entire MIDI note range (C-2 to G8). By clicking on 
any of the keys, you can audition the notes. As soon as the mouse pointer reaches the keyboard section, the cursor 
changes to a speaker symbol.

q Note that the black and white keys are reflected in the background colors of the Note Edit Lane grid, making it 
easier to locate the desired note when drawing and moving note events.
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Drum Edit Mode

Drum Edit Mode

Drum Edit Mode is best suited for viewing and editing notes recorded for a Redrum device. In Drum Edit Mode the 
keyboard has been replaced by a list showing the corresponding Redrum drum sound channel names. If the track is 
associated with another type of instrument device, the list shows MIDI note numbers (0-127) instead. By clicking on 
any of the names (or note numbers) in the list, you can audition the sounds.

REX Edit Mode

REX Edit Mode

REX Edit Mode is designed for viewing and editing Dr. Octo Rex Loop Player slices. In REX Edit Mode the keyboard 
has been replaced by a list showing the corresponding loop slice numbers in a Dr. Octo Rex device. Slice #1 in the 
list corresponds to the note C3. By clicking on any of the slice numbers in the list, you can audition the corresponding 
sound of the Rex loop.
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Creating empty clips
When recording in the sequencer, clips are automatically created on the record enabled lane when necessary. How-
ever, there might be situations when you want to manually draw empty clips in Arrange Mode to record or edit in later 
on:
1. Select the Pencil Tool from the sequencer Toolbar.

2. Place the Pencil on the lane where you want the clip to begin.
If you want to create a note clip, draw it on a note lane. If you want to create a parameter automation clip, draw it 
on a parameter automation lane. If Snap is activated, the clip start and end boundaries will snap to the set Snap 
value (see “Snap”).

3. Click and drag the Pencil to the right where you want the clip to end.

An empty note clip in Arrange Mode created using the Pencil Tool

D You can also draw empty clips in Edit Mode. A note clip should then be drawn in the Clip Overview and a pa-
rameter automation clip on the corresponding Parameter Automation Lane.
If you draw on the Edit Pane in Edit Mode, a note will be created instead. If necessary, a new clip will be automat-
ically created to surround the note.

q See also “Drawing notes” and “Drawing parameter automation events”.
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Tool Window editing tools
The Sequencer Tools tab in the Tool Window is very useful when you want to perform various note and parameter au-
tomation editing tasks. Here is how you access the Tool Window and the contents of the Sequencer Tools tab:
1. Open the Tool Window by selecting “Show Tool Window” from the Window menu. Alternatively, press [F8].

The [F8] key can be used for toggling between showing and hiding the Tool Window.

2. Click the Sequencer Tools tab.

The Sequencer Tools page has a number of panes, each with a separate function.

D Click on the arrow buttons to the right of the function name to fold/unfold the corresponding pane.

D Hold down [Alt](Win) or [Option](Mac) an click an arrow button to fold/unfold all panes simultaneously.

The values in the displays on the various panes can be edited in similar ways as in the Inspector. For single-segment 
displays, you can either use the spin controls or click in the display and select a value from a list, or drag up or down 
to change the value. For multi-segment displays, click on a specific segment (e.g. bars, beats, 1/16ths or ticks) and 
then use the spin controls to set the value. Alternatively, click on a segment and drag up or down.

Fold/unfold buttons
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Note editing
Notes can be edited using the mouse in Edit Mode. It’s also possible to edit notes by using the functions on the Tools 
tab in the Tool Window. Notes can also be numerically edited in the Inspector, as described in “Note and automation 
editing in the Inspector”.

Selecting notes
To select notes in an open clip in Edit Mode, use one of the following methods:

D Click on a note event with the Selection (Arrow) Tool.

The Selection tool

A selected note is distinguished by a darker color and by the handle at the right edge

D To select several notes, hold down [Ctrl](Win) or [Shift](Mac) and click on the desired notes, one after the 
other. You can de-select individual notes by [Ctrl](Win)-clicking or [Shift](Mac)-clicking them again. In Win-
dows it’s also possible to select a range of notes by [Shift]-clicking the first and last note in the range.

D You can also click and drag a selection rectangle around the notes you want to select.

D You can select the next or previous note on the lane by pressing the right or left arrow key on the computer 
keyboard.
Holding down [Shift] and using the arrow keys allows you to make multiple selections.

D To select all notes of the same pitch (note value) in a clip, first select one or several notes and then use the 
function "Select Notes of Same Pitch" on the Edit menu or context menu.

D To select all notes in the open clip, use the “Select All” function on the Edit menu. Alternatively, hold down 
[Ctrl](Win) or [Cmd](Mac) and press [A].

D To deselect all notes, click somewhere in an empty area in the clip (where there are no events).

Deleting notes
You can delete notes by doing any of the following:

D Select one or several notes with the Selection (Arrow) tool and press [Backspace] or [Delete], or select “De-
lete” from the Edit or context menu.

D Select the Eraser tool and click on the notes you want to delete.

The Eraser tool

D You can also draw a selection rectangle with the Eraser tool to delete several notes in one go.
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Drawing notes
Notes are usually drawn and edited in Key Edit Mode on the Note Edit Lane, but the actions described below also ap-
ply to the Drum Edit Mode and the REX Edit Mode.
1. If you want to restrict note input to certain note values (e.g. 1/16th notes), activate Snap (see “Snap”) and set 

the snap value accordingly.

2. Select the Pencil tool.

q With the Selection (Arrow) tool selected, you can toggle temporarily between the Selection tool and the Pencil 
tool by holding down [Alt](Win) or [Cmd](Mac).

3. Click at the desired position on the Note Edit Lane.
A note will be inserted at the closest Snap value position. By default, the note will be given the Velocity value ‘100’. 
(This can be edited afterwards according to the descriptions in “Editing note velocity”). If an open or closed clip is 
already present on the Note Lane, at the position where you draw the note, the note will be placed in that clip. If no 
clip is available, refer to “About drawing notes outside an open clip” and “About drawing notes outside a closed 
clip” below.

• If you just click, and Snap is activated, the note will get the length of the set Snap value.
If Snap is off, the note will get the length of the shortest possible Snap value, i.e. 1/64th note.

• If you click and keep the mouse button depressed, you can drag to the right to set the length of the note.
If Snap is on, the length will be a multiple of the Snap value. 

! If you are drawing drum notes for a Redrum device, refer to the info about drum note lengths in “About resiz-
ing drum notes”.
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About drawing notes outside an open clip

If you draw notes outside the boundaries of an open clip, the result depends on the setting "Keep Events in Clip 
While Editing" on the Options menu:

• If the “Keep Events in Clip While Editing” option is active, the notes will belong to the open clip after they have 
been drawn, but become masked since they are drawn outside the clip boundaries. 
The clip position and length will remain unchanged.

• If "Keep Events in Clip While Editing" is deactivated and you draw notes outside the clip, the notes will be 
placed in an existing clip - or in another new clip on the lane, depending on where you draw.
The picture below shows three scenarios when drawing a note outside an open clip with the “Keep Events in Clip 
While Editing” option off:

About drawing notes outside a closed clip

If you draw notes outside the boundaries of a closed clip in Edit Mode, i.e. where there are no clips available on the 
lane, a new clip will be automatically created and opened. The clip length is determined by Arrange Mode Snap value, 
if Snap is activated.

q This works best with "Keep Events in Clip while Editing" turned OFF because then you can continue drawing 
notes - the clip will be resized to fit the new notes.

Here, we’re going to draw a note in beat 3 of bar 5... The open clip expands by the set Arrange Mode Snap 
value (1 bar) to fit in the new note.

Here, we’re going to draw a note in beat 3 of bar 8... The note is placed in the existing clip at beat 3 of bar 8.

Here, we’re going to draw a note in beat 1 of bar 12... A new clip is created at bar 12 with a length of the set 
Snap value (1 bar) and the new note is placed in beat 1
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Resizing notes

Resizing notes manually

When you select a note on the Edit Pane, a handle appears on its right edge. You can click on this handle and drag 
sideways to make the note shorter or longer.

• If Snap is on (see “Snap”), the end of the note will be magnetic to the Snap value positions.

• If several notes are selected, all will be resized by the same amount.

• When resizing notes the event may extend outside the right clip boundary.
As long as the start position of events is inside the clip, the note will play for the whole duration, i.e. it won’t be cut 
off when the clip ends.

About resizing drum notes

Redrum drum notes can be resized, just like any other notes. However, the audible result of this depends on the set-
tings of the Decay/Gate switch and the Length knob for the drum sound on the Redrum device panel:

• If Decay mode is selected, the drum sound will play to its end, regardless of the note length in the sequencer.
Or rather, it will fade out according to the Length parameter setting on the Redrum device panel.

• If Gate mode is selected, the note lengths in the sequencer affect the resulting sound.
However, the maximum length of the sound is determined by the Length knob setting - the sound will be cut off 
after this length, regardless of the note length in the sequencer. Also, even if the Length knob is set to its maxi-
mum value, the sound will not play longer than the length of the drum sample.
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Resizing notes with the “Note Lengths” function

The Note Lengths pane in the Tool Window

The “Note Lengths” function on the Sequencer Tools tab in the Tool Window allows you to add or subtract length val-
ues to the selected notes.

Note length resizing can be applied to: 

• Individual (selected) note events in a note clip.
This has to be done in Edit Mode.

• All note events in one or several selected note clips.
This is done in Arrange Mode. If the clips are on the same lane, it can also be done in Edit Mode.

! In Edit Mode, select clip(s) by clicking on it/them in the Clip Overview.

• All note events in all note clips on one or several selected instrument tracks.
This has to be done in Arrange Mode.

D Click the “Add” or “Sub” radio button and select the length value to add or subtract in the corresponding dis-
play. Then, click “Apply”.

D Click the “Fixed” radio button to set all notes to the length defined in the display. Then, click “Apply”.

Resizing notes with the “Legato Adjustments” function

The Legato Adjustments pane in the Tool Window

The “Legato Adjustments” function can be used to extend each selected note so that it reaches the next selected 
note. You can also shorten the note length for the first of two selected overlapping notes and set a gap between 
them. You specify the desired gap or overlap in the displays. Only the note length is affected by Legato Adjustments 
- note start positions are never changed.

Legato adjustments can be applied to: 

• Individual (selected) note events in a note clip.
This has to be done in Edit Mode.

• All note events in one or several selected note clips.
This is done in Arrange Mode. If the clips are on the same lane, it can also be done in Edit Mode.
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! In Edit Mode, select clip(s) by clicking on it/them in the Clip Overview.

• All note events in all note clips on one or several selected instrument tracks.
This has to be done in Arrange Mode.

• “Side By Side (Abut)” extends the selected note(s) to the start of the next selected note(s):

A group of notes before and after applying the “Side By Side (Abut)” legato function

• “Overlap” extends the selected note(s) to overlap the next selected note(s) by a set amount.

A group of notes before and after applying the “Overlap” legato function with an overlap of 1/16th note

D “Gap by” introduces a gap between selected notes, which you specify in the “Gap by:” display.

A group of notes before and after applying the “Gap” legato function with a gap value of 1/16th note

Resizing notes in the Inspector

You can also edit the length of notes numerically in the inspector. See “Note and automation editing in the Inspector”.
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Moving notes

Moving notes manually

D To move a note, click and drag it to a new position, or new pitch (note number), using the Selection Tool.
If several notes are selected, all will be moved. If Snap is on (see “Snap”), the moved events will keep their relative 
distance to the Snap value positions. For example, if the Snap value is set to “Bar”, you can move the selected 
notes to another bar without affecting their relative timing.

• By default, when manually moving notes to new pitches (note numbers), the notes will trigger and sound. This 
makes it easier to move (transpose) the notes to where you want them.
If you don’t want notes to sound during editing, it’s possible to disable the function in the Preferences dialog by de-
selecting the “Trigger Notes While Editing” box:

The “Trigger Notes While Editing” function in the Preferences dialog

D If you hold down [Shift] when you drag, the movement is restricted to horizontal or vertical direction.
This helps you move notes without accidentally transposing them, or transpose notes without accidentally chang-
ing their position.

D You can also edit the note pitches numerically using the “Pitch (Transpose)” function in the Tool Window.
See “Transposing notes”.

D You can also move selected notes to a new note clip, on a new additional note lane, by right-clicking (Win) or 
[Ctrl]-clicking (Mac) and selecting “Move Selected Notes to New Lane” from the context menu.
A new note clip and note lane will be automatically created.
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About moving notes outside or between clips

If you want to move notes outside the boundaries of an open clip, the result depends on the setting "Keep Events in 
Clip While Editing" on the Options menu:

• If the “Keep Events in Clip While Editing” option is active, the notes will belong to the open clip after they have 
been moved, but become masked since they are moved outside the clip boundaries. 
The clip position and length will remain unchanged.

• If "Keep Events in Clip While Editing" is deactivated and you move notes outside the clip, the notes will be 
placed in an existing clip - or in a new clip on the lane, depending on to where you move them to.
The picture below shows three scenarios when moving three notes outside a clip with the “Keep Events in Clip 
While Editing” option off:

Changing note pitches (transpose) with the arrow keys

You can use the up/down arrow keys to change the pitches of selected notes by moving them up or down:

D Hold [Ctrl](Win) or [Cmd](Mac) and use the up or down arrow key to move the selected notes in semi-tone 
steps.

We’re going to move the last three notes in the clip to 
beat 3 in bar 5.

The open clip expands by the set Arrange Mode Snap 
value (1 bar) to fit in the moved notes.

Here, we’re going to move the last three notes in the 
clip to beat 4 in bar 10.

The notes are placed in the other existing clip at beat 4 
in bar 10.

Here, we’re going to move the last three notes in the 
clip to beat 1 in bar 12.

A new clip is created at bar 12 with a length of the set 
Snap value (1 bar) and the notes are placed in beat 1.



NOTE AND AUTOMATION EDITING230

Nudging note positions with the arrow keys

You can use the left or right arrow keys to “nudge” the positions of selected note events:

D Hold [Ctrl](Win) or [Cmd](Mac) and use the left or right arrow key to move the position back or forward by the 
set Snap value.

D Hold [Ctrl]+[Alt](Win) or [Cmd]+[Option](Mac) and use the left or right arrow key to move the position back or 
forward in Tick increments. 
There are 240 ticks per 1/16 note so this allows for very fine editing. Check the Tick value in the Inspector when 
you nudge because typically you won’t see the position changes on the Edit Pane, unless you have zoomed in a lot.

D Hold [Ctrl]+[Shift](Win) or [Cmd]+[Shift](Mac) and use the left or right arrow key to move the position back or 
forward in Beat increments.

About nudging notes outside an open clip

If you nudge notes outside the boundaries of an open clip, the notes will belong to the open clip, but become masked 
since they are nudged outside the clip boundaries. The “Keep Events in Clip While Editing” setting has no effect 
when nudging notes. If you want to move notes between clips, or to a new clip, you have to do that using the Selec-
tion Tool as described in “About moving notes outside or between clips”.

Moving notes with the “Alter Notes” function

The Alter Notes pane in the Tool Window

The “Alter Notes” function on the Sequencer Tools tab in the Tool Window alters the positions between the selected 
notes, in a random fashion.

The “Alter Notes” function can be applied to: 

• Individual (selected) note events in a note clip.
This has to be done in Edit Mode.

• All note events in one or several selected note clips.
This is done in Arrange Mode. If the clips are on the same lane, it can also be done in Edit Mode.

! In Edit Mode, select clip(s) by clicking on it/them in the Clip Overview.

• All note events in all note clips on one or several selected instrument tracks.
This has to be done in Arrange Mode.

• The Alter Notes function will only use the note positions that already exist among the selected notes.

D Adjust the alteration amount in with the Amount display.

q This function is especially useful for experimenting with rearranging Dr. Octo Rex loop slices. Select some 
slices on a Dr. Octo Rex track and use Alter Notes to rearrange the slices and create instant variations, without 
losing the timing and rhythmic feel of the loop.

Moving notes with the “Extract Notes to Lanes” and “Explode” functions

It’s possible to move defined notes in a clip to new clips on new, additional lanes. See “Extract Notes to Lanes”.
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Moving notes in the Inspector

You can also edit the note positions and pitches numerically in the inspector. See “Note and automation editing in the 
Inspector”.

Duplicating notes

Duplicating notes manually

D To duplicate selected notes, hold down [Ctrl](Win) or [Option](Mac) and click and drag a copy of the selection, 
similar to when moving notes manually (see “Moving notes”).

D You can also duplicate selected notes to a new note clip by right-clicking (Win) or [Ctrl]-clicking (Mac) and se-
lecting “Duplicate Selected Notes to New Lane” from the context menu.
This will automatically copy the selection and paste it in a new note clip on a new, additional note lane.

Duplicating notes with the “Extract Notes to Lanes” function

It’s possible to duplicate defined notes in a clip and automatically place them on new, additional lanes. See “Extract 
Notes to Lanes”.
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Using Cut, Copy and Paste
You can move or duplicate events using the Cut, Copy and Paste commands on the Edit menu or context menu.

• When you use Cut or Copy, the Song Position Pointer is automatically moved to the end of the selection.
This is very useful for repeating events, i.e. pasting the selection several times one after another in the song.

Pasting events outside an open clip

When you use the Paste command, the events will appear at the Song Position Pointer, on the original lane. Depend-
ing on the “Keep Events in Clip While Editing” setting in the Preferences dialog, the following rules apply:

• If the “Keep Events in Clip While Editing” option is active, the notes will belong to the open clip after they have 
been pasted, but become masked since they are pasted outside the clip boundaries. 
The clip position and length will remain unchanged.

• If "Keep Events in Clip While Editing" is deactivated and you paste notes outside the clip, the notes will be 
placed in an existing clip - or in another new clip on the lane, depending on where you paste them.
The picture below shows three scenarios where three notes are being cut and pasted at different positions outside 
the open clip with the “Keep Events in Clip While Editing” option off. We determine the paste positions by moving 
the Song Position Pointer:

We’re going to cut the last three notes in the open clip 
and paste at beat 3 in bar 5.

The open clip expands by the set Arrange Mode Snap 
value (1 bar) to fit in the pasted notes.

Here, we’re going to cut the last three notes in the open 
clip and paste at beat 4 in bar 10.

The notes are pasted in the other existing clip at beat 4 
in bar 10.

Here, we’re going to cut the last three notes in the open 
clip and paste at beat 1 in bar 12.

A new clip is created at bar 12, with a length of the set 
Snap value (1 bar), and the notes are pasted in beat 1.
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Quantizing notes
The “Quantize Notes” function on the Sequencer Tools tab in the Tool Window is used for applying quantization to 
notes. Clicking the Apply button will automatically align the start positions of the selected notes to a pre-defined, ab-
solute grid. You can also choose to automatically quantize notes as they are being recorded - see “Quantizing notes 
during recording”.

q You could also use the ReGroove functions for groove quantizing. See “The ReGroove Mixer”

Quantization can be applied to: 

• Individual (selected) notes in a note clip.
This has to be done in Edit Mode.

• All notes in one or several selected note clips.
This is done in Arrange Mode. If the clips are on the same lane, it can also be done in Edit Mode.

! In Edit Mode, select clip(s) by clicking on it/them in the Clip Overview.

• All notes in all note clips on one or several selected instrument tracks.
This has to be done in Arrange Mode.

The quantization grid is selected in the Quantize pane on the Tools tab in the Tool Window:

The Quantize pane in the Tool Window
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Quantizing notes after recording

1. Select the note(s), note clip(s) or instrument track(s) you want to quantize.
Only the notes in the clip(s) will be affected - not any parameter automation events.

2. Select a quantize value from the Value drop-down list in the Tool Window.
This determines to which note value grid the notes will be moved when you quantize. For example, if you select 
1/16 , all notes will be moved to (or closer to) the closest sixteenth note position.

The Quantize Value drop-down list

A ‘T’ letter next to some quantization value means Triplets. The effect of using triplets is that three notes are 
equally distributed over the same time period as two “regular” (non-triplet) notes of the same note value.

3. Select a value from the Quantize Amount drop-down list.
This is a percentage, governing how much each note should be moved. If you select 100%, notes will be moved all 
the way to the closest Quantize value positions; if you select 50%, notes will be moved half-way, etc.

The Quantize Amount drop-down list
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4. Click the Quantize “Apply” button.
The selected notes are quantized.

A sloppily recorded hi-hat pattern is quantized to straight 1/4 notes (Quantize Value 1/4, Amount 100%).

D Quantization can also be applied to note(s), clip(s) and track(s) by right-clicking(Win) or [Ctrl]-clicking(Mac) 
and selecting “Quantize” from the context menu.
The current settings on the “Quantize” pane in the Tool Window will apply when performing this operation.

Random

You can offset the quantized notes using the Random function. The notes will be quantized according to the Value 
and Amount settings, but the note positions will be randomly offset by the set tick value. E.g. if you set Random to 10 
ticks, the notes positions will randomly vary within a +/- 10 tick range after applying quantization.

Quantize to Shuffle

In the Value drop-down list, you will also find an option called “Shuffle”. If this is selected when you quantize, the notes 
are moved towards sixteenth note positions, but with Shuffle applied.

Shuffle creates a “swing feel” by delaying the even-numbered sixteenth notes (the sixteenth notes that fall in be-
tween the eighth notes). The amount of Shuffle is set with the Global Shuffle control in the ReGroove Mixer. Quan-
tizing to Shuffle is useful if you want to match the timing of recorded notes with pattern devices in the song (if Shuffle 
is activated in their patterns). However, a more flexible way of doing this would be to use the ReGroove mixer - see 
“The ReGroove Mixer” chapter for details.

! The Amount setting applies as when quantizing to “regular” note values.
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Quantizing notes during recording

It’s also possible to quantize input notes directly during recording. Activation of this function can be made in the Tool 
Window and/or on the Transport Panel:

D Enable note quantization by ticking the “Quantize During Recording” check box.

The Quantize Notes During Recording check box on the Sequencer Tools tab

D Alternatively, click the Q Rec button on the Transport Panel.

The Q Rec (Quantize During Recording) button on the Transport Panel

It doesn’t matter where you activate or deactivate this function - the current state is automatically mirrored at the 
other location.

Any notes recorded after having activated this function will be automatically quantized to the current settings on 
the “Quantize Notes” pane in the Tool Window.

Transposing notes

The Pitch pane in the Tool Window

The “Pitch” function in the Tool Window transposes selected notes, or all notes in selected clips, up or down. There is 
also a randomize function which randomly transposes the pitch of selected notes.

The “Pitch” function can be applied to: 

• Individual (selected) note events in a note clip.
This has to be done in Edit Mode.

• All note events in one or several selected note clips.
This is done in Arrange Mode. If the clips are on the same lane, it can also be done in Edit Mode.

! In Edit Mode, select clip(s) by clicking on it/them in the Clip Overview.

• All note events in all note clips on one or several selected instrument tracks.
This has to be done in Arrange Mode.
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Semi-tones

D Click the “Semi-tones” radio button and then select the number of semi-tones to transpose the selected notes 
up or down. Click “Apply” to transpose.

q You can also transpose notes by manually moving them using the mouse or arrow keys, as described in “Mov-
ing notes manually” and “Changing note pitches (transpose) with the arrow keys”.

q You can also transpose notes numerically in the inspector. See “Note and automation editing in the Inspec-
tor”.

Randomize

D Click the “Randomize” radio button and then select the note range to which to transpose the selected notes. 
Click “Apply” to transpose.
The selected notes will be randomly transposed within the set note range.

Extract Notes to Lanes

The Extract Notes to Lanes pane in the Tool Window

The “Extract Notes to Lanes” function on the Sequencer Tools tab in the Tool Window is used for moving or duplicat-
ing user-defined notes of a certain pitch, or notes within a defined pitch range, to a new note clip on a new, additional 
note lane. This function is very useful if you, for example, have recorded a drum track, with all notes in the same clip, 
and then want to extract individual drum sounds (note pitches in this case) to separate lanes to be able to edit them 
more easily - or to apply ReGroove channels (see “The ReGroove Mixer”).

The “Extract Notes to Lanes” function can be applied to: 

• Notes of defined pitches in one or several selected note clips.
If the clips are on the same lane, this can be done in Edit Mode. If the clips are on separate lanes, this has to be 
done in Arrange Mode.

! In Edit Mode, select clip(s) by clicking on it/them in the Clip Overview.

• Notes of defined pitches in all note clips on one or several selected instrument tracks.
This has to be done in Arrange Mode.
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Extract Notes to Lanes example

We have recorded a 4-bar drum beat, consisting of kick, snare and open+closed hi-hat, in a single clip on a note lane. 
Now, we want to extract the open and closed hi-hat sounds to a new separate note lane. Normally, this could be done 
in Arrange Mode, but to better show what happens with the individual note events, we will show this in Edit Mode:
1. Open the note clip in Edit Mode.

2. Click in the Clip Overview to enable the ”Extract Notes to Lanes” function.
Since the Extract Notes to Lanes function applies to selected clips and not to selected notes, you have to click in 
the Clip Overview to enable the function. (In Arrange Mode, you just select the clip by clicking on it).

Click in the Clip Overview to enable the Extract Notes to Lanes function

3. Define which notes you want to move on the “Extract Notes to Lanes” pane in the Tool Window.
We want to move the open and closed hi-hat notes, i.e. the note range from G#1 to B1. We therefore click the 
“Note Range” radio button and then select the note range in the “From:” and “To:” displays.

Select the notes to be moved
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4. Click the “Move” button on the “Extract Notes to Lanes” pane.
The open and closed hi-hat notes are now moved to a new clip on a new note lane. If we click in the Note Edit lane 
and scroll, we can see the moved hi-hat notes in the new clip:

The moved notes in a new clip on a new note lane

If we exit to Arrange Mode, we can see both the original clip and the new clip:

The original clip and the new clip in Arrange Mode

D If you want to move or duplicate notes of a certain note number only, click the “Single Note” radio button and 
select the note pitch in the display. Then click, the “Move” or “Duplicate” button.
Only the notes of the selected note number will be moved or duplicated to a new clip on a new note lane.

• The “Extract Notes to Lanes” function is available both in Edit Mode and Arrange Mode, since it’s applied to 
defined notes in clips and not to manually selected notes.

! Any recorded performance controller automation will remain on the original note lane.

The “Explode” function 

D Click the “Explode” radio button to move or duplicate notes of the same note numbers to new clips on sepa-
rate note lanes.
Notes of the same note number will be moved or duplicated to new separate clips on separate note lanes. A new 
lane will be created for each of the used note numbers in the original clip

q The “Explode” function is perfect if you have recorded a drum track and want to move, or duplicate, each indi-
vidual drum sound to a separate note lane for further editing. Applying different ReGroove channels to each of 
the generated note lanes could provide extremely nice grooves to the rhythm! See “The ReGroove Mixer” for 
more details.

New note lane

Original note lane

New note clip with 
the hi-hat sounds

Original note clip
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Scale Tempo

The Scale Tempo pane in the Tool Window

The “Scale Tempo” function in the Tool Window can be applied to selected notes and/or automation events. It can 
also be applied to selected note, audio and automation clips. The Scale Tempo function will make the selection play 
back faster (Scale factor above 100%) or slower (Scale factor below 100%). For notes and automation events, this 
is achieved by changing the position of the events (starting from the earliest selected event) and adjusting the length 
of the notes accordingly. For audio clips, high-quality stretching is applied to all audio recordings in the clip.

Tempo scaling can be applied to: 

• Individual (selected) note and/or parameter automation events in a clip.
This has to be done in Edit Mode.

• All note and/or parameter automation events and/or audio recordings in one or several selected clips.
This is done in Arrange Mode. If the clips are on the same lane, it can also be done in Edit Mode.

! In Edit Mode, select the clip(s) by clicking on it/them in the Clip Overview.

• All note and/or parameter automation events and/or audio recordings in all clips on one or several selected 
tracks.
This has to be done in Arrange Mode.

• The “Double” and “Half” buttons are “shortcuts” to Scale factors 200% and 50%, respectively.
These are probably the most common values used, simulating double tempo and half tempo scaling.

The result of applying Scale Tempo on note events with the Scale factor 200% (double speed).

• The “Scale to” function can be used for scaling selected clips, or selected events in an open clip, to a fix length. 
The segments in the “Scale to” box are divided into, bars, beats, 1/16th notes and tics.

! The Scale Tempo function affects note, performance controller, parameter automation, pattern change, tempo 
automation events and audio clips! It does NOT affect time signature automation. 

! Note that Pattern Automation Clips will only be resized - the pattern tempo in the source device will NOT be 
scaled but will still be synced to the main sequencer tempo!
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Editing note velocity

Editing note velocity manually

The velocity values of notes can be edited manually on the Velocity Edit Lane:

The velocity values are shown as bars, with taller bars indicating higher velocity. 
Note also that the color intensity of the notes and velocity bars reflect the velocity values.

D To change the velocity of a note, click on its velocity bar with the Pencil tool and drag the bar up or down. Click-
ing above or below a bar immediately adjusts the velocity to the level at which you click.
You can also edit the velocity of several notes at once by clicking and dragging with the Pencil tool.

D When the Pencil Tool is selected and you press [Ctrl](Win) or [Option](Mac) on the Velocity Edit Lane, the pen-
cil will change to a cross.
This is the Line Tool which is a special tool only available on the Velocity Edit Lane. By dragging across the velocity 
“bars”, at the desired height, you can quickly draw velocity ramps.

Drawing a velocity ramp with the Line Tool.

The Line Tool is probably the preferred method for creating regular, smooth ramps, or for giving all the notes the 
same velocity (by drawing a straight line), while the Pencil tool can be used for creating more irregular curves.



NOTE AND AUTOMATION EDITING242

D If you hold down [Shift] when you edit velocity values, only selected notes will be affected.
This can be very useful, especially in “crowded” sections with lots of notes. 
Consider for example if you have a busy drum beat, and want to adjust the velocity of the hi-hat notes only. Simply 
dragging with the Line- or Pencil tool would change the velocity of all other drum notes in the area too, but if you 
first select the hi-hat notes on the Drum Edit lane and press [Shift] as you draw, you can edit their velocity without 
affecting any other notes.

Editing note velocity with the “Note Velocity” function

The Note Velocity pane in the Tool Window

The “Note Velocity” function in the Tool Window can be used for adjusting the velocity of selected notes in a number 
of different ways.

Note velocity can be applied to: 

• Individual (selected) notes in a note clip.
This has to be done in Edit Mode.

• All notes in one or several selected note clips.
This is done in Arrange Mode. If the clips are on the same lane, it can also be done in Edit Mode.

! In Edit Mode, select clip(s) by clicking on it/them in the Clip Overview.

• All notes in all note clips on one or several selected instrument tracks.
This has to be done in Arrange Mode.

D The “Add” function lets you add a fixed value to the existing velocity values.
To subtract, choose a negative value. Note that the allowed range is 1-127.

D “Fixed” allows you to set a fixed velocity value for all selected notes.

D The “Scale” function allows you to scale velocities by a percentage factor.
Scaling by a factor of more than 100% will increase the velocity values, but also make the difference between soft 
and hard notes bigger.
Scaling by a factor of less than 100% will decrease the velocity values, but also make the difference between soft 
and hard notes smaller.

D “Random” will randomize the velocity values by a set percentage value.

q By combining the “Add” and “Scale” functions, you can adjust the “dynamics” of the notes in various ways. For 
example, by using a Scale factor below 100% and adding a suitable value in the “Add” display, you can “com-
press” the velocity (decreasing the difference between the velocity values without lowering the average veloc-
ity level).

Editing note velocity in the Inspector

You can also edit velocity values numerically in the Inspector. See “Note and automation editing in the Inspector”.
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Automation editing

Overview
Automation in Reason Essentials is vector-based. This means that automation is stored in clips as automation events 
(points), connected by lines.

Automation lanes for a Mixer 14:2 Level slider (top), Mute button (middle) and Aux Send slider (bottom) in Edit Mode. The Aux 
Send automation clip at the bottom is open for editing.

• Parameter automation is contained in automation clips on Parameter Automation Lanes (see “Edit Mode ele-
ments”).
Each automated parameter has its own Parameter Automation Lane.

• Performance controller automation is stored on Performance Controller Edit Lanes in note clips (see “Edit 
Mode elements”).

Editing parameter automation
Parameter automation events can be edited both in Arrange Mode and Edit Mode. In Arrange Mode the parameter 
automation clip can be opened in sort of a “semi edit mode”, which only shows the automation events of the selected 
clip. Editing automation events works in the same way, whether in Arrange Mode or in Edit mode - except that the 
Static Value for the automated parameter is shown and can be edited only in Edit mode.

Editing parameter automation in Arrange Mode

D In Arrange Mode, double-click the parameter automation clip on the parameter automation lane.
The parameter automation clip is now opened in Arrange Mode:

A parameter automation clip before and after opening it in Arrange Mode

Parameter automation events
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In the open parameter automation clip, it’s possible to move, add and delete automation events in the same way as in 
Edit Mode using the Selection (Arrow), Pencil and Eraser tools - see “Editing parameter automation in Edit Mode”.

• A selected automation event’s position and value is also shown in the Inspector.

The event’s position and value can be edited numerically in the displays - see “Note and automation editing in the 
Inspector”.

D To close an open parameter automation clip in Arrange Mode, press [Esc] or click on another lane on the Ar-
rangement Pane.

D If you resize the automation clip and make it longer, the first and/or last automation value will be extended all 
the way to the clip boundary.

In the picture above, a Mixer 14:2 Mute button is automated. The clip only contains a single automation point, but 
as we extend the clip in both directions, the value is automatically extended to the start and end of the clip. This 
means you can adjust the Mute automation time by moving and resizing the clip, without having to open the clip.

Selected parameter 
automation event

Position and Value of 
the selected parameter 
automation event
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Editing parameter automation in Edit Mode

1. Switch to Edit Mode and select the track containing the parameter automation you wish to edit.
Use the dividers if necessary to locate the automation clip to edit - these are located at the bottom of the Edit/Ar-
range Pane (not in the note clip). Parameter automation clips are distinguished by a “cut off” upper right corner.

An instrument track in Edit Mode with parameter automation clips at the bottom

2. Open the parameter automation clip for editing by double-clicking it or by selecting it and pressing [Return].
The parameter automation clip is now open for editing.

The “Parameter 1” automation clip open for editing in Edit Mode

In Edit Mode, the parameter’s Static Value is shown to the left in the automation lane. In this example, the Static 
Value is set to 20 - this means that the “Parameter 1” value will be set to 20 everywhere in the song except where 
there are automation clips for the parameter. 

Parameter automation 
clips in Edit Mode

Parameter automation 
clip open for editing
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D To change the Static Value, click and drag the handle up or down, or double-click and type in a new value.
To fine adjust the Static Value, hold down [Shift] when you click and drag.

3. When a parameter automation clip is open, you can select, move, copy or delete automation events, using the 
Selection (Arrow) Tool.
When moving automation events with the Selection (Arrow) Tool, Snap (see “Snap”) is taken into account if en-
abled. You can also resize the clip by dragging the clip handles.

D If you resize the automation clip and make it longer, the duration of the first or last automation event will be 
extended all the way to the clip boundaries (see the last example in “Editing parameter automation in Arrange 
Mode”).

• A selected automation event’s position and value is also shown in the Inspector.
These values can be edited numerically in the Inspector displays. See “Note and automation editing in the Inspec-
tor”.

About moving parameter automation events outside an open clip

If you move parameter automation events outside the boundaries of an open clip, the same rules apply as when mov-
ing note events outside an open clip. See “About moving notes outside or between clips”.

Drawing parameter automation events
D To add new parameter automation events, click or drag with the Pencil Tool in the open automation clip.

When dragging, the resulting curve (i.e. the number of points) depends on two factors; the selected “Automation 
Cleanup” setting in the Preferences menu (see “About Automation Cleanup”), and the snap value if Snap is acti-
vated (see “Snap”).

D Holding down [Ctrl](Win) or [Option](Mac) and clicking or dragging with the Pencil tool will insert an automa-
tion range (the same parameter value over a period of time).
The length of the range is set with the Snap value.

Drawing an automation range 

D When the automated parameter is “stepped” rather than continuous, there will be abrupt steps between the 
automation events instead of linear ramps.
Examples of stepped parameters could be device buttons and multi-mode selectors, and the Sustain Pedal perfor-
mance controller.

Stepped automation

Static Value handle
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About drawing parameter automation events outside an open clip

If you draw parameter automation events outside the boundaries of an open clip, the same rules apply as when draw-
ing note events outside an open clip. See “About drawing notes outside an open clip”.

Deleting automation events
D Deleting automation events is done in the same way as when deleting note events. I.e. click on events to select 

them or draw selection rectangles and then press [Backspace] or [Delete] - or use the Eraser tool (see “Delet-
ing notes”). 

D To clear all automation events in a clip, hold down [Ctrl](Win) or [Cmd](Mac) and press [A] to select all events, 
then press [Backspace] or [Delete]. Alternatively, delete the clip (or remove the whole lane to clear all automa-
tion for that parameter).

Editing performance controller automation
D To edit, draw or delete performance controller events, open the note clip in Edit Mode. 

Performance controllers (Mod Wheel and Pitch Bend in the example above) are shown on separate Performance 
Controller Edit Lanes at the bottom of the open note clip. The performance controller curves are also indicated in 
the Clip Overview (top), and in the clip in Arrange Mode.

D You can edit performance controller events using the Selection (Arrow), Pencil and Eraser tools, just like when 
editing parameter automation events in Edit Mode (see “Editing parameter automation in Edit Mode”).

Performance Controller 
Edit Lanes
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Creating new performance controller automation lanes

If you want to manually draw performance controller automation events for a controller which hasn’t already been 
automated, you have to create a new Performance Controller Edit Lane for that parameter. Proceed as follows:
1. Open the note clip in Edit Mode.

2. Select the new performance controller to be automated by clicking on the Performance Controller Automation 
Selector and selecting it from the pop-up list that appears:

In this example, we select Aftertouch.

3. A new Performance Controller Edit lane is created for the Aftertouch controller:

4. Now, you can draw Aftertouch performance controller events in the clip using the Pencil Tool as described in 
“Drawing parameter automation events”. 
Afterwards, you can edit the performance controller events the same way as with regular parameter automation 
events (see “Editing parameter automation in Edit Mode”).

D It’s also possible to add any of the available device panel parameters as a performance controller.
Just select the “More Parameters...” alternative in the Performance Controller Automation Selector pop-up and se-
lect desired parameter from the list.

Deleting performance controller automation lanes

D To delete a performance controller automation lane, de-select it from the Performance Controller Automation 
Selector list.
This brings up a confirmation alert if there is data on the lane (in any clip). You can delete without the alert by 
pressing [Ctrl](Win) or [Cmd](Mac) when you de-select the parameter from the list.

Performance Controller 
Automation Selector

Aftertouch Edit lane
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About Automation Cleanup
Automation Cleanup is a function for controlling the amount of parameter automation events that should be created 
during recording and/or manual drawing. The Automation Cleanup function applies to parameter automation events 
as well as to performance controller automation events. The Automation Cleanup level can be set in the Preferences 
menu and will apply to all new recorded automation events. You can also use the function on previously recorded pa-
rameter automation events. This is done on the Tools tab in the Tool Window.

Automation Cleanup in the “Preferences” menu

D If you feel you get too many automation events when recording or drawing events, you can adjust the “Auto-
mation Cleanup” setting in the Preferences dialog - General page to “Heavy” or “Maximum”:

This automatically removes superfluous automation events next time you record or draw events and simplifies the 
curves. Note that Snap (see “Snap”) also governs the number of events when drawing events.

Drawing automation with “Normal” Cleanup (left), and with “Maximum” Cleanup (right).

The “Automation Cleanup” function in the Tool Window

You can also apply Automation Cleanup to already recorded/drawn events. This is done on the Sequencer Tools tab 
in the Tool Window:

The Automation Cleanup pane in the Tool Window

The “Automation Cleanup” function can be applied to: 

• Individual (selected) parameter automation events in an open clip.
This has to be done in Edit Mode for performance controllers. For parameter automation, it can be done in both 
Edit Mode and Arrange Mode.

• All parameter automation events in one or several selected clips.
This is done in Arrange Mode. If the clips are on the same track, it can also be done in Edit Mode.

• All parameter automation events in all clips on one or several selected tracks.
This has to be done in Arrange Mode.
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Editing pattern automation
Pattern automation clips are viewed and edited in the Pattern Select lane, which is available on Dr. Octo Rex, Redrum 
and Matrix tracks:

Pattern changes are shown as clips with a Pattern Selector at the top (when the clip is selected). A single pattern au-
tomation clip can only contain data for a single pattern. In practice this means that each pattern automation clip only 
contains one pattern automation “event”. All pattern changes in the song will therefore require unique clips.

• Pattern (Bank and number)
The Pattern (Bank and number) indicate which pattern in the source device is playing in this clip. For Dr. Octo Rex 
devices, the Bank is of no importance.

• Pattern Selector

Click the Pattern Selector triangle, or double-click anywhere in the clip, to bring up a pop-up list featuring all avail-
able patterns (Banks and numbers) of the source device. Select another pattern from the list if you wish to change 
pattern in the selected clip. If several pattern clips are selected, selecting a pattern for one of them will set them all 
to play that pattern.

• Clip Resize handles
Click and drag any of the Clip Resize handles horizontally to resize the clip and thus change the pattern playback 
start position and/or duration.

! If there is pattern automation for a device, it will only play patterns where there are pattern clips.

Clip Resize handles

Pattern (Bank and number)

Pattern Selector



NOTE AND AUTOMATION EDITING 251

Drawing pattern automation
You can draw pattern automation clips on a Pattern Select lane with the Pencil tool:
1. Activate Snap and set the Snap value to the note position where you want to insert the pattern change clip 

(see “Snap”).
It is probably a good idea to set the Snap value to “Bar”, at least if you are working with patterns of a length corre-
sponding to the time signature (e.g. 16 or 32 step patterns and 4/4 time signature). However, if you are working 
with patterns of another length, it can make sense to use other Snap values when drawing pattern automation 
clips.

2. Select the Pencil Tool.
A Pattern/Loop drop-down list appears in the Inspector. Use this to select the pattern/loop you wish the clip to 
play. For Dr. Octo Rex devices, the Bank is of no importance.

3. Draw a clip for length you want the selected pattern to play.

4. Continue using the same method to draw clips for all the patterns you wish to use.

q Don’t draw pattern change clips with Snap turned off, unless you want chaotic pattern changes!
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Moving, resizing and duplicating pattern automation clips
• You can move, resize and duplicate pattern automation clips in the same way as with note or automation clips.

However, it is recommended that Snap is activated (and in most cases set to “Bar”) when you do this (see “Snap”).

! If you resize a pattern automation clip by clicking and dragging the left resize handle, and thus change the 
start position, the clip will be masked (just like a note clip). This means the pattern won’t necessarily begin on 
beat 1. A selected pattern automation clip that has a masked start position will indicate this in the Pattern Off-
set display in the Inspector.

A pattern automation clip drawn between bar 1 and 5

Now, if we resize the clip by dragging the left resize handle two beats to the right, the Pattern Offset will change 
but the pattern will play back as expected:

The same pattern automation clip “resized” to begin at beat 2

• You can also move or duplicate pattern automation clips using the Cut, Copy and Paste commands on the Edit 
menu or context menu.
Again, the same rules apply as for note and parameter automation clips.

Deleting pattern automation clips
D Deleting pattern automation clips is done in the same way as deleting note clips. I.e. you can select or draw se-

lection rectangles and then press [Backspace] or use the Eraser tool etc.

D To clear all automation in a clip, simply delete the clip (or remove the whole lane to clear all pattern change au-
tomation on the track).
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The “Convert Pattern Automation to Notes” function
If you have recorded or drawn pattern automation on a Redrum or Matrix track, you can automatically convert the 
whole pattern automation lane into note events on an additional note lane. Proceed as follows:
1. Select the track with the pattern automation.

2. Select “Convert Pattern Automation to Notes” from the Edit menu or the track’s context menu.
For each pattern automation clip, the corresponding device pattern is converted to note clips on an additional note 
lane on the track. The generated note lane will play back just the same as when you played the pattern device with 
the pattern changes.

• The pattern automation lane is automatically disabled (turned off) after this operation.
You can later go back to pattern automation if you wish, by turning on the pattern lane again.

Redrum specifics:

• The “Enable Pattern Section” switch on the Redrum device is automatically turned off when you use the “Con-
vert Pattern Track to Notes” function.

Matrix specifics:

• Make sure that the correct track is selected (normally the track for the device that the Matrix is connected to)!
Creating notes for the Matrix itself is pointless, as the Matrix cannot produce any sound.

• You may want to disconnect or even remove the Matrix device after performing this function. 
This is because you probably don’t want both the Matrix and the sequencer notes to play the device at the same 
time.

Editing tempo automation
Tempo automation is edited in the same way as regular parameter automation. See “Editing parameter automation”.

Drawing tempo automation events

Drawing tempo automation events is done in the same way as drawing regular parameter automation events. See 
“Drawing parameter automation events”.

• Even though Reason Essentials supports a very wide tempo range (1.0 BPM to 999.999 BPM), the initial dis-
played editing range is 60-250 BPM in the left column in Edit Mode. This is only to make it easier to work with 
small tempo changes.

If you want higher tempi than 250 BPM, or lower than 60 BPM, you can easily expand the range, either by select-
ing and moving a tempo automation event above, or below, the clip border, by double-clicking the max or min val-
ues (“250” or “60” in the left column in the picture above) and typing in a new value, or by selecting an event and 
changing its value in the Value display in the Inspector.
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About tempo changes and tempo automation of audio tracks
The built-in Stretch function in the Audio Track devices allows you to change the tempo of the song without affecting 
the pitch of the recordings on the audio tracks. This is great if you want to adjust the tempo after you have recorded 
your audio tracks. In Reason Essentials, the Stretch is enabled by default for all audio clips.

There are two selectable Stretch algorithms which are suitable when playing back different types of audio material: 
the “Melody” Stretch type is best suited for sources sounding one note at a time e.g. solo vocals, and the “Allround” 
Stretch type is best suited for all other types of audio material.

D Select stretch type from the Stretch Type selector on the Audio Track device in the Rack.

Selecting Stretch Type on the Audio Track device in the Rack

Stretch preview vs. high quality stretch

Stretch is always made in two parallel steps: a real-time “preview” stretch so that you can instantly hear the result of 
your tempo changes, and a high quality stretch “in the background” to further improve the sonic results. As soon as 
high quality stretch is in progress, the “Calc” indicator on the Transport Panel shows a progress bar:

The CALC progress bar appears when Reason Essentials performs high quality stretching of audio

Since the high quality stretch is performed in the background, you can still continue to work with your song without 
any interruption. When the high quality stretch is finished, the “Calc” indicator goes out and the high quality audio au-
tomatically replaces the “preview” audio.

About disabling Stretch for audio clips

In some situations, you might want to exclude audio clips from tempo automation. For example, if you have recorded 
dialogue or sound effects that shouldn't adapt to tempo changes. In such situations, you can select the audio clip(s) 
you want to exclude from the tempo changes and select “Disable Stretch” from the Edit menu or clip context menu.

Automating time signature
Time signature automation events can only be manually drawn with the Pencil tool - not recorded like tempo automa-
tion, parameter automation or performance controller automation. A single time signature automation clip can only 
contain a single time signature value. In practice this means that each time signature automation clip can only contain 
one time signature automation “event”. All time signature changes in the song will require a unique clip.
1. Set the desired time signature in the Signature display on the Transport Panel.

This will be the Static Value, i.e. the time signature of the song wherever there is no clip present on the time sig-
nature automation lane.

2. Hold down [Alt](Win) or [Option](Mac) and click in the Signature display on the Transport Panel.
This will select the Transport track and create a time signature automation lane in one go. The Signature display 
will also be displayed with a green border, indicating that the time signature has been automated.

q It is generally a good idea to activate Snap (see “Snap”) and have the Snap value set to “Bar” when drawing 
clips.
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3. Select the Pencil Tool.
When the Pencil tool is selected, a Time Signature drop-down list appears in the Inspector. Select the desired time 
signature from the drop-down list.

D If you select “Other” the Edit Time Signature dialog appears where you can specify another time signature.

The available signatures are: 1/2-16/2, 1/4-16/4, 1/8-16/8 and 1/16-16/16. The Time Signature display in the 
dialog can be edited according to the descriptions in “Transport Panel segment displays”.

4. Draw a clip over the area on the Time Signature lane in the Transport track where you want the time signature 
to change.
The time signature will change for the duration of the clip.

5. Continue using the same general method wherever you want the time signature to change in your song.

D You can change the time signature for the automation clip at any time by simply double-clicking the clip with 
the Selection (Arrow) Tool and changing the value on the pop-up that appears. Alternatively, select the clip and 
then click the small triangle in the clip to bring up the time signature pop-up.
There is no need to switch to Edit Mode unless you wish to change the time signature’s Static Value.

Moving, resizing and duplicating time signature automation 
clips
D You can move, resize and duplicate time signature automation clips in the same way as with note or automa-

tion clips.
However, it is recommended that Snap is activated (and in most cases set to “Bar”) when you do this.

D You can also move or duplicate clips using the Cut, Copy and Paste commands on the Edit menu or context 
menu.
Again, the same rules apply as for cutting, copying and pasting note and parameter automation clips.
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Deleting time signature automation clips
D Deleting time signature automation clips is done in the same way as deleting note clips. I.e. you can select or 

draw selection rectangles and then press [Backspace] or [Delete], or use the Eraser Tool.

D To clear the time signature automation in a clip, simply delete the clip (or remove the whole Time Signature 
Lane to clear all time signature automation on the track).

Note and automation editing in the Inspector
In the Inspector you can edit note and automation events numerically using the displays.

Editing notes and events in the Inspector
If you select a note, four displays appear in the Inspector, showing the event (start) Position, Length, Note 
number and Velocity value:

If you select a parameter automation event, two displays appear, showing the event’s Position and Value:

If you select a pattern automation clip, three displays appear, showing the clip’s Position, Length and Pattern Offset:

D Edit the values by clicking on a segment in a display and then drag up/down, use the up/down spin controls, or 
type in new values. Snap is not taken into account. 
See “Inspector segment displays” for details on how to edit in the Inspector displays.

! Note that when moving the position of events, these may end up outside the clip and be masked (not played). 
There will be no warning or indication if this should happen. However, since the clip is open in Edit Mode, you 
will be able to see if events are masked.

• If the Tick segment in the Position and/or Length displays shows an asterisk (*), it means that the value is a 
fraction of a Tick - a subtick. See “About subticks in the Position and Length displays” for more info.

Editing values for multiple notes or events in the Inspector

When you edit values for several selected events, the changes will always be relative. For example, if you change the 
position, length, pitch or velocity when several notes are selected, they will all be changed by the same amount, re-
taining their relative values.

• If several events are selected, the displays will show the values for the event with the earliest start position in 
the song.
If several selected events have the same start position, the displays will show the values for the event with the low-
est Note value (for note events) or lowest Value (for automation events).

• If several events are selected and any of their values differ, Match Value buttons appear next to the corre-
sponding display.
See “Matching notes or events using the “Match Values” function”.
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Matching notes or events using the “Match Values” function

The Match Values buttons appear as red ‘=’ signs

The “Match Values” function in the Inspector can be used for matching the positions, lengths and velocities of several 
selected note events to the position/length/velocity of the selected event with the earliest start position in the song. 
It’s always the values of the earliest event that are shown in the displays. Similarly, automation events can be matched 
to the position and/or value of the earliest selected automation event in the song.

If several selected events have the same start position, the matching will be to the values for the event with the low-
est Note value (for note events) or lowest Value (for automation events).

Matching notes

Here’s an example on how to match note values:
1. In Edit Mode, select several notes.

Four selected notes in Edit Mode
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2. Click the respective Match Values button to achieve the following results:

Position values 
matched

Length values 
matched

Velocity values 
matched

or or
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Matching parameter automation events

Matching parameter automation event values is useful if you want an automated device parameter to be modulated 
to the same value throughout the clip. 

• Let’s say you want to modulate a parameter to a maximum value of 80 several times throughout the clip. Then, 
just select all “max value” events, click the “Match Values” button and then adjust the Value to 80 for the se-
lected events.

Matching automation events positions can be useful under the following circumstances:

• If you want to match the positions of single performance controller events on several Performance Controller 
Automation lanes.

• If you want to match the position of two adjacent automation events in a clip to create an instant “jump” be-
tween the two values.

Matching the positions of several automation events in a single clip is not really useful. It will only place them in a 
“pile” on the same position. The effect during playback would be an instant jump between the extreme values. In 
practice, all events in between the extreme values will be disregarded.
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Chapter 10
Working with the Rack
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About this chapter
This chapter describes the procedures and techniques for managing devices and Device Groups in the rack.

Rack device procedures
The rack is where you create and configure your devices, and make parameter settings. This section describes all the 
procedures for managing the rack, that is, procedures and techniques common to all devices.

Navigating in the rack

The rack, here with three rack columns.

The rack houses all the devices you use in your song. To make it easier to overview the devices, the rack can contain 
several rack columns next to each other. To navigate in the rack, use one of the following methods:

D Click and drag the blue frame in the Rack Navigator to scroll continuously in the rack, both vertically and hori-
zontally.
Just clicking in the Rack Navigator will directly scroll to the corresponding position in the rack.

D If you’re using a mouse equipped with a scroll wheel, you can use it to scroll up or down in the rack.
Hold down [Shift] and use the scroll wheel to scroll horizontally in the rack.

D Press the [Page Up] and [Page Down] buttons on the computer keyboard to move the view one “full screen” up 
or down in the rack column currently in view.
Note that the rack area must have Edit Focus, i.e. there must be a frame surrounding the rack area. Set Edit Focus 
by clicking anywhere in the rack area.

D Press the [Home] and [End] buttons on the computer keyboard to scroll the top or bottom of the rack column 
currently in view.
Note that the rack area must have Edit Focus.

q When you select a track in the sequencer, or click the “Rack” button below a channel strip in the Main Mixer, 
the rack will automatically scroll to bring the associated device into view.

Rack 
Navigator

Rack Column 3 Rack Column 2 Rack Column 1
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Resizing and detaching the rack

D Resize the rack area by clicking and dragging either of the horizontal dividers above or below the rack area. 
This will shrink the Main Mixer and/or sequencer areas and make more of the rack visible.

D You can also resize the Rack Navigator area by clicking and dragging the vertical divider to the left of the Rack 
Navigator.
Dragging the divider to the left will expand the Rack Navigator area and enlarge the devices, making it easier to 
get a good overview of all devices in your rack.

D You can also make the rack fill the entire song document window by pressing [F6] or by clicking the “Maxi-
mize” button to the right of the Rack Navigator.

The rack Maximize and Detach buttons.

D You can detach the rack area from the other areas altogether by holding [Ctrl](Win) or [Cmd](Mac) and press-
ing [F6], or by clicking the “Detach” button. 
This will place the rack in a separate window. (See “The Rack” for more info.)

q See also “Creating new rack columns” for information on how to create several rack columns.

About Device Groups
A Device Group is a series of interconnected devices that “belong together”. A Device Group could be, for example, 
an instrument device connected to an effect device and then to a Mix Channel device.

A Device Group consists of the following:

• One (and only one) Source device (e.g. an instrument).

• The devices to which the Source device feeds its audio signals (e.g. and effect device).

• Any CV-only devices (a Matrix Sequencer, for example) that are CV-connected to devices in this group only.

• All sequencer tracks and Main Mixer channel strips for the devices in the group.

! A Device Group is only defined by the connections between the devices - it has nothing to do with the physical 
location of the devices in the rack.

Maximize Rack button

Detach Rack button
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By default, when you create an Instrument device, a new (or currently unused) Mix Channel device will be automati-
cally connected to the Instrument device, as described in “Creating devices”. In this situation, the Instrument device 
and the connected Mix Channel device will now be considered a Device Group - with the Instrument device as the 
Source device.

If you want to keep all devices in a Device Group physically together in the rack (e.g. if you want to move all devices 
in the group), there is an option “Auto-group Devices and Tracks” on the Options menu.

The “Auto-group Devices and Tracks” option.

The advantage of using the “Auto -group Devices and Tracks” option is that it’s much easier to get a good visual over-
view over what devices are connected to each other and associated with specific sequencer tracks and with a spe-
cific channel strip in the Main Mixer. It’s also easier to rearrange devices in the rack since all devices in the Device 
Group will move together if one device in the Device Group is moved. 

The example below shows two ID8 devices connected to one Mix Channel device each. Let’s say you want to move 
the ID8 1 device to another position in the rack. This is what will happen:
1. Make sure the “Auto-group Devices and Tracks” is selected on the Options menu - if not, select it from the 

menu or hold down [Ctrl](Win) or [Cmd](Mac) and press [G].

2. Click on the ID8 1 device panel (but not on a parameter or display) and drag and drop below the ID8 2 device in 
the rack.
As you can see, both the ID8 1 device and its connected Mix Channel device are moved together, as a group, to 
the new destination.

q If you want to view what devices belong to a specific Device Group, select a device and then select “Select All 
in Device Group” from the Edit menu or context menu.

ID8 1
Device 
Group

ID8 2
Device 
Group

Moved ID8 1
Device 
Group
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Creating devices
Devices can be created in a number of different ways. These first two methods apply to any device types:

D Use drag and drop, or double-click on a device on the “Device Palette” tab in the Tool Window.
Alternatively, select a device and click the “Create” button. Any device type can be created.

The Device Palette tab in the Tool Window.

D Select desired device from the “Create” menu.
Any device type can be created. The “Create” menu is available both on the main menu and on the rack and device 
context menus.

Depending on what type of device you’ve created, and also the “Auto-Group Devices and Tracks” setting, the results 
will differ:

• If “Auto-Group Devices and Tracks” on the Options menu is not selected, the new device is added directly be-
low the currently selected device in the rack.
If no device is selected, the new device is added at the bottom of the rack.

• If “Auto-Group Devices and Tracks” on the Options menu is selected, devices will not be created in the middle 
of existing Device Groups (except if they are effect devices - see “Effect devices specifics”).
This means a device might not end up below the selected device in the rack, but below that device's Device Group.

• When you add a new device, Reason Essentials attempts to automatically route it in a logical way.
For more information about the auto-routing features, see “Automatic routing”.

! See below for information specific to certain device types.
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Instrument device specifics

The following additional methods can be used for creating Instrument devices:

D Click the “Create Instrument...” button on the “Device Palette” tab in the Tool Window, or select “Create Instru-
ment...” from the Create menu.
This will bring up the Patch Browser from which you can choose an Instrument patch to load in its corresponding 
device - see “Create Instrument/Create Effect”.

! You can only create Instrument devices using the “Create Instrument...” button - not mixers or effects devices.

• If you have created an Instrument device, a new sequencer track will be automatically created. Also, a new (or 
unused) Mix Channel device will be connected to the Instrument device. The Mix Channel device’s channel 
strip will appear in the Main Mixer.
The track, the Mix Channel device and its channel strip will be given the same name as the created Instrument de-
vice. Master Keyboard Input will also automatically be set to the new track, allowing you to immediately play the 
created Instrument device via MIDI (see “Master Keyboard Input”). By default, the Instrument device and Mix Chan-
nel device will be treated as a “Device Group” from here on (see “About Device Groups”).

! By default, the automatic creation of a sequencer track and Mix Channel device only applies to instrument de-
vices, not to mixers or effect devices.

• If you hold down [Alt](Win) or [Option](Mac) when you create an Instrument device (except when you drag and 
drop from the Tool Window), a sequencer track will not be created.

• If you hold down [Shift] when you create an Instrument device, there will be no automatic routing or connec-
tions made.

Audio Track device specifics

The following additional methods can be used for creating Audio Track devices:

D Click the “Create Audio Track...” button on the “Device Palette” tab in the Tool Window, or select “Create Au-
dio Track” from the Create menu.
This will create an Audio Track device (with its corresponding channel strip in the Main Mixer) and a sequencer 
track.

Mix Channel device specifics

• If you hold down [Alt](Win) or [Option](Mac) when you create a Mix Channel device (except when you drag and 
drop from the Tool Window), a sequencer track will be created for the device.

Effect devices specifics

The following additional method can be used for creating Effects devices:

D Select “Create Effect...” from the Create menu.
This will bring up the Patch Browser from which you can choose an FX Combinator patch to load in a Combinator 
device - see “Create Instrument/Create Effect”.

The results when creating Effect devices depend on the following criteria:

• If an Audio Track (device or channel strip), or a Mix Channel (device or channel strip), was selected when you 
created an effect, the effect device will be added and connected as an insert effect, inside the Insert FX con-
tainer for that Audio Track or Mix Channel device.

• If an Instrument device was selected when you created an effect device, the effect device will be added and 
connected as an “insert effect”, after the Instrument device.

• If a Mixer 14:2 or Line Mixer 6:2 was selected when you created an effect, the effect device will be added and 
connected as a Send Effect, on the first available Send FX connectors of the mixer device.
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• If you hold down [Alt](Win) or [Option](Mac) when you create an effect device (except when you drag and drop 
from the Tool Window), a sequencer track will be created for the device.

• If you hold down [Shift] when you create an effect device, it will not be connected.

Mixer device specifics

• If you hold down [Alt](Win) or [Option](Mac) when you create a mixer device (except when you drag and drop 
from the Tool Window), a sequencer track will be created for the mixer device.

• If you hold down [Shift] when you create a mixer device, it will not be connected to a Mix Channel device.

Selecting devices
Some operations, e.g. cutting, copying, moving and deleting devices (see “Cut, Copy and Paste devices” and “Deleting 
devices”), require that you select one or several devices in the rack. This is done according to the following:

D To select a single device, click on it in the rack.
The selected device is displayed with a colored border (based on the color scheme selected for your operating 
system).

D To select several devices, hold down [Shift] and click on the desired devices.
In other words, [Shift]-clicking a device selects it without de-selecting any other selected devices.

D To de-select all devices, click in the empty area at the bottom of, or next to, the rack.

D To de-select a device in a multiple selection, hold down [Shift] and click on it.
All other selected devices remain selected.

D You can also use the arrow keys on the computer keyboard to select the device directly above, below or next 
to the currently selected one.
When you use this method, Reason Essentials will automatically scroll the rack so that the selected device is fully 
visible. This is a quick way of “stepping through” the rack. Narrow devices (e.g. half-width devices such as some ef-
fects) are ordered left-to-right, i.e. pressing the down arrow key will step through the devices from left to right be-
fore moving on the next device row.

D If you hold down [Shift] when using the up or down arrow keys, the currently selected device will remain se-
lected.
This allows you to select a range of devices.

D Adjusting a parameter in a device will automatically select the device.
In other words, you don’t have to select a device as a separate operation before editing its parameters.

About selecting all devices in a Device Group

To select all devices in a Device Group, proceed as follows:
1. Select any device in the desired Device Group.

2. Select “Select All in Device Group” from the Edit menu or context menu.
All devices in the Device Group will be selected as indicated by the colored borders around the devices.
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Deleting devices
To delete one or several devices, select them and use one of the following methods:

D Press [Backspace] or [Delete].
An alert appears asking you to confirm the deletion. Any cable connections to the device will also be deleted (or 
re-routed).

! If you have selected a Source device or a Mix Channel device and the “Auto-Group Devices and Tracks” on the 
Options menu is selected, an alert appears asking if you want to delete the device or the whole Device Group, 
including sequencer tracks and channel strips. (See “About Device Groups”).

D To delete devices or Device Groups without alerts, hold down [Ctrl](Win) or [Cmd](Mac) and press [Backspace] 
or [Delete].

D Select “Delete Devices and Tracks” from the Edit menu or the device context menu.
An alert appears asking you to confirm the deletion. This will delete the devices together with the associated se-
quencer track(s) also if the “Auto-group Devices and Tracks” option isn’t selected. (It’s possible to have devices 
without associated tracks but it is not possible to have a sequencer track without an associated device.)

D To delete devices and tracks without alerts, hold down [Ctrl](Win) or [Cmd](Mac) before selecting “Delete De-
vices and Tracks” from the Edit menu or the device context menu.

! If you delete a device connected between two other devices, the connection between the two other devices is 
automatically preserved.

! The Reason Essentials Hardware Interface and the Master Section device at the top of the rack cannot be de-
leted.

Re-ordering devices
If you want to move an instrument device to another position in the rack, you probably also want its Mix Channel de-
vice and connected effects to move along with it. If the “Auto-group Devices and Tracks” on the “Options” menu is se-
lected, all devices in the Device Group will follow along when you drag and drop a device included i a Device Group. 
However, it’s still possible to re-order devices within each Device Group. See “About Device Groups” for more details. 
See also “About the “Sort Selected Device Groups” function” for information about automatic sorting of several De-
vice Groups.

If the “Auto-group Devices and Tracks” on the “Options” menu is not selected, you can re-order and move devices in-
dividually in the rack - even outside the Device Groups:
1. If you want to move more than one device at the same time, [Shift]-click the devices to select them.

2. Click on the panel of one of the devices (but not on a parameter or display).

3. With the mouse button pressed, drag the device(s) to the new destination in the rack.
A thick red vertical line indicates where the device(s) will be positioned. Note that when re-ordering devices with 
smaller width, the red line can be to the left of a device (indicating that the moved device will be inserted before 
the other device) or to the right of a device (indicating that the moved device will be inserted after the other de-
vice).



WORKING WITH THE RACK 269

q It’s also possible to move devices to a new rack column to the left or right of the original rack (see “Creating 
new rack columns”).
In this example a DDL-1 Delay device is moved to two different destinations:

4. Release the mouse button.
The device(s) are moved to the new position and the other devices in the rack are adjusted to fill up the gaps.

! Note that if you start to move a device but change your mind, you can abort the operation by pressing [Esc] 
while keeping the mouse button depressed.

D If you hold down [Shift] when you move a device, Reason Essentials will attempt to automatically re-route it.
See “Automatic routing” for more info on auto-routing.

! Moving devices in the rack does not affect the order of the sequencer tracks or channel strips and vice versa. If 
you want the sequencer tracks and channel strips to be re-ordered as well, see “About the “Sort Selected De-
vice Groups” function”.

In this case, the red line 
indicates that the DDL-1 
Delay device will be 
inserted to the left of the 
CF-101 Chorus/Flanger.

This is the result. Note 
that the Spider CV 
device is moved to the 
left, to fill out the gap.

In this case, the red line 
indicates that the Delay 
device will be inserted to 
the right of the Spider 
Audio device. 

This is the result. All three 
devices are moved to the 
left, to fill out the gaps.
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Creating new rack columns
It’s possible to move devices, or Device Groups, to new rack columns. This is very useful if your rack starts to get 
crowded, or if you want to arrange your devices in separate rack columns to get a better overview.

By default, when you create a new empty Song document, the rack consists of a single rack column featuring the 
Reason Essentials Hardware Interface and the Master Section device. When you create new devices from the “Cre-
ate” menu, these will automatically be placed in that rack column.

By dragging and dropping devices to either side (left or right) of the original rack, you can move the devices and at 
the same time create a new rack column. You can create as many rack columns as you like - the only condition is that 
at least one device must be present in a neighboring rack column. In other words, you can’t create empty rack col-
umns.

In the example below, we drag and drop an RV7000 reverb device to the right of the original rack:

A large white arrow symbol appears on the right wooden rack side of the original rack column to indicate that the de-
vice is about to be moved to a new rack column.

About the “Sort Selected Device Groups” function
When you are working with Device Groups (see “About Device Groups”), there is a very nice feature which allows you 
to visually organize and re-order the Device Groups, Main Mixer channel strips and sequencer tracks. With the “Sort 
Selected Device Groups” function on the Edit menu, it’s possible to sort Device Groups and Main Mixer channel strips 
according to the current sequencer track order - or vice versa, depending on what’s currently selected. To sort the 
Device Groups in the rack, and the channel strips in the Main Mixer, according to the current sequencer track order, 
proceed as follows:
1. Select a track in the sequencer Track List rack and choose “Select All” from the Edit menu or track context 

menu.
Tracks are marked with darker colors to indicate they’ve been selected.

2. Select “Sort Selected Device Groups” from the Edit menu or track context menu.
Now all Device Groups and channel strips in the Main Mixer will be automatically re-ordered according to the cur-
rent track configuration in the sequencer. The topmost sequencer track will have its associated Device Group 
moved to the top in the rack. The remaining Device Groups will be re-ordered according to the remaining track or-
der in the Track List. The Main Mixer channel strips will also be re-ordered according to the sequencer track order.

• If you have devices in several rack columns, the sorting will begin in the leftmost rack column and continue to 
the right through the rest of the rack columns. The number of devices in each rack column will not be changed.

Click on the rightmost 
side of the RV7000 
device panel and drag 
to the right...

... Release the mouse 
button and the RV7000 
device is automatically 
placed in a new rack 
column to the right.
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• If you select several Device Groups in the rack and choose “Sort Selected Device Groups” from the Edit menu 
or device context menu, the tracks in the sequencer and the Main Mixer channel strips will be re-ordered ac-
cording to the current Device Group order in the rack.

• If you select several channel strips in the Main Mixer and choose “Sort Selected Device Groups” from the Edit 
menu or channel strip context menu, the Device Groups in the rack and the tracks in the sequencer will be re-
ordered according to the current channel strip order in the Main Mixer.

Duplicating devices
Duplicating devices will have different results depending on the “Auto-group Devices and Tracks” setting on the Op-
tions menu (see “About Device Groups”):

D To duplicate a device or a Device Group in the rack, hold down [Ctrl](Win) or [Option](Mac) and drag the device 
to a new position.

• If “Auto-group Devices and Tracks” is not selected, a copy of the selected device will be created without any 
connections.

• If “Auto-group Devices and Tracks” is selected, a copy of the entire Device Group will be created with all con-
nections preserved. A new track will also be created in the sequencer.

D Select the device(s) and select “Duplicate Devices and Tracks” from the Edit menu or context menu.
A duplicate (copy) of the device(s) or Device Group(s) will be created. New tracks for the device(s) or Device 
Groups will also be created in the sequencer.

D If you hold down [Shift] when you duplicate devices, Reason Essentials will attempt to automatically route 
them, just as when you move devices.
See “Automatic routing”.

Cut, Copy and Paste devices
Selected devices or Device Groups can be moved or duplicated using the Cut, Copy and Paste Device functions on 
the Edit menu or device context menu. This allows you to copy one or several devices (such as an instrument device 
and all its “insert” effects) from one Reason Essentials Song document to another. Cutting/Copying and Pasting will 
have different results depending on the “Auto-group Devices and Tracks” setting on the Options menu (see “About 
Device Groups”):

• Cut and Copy affects all selected devices or Device Groups, and works according to the standard procedures.
That is, Cut moves the devices/Device Groups to the clipboard (removing them from the rack) while Copy creates 
copies of the devices/Device Groups and puts these in the clipboard memory, without affecting the rack.

D To Cut, Copy and Paste a Device Group, make sure the “Auto-group Devices and Tracks” is selected on the Op-
tions menu. Then, select a device in the Device Group and proceed with the Cut/Copy and Paste procedure.
All devices in the Device Group will be cut/copied and pasted with preserved connections (in the same Song or in 
another Song document).

• When you Paste devices or Device Groups, these are inserted into the rack below the currently selected device.
If no device is selected, the pasted devices/Device Groups will appear at the bottom of the rack column.

! As when creating devices, you cannot paste a Source device into an existing Device Group if “Auto-group De-
vices and Tracks” is on. It will be inserted below the Device Group.

• If you Copy and Paste several devices, any connections between these are preserved.

• If you hold down [Shift] when you Paste a device, Reason Essentials will attempt to automatically route it.
The rules are the same as when moving or duplicating devices by dragging and dropping. See “Routing Audio and 
CV” for more information about automatic and manual routing.
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Naming devices
Each device has a “tape strip” which shows the name of the device. When you create a new device it is automatically 
named according to the device type, with an index number (so that the first Subtractor synthesizer you create is 
called “Subtractor 1”, the next “Subtractor 2” and so on). If you like, you can rename a device by clicking on its tape 
strip and typing a new name (up to 16 characters).

For instrument devices connected to Mix Channel devices, the device names are automatically copied to the tape 
strips for the corresponding Mix Channel devices and their channel strips in the Main Mixer, as well as on their corre-
sponding sequencer tracks. Similarly, the names of the FX Returns in the Main Mixer show the names of the effect 
devices connected to the corresponding FX Return inputs.

• When you create a device for which an associated sequencer track is created, the track in the sequencer will be 
assigned the same name as the device. Renaming the device will also rename the corresponding sequencer 
track, and vice versa.

• Note that the mixer channel tape strips always show the name of the source device connected to the Mix Chan-
nel device! This means that if you have an instrument device routed through one or several effect devices, the 
Mix Channel tape strip will show the name of the instrument device (as this is the Source device).

• You can rename Mix Channels manually, for example, if you use multiple outputs from a sampler device going 
to separate Mix Channels. If you later delete the custom name, the Mix Channel will default to showing the 
Source device's name. For audio tracks, the Audio Track device is always the Source device and will never 
change name unless you manually rename it.
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Folding and unfolding devices
If you don’t need to edit the parameters for a device, you can fold the device to make the rack more manageable and 
to avoid having to scroll a lot.

D Click the “Fold/Unfold” button to the left on the device panel to fold the device.

The “Fold/Unfold” button on an RV7000 device

D To unfold the device, click the “Fold/Unfold” button again.

• In rack rows containing devices of smaller width, the “Fold/Unfold” button is placed to the left of the leftmost 
device and affects all devices in the row:

The “Fold/Unfold” buttons for half-rack devices

D Hold down [Alt](Win) or [Option](Mac) and click the “Fold/Unfold” button of an unfolded device to fold all de-
vices in the current rack column.
Conversely, hold down [Alt](Win) or [Option](Mac) and click the “Fold/Unfold” button of a folded device to unfold 
all devices in the current rack column.

• For folded devices, no parameters are shown and you cannot reroute any cables on the rear of the rack as long 
as the devices are folded.
However, if you want to make a connection to a folded device, you can drag a cable to it and hold it there for a mo-
ment. This will cause the folded device to automatically unfold and let you make the connection.

• Folded devices can be renamed, moved, duplicated and deleted just like unfolded devices.

• For devices that use patches, you can select patches in folded mode as well.

• Playback is not affected by folding.
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Chapter 11
Sounds and Patches
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About this chapter
This chapter deals with the following topics:

• Handling Patches.
See “About patches”.

• Using the Patch Browser.
See “Using the Browser”.

• ReFills and Reason file formats.
See “About ReFills”.

About patches
A patch contains settings for a specific device. Patches can be either separate files on your hard disk or files embed-
ded in a ReFill (see “About ReFills” for info about ReFills). The devices that use patches in Reason Essentials are: 
Subtractor, NN-XT, Dr. Octo Rex, Redrum, Line 6 Guitar and Bass Amps, RV7000, Scream 4 and the Combinator. 
The Mix Channel, Master Section and Audio Track devices use Insert FX patches saved as Combinator patches. All 
other Reason Essentials devices use either presets or can only be programmed using the device panel parameters 
and saved with the Song.

Devices that use patches
• Subtractor synth patches contain all settings on the device panel.

Selecting a patch brings up a new sound, just like when selecting programs or patches on a hardware synthesizer.

• NN-XT sampler patches contain information about what samples are used, their settings (key mapping, tuning, 
etc.) and the parameter settings on the device panel.
It is important to note that the sampler patch doesn’t contain the actual samples - only information about which 
sample files are used.

• Dr. Octo Rex patches contain information about what REX files are loaded in each slot, their settings as well as 
the parameter settings on the device panel.
It is important to note that the Dr. Octo Rex patch doesn’t contain the actual REX files - only information about 
which REX files are used.

• Redrum Drum Computer patches contain a complete “drum kit”, that is, information about what drum samples 
are used, together with the parameter settings for each drum sound.
Again, the actual samples are not included in the patch, only references to files. Also note that Redrum patches are 
separated from Redrum patterns - selecting a new patch will not affect the patterns currently in the device.

• Line 6 Guitar and Bass Amp patches contain information about the parameter settings on the device panel, as 
well as information about used Amp and Cabinet models.
Selecting a patch brings up a new sound, just like when selecting programs or patches on a hardware effect de-
vice.

• RV7000 and Scream 4 effect patches contain all settings on their respective device panels.
Selecting a patch brings up a new sound, just like when selecting programs or patches on a hardware effect de-
vice.

• The Combinator (Combi) patch format saves all settings and file references for each device in the Combi, 
along with the Combinator’s own settings; key/velocity zones, modulation routing etc.
Any audio or CV routing from/to devices that are part of the Combi is also saved.

! Note that patches for devices included in a Combi are not saved individually - e.g. if a Combi includes a Sub-
tractor, and you have tweaked its settings, these settings will be saved with the Combi patch, but will not be 
saved as a separate Subtractor patch unless you do so from within the Combinator - see “Saving patches”.

! Patches other than Combi patches do not include any cable routing information. 
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About the “Load Default Sound in New Devices” preference

On the “General” tab in Preferences, there is an option (on by default) to load a default patch when creating a device. 
For some devices, there are a number of patches that exist outside category folders in the main Sound Bank folder 
for the device. These will be available on the browse list (see “About browse lists”) directly after creating the device, 
which allows you check out a few sounds for a device without opening the browser.

Loading patches 
To select and load a patch for a device, use one of the following methods:

D Click the “Browse Patch” button in the Patch section on the device panel.
The Patch section has the same basic layout for all patch devices; a Patch Name display, two “Select Patch” but-
tons (up/down) for stepping through patches sequentially, a “Browse Patch” button to open the browser, and a 
“Save Patch” button to save patches.

The Patch section of an RV7000 device.

! On the panels of the Redrum, NN-XT and Dr. Octo Rex devices, there are also other folder buttons, used for 
loading samples or REX files. Make sure you click on the button in the Patch section (next to the patch name 
display)!

D Select “Browse Patches” from the Edit menu or device context menu.
Note that the Edit menu reflects which device is selected - in other words, you must select the device for the cor-
responding Browse Patches item to appear on the Edit menu.

• In both cases, the Patch browser dialog appears, allowing you to locate and select the patch, on the file system 
or within a ReFill.
Browser operations are described in “Using the Browser” later in this chapter.

• Once you have selected a patch, you can step between all the patches in the same folder by using the “Select 
Patch” buttons on the device panel:

! Note that switching patches on a device this way can also change the actual device! See “About browse lists”.

D If you click on the Patch Name display on the device panel, a pop-up menu will appear, listing all patches in the 
currently selected folder - see “About browse lists”).
This allows you to quickly select another patch, without having to step through the patches one by one. You can 
also choose to open the Patch browser from this pop-up menu.

When you select a patch in any of the ways described above, the device’s parameters will be set according to the val-
ues stored in the patch, and the name of the patch will be shown in the Patch Name display.

! Any parameter adjustments you make on the device panel after selecting a patch will not affect the actual 
patch file. For this to happen, you need to save the patch - see “Saving patches”.

Patch Name display

Save Patch button

Select Patch buttons

Browse Patch button
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! You can also select patches from a MIDI Master Keyboard or Control Surface - see “Remote - Playing and Con-
trolling Devices”.

If referenced samples are missing

As described above, patches for the Redrum, NN-XT and Dr. Octo Rex contain references to samples or REX files. 
Just like patches, samples can be independent files on the hard disk or elements within a ReFill. However, if sample 
files have been moved or renamed after a patch was saved, the sample file references in the patch will not be accu-
rate.

If this is the case when you select a patch, the program will tell you so. You can then choose to either manually locate 
the missing files, to have the program search for them, or to proceed without the missing sounds. For details, see 
“Handling Missing Sounds”.

! Proceeding without locating or replacing the missing samples will result in silent drum channels, key zones or 
loop slots (for the Redrum, NN-XT and Dr. Octo Rex respectively).

About Combinator patches containing unsupported device types

Combinator patches created in the full version of Reason may contain device types that are not available in Reason 
Essentials. Such Combinator patches cannot be loaded in Reason Essentials. The patch files will be visible in the Ex-
plorer (Win) or Finder (Mac) but won't be visible in the Reason Essentials patch browser.

Saving patches

Saving device settings in a song

When you save a Reason Essentials song, all settings for all devices are automatically included in the song file - there 
is no need to save the patches separately.

! It’s important to realize that it’s the actual settings that are saved in the Song - not references to patches on 
disk. The next time you open the song, all devices will be set as they were when you saved it (regardless of 
whether you have removed or edited any patches on disk).

! Note that device samples are not stored with the Song by default. This means that if you edit any Redrum or 
NN-XT samples in an external application and then open a Song containing devices that use these samples, 
the sound will be different. It’s possible, however, to store actual device samples together with the Song using 
the “Self-Contain” feature. See “About Self-Contained Songs”.

Saving device settings as patches on disk

Even though the device settings are stored with the song, you may want to save any settings you have made for a de-
vice as a separate patch file. This allows you to use the patch in other songs, and lets you try out other patches in your 
song without the risk of losing your original sound. A patch is saved as follows:
1. Click the “Save Patch” button on the device panel:

2. In the file dialog that appears, specify a location and name for the patch file and click Save.

• Under Windows, the different types of patch files have different file extensions.
File extensions are automatically added by Reason Essentials when you save. Under Mac OS X, file extensions are 
not needed but it may be a good idea to keep them if you want the saved files to be usable under Windows.
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• If you have selected a patch, modified it and want to save it with the modifications, you could either save a sep-
arate, modified version of the patch (with a new name) or simply overwrite the old patch file on disk.
As usual, you will be asked whether you really want to replace the existing patch file. 

! Note that you can save a patch under the same name and location without having the save dialog appear by 
holding down [Alt](Win) or [Option](Mac) and clicking the “Save Patch” button on the device panel. Be aware 
that this overwrites the original patch!

! Note also that you cannot save into a ReFill! This means that if you have opened a patch from within a ReFill, 
modified it and want to save it, you need to save it as a separate file in a new location (outside the ReFill). Pref-
erably, you should also rename the modified patch file, to avoid confusion.

Copying and pasting patches between devices
A quick way to copy device parameter settings between devices of the same type is to use the “Copy Patch” and 
“Paste Patch” functions. The result is exactly the same as if you had saved a patch from one device and opened it on 
another device of the same type - this is just a quicker method.

! Copying and Pasting settings is possible with all device types that can use patches.

Proceed as follows:
1. Select a patch, and/or make the desired settings on the source device.

Make sure the device remains selected.

2. Select “Copy Patch” from the Edit menu or from the device context menu.

3. Select the destination device of the same type (in the same song or another song).

4. Select “Paste Patch” from the Edit menu or from the device context menu.
The settings of the source device (including Redrum and NN-XT sample references and Dr. Octo Rex REX loop 
references) are applied to the destination device.

! Note that this operation simply copies the settings from one device to another. Adjusting the settings on one 
of the devices will not affect the other; neither will the settings affect any patch file on disk.

Copying Main Mixer Insert FX settings and paste as Combinator patches

You can copy Insert FX settings from Main Mixer channels and paste these as Combinator effect patches - or vice 
versa. To copy a Main Mixer channel Insert FX setting and paste into a Combinator device, follow the steps below:
1. Select the desired Mix Channel/Audio Track device in the rack, or the desired Mixer Channel in the Main Mixer.

2. Select “Copy Channel Settings -> Insert FX” from the Edit menu or device/Mix Channel context menu.
The Insert FX devices with their settings and connections are placed on the computer’s clipboard memory.

3. Select the desired empty Combinator device in the rack - or create a new Combinator device and select it.

4. Select “Paste Patch” from the Edit menu or the device context menu.
The Insert FX devices with their settings and connections are pasted into the Combinator device.

To copy an effect patch in a Combinator device and paste it as an Insert FX in a channel strip in the Main Mixer, pro-
ceed as follows:
1. Select the Combinator device which contains the effects you want to copy.

2. Select “Copy Patch” from the Edit menu or the device context menu.
The Combinator effect devices with their settings and connections are placed in the computer’s clipboard memory.

3. Select the desired Mix Channel/Audio Track device in the rack, or the desired channel strip in the Main Mixer.

4. Select “Paste Channel Settings: Insert FX” from the Edit menu or the device context menu.
The Combinator devices with their settings and connections are pasted into the Insert FX section of the selected 
Mix Channel/Audio Track device.
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Initializing patches
Sometimes it is useful to start with a “clean slate” when creating a synth sound, a drum kit or a sampler patch. This is 
achieved by selecting “Initialize Patch” from the Edit menu or from the device context menu. This sets all parameters 
to “default” values. Initializing NN-XT, Dr. Octo Rex or Redrum devices will also remove all sample/REX file refer-
ences, allowing you to start from scratch.

About ReFills
A ReFill is kind of a content package for Reason Essentials, Reason and Record which can contain sounds and ef-
fects patches, samples, REX files, SoundFonts and demo songs. If you like, you can compare ReFills to ROM cards 
for a hardware synthesizer. On your computer, ReFills appear as large files with the extension “.rfl”.

All sounds included with Reason Essentials are embedded in a ReFill named “Factory Sound Bank” located in the 
Reason Essentials program folder.

Additional Propellerhead ReFills are available for purchase. You can also download ReFills from other Reason Essen-
tials users on the Internet, purchase them from other sample manufacturers, etc.

! Be aware that some ReFills may not be usable with Reason Essentials since they contain patches for devices 
that are only included in the full version of Reason.

• Samples (Wave and AIFF files) are compressed to about half their original file size when stored in ReFills, 
without any loss of sound quality whatsoever.

In Reason Essentials, you can use the browser to list and access the embedded sounds and other components within 
the ReFills, just as if the ReFills were folders on your hard disk.

Furthermore, if a song makes use of components from ReFills, Reason Essentials will tell you which ReFills are re-
quired.
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Using the Browser 

The Song Browser dialog

The Browser is a special file dialog that appears when you open songs or load patches, samples, audio files, MIDI 
files or REX files, from regular file folders or from a ReFill.

Besides standard file folder browsing, the browser dialog offers you several useful functions:

• Search for files by name and/or type - see “Using the “Search” function”. 

• Use “cross-browsing” to search for patches belonging to any type of device.
For example, you open the Browser from a Subtractor device to browse for a suitable patch. But instead of limiting 
the Browser to show only Subtractor patches, you can chose to browse for any type of instrument patch. If you se-
lect a patch with a different format than the device you are browsing from, the original device will be replaced by 
the new device. See “Cross-browsing patch files”.

• Create Favorite Lists containing shortcuts to your favorite files for instant access.
See “Favorites Lists”.

• Audition instrument patches, audio samples and loops on the fly.

• Save shortcuts to various locations on your local drive(s).
See “Using Locations and Favorites”.
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Opening the browser
You can use any of the following commands to open the Browser dialog (what file types you can browse for depends 
on which method you used to open the Browser dialog):

• By selecting “Open” from the File menu.
This opens the Song Browser where you can select to open a Reason Essentials Song.

• By selecting “Browse Patches” on the Edit menu with a patch based device selected (or by clicking the 
“Browse Patches” button on the device panel).
This opens the Patch Browser allowing you to browse patches for the selected device. You can also use “cross-
browsing” (see “Cross-browsing patch files”) to select patches for other device types.

• By selecting “Browse Insert FX Patches” on the Edit menu with a Main Mixer Channel or Mix Channel/Audio 
Track device selected.
This opens the Patch Browser, where you can browse for Combinator Effect patches.

• By selecting “Browse Samples” on the Edit menu with a sample based device selected (or by clicking the 
“Browse Samples” button on the device panel).
This opens the Sample Browser, where you can browse for samples in the supported audio formats. 

• By selecting “Browse ReCycle/REX Files” on the Edit menu with a Dr. Octo Rex Loop Player selected (or by 
clicking the “Browse Loops” button on the device panel).
This opens the REX File Browser, allowing you to browse for REX loops to load into the Dr. Octo Rex device.

• By selecting “Import Audio File” from the File menu.
This opens the Audio File Browser, allowing you to browse for WAV, AIFF and REX files to import to an audio track 
in the sequencer. See “Importing audio to the sequencer”.

• By selecting “Import MIDI File” from the File menu.
This opens the MIDI File Browser, allowing you to browse for MIDI files to import to instrument tracks in the se-
quencer. See “Importing Standard MIDI Files”.

• By selecting “Create Instrument...” or “Create Effect...” from the Create menu.
This allows you to browse for patches for any device. When you select a patch in the Patch Browser (without click-
ing “OK” in the browser dialog), the corresponding device is automatically created in the background, together with 
a corresponding sequencer track if an instrument patch is selected. See “Create Instrument/Create Effect”.
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Browser elements

The Patch Browser dialog.

Regardless of what browser mode is chosen (song/patch/sample etc.), the Browser dialog basically contains the 
same main elements, although items may be grayed out if not applicable. The dialog contains the following elements:

Files and Folders list

This is the main browser list, showing the contents of a selected folder - see “Navigating in the Browser”.
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Show drop-down list

This is only available in the Patch Browser (it is otherwise grayed out). It determines what patch types are shown in 
the files and folder list view and thus which patches can be selected. See “Cross-browsing patch files”.

Root Folder drop-down list

The field above the file and folder list displays the name of the currently selected root folder. 

D Click in the name field, or on the arrow button, to bring up a drop-down list where you can move up in the 
folder hierarchy.
Search results and Favorites lists, however, are shown as “flat” lists - with no folder hierarchy.

D Click on the (arrow) button to the right of the root folder list to move up in the hierarchy one level at a time.

Back/Forward buttons

These arrow buttons allow you to move between the browser locations opened while browsing, much like pages in a 
web browser. When the browser dialog is closed, the location list is cleared.
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Locations and Favorites list

This list contains shortcuts to various locations. You can manually add any locations (on any local drive) to the bottom 
section of the list below the gray divider. The locations above the gray divider are default and cannot be changed. Se-
lecting an item in the “Locations and Favorites” list will open the corresponding folder/ReFill as the root in the main 
files and folder list - see “Navigating in the Browser”.

In the “Locations and Favorites” list you could also create your own “Favorites Lists”. The “Favorite Lists” can contain 
shortcuts to your favorite patches, samples or song files - see “Favorites Lists”. 

Search pop-up and text field

These items allow you to specify a search location and to enter a text string to search for, respectively. The Search 
function is described in “Using the “Search” function”.

Info and Details

The “Info” section in the left corner can show Song/ReFill splash images and the “Details” section shows information 
about the item currently selected in the “Files and Folders” list. Exactly which information is shown depends on the 
file type. For example, samples or REX files contain information about the file format and length of the selected file, 
while a selected song file can display comments from the author (see “Including Song Information”) etc. If the se-
lected file is part of a ReFill, this will be indicated regardless of the file type.
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Audition section

This section contains controls for auditioning audio files, samples and REX files - see “Selecting and auditioning sam-
ples”. For all other file types, the “Audition” section will be grayed out.

Select Previous/Next arrow buttons

These buttons allow you to select previous or next patches in the “Files and Folders” list. In the Patch or Sample 
Browser, a selected file (patch or sample) is automatically loaded in the background.

Loading indicator

This icon will light up to indicate that a patch or sample is being loaded. You cannot play or audition the sound until it 
is loaded and the indicator switches off.

Navigating in the Browser

The Patch Browser opened from an ID8 device, allowing you to browse for Combinator patches - or other instrument patches.
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When navigating in the Browser, items are shown as a hierarchical list in a selected root folder, just like in your com-
puter’s file browser (Finder on Mac and Explorer on Windows). 

All folders and sub-folders within a root folder are shown, but only files of the relevant type (i.e. songs/samples/
patches etc.) can be viewed/selected in the Browser. For example, if you have selected to browse samples for a NN-
XT device, only audio samples and REX files will be shown in the Browser.

D Click on the plus sign (Win) or arrow (Mac) next to a closed folder to open it. If the folder contains files of the 
relevant type, these will be shown.

D Double-clicking a folder in the list opens it as the root folder in the Browser.

• The “Name”, “Modified” and “Size” columns show the name of the folder or file, the modification date and the 
size (files only), respectively. 
Clicking on a column header sorts the files accordingly (i.e. alphabetically, by modification date or by file size).

D You can use the “Back/Forward” buttons to move between the different locations you have opened in the 
Browser.
When you close the Browser the “location list” is cleared.

D Use the “Select Previous/Next” arrow buttons to step between files in the current “Files and Folders” list.
Only files will be stepped through, while folders are skipped.

• The Root Folder drop-down list to the right of the “Back/Forward” buttons allows you to move up in the folder 
hierarchy when the Browser points to a specific folder location (see “About hierarchic and flat lists” below). 

About hierarchic and flat lists

In certain circumstances the Browser will display a flat list without any folder hierarchy. In such cases there will be an 
extra “Parent” column displaying the parent folder location for all files. The “Root Folder” drop-down list will then also 
contain a shortcut to the selected file’s parent folder - the “Go To Parent Folder” item.

The Browser display for flat lists

Flat lists are shown in the following cases:

• When the Browser is showing a search result - see “Using the “Search” function”. 

• When the Browser is showing a Favorites folder list - see “Favorites Lists”.

• When the Browser is showing a browse list stored for a device in a saved song - see “About browse lists”.

The “Parent” column
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Using Locations and Favorites
To help you to find your files quickly, you can add shortcuts to the folders where you store your samples and patch 
files etc. By default, the Locations list contains fixed locations above the divider. You can easily add your own loca-
tions below the divider in this list if you like.

• Selecting a Location or Favorite List in the list opens it as the root folder in the Browser.

D To add a new Location or Favorite, select a file, folder or ReFill in the main browser list and drag and drop it 
below the gray divider in the “Locations and Favorites” list. Alternatively, select the file, folder or ReFill in the 
Browser list and click the “Add As Favorite” button.
Any new Locations or Favorites will be added below the list of fixed locations. An insertion line is shown to indicate 
where in the list the new location will placed. Manually added locations can later be reordered by dragging and 
dropping.

D To remove a Location or Favorite, select it in the “Locations and Favorites” list and press [Backspace] or [De-
lete] - or click the “Remove Favorite” button.
Alternatively, select “Remove” from the context menu.

! The default locations (above the gray divider) cannot be removed.

! If a stored location has been removed or is unavailable, a warning triangle with an exclamation mark is shown 
before the location name in the “Locations and Favorites” list.

Favorites Lists
“Favorites Lists” provide a way to group and order files that may be physically located at different places on your local 
drives. Any file that can be loaded in Reason Essentials (songs, patches, samples etc.) can be added to a “Favorites 
List”. Only shortcuts to the files are added - the original files aren’t moved.

This is particularly useful for handling patches. By adding the patches you need for a given situation to a Favorite List, 
you can determine exactly which patches will be selectable for a device, and in what order. You can then sequentially 
step through these patches using patch select buttons on your MIDI keyboard or control surface device. See “Using 
Favorites - a practical example”.

The “Add As Favorite” button

The “Remove Favorite” button
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D To add a New Favorite List, click the “Create New Favorite Lists” button.

The “Create New Favorites Lists” button

An empty “folder” is created, named “New Favorite List”. Favorite Lists are always indicated by a star icon. The 
Browser list remains unchanged.

D To rename the “New Favorite List” folder, double-click it and type in a new name.
Alternatively, select “Rename” from the context menu.

D To add a file to the “Favorite List” folder, select it in the Browser and drag it to the desired “Favorite List” 
folder.
You can also select multiple files using standard selection techniques - [Shift] and/or [Ctrl](Win) or [Command] 
(Mac) - and drag these into the folder in the same way.

D Select the “Favorite List” folder to view the currently added files in the Browser list.
What is selectable/shown in the Browser list depends as usual on the current Browser mode. If you select a Fa-
vorite List folder that contains samples, these will only be shown if the Sample Browser is selected.

• When a “Favorites List” folder is selected in the Browser, an additional “Parent column” is shown (just like 
Search results), listing the name of the containing folder for each file in the list.

• Files in a “Favorites List” folder cannot be sorted by clicking the column headers. However, they can be reor-
dered by using drag and drop. 

D To remove files from a “Favorite List” folder, select the folder and then select the files in the Browser list and 
press [Delete], or select “Remove” from the context menu.
This removes the shortcut only - the original file isn’t affected.

D To remove a “Favorite List” folder, select it and press [Backspace] or [Delete] - or select “Remove” from the 
context menu.
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Using Favorites - a practical example

Here follows a practical example of how you can use Favorites for patch files:

You are preparing for a live gig as a keyboard player. You know the songs, and you have chosen suitable patches (in 
various device formats) for each song.

You want to use Reason Essentials, but you want to be able to switch to the correct patch for each song using your 
MIDI keyboard, and not have to worry about fiddling with the computer during your performance.

Here is how this can be done by using Favorites:
1. Create a new Reason Essentials song.

2. Create an instrument device, for example a Combinator.
It doesn’t matter which instrument device you choose at this point. 

3. Open the Patch Browser from the Combinator device.

4. Click the “Create New Favorites Lists” button.
A new folder appears in the list. Double-click it and type in an appropriate name.

5. Select to show “All Instruments” on the Show drop-down list.
Now you can start locating the patches you need by navigating in the Browser.

6. When you have located a patch that you need for the gig, drag it from the Browser into the Favorites List folder.
If this was a patch in a different format than the instrument you created, a device of this type will replace the orig-
inal device (see “Cross-browsing patch files”).

7. Continue to add new patches in the same way until you have all the patches you need.

8. When you’re done, select the Favorites List folder.
The folder is opened in the Browser, listing all the patches you added.

9. Use drag and drop to order the patch files according to the set list.

10.Select the first patch file in the Favorites List and click OK. 
The browser closes with the patch loaded.

D If you have a MIDI keyboard or control surface with programmable buttons, you can assign a button to “Select 
next patch” on the device.
Many MIDI keyboards and control surfaces have buttons assigned to patch selection - check the Control Surface 
Details document for information about your controllers. Alternatively, you can manually assign buttons for select-
ing patches - see the “Remote - Playing and Controlling Devices” chapter.

11.Save the Song.

12.At the gig, open the song, and the first patch will be loaded.

13.When the first song is finished, use the “next patch” button on the device or on your MIDI keyboard and the 
next patch in the Favorites List will be loaded!
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Selecting and auditioning patches
In the Patch Browser, selecting a patch automatically loads it in the background (i.e. with the Browser dialog still 
open). This allows you to preview patches before confirming a selection by clicking OK in the Browser.

D Select a patch and play a few notes to audition the patch.

D For effect patches you can activate loop playback in the sequencer before opening the Patch Browser from the 
effect. 
Once the Browser dialog is open, you can browse to a folder containing compatible effect patches and step 
through them to hear how the patches affect the sound.

q You can also audition patches for any instrument or effect device - not just the device you opened the browser 
from! See “Cross-browsing patch files”.

Selecting and auditioning samples
For audio files, samples and REX loops you can use the Audition controls to preview the audio.

This is done in the following way:

D Select the file in the file list and click the Preview - Play button to the right.
The file is played back. During playback, the Play button in the Audition section is relabeled to “Stop” - click this to 
stop playback.

D You can also activate the Autoplay checkbox and simply select the file you want to audition.
The selected file is automatically played back. Again, click the Stop button to stop playback.

About browsing large patches

As stated previously, when you are browsing patches (or samples), these are automatically loaded in the background 
when selected. Most of the time, this happens instantaneously. Bear in mind, however, that some files (especially big 
Combinator patches, which can contain any number of devices and samples) can take a little while to load.

q If you select a particularly large patch by mistake, you can abort the loading by simply selecting another patch.

Selecting multiple files
It is possible to select multiple files in the Browser, by using standard [Shift] or [Ctrl](Win) or [Cmd](Mac) selection 
techniques. This, however, doesn’t necessarily mean that the selected files can be loaded. There are basically three 
instances where selecting several files in the Browser file list is relevant:

• It is possible to load several samples simultaneously into the NN-XT sampler device.
See the “NN-XT Sampler” chapter for details.

• It is possible to load several (up to eight) REX files simultaneously into the Dr. Octo Rex device.
See the “Dr. Octo Rex Loop Player” chapter for details.

• You can select several files to add them to a Favorites list in one go - see “Favorites Lists”.

! In situations where several selected files (e.g. patches or songs) cannot be loaded, the “OK” button in the 
Browser is grayed out.
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Cross-browsing patch files
Cross-browsing patches is a powerful feature of the Patch Browser. It allows you to browse for any type of instru-
ment patches or effect patches, regardless of which instrument or effect device you opened the Browser from.

About instrument and effect patches

Patches are internally divided into two patch categories in the Browser; instrument patches and effect patches (the 
Browser “knows” what type of patch it is). This is because instrument patches and effect patches are fundamentally 
different - instruments are played, and effects are used to process sound - and you would logically browse for one or 
the other, but not both.

When browsing patches from an existing instrument device, the options on the Show menu are:

• “XXX Patches” (where XXX is the device type you opened the Browser from, e.g. NN-XT).

• “All Instruments” will show patches for any instrument device.

When browsing patches from an existing effect device, the options on the menu are:

• “XXX Patches” (where XXX is the device type you opened the Browser from, e.g. RV7000).

• “All Effects” will show patches for any effect device that uses patches, including Combi patches.

! When browsing Insert FX patches for an audio track, Mix Channel or the Master Section, cross-browsing is not 
possible (you can only load effect Combinator patches).

! You cannot cross-browse to devices that don't support patches. This includes the ID8, as it only supports its 
built-in Preset sounds.

Cross-browsing - an example:

1. You are playing a Subtractor device but feel that the sound isn’t quite what you had in mind, so you open the 
Browser to check out some other patches.

2. After browsing Subtractor patches for a while, you still haven’t found the type of sound you wanted, so you 
click the “Show” pop-up and select “All Instruments” from the menu.
Now you can select instrument patches for any patch-based device. You decide to browse a folder containing NN-
XT patches. You can use the Previous/Next buttons to step through the files in the selected folder.

3. As soon as you select an NN-XT patch in the Browser, an NN-XT device replaces the Subtractor in the back-
ground (the Browser is still open).
The sequencer track which was previously assigned to the Subtractor is now assigned to an NN-XT with the patch 
selected in the Browser loaded.

• The name of the sequencer track is not automatically changed to reflect the new device.
This may or may not matter. If the track was named “Bass” (and it is a bass sound you are looking for), this obvi-
ously works fine. But if the track was named “Subtractor 1” and you end up with another device connected, it might 
be better to rename the track to avoid confusion.

D You can continue to browse patches and play your keyboard to audition them.
Each time you select a patch type belonging to a different device, a corresponding instrument device is created in 
the background, replacing the previous instrument.

4. When you have settled on a patch - for whatever instrument device - click “OK” to confirm the selection and 
close the dialog.
Clicking Cancel will return to the same state as when opening the Browser.

• Cross-browsing for an effect patch it works in the same way - selecting an effect patch of a different format will 
replace the current effect in the background with a device of the selected format.
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Special instances of cross-browsing

There are a few instances when replacing an existing device by browsing might lead to lost connections:

• When a device is replaced by another device type, audio connections may be lost. 
An example is replacing an NN-XT, which can use up to audio 16 outputs, with a Subtractor which only has one 
output.

• When a device is replaced by another device type, CV connections on the back panel may be lost.
The only connections that are retained between device types are Sequencer Control CV/Gate in.

! If you encounter such situations and you want to restore the original connections, use the “Undo” function. 
Browsing back to the original device patch will not restore lost connections.

Create Instrument/Create Effect
These functions allow you to browse for any kind of instrument or effect patches. This is essentially the same as 
cross-browsing, except that you do not start with an existing device. The “Create Instrument/Effect” functions are 
very useful if you’re looking for a specific type of sound or effect but don’t know, or don’t care, what devices are used. 
For example, you might be looking for a “pad” sound or a “delay effect”. Once you’ve found what you’re looking for, 
you can just click “OK” and the sound or effect will open in the required device(s).
1. Select “Create Instrument...” or “Create Effect...” from the Create menu.

The Patch Browser opens. Depending on your selection, only Instrument Patches or Effect Patches are shown.

2. When you select a patch, a corresponding device is created automatically.
If you select an instrument device patch, a corresponding sequencer track will also be automatically be created. If 
an “empty” Mix Channel device isn’t available in the rack, a new one will be automatically created - with its channel 
strip in the Main Mixer. The instrument device will be automatically connected to the Mix Channel device. Master 
Keyboard input will be set to the new track so that you can audition the patch by playing your master keyboard.

3. When you have found the patch you want, click “OK” to confirm the creation of the new device and to close the 
Browser.

About patch formats and sampler devices 
As the NN-XT sampler device can load patches in the Reason NN19 (.smp) and REX (.rx2/.rcy/.rex) formats, there 
must be certain rules regarding cross-browsing. 

• The basic rule is that the Browser will load such patches into the original device type (the device you opened 
the browser from), whenever possible.
Thus, when the patch format is NN19 (.smp) or REX (.rx2/.rcy/.rex) and you are browsing from an NN-XT device, 
the patch will be loaded into this device.

• If you are browsing from any other type of device, these patch types will be loaded into a NN-XT device.

• If you are using the “Create Instrument” function, a REX patch will create a Dr. Octo Rex device.
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Using the “Search” function

The Search function allows you to search for files by name and/or type. The Browser mode (patch, song etc.) deter-
mines what file type(s) you can search for, just as when you are manually navigating in the Browser. 

The “Search In:” pop-up menu

This pop-up menu allows you to select where to search. The options are as follows:

• “Local disks” will perform a complete search of all local drives. 

• “User Locations” will search all folders and ReFills stored in the Locations list (except the Desktop).

• “Current Folder” will limit the search to the currently selected root folder (including subfolders).

The “Search For:” text field 

This is where you can enter a text string to search for.

• You can specify one or several words, whole or partial. 
If you specify more than one word, the search will show results that match all specified words. 

! Text search is not case sensitive.

q Note that you don’t have to enter text to use the Search function. Depending on the selected Browser (Patch, 
Sample etc.), you can also simply search for files of the corresponding type in the selected location(s).

Executing the search

D Click the “Find” button to execute the search according to your specifications.
After the search, the search result is shown as a flat list in the Browser, and the “Root Folder” field reads “Search 
result”. 

• A new “Parent” column also appears, listing the name of the parent folder for each file.
If you select a file, you can pull down the “Root Folder” drop-down list and select “Go to Parent folder” - this opens 
the parent folder for the selected file.

• Folder names are also included in the search result (given that it contains patch files of the appropriate type). 
This means that if you are searching for “Guitar”, all samples or patches with “Guitar” in the filename will be shown, 
but also all samples or patches contained in folders with “Guitar” in the name.
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• If you have opened the Browser and searched for patches from an instrument device, you can select to show 
all patches that match the search criteria by selecting to show “All Instruments” on the Show drop-down list.
This will extend the search result to show all patches that matches the search text. Note that you do not have to 
repeat the search to do this.

• If you have opened the Browser and searched for patches using the “Create Instrument” or “Create Effect” 
item on the “Create” menu, the “Show” drop-down list will be grayed out.
In this situation, the search result will always include “All Instrument Patches” or “All Effect Patches”.

Opening files
When you have navigated to the desired folder (on your hard disk or within a ReFill) and located the desired file, you 
open it by double clicking it in the file display or by selecting it and clicking the “OK” button.

As described earlier, patches and samples are loaded directly upon selection, so clicking ”OK” doesn’t actually “open” 
the file, it simply confirms the selection, and closes the Browser dialog.

About browse lists
When you click “OK” to open a file from the Browser, the file and folder list shown at that time is memorized for that 
device. This is called a “browse list”. 

For patches (and to a certain extent samples) this list provides a specific functionality:

• The browse list is what applies when changing patches using the Next/Previous Patch buttons on the front 
panel of a device (or from patch selectors on a control surface).

• The browse list is shown as the patch list when you click in the patch name field for a device.

• For samples, the browse list applies when changing samples using the Next/Previous Sample buttons on the 
front panel of a sampler device.

What can a browse list contain?

• When you confirm a patch or sample selection by clicking “OK” in the Browser, the resulting browse list will in-
clude the files contained in all currently open folders in the Browser.
If you open the Browser again for the same device, the same file and folder structure is shown. 

• If you save the current song and reopen it, the items in the browse list will be shown as a “flat” list, and the 
“Root Folder” field will show “Document Browse List”.
In these situations, the Browser will show the “Parent” column, listing the names of the source folders. The “Root 
Folder” drop-down list will also contain the item “Go to parent folder” for a selected file.

• A browse list could also be a Search result, or a Favorites List.
Favorites Lists provide a way of controlling/filtering which patches or samples will be available on a browse list for 
a device - see “Using Favorites - a practical example”!

! Note that if you opened a patch after having used cross-browsing (see “Cross-browsing patch files”) or used 
the Search function (see “Using the “Search” function”), the active browse list could contain patches of differ-
ent formats, and stepping through patches from the device panel could change the device type.
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Handling Missing Sounds
Sampler patches, drum machine patches, Dr. Octo Rex patches and SoundFonts contain references to samples - 
files on your hard disk. The same is true for songs that contain samples (in sampler or drum machine devices) or REX 
files. If any of these files have been moved, renamed or removed when you try to open the patch or song, Reason Es-
sentials will alert you that files are missing by showing the “Missing Sounds” alert. The “Missing Sounds” alert will also 
appear if patches in the song are part of a ReFill which has been moved, removed or is not installed on your com-
puter:

The “Missing Sounds” alert

The main display in the dialog lists all missing files. The four columns show the following properties:

Below the main display are four buttons:

D Click on the “Open Without” button to open the song or patch without the missing sounds.
The song or patch will be opened, but with sounds missing. This means that sampler patches, drum machine 
patches and/or loop players will not play back correctly.

On the panels of the concerned devices, missing samples are indicated with an asterisk (*) before the file names:

D Click on the “Locate Sounds” button to open the “Missing Sounds” dialog.
See “The Missing Sounds dialog”. 

| Column | Description

Device Shows the name of the device in which the missing sound is used, along with a de-
vice type icon.

Sound Shows the name of the missing file, along with a file type icon.

Part of ReFill/SoundFont If the missing file is part of a ReFill, or a SoundFont within a ReFill, this column 
shows the name of the ReFill/SoundFont If there is an URL (Internet address) as-
sociated with a ReFill, you can download the necessary ReFill(s) from this dialog, 
as described below.

Status When the dialog appears, all files will have the status “Missing”. Files that are found 
by the auto-search function or manually replaced will be indicated with “OK”.

This sample is missing



SOUNDS AND PATCHES 297

D Click on the “Cancel” button to cancel the operation
No song or patch will be opened.

D Click on the “Help” button to get to the “Missing Sounds” help section in the application.

About missing ReFills

If a song contains patches from a ReFill and the ReFill has been moved, or removed since you saved the song, the 
following alert will show up when you open the song:

The “Missing ReFill” alert

! This alert is shown if only ReFill patches are missing, but all other sounds in the song can be located.

D If you have a disk (CD or DVD) containing the missing Refill, insert the disk and locate the ReFill in the browser 
that appears.

D If the missing ReFill is available somewhere on your hard disk, Click “Browse” and locate it in the browser that 
appears.

D Click “Cancel” to continue to load the song without the missing ReFill patches.

The Missing Sounds dialog
If you clicked “Locate Sounds” in the “Missing Sounds” alert described in “Handling Missing Sounds”, the “Missing 
Sounds” dialog appears:

The “Missing Sounds” dialog

The “Missing Sounds” dialog features the same columns as the “Missing Sounds” alert.
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Selecting files

The “Search Locations”, “Search Folder”, “Browse Manually” and “Download ReFill” functions (see below) are per-
formed on the files that are selected in the list. This allows you to replace some files manually (necessary if the files 
have been renamed or are outside the Locations), have the program find other files automatically and skip the rest of 
the files.

D To select a file, click on it in the list.
You can use the standard [Shift], or [Ctrl](Win) or [Cmd](Mac) selection techniques to select several files.

D To select all files in the list, click the “Select All” button above the list.
When the dialog first appears, all files in the list are selected by default.

Search Locations

If you click the “Search Locations” button, Reason Essentials will search for the selected files in all Locations set up 
in the Browser (except the Desktop). If the program finds a file with the matching name and file type, the new path is 
stored in the song/patch and the file is shown as “OK” in the Status column.

! Since the file search looks at the file names, files that have been renamed will not be found!

This also means that if your Locations contain several files with the same name, the wrong sounds may be found.

Search Folder

This function is useful when you need to replace a whole lot of samples and you know where these samples are lo-
cated. A typical example would be if you have reorganized the folder structure on your computer, and the sample 
folder has been moved in relation to the folder with a sampler patch or song.

D If you click “Search Folder”, the Browser opens, asking you to select the sample directory, i.e. the folder in 
which you know that the samples are located.
Select the folder. When you click “OK”, Reason Essentials will search in the selected folder (and its husbanders) 
only.

If the program finds a file with the matching name and file type, the new path is stored in the song/patch and the file 
is shown as “OK” in the Status column.

Browse Manually

This function opens the Browser dialog, allowing you to manually locate each missing file. This allows you to use files 
that have been renamed. The Browser dialog will appear once for each selected file in the list. The name of the file 
to look for is shown in the Browser window’s title bar.

D If you click “Browse Manually”, the Browser opens, asking you to select the sample indicated in the Browser’s 
title bar.
Select the sample and click “OK”. 

D If you have selected several samples in the Missing Sounds dialog, the Browser remains open, promting you to 
select the next sample, as indicated in the Browser’s title bar.

Download ReFill

If a missing sound is part of a ReFill (as indicated in the Part of ReFill/SoundFont column), and there is a valid URL 
(Internet address) for this ReFill, you can download the ReFill directly from this dialog (provided you have a working 
Internet connection):
1. Select the sound(s) that use the ReFill.

! You should only select several sounds if they use the same ReFill.
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2. Click the “Download ReFill” button.
This launches your Internet browser and takes you to the URL associated with the ReFill.

3. A dialog appears, asking you to download the ReFill. Do so.

4. Click OK.
Reason Essentials automatically scans the downloaded ReFill and locates the files.

Proceeding

At any point, you can click the “Done” button to close the dialog and open the song or patch. There are a couple of 
things to note, though:

• For the files you have found (status “Replaced”), the new paths will be stored in the song or patch.
However, you need to save the song or patch for the changes to become permanent!

• If any file is still missing when you click OK, there will be sounds missing in the song/patch.
Sometimes, you may want to proceed with sounds missing, and then remove or replace the sounds from the de-
vice panels in the rack instead.

On the device panels, missing samples are indicated with an asterisk (*) before the file names:

D Clicking “Cancel” will abort the operation, i.e. the song or patch will not be opened.

Reason Essentials file formats
The following table lists the file formats that you can browse and open using Reason Essentials’s browser:

| File type | Extension | Description

Reason Essentials Song .ree This is the main document format in Reason Essentials. It contains the recordings on all au-
dio, instrument and automation tracks - and the device setup in the rack, along with refer-
ences to any used instrument samples and loops - or it can contain the actual samples and 
loops if you have made the song “self-contained” (see “About Self-Contained Songs”).

Reason Essentials Demo 
Song

.reedemo A Reason Essentials Demo Song is a factory made song intended to demo the sound and 
features of the Reason Essentials program. Reason Essentials Demo Songs are the only 
song file type that can be opened when you run Reason Essentials in Demo Mode (without 
authorization). See “Opening a Reason Essentials Demo Song”.

Reason Limited Song .rltd This is a song created in Reason Limited. It contains the recordings on all audio, instrument 
and automation tracks - and the device setup in the rack, along with references to any used 
instrument samples and loops - or it can contain the actual samples and loops if the song was 
made “self-contained” in Reason Limited (see “About Self-Contained Songs”).

Combinator Patch .cmb The Combinator can store/recall combinations of Reason Essentials devices. Combinator 
patches (Combis) will save all panel settings (as well as sample references if used) for all de-
vices that are part of the Combi. In addition, all routing (audio/CV) between devices in the 
Combi are included in the patch. Effect Combi patches are also used for Insert FX patches in 
the Main Mixer.

Subtractor Patch .zyp This is a patch for the Subtractor synth device, containing all panel settings. You store your 
synth sounds by saving Subtractor patches.

NN19 Sampler Patch
(Reason)

.smp This is a patch for the Reason NN19 Sampler device, containing references to and settings 
for all used samples, along with panel settings. NN19 .smp patches can be opened in NN-XT 
devices in Reason Essentials.

NN-XT Sampler Patch .sxt This is a patch for the NN-XT Sampler device, containing references to and settings for all 
used samples, along with panel settings.
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Redrum Patch .drp This is a patch for the Redrum drum machine device. It contains information about which 
drum samples are used, along with all drum sound settings. In effect, a Redrum patch is a 
stored drum kit.

Dr. Octo Rex Patch .drex This is a patch for the Dr. Octo Rex Loop Player device. It contains information about which 
REX Loops are used, along with all loop and panel parameter settings.

REX files .rx2, .rcy or .rex REX files are created in another Propellerheads application, the ReCycle loop editor. REX 
files contain audio loops chopped into slices, with one slice for each significant beat in the 
loop. 
By loading a REX file into the Dr. Octo Rex Loop Player device, you can play back the loop in 
virtually any tempo (without affecting the pitch), manipulate individual beats in the loop, ex-
tract timing info, etc.
You can also load REX files into the NN-XT sampler and the Redrum drum machine.
REX files can also be imported to Audio Tracks in Reason Essentials and are then automati-
cally converted to audio clips. 

RV7000 Patch .rv7 This is a patch for the RV7000 reverb effect, containing all panel settings.

Scream 4 Patch .sm4 This is a patch for the Scream 4 distortion effect, containing all panel settings.

Line 6 Amp Tone l6t This is a patch for the Line 6 Amp devices in Reason Essentials. It contains all panel settings 
as well as information about used Amp and Cabinet models.

Audio files and Samples .wav or .aif WAV and AIFF files of various resolutions and sample rates can be imported to Audio Clips 
on Audio Tracks in Reason Essentials.
The NN-XT sampler and the Redrum drum machine can also load and play back samples in 
Wave or AIFF format. You can use files of different formats in the same device - one drum 
sound can be an 8-bit sample, the next a 16-bit sample, etc.

SoundFont Bank .sf2 The SoundFont format was co-developed by E-mu Systems and Creative Technologies and is 
used with many audio cards and software synthesizers. SoundFont banks store wavetable 
synthesized sounds, allowing users to create and edit multi-sampled sounds in special 
Soundfont editing programs. The SoundFonts can then be played back in wavetable synthe-
sizers, typically on audio cards, thereby effectively turning an ordinary sound card into a sam-
pler.
The NN-XT Sampler and the Redrum drum machine allow you to browse and load Sound-
Fonts. Regardless of which editing program was used to create them, these banks are simi-
larly and hierarchically organized, with folders for instruments, presets, samples etc. The NN-
XT and the Redrum lets you load individual samples and presets from a SoundFont bank, but 
not the complete SoundFont.

| File type | Extension | Description
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Routing Audio and CV
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About this chapter
This chapter describes the various signals used in Reason Essentials and how you can route them.

Signal types
The following signal types are used in Reason Essentials:

Audio signals
Besides the Spider CV and Matrix Pattern Sequencer, all devices have audio connectors on the back. The audio con-
nectors carry audio signals to or from devices via virtual cables.

D Audio connectors are shown as large quarter inch jacks.

D Audio Effects devices, which are used to process audio, have both audio inputs and outputs.

D Instrument devices, which generate audio, have either mono or stereo left/right audio output connectors.
You do not have to use both outputs for devices with stereo outputs. Use the left output to use a mono signal from 
a stereo device.

D To monitor audio outputs from devices, the signals can be routed, either via the Main Mixer or directly, to the 
physical outputs of your audio interface via the Reason Essentials Hardware Interface (see “Manual audio 
routing”). 
Typically, if you are using an audio interface with stereo outputs, you will most likely use the Main Mixer to mix the 
audio signals to the master outputs.

D To route audio input signals from your audio interface to audio tracks in the sequencer, you just have to select 
the appropriate input(s) from the Audio Input drop-down list on the corresponding audio track (see “Selecting 
audio input(s) and defining mono or stereo”).
This means that you never have to manually patch input signals from the Audio In jacks of the Reason Essentials 
Hardware Interface.

For more information about signal paths in Reason Essentials, see “System signal paths”.

CV/Gate signals
In the early days of synthesizers, before the MIDI protocol was invented, analog synthesizers could be interconnected 
using Control Voltage (CV) cables. For example, one cable would be used for controlling pitch while another would 
send a Gate voltage, basically telling a synth when to play a note and when to stop. The CV signal cables in Reason 
Essentials emulate this analog control system. CV signals are typically used to modulate parameter values, and do not 
carry audio.

D CV/Gate connectors are shown as smaller mini jacks.

D CV is typically used for modulation purposes.
For example, you could modulate a parameter with a CV signal generated by an LFO or an envelope generator on 
another device.

D Gate outputs/inputs are typically used to trigger events, such as note on/off values, envelopes etc.
Gate signals produce on/off values, plus a “value” which could be likened to (and used as) velocity.

D You can only route CV/Gate signals from an output to an input (or vice versa).
You cannot route an input to another input or an output to another output.
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About P-LAN signals
P-LAN is the internal system used for routing audio signals from Mix Channel and Audio Track devices, with their 
Main Mixer channel strips, to the Main Mixer Master Section device. P-LAN connections are not indicated by cables 
or similar in the rack - only by a display on the rear of Mix Channel and Audio Track devices. 

The P-LAN connections are fixed and cannot be created or removed. However, if you use the Direct Out jacks on an 
Audio Track device or Mix Channel device, the internal P-LAN connection is broken. In this case, the audio from the 
Mix Channel/Audio Track device is not sent to the Master Section.

About MIDI routing
Normally, MIDI (e.g. note and performance data) are sent to devices from their respective sequencer track. No cables 
are used in the rack to indicate MIDI connections.

For other ways to route MIDI to devices, see the chapters “Remote - Playing and Controlling Devices” and “Synchro-
nization and Advanced MIDI”.

About cables

Cable appearance
If there are many connections in Reason Essentials, the cables can sometimes obscure the view, making it difficult to 
read the text printed on the back panels of the devices. Cables can be displayed in “normal” mode and in “Reduced 
Cable Clutter” mode.

D Toggle cable display mode by pressing [K] or by selecting “Reduce Cable Clutter” on the Options menu:

• In “normal” mode, i.e. with the option “Reduce Cable Clutter” deselected, all cables for all devices are dis-
played at the back of the rack.

• With “Reduce Cable Clutter” selected, the cable appearance depends on the settings in the “Appearance” sec-
tion on the “General” tab in Preferences:
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D Select “Show For Selected Devices Only” to only display the cables for selected devices.
All other (non-selected) devices will have “transparent” cables to make it easier to distinguish the cables of se-
lected devices.

D Select “Hide Auto-Routed Cables” to only display manually routed cables.
All devices with auto-routed cables will have “transparent” cables to make it easier to distinguish the manually 
routed cables.

D Select “Hide All Cables” to hide all auto-routed and manually routed cables.
All cable connections on devices will be indicated with colored dots in the jacks, and no cables will be displayed.

“Reduce Cable Clutter” selected with the “Hide All Cables” appearance

• In “Reduced Cable Clutter” mode, it’s still possible to connect and disconnect cables in the same way as when 
they are shown.
See “Manual routing” for a description of routing methods.

Checking and following cable connections
You can always check to which device a jack is connected. This is especially useful if the patch cables are hidden, but 
it is also practical if you have a lot of cables in your rack, or if the two connected devices are far from each other in 
the rack:

D Hover with the pointer over a connector and wait a moment.
A tool tip appears, showing both the device name and connector that the cable is connected to.

About the “Scroll to Connected Device” function

It’s possible to scroll directly to a connected device as follows:
1. Click and hold (or right-click (Win) or [Ctrl]-click (Mac)) on a connector.

A pop-up menu appears.

2. Select “Scroll to Connected Device” from the pop-up menu.
The device in the other end of the cable will be scrolled into view in the rack.
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Cable color
To allow for a better overview of the connections in the rack, the cables have different colors:

• Audio connections between instrument and mixer devices are different shades of red.

• Connections to and from effect devices are different shades of green.

• CV connections are different shades of yellow.

• Combinator connections are blue.

Automatic routing
Auto-routing enables the automatic routing of cables between devices according to certain rules. Auto-routing is per-
formed under the following circumstances:

• When you create a new (Empty) Song, the Master Out L & R on the Master Section device are by default con-
nected to Outputs 1 & 2 of the Reason Essentials Hardware Interface.

• When a new device is created.

• When moving, duplicating or pasting devices with [Shift] pressed.

• When selecting “Auto-route Device” from the Edit or context menu, with one or several devices selected in the 
rack.

• Audio input signals from the Reason Essentials Hardware Interface to the audio tracks in the sequencer are 
automatically routed “in the background”.

When applicable, auto-routing is performed in stereo.

Auto-routing of audio input signals
• Available audio inputs on your installed audio interface are auto-routed from the Hardware Interface to audio 

tracks in the sequencer “in the background”. 
This means that no patch cables are necessary for routing audio to audio tracks in the sequencer.

Yellow cables 
indicate CV 
connections.

Red cables indicate connections 
between instrument and mixer 
devices.

Green cables indicate effect device connections.



ROUTING AUDIO AND CV306

Auto-routing of Instrument devices

Routing to the Main Mixer

• When you create an instrument device, it is automatically connected to a new Mix Channel device in most sit-
uations.
However, if the instrument device is created directly below an unused (no inputs connected) Mix Channel device 
in the rack, it will be connected to this instead.

Routing to the Mixer 14:2 or Line Mixer

• If a Mixer 14:2 or Line Mixer 6:2 is selected when you create an Instrument device, or if you create an Instru-
ment just below the mixer device in the rack, the instrument will be auto-routed to the first available inputs on 
the mixer device.

Auto-routing of Effect devices

Routing as a Main Mixer insert effect

• When you have a Mix Channel or Audio Track device selected and create an effect device, it will be automati-
cally connected as an insert effect in the Mix Channel/Audio Track device. See “Adding Insert effects”.

! The above does not apply to the Master Section device - see below!

q It’s also possible to select Effect Combi patches as insert effects - see “Loading Effect Combi patches”.

Routing as a Main Mixer Master Section insert effect

Routing an effect device as an insert effect in the Maser Section device can be done in the following ways:
1. Click the “Show Insert FX” button on the Master Section device and then click inside the Insert FX container.

A red insertion line is shown.

2. Create an effect device from the Create menu, or by selecting it from the device context menu, or by double-
clicking on the device in the “Devices” tab in the Tool Window.
The device will be automatically connected as an insert effect in the Master Section device.

D By dragging and dropping an effect device from the “Devices” tab in the Tool Window to the open Insert FX 
container in the Master Section device, it will be automatically connected as an insert effect.

q It’s also possible to select Effect Combi patches as insert effects in the Master Section - see “Loading Effect 
Combi patches”.
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Routing as a Main Mixer Master Section send effect

• When you have the Master Section device selected and create an effect device, it will be automatically con-
nected as a send effect to the first available Send FX connectors on the Master Section device. See “Creating 
Send effects”.

q It’s also possible to use the “Add Send FX” function to add effect devices or Effect Combi patches as send ef-
fects in the Master Section - see “Creating Send effects”.

Routing directly to another device

• When you have an instrument device selected and create an effect, that effect will be connected as an “insert” 
effect between the instrument device and the Mix Channel/mixer device. 
Examples of effects that work well as insert effects are distortion, compression and modulation effects.

Routing as a send effect to a mixer device

• When you have a mixer device (the Mixer 14:2 or Line Mixer 6:2) selected in the rack and create an effect de-
vice, it will be automatically connected as a send effect (to the first free Aux Send/Return jacks).

Auto-routing of CV/Gate signals

The Matrix Pattern Sequencer

• When you have an instrument device (Subtractor/NN-XT/Combinator) selected and create a Matrix Pattern 
Sequencer, the Note and Gate CV signals will be auto-routed to the instrument device.
The Matrix Note and Gate CV outputs are automatically connected to the Sequencer Control CV and Gate inputs 
on the instrument device, respectively.

Auto-routing devices after they have been created
Some additional rules regarding auto-routing devices that are already in the rack:

D To reroute a device already in the rack, you can select it and choose “Disconnect Device” and “Auto-route De-
vice” from the Edit menu or context menu.
When you use “Auto-route Device” it will be connected in a logical way according to its current location in the rack.

• If you delete a device connected between two devices, the connection between the two remaining devices is 
preserved.
A typical example might be if you have an effect device connected between an instrument device and a Mix Chan-
nel device. If you delete the effect device, the instrument device will be re-routed directly to the Mix Channel de-
vice.

• When you move a device in the rack, the connections are not affected.

• When you duplicate devices by dragging and dropping, or using copy and paste, the devices are not auto-
routed.
If you would like them to be auto-routed, hold down [Shift] while performing the operation. 

! If you are duplicating a complete Device Group (see “Duplicating devices”), this will often include a Mix Chan-
nel. In this case, the Mix Channel will also be duplicated, with no need for further auto-routing.

Bypassing Auto-Routing

D If you wish to create a new device without any auto-routing taking place, press [Shift] when creating the de-
vice.
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Manual routing
To connect devices manually, you need to flip the rack around to see the back. This is done by pressing [Tab] or by 
selecting “Toggle Rack Front/Rear” from the Options menu. 

Note that routing cables can be done regardless of the “Reduce Cable Clutter” setting on the Options menu. This 
means that you can connect cables even though they are hidden (see “Cable appearance”).

On the back of each device you will find connectors of two different types: audio and CV (Control Voltage, used for 
controlling parameters - see “Using CV and Gate”). Audio inputs and outputs are shown as large quarter inch jacks, 
while CV input and output jacks are smaller. For now, we’ll stick to the audio connections.

Audio and CV connectors

q When the back of the rack is shown, you can still navigate in the rack by scrolling or by using the computer key-
board.

There are two ways to route signals from one device to another:

• By connecting virtual patch cables between inputs and outputs.

• By selecting connections from a pop-up menu.

Audio connectors

CV connectors
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Connecting cables
1. Click on the desired input or output jack on one of the devices, and drag the pointer away from the jack (with 

the mouse button pressed).
A loose cable appears.

2. Drag the cable to the jack on the other device.
When you move the cable end over a jack of the correct type (audio/CV, input/output) it will be highlighted to 
show that a connection is possible.

3. Release the mouse button.
The cable is connected. If both input and output are in stereo and you connect the left channels, a cable for the 
right channel is automatically added.

! Dragging a cable to make a connection can be aborted by pressing [Esc] while keeping the mouse button 
pressed.

D You can change an existing connection in the same way, by clicking on one end of the cable and dragging it to 
another connector.

Connecting cables using pop-up menus
1. Click and hold (or right-click (Win) or [Ctrl]-click (Mac)) on a connector.

A pop-up menu appears, listing all devices currently in the rack.

2. Move the pointer to the device you want to create a connection to.
A sub-menu appears, listing all suitable input/output connections. For example, if you clicked on an audio output 
on a device, the hierarchical sub-menus will list all audio inputs in all other devices.

• If a device is grayed out on the pop-up menu, there are no suitable connections on the device.

• An asterisk (*) next to the connector name on the sub-menu indicates that the connection is already occupied.
It’s possible, however, to select an occupied connection. Doing so will disconnect the existing connection and re-
place it.

3. Select the desired connector from the submenu.
The connection is created.
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Disconnecting cables
There are two ways of manually disconnecting cables:

D Click on one end of the cable, drag it away from the jack and drop it anywhere away from a jack.

D Click and hold (or right-click (Win) or [Ctrl]-click (Mac)) on a connector and select “Disconnect” from the pop-
up menu that appears.

Disconnecting devices
It’s also possible to disconnect all cables from selected devices in one go:

D Select the device(s) and then choose “Disconnect Device” from the Edit menu or device context menu.
All cables on the selected device(s) are now disconnected simultaneously.

Using CV and Gate
CV/Gate is used for modulating and triggering device parameters. Each separate Device chapter lists the available 
CV/Gate connections and the parameters that can be modulated or used for modulation outputs for that device.

Routing CV and Gate signals
There are not really any hard and fast “rules” applicable to CV/Gate routing. A few points should be mentioned, 
though:

• The specific “Sequencer Control” inputs present on the Subtractor and NN-XT devices are primarily intended 
for controlling these devices as (monophonic) instruments from the Matrix Pattern Sequencer.
If your intention is to use the Matrix CV/Gate outputs to create melodic patterns using these Instrument devices, 
you should use the Sequencer Control inputs. 

q The Matrix Pattern Sequencer can be used in many other ways, besides creating melodic patterns. For exam-
ple you could use it to modulate any CV controllable parameter, with the added advantage of the modulation 
being synchronized to the tempo.

• Conversely, if you would like to apply Gate or CV modulation to more than one voice, you should not use the 
Sequencer Control inputs, as these only function monophonically.

• Feel free to experiment: Use Gate signals to control parameter values and CV signals to trigger notes and en-
velopes, if you like.
See the chapter “Matrix Pattern Sequencer” for more tips about using CV.

q By routing CV to the rotary controls on a Combinator, you can CV control virtually any parameter on any device 
- see “CV Connections” in the Combinator chapter.

About CV Trim knobs
All CV inputs have an associated Trim knob. This is used to set the CV “sensitivity” for the associated parameter. The 
further clockwise a CV trim knob is set, the more pronounced the modulation effect.

• Turned fully clockwise, the modulation range will be 100% of the parameter range (0-127 for most parameters). 

• Turned fully anti-clockwise, no CV modulation will be applied.



Chapter 13
The Main Mixer
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About this chapter
This chapter describes the various procedures, parameters and functions in the Main Mixer as well as the relationship 
between mixer channels and Audio Track and Mix Channel devices in the rack. The chapter also covers how to set up 
and use Insert and Send effects, as well as some advanced routing tips and tricks.

Overview

The Main Mixer in Reason Essentials is a slimmed-down version of the high-end Main Mixer introduced in Propeller-
head Record - and now available in Reason Version 6. It provides the same outstanding sound quality as the Record 
and Reason 6 mixer but with fewer sections and parameters. You can have an unlimited number of channels, each 
with their own eq and insert FX. The Main Mixer also features the same legendary Master Bus Compressor as in the 
Record and Reason 6 mixer.

The Main Mixer can be viewed as a remote control for Audio Track and Mix Channel devices in the rack. This is where 
you control levels, make eq and effect settings etc., although the devices themselves “live” in the rack.
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The Audio Track, its device and mixer channel strip
Audio Tracks and their associated rack devices are for recording/playing back audio. 

When you create a new Audio Track, a corresponding Audio Track device is added to the rack as well as an Audio 
Track channel strip in the Main Mixer. 

The track, device and channel strip all belong together. If you delete the device, the corresponding track and channel 
strip are also deleted.

An Audio Track in the sequencer with its corresponding rack device and channel strip in the Main Mixer.

• Audio Track devices have no inputs on the back - audio inputs are fed directly from the associated sequencer 
track.
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The Mix Channel device and channel strip 
A Mix Channel device acts as a host to a source device (e.g. an instrument device). When you create an instrument, 
a Mix Channel device is automatically added to the rack together with a corresponding Mix Channel strip in the Main 
Mixer.

You can also create Mix Channels manually, from the Devices tab in the Tool Window, or from the Create menu. This 
is useful if you need to make manual mixer routings - see “Advanced routing tips and tricks” at the end of this chap-
ter.

The Mix Channel device has inputs to which the source (instrument) device is connected. The Mix Channel device 
and channel strip will automatically be assigned the name of the connected source device, but this can be changed - 
see “Naming mixer channels”.

Mix Channel devices will not automatically have a corresponding track in the sequencer created (but the connected 
source device will). Mix Channel tracks are created manually and used for automating channel strip parameters - see 
“Automating mixer parameters”.

A Mix Channel device (with an ID8 source device connected) and the corresponding channel strip in the Main Mixer.
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The Master Section device mixer strip
The Master Section device is always present and is fixed in the rack, just below the Reason Essentials Hardware In-
terface. This is where all your Audio Track and Mix channels are summed and mixed to stereo, and where you set up 
your Send effects and Master Insert effects. For descriptions of how to set up and use effects, see “Insert FX” and 
“Send FX”.

The corresponding Master Section mixer strip is also fixed and is always visible to the right in the Main Mixer.

The Master Section track is used for automating Master Section parameters - see “Automating mixer parameters”.

The Master Section device and mixer strip.
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Navigating in the Main Mixer

Viewing the Main Mixer area
There are several ways to bring the Main Mixer area into view:

• By dragging the rack divider to reveal the mixer area.

• By pressing [F5] on your keyboard or selecting “View Main Mixer” from the Windows menu.

• To view the mixer in a separate window, select “Detach Main Mixer Window” from the Windows menu or hold 
down [Ctrl](Win) or [Cmd](Mac) and press [F5].

Scrolling and navigating in the Main Mixer
The navigators allow you to scroll between channels in the Main Mixer or to focus on a specific channel strip area. 
The navigator areas can be shown/hidden using the “Show Navigators” Options menu item.

The Mixer Navigator and Channel Strip Navigator are the miniature mixer and channel strip areas at the top and far 
right of the Main Mixer window, respectively. The blue rectangles shown inside both areas act much in the same way 
as scrollbars in standard document windows. If you move the pointer inside the rectangle the pointer changes to a a 
hand, allowing you to click and scroll. You can also click anywhere in the Navigator areas to immediately get to the 
desired destination.

• The Mixer Navigator allows you to scroll between the existing channels in the mixer.
The miniature mixer fader section in the Mixer Navigator provides an overview of all channels in the mixer. Channel 
color and the selected channel are reflected in the navigator view. The Mixer Navigator will only show and scroll 
the regular channel strips - the Master Section is always visible and fixed to the right in the Main Mixer area.

• The Channel Strip Navigator area allows you to scroll between the various channel strip sections. 
All areas of the channel strips and Master Section can be scrolled, except the Channel Header section (the area 
below the faders) which is always visible at the bottom. If the Main Mixer is detached, the fader section is also al-
ways visible and stays at the bottom.

• Alternatively, you can use a mouse scroll wheel or a trackpad to scroll.

• The [left]/[right] arrow keys can be used to scroll between channels, and the [Page Up]/[Page Down] keys can 
be used to scroll vertically. The [Home] and [End] keys will scroll the mixer to the leftmost and rightmost chan-
nel strip, respectively.

Mixer Navigator

Channel Strip Navigator
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Switching between channels, rack devices and tracks
The RACK and SEQ buttons allow you to go to a channel’s rack device or sequencer track directly from the Main 
Mixer. Both buttons are located in the Channel Header section of the Main Mixer:

If you click the Rack button the following happens:

D For Audio Track channels, this will bring the Audio Track rack device into view.
The rack area will be shown (if hidden) with the channel device in view. 

D For Mix channels, this will bring the Source device (i.e. the instrument device connected to the channel) into 
view.
[Shift]-clicking the Rack button for a Mix channel will instead bring the Mix Channel device into view.

The SEQ button allows you to go to a channel’s sequencer track from the mixer. The SEQ button is also located in the 
Channel Header section. If you click the SEQ button the following happens:

D For Audio Track channels, this will bring the Audio Track into view.
The sequencer area will be shown (if hidden) with the track in view. 

D For Mix channels, this will bring the track for the Source device into view.
[Shift]-clicking the SEQ button for a Mix channel will instead bring the Mix Channel automation track into view. If 
there isn’t an automation track, one will automatically be created.

D If you have previously deleted Mix Channel tracks and/or Audio tracks in the sequencer, clicking the SEQ but-
tons on the corresponding channel strips in the mixer will automatically create new sequencer tracks.

To find the mixer channel for a specific track in the sequencer, or for a specific Mix Channel or Audio Track device in 
the rack, proceed as follows:
1. Select the track in the sequencer, or select the Mix Channel/Audio Track device in the rack.

2. Bring the mixer into view.
The channel will get Edit Focus (see “Channel Header section”) and be scrolled into view in the Main Mixer. If you 
have both the sequencer and Main Mixer in view, or the rack and Main Mixer, clicking a track in the Track List, or 
on a Mix Channel/Audio Track device in the rack, will flash the corresponding channel strip in the Main Mixer.
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Managing mixer channels

Creating and deleting channels
Mixer channel strips are automatically created when you create Audio Track and Mix Channel devices. In most situa-
tions, a Mix Channel device (with its channel strip) is also automatically created when you create an instrument de-
vice (see “Creating devices”).

To delete a channel, proceed as follows:

D Select the channel strip in the Main Mixer, or select its device in the rack, and select “Delete Channels and 
Tracks” from the Edit menu or context menu.
This will delete the channel strip, device and associated track. An alert appears asking you to confirm deletion.

If there are devices connected to the Mix Channel device you delete, and “Auto-group Devices and Tracks” is se-
lected on the Options menu, the alert will ask if you want to delete only the selected device, or all devices in the 
Device Group (see “About Device Groups” for more information).

Selecting channels
To select channels in the mixer you can use any of the following methods:

D Clicking anywhere on a channel strip (including parameters) will select the channel.
If you are not editing parameters but want to select a channel, the channel header is a good place to click. You 
could also click anywhere on the channel strip background (where there are no parameters or displays).

D If the Main Mixer has focus, you can use the [left]/[right] arrow keys to select channels.
The selection will move to the next adjacent channel (left or right) with each keystroke.

D It is possible to select several channels, by using standard [Shift], or [Ctrl](Win) or [Cmd](Mac) selection tech-
niques.
This allows you to e.g. move or delete several channels in one go. The last selected channel will be given edit focus 
which is indicated by a red strip in the channel header (see “Channel Header section”).

D To select all channels, use the “Select All Channels” item on the Edit menu or channel strip context menu.
The Main Mixer must have focus for this item to be available.

Moving channels
To move channels in the Main Mixer, simply select them and use standard drag and drop method. A red insertion line 
will show the insertion point, exactly like when moving devices in the rack or tracks in the sequencer.

Moving a channel. The thicker red line indicates where the moved channel will be inserted.
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Displaying channels, devices and tracks in the same order

Channel strips in the mixer, Audio Track and Mix Channel devices and tracks can be independently re-ordered. This 
allows you to set up the main work areas as you desire. 

Should you wish to display mixer channels, devices in the rack and sequencer tracks in the same order, proceed as 
follows:
1. Select the area where everything is in the order you want reflected in the other areas.

This could either be the Main Mixer, the sequencer or the rack.

2. Use the “Select All” Edit menu item.
This menu item would be “Select All Devices” if the rack is selected, or “Select All Channels” if the mixer is se-
lected. You could also select channels, tracks or devices manually.

3. Select the “Sort Selected Device Groups” Edit menu item.
Channels, devices and tracks will now all be presented in the same order as the area you selected in the first step.

Copying and duplicating channels

Cut, Copy and Paste functions

Selected channels can be moved or copied using the “Cut/Copy/Paste Channels and Tracks” functions on the Edit 
menu or channel strip context menu. This allows you to copy one or several channels from one Song document to an-
other. The following rules apply:

D Cut and Copy affects all selected channels, and behaves according to the standard procedures.
Cut moves the channels to the clipboard while Copy creates copies of the channels on the clipboard.

D If the “Auto-group Devices and Track” option is activated on the Options menu, this will copy the channel’s en-
tire Device Group, including tracks and clips - see “About Device Groups”.

D When pasting, channels will be added to the left in the Main Mixer.
If a channel is selected when pasting, the copied channel(s) will be inserted to the right of the selected channel.

Duplicating channels

D To make a duplicate copy of a mixer channel, with its settings and Insert FX (if any), hold down [Ctrl](Win) or 
[Option](Mac) and drag the channel to where you want it. 
Several selected channels can be duplicated. You can also select “Duplicate Channels and Tracks” functions on 
the Edit menu or mixer context menu.

D If the “Auto-group Devices and Track” option is activated on the Options menu, this will duplicate the chan-
nel’s entire Device Group, including tracks and clips - see “About Device Groups”.

Copy channel settings
If you wish to copy mixer channel settings from one channel to another you can use this function.
1. Select the channel you wish to copy settings from.

Copy channel settings only works when a single channel is selected. If several (or no) channels are selected the 
function is not available.
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2. Select “Copy Channel Settings” functions on the Edit menu or channel context menu.
On the submenu you can select to copy channel settings from a single section (EQ, Insert FX, or FX Sends), or 
“All”, which copies everything including any Insert FX devices with their settings.

3. To paste the settings, select the channel you wish to copy channel settings to, then select “Paste Channel Set-
tings” on the Edit menu or mixer context menu.
The type of settings you copied will be reflected in the paste menu item, e.g. “Paste Channel Settings: EQ” if you 
only copied the EQ section.

D The copied channel settings remain on the clipboard (until you cut or copy again) so you can paste them to 
other channels if you so wish.
This can only be done with one selected channel at a time - pasting channel settings is not possible if several 
channels are selected.

D Copying channel settings can also be done by selecting an Audio Track or Mix Channel device in the rack.
The procedure is the same. You can copy settings from a device to a mixer channel or vice versa.

Resetting channel settings
Resetting channel settings initializes all channel strip parameters to default values and removes any insert effects 
(see “Insert FX section”) from the channel.

D To initialize a mixer channel (or Mix Channel/Audio Track device), select “Reset All Channel Settings” from the 
Edit menu or channel/device context menu.
Channel settings reset is not possible if several channels are selected.

Naming mixer channels
New Audio Tracks will by default be named “Audio Track + number”. When creating an Instrument, the Mix channel 
will take its name from the connected Instrument device. 

D To enter a new name for a channel, double-click the name in the channel header.
A text field opens allowing you to enter a name for the channel. 

Channel names are reflected - and can be changed - in all areas; the Track List., the Main Mixer and in the device. 
Mix Channel source devices and tracks have independent names from the Mix Channel device/channel strip. By de-
fault, a Mix channel takes its name from its source device (typically, the instrument device connected to it). If you 
change the name of the source device, the Mix channel name will change too.

If you want the source device and Mix channel to have different names, change the name of the Mix channel. To re-
turn to the default state (and use the source device name for the Mix channel), just delete the Mix channel name.
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Coloring mixer channels
Track Color can be set for a mixer channel and is reflected in all areas; in the mixer, sequencer track list, new clips 
and Mix Channel/Audio Track devices. Tracks for Mix channel source devices have independent color and will not re-
flect the color set for the Mix channel or device. If you set Clip Color (see “Coloring clips”), this overrides the set Track 
Color. Any previously recorded clips will not reflect Track Color.

D To set Track Color, select a channel, then select “Track Color” from the Edit menu or the channel context menu 
and then select a color from the palette on the submenu.

In the Main Mixer, the Track Color is shown in the channel header and above the channel.

D You can also set Track Color from a selected track or Mix Channel/Audio Track device in the same way.
In case of Mix channel source device tracks, color is independent - only automation tracks for a Mix channel will 
reflect the Track Color.
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The channel strip
The channel strip is divided into sections. Mix Channel and Audio Track channel strips have identical parameters. 
Here is a detailed rundown of the parameters and functions of each section.

Input section

 

EQ section

This is a two-band EQ with high and low frequency shelving bands.

The parameters are as follows: 

| Parameter | Description

Gain This sets the input gain for the channel. Range is +/- 18 dB. 

INV (Invert Phase) This inverts the phase of the input signal to correct phase problems. For example, using multiple microphones during 
recording can sometimes cause phase-cancellation between microphones picking up the same sound source but at 
slightly different distances. Phase problems are most noticeable when signals are summed to mono. Out of phase sig-
nals are indicated by a lack of lower frequencies and a generally “hollow” sound quality. 

| Parameter | Description

EQ “ON” button Activates/deactivates the EQ.

HF Gain/Frequency The HF section provides high frequency shelving equalization. Frequencies above the set corner Frequency will be 
cut or boosted by the set HF Gain amount.
The HF Gain control can cut or boost the selected frequency range +/- 20dB and the HF Frequency can be set 
between 1.5kHz - 22kHz.

BELL mode When this button is activated, the HF EQ will switch to peaking characteristics. This means it works like a regular 
parametric EQ band, cutting or boosting the signal around the set frequency. Bell mode has a fixed bandwidth 
(Q value).

LF Gain/Frequency The LF section provides low frequency shelving equalization. All frequencies below the set Frequency will be cut 
or boosted by the set LF Gain amount.
The LF Gain control can cut or boost the selected frequency range +/- 20dB and the LF Frequency can be set 
between 40 Hz - 600 Hz.

BELL mode This works in the same way as described above, but affects the LF filter.
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Insert FX section

The channel strip Insert FX “slot” allows you to load a Combi patch, which in turn can contain any number of effects 
and other devices. Insert effect devices that belong to the patch are added to the Audio Track or Mix Channel device 
in the rack.

Insert effects process the whole channel signal, as opposed to Send effects where the effect balance is adjustable. 
Typical examples of when to use insert effects include compression, distortion and modulation effects such as cho-
rus.

D Loading Insert FX patches is done using the patch browser located in the Insert FX section. 
Insert effects patches in Combinator (.cmb) format can be loaded. 

• See “Insert FX” for descriptions of how to work with Insert effects.

• Creating your own Insert FX patches is done in the Combinator in the rack.

The Inserts section in the channel strip contains the following parameters:

FX Sends section

Send effects are global for all channels in the Main Mixer and are connected to the Master Section rack device. Up 
to 4 Send effects can be used simultaneously. For a description of how use Send effects, see “Send FX”.

The Send section contains the following parameters:

| Parameter | Description

Patch browser This is a standard patch browser for channel Insert FX where you can select/save patches in the Combinator Effect patch for-
mat. 

Edit This will bring the channel’s rack device into view with its Insert FX container opened, allowing you to edit the effect devices.

Bypass Bypasses the loaded Insert effect.

| Parameter | Description

FX Send On 1-4 Activates the Send for the channel. 

Level 1-4 The Send Level knobs control the amount of channel signal to be sent to the effect connected to the corresponding 
Send.

PRE button Send channel output is normally taken post channel fader, so that changing the channel's volume also changes the 
send level. By activating the PRE button, the send output is taken pre channel fader. In this mode, the send level is in-
dependent of the channel fader. 
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Fader section

The Fader section is used to control the channel level and stereo placement of a channel in the mix. The section has 
the following parameters:

About Level/Pan CV

On the back of a Mix Channel or Audio Track device you will find CV inputs for the channel Level and Pan controls. 
These allow for automatic level and pan control from sources that output CV signals.

| Parameter | Description

Pan L/R Use this control to set the left/right position of the channel in the stereo field. [Ctrl]-click (win) or [Cmd]-click 
(Mac) the Pan knob to reset to the default “0” (center position).

Width Width will only be available on stereo channels. It allows you to control the width of the stereo field for the channel. 
Normally this is fully on (value 127) which represents full stereo. By decreasing this value the stereo width is nar-
rowed. Turned fully off the channel output will be in mono.

MUTE/SOLO buttons Clicking a channel’s Mute button silences the output of that channel. Click the button again to unmute the chan-
nel.
Clicking a channel’s Solo button silences all other mixer channels, so that you only hear the soloed channel. Sev-
eral channels can be soloed at the same time, but if this is the case, note that soloed channels can’t be muted with 
the Mute button. To mute one of several channels in solo mode you simply “un-solo” it. There are also Mute/Solo 
All Off buttons in the Master Section - see “Master Section Header”.

Channel Fader The channel fader is used to control the output level of each channel.
By adjusting the faders, you can set the desired mix (balance) between channels.

Channel Meter The meter is a graphical representation of the channel output level. Stereo channels have dual level bars and 
mono channels one. If the signal level pushes the meter into the red, try lowering either the output level of the de-
vice connected to the channel device, or the channel fader itself, to avoid distortion. The meter is a VU meter, tak-
ing into account any VU offset set in the Big Meter of the Reason Essentials Hardware Interface - see “The Big 
Meter”.
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Channel Header section
The Channel Header is always visible at the bottom of the channel strip. It contains the following items:

The Edit Focus indicator - When you select a channel, the horizontal strip at the top of the Channel Header lights up 
orange to indicate edit focus. With several channels selected, the last selected channel will have edit focus. 

Edit Focus also reflects the last selected track or Mix device, which is useful when moving between work areas be-
cause the channel with Edit Focus will always be in view in the Main Mixer. For example, if you select an ID8 track in 
the sequencer, the Mix channel to which it is connected will be scrolled into view in the Mixer, and will be given Edit 
Focus.

The top strip is lit to indicate Edit Focus.

The Remote Base Channel indicator - To the left in the same horizontal strip area a small yellow arrow symbol can be 
shown. This is the Remote Base Channel indicator which shows which channel is considered the first or base chan-
nel when using Remote Control - see “Setting the Remote Base Channel”.

The Remote Base indicator.

The Rack and SEQ buttons allow you to switch to a channel’s rack device or sequencer track directly from the mixer 
- see “Switching between channels, rack devices and tracks”.

The Channel Header area reflects the selected Track Color (see “Coloring mixer channels”), and allows you to re-
name the channel by double-clicking on the name (see “Naming mixer channels”).
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The Master Section strip

The Master Section is where all your audio track and mix channels are mixed down to the Master Out bus. The Mas-
ter strip contains a compressor and a Master Insert section which both process the master bus, as well as send/re-
turn master level sections. Any processing applied to the master bus affects all channels in the mixer.
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Master Compressor section

The Master Compressor is perfect for providing the final “fairy dust” to your mix. It can add punch and cohesion, and 
generally make the mix sound bigger and more powerful. The compressor is very straightforward in operation and 
features make-up gain as well as program-adaptive Release.

The parameters are as follows:

| Parameter | Description | Range

On button Activates/deactivates the Master Compressor.

Meter The meter shows the amount of gain reduction in dB. 0dB - 20dB

Threshold This sets the level at which onset of compression occurs. The lower the Threshold, 
the more compression will be applied.

-30dB to 0dB

Ratio Ratio specifies the amount of gain reduction applied to signal levels above the set 
threshold. A 2:1 compression ratio effectively means that a signal level 2dB above 
threshold will have a signal gain of 1dB.

Fixed Ratios:
2:1 / 4:1 / 10:1

Attack This governs how quickly the Master Compressor will react when signals rise above 
the set threshold.

Fixed settings (in ms):
0.1 / 0.3 / 1 / 3 / 10 / 30 

Release When the signal level drops below the set threshold, this determines how long it 
takes before the compressor lets the sound through unaffected. 
If set to “Auto”, the Release time will be program adaptive, so if longer peaks occur 
the Release time is automatically increased.

Fixed settings (in s):
0.1 / 0.3 / 0.6 / 1.2 /Auto

Make-Up Make-Up gain compensates for level reduction caused by compression and helps 
maintain a steady output level.

-5dB to 15dB
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Master Inserts section

The Master Section Inserts is identical to the Insert FX section in the channel strips, except that it affects the master 
bus, i.e. the whole mix. You can load Combinator effect patches, which can include anything from a single device to a 
complex array of multiple devices to process the master bus.

The Master Inserts slot is ideally used to apply mastering effects for finalizing the mix. 

Devices that belong to the Insert effect patch are added to the Master Section device in the rack.

The Master Insert effects are placed after the Master Compressor in the signal path. This makes sense, as you usu-
ally add a Maximizer or Mastering Combi patch as a Master Insert effect, and this must be last in the signal path to 
avoid clipping on the output.

D Loading Insert FX patches is done using the patch browser located at the bottom of the Insert FX section. 
Insert effects in Combinator format can be loaded. 

• See “Insert FX” for descriptions of how to work with Insert effects.

The Inserts section in the Master Section contains the following parameters:

| Parameter | Description

Patch browser This is a standard patch browser for Master Insert FX where you can select/save patches in the Combinator Effect 
patch format. 

Edit This will bring the Master Section device into view in the rack, with its Insert FX container opened, allowing you to edit 
the effect devices.

Bypass Bypasses the loaded Master Insert effect.
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FX Return section

This section controls the master levels of the FX Returns. Send effect devices are connected to the Master Section 
via the 4 FX Send and 4 FX Return connectors on the back of the rack device. See “Send FX” for a description of 
Send FX.

The Send/Return connectors on the Master Section device.

The section contains the following items:

| Parameter | Description

Name label This automatically shows the name of the connected effect device. If you enter a new name for the label, this overrides 
the automatic naming. Deleting a manually entered name will bring back the automatic naming.

EDIT button This brings the connected effect device in the rack into view for easy editing of its parameters.

Mute (M) This mutes the return signal for the send effect.

Level Adjusts the FX Return master level. The master return levels are normally left at default 0dB. if you wish to increase/de-
crease the effect balance, this is best done by increasing/decreasing the send levels for the individual channels using 
the effect. You can, however, use the FX Return level to change the overall balance of a send effect in the mix.

Pan Pan adjusts the return signal stereo balance.

Meter Shows the signal level of the return bus.
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Master Fader section

The Master Fader controls the final output level of the mix to be recorded or exported to a file. It should normally be 
set to 0dB.

The section contains the following items:

Master Section Header

The Header is always visible at the bottom of the Master Section. It contains the following items:

| Parameter | Description

Master Fader Adjusts the level of the Master Out bus.

Meter Shows the level of the Master Out bus. 

Mode The Mode button switches the meter between VU/Peak/PPM modes - see “The Big Meter”.

Reset This resets the meter, deleting any registered peaks.

| Parameter | Description

SEQ / RACK
buttons

The Rack and SEQ buttons allow you to switch to the Master Section rack device or automation track directly from 
the mixer - see “Switching between channels, rack devices and tracks”.

Mute/Solo All Off This allows you to switch off all channel Mute or Solo buttons in one go. 

DIM -20dB This simply dims the Master Out level -20dB. Use this to temporarily lower the output level when answering the 
phone etc.
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Automating mixer parameters
Automating mixer parameters works in the same way as with other parameters. Automation is part of the audio track 
or Mix channel automation track. See “Recording parameter automation”.

D A quick way to automate a parameter is to right-click (Win) or [Ctrl]-click (Mac) on the parameter and select 
“Edit Automation” from the context menu.
This will create an automation lane (and track if needed) where you can record or draw automation. 

• When you select a sequencer track, the “Record Enable Parameter Automation” button is automatically en-
abled, allowing for parameter automation to be recorded. However, when recording automation for Audio 
Track channel strip parameters, you may want to disable the regular Record Enable button to avoid recording 
audio by mistake.

Working with effects

Insert FX
By definition, insert effects are inserted in the signal chain and process the whole channel signal, as opposed to Send 
effects (see “Send FX”) where the effect balance is adjustable. Typical insert effects are dynamics, distortion, chorus 
etc., plus mastering effects for the Master Section.

As mentioned earlier in this chapter, the channel strips and Master Section strip has a “slot” dedicated to insert ef-
fects - the Insert FX section. In the Insert FX section, you can choose to load Effect Combi patches using the stan-
dard Patch browser. However, it’s also possible to manually create effect devices and use as insert effects.

Adding Insert effects

To add an effect device as an insert effect, proceed as follows:
1. Select a channel strip in the Main Mixer, a Mix Channel or Audio Track device in the rack, or an audio track or 

Mix Channel track in the sequencer.

2. Select the desired effect device from the Create menu or from the context menu.
The effect device is created and automatically routed in the Insert FX container in the channel's rack device.

A Line 6 Guitar Amp device created as Insert FX in an Audio Track device
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3. If you need to re-route any connections, press [Tab] to flip the rack around.

The “To Device” and “From Device” connections in the Insert FX slot in the Audio Track device

! Note that the Mix Channel/Audio Track device must be unfolded to show the connections.

D If desired, re-route the connections according to the standard routing procedures (see “Manual routing”).
The signals always travel from the “To Devices” outputs, via the desired effect devices, to the “From Devices” in-
puts on the Mix Channel/Audio Track device.

• When the Show Insert FX button is on, you can add devices directly in the insert FX container area, dragging 
devices in or out etc. - just like with a Combinator (see “The Combinator”).

! Note that if you add, load or route insert effects in stereo, and the Mix Channel/Audio Track device (and chan-
nel strip) is in mono, the channel will automatically switch to stereo.

Loading Effect Combi patches

It’s possible to load Effect Combi patches directly into the Insert FX container of the channel. An Effect Combi patch 
loaded in the Insert FX container has the same functionality as a regular Combinator patch, with the following excep-
tions:

• Insert FX do not receive note and performance controller data (Pitch Bend, Mod Wheel etc.). 

• If you load a Combinator patch which has a backdrop image, it is not shown in the Insert FX section in the rack.

To load an Effect Combi patch in the Insert FX section of a channel strip, proceed as follows:
1. Click on the “Browse Insert FX” button.

The Patch browser opens.

2. Navigate to an Effect Combinator patch and select it.
Effect Combinator patches can be found in the All Effect Patches folder in the Factory Sound Bank.

3. Click “OK” to load the selected patch in the Insert FX section.
The Effect Combinator is loaded and patched in the Insert FX container in the channel's rack device, so you can 
hear the result of the effect immediately. The name of the patch is also shown in the display on the channel strip:
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Editing and saving Insert effects

Insert effects can be edited from their device panels in the Insert FX container in the channel’s rack device. You can 
also assign device parameters to the four buttons and knobs on the Insert FX Programmer panel.

Most of the Effect Combi patches already have a number of parameters assigned to the four buttons and knobs on 
the Insert FX Programmer panel. 

! Remember to click the “Show Programmer” button on the Audio Track/Mix Channel device in the rack to bring 
up the Effect Combi panel with its assignable knobs and buttons.

q These assigned parameters can be also be automated on a Mix Channel/Audio Track in the sequencer.

To edit effect device parameters that are not assigned to the four knobs and buttons on the Insert FX Programmer 
panel, you have to access the device(s) in the rack.
1. Click the “Edit Inserts” button to get to the channel’s Insert FX container in the rack.

The channel’s Insert FX container is scrolled into view, and unfolded, in the rack.

D Now, you can edit the effect device(s) parameters, just like for any other devices in the rack.

D To edit the parameter assignments on the Insert FX Programmer panel, click the “Show Programmer” button 
on the Mix Channel/Audio Track device.

The parameter assignments to the Insert FX Programmer panel in the rack are made in the same way as when 
creating/editing regular Combinator devices (see “The Combinator”).

2. If you like, you can choose to save your effect device setup in the Insert FX container (with any parameter as-
signments) as an Effect Combi patch by clicking the “Save Insert FX Patch” button on the Programmer panel.

This will bring up the Patch browser, where you can select name and location for your Effect Combi patch.
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! You don’t have to save your insert effect as an Effect Combi patch if you don’t want to. All parameter settings 
are automatically stored in the song when you save the Song document.

Bypassing Insert effects

D Click the “Bypass” button at the bottom of the Insert FX section on the channel strip - or on the device in the 
rack - to bypass the insert effects for the channel.

The “Bypass” buttons on the channel strip and on the device

Deleting Insert effects

Deletion of insert effects can be done either in the rack or with a mixer channel selected in the Main Mixer:
1. Select a Mix Channel or Audio Track device in the rack or a mixer channel in the Main Mixer.

2. Select “Clear Insert FX” from the Edit menu or context menu.
This will disconnect and delete all Insert FX devices of the selected channel.

Another way of deleting Insert FX is by manually removing them from the Insert FX container in the Mix Channel or 
Audio Track device in the rack:
1. Unfold the Mix Channel/Audio Track device and click the “Show Insert FX” button.

2. Select the device(s) you want to remove in the Insert FX container.

3. Press [Backspace] or [Delete] - or select “Delete Devices and Tracks” from the Edit or context menu.
An alert appears asking you to confirm the deletion. (See “Deleting devices” for more details).

Copying and Pasting Insert effects between mixer channels

To copy an insert effect from one mixer channel and paste to another mixer channel, proceed as follows:
1. Select the mixer channel which contains the Insert effect you want to copy.

2. Select “Copy Channel Settings” from the Edit or context menu and then select “Insert FX” from the sub-menu.
If you select the Master Section, the “Copy Insert FX” item will appear directly on the Edit menu or context menu.

3. Select the mixer channel to which you want to paste the Insert effects and choose “Paste Channel Settings: In-
sert FX” from the Edit menu or context menu.
If you select the Master Section, the “Paste Insert FX” item will appear directly on the Edit menu or context menu.
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Send FX
Send effects are routed in parallel with the signal chain, and the effect balance can be adjusted - as opposed to In-
sert effects, which are inserted in the signal chain and process the whole channel signal (see “Insert FX”). Typical 
Send effects are, for example, reverbs and delays.

The Main Mixer can hold up to four separate Send effects per Song. These four Send effects can be used simulta-
neously by all mixer channels in the Song - at individually adjustable levels per mixer channel. In the FX Return sec-
tion in the Master Section strip in the mixer, you can control the FX Return levels from all Send FX busses, as well as 
panning for each of the Send effects. 

Each mixer channel features a Send FX section, where you can control the levels to each of the (up to four) Send ef-
fects for the specific mixer channel.

Creating Send effects

Send effects can be added in the following ways:
1. Select a channel strip, or the Master Section strip, in the Main Mixer.

2. Select “Create Send FX” from the context menu.
A sub-menu appears, from which you could choose to create an Effect Combi patch or a desired effect device:

D Select “Create Effect...” from the sub-menu to open the Patch browser.
In the Patch browser, you can select an Effect Combi to add as a Send effect. The Combinator is created and au-
tomatically routed as a Send effect to the first available Send FX connectors on the Master Section device.

D Select an effect device from the sub-menu to add a single effect device as a Send effect.
The effect device is created and automatically routed as a Send effect to the first available Send FX connectors on 
the Master Section device.

! If all four Send effect busses are used, the “Create Send FX” item on the context menu will be grayed out.

Master Section
FX Return section

Mixer Channel
FX Send sections

Send FX 1
(RV7000 1)
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• The name of the added Send effects are shown in the FX Return displays in the Master Section strip:

The names of three added Send effects are displayed in the Master Section strip

3. If you need to re-route any connections, press [Tab] to flip the rack around.

The Send FX connections on the Master Section device

! Note that the Master Section device must be unfolded to show the connections.

As you can see, all Send effects are placed outside the Master Section device - as opposed to Insert effects, which 
are placed in the Insert FX container of the Master Section device.

Another way of creating a Send effects is this:
1. Select the Master Section device in the rack and choose “Create” from the Edit menu or context menu.

A sub-menu appears where you can choose to create an Effect Combi patch or a single effect device:

D Select “Create Effect...” from the sub-menu to open the Patch browser.
In the Patch browser, you can select an Effect Combi to add as a Send effect. The Combinator is created and au-
tomatically routed as a Send effect to the first available Send FX connectors on the Master Section device.

D Select an effect device from the sub-menu to add a single effect device as a Send effect.
The effect device is created and automatically routed as a Send effect to the first available Send FX connectors on 
the Master Section device.

• It’s also possible to manually connect devices to the FX Send and FX Return connectors according to the stan-
dard routing procedures (see “Manual routing”).
The signals always travel from the “FX Send” outputs, via the desired effect device(s), to the “FX Return” inputs on 
the Master Section device.
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Editing and saving Send effects

D Click the “Edit” buttons in the FX Return section to get to the corresponding Send effect device(s) in the rack.

The Edit buttons for the Send effects in the FX Return section

The corresponding Send effect devices are scrolled into view in the rack.

• Send effects can be edited from their device panels according to standard editing procedures. 
Any edits you make will be automatically stored when you save the Song document. If you edit Effect Combi 
patches, these can also be saved separately as Combinator patches as usual.

Muting Send effects

D Click the “M” buttons in the FX Return section to mute the FX Return for the corresponding Send effect.
All channels that currently use the muted send effect will be affected.

The Mute buttons for the Send effects in the FX Return section

! The Mute buttons only mute the FX Return signals. If you route an FX Send output of the Master Section de-
vice to an effect, and then route the effect to a regular Mix Channel instead of an FX Return input, the Mute 
button won't do anything.

Deleting Send effects

Deletion of Send effects is done in the rack according to the standard device deletion procedures:

D Select the device(s) you want to delete and press [Backspace] or [Delete] - or select “Delete Devices and 
Tracks” from the Edit or context menu.
An alert appears asking you to confirm the deletion. (See “Deleting devices” for more details). 

• When a Send effect has been deleted, the name will automatically be removed from the displays in the FX Re-
turn section in the Master Section strip.
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Remote controlling the Main Mixer
There are two ways of Remote controlling the Main Mixer: one channel at a time, for detailed control of the parame-
ters of one mixer channel at a time, or multiple channels simultaneously, for balancing levels etc.

Remote controlling a single mixer channel
You can control a single mixer channel, either by locking your control surface to the mixer channel, or by setting Mas-
ter Keyboard Input to the mixer channel’s track in the sequencer.

For example, if you set Master Keyboard Input to the audio track you’re recording on, you will be able to adjust the 
monitor level and other parameters of the channels you're using when recording.

The extensive Remote control functionality in Reason Essentials allows for detailed control of the parameters of one 
mixer channel at a time.

Remote controlling multiple mixer channels
The typical way of remote controlling the Main Mixer is to control the Master Section (by setting Master Keyboard In-
put to the Master Section track in the track list, or typically by locking your control surface). This lets you control the 
Master Section parameters plus mixer parameters for a number of channels (often 8 channels at a time, depending 
on the control surface). To define what channels to remote control at a given time, you need to set the “Remote Base 
Channel”.

Setting the Remote Base Channel

The first (leftmost) mixer channel controlled by Remote is called the "Remote Base Channel". The current Remote 
Base Channel is indicated by a yellow arrow symbol in the mixer channel strip Header section:

The Remote Base Channel indicator.

To change the Remote Base Channel, proceed as follows:

D Select a mixer channel and select “Set Remote Base Channel” from the Edit menu or context menu.
The Remote Base Channel indicator will move to the selected mixer channel.

D Alternatively, change Remote Base Channel via Remote (in steps of 1 or 8 channels).
Functions for changing the Remote Base Channel may already be mapped to buttons on your control surface - 
see the “Control Surface Details” pdf document. If not, you can set this up manually in the Additional Remote Over-
rides dialog on the Options menu - see “Additional Remote Overrides...”.
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Remote controlling multiple mixer channels - an example

If you want to remote control several channel strips at once from your control surface, you can proceed as follows:

D Select the Master Section device in the rack or the Master Section Strip in the Main Mixer.
If you want to lock your control surface to the Master Section, select “Lock Xxxxx to This Device” from the Edit 
menu or context menu. (“Xxxxx” represents the name of your connected control surface.) This way, you can ensure 
that your control surface will always control the Main Mixer, regardless of where the edit focus is.

Selecting and locking the Master Section to the connected control surface

Depending on your connected control surface, it may now be possible to control parameters of several channel strips 
at the same time. In this example, we’re using a control surface which has nine sliders. These sliders are configured 
to control one channel strip Level Fader each, plus the Master Section Level Fader.

In the picture below, the Remote Base Channel is currently set to Audio Track 1. This means we can control the Level 
Faders of Audio Track 1 through Audio Track 8, plus the Master Section Level Fader, with the nine sliders on the 
control surface:

Controlling Audio Track 1 through Audio Track 8 and Master Section from the connected control surface

Remote
Base
Channel

Remote controlled channels
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On our control surface it’s possible to select next and previous Remote Base Channel in steps of 8 channels. If we 
click the “Next” button on our control surface, the Remote Base Channel is set to Audio Track 9 and we can now 
control Audio Track 9 through Audio Track 12, plus the Master Section:

Controlling Audio Track 9 through Audio Track 12 and Master Section from the connected control surface

If your control surface doesn’t have buttons already assigned for controlling Remote Base Channel selection, you can 
manually assign controllers for this by using the Remote Override function described in “Remote Override mapping”. 
Alternatively, select a channel strip and select “Set Remote Base Channel” from the Edit menu or context menu.

See “Remote - Playing and Controlling Devices” for more details about remote controlling Reason Essentials. See 
also the “Control Surface Details” pdf document for information about parameter assignments on various common 
control surfaces.

Remote Base Channel Remote controlled channels
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Advanced routing tips and tricks

Chaining Send effects from Redrum or Mixer devices
The Redrum Drum Module and the Mixer 14:2 and 6:2 devices have separate Send FX connectors where you can 
add send effects individually for each device. The Redrum and Mixer devices also have separate Send FX level pots 
for each drum/mixer channel so that you could set the send effect levels individually for each drum/mixer channel in 
the device.

Let’s say you want to add a Redrum device and use two of the Main Mixer’s Send FX, but with individual settings for 
each of the Redrum device’s internal channels. In the example below, we’re going to chain the two Send Outs from 
the Redrum device to two send effects in the Main Mixer:
1. Create two extra Mix Channel devices - one for each of the send effects we’re going to chain.

In this example we name the Mix Channel devices “FX 1 Chaining” and FX 2 Chaining”.

2. Activate the Send FX bus you want to use in each of the mixer channels and also activate the corresponding 
Pre-fader button.
In this example, we activate the Send FX 1 bus on the FX1 Chaining channel and the Send FX 2 bus on the FX 2 
Chaining channel. The Send FX 1 has a reverb connected and the Send FX 2 has a delay connected. The Pre-
fader buttons should be activated because we don’t want the mixer channel faders to affect the Send levels.

3. Lower the “FX 1 Chaining” and “FX 2 Chaining” mixer channel faders to zero.
This way, the effect signals won’t be mixed with the rest of the Main Mixer channel signals in the mix bus, but are 
kept isolated in the Send FX busses. Now, our setup should look like this in the rack and in the Main Mixer:

The device setup, plus two new Mix Channel devices added. To the right, the channel strips with activated FX Send busses.
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4. Connect the Send Out 1 and 2 of the Redrum device to the Left inputs of each of the “FX 1 Chaining” and “FX 
2 Chaining” Mix Channel devices.
Now, you should have a setup that looks something like this:

The Redrum Effect Sends chained to one Send FX bus each of the Master Section, via two new Mix Channel devices

5. Set individual Send levels for each of Redrum’s internal channels.

Now, you have individual send levels for each of the Redrum device’s internal channels - and are still able to use 
the Send FXs in the rest of the Main Mixer channels like before.
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Splitting signals using the Insert FX Out
It’s possible to tap the signals from the Insert FX "To Devices" outputs of the Mix Channel/Audio Track device, with-
out breaking the internal signal chain of the channel. This feature can be used if you want to apply “parallel” signal 
processing in an additional Mix Channel, for example.

Splitting a dry signal to an additional Mix Channel for parallel processing

The first example below shows an Audio Track with an electric bass. The Insert FX “To Device” signal of the Audio 
Track device is tapped to an additional Mix Channel which has a Scream 4 device as Insert FX. By adjusting the Level 
of the Bass Dist channel in the Main Mixer, you can gradually introduce the distortion effect, in parallel with the un-
processed bass sound of the audio track.

! Tapping an Insert FX signal like this only works if both Insert FX “From Device” connectors are unused!

Tapping the signal from the Insert FX “To Device” of an Audio Track device to an additional Mix Channel device 
for parallel signal processing
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Splitting an Insert FX signal to an additional Mix Channel for parallel processing

If you are already using an Insert FX in the Audio track device, you can still tap the signal to another Mix Channel de-
vice for parallel signal processing by using a Spider Audio Merger and Splitter device as shown in the picture below:

Tapping the signal from the Insert FX chain of an Audio Track device to an additional Mix Channel device, 
via a Spider Audio Merger and Splitter device

By adjusting the Level of the Bass Dist channel in the Main Mixer, you can gradually introduce the distortion effect, 
in parallel with the internally processed bass sound of the audio track. This way, you now have two parallel Insert FX 
signal chains for the audio track, where the tapped signal is adjustable.

Using the Mix Channel and Audio Track devices’ Direct Outs
The Mix Channel and Audio Track devices feature Direct Out connectors. By patching cables into these outputs, you 
break the internal signal chain from the device to the Master Section, and can route the channel output signals di-
rectly to the Reason Essentials Hardware Interface’s outputs. This is a very nice feature if you want to use outboard 
mixing or summing - or if you’re using ReWire (see “ReWire”) to route individual channel signals to another applica-
tion.

You could also patch cables from the Direct Outs to a Mixer device to create a sub-mixer, for example (see “Creating 
a sub-mixer”).
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The example below shows how to route the Direct Outs of a number of Audio Track devices to separate outputs of 
the Reason Essentials Hardware Interface:

Direct routing of individual channel outputs to individual outputs on the Reason Essentials Hardware Interface

! Using the Direct Outs will break the internal P-LAN routing to the Master Section device!

Creating an input channel for recording with effects
When you record on an audio track, the input signal is routed “dry” to the audio track. Then, when you play back the 
recorded audio, the signal goes via the channel strip, with all its settings and any Insert FX etc. However, there might 
be situations where you want to record a processed signal to the audio track. For example, if you record an electric 
guitar, you might want to record it with distortion effects or similar.

The example below shows a typical setup where a separate Mix Channel device is used for processing the input sig-
nal before it’s routed to the audio track for recording:
1. Begin by creating an Audio Track device and a separate Mix Channel device.

The Mix Channel device is going to be used for housing the effects we’re going to record with.

2. Create the effect(s) you want to use and patch them as Insert FX in the Mix Channel device.
In this example, we use a Line 6 Guitar Amp and an RV7000 reverb device connected in series.
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3. Connect one of the Audio Ins of the Reason Essentials Hardware Interface to the “Input L” of the Mix Channel 
device.
This manual patching from the Hardware Interface is made to route the input signal directly to the Mix Channel de-
vice, where we have our effects.

Direct routing of an Input signal from the Reason Essentials Hardware Interface to the Mix Channel device

4. Flip the rack around to view the front.

5. Click the “Rec Source” button on the Mix Channel device.
This makes the Mix Channel device selectable as input source for the Audio Track device.

Rec Source enabled on the Mix Channel device
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6. Finally, select the Mix Channel device as Input on the Audio Track.
This will route the signal from the Mix Channel device’s output directly to the input of the Audio Track.

The Mix Channel device selected as audio input on the Audio Track

Now, you can begin recording on the Audio Track according to the standard recording procedures described in 
“General recording procedure”. The signal will be processed by the Insert FX of the Mix Channel device before be-
ing recorded on the track.

With this setup, you will always hear the sound of the input processed through the Amp device - just as if you had 
a real hardware amp turned on and mic'd in the studio. If you don't want the "Lead Gtr Rec Input" Mix channel to 
be heard, just mute it in the Main Mixer.

Creating a sub-mixer
By using the Direct Outs of the Audio Track and Mix Channel devices and routing the signals to a Mixer device you 
can create a sub-mixer. A sub-mixer can be very useful for pre-mixing multi-mic’ed drums, or a horn section, for ex-
ample.
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The example below shows a number of Mix Channel devices to which various drum sounds have been routed from 
separate devices within a Combinator device. Each of the Mix Channel devices’ Direct Outs have then been manually 
routed to a Mixer 14:2 device, which is used as a sub-mixer in this setup. The sub-mixer is routed to a Mix Channel 
device for connection to the Main Mixer:

Direct routing of individual Mix Channel outputs to individual inputs on a Mixer 14:2 device for sub-mixing
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You can also use a sub-mixer configuration for routing several external input signals (from separate microphones, for 
example) for recording on an audio track.

The example below shows a sub-mixer configuration similar to the previous example, but with four separate micro-
phones connected to one input each on the audio interface and then routed from the Reason Essentials Hardware 
Interface to Inputs on four Mix Channel devices. The Mix Channel devices’ Direct Outs are then routed to a Mixer 
14:2 device, just as in the previous example:

Direct routing of individual Audio Inputs to Mix Channels with their Direct Outs routed for sub-mixing

D To record the mixed signals from the “Drums Submix” Mix Channel on Audio Track 1, click the Rec Source but-
ton on the “Drums Submix” Mix Channel device, and then select “Drums Submix” as Input source on the “Au-
dio Track 1” in the sequencer Track List. See “Recording audio from Mix Channel outputs” for more details.

q In the sub-mixer setups above, the Mix Channels could also house individual Insert FX. See “Creating an input 
channel for recording with effects” for tips on how to record with FX.
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Chapter 14
Song File Handling
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About this chapter
This chapter describes how to open, create and save songs in various ways. It also describes how to save a song as 
a Template and how to import and export songs as Standard MIDI files.

Opening Songs

Opening a Reason Essentials Song
! To be able to open a Reason Essentials Song (or Reason Limited Song) you need to run Reason Essentials in 

Authorized mode. If you’re using Reason Essentials in Demo Mode (unauthorized), the “Open” item on the File 
menu is removed and replaced by “Open Demo Song”. This allows you to open only the factory made Reason 
Essentials Demo Songs (see “Opening a Reason Essentials Demo Song”). See “Running Reason Essentials 
with the Ignition Key hardware” and “Running Reason Essentials with Internet Verification” for details on how 
to authorize Reason Essentials.

To open a Reason Essentials Song:
1. Hold down [Ctrl](Win) or [Cmd](Mac) and press [O], or select “Open” from the File menu.

The Reason Essentials Song Browser window appears.

2. Use the browser to navigate to the desired folder on disk or within a ReFill.
See “Using the Browser” in the “Sounds and Patches” chapter.

3. When you have located the Reason Essentials (.ree) Song, select it and click “Open” (or double click the file).
The song opens in a new document window.

q You can have several Songs open at the same time if you like. This allows you to copy and paste patterns, clips 
and patches between songs. However, all open songs consume some memory and processing power, so you 
might want to close songs you don’t need for the moment.

q It’s possible to have Reason Essentials open the last song you worked on as soon as you launch the program. 
See “Opening the last Song at program launch” for more information.

If the “Missing Sounds” dialog appears

If the song includes samples or REX files, and these have been moved or renamed since the song was saved, the 
program will inform you that it cannot find all files. You can then choose to either manually locate the missing files, to 
have the program search for them or to proceed without the missing sounds. For details, see “Handling Missing 
Sounds” in the “Sounds and Patches” chapter.

Opening a Reason Essentials Demo Song
Reason Essentials Demo Songs are factory made songs that demonstrate how Reason Essentials can be used for 
recording various musical projects. If you run Reason Essentials in “Demo Mode” (unauthorized), you will still be able 
to open Demo Songs, even though the regular “Open” function is disabled. If you run Reason Essentials in authorized 
mode, you can open Reason Essentials Demo Songs just like regular Reason Essentials Songs.

D Select “Open Demo Song” from the File menu and select a Demo Song from the sub-menu.
You could also select “Download more Demo Songs” from the sub-menu. This will open your default Internet 
browser and direct you to the Reason Essentials Demo Songs page on the Propellerhead web site. On this page 
you can download additional Reason Essentials Demo Songs to your computer. You will then have to use the 
“Open Demo Song” command from the File menu to open the downloaded Demo Songs.

q You can also download more Reason Essentials Demo Songs by selecting “Download more Demo Songs” 
from the Help menu.
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q You can have several Demo Songs open at the same time if you like. This allows you to copy and paste pat-
terns, clips and patches between songs. However, all open songs consume some memory and processing 
power, so you might want to close songs you don’t need for the moment.

Opening the last Song at program launch
It’s possible to instruct the program to automatically open the last Song you worked on each time you launch Reason 
Essentials. You select this on the “General” tab in the “Preferences” dialog.
1. Select “Preferences” from the Edit menu (Win) or “Reason Essentials” menu (Mac) and then click the “Gen-

eral” tab.

2. Tick the “Load Last Song On Startup” checkbox.
When you launch Reason Essentials the next time, the last saved Song will automatically open in a document win-
dow.

Closing Songs

Closing a Song
D To close a Song, hold down [Ctrl](Win) or [Cmd](Mac) and press [W], or select “Close” from the File menu. Al-

ternatively, click the close button in the upper corner of the Song document window.
If you have unsaved changes, you will be asked if you want to save the song before closing.

! Note that when you’re closing the last open Song document in the Windows version of Reason Essentials, the 
application will quit.

Creating Songs

Creating a new empty Song
D To create a new song, hold down [Ctrl](Win) or [Cmd](Mac) and press [N], or select “New” from the File menu.

A new Song document window appears. By default, the new Song contains the following:

• The Reason Essentials Hardware Interface.

• The Main Mixer Master Section with its Master Section device in the Rack.
The Master Section device’s Master Out L & R are connected to the Reason Essentials Hardware Interface’s Au-
dio Out 1 & 2.

• The Transport Track at the top of the Sequencer.

q Instead of creating an empty song each time you select “New”, it’s possible to automatically load an existing 
song to use as template for your new songs. For example, if you want to start with your own unique selection 
of devices, you can create and save a song and then instruct Reason Essentials to use this song each time you 
create a new song. See “Setting up the Default Song”.

q An alternative to creating a new song is to use the “Create New from Template” command to open one of the 
factory made Template Songs. See “Creating a new Song from a template”.
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Setting up the Default Song
It’s possible to specify a certain Song document which will automatically open as a “template” each time you select 
“New” from the File menu. The Default Song could be any Song you have created earlier, or a factory made Template 
Song. You can select this Default Song on the “General” tab in the “Preferences” dialog.
1. Select “Preferences” from the Edit menu (Win) or “Reason Essentials” menu (Mac) and then click the “Gen-

eral” tab.

2. Click the “Template” radio button in the “Default Song” section.

3. Click the folder icon to the right and select the Song you want to use as a template when creating new Songs.
Each time you create a new Song (by selecting “New” from the File menu), the selected Song will be loaded and 
used as a template for your new Song. On Windows platforms, the Song document will be named “Document n” 
where “n” is an incremental number. On Mac OS X platforms, the document will be named “untitled n” where “n” is 
an incremental number. You can then save your Song with a new name.

! Make sure the “Load last song on startup” checkbox is not ticked, otherwise the last song will be opened in-
stead of the Template song!

Creating a new Song from a template
D To create a new song from a Template, select “New from Template” from the File menu and then select one of 

the Template Songs that appear in the sub-menu.
The selected Template Song appears in a new document window. On Windows platforms, the document will be 
named “Document n” where “n” is an incremental number. On Mac OS X platforms, the document will be named 
“untitled n” where “n” is an incremental number. You can then save your Song with a new name.

q You could also create your own Template Songs and make them appear in the sub-menu. See “Making a Song 
appear as a Template Song”.

q You can also download more Reason Essentials Template Songs by selecting “Download more Template 
Songs” from the Help menu.

Saving Songs

Saving a Song
You will always be able to save your Songs in Reason Essentials. It doesn’t matter if you’re running in authorized or 
unauthorized (Demo) mode.

The “Save” function

To save a Song, proceed as follows:
1. Hold down [Ctrl](Win) or [Cmd](Mac) and press [S], or select “Save” from the File menu.

If this is the first time you’re saving the song, a file dialog will appear where you can specify a name and destina-
tion.
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2. Specify a name and destination for the Song and click “Save”.
Once you have saved a song, selecting “Save” will simply save it under the same name and in the same location, 
without showing a dialog.

q It’s also possible to automatically include all samples used by the Reason Essentials devices and make the 
Song “self-contained”. Refer to “About Self-Contained Songs” for details about how to include samples in 
your songs.

q To reduce the file size of your song, you can use the “Save and Optimize” command described in “Saving and 
optimizing a Song”.

q It’s also possible to include detailed information about your song. Refer to “Including Song Information”for 
more details.

The “Save As...” function

To save an existing Song under another name and/or in another location:
1. Hold down [Ctrl]+[Shift](Win) or [Cmd]+[Shift](Mac) and press [S], or select “Save As...” from the File menu.

The “Save As” dialog appears.

2. Specify a new name and/or new destination for the Song and click “Save”.

q Using the “Save As...” function will automatically optimize the Song (see “Saving and optimizing a Song”).

Saving and optimizing a Song
When you record audio in the Sequencer, the recordings are stored in your Song document. If you remove recordings 
in your song, there might be “empty” areas left in the document, similar to a fragmented hard disk. To “defragment” 
the Song document, and thus reduce the file size, you can use the “Save and Optimize” command on the File menu. 
Note that the “Save and Optimize” command can only be used on previously saved Song documents.

D Select “Save and Optimize” from the File menu.
The Song will be optimized and saved at the original location.

! Note that saving and optimizing a Song could take some time if you have lots of audio recordings in it. There-
fore, the best alternative would probably be to use the “Save” command while you’re still working with your 
Song, and then use the “Save and Optimize” command as a final step when you’ve finished editing.

q Using the “Save As...” function also automatically optimizes the Song.

q In some situations, it’s possible to reduce the file size even further by deleting recordings you haven’t used in 
your Song. See “Delete Unused Recordings”.



SONG FILE HANDLING356

Including Song Information
Selecting “Song Information” on the File menu opens a dialog in which you can add information about your song. For 
example, if you plan to send the song to other Reason Essentials users, this dialog allows you to add contact infor-
mation, comments about the song, etc.

D Select “Song Information...” from the File menu.
The Song Information dialog opens.

The Song Information dialog contains the following items:

• Text in Window Title:
The text you add here will be displayed directly after the file name in the song window’s title bar.

• More Information:
This is where you could add notes and comments about your song.

• Song Splash:
This allows you to add a picture to the song. The picture will be displayed when the song is opened.

D To add a splash picture, click the folder button at the upper right corner, locate and open the picture file in the 
file dialog that appears.

! Splash pictures must be JPEG files (Windows extension “.jpg”) with a size of 256 x 256 pixels.

D To remove the splash picture from the song, click the “cross” button at the upper right corner.

D Tick the “Show Splash on Song Open” check box to make the splash appear every time the song is opened.

• Author’s Web Page:
Here, you can type in your web site URL. When a user opens your song, he/she can go directly to your web site 
by clicking the Browse button that appears in the splash (provided there’s an Internet connection available).

• Author’s E-mail Address:
Here, you can specify your e-mail address if you want other Reason Essentials users to e-mail you their comments, 
etc.
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About Self-Contained Songs
The Song is the main file format in Reason Essentials. A Song contains the device setup and all settings and connec-
tions in the Rack, all Main Mixer Channel settings as well as everything you have recorded in the Sequencer. How-
ever, this is not always sufficient. If you want to open your song on another computer, or send it to another Reason 
Essentials user, you will also need to include all samples and REX files used by the devices in the Song. To make this 
easier, Reason Essentials allows you to create “self-contained” songs. A self-contained song contains not only the 
references to the used samples and REX files, but also the files themselves. You can choose exactly what files 
should be included in the self-contained song.

q An alternative to self-containing samples and/or REX files could be to bounce Mixer Channels to Audio 
Tracks. This way, you could “convert” samples to audio so that your song would always sound the same, no 
matter on which computer you play it back. See “Bouncing Mixer Channels” for details.

To specify which files should be included in the self-contained song, proceed as follows:
1. Select “Song Self-Contain Settings...” from the File menu.

The “Song Self-Contain Settings” dialog appears, listing all samples and REX files used in the song:

2. Tick the checkboxes to the left of the “Name” column for the files you want to contain in the song.

D You can use the “Check All” button to tick all checkboxes in one go.
Similarly, the “Uncheck All” button unchecks all checkboxes.

3. When you have marked the desired sounds, click “OK” to exit the dialog.
The next time you save your Song, the specified sounds will be automatically included in the Song file.

! Note that a self-contained song file will be larger than the original song file. However, samples included in a 
self-contained song are automatically compressed by approximately 50% of their original size. Since the com-
pression is lossless, this does not in any way affect the sound quality.
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“Un-self-containing” a Song

If you have opened a self-contained song which contains one or several sounds embedded in the song file, you may 
want to extract these sounds and make the song refer to them on disk as usual. This is done as follows:
1. Select “Song Self-Contain Settings...” from the File menu.

The “Song Self-Contain Settings” dialog appears.

2. Locate the sounds you want to extract from the song file, and deactivate their checkboxes (or click the “Un-
check All” button).

3. Click “OK” to close the dialog.
Now, Reason Essentials will check for each “extracted” sound file whether it is available (at its original, stored lo-
cation) or not.

• If the program finds the sound file at the location stored in the song, it is simply removed from the song file, 
and the original file reference path is used.
This would be the case if you made the song self-contained yourself, and un-self-contain it on your own computer 
(provided that you haven’t removed the original sound files from disk since you made the song self-contained).

• If the program doesn’t find the sound file, a file dialog appears, allowing you to select a folder and name for 
the sound file.
The extracted file will be saved in the specified folder, and the path in the song will be adjusted. This would be the 
case if you were given the self-contained song by another user, for example.

! Note that it is not possible to un-self-contain samples that originate from ReFills!

! If you un-self-contain samples that were modified in the Edit Sample Window and feature Start and End Mark-
ers and/or loop crossfades, the Lossy Sample Export dialog appears. The available options are described fur-
ther down in the “Exporting samples” section in the Sampling chapter. Note that the option you select in the 
Lossy Sample Export applies to all samples you have deselected in the Song Self-contain Settings dialog! 

Making a Song appear as a Template Song
If you want Songs you have created to appear on the “New Song from Template” sub-menu, and be available for se-
lection when you use the “New Song from Template” command (see “Creating a new Song from a template”), you 
need only move or copy the Song(s) to the Template Songs folder in the application folder on your hard drive. The 
Template Songs folder is located a little differently depending on computer platform and OS:

! Under Windows, the Application Data folder might be hidden. If this is the case, you’ll have to change the prop-
erties so that you can view hidden files and folders.

• Under Windows XP, the Template Songs folder can be found in:
C:\Documents and Settings\UserName\Application Data\Propellerhead Software\Reason Essentials\Template 
Songs

• Under Windows Vista, the Template Songs folder can be found in:
C:\Users\UserName\AppData\Local\Propellerhead Software\Reason Essentials\Template Songs

• Under Windows 7, the Template Songs folder can be found in:
C:\Users\UserName\AppData\Roaming\Propellerhead Software\Reason Essentials\Template Songs

• Under Mac OS X, the Template Songs folder can be found in:
~/Library/Application Support/Propellerhead Software/Reason Essentials/Template Songs

A note about saving Songs as audio files
It’s also possible to export your Songs as audio files in WAV or AIFF format. Refer to “Exporting Songs or parts of 
Songs” for more information.
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Audio data and Scratch Disk settings

About audio data in Song files
If you record or import audio into an unsaved Song document, the audio is written to the “Scratch Disk folder” on your 
computer. As soon as you save (and name) the Song document, the audio is moved from the Scratch Disk folder to 
the Song document. From here on, all new recorded and/or imported audio is stored in the Song document.

Changing Scratch Disk folder location
The Scratch Disk is where Reason Essentials stores new, unsaved songs, plus analysis data (waveform data and 
high-quality time stretch/sample rate conversion data).

By default, Reason Essentials places the Scratch Disk folder in the system temp folder in your home directory. You 
can change the Scratch Disk folder location if you like:
1. Select “Preferences” from the Edit menu (Win) or Reason Essentials menu (Mac) and then click the “Ad-

vanced” tab.

2. Click the “Change” button in the Scratch Disk Folder section.
A system folder browser opens where you can select - or create - a new folder.

3. Select the folder where you want to locate the Scratch Disk Folder and click “OK”.

4. Restart the computer and relaunch Reason Essentials.

D If you later want to revert to the default setting, click the “Reset” button on the “Advanced” tab. 
The custom Scratch Disk Folder setting is removed and is replaced by the default setting. You will then have to re-
start the computer for the change to take effect.

About unavailable Scratch Disk Folder

If a custom assigned Scratch Disk Folder isn't available when you launch Reason Essentials, an alert saying: "The se-
lected Scratch Disk folder isn't available. Reason Essentials will use the default scratch disk for this session." is 
shown. This could happen if you have assigned the Scratch Disk folder to a removable disk and that disk is currently 
unavailable.

D Click “OK” to use the default Scratch Disk Folder.

The next time you launch Reason Essentials, it will look for the custom assigned Scratch Disk Folder again, and will 
do so every time you launch Reason Essentials, until you reset the custom assignment by clicking the “Reset” button.
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About “Orphan Audio Streams”
If your computer should malfunction (due to power loss etc.) during recording into a previously saved Song document, 
there is a good chance that your last unsaved audio recordings can be (at least partly) recovered:
1. Restart your computer and launch Reason Essentials.

2. Open one of the Song documents that was open during the computer malfunction.
If the Song contained unsaved audio recordings, Reason Essentials will find these and show an alert saying that 
the Song contains “orphan audio streams”. You will be given the choice of deleting them or having them appear in 
new clips on a new audio track, for salvaging.

! Note that it’s only audio recordings that it’s possible to recover. Any new Instrument Tracks in an unsaved 
Song will be lost in the case of computer malfunction.

Importing and exporting Standard MIDI Files
Reason Essentials can import and export Standard MIDI Files (SMF). This allows you to transfer MIDI data between 
Reason Essentials and other applications.

Importing Standard MIDI Files
To import a Standard MIDI File to the Reason Essentials sequencer, follow these steps:
1. Create a new, empty Song document.

2. Select “Import MIDI FIle...” from the File menu.
The standard file browser appears.

3. Select a Standard MIDI File (.mid) in the browser and click “Open”.
A number of new tracks are created in the Reason Essentials sequencer. The tracks will have their original name, 
with their original MIDI channel added. Each track will be assigned an ID8 device, loaded with a sound that resem-
bles the original sound. These assignments will only serve as a starting point to be able to play back the imported 
MIDI file. You may want to change sound, or replace the ID8 with another device if you have Reason installed. 

• The Note events in the MIDI file will be imported into one or several Note Clips on a Note Lane on each Track.

• If the imported MIDI file is a Type 1 MIDI file, there will be one sequencer track for each track in the MIDI file.

• If the imported MIDI file is a Type 0 MIDI file (that is, it contains one track with MIDI events on multiple chan-
nels), there will be one sequencer track for each used MIDI channel.

• The Tempo setting, any Tempo Automation and any Time Signature automation in the MIDI file will be recog-
nized.

• All controller data in the MIDI file is included.
This means that standard performance controllers (Pitch Bend, Mod Wheel etc.) are preserved properly and will be 
included in the note clip, just as when recording in Reason Essentials. If there are separate MIDI Controllers in the 
imported MIDI file, these will be imported to separate Automation Lanes on the Instrument Tracks. There is a 
chance that some controller data may be imported to alien clips, due to different interpretations of a controller by 
a device in the rack and the MIDI instrument used to create the MIDI file (see “About alien clips”).

Green frames will appear for automated parameters on the ID8 device panels. This helps you locate any unwanted controller 
automation.
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Exporting Standard MIDI Files
To export all Instrument Tracks and Automation Tracks from the Reason Essentials sequencer as a Standard MIDI 
File (SMF), do like this:
1. Set the End Marker in the sequencer to where you want your song to end.

The MIDI file will contain all MIDI events on all tracks from the start of the song to the End marker.

2. Select “Export MIDI FIle...” from the File menu.
The standard file browser appears.

3. Type in a new file name (if desired) and select location for the file to be exported. Then, click “Save”.
The default name for the MIDI File will be the Song’s name followed by the “.mid” extension.

MIDI files exported by Reason Essentials will have the following properties:

• The MIDI file will be of Type 1, with one MIDI track for each track in the Reason Essentials sequencer.
The tracks will have the same names as in the Reason Essentials sequencer.

• Since the Reason Essentials sequencer doesn’t use MIDI channels as such, all tracks will be set to MIDI chan-
nel 1.

• The sequencer Tempo, and any Tempo Automation and/or Time Signature Automation, is included in the MIDI 
file.

! Since an Instrument Track in Reason Essentials could consist of different types of devices (plus FX etc.), there 
is no information about the actual sound in the exported MIDI File. The exported MIDI File only contains infor-
mation about each instrument track and its MIDI Notes and/or MIDI Controller data laid out on the track. You 
will have to manually assign appropriate sounds to each track in the importing application.



SONG FILE HANDLING362



Chapter 15
Importing and 
Exporting Audio
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About this chapter
This chapter describes the various techniques you can use to import and export audio to and from Reason Essentials.

Importing audio

Audio formats, sample rates and tempo matching
The Reason Essentials sequencer supports import of mono and stereo WAV and AIFF files with different sample 
rates and resolutions. Reason Essentials also supports import of REX (ReCycle rcy, rex and rx2) files. You can import 
several audio files at the same time, with each audio file ending up on a separate Audio Track in the sequencer - or 
on separate Comp Rows in a selected Audio Clip. You can import files of different formats on the same Audio Track 
- or even in the same Audio Clip. One audio file could be an 8-bit mono file sampled at 22.05 kHz, the next a 24-bit 
stereo file sampled at 192 kHz, etc. Reason Essentials automatically converts sample rates and resolution with pre-
served audio quality. If the imported audio file includes tempo data, Reason Essentials automatically matches 
(stretches) the audio file to fit the current Song Tempo, without affecting the pitch.

• if the imported audio files’ sample rates differ from the current audio hardware sample rate, Reason Essentials 
will automatically sample rate convert.
This will first be done with a real-time algorithm, allowing for immediate playback. In the background, a high-quality 
sample rate conversion is performed. This is indicated by the CALC indicator on the transport panel. When done, 
Reason Essentials will automatically switch to playing back the high-quality version and the CALC indicator will go 
out.

The CALC indicator shows a progress bar when Reason Essentials performs high-quality stretching of audio

About tempo matching imported audio
If you have imported audio to the sequencer, you could manually tempo match (stretch) audio clips in a couple of 
ways:

• By using the Scale Tempo “tool” to manually stretch the audio clips, see “Tempo scaling Clips”.

• By using the Scale Tempo function in the Tool Window, see “Scale Tempo”.
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Importing audio to the sequencer
! To minimize the song saving time, we strongly recommend to save the song before you import many or large 

audio files.

To import one or several audios file to tracks in the sequencer, proceed as follows:
1. Select “Import Audio File...” from the File menu, or hold down [Ctrl]+[Shift](Win) or [Cmd]+[Option](Mac) and 

press [I].
The “Import Audio File” dialog appears:

2. Browse and select the audio file(s) (WAV, AIFF or REX) you want to import.
When you select a single audio file, information about length, format, size and tempo (if included in the file) is 
shown in the “Details” section of the dialog. If you like, you can also preview selected audio file by clicking the 
“Play” button in the “Audition” section. If you select several audio files, the total number of files and their total size 
are displayed in the Details section. You will not be able to preview the audio files when several files are selected.

D You can also import samples from the Song Samples tab of the Tool Window. All Song Samples can be found 
in the Song Samples folder in the Locations and Favorites section at the top left of the Import Audio File dia-
log.

! If you select a REX file, this will be rendered to audio when imported. The Song Tempo and any Tempo Auto-
mation starting at the Song Position Pointer will also be taken into account. After the import, the REX file will 
behave just like any imported audio file.

3. Click “Open” to import the audio file(s).
Depending on the where the edit focus was when you selected “Import Audio File” from the Edit menu, the audio 
file(s) will be placed a little differently. In all scenarios, the imported audio file(s) will be placed at the current song 
position:

• If an audio track has edit focus in the sequencer track list and you have selected only a single audio file, the 
imported audio file will be placed in a new clip on this audio track.

• If you selected several audio files in the Import Audio File dialog, each audio file will be imported to a new au-
dio track in the sequencer - in the order the files were selected in the Import Audio File dialog.

• If you selected only a single audio file and the edit focus is elsewhere in the application, a new audio track will 
be created for the imported audio file.
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Import audio file(s) to an open Audio Clip

It’s also possible to import audio files to open Audio Clips in the sequencer. Proceed as follows:
1. Double-click on the Audio Clip you wish to import the audio file(s) to.

The clip opens.

2. Select “Import Audio File...” from the File menu, or hold down [Ctrl]+[Shift](Win) or [Cmd]+[Option](Mac) and 
press [I].
The “Import Audio File” dialog appears.

3. Browse and select the audio file(s) (WAV, AIFF or REX) you want to import.

D You can also import samples from the Song Samples tab of the Tool Window. All Song Samples can be found 
in the Song Samples folder in the Locations and Favorites section at the top left of the Import Audio File dia-
log.

! If you select REX files, these will be rendered to audio when importing. The Song Tempo and any Tempo Auto-
mation starting at the Clip position will also be taken into account.

4. Click “Open” to import the selected audio file(s).
The audio file(s) will be imported as a new recordings on new Comp Rows. The Comp Row(s) for the imported au-
dio file(s) will be named “<filename.extension> (Imported)” where <filename.extension> is the name of the im-
ported audio file with the extension wav, aiff, rcy or rx2.

Depending on if you selected one or several audio files, the following will happen:

• If you selected a single audio file, it will end up on the topmost Comp Row in the audio clip. 
If the audio clip is in Single Mode, the imported audio file will be the currently active one. If the clip is in Comp 
Mode, any existing recording in the clip will still be the active one.

• If you selected several audio files, the first selected file will end up on the topmost Comp Row.
If the audio clip is in Single Mode, the first selected audio file will be the currently active one. If the clip is in Comp 
Mode, any existing recording in the clip will still be the active one.

q If you like, you could now edit the Audio Clip and comp the recordings on the different Comp Rows according 
to the description in “Creating a comped audio clip”.

Importing audio to sample-based devices
When loading WAV or AIFF samples or REX (ReCycle) files into the NN-XT sampler, the Redrum or the Dr. Octo Rex 
loop player, Reason Essentials supports files of a large number of sample rates and resolutions. You can use files of 
different formats in the same device - one drum sound can be an 8-bit sample, the next a 16-bit or 24-bit sample, etc.
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Exporting audio
You can export audio from Reason Essentials in a number of different ways. In addition to exporting entire songs, it’s 
also possible to export (bounce) audio from separate Mixer Channels, with or without the mixer settings. It’s also pos-
sible to export (bounce) individual Audio Clips. You can choose a variety of sample rates for the exported/bounced 
audio, and also various audio file formats and resolutions.

Exporting Songs or parts of Songs
There are two ways of exporting the mix of all active sequencer tracks in a song:

• The “Export Song as Audio File...” on the File menu allows you to save the mix from the start of the song to the 
End Position Marker.

• The “Export Loop as Audio File...” on the File menu allows you to save the mix from the Left Locator to the 
Right Locator.

! When you export a song or a Loop, the signals for the exported audio file are taken from Outputs 1 and 2 of the 
Hardware Interface device. Any other used outputs on the Hardware Interface will be disregarded.

To export the mix of an entire song, or a loop section of a song, proceed as follows:
1. Make sure the End Position Marker is placed where you want the song to end or, if you want to export a Loop, 

make sure the Left and Right Locators are placed around the Loop you want to export.

! Make sure you place the End Marker (when exporting a Song) or Right Locator (when exporting a Loop) so that 
any sustaining sounds are allowed to decay to silence. Otherwise, there will be an abrupt “cut” in the end of 
the exported audio file. This is probably not what you want.

2. Select “Export Song as Audio File...” or “Export Loop as Audio File...” from the File menu.
The “Export Song as Audio File” or “Export Loop as Audio File” dialog appears.

3. Choose location, File Name and File Format (AIFF or WAV) for the exported audio file at the bottom of the di-
alog and click “Save”:

Choose a file name and select file format

4. Select “Sample Rate”, “Bit Depth” (resolution) and “Dither” in the “Export Audio Settings” dialog and click 
“OK”:
If you are exporting at 16-bit Bit Depth you will have the option of applying Dither. Dither means that a type of 
noise is added to the digital signal to improve low level sound quality when exporting high resolution audio at a 
lower bit depth. Reason Essentials features a very sophisticated dithering algorithm with noise shaping.

D Place a tick in the “Dither” check box to improve the audio quality of exported audio at 16-bit resolution.

Select Sample Rate, Bit Depth and Dithering of the audio to be exported
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About Tempo data in exported audio files

In addition to the audio data, tempo data is automatically included in the exported audio file. The tempo data contains 
information about the song Tempo and any Tempo Automation used in the song/loop. If you import such an audio file 
into another Reason Essentials or Reason Version 6 song, it will automatically stretch to fit the current song tempo.

If the section to be exported contains audio for which high-quality stretching hasn't already been done, this will be 
calculated before the actual export happens. When Reason Essentials performs high-quality stretching, the CALC in-
dicator on the Transport Panel shows a progress bar:

The CALC indicator shows a progress bar when Reason Essentials performs high-quality stretching of audio

• If high-quality stretching is still in progress when you export your audio file, the Export dialog will show a prog-
ress bar as well.
As soon as the high-quality stretching is finished, the dialog will be closed.
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Bouncing Mixer Channels
Bouncing Mixer Channels basically means “recording” the audio outputs from Audio Track Channels and/or Mix 
Channels and then automatically creating separate audio files. The audio files can then be saved to disk or placed on 
new Audio Tracks in your song. If you choose to bounce to disk, the audio files will be automatically saved to disk as 
separate audio files. If you instead choose to bounce to new tracks, the bounced audio files will be automatically 
placed on new Audio Tracks in the sequencer.

The “bounce to disk” option is ideal if you want to export your sequencer tracks separately for further processing in 
external applications. The “bounce to track” option is great if you, for example, have instrument tracks with lots of re-
source consuming FX etc. and therefore want to render them into audio to free up DSP resources in your song.

You can choose to bounce the Mixer Channels, either throughout the entire song, or only between the Left and Right 
Locators. You can also choose to bounce with or without mixer settings.

Do like this to bounce Mixer Channels:
1. Select “Bounce Mixer Channels...” from the File menu.

The “Bounce Mixer Channels” dialog appears:

The “Bounce Mixer Channels” dialog

When you open the “Bounce Mixer Channels” dialog, some channels in the Mixer Channels list might already be 
checked. This depends on what Mixer Channels (or their corresponding tracks or rack devices) were selected 
when you opened the dialog. The Master Section and FX Returns are never automatically checked when you open 
the dialog; you have to do that manually.
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2. Place a tick in the check boxes for the Mixer Channels you want to bounce. Note that you can also bounce the 
Mixer Master Section and any FX Returns at the same time if you like.
The Mixer Channels in the list appear in the order they are placed in the Main Mixer, i.e. not necessarily in numer-
ical or chronological order. The color tags in the list correspond to the Channel Strip colors in the Main Mixer. The 
Master Section is always listed as “Master Section” in the list and the eight FX Returns are listed as "FX 1 Return 
(<name>)", where <name> is the FX name shown on the label in the Main Mixer. Selecting FX Returns makes it 
possible to bounce reverbs and other Send FX you might be using in your song. The FX signal is tapped after FX 
Return Level/Pan/Mute if “Apply Mixer Settings = All” (see below). Otherwise, the signals will be taken at the FX 
Return inputs.

D Click the “Check All” or “Uncheck All” buttons to activate or deactivate all checkboxes in one go.

3. Select what channel settings you want to use (or not use) by clicking one of the radio buttons in the “Apply 
Mixer Settings” section.

D Select “All” to bounce the selected Mixer Channels with all its settings, including any Insert FX, Level and Pan.
Since the Pan parameter is included, mono Mixer Channels will be bounced as stereo audio files.

D Select “All except fader section” to bounce the selected Mixer Channels with all Mixer Channel settings, in-
cluding any Insert FX, but excluding the Level, Pan, Stereo Width and Mute parameters of the Channel Strip.
Stereo Mixer Channels will be bounced as stereo audio files whereas mono Mixer Channels will be bounced as 
mono audio files. For the Master Section, this option means including Insert FX and the Master Compressor, but 
not the master fader.

D Select “None” to bounce the selected Mixer Channels before the Mixer Channel Strips, without applying any 
Mixer Channel parameters or Insert FX.
Bounced files will be in stereo if there's any stereo material on the Audio Track (or, for a Mix Channel, if it's con-
nected in stereo). Otherwise, the bounced audio files will be in mono.

4. Place a tick in the “Normalize” check box to adjust all bounced audio files so the maximum level is 0 dB.
Normalizing is useful to get good levels when you proceed to use the bounced audio files in another application, or 
to avoid clipping.

5. Select what range to bounce in the “Range to Bounce” section.

D Select “Song” to bounce the entire song (from the beginning of the song to the End Marker).

D Select “Loop” to bounce the section between the Left and Right Locators.

! Make sure you place the End Marker (when bouncing a Song) or Right Locator (when bouncing a Loop) so that 
any sustaining sounds are allowed to decay to silence. Otherwise, there will be an abrupt “cut” in the end of 
the bounced audio files.

6. Select destination for the bounced Mixer Channel(s) in the “Bounce to:” section.

D Select “New Tracks in Song” to bounce the Mixer Channels to new Audio Tracks in the song.
When “New Tracks in Song” is selected, the File Format settings in the dialog are disabled (as is the "Export 
Tempo Track (.MID)" setting). The audio will be rendered at the current song’s sample rate (i.e. what you have pre-
viously set up in the hardware audio interface), at full 32-bit float resolution.

Clicking OK will create a new Audio Track for each selected Mixer Channel, create an Audio Clip on each of these 
Tracks and render the Mixer Channel audio as a recording on a Comp Row in the Audio Clip.

The new Audio Tracks will get the names and colors of their corresponding (bounced) Mixer Channels. The Audio 
Clips will get the same color but will not be labeled (named).

The new recordings (on the Comp Rows) will get the name of their source Mixer Channels + "(Bounced)", e.g. 
"Picked Guitar (Bounced)" if the bounced Mixer Channel’s name is “Picked Guitar”.

Selecting "Mute Original Channels" will mute all bounced Mixer Channels (those selected in the Mixer Channels 
list) after the bouncing. If there are automation lanes for their Mute buttons, their ON buttons will be turned off.

! The “Mute Original Channels” setting does not affect the Master Section or the FX Returns.
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D Select “Audio Files on Disk” to bounce the Mixer Channels to audio files on disk.
When “Audio Files on Disk” is selected, the "Mute Original Channels" option in the dialog is automatically disabled.

Choose File Type, Sample Rate, Bit Depth and any Dither in the “File Format” section.

Clicking OK will bring up a Save dialog which allows you to select a folder, or create a new folder. Clicking Save 
will then create one audio file per selected Mixer Channel and place in a sub-folder named “Bounced <song 
name>”. All audio files will have the file type, sample rate and bit depth as defined in the “File Format” section.

The audio files will get the name of the bounced Mixer Channels, plus the File Type extension. If several selected 
Mixer Channels have the same name, an incremental number (starting with "-01") will be automatically added be-
fore the file extension.

The Song Tempo, and any Tempo Automation, is also included in the exported audio files. This means that if you 
import the audio files into another Reason Essentials or Reason 6 Song document, they will automatically be 
stretched to the Song Tempo of that song.

If "Export Tempo Track (.MID)" is activated, the bounce function will also export a separate MIDI file containing the 
Song Tempo, and any Tempo Automation data. The MIDI file will have the name of the song, with the extension 
".MID". This MIDI file can then be imported to the tempo automation lane in another Reason Essentials or Reason 
6 Song document, or to the tempo track in another DAW, to automatically set the song tempo and control any 
tempo automation in the sequencer.

! Note that the “Export Tempo Track” option is available only if you have selected “Audio Files on Disk" in the 
“Bounce to:” section and “Song” in the “Range to Bounce:” section.

Bouncing Audio Clips

The “Bounce Clip to Disk” function

The “Bounce Clip to Disk” function becomes available when a single Audio Clip is selected (in Arrange Mode or Edit 
Mode). The function allows you to bounce single Audio Clips, after the Clip Level and Fades but without the Mixer 
Channel settings, to disk for further processing in an external application, for example. Do like this to bounce an audio 
clip to disk:
1. Select an Audio Clip and choose “Bounce Clip to Disk...” from the Edit menu or context menu.

The “Bounce Clip As Audio File” dialog appears. It looks the same, and has the same functionality, as the “Export 
Song as Audio File” and “Export Loop as Audio File” dialogs.

2. Choose location, File Name and File Format (AIFF or WAV) for the bounced audio clip at the bottom of the di-
alog and click “Save”.
(The default name in the dialog is the Clip name + extension, or (if there's no name label on the clip) the track 
name + extension.)

Choose a file name and select file format

3. Select “Sample Rate”, “Bit Depth” (resolution) and “Dither” in the “Export Audio Settings” dialog and click 
“OK”:
If you are exporting at 16-bit Bit Depth you will have the option of applying Dither. Dither means that a type of 
noise is added to the digital signal to improve low level sound quality when exporting high resolution audio at a 
lower bit depth. Reason Essentials features a new, and very sophisticated, dithering algorithm with noise shaping.
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D Place a tick in the “Dither” check box to improve the audio quality of exported audio at 16-bit resolution.

Select Sample Rate, Bit Depth and Dithering of the audio clip to be bounced

The exported audio file will also contain tempo data as described in “About Tempo data in exported audio files”.

About the “Bounce Clip to New Sample” function

You can also bounce an Audio Clip to a new Song Sample. You could then edit the sample and load into a sampler 
device for playback.

See “Bounce Clip(s) to New Sample(s)” in the “Audio Editing in the Sequencer” chapter for more details.

About the “Bounce Clip to New Recording” function

You can also bounce an Audio Clip to a new recording on an additional Comp Row in the Audio Clip. This is like a 
non-destructive “Flatten” operation. It will create a new recording from the clip output - ignoring Clip Level and Clip 
Fade In/Out settings. The recording will be placed on a new Comp Row at the top of the Comp Row list in the clip. 
The Audio Clip will then automatically switch to Single Mode.

See “Bounce Clip(s) to New Recording(s)” in the “Audio Editing in the Sequencer” chapter for more details.



Chapter 16
Sampling
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About this chapter
This chapter describes how you can sample, edit samples and manage your samples in your songs. For more infor-
mation about the specific devices that can sample and play back samples, please refer to the “NN-XT Sampler” and 
“Redrum Drum Computer” chapters.

Overview
The sampling feature allows you to sample external audio (or internally from the outputs of any device) and use in any 
of the devices that support sample files, i.e. NN-XT and Redrum.

One-click sampling
The sampling workflow has been designed to be as quick and easy as possible, so you don’t lose any inspiration. Re-
gardless which device you use when sampling - be it the NN-XT or Redrum - sampling can be instantly accessed by 
simply clicking, or by clicking and holding the Sampling button(s) on these devices:

Sampling buttons on the NN-XT and Redrum devices respectively

You can also sample from the Song Samples tab in the Tool Window at any time. You don’t even have to have a sam-
ple player device present in the rack (see “Recording unassigned samples”).

See “Sampling procedure” for more details on how to sample.

The Edit Sample window
All sampling parameters and functions are controlled from one single window - the Edit Sample window. This window 
is used whenever you’re sampling to any of the devices described above, or from the Song Samples tab in the Tool 
Window. See “Editing samples” for more details.

The Edit Sample window with a sample
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About sample format, rate and resolution
Whenever you sample in Reason Essentials, the resulting audio files are stored in WAV format. The sample rate is 
determined by the settings on the Audio tab in Preferences (see “Audio settings”). The resolution (bit depth) is de-
fined in the setup application for your specific audio hardware (consult the manual for your audio hardware for infor-
mation). If you use the Propellerhead Balance audio interface, the resolution is fixed at 24-bit.

Actually, Reason Essentials is totally agnostic about what sample rate and resolution you use. If you like, you can 
change audio settings at any time without affecting the pitch, playback speed etc. of your samples. What you have 
once sampled will always sound the same, regardless of the current audio settings!

General sampling functions

Setting up for sampling
If you want to sample external audio, e.g. from a mic or an instrument connected to the audio hardware on your com-
puter, make sure you have set up the desired audio input(s) on the Audio tab in Preferences, see “Active Input and 
Output Channels”. Available audio inputs are indicated with yellow or green LEDs on the Hardware Interface in the 
rack:

Selecting audio input source(s)

To set up for sampling, you first need to make some connections on the Hardware Interface:
1. Navigate to the Hardware Interface and press [Tab] to flip the rack around.

2. Patch cables to the Sampling Inputs as follows:

D To sample external audio, connect the desired Audio Input connector(s) to the Sampling Input connector(s) to 
the left on the rear of the Hardware Interface.

D To sample the audio of a device in the rack, connect cables from the audio output(s) of the device to the Sam-
pling Input connector(s) on the Hardware Interface.

• To sample in stereo, connect to both the Left and Right Sampling Input connectors.

• To sample in mono, connect only to the Left or Right Sampling Input connector.

Audio Inputs 1&2 connected to Sampling Inputs L&R for sampling in stereo
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Setting audio input level

Once you have made the desired connections to the Sampling Input(s) on the Hardware Interface, it’s important to 
check the audio input level to avoid clipping. If you are going to sample external audio via the audio hardware of your 
computer, you have to adjust the level at the source, i.e. on the pre-amp of the audio hardware (or connected instru-
ment). A good suggestion is to use the Big Meter on the Hardware Interface to be able to monitor the input level(s) 
more easily.

D Adjust the level at the source and make sure the level doesn’t exceed 0 dB to avoid clipping.

D If you sample internally, from the output(s) of a device in the rack, adjust the Output Level on the source device 
and check the levels with the Sampling Inputs selected on the Big Meter:

Monitoring and Monitor Level

To the left on the Hardware Interface are two buttons and one knob for monitoring the signals on the Sampling In-
puts:

D Click the Monitor button to activate monitoring of the signals present at the Sampling Inputs.
Monitoring will always be active, regardless of if you sample or not.

D Click the Auto button to activate monitoring only during sampling.
Monitoring will only be active during the actual sampling. When you don’t sample, monitoring will be off.

D Turn the Monitor knob to adjust the monitor signal level.

! The Monitor Level knob does not affect the level of the audio to be sampled - only the monitored signal.
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Sampling

The Sample buttons
The NN-XT and Redrum devices feature one or several Sample buttons. There is also a Sample button on the Song 
Samples tab in the Tool Window (see “Recording unassigned samples”). The Sample buttons are located on the de-
vices as follows:

Sampling buttons on the NN-XT and Redrum devices respectively

Sampling procedure
Sampling can be made in two basic ways: 

• Sampling “assigned samples” directly into a device by clicking, or clicking and holding the Sample button on 
the device’s panel.

• Sampling “unassigned samples” that are not (yet) assigned to any sampler device.

Regardless of which method you use to sample, the sample rate will be according to your current audio hardware set-
tings (see “Audio settings”).

Sampling into a device (NN-XT or Redrum)

1. Make sure you have made the necessary connections and set the levels according to the descriptions in “Set-
ting up for sampling”.

2. Click the Sample button on the device.

D Alternatively, click and hold the Sample button depressed for as long as you want to sample.
When you use the “click and hold” method, sampling will be automatically terminated as soon as you release the 
mouse button. The sample will then end up in the device and on the Song Samples Tab in the Tool Window.

! If you’re sampling into a Redrum, make sure you click/hold the Sample button for the desired drum channel.

A waveform display shows up with a moving “play head”:

Play head
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3. Start playing or singing what you want to sample.
As soon as any audio is present on the Sampling Inputs on the Hardware Interface, the waveform display will indi-
cate this by drawing a wave.

! The buffer size for sampled audio is 30 seconds. After 30 seconds, the play head will start over again from the 
beginning and start erasing any previously sampled audio.

D If you want to restart the sampling manually, click the Restart Sampling button:

The “Restart Sampling” button

This will erase any sampled audio and force the play head to restart from the beginning.

! Note that you cannot restart sampling this way if you use the “click and hold” sampling method.

4. When you’re satisfied with your recording, click the Stop Sampling button in the waveform display.

The “Stop Sampling” button

The waveform display closes and the sample automatically ends up in the device, where you can play it back instantly:

By default, the sample is named “Sample ‘n’” where ‘n’ is a serial number. As you will notice, any silence preceding the 
actual audio in the sample will be automatically disregarded. The entire sample is preserved, but this is done so you 
won’t have to edit the sample start before playback.



SAMPLING 379

Besides ending up in the device, a shortcut to the sample is also placed under the corresponding device icon in the 
Assigned Samples folder on the Song Samples tab in the Tool Window:

Here, all samples you use in your song are listed (see “The Song Samples tab”). Here is also where you can open 
samples for editing (see “Editing samples”).

Recording unassigned samples

If you don’t want to sample directly into a device, you can record “unassigned samples” from the Song Samples tab in 
the Tool Window instead. You can then choose to assign these samples to a device later on if you like.

The sampling procedure is identical to the description in “Sampling into a device (NN-XT or Redrum)” above, except 
you start the sampling by clicking the Sample button at the bottom of the Song Samples tab in the Tool Window:

The Sample button on the Song Samples tab in the Tool Window

! Note that you cannot use the “click and hold” method when sampling from the Song Samples tab!

The same waveform display shows up with the moving play head. When you’re satisfied with your recording, click the 
Stop Sampling button in the waveform display. The sample is now placed in the All Self-contained Samples folder on 
the Song Samples tab, with a shortcut in the Unassigned Samples folder. The sample is automatically named “Sam-
ple ‘n’” where ‘n’ is an integer. To play back the sample, select it in the All Self-contained Samples folder and click the 
Play button on the Song Samples tab (see “The Song Samples tab”). 
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The Song Samples tab
The Song Samples tab in the Tool Window is where all samples in your song are listed and can be accessed for pre-
view and editing purposes. Besides your own samples, all Factory samples and any ReFills samples used in the song 
are also accessible for previewing and editing!

The Song Samples tab in the Tool Window
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The Song Samples tab in the Tool Window contains the following items:

• Assigned Samples folder
Here, all samples that are assigned to devices in the song are listed. All devices that contain assigned samples are 
listed as “sub-folders”. Each device “sub-folder” shows the samples currently assigned to it. Since samples can 
originate either from the Factory Soundbank, from external ReFills or your own samples, they are all listed as 
shortcuts in the list. See “Assigned Samples” for more details.

• Unassigned Samples folder
Here are all sounds that you have sampled yourself in your song, by using the Sample button at the bottom of the 
Tool Window (see “Sample button”). When you sample using the Tool Window Sample button, the samples auto-
matically become unassigned (since they weren’t sampled from a device). See “Unassigned Samples” for more de-
tails.

• All Self-contained Samples folder
All sounds you have sampled yourself, plus any duplicated samples from the Factory Soundbank and/or ReFills, 
automatically becomes self-contained and are always stored with the song. These samples are listed in the All 
Self-contained Samples folder. See “About self-contained samples” for more details.

• Play button and Autoplay checkbox.
To audition a sample, select it in the Song Samples list and click the Play button. If you tick the Autoplay box, sim-
ply selecting a sample in the list will automatically play it back.

• Volume slider
Adjust the preview volume of the sample with the slider. This does not affect the samples original volume.

• Sample button
Click the Sample button to sample the signal present at the Sampling Inputs of the Hardware Interface. 
See “Recording unassigned samples” for more details.

• Edit button
Click the Edit button to open the selected sample for editing in the Edit Sample window (see “The Edit Sample 
window”).

• Duplicate button
Click the Duplicate button to create a duplicate of the selected sample. The duplicated sample is placed in the All 
Self-contained Samples and Unassigned Samples folders. See “Duplicating samples” for more details.

• Delete button
Click to permanently delete the selected sample from the song. Note that samples from the Factory Soundbank 
and from ReFills will not be deleted from their original locations - only from the song document. See “Deleting 
samples from a song” for more details. Any samples you have recorded yourself will be permanently erased unless 
you have previously exported them to disk (see “Export button” below).

• Export button
Click to export the selected sample to disk. A dialog appears where you can select file format. Note that it is not 
possible to export samples from the Factory Soundbank or from ReFills. See “Exporting samples” for more details.
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Editing samples

The Edit Sample window
Any sample present in the All Self-contained Samples folder on the Song Samples tab in the Tool Window can be ed-
ited.

Double-clicking a sample or a short-cut icon in any of the folders on the Song Samples tab, or selecting a sample and 
then clicking the Edit button, opens the sample in the Edit Sample window:

The Edit Sample window with an open sample
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The Edit Sample window can be resized in all directions by clicking and dragging the window frame. If you resize the 
window vertically, the displayed waveform will be resized vertically as well.

• Undo and Redo buttons
The Undo and Redo buttons work like the regular undo and redo functions in the main window menu, but these 
are used locally only for the Sample Edit window. The number of Undo and Redo steps in the Sample Edit window 
are limited to 10. Once you have clicked the Save button, you can still undo the entire sample editing procedure by 
using the Undo function in the main window.

• Crop button
Click the Crop button to crop the sample so that only the content between the Start (S) and End (E) locators is 
preserved. The rest of the sample will be permanently deleted. See “Cropping samples” for more info.

• Normalize button
Click the Normalize button to amplify the entire sample so that the loudest peak touches 0 dB. Note that the entire 
sample is normalized, regardless of any locator settings. See “Normalizing samples” for more info.

• Reverse button
Click the Reverse button to reverse (play backward) the entire sample. Note that the entire sample is reversed, re-
gardless of any locator settings. See “Reversing samples” for more info.

• Fade In and Fade Out buttons
The Fade In and Fade Out buttons can be used to apply a fade in or fade out of the sample volume. See “Fading 
in/out samples” for more info.

• Loop Mode buttons
Click one of the Loop Mode buttons to select loop type. The default (leftmost) setting is “no loop”. Then follow 
“Loop Forward” and “Loop Forward + Backward”. See “Looping samples” for more info.

• Waveform pane
Here, the currently open sample is displayed as one (mono) or two (stereo) waveforms. The Start (S) and End (E) 
locators are also displayed. By default the Start locator is placed where the audio begins in the sample. This means 
that if you have started sampling before there were any audio present, the playback will automatically start where 
the audio begins. This way you won’t have to manually move the Start locator in most situations.

• Waveform Navigator
Below the waveform pane is the horizontal Waveform Navigator. This can be operated in the same way as the 
Song Navigator in the sequencer (see “Scrolling with the Navigators”, “Zooming horizontally in the Sequencer” and 
“Scrolling and zooming using a wheel mouse”).

• Set Sample Start/End button
Set the desired sample playback region by clicking and dragging on the waveform pane. Then, click the Set Sam-
ple Start/End button to automatically place the Start and End locators at the beginning and end of the sample re-
gion. See “The Set Start/End function” for more info.

• Snap Sample Start/End To Transients button
Click the Snap Sample Start/End To Transients button to make the Start and End locators snap to suitable tran-
sients in the sample as you move the locators. This makes it easier to find appropriate start and end locations for 
the sample playback.

• Crossfade Loop checkbox
Tick the Crossfade Loop box to introduce a crossfade in the loop. Crossfade is useful to even out any clicks in the 
loop points, especially for sounds with fairly even volume throughout the loop region. See “The Crossfade Loop 
function” for more info.

• Set Loop button
Set the desired loop region by clicking and dragging on the waveform pane. Then, click the Set Loop button to au-
tomatically place the Left and Right Loop locators at the beginning and end of the loop region. See “The Set Loop 
function” for more info.
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• Play button, Solo checkbox and Volume slider
Click the Play button to play back the sample from the current position of the play head until the end of the sample. 
As soon as playback is started the button switches to display Stop instead, giving you the option of stopping play-
back. This is especially useful if your sample is looped. As an alternative to clicking the Play/Stop button you can 
press [Spacebar] to toggle between Play and Stop.

Tick the Solo checkbox to solo sample playback. This is useful if your song is playing in the background and you 
only want to listen to the sample.

Adjust the sample playback volume with the Volume slider to the right.

• Root Key
Set the sample Root Key (pitch) by clicking the spin controls, or by entering the desired note value in the display.

• Name
Type in desired name for your sample. Note that this will overwrite the original name of the sample in the Song 
Samples list in the Tool Window once you click Save. See “Renaming samples” for more info.

• Save and Cancel buttons
Click Save to save your sample. The sample will appear in the Song Samples list in the Tool Window. See “Saving 
edited samples” for more info.

Click Cancel to exit the Edit Sample window and discard from any edits you’ve made in the current sample.

Setting Sample Start and End
1. Open the sample by double-clicking it in the Song Samples list in the Tool Window.

The sample is opens in the Edit Sample window.

If you have recorded the sample yourself in Reason Essentials, the Start (S) locator has been automatically placed 
at the first significant transient in the sound. The play head is also automatically placed at the Start locator.

2. If necessary, adjust the Start locator by clicking and dragging it back or forth in the Edit Sample window ruler.
Play back the sample by clicking the Play button, or by pressing the [Spacebar].
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q To make it easier to fine adjust the locators, it could be wise to magnify the waveform pane horizontally using 
the Waveform Navigator. The Waveform Navigator works exactly as the Song Navigator in the Sequencer - see 
“Zooming horizontally in the Sequencer” and “Scrolling and zooming using a wheel mouse”.

D Tick the “Snap Sample Start/End To Transients” check box if you want the locators to snap to significant tran-
sients in the sample.

3. Adjust the End locator by clicking and dragging it back or forth in the Edit Sample window ruler.

The Set Start/End function

Another way of defining a sample’s start and end positions is by using the Set Start/End function:
1. Set the desired sample playback zone by clicking and dragging on the waveform pane.

The defined zone is highlighted in blue color.

2. Click the Set Sample Start/End button.

The Start and End locators are automatically placed at the beginning and end of the defined playback zone.

3. Click anywhere on the Waveform pane to remove the highlight.
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Cropping samples
Cropping a sample means deleting parts you don’t want to keep, e.g. any silence in the beginning and/or in the end 
of a sample. The Crop function in the Edit Sample window deletes everything except what’s in between the Start and 
End locators, or everything outside any highlighted part of the sample. To crop a sample, proceed as follows:
1. Set the Start and End locators where you want them - see “Setting Sample Start and End”.

Alternatively, click and drag in the Edit Sample window to highlight the section you want to keep.

2. Click the Crop button in the Edit Sample window.

• If you highlighted a section by clicking and dragging in the Edit Sample window, everything except the high-
lighted part gets permanently deleted.

• If you didn’t highlight a section of the sample, everything before the Start locator and after the End locator 
gets permanently deleted.

Normalizing samples
Normalizing means amplifying the volume of the sample so that the loudest peak in the sound touches 0 dB. The 
Normalize function normalizes either the entire sample, or the highlighted part of the sample.
1. Click and drag in the Edit Sample window to highlight the part of the sample you want to normalize.

To normalize the entire sample, you don’t have to do anything.

2. Click the Normalize button in the Edit Sample window.

• If you highlighted a section of the sample, the highlighted part gets normalized.

• If you didn’t highlight a section of the sample, the entire sample gets normalized regardless of any Locator set-
tings.
Since the entire sample is normalized, this means that any noise present in the sound will also be amplified.

After the Normalize operation, the waveform is redrawn with the new volume values.

! Note that normalizing a sample that already use the full headroom (touches 0 dB) won’t have any effect.

Reversing samples
Reversing a sample means playing it backwards, from the end to the start. The Reverse function reverses either the 
entire sample, or the highlighted part of the sample.
1. Click and drag in the Edit Sample window to highlight the part of the sample you want to reverse.

To reverse the entire sample, you don’t have to do anything.

2. Click the Reverse button in the Edit Sample window.
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• If you highlighted a section of the sample, the highlighted part gets reversed.

• If you didn’t highlight a section of the sample, the entire sample gets reversed regardless of any Locator set-
tings.
After the Reverse operation, the waveform is redrawn with the reversed shape.

Fading in/out samples
Using short fades is useful if you want to remove clicks or pops in the beginning and/or end of the sample. You can 
also create longer fades to make a sound fade in and/or out nice and smoothly.
1. Set the desired Fade In (or Fade Out) zone by clicking and dragging on the waveform pane.

The defined zone is highlighted in blue color.

2. Click the Fade In (or Fade Out) button.

Clicking the Fade In button creates a fade in from complete silence at the beginning of the highlighted zone to the 
current volume at the end of the highlighted zone:

Clicking the Fade Out button creates a fade out from the current volume at the beginning of the highlighted zone 
to complete silence at the end of the zone.

After the Fade operation, the waveform is redrawn with the new volume values.

3. Click anywhere on the Waveform pane to remove the highlight.
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Looping samples
Looping a sample means playing back the sample from the start and then playing back a defined zone in the sample 
over and over again (usually as long as a key is pressed on the MIDI master keyboard). In practice, looping samples 
can be used to create “longer” sounds out of shorter ones. For example, if you have a flute sample you may want to 
loop the middle part of it so that you could make the sound sustain as for long as you like.

There are two different loop modes available in the Edit Sample window (besides the default non-loop mode):

• Loop Forward
In Loop Forward mode the sample is played back from the Start locator to the Right Loop locator, then playback 
starts over from the Left Loop locator and continues to the Right Loop locator over and over again.

• Loop Forward + Backward
In Loop Forward + Backward mode the sample is played back from the Start locator to the Right Loop locator, 
then the playback is reversed from the Right Loop locator to the Left Loop locator and then forward again to the 
Right Loop locator over and over again.

Adjusting the Loop locators

1. Click the Loop Forward or Loop Forward + Backward button.

The Left (L) and Right (R) Loop locators appear on the Waveform pane.

2. Play back the sample and adjust the Loop locators to your liking.
If necessary, zoom in horizontally to more easily find suitable loop positions. 

D To make loops sound smoother, try using crossfades as described in “The Crossfade Loop function”.
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The Set Loop function

Another way of defining a sample’s loop positions is by using the Set Loop function:
1. Set the desired loop zone by clicking and dragging on the waveform pane.

The defined zone is highlighted in blue color.

2. Click the Set Loop button.
The Left and Right Loop locators are automatically placed at the beginning and end of the defined zone.

3. Click anywhere on the Waveform pane to remove the highlight.

D To make loops sound smoother, try using crossfades as described in “The Crossfade Loop function”.
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The Crossfade Loop function

Crossfades are useful for evening out clicks or transients at the loop points, especially in sounds with fairly constant 
volume throughout the loop zone. The Crossfade Loop function creates smooth volume crossfade around the Loop 
Locators.

D Tick the Crossfade Loop box to automatically introduce a crossfade in the loop.

• When the Crossfade Loop function is active, moving the Left and/or Right Loop Locators will force them to au-
tomatically “snap” to suitable loop positions. If you move the Left Loop Locator, the Right Loop Locator will 
automatically self-adjust to a suitable loop position.
This way you will quickly reach a good result.

q Experiment by alternating the Loop Modes between Loop Forward and Loop Forward + Backward. Just chang-
ing Loop Mode can make the loop transitions much smoother in many situations.

q A general tip when trying to create a smooth loop is to locate the loop zone where the volume and timbre is 
fairly constant over time. Big changes in volume and/or timbre in the loop zone will often result in quite pro-
nounced or strange “pulsating” loops. Also, very short loop zones often tend to sound unnatural and “static”.

Saving edited samples
D Click the Save button in the Edit Sample Window to save your edited sample.

The sample is saved, complete with all the edits you have made in the Edit Sample Window (Start, End, Loop set-
tings, Name etc.) The sample will appear in the Song Samples list in the Tool Window, with the new name if this 
has been changed.

! If you have opened and edited a ReFill sample, a copy of this sample (including any edits) will be saved with its 
original name in the All Self-contained Samples folder.

Renaming samples
1. Type in the desired name of your sample in the Name field in the Edit Sample Window.

2. Click the Save button to save the sample with the new name.

! Note that saving a sample under a different name will simply replace the current name - it will not create a copy 
of the original sample!
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Sample management

About Assigned and Unassigned samples

Assigned Samples

Samples can be assigned to devices that support sample playback, i.e. the NN-XT and Redrum. Samples that are as-
signed to a device can be found in the Assigned Samples folder on the Song Samples tab in the Tool window:

The Assigned Samples folder can contain various sub folders, one for each sampler device used in the current song. 
The song in the picture above contains two sampler devices; the “NN-XT 1” and the “Redrum 1”. The instrument fold-
ers can be unfolded to display their current sample contents. Sounds you have sampled yourself as well as samples 
from the Factory Soundbank and from ReFills are displayed with shortcut icons.

The reason the samples are displayed with shortcut icons here is that they merely point to the original samples’ loca-
tions on your computer, or in the Self-contained Samples folder (see “About self-contained samples”).

Unassigned Samples

Samples that are not (yet) assigned to a sampler device are displayed in the Unassigned Samples folder:

Here are shortcuts to the samples you have previously recorded in the Reason Essentials song using the Sampling 
button in the Tool Window (see “Recording unassigned samples”). These unassigned samples can easily be assigned 
to any of the sampler devices at any time by loading them into a sampler device - see “Loading samples into a de-
vice”.
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Saving samples in a song
When you have recorded a sample, either by clicking a Sample button on a sampler device or on the Song Samples 
tab in the Tool Window, the sample is automatically stored in the All Self-contained Samples folder in the Tool Win-
dow.

The samples you have recorded are automatically named “Sample ‘n’” where ‘n’ is a serial number.

You can rename a sample by double clicking it in the All Self-contained Samples folder, renaming it in the Edit Sam-
ple Window and then clicking the Save button.

As soon as you save your song, all samples you have recorded will be automatically saved as self-contained samples 
in the song document. This way you don’t have to keep track of any “loose” samples on your computer.

Deleting samples from a song
It’s only possible to delete samples you have recorded yourself in a Reason Essentials song, i.e. samples that are lo-
cated in the All Self-contained Samples folder in the Tool Window. Samples from the Factory Soundbank and from 
ReFills cannot be deleted because they are contained in ReFills. However, you can delete shortcuts to ReFill samples 
in the Assigned Samples folder in the Tool Window if you like.

D To delete a sample in the All Self-contained Samples folder, select it and click the Delete button.

An alert appears asking you to confirm or cancel deletion.

! If you select a shortcut icon (in the Assigned Samples folder or Unassigned Samples folder) that points to a 
sample in the All Self-contained Samples folder, clicking the Delete button and confirming the deletion will 
permanently erase the original sample!
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Loading samples into a device
To load samples into a sampler device (NN-XT and Redrum) proceed as follows:
1. Click on a Browse Sample button on the device.

Browse Sample buttons on NN-XT and Redrum respectively

The Sample Browser window opens:

2. Click the Song Samples folder in the Locations and Favorites section to the left.
The Assigned Samples, Unassigned Samples and All Self-contained Samples folders appear in the Browse List.

3. Unfold desired folder(s) and select the sample you want to assign to your device.
You can select a sample in any of the folders. If you like to audition a sample, click the Play button in the Audition 
section of the window. To make samples automatically play upon selection, tick the Autoplay check box.



SAMPLING394

4. Click OK to load the selected sample into the device.
When the selected sample has been loaded into the device, the corresponding sample file icon in the Tool Window 
has been placed under the device’s icon in the Assigned Samples folder. If the loaded sample was originally in the 
Unassigned Samples folder, it has now been moved from this folder to the Assigned Samples folder.

Duplicating samples
If you want to use an existing sample as base for new edits, you can do this by first duplicating the existing sample 
and then performing the edits on the duplicate. It’s even possible to duplicate samples from the Factory Soundbank 
and from any existing ReFills! However, duplicated samples from the Factory Soundbank or from ReFills cannot be 
exported to disk as separate files but can only be saved as self-contained samples inside the song document.

To duplicate a sample, proceed as follows:
1. Select a desired sample in the Song Samples list in the Tool Window.



SAMPLING 395

2. Click the Duplicate button at the bottom of the Song Samples tab.
The duplicated sample appears - with its original name followed by the word “Copy” - in the All Self-contained 
Samples folder. A shortcut icon to the duplicated sample also appears in the Unassigned Samples folder:

To edit and/or rename the duplicated sample, refer to “Editing samples” and “Renaming samples”.

Exporting samples
If you like you can export samples that you have recorded in your song and save them as separate WAV or AIFF files 
to disk. Proceed as follows:
1. Select desired sample(s) in the Song Samples list in the Tool Window.

! Note that it is not possible to export samples that originate from the Factory Soundbank or from a ReFill.

2. Click the Export button at the bottom of the Song Samples tab.
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• If your sample(s) are not cropped, or use a Crossfade Loop, the Lossy Sample Export dialog appears:

The following options are available:

• Crop selected sample(s) and render Loop Crossfade
This item shows up if you have edited the Start and/or End Markers and use a Loop with Crossfades. The sample 
will be cropped at the Start and End Markers and the crossfaded loop will be rendered into the sample.

! This will make the sample sound exactly the same when you import it to a sample playback device/application, 
but the sample data has been changed compared to the original.

• Crop selected sample(s)
This item shows up instead of the above item if no Loop is used. The sample will be cropped at the Start and End 
Markers.

• Save raw sample(s)
The sample will be exported without Start or End Marker position data but with Loop data, if any. If the loop is 
crossfaded, the crossfade will be removed.

! This will make the sample sound differently when you import it to a sample playback device/application.

3. Click OK to proceed.
The “Export Sample as...” dialog appears;

4. Choose location for your sample file, type in desired name and choose WAV or AIFF file format.

5. Click Save to export the sample file to disk.
The sample is saved to disk using its original resolution (bit depth) and sample rate. The original self-contained 
sample in your song will remain intact.
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About self-contained samples
All samples you record in a song automatically become self-contained. Self-contained means that the samples are 
automatically stored within the song when you save it. A great advantage with this is that you never have to keep 
track of any “loose” custom samples you use in your song - they are always included in the song document.

All self-contained samples in a song can be viewed by unfolding the All Self-contained Samples folder on the Song 
Samples tab in the Tool Window:

Self-contained samples can also be loaded into any sampler device from the Sample Browser window:

The Sample Browser window opens when you click any of the Browse Sample buttons on a sampler device. See 
“Loading samples into a device” for more details.

Un-self-containing samples

There might be situations where you want to “un-self-contain” your own samples, i.e. export the samples to disk as 
separate files and at the same time remove them from the song document. This can be done by selecting “Song Self-
Contain Settings...” from the File menu - see “About Self-Contained Songs” for more details.
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Chapter 17
The ReGroove Mixer
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Introduction

The ReGroove Mixer combines all the benefits of quantization, shuffle, and groove templates into a single integrated 
environment, giving you real-time creative control over the feel and timing of individual note lanes. The ReGroove 
Mixer, which extends from the top of the Transport Panel puts 32 channels of interactive groove control at your fin-
gertips.

If you're familiar with mixing, you're already well on your way toward understanding the ReGroove Mixer. Think of it as 
a mixer with 32 busses but, instead of these busses modifying the volume of the input tracks, they modify the feel (or 
groove) of the input tracks. You can route any note lane to one of ReGroove's 32 channels, and that lane's feel and 
timing are modified, in real-time, by the channel's settings. Each ReGroove channel can use its own groove template 
or shuffle amount. In addition, each channel can slide notes forward or backward in time, allowing you to put certain 
tracks slightly ahead or behind the beat, which greatly alters the feel of your music.

! Note that ReGroove only works for notes on note lanes.

q It’s also possible to lock a control surface to control the ReGroove Mixer parameters via Remote - see “Lock-
ing a surface”.

ReGroove basics
When working with grooves, you'll make use of three interacting sections within Reason Essentials's interface:

• First, in the Sequencer, each note lane can be assigned to any of ReGroove's 32 channels. 
You assign a note lane to a groove channel by selecting it with the Select Groove pop-up in each note lane.

• Second is the ReGroove Mixer, which contains both global groove settings and channel-specific ones. 
This is described on the following pages.

• Finally, there's the Groove Settings section of the Tool Window, which is accessed by clicking a ReGroove 
channel's Edit button. 
Groove Settings allow you to set the intensity of various groove patch parameters. This is also where you save your 
own ReGroove patches. See “Groove Settings”.
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The ReGroove Mixer
D Open the ReGroove Mixer by clicking the ReGroove Mixer button to the right on the Transport Panel.

The ReGroove mixer is divided into two sections. On the left are the Global parameters, and on the right are the 
Channel parameters.

Global parameters

These parameters operate globally, rather than channel-by-channel.

Channel Banks

The ReGroove mixer consists of 32 channels, grouped into 4 banks (labeled A through D). Click a Channel Bank but-
ton to see and edit its corresponding bank of 8 channels.

Global parameters

Channel parameters
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Anchor Point

Normally, all groove patterns start at Bar 1 and repeat themselves throughout a song. For example, a 4-bar groove 
pattern will begin at Bar 1 and repeat its pattern every four bars. Many times, however, songs begin with blank mea-
sures, pickup measure or, perhaps, a short introduction. In these cases, you probably don't want the groove pattern to 
begin at Bar 1, but at some later bar. This is the purpose of the anchor point - it tells Reason Essentials at which mea-
sure it should begin applying the groove settings.

For example, assume you have a song with a 1-bar pickup. Because the song really begins on bar 2, that's where you 
want your groove to begin. Setting the anchor point to 2 insures that the groove patterns all begin at measure 2.

D Note: There is one exception to the rule that grooves start playing at their anchor point and repeat indefinitely 
throughout the song-and that's when they encounter a time-signature change. Grooves always restart at any 
measure containing a time signature change. 
You can use this knowledge if, for example, you have a song section with an odd number of bars-inserting a time 
signature change will force all your grooves to restart at that measure.

Global Shuffle

This knob adjusts Reason Essentials's global shuffle amount, and is used by any devices that employ patterns, such 
as Redrum's internal sequencer and the Matrix pattern sequencer. It also defines the shuffle value for any ReGroove 
channel for which the Global Shuffle option is activated.

Setting the Global Shuffle to a value of 50% results in a “straight” beat, with no swing applied. Setting the Global 
Shuffle to a value of 66% results in a perfect sixteenth-note triplet shuffle. Values between 50% and 66% have a 
less pronounced swing feel, and values greater than 66% are more exaggerated.

Channel parameters

These parameters operate on a per-channel basis. Each of ReGroove's 32 channels (arranged in 4 banks of eight) 
contains an identical set of parameters.

On button
Edit button

Channel number

Groove patch name

Groove patch browser button

Slide knob

Groove Amount slider

Shuffle knob

Pre-align button

Global Shuffle button
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On Button

This is an On/Bypass button for the channel. When the button is lit, the groove channel is active and any note lane 
assigned to this groove channel will be affected. When the button is not lit, the channel is disabled and any note lanes 
assigned to this groove channel will play back straight, without being “grooved.”

q This can be used for comparing the groove with the original, ungrooved beat. You can also do this for individ-
ual note lanes, by turning off the “Enabled” item on the Groove Select pop-up menu in the track list - see “Ap-
plying grooves to your music”.

Edit Button

Click this button to open Reason Essentials's floating Tool Window, and show the Groove tab, where you can view 
and edit additional “Groove Settings” for each channel.

Each ReGroove channel has its own groove settings, so clicking the Edit button in different channels will fill the Tool 
Window with groove settings specific to that channel.

Channel Number

This is a non-editable channel number label. Channels are numbered 1-8 and are grouped into 4 banks (A-D). Chan-
nel numbers are named accordingly. For example, A2 is the second channel in Bank A, and B5 is the fifth channel in 
Bank B.

Groove Patch Name

This shows the name of the groove patch currently loaded into the channel. If no groove patch is loaded, then no 
name appears. Click this area to bring up a list of the patches in the current folder, just as with patch displays on de-
vices in the Reason Essentials rack.

D To remove a groove patch assignment and reset the channel to its default values, right-click (Win) or [Ctrl]-
click (Mac) the Groove Patch name, or anywhere on the ReGroove panel background, and select “Initialize 
Channel” from the context menu.

Groove Patch Browser

This allows you to load groove patches and to step between them, just like device patches in the Reason Essentials 
rack. ReGroove patches have a .grov extension. See “ReGroove patches in the Reason Essentials Sound Bank”, later 
in this chapter, to learn more about the types of groove patches included with Reason Essentials.
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Slide

Use this knob to slide notes forward or backward in time. Musicians will frequently add energy and urgency to a track 
by “rushing” a particular beat or instrument a little. Similarly, they may “drag” a note a little in order to create a more 
laid back, shuffle-like feel. The Slide knob has a range of ±120 ticks, which allows you to slide notes up to a thirty-
second note in either direction. Setting negative values makes notes play earlier in time (rushing the feel). Setting 
positive values makes notes play later in time (lagging the feel).

For example, if you wanted to create a slightly “in the pocket” groove, you could create a snare lane and assign it to 
a ReGroove channel with a small amount of positive slide. This would delay the snare track slightly, giving your music 
a relaxed, laid back feel.

q If you have a track that you want to rush (set to a negative slide value), you should put an empty bar at the be-
ginning of your sequence, making sure to set the Anchor Point to “2” (see “Anchor Point”). This insures that 
any notes assigned to Bar 1/Beat 1 will indeed play ahead of the beat (since you created an empty measure 
into which the early note can shift).

Shuffle

At its most basic level, this knob adds a sixteenth note “swing” feel to the ReGroove channel. A value of 50% results 
in a straight (no shuffle) feel, and a value of 66% creates a perfect triplet feel.

You can also use this knob to “de-shuffle” a beat by dialing in values below 50%. For example, if you had a recording 
that was played with a perfect triplet feel, setting the Shuffle value to 34% will make the beat straight again!

With Slide set to +20 ticks, notes 
play back later in time.

With Slide set to 0 ticks, notes are 
not shifted in time.

With Slide set to –20 ticks, notes 
play back earlier in time.

Shuffle works by changing the start 
time of every other sixteenth note.

A shuffle value of 66% delays every 
other sixteenth note to create a 
perfect triplet feel.
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Groove Amount

Use this fader to adjust how intensely the selected groove patch will modify your notes. At 0%, the groove patch will 
have no effect. At 100%, the groove patch will have its maximum effect. Obviously, values between these extremes 
will produce some amount of groove effect, but less than maximum.

As discussed in “Groove Settings”, later in this chapter, several additional parameters are associated with groove 
patches and how they modify your notes. Specifically, the Groove Settings section of the Tool Window contains four 
“impact” settings (timing, velocity, note length, and randomness), and the Groove Amount fader acts like a “master” 
fader that scales these four parameters proportionally.

Pre-Align

Enabling this button causes any incoming notes to be quantized to a rigid, sixteenth note grid prior to having any ad-
ditional groove modifications applied to them. This quantization, which occurs in real time and is non-destructive, is an 
easy way to align all incoming notes to a “straight” grid, so that any shuffle, slide, or groove modifications have the ex-
pected effect on the notes.

Global Shuffle

Enabling this button causes the ReGroove channel to use the “Global Shuffle” setting, rather than the channel's own 
shuffle setting. The channel's Shuffle knob will have no effect when a channel uses global shuffle. Using global shuf-
fle is a good way to synchronize notes in a particular channel with those in pattern-based devices, such as Redrum’s 
internal sequencer and the Matrix pattern sequencer, all of which get their shuffle values from the Global Shuffle 
value.

A Groove Amount of 100% 
modifies notes using all 
groove settings at their 
specified amounts.

A Groove Amount of 50% 
modifies notes using all 
groove settings at only half 
their specified amounts.
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Copy, Paste and Initialize ReGroove channels
To copy one ReGroove channel configuration into another:
1. Decide which ReGroove channel you want to copy from, then right-click (Win) or [Ctrl]-click (Mac) on the 

Groove Patch Name (or anywhere else in that channel, except directly on a parameter).
A context menu appears.

2. Select “Copy Channel” from the context menu.

3. Right-click (Win) or [Ctrl]-click (Mac) on the destination channel's Groove Patch Name, then select “Paste 
Channel” from the context menu.
Reason Essentials copies all the ReGroove channel settings to this channel.

To initialize a ReGroove channel:
1. Right-click (Win) or [Ctrl]-click (Mac) on the Groove Patch Name (or anywhere else in that channel, except di-

rectly on a parameter) to open a context menu.

2. Select “Initialize Channel” from the context menu.
Reason Essentials resets all channel parameters to their default values.
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Groove Settings

A groove patch consists of a groove template, which contains timing and dynamics information extracted from a per-
formance, plus a collection of Impact parameters, which determine how strongly the groove patch applies the tem-
plate settings. This section discusses the settings on the Groove tab in the Tool window, which is where all the 
Groove Patch settings are viewed and edited.

Groove Channel

The Groove Settings display one mixer channel at a time. To select which ReGroove channel is currently displayed, 
select it from this pop-up (or click the Edit button for the channel in the ReGroove Mixer).

Groove Patch Name

This shows the name of the groove patch currently loaded into the channel. If no groove patch is loaded, then no 
name appears. Click this area to bring up a list of the patches in the current folder, just as with device patches in the 
Reason Essentials rack. This area duplicates the functionality of the Groove Patch Name area in each channel of the 
ReGroove Mixer.

Groove Patch Load/Save

These buttons allow you to load and/or save groove patches, just like device patches in the Reason Essentials rack. 
ReGroove patches have a .grov extension. To learn more about the types of groove patches included with Reason Es-
sentials, see “ReGroove patches in the Reason Essentials Sound Bank”.
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Groove Patch Length

This displays the groove's length, which is import for determining how often the groove repeats.

D In general, if you apply different groove patches to different note lanes, you'll want their lengths to be multi-
ples of one another. 
For example, if one ReGroove channel uses a 4-bar groove, you might want to use 4-bar grooves on other chan-
nels or, perhaps, a multiple (such as 1-bar, 2-bar, or 8-bar grooves). 
You can, of course, mix and match grooves with non-standard lengths, but you need to be aware of how these 
grooves will interact. For example, if one channel used a 3-bar groove and another used a 4-bar groove, the groove 
pattern would actually repeat every 12 bars (3-bars times 4-bars).

Groove Patch Time Signature

This displays the groove's time signature and should, in most cases, match the time signature of your sequence.

D In general, if you apply different groove patches to different note lanes, you'll want them to share a common 
time signature. 
You can, of course, mix and match time signatures to create polyrhythmic grooves, but you need to be aware of 
how these grooves interact. For example a 6/8 groove will shift notes in a radically different way than a 4/4 
groove, so applying them simultaneously may or may not sound the way you expect.

Timing Impact

This determines the extent to which timing information embedded in the groove template affects the position of your 
notes. A 50% setting means that notes are moved halfway to the positions defined in the groove template. 100% 
means they are moved exactly to the positions in the groove, and 200% means they are moved just as far past the 
groove template positions.

D This parameter works in conjunction with the ReGroove Mixer's Groove Amount fader, which can scale back 
the groove's timing impact. 
For example, if the Groove Amount fader is set to 100%, then notes are moved by the indicated Timing Impact 
amount, but if the Groove Amount fader is set to 50%, then notes are moved by only half the Timing Impact 
amount.

These are the original notes in your sequence.

These are note locations stored in a groove 
template. A Timing Impact = 100% moves your 
original notes to this location.

A Timing Impact = 50% moves your original notes 
only halfway to the template's note location.
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Velocity Impact

This determines the extent to which velocity information embedded in the groove template affects the velocity of your 
notes. Grooves modify only the relative differences between note velocities, not their absolute values. This way, soft 
passages remain soft and loud passages remain loud-the groove simply accents the notes differently. A 100% set-
ting means that the feel is more or less exactly transferred from the template to your music. Values below this mean 
that less of the groove's dynamics affect your notes, and values above 100% dramatically increase the dynamic ef-
fect of the groove patch.

D This parameter works in conjunction with the ReGroove Mixer's Groove Amount fader, which can scale back 
the groove's velocity impact. 
For example, if the Groove Amount fader is set to 100%, then velocities are modified by the indicated Velocity Im-
pact amount, but if the Groove Amount fader is set to 50%, then velocities are modified by only half the Velocity 
Impact amount.

Note Length Impact

This determines the extent to which note length information embedded in the groove template affects the length of 
your notes. This setting is not always relevant (such as with drum samples, which always play at their full length) and, 
consequently, most grooves in the Factory Sound Bank do not contain any length information (with the exception of 
the “Bass-Comp” category).

That said, when working with sustaining instruments, note length can have a dramatic impact on the performance's 
feel. Grooves modify only the relative differences between note lengths, not their absolute values. This way, legato or 
staccato passages retain some of their original intent when modified with a groove patch.

D This parameter works in conjunction with the ReGroove Mixer's Groove Amount fader, which can scale back 
the groove's note length impact. 
For example, if the Groove Amount fader is set to 100%, then note lengths are modified by the indicated Note 
Length Impact amount, but if the Groove Amount fader is set to 50%, then note lengths are modified by only half 
the Note Length Impact amount.

Random Timing

This determines the extent to which note positions are randomized. This value defines the maximum distance that a 
note can be randomly shifted (in either a positive or negative direction). You may set an amount between 0 ticks (no 
randomization occurs) and 120 ticks, which allows notes to shift as much as a thirty-second note in either direction.

The effect is “polyphonic,” meaning that any notes originally beginning at the same position will still be moved by dif-
ferent amounts. It is also “semi-deterministic,” meaning that if you play a clip several times, without editing anything, 
all notes will play back at exactly the same positions each time. However, as soon as you edit the clip in any way, all 
random positions are recalculated.

D This parameter works in conjunction with the ReGroove Mixer's Groove Amount fader, which can scale back 
the randomization. 
For example, if the Groove Amount fader is set to 100%, then notes are randomized by the indicated Random Tim-
ing amount, but if the Groove Amount fader is set to 50%, then notes are randomized by only half the Random 
Timing amount.

Get From Clip

This button converts the notes in a selected clip into a groove patch. The patch can then be used right away in the ac-
tive ReGroove Mixer Channel or saved to disk as a new groove patch. Clicking this button has the same effect as se-
lecting a clip and choosing “Get Groove From Clip” from the Edit (or context) menu. See “Creating your own 
ReGroove patches”.
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Working with grooves

Applying grooves to your music
Follow this example to learn basic ReGroove mixing techniques and hear the effect that various groove parameters 
have on your music.
1. If it's not already visible in either the Sequencer or Rack, open the ReGroove Mixer by clicking the ReGroove 

Mixer button to the right on the Transport Panel in the Sequencer.

2. Decide which note lane you are going to apply the groove to.
For the most obvious effect the track should contain a drumbeat based on straight (as opposed to shuffled) six-
teenth notes. A hi-hat lane, for example, might be a good source for experimentation.

3. Use the Groove Select pop-up on the chosen note lane to route those notes to a specific ReGroove mixer chan-
nel.

D The “Enabled” item at the top of the pop-up menu allows you to turn ReGroove off for individual note lanes.
This is useful for comparing with the original, ungrooved beat. If you want to do this for several note lanes set to a 
particular ReGroove channel, use the “On” button for the channel in the ReGroove mixer instead (see “On Button”).

D To turn ReGroove off for a note lane, select “No Channel”.

4. In the ReGroove Mixer, make sure the channel you are using is activated - the On button should be lit.

Groove Select pop-up
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5. To hear some of the different possibilities, start by turning up the channel's Shuffle knob while you play the se-
quence. 

The music on that note lane (and any other note lane assigned to the same ReGroove channel) will start playing 
with a shuffle feel.

6. Turn down Shuffle to its middle position (50%), and turn up the channel's Slide knob to hear its effect.

D Note that, because slide shifts all notes by the same amount, you won't hear the results unless you play the 
track in conjunction with another track whose notes are not being slid (or with Click activated in the se-
quencer).
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7. Turn the Slide knob back to its middle position (0 Ticks), then click the channel's Browse button and navigate 
to the ReGroove Patches folder in the Reason Essentials Sound Bank.

8. Open the Vinyl folder, select the first groove patch in the list and click Open to load the groove patch and close 
the browser.

9. Pull up the Groove Amount fader on the channel, to about 80%.

10.Click the Next Patch button to step through the groove patches in the folder and hear what they do to your mu-
sic.

11.On the ReGroove Mixer channel, click the Edit button to open that channel's groove settings in the floating 
Tool Window.

12.Move the various horizontal faders and listen for their effect.
Note that none of the patches in the Vinyl folder make use of Note Length, so the Note Length Impact will have 
no effect.

q There are all sorts of creative and useful ways to apply grooves to your music. See “Groovy tips & tricks”, later 
in this chapter, for some suggested techniques.
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Commit to Groove - making the grooves “permanent”
When you assign a ReGroove channel to a note lane, this will only affect how the notes play back. The notes will still 
be shown with their original, ungrooved positions if you open the note clip. 

If you want to edit grooved notes (e.g. adjust timing and velocity manually), it’s useful to first actually move the notes 
to the grooved positions, permanently. This is done with the “Commit to Groove” function:
1. Select the track with the grooved note lane(s).

2. Select “Commit to Groove” from the Edit menu or the track context menu.
All notes on all lanes on the track will be moved to their grooved positions, and the Groove Select pop-up will be 
reset to “No Channel”.

If you play back the track, it will sound exactly the same as before. If you look at the notes in Edit mode, their posi-
tions, length and velocity will now match what you hear.

Using Commit to Groove on some lanes only

“Commit to Groove” affects entire tracks, including all note lanes if there are several. If you only want to make the 
groove permanent for one of the lanes, here’s a workaround:
1. Click the Groove Select pop-up for the note lanes that should remain ReGrooved, and turn off “Enabled”.

This bypasses the ReGroove channel for those note lanes, but retains the channel selection.

2. Select “Commit to Groove”.
Only the note lanes with ReGroove Enabled will be affected.

3. Select “Enabled” again for the note lanes that should remain ReGrooved.
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Creating your own ReGroove patches
To create your own ReGroove Patch, proceed as follows.
1. Create a clip containing notes with the desired timing and dynamics (velocity).

Alternately, you could import a MIDI File with the desired effect, or use the “To Track” function on a Dr. Octo Rex 
device to extract the notes from a REX loop.

D Note that some MIDI clips will make better grooves than others. 
To learn some of the characteristics of a good groove-making clip, see “Tips for selecting the best Groove-Making 
Clips” below.

2. Select the clip.

3. In the Tool Window's Groove section, select an unused Groove Channel.

4. Click the “Get From Clip” button at the bottom of the Tool Window's Groove Settings tab.
Alternately, you could select “Get Groove From Clip” from the clip's context menu.

5. Set the various impact parameters as desired.
For a good starting point, you can simply leave them at their default settings.

6. Click the Save Patch button in the Tool Window's Groove section and specify a name and location.

Your ReGroove patch is now ready to use. As discussed in “Applying grooves to your music”, simply route one or 
more note lanes to the ReGroove channel assigned to your new groove, and pull up the Groove Amount fader on that 
channel.

Tips for selecting the best Groove-Making Clips

The following tips will help insure that your custom grooves work their best:

D Include as many sixteenths notes as possible in the source clip. 
If there are any sixteenth note gaps in your source material, there will be corresponding gaps in your groove patch. 
This means, when you apply the groove to a note lane, some notes will be grooved and some (those that fall in the 
gaps) will not.

D Grooves use the relative differences between note velocities, not their absolute values. 
If you don't want dramatic shifts in dynamics, avoid having widely varying velocities in your source clip.

D Groove patches are always an exact number of bars, so if your source clip has an uneven length, the groove 
will be extended to the next bar. 
We recommend that you adjust your source clip to an exact number of bars before creating a groove patch.

D In general, you should use source clips whose length is an even multiple of 2 (for example, 1-bar, 2-bars, 4-
bars, etc.)
You can create and use grooves that are an odd number in length (3, 7, 13, etc.), but unless you're well organized 
and plan to use these grooves in specific polyrhythmic pieces, their general effect on most tracks will be some-
what unpredictable.
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Groovy tips & tricks
• Because you can route each note lane to any of the 32 ReGroove channels, the key to creating really dynamic 

grooves is to spread your instrumentation across multiple note lanes. 
For instance, where you might normally create a Redrum sequence with kick, snare, and hi-hat all on the same 
track, putting these elements into different lanes will let you apply different grooves to them. For example, you 
might have a kick lane routed to a ReGroove channel with a slight shuffle feel, and you might send the snare to a 
ReGroove channel that slides the notes earlier in time to “push” the backbeat a little. Breaking things into lanes will 
definitely enable you to create beats that are more loaded with feel and personality than if you simply apply one 
groove setting to everything.

q See “Extract Notes to Lanes” for tips on how to automatically distribute notes from one note lane to several 
additional note lanes.

• When building a groove, start simple. Experiment with adjusting the slide parameter to move just the snare or 
hi-hat forward or backward in time. 
Try applying slightly different amounts of shuffle to different percussion instruments. Small changes can some-
times have a big visceral effect, so use your ears (and not your eyes) when adjusting the various groove settings.

• Try applying the same groove patch to multiple lanes, but by varying amounts. 
You are, of course, free to apply different groove patches to different lanes. Though, more often than not, your re-
sults might result in something that sounds more clumsy than groovy. The hottest grooves often have the most 
subtle of humanization.

• Don't forget to try sending sequenced REX files through the ReGroove mixer. 
Depending on the material in the file and how it's sliced up, this can create all types of results-ranging from unus-
able to downright inspiring.

• If you're doubling instruments - that is two instruments play the exact same part - try sending one of the instru-
ments to a ReGroove channel that has a small amount of random timing applied. 
Random timing (which is accessible in the Groove Settings section of the Tools Window) will put some separation 
between the two instruments, making their performance sound more human. For example, if you have a clap dou-
bling a snare, apply a little bit of random timing to the clap track, and it'll stand out more clearly in the mix.

• As described under the “Anchor Point” heading above, grooves restart whenever a new time signature ap-
pears.
You can use this knowledge to force a groove to restart, which might be required if your music contains sections 
of odd lengths. Simply add in a time signature event, with the same type of time signature as you already have in 
the song. The groove will restart where the event starts.

• Remember that groove patches have separate timing and velocity impacts and, as such, you can apply them in-
dependently. 
For example, if you already have a track that has just the right groove timing, but you want to experiment with dif-
ferent dynamic feels, you can apply just the velocity portion of a groove by setting its Timing Impact parameter to 
0. A groove's timing and velocity impact parameters can be accessed by clicking a ReGroove channel's Edit but-
ton, which opens the Groove Settings section of the Tools Window.



THE REGROOVE MIXER416

ReGroove patches in the Reason Essentials Sound 
Bank
Reason Essentials ships with a ready-made assortment of groove patches, arranged in a number of different folders:

MPC-60

These grooves were created by analyzing the audio output of an Akai MPC-60. Use these patches to get the same 
shuffle feeling as an original MPC-60. Note that these patches do not contain any velocity or note length information. 
There are some additional patches that use the Random Timing feature, which emulates the original MPC-60's be-
havior when loaded with a lot of information.

Vinyl

These grooves were created by sampling snippets from classic groove records, analyzing them with a special signal 
processing tool, then extracting both timing and velocity information from the samples. These grooves do not contain 
any note length information.

Programmed

These grooves were created by a session drum groove programmer. They were hand-crafted to emulate the feel of 
certain styles, and are divided into two genres: Hiphop and Pop-Rock. These grooves do not contain any note length 
information.

Bass-Comp, Drummer, and Percussion

Grooves in these categories were created by session musicians. Their performances were captured and analyzed, 
and the timing and velocity information was then extracted from the performances. The Bass-Comp patches also 
contain note length information, though the other categories do not.



Chapter 18
Remote - Playing and 
Controlling Devices
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About the various MIDI inputs
This chapter describes how you use Remote to set up your master keyboard and control surfaces, allowing you to 
play Reason Essentials devices, adjust parameters and control various Reason Essentials functions. This is the main 
way of sending MIDI to Reason Essentials, but there are also some additional methods:

D Using ReWire 2.
ReWire allows you to run Reason Essentials together with another application, such as a sequencer or another 
DAW. With ReWire 2, you can send MIDI from the other application directly to devices in Reason Essentials. See 
“Routing MIDI via ReWire 2”.

D Using the External Control Bus inputs.
The External Control Bus inputs (set up on the Preferences - Advanced tab and in the MIDI In device in the hard-
ware interface) let you send MIDI directly to the individual devices in the rack. This is mainly used if you control 
Reason Essentials from an external sequencer, etc. See “About the External Control Bus inputs”.

D Sending MIDI Clock to Reason Essentials.
This allows you to synchronize Reason Essentials’s tempo to other devices. See “Synchronization to MIDI Clock”.

About Remote
MIDI from control surfaces (keyboards, remote control units etc.) is handled by a protocol called Remote. The Remote 
protocol allows for seamless integration between Reason Essentials and control surface devices. It is basically a 
mapping system that provides direct hands-on control of parameters for each Reason Essentials device - including 
transport and sequencer track selection! 

At the time of this writing, Reason Essentials supports a large number of control surfaces and keyboards - the knobs, 
faders and buttons on the devices are automatically mapped to parameters on each Reason Essentials device. 

Remote drivers for more control surfaces will be added continuously. Check the Propellerhead web page in case your 
model isn’t listed on the Preferences - Control Surfaces tab.

Remote controlling Reason Essentials devices couldn’t be made any simpler. Set up your control surface once and 
for all for use with Reason Essentials - the program handles the rest!
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Setting up

Adding a control surface or keyboard
This is how you add your control surfaces - including the master keyboard.
1. Open the Preferences dialog and select the Control surfaces tab.

2. If your control surface is connected via USB (or if you have made a two-way MIDI connection), try clicking the 
Auto-detect Surfaces button.
Reason Essentials scans all MIDI ports and tries to identify the connected control surfaces. Note that not all con-
trol surfaces support auto-detection.

All found surfaces are listed in the Attached Surfaces list. 

3. To add a control surface manually, click the Add button.
This brings up a new dialog.

4. Select the manufacturer of your control surface from the Manufacturer pop-up menu.
If you can’t find it on the menu, see below.

5. Select the model of your control surface from the Model pop-up menu.
If you can’t find it on the menu, see below.
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6. An image of the selected control surface model is shown, often along with some information text - read this 
carefully.
For some control surfaces, you need to select a specific preset to use the surface with Reason Essentials - this is 
noted here.

7. Use the MIDI Input pop-up to select the input port to which you have connected the surface.
If in doubt, you can click the Find button and then tweak a control or play a key on the control surface to have Rea-
son Essentials find the correct input port for you.

D Some control surfaces may have more than one MIDI Input pop-up menu.
You need to select ports on all MIDI Input pop-up menus.

D Some control surfaces will have a MIDI Output pop-up menu.
In some cases this labeled “Optional” - then you don’t have to make a selection. In other cases, a MIDI Output is re-
quired. This is the case if the control surface uses MIDI feedback - motor fader, displays, etc. See the separate 
“Control Surface Details” pdf document for details.

D Reason Essentials only “grabs” the MIDI inputs you are actually using. 
MIDI inputs not selected here or on the Advanced MIDI page (see “Advanced MIDI - The External Control Bus in-
puts”) are available to other programs.

D Note that other MIDI programs may “grab” all MIDI ports in your system when you launch them!

8. If you like, you can rename your control surface in the Name field.

9. Click OK to add the surface.

D Depending on the surface model, alerts may appear, reminding you to select a specific preset etc.
In some cases, Reason Essentials can restore a preset in the control surface to factory settings for you. In such 
cases you will be informed about this.

Finally you return to the Control Surfaces and Keyboards Preferences page, where your added surface is now listed.

If your control surface model isn’t listed

If you can’t find your control surface listed on the Manufacturer or Model pop-up menus when you try to add it, this 
means that there’s no native support for that model. However, the program supports generic keyboards and control-
lers. Here’s what to do:

D Select “Other” on the Manufacturer pop-up menu and then one of the three options on the Model pop-up 
menu.

or, if the Manufacturer is listed but not your specific model:

D Select one of the three “Other” options on the Model pop-up menu:

In both cases, the options are:
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• Basic MIDI Keyboard
Select this is you have a MIDI keyboard without programmable knobs, buttons or faders. This is used for playing 
only (including performance controllers such as pitch bend, mod wheel, etc.) - you cannot adjust Reason Essen-
tials device parameters with this type of control surface.

• MIDI Controller
Select this if you have a MIDI controller with programmable knobs, buttons or faders (but without keyboard). 
You need to set up your control surface so that the controllers send the correct MIDI CC messages, depending on 
which Reason Essentials device you want to control - check out the MIDI Implementation Chart in the Reason Es-
sentials Documentation folder. If your control surface has templates or presets for Reason devices, these can be 
used if you run Reason Essentials+Reason.

• MIDI Keyboard with Controls
Select this is you have a MIDI keyboard with programmable knobs, buttons or faders. Again, you need to set your 
controllers to send the right MIDI CCs.

After selecting a model, proceed with selecting MIDI input port as described above.

About the Master Keyboard

One of the control surfaces can be the Master Keyboard. This is like any other control surface, but it must have a key-
board and it cannot be locked to a specific Reason Essentials device (in other words, it always follows the MIDI input 
to the sequencer). This is the surface you use to play the instrument devices in Reason Essentials.

D The first surface with a keyboard that is added (or found by auto-detect) is automatically selected to be the 
master keyboard.
This is shown in the Attached Surfaces list on the Preferences page.

D If you want to use another surface as master keyboard, select it in the list and click the “Make Master Key-
board” button.
You can only have one surface as master keyboard at a time.

D If you don’t want to use any master keyboard at all, select the current master keyboard surface and click the 
same button (which is now labeled “Use No Master Keyboard”).

Other functions
D To edit a surface, double click it in the list (or select it and click Edit).

This lets you change its name and MIDI port settings, if needed.

D To delete a surface, select it in the list and click Delete.

D You can turn off a surface by deactivating its “Use with Reason Essentials” checkbox.
This could be useful if the surface is connected to your system but you only want to use it with another program.

There is also an “Advanced MIDI” page in the Preferences. This is only used for External Control MIDI buses and for 
MIDI Clock Sync input. All hands-on MIDI control is set up on the Keyboards and Control Surfaces page.

Example Setups
There are several possible variables when it comes to what type of setup you are using. Please read on.

A single MIDI keyboard with controls

With this setup, the keyboard is your master keyboard, which means it is always routed via the sequencer (it controls 
the device connected to the sequencer track with Master Keyboard Input). To control another device, you move the 
Master Keyboard Input (the keyboard symbol in the In column in the track list) to another sequencer track.

You can, however, use Remote Override to control parameters on other Reason Essentials devices (or global Reason 
Essentials functions such as transport).
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A basic MIDI keyboard and an additional control surface

The keyboard and the control surface should be connected to separate MIDI ports (or use separate USB connec-
tions). Here, the basic MIDI keyboard is your master keyboard - it is used for playing and recording via the sequencer. 
You can have the control surface follow the master keyboard - this lets you tweak the parameters of the device you 
are playing (just like in the example above). 

You can also lock the control surface to another device in the rack - this lets you play one device while adjusting the 
parameters of another.

A MIDI keyboard with controls plus one or more control surfaces

This is the ideal setup! Again, all keyboards and control surfaces should be connected to separate MIDI ports (or use 
separate USB connections). The master keyboard is routed via the sequencer track and you can use its controls to 
tweak the parameters of the device you are playing. The additional control surfaces could be locked to the Main 
Mixer or to different devices in the rack.

If you have additional MIDI keyboards locked to devices in the rack, you can also play and record on their correspond-
ing sequencer tracks simultaneously. This is perfect if your band has several keyboard players who want to play and 
record their tracks simultaneously into Reason Essentials!

For example, if you lock a control surface to the Main Mixer, you will always have control over levels, pans and addi-
tional channel strip parameters - see “Remote controlling the Main Mixer” and “Remote controlling multiple mixer 
channels”. You could also have dedicated controls for transport, Undo/Redo, sequencer track MIDI focus selection, 
etc.

Remote basics
Parameters and functions for each Reason Essentials device are mapped to controls on supported control surface 
devices. As soon as you have added your control surface(s) in the Preferences, you can start tweaking parameters!

• By default, all connected control surfaces follow the sequencer’s current Master Keyboard Input.
This means that you set Master Keyboard Input to a track in the sequencer to route the control surface(s) to the 
track’s device in the rack. You can bypass this functionality by locking a control surface to a specific device - see 
“Locking a surface to a device”. Or you can simply use Remote Override mapping (see “Remote Override” for spe-
cific parameters - these will then be mapped to the selected controls regardless of Master Keyboard Input.

• The Reason Essentials device associated with the track with Master Keyboard Input will have its parameters 
standard mapped to logical controls (faders, buttons etc.) on the control surface device.
E.g. if a Subtractor has Master Keyboard Input, your control surface will control the most important Subtractor pa-
rameters. If you set Master Keyboard Input to a track connected to an NN-XT, the control surface will now control 
parameters on the NN-XT device, and so on for each device. There are standard mapping variations for most de-
vices as well - see “About mapping variations”.

! Please refer to the separate “Control Surface Details” pdf document for device related information.

• Supported control surfaces with dedicated transport controls will be standard mapped to the equivalent trans-
port controls in Reason Essentials.
If you do not have transport controls on your control surface you can still map transport controls to controllers us-
ing Remote Override mapping - see “Remote Override mapping”.

• Other important functions such as switching target track in the sequencer, selecting patches, Undo/Redo can 
also be remote controlled.
See “Additional Remote Overrides...”.
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About Standard vs Remote Override mapping
Reason Essentials parameters are “standard-mapped” to supported control surface devices. There is nothing the 
user needs to set up to remote control any Reason Essentials device. You can, however, use Remote Override map-
ping to map a specific parameter to a specific control if you should want to.

D By using standard mapping, the remote mapping for each device will be the same for any new song created in 
Reason Essentials, given you have the same set of control surfaces connected.
If you use Remote Override mapping (see “Remote Override”), the overrides will be saved with the current song, 
but won’t be there if you create a new song. 

D Which parameters and functions that are standard mapped for each Reason Essentials device depends on the 
control surface(s).

The “Control Surface Details” document contains some information about the standard mappings of the different 
control surface models. But you can also activate Remote Override Edit mode to see which parameters for each de-
vice are mapped to your control surface(s) - see “Remote Override”.

D Note that if you have several control surfaces connected, some parameters could be mapped to controls on 
more than one control surface.
This is not a conflict of any kind, but simply a consequence that stems from the fact that all control surfaces by de-
fault follow Master Keyboard Input. By using Surface Locking (see below) or Remote Override (see “Remote Over-
ride”) you have full control over your control surfaces.

About mapping variations
Since there are often more parameters on a device than there are controls on the control surface, there are standard 
mapping variations available for most devices. When selecting a standard mapping variation, a new set of parameters 
will be mapped to the controls on your control surface for a selected Reason Essentials device. 

For example, if you have a control surface with 8 rotary knobs routed to a Subtractor, the knobs may control filter pa-
rameters by default. Selecting variation 2 may make the knobs control the oscillator settings, variation 3 may control 
LFOs and so on.

D For devices that support keyboard shortcuts, you switch between mapping variations by holding down [Ctrl]+ 
[Alt](Win) or [Cmd]+[Option](Mac) and press the numerical keys [1] to [10] (not the numerical keypad), where 
[1] selects the default standard mapping.
How many mapping variations are available depends on the control surface and the Reason Essentials device se-
lected. The variation selected will stay active until you switch MIDI input to another device (or select another varia-
tion). If you switch back to the same device it will have its default standard mapping (variation [1]).

D For control surfaces that have dedicated controls for selecting mapping variations these are used instead of 
keyboard shortcuts.

D Locked devices (see “Locking a surface to a device”) can also be locked to a specific mapping variation.
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Locking a surface to a device
You can lock a control surface or an additional MIDI keyboard/controller to a specific device so that it is always 
“tweakable” and record enabled, regardless of which track has Master Keyboard input in the sequencer. This enables 
you to play and record notes for several devices simultaneously from multiple control surfaces/keyboards.

For example, you could lock a control surface to control the Main Mixer, so you can always control overall levels while 
playing/tweaking other devices. See “Remote controlling the Main Mixer” for an example.

• The master keyboard device cannot be locked!
If you select the master keyboard in the Preferences, you can click the “Use No Master Keyboard” button. You can 
then lock this control surface to a device and use its controllers to tweak parameters, but you will not be able to 
play the device.

• You can lock several control surfaces to the same device.
However, each control surface can only be locked to one device at a time.

• Info about which devices are locked (and to which control surfaces) is saved with the song.

Locking a surface
There are basically two methods you can use to lock a Surface:

Using the Surface Locking dialog

1. Select “Surface Locking...” from the Options menu.
The Surface Locking dialog opens. 

In this picture, the dialog has the master keyboard as the selected control surface - this cannot be locked. 
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2. Pull down the Surface pop-up from at the top of the dialog and select the control surface you wish to lock to a 
device.

3. Next, open the “Lock to device” pop-up menu.
On this pop-up, all devices in the current song are listed. The “Follow Master Keyboard” item which is selected by 
default, means that the control surface isn’t locked (it instead follows the Master Keyboard Input in the sequencer).

4. Select the device you wish to lock to the selected control surface from the list.

D If the selected control surface supports keyboard shortcuts for selecting mapping variations (see “About map-
ping variations”) an additional “Always use Mapping” pop-up appears.
On this pop-up you can set whether you wish to lock a specific standard mapping variation or whether the device 
should switch mapping variations according to keyboard shortcuts. If the former is the case, select the mapping 
variation from the list. If the latter is the case, select “Follow Keyboard Shortcut”.

5. Close the dialog when you are done.
The device is now locked to the selected control surface. In Remote Override Edit mode (see “Activating Remote 
Override Edit mode”) a locked device is shown with a lock symbol in the upper left corner of the device panel.

q It’s also possible to lock a control surface to the ReGroove Mixer (see “The ReGroove Mixer”) to control its pa-
rameters via Remote!
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Using the context menu

D A quick way to lock devices is by right-clicking (Win) or [Ctrl]-clicking (Mac) on a device panel to bring up the 
context menu.
On the context menu, all installed control surfaces (apart from the master keyboard) are listed with the text “Lock 
to” plus the name of the control surface. Selecting one will lock the device to the control surface. On the context 
menu the control surface that is currently locked to this device will be ticked.

Unlocking a surface
D To unlock a locked device, bring up the context menu for the locked device, and untick the “Lock to” item.’

This unlocks the device and the control surface will now follow master keyboard input.

D Another way to unlock a surface is to open the Surface Locking dialog and selecting “Follow Master Key-
board” on the Lock to device pop-up.
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Remote Override
Remote Override allows you to map parameters and functions to controls on your control surface device, overriding 
the standard mapping.

Activating Remote Override Edit mode
1. Select “Remote Override Edit Mode” from the Options menu.

All unselected devices in the rack are grayed out, indicating Edit mode. Each selected device (including the Trans-
port panel) will show a blue arrow symbol on every parameter that can be mapped to a control on a control surface.

Remote Override Edit mode enabled with the mixer device selected

To be able to see which parameters are currently mapped for a device, you have to direct Master Keyboard input to 
the sequencer track it is connected to:

2. Select a device in the rack and enable Master Keyboard input for its sequencer track.
Standard-mapped parameters are tagged with yellow knob symbols.

A Subtractor with standard-mapped parameters
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D Note that you can select the Transport Panel as well!
Most items on the Transport panel can be mapped to controls. Note that by selecting the Transport panel any 
standard mapping will be shown automatically, unlike other devices where you have to first direct Master Keyboard 
input to the device from the sequencer.

D If you point on a standard mapped parameter, a tooltip appears showing which control on the control surface 
device the parameter is mapped to.

Remote Override mapping
If Remote Override Edit Mode is enabled you can use the following methods to map a parameter to a control:

Method 1:

1. Select the parameter you wish to map.
The arrow (or knob) changes to orange, indicating it is selected.

2. Select “Edit Remote Override Mapping...” from the Edit menu.
You can also right-click (Win) or [Ctrl]-click (Mac) on the parameter to select the same item from the context 
menu.

The “Edit Remote Override Mapping” dialog opens. From here you have two ways to proceed:

D Either manually select the control surface and the control you wish to map the parameter to from the two cor-
responding pop-ups.
The Control Surface pop-up lists all installed control surface devices, and the Controls pop-up lists all the mappa-
ble controls for the selected control surface.

D Or you can activate “Learn From Control Surface Input” and simply move (or press) the control you want to 
map the parameter to.
The “Control Surface Activity” field momentarily flickers as you turn the knob, and then the dialog shows the con-
trol surface and control it is mapped to.

D If the control surface has a keyboard, you can also select keys as controls.
Keys work just like on/off buttons. If “Keyboard” is selected from the Controls pop-up, a Note Number field ap-
pears in the dialog.
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3. Click OK to exit the dialog.
The mapped parameter now shows a lightning bolt icon, indicating it uses Remote Override mapping. Any over-
rides are always shown in Remote Override Edit mode. The device does not have to be selected or have Master 
Keyboard Input in the sequencer.

4. To exit Remote Override Edit Mode, deselect it from the Options menu.
You can also leave this mode by pressing [Esc].

Method 2:

1. Double-click the parameter you wish to map.
A rotating lightning bolt appears for the parameter - this indicates that “Learn From Control Surface” mode is ac-
tive. You can leave this mode by pressing [Esc].

2. Now move (or press) the control you want to map the parameter to.
The parameter is now mapped to the control. 

You do not always have to edit override mapping when Remote Override Edit mode is activated - see below.

Override mapping with Remote Override Edit mode deactivated

If Remote Override Edit Mode is enabled on the Options menu, mapped parameters are “tagged”, and the arrow indi-
cators show the assignable parameters. In this mode, however, you cannot operate Reason Essentials normally. Re-
mote Override Edit mode is primarily for overview of available parameters and the current assignments.

D Another way to map parameters is to have “Remote Override Edit Mode” deactivated on the Options menu, 
and to simply right-click (PC) or [Ctrl]-click (Mac) on the parameter you wish to remote control.
This opens a pop-up menu, where one of the options will be “Edit Remote Override Mapping”. Selecting this will 
open the Edit Remote Override Mapping dialog. Thus, you do not have to select Edit mode from the Options menu 
if you already know that a parameter is free and assignable.
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Removing Remote Overrides

This can be done for a selected parameter in the following way:
1. In Remote Override Edit Mode, select the parameter you wish to remove Remote Override for.

The lightning bolt changes to orange, indicating it is selected.

2. Select “Clear Remote Override Mapping...” from the Edit menu.
You can also right-click (Win) or [Ctrl]-click (Mac) on the parameter to select the same item from the context 
menu. This is always available, regardless whether Remote Override Edit mode is selected or not.

Or you can remove all Remote Overrides for a device in one go:
1. Select the device you wish to remove Remote Override for.

2. Select “Clear All Remote Override Mappings for Device” from the Edit menu.
You can also right-click (Win) or [Ctrl]-click (Mac) on the device panel to select the same item from the context 
menu.

Copying/Pasting Remote Overrides

You can copy Remote Override mappings for a device and paste them into a device of the same type. This works as 
follows:
1. With Remote Override Edit mode activated, select the device you want copy Remote Override mappings from, 

and the select “Copy Remote Override Mappings” from the Edit menu.
You can also right-click (Win) or [Ctrl]-click (Mac) on the device panel to select the same item from the context 
menu.

2. Select the device you wish to paste the copied mappings to.
It has to be the same type of device you copied from. In case you copied Remote Override mappings from the 
Transport panel you can thus only paste the mappings into another song document.

3. Select “Paste Remote Override Mappings” from the Edit menu.

Now the following happens:

D If you are pasting in the mappings into a device in the same song document, a dialog appears informing that 
the overrides are already used.
You then have the choice of cancelling the operation, or to move the existing overrides to the new device.

D If you are pasting into a device in another song, the copied Remote Override mappings are simply pasted.
In this case, the original Remote Override mappings are not affected.
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Additional Remote Overrides...

On the Options menu there is an item named “Additional Remote Overrides...”. Selecting this opens a dialog with re-
mote functions that cannot be assigned using Remote Override Edit mode, such as switching target tracks, Undo/
Redo etc.

Although most of the items in this dialog are self-explanatory, some need to be described. These are as follows:

Target Track Delta and Target Previous/Next Track 

D Target track is the track with Master Keyboard Input.
Assigning Target Previous/Next Track to two Button controls on a control surface allows you to move the Master 
Keyboard Input symbol up or down in the Track list.

D Target Track Delta is meant to be used with Delta wheel controllers (a special control with no min/max range) 
to switch target track.
A Mackie Jog wheel is an example of this type of controller. 

D Select Previous/Next Track can be assigned to standard button controls.

Select Patch for Target Device and Select Previous/Next Patch for Target Device

The target device is the device connected to the target track. 

D Patch selection is usually standard-mapped to buttons on a control surface. 
If you wish to override this standard patch selection mapping for devices globally to select patches for any patch 
device that currently has Master Keyboard Input, you can assign this here.

For example, you may always want to use the same buttons on a specific control surface for selecting patches.

D Select Patch for Target Device is also meant to be assigned to a Delta-type control (see above). 
This allows you to select patches for a device connected to the target track by spinning the wheel clockwise or 
anti-clockwise.

D Select Previous/Next Patch can be assigned to standard button controls.
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Select Keyboard Shortcut Variation (Delta)/Select Previous/Next Keyboard Shortcut 
Variation

By mapping controls to these, you can use your control surface to change which keyboard shortcut variation is se-
lected in Reason Essentials.

• The "Select Previous/Next” functions are typically mapped to buttons, allowing you to step between keyboard 
shortcut variations.

• The Delta function must be mapped to a delta-type control to work.

• The keyboard shortcut variation selection is a global setting in Reason Essentials. It affects all added control 
surfaces (if they make use of keyboard shortcut variations and aren't locked to a specific device and variation 
in the Surface Locking dialog).

Undo/Redo

You can assign Undo/Redo to controls. This works just like the corresponding items on the Edit menu.

Document Name

This allows you show the name of the song in the display of the control surface. This only works for control surfaces 
that support this feature.

Assigning Additional Overrides
Assigning overrides in this dialog is similar to assigning standard Remote Overrides:
1. Select a function/parameter in the list that you wish to assign to a control and click “Edit”.

This opens the Edit Remote Override Mapping dialog, where you can assign a control to the selected function/pa-
rameter. You can also simply double click the item in the list to open this dialog.

2. Click OK to close the dialog.

Clearing Additional Overrides

1. Select “Additional Remote Overrides” from the Options menu.
In the Mapping column you can see which parameters/functions use overrides.

2. Select the item currently assigned override mapping, and click “Clear”.



REMOTE - PLAYING AND CONTROLLING DEVICES 433

Keyboard Control
Assigning computer keyboard remote commands does not involve MIDI, so there is no special setting up required. 
Keyboard commands can be assigned to parameters just as when using Remote Override mapping, but the function-
ality differs in one central aspect:

• Keyboard Control commands can only be used to toggle on/off or min/max values for an assigned parameter.

Hence, if you assign a computer keyboard remote command for a knob, slider or spin control, it will only switch be-
tween the minimum and maximum values for that parameter. The only exception to this are the multi-selector buttons 
used for various parameters such as envelope destination, for example. These will cycle through the available options 
when using keyboard control.

! Note that Keyboard Control cannot be used for the ReGroove Mixer parameters.

Enabling Keyboard Control
To enable Keyboard Control, select “Enable Keyboard Control” from the Options menu.

Editing Keyboard Control
D To get an overview of which parameters are remote controllable select “Keyboard Control Edit Mode” from the 

Options menu. 
When done, each device you select in the rack will show a yellow arrow symbol beside every parameter that can be 
assigned a keyboard control.

A section of a Redrum drum machine with Keyboard Control Edit Mode enabled.

! The Main Mixer channel strip parameters can also be controlled using the Keyboard Control function, but there 
is no Edit Mode for this. Instead, you have to right-click (Win) or [Ctrl]-click (Mac) on individual channel strip 
parameters and select “Edit Keyboard Control Mapping” from the context menu.
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D If you click on an assignable parameter to select it, you can then select “Edit Keyboard Control Mapping” from 
the Edit menu.
This opens a dialog allowing you to select a key command for that parameter.

You may use any key except the [Space bar], [Tab], [Enter], the Numeric keypad keys (which is reserved for Trans-
port functions) and the function keys (except [F2] and [F3]) - or a combination of [Shift] + any key (with the same 
aforementioned exceptions).

The Keyboard Control dialog.

D Simply press the key (or Shift-key combination) you wish to use to remote control the parameter.
The “Key Received” field momentarily indicates that it is “learning” the keystroke(s), and then the dialog displays 
the name of the key you have pressed. If [Shift] was used, the box beside the word Shift in the dialog is ticked. 

You can also double-click on the arrow for an assignable parameter to set up keyboard control:

D A rotating yellow rectangle appears, indicating Learn mode. Press the key (or key combination) you wish to 
use to control the parameter.
The rotating stops and the rectangle will now display the key or key combination you used.

About the two Edit Keyboard Control Modes

If Keyboard Control Edit Mode is enabled (ticked) on the Options menu, assigned parameters in the rack are 
“tagged”, showing the remote key for that parameter. In this mode, however, you cannot operate Reason Essentials 
normally. This mode is primarily for overview of available parameters and the current assignments.

D Another way to assign keyboard remote commands is to have “Keyboard Control Edit Mode” deselected on 
the Options menu, and to simply right-click (Win) or [Ctrl]-click (Mac) the parameter you wish to remote con-
trol.
This opens a pop-up menu, where one of the options will be “Edit Keyboard Control Mapping”. Selecting this opens 
the Keyboard Control dialog. Thus, you do not have to enable/disable Edit mode from the Options menu if you 
know that a parameter is assignable.

! This is the only way Main Mixer channel strip parameters can be assigned to Keyboard Control.

Saving Remote Setups
There’s no need to save MIDI Remote mapping as the Standard Remote mapping for each Reason Essentials device 
to supported control surfaces is built-in, and is always available. You may, however, wish to save specific Remote 
Override mappings or Keyboard Control setups as a template:

D This could be done by saving a song document containing all the devices that are affected by the related Key 
or Remote Override mappings, but without any sequencer data. 
This song document could then be used as a starting point for any new song, by simply loading it, and immediately 
using “Save As” to save it under a new name.

q A good idea could be to save these types of “Remote Template” songs in the Template Songs folder. See 
“Making a Song appear as a Template Song” for info on how to do this.



Chapter 19
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About this chapter
This chapter describes how to use Reason Essentials as a ReWire slave; that is with Reason Essentials delivering au-
dio to another ReWire compatible application.

Why use Reason Essentials with ReWire?
While Reason Essentials is a complete music tool in its own right, you might want to add other elements to the music, 
such as:

• Software synthesizers (Plug-ins controlled via MIDI).

• Hardware synthesizers (controlled via MIDI).

Connecting Reason Essentials to another application allows you to integrate your Reason Essentials songs with 
other type of music and recordings, external MIDI instruments etc. By recording Reason Essentials tracks onto audio 
tracks in another audio sequencer, you can also continue processing your Reason Essentials tracks with other soft-
ware plug-ins and/or external effects.

Introducing ReWire!
To make this integration between two audio programs possible, Propellerhead Software has developed ReWire. This 
technology provides the following possibilities and features:

In ReWire version 1
• Real time streaming of separate audio channels, at full bandwidth, into another audio program.

• Automatic, sample accurate, synchronization between the audio in the two programs.

• The possibility to have the two programs share one audio card.

• Linked transport controls that allows you to play, rewind etc., from either program.

• Less total system requirements than when using the programs together in the conventional way.

In ReWire 2
A number of features were added in ReWire version 2. The following are the most important:

• Up to 256 audio channels (previously 64).

• Bi-directional MIDI communication of up to 4080 MIDI channels (255 devices with 16 channels each)

• Automatic querying and linking features that (among other things) allow a host to display the slave’s devices, 
controllers, drum sounds etc. by name.

How does it work?
Basically the key to ReWire is the fact that Reason Essentials is divided into three components:

• The Reason Essentials application.

• The Reason Essentials Engine (a DLL on the PC and a Shared Library file on the Macintosh. Both located in the 
Reason Essentials program folder.)

• ReWire (also a DLL on the PC and a Shared Library on the Macintosh).
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ReWire and the Reason Essentials Engine are common resources to the two programs (the other application and 
Reason Essentials) that generate the audio and passes it onto the other audio application.

Terminology
In this text we refer to Reason Essentials as a ReWire slave and the application receiving audio from Reason Essen-
tials (this could be Steinberg Cubase, Apple Logic Audio or MOTU Digital Performer, for example) as the host appli-
cation.

About system requirements
To run Reason Essentials together with another audio application of course raises the demands on computing power. 
However, adding ReWire to the equation does not in itself require a more powerful computer. On the contrary, it is 
likely that ReWiring two programs requires less power than, for example, running them with one audio card each.

Still, you should be aware that running two powerful audio applications on one computer will require a fast processor 
and most of all a healthy amount of RAM.

About synchronization
All synchronization to other equipment is handled from the host application - not in Reason Essentials. In fact there 
are no special synchronization issues. All that is said in the host application’s documentation about synchronizing au-
dio channels is true for ReWire channels as well.

For information about MIDI Clock synchronization - without using ReWire - refer to “Synchronization to MIDI Clock”.

Launching and quitting applications
When using ReWire, the launch and quit order is very important:

Launching for normal use with ReWire

1. First launch the host application.

2. Then launch Reason Essentials.

Quitting a ReWire session

When you are finished, you also need to quit the applications in a special order:
1. First quit Reason Essentials.

2. Then quit the host application.

Launching the host application for use without Reason Essentials/ReWire

If you don’t plan to run Reason Essentials, just launch the host application as usual. We recommend that you then 
also deactivate all ReWire channels if required (see the relevant section for your program, below). But this is not com-
pletely critical; ReWire does not use up very much processing power when it isn’t used.

Launching Reason Essentials for use without the host application

If you want to use Reason Essentials as is, without ReWire, just launch it as you normally do.
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Launching both programs without using ReWire

We don’t know exactly why you would want to run Reason Essentials and a Rewire host application at the same time 
on the same computer, without using ReWire, but you can:
1. First launch Reason Essentials.

2. Then launch the host application.

You may get a warning message in the host application, regarding ReWire, but you can safely ignore it. Please also 
note that the two programs now compete for system resources such as audio cards, just as when running either with 
other, non-ReWire, audio applications.

Using the Transport and Tempo controls
Basic Transport controls

When you run ReWire, the transports in the two programs are completely linked. It doesn’t matter in which program 
you Play, Stop, Fast Forward or Rewind. Recording, however, is still completely separate in the two applications.

! When you run Reason Essentials as a ReWire slave, it’s not possible to record on audio tracks in Reason Es-
sentials.

Loop settings

The Loop in Reason Essentials and the corresponding feature (Loop, Cycle etc.) in the host application are also 
linked. This means that you can move the start and end point for the Loop/Cycle or turn the Loop/Cycle on/off in ei-
ther program, and this will be reflected in the other.

Tempo settings

As far as tempo goes, the host application is always the Master. This means that both program will run in the tempo 
set in the host application. However, if you are not using automated tempo changes in the host application, you can 
adjust the tempo on the transport in either program, and this will immediately be reflected in the other application.

! If you are using automated tempo changes in the host application, do not adjust the tempo on the Reason Es-
sentials Transport Panel, since that tempo the doesn’t have any effect on playback!

! If you are using automated tempo changes in the host application, or change the Tempo in the host applica-
tion, Reason Essentials will not use high-quality stretching of audio tracks!

Routing audio

Preparations in Reason Essentials
When you route audio from Reason Essentials to a ReWire host application, you make use of the Reason Essentials 
Hardware Interface at the top of the rack. Basically, each output in the Hardware Interface is connected to a separate 
ReWire channel.
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• To take full advantage of the mixing features in the host application you need to connect the different Reason 
Essentials Mix Channel and/or Audio Track devices directly to the Hardware Interface (see “Using the Mix 
Channel and Audio Track devices’ Direct Outs”).
For example, if your Reason Essentials Song contains eight different instrument devices and you connect these, 
either directly or via their Mix Channel devices, to separate audio outputs on the Hardware Interface, they will ap-
pear on separate ReWire channels in the host application. You can then use the mixing facilities in the host appli-
cation to adjust volume and pan, add effects and equalizing etc. - individually for each Reason Essentials device.

If you instead connect all your Reason Essentials devices via the Main Mixer to the stereo input pair on the Hard-
ware Interface, all sounds will appear mixed on a single ReWire stereo channel pair. While this works perfectly fine, 
you won’t be able to mix and process the devices separately in the host application.

Routing in the ReWire host application
The following description is based on using Reason Essentials with Cubase as the host application. For descriptions 
on how to activate and route ReWire channels in other host applications, please go to www.propellerheads.se/rewire-
help.
1. Pull down the Devices menu in Cubase and select the menu item with the name of the ReWire application (in 

this case Reason Essentials). All recognized ReWire compatible applications will be available on the Devices 
menu.
The ReWire panel appears. This consists of a number of rows, one for each available ReWire channel.

2. Click on the green buttons in the “Active” column to activate/deactivate the desired channels.
The buttons light up to indicate activated channels. How many and what channels you need to activate depends on 
to which Hardware Interface inputs you have connected your Reason Essentials devices, as discussed above.

3. If desired, double click on the labels in the right column, and type in another name.
These labels will be used in the Cubase Mixer to identify the ReWire channels.

4. Open the Cubase Mixer.
You will find that new channels have been added - one for each activated ReWire channel. If the channels aren’t 
visible, you may need to scroll the Mixer window or check the Mixer View options (different channel types can be 
shown or hidden as desired in the Cubase Mixer).

5. Start playback (in Reason Essentials or Cubase - it doesn’t matter as both programs will automatically be syn-
chronized).
You will now see the level meters moving for the playing ReWire channel, and hear the sound of the Reason Es-
sentials devices through Cubase’s Mixer. Of course, this requires that your Reason Essentials Song contains some 
music!

6. Use the mixing features in Cubase to add effects, EQ, etc.

Routing MIDI via ReWire 2
The following description is based on using Reason Essentials with Cubase as the host application. For descriptions 
on how to route MIDI to Reason Essentials and Reason from other host applications, please go to www.propeller-
heads.se/rewirehelp.
1. In Cubase, select a MIDI track that you want to route to a Reason Essentials device.

2. Pull down the MIDI Output menu for the track (in the Inspector or track list).
All devices in the current Reason Essentials Song are listed on the pop-up menu, along with the conventional, 
“physical” MIDI outputs.

3. Select a Reason Essentials device from the pop-up menu.
The output of the MIDI track is now routed to that device.

http://www.propellerheads.se/rewirehelp
http://www.propellerheads.se/rewirehelp
http://www.propellerheads.se/rewirehelp
http://www.propellerheads.se/rewirehelp
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• If you now play back a MIDI part on the track, the MIDI notes will be sent to the Reason Essentials device - just 
as if the track were connected to any regular MIDI sound source.
The sound of the device will be sent back into Cubase via ReWire - which channel it will appear on depends on 
how you have routed the device to the Hardware Interface in Reason Essentials, as discussed above.

• To play the device “live”, you need to select the proper MIDI input for the track in Cubase (the input to which 
your MIDI keyboard is connected) and activate the Monitor button for the track.
When the Monitor button is activated, all incoming MIDI (i.e. what you play on the keyboard) is immediately sent to 
the track’s MIDI Output (i.e. to the Reason Essentials device).

Converting ReWire channels to audio tracks
Most often, there is no need to convert individual ReWire channels to regular audio tracks. The channels already ap-
pear in the host application’s Mixer, and you can typically perform the same kind of real-time processing as with reg-
ular audio channels (effects, EQ, volume, pan and mute automation, etc.).

Still, you may need to convert the ReWire channels to audio tracks, for example if you want to continue working in 
Cubase only. This is probably easiest done by using Reason Essentials’s internal “Bounce Mixer Channels” function, 
described in “Bouncing Mixer Channels”. When you have bounced the desired Mixer Channels, you could then import 
the generated audio files to tracks in the host application for further processing.

Alternatively, you could use the host application’s “Export Audio” or “Bounce” function. In Cubase, you would proceed 
as follows:
1. Make sure your Reason Essentials devices and/or audio tracks play back properly via ReWire.

2. In the Cubase Mixer, activate Solo for the ReWire channel you want to convert to a regular audio track.
Make sure no other channel is Soloed.

3. Go to Cubase’s Project window and set the left and right locator to encompass the whole song (or a section, if 
that’s what you want).
Make sure the Cycle (loop) function is turned off.

4. Pull down the File menu in Cubase and select “Audio Mixdown” from the Export submenu.
The Export Audio Mixdown dialog appears.

5. Activate the “Import to Pool” and “Import to Track” options and fill in the rest of the dialog as desired.
You can choose to include any Cubase mixer automation, select a file format and file name, etc.

6. Click Save.
The ReWire channel is now rendered to a new audio file on disk. A clip referring to the file will appear in the Pool, 
and an audio event playing this clip will be created and placed on a new audio track, starting at the left locator.

• If you now play back the audio track you will hear exactly what was played on the ReWire channel. 
This means you should keep that ReWire channel muted (or deactivated) now, since otherwise you would hear the 
sound twice - once via ReWire and once from the audio track.

D To convert all your ReWire channels this way, simply proceed as above (but solo another ReWire channel in 
the Cubase Mixer).

! Converting ReWire channels this way results in a number of audio files that can be very large (depending on 
the length of the song). Make sure you have enough disk space!

Details about various ReWire hosts
The Propellerhead Software web site provides updated information on how to configure ReWire for most compatible 
host applications. 

Please go to: www.propellerheads.se/rewirehelp.

http://www.propellerheads.se/rewirehelp
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About this chapter
This chapter describes how to synchronize Reason Essentials to MIDI Clock, and how to use the External Control 
Bus inputs for advanced MIDI routing when you’re not using ReWire.

Synchronization to MIDI Clock

ReWire users – read this!
This section is about synchronization via MIDI Clock, and does not apply to users of ReWire. If you are using Reason 
Essentials together with a ReWire compatible application, ReWire automatically handles all synchronization issues for 
you. See “About synchronization” for details.

What is synchronization and MIDI Clock?
Synchronization, in this context, is when you make Reason Essentials play at the same tempo as another device; 
where both start, stop and can locate to certain positions, together. This is done by transmitting MIDI Clock signals 
between Reason Essentials and the other device. MIDI Clock is a very fast “metronome” that can be transmitted in a 
MIDI cable. As part of the MIDI Clock concept there are also instructions for Start, Stop and locating to sixteenth note 
positions.

You can set up synchronization between Reason Essentials and hardware devices (tape recorders, drum machines, 
stand alone sequencers, workstations etc.) and other computer programs running on the same or another computer.

Master/Slave

In a synchronized system there is always one master and one or more slaves. In our case, the master is the one that 
controls the tempo. In other words, it is only the tempo setting on the master device that is of any relevance, since the 
slaves slavishly follow the master's tempo.

• Reason Essentials always acts as a slave. That is, it receives MIDI Clock signals, it never transmits them.

! Before you create any serious projects that require sync, try out the features described in “Slaving Reason Es-
sentials to an external MIDI application or instrument” and “Slaving Reason Essentials to another program on 
the same computer”, and check out “Synchronization considerations”.

Slaving Reason Essentials to an external MIDI application or 
instrument
This example assumes that you have an external device, such as a drum machine, hardware sequencer, another com-
puter, tape recorder etc., that transmits MIDI Clock signals to which you want to synchronize Reason Essentials.
1. Connect a the device via USB/MIDI to the computer running Reason Essentials.

2. Set up the other device so that it transmits MIDI Clock signals to the MIDI Out you just connected to the com-
puter running Reason Essentials.

3. In Reason Essentials, pull down the Edit menu (under Mac OS X, the Reason Essentials menu) and open the 
Preferences dialog. Click the Advanced tab.
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4. Pull down the MIDI Clock Sync pop-up and select the MIDI Input to which you connected the other device.

5. Close the dialog.

6. Activate MIDI Clock Sync from the Options menu - “Sync” submenu in Reason Essentials.

7. Activate playback on the other device.
Reason Essentials will start playing ‘in sync’ with it.

Slaving Reason Essentials to another program on the same 
computer
! The preferred method for synchronizing two applications is by using ReWire, see “ReWire”. However, if the ap-

plication you need to sync Reason Essentials with doesn’t support ReWire, you can try the procedures de-
scribed below.

This section describes how to use MIDI Clock to synchronize Reason Essentials to another application running on the 
same computer.

! Note that synchronization via MIDI Clock makes the two programs play at the same time, that is, they both 
“run” when you “hit play”. It does not mean they can both play audio at the same time. 

Proceed as follows:
1. Set up the other program, so that it transmits MIDI Clock to Reason Essentials:

Under Windows this is done by selecting one of the MIDI routing utility ports.

2. In Reason Essentials, open the Preferences - Advanced tab.

3. Pull down the MIDI Clock pop-up and select the corresponding MIDI port.

4. Close the dialog.

5. Activate MIDI Clock Sync from the Options menu - “Sync” submenu in Reason Essentials.

6. Activate playback on the other device.
Reason Essentials will start playing ‘in sync’ with it.

Synchronization considerations

Adjusting for Latency

Latency compensation on the Audio tab in Preferences.

Because of the latency problem described in “ReWire and Latency”, you might need to adjust Reason Essentials’ 
playback in relation to the sync master, so that they are in perfect time. The tempo will not differ between the two, but 
Reason Essentials might play ahead or behind the other application. You might need to adjust this. However, this is 
something you only need to do once. The setting is stored with your other preferences, so you don’t need to adjust it 
again.

Proceed as follows:
1. Set up the other application so that it generates a solid click, on for example quarter or eighth notes, prefera-

bly with a special sound on the downbeat.
This click can either come from an internal metronome or from a MIDI source. If you use a MIDI source, make sure 
you pick one that has solid MIDI timing.
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2. Set up Reason Essentials so that it plays a similar rhythm as the other application.
You might for example use the sequencer Click or a Redrum drum computer for this.

3. Start the two applications in sync.

4. Make sure you hear both applications at approximately equal level.

5. Open the Preferences dialog in Reason Essentials and click the Audio tab.

6. Trim the “External Sync Offset” setting until the “clicks” from the both sources sound at exactly the same time.

7. Close the Preferences dialog in Reason Essentials.

If Latency Compensation isn’t enough

There might be situations where you can’t compensate enough in Reason Essentials to make two software applica-
tions run in sync. This might especially be true if the other application is an audio sequencer, that is if it can record 
and playback both audio and MIDI.

This problem is an indication of the fact that the other application has not been set up properly and that its audio play-
back is not in sync with its own MIDI playback.

! This is not something that you can or should compensate for in Reason Essentials. Instead, follow the instruc-
tion included with the other application to make sure its MIDI playback and audio playback are correctly 
locked to each other.

About the beginning of the Song

Due to the latency phenomenon, described in “About latency”, Reason Essentials needs some time to correct it’s 
playback speed when it first receives the Start command. This can be noted as a small glitch in the audio playback, 
when the program starts. If this is a problem, you need to insert a couple of empty measures at the beginning of the 
Song. Proceed as follows: 
1. Set the Left Locator to “1. 1. 1.0” and the right Locator to “3. 1. 1.0“.

2. Click somewhere in the main sequencer area to move the menu focus to the sequencer.

3. Select “Insert Bars Between Locators” from the Edit menu.

4. Set up the other device/application, so that it also plays two empty bars at the beginning.

About MIDI Song Position Pointers

MIDI Clock actually consists of five type of messages: The actual clock (the metronome that establishes the tempo), 
Start, Stop and Continue commands and Song Position Pointers. This last type of message contains information 
about positions, so that a program for example “knows” where in a Song to start playback from.

Normally, this ensures that you can locate to any position and activate playback from there. In older devices, Song Po-
sition Pointers might not be implemented. This means that you will be able to synchronize properly only if you start 
both devices from the absolute beginning of the song.

About Tempo Changes

Again, due to the latency phenomenon, Reason Essentials needs a bit of time to adjust to changes in tempo. If there 
are abrupt changes in the MIDI Clock, due to drastic tempo changes in the master, you will note that Reason Essen-
tials will require up to one measure to adjust itself to the change. How long this actually takes also depends on the 
precision of the incoming MIDI Clock. The more precise it is, the faster Reason Essentials can adjust to it. 

If this adjustment is a problem, try to use gradual tempo changes rather than immediate ones.

! When Reason Essentials is synchronized to MIDI Clock, there is no Tempo readout.
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Input Focus and Play Focus

If you activate MIDI Clock Sync, the Transport Panel controls will be disabled, and Reason Essentials will not run un-
less MIDI Sync data is provided from an external device.

The Input Focus (MIDI + Audio) and Play Focus (MIDI Sync) buttons (located on the Reason Essentials Hardware In-
terface) relate to how incoming MIDI and MIDI sync should be handled if there are several open Song documents. If 
you have two or more Songs opened, and no MIDI sync is used, the currently selected Song (the document “on top”) 
always has Input focus.

If MIDI Sync is enabled (which is global for all currently open Song documents), this functionality changes in the fol-
lowing way:

• If both “Play Focus” and “Input Focus” are activated for a Song, incoming MIDI data, MIDI sync (and Audio) 
will be sent to this Song, regardless of whether another Song is currently in focus.

• If only “Input Focus” is activated for Song, and another Song has “Play Focus”, incoming MIDI (and Audio) will 
be sent to the former and MIDI sync to the latter (i.e this Song will play back), regardless of which Song is cur-
rently in focus.

Advanced MIDI - The External Control Bus inputs

About the External Control Bus inputs
The External Control Bus inputs allow you to send MIDI directly to Reason Essentials devices.

• These MIDI inputs are for controlling Reason Essentials devices from an external sequencer.
This could be an external hardware sequencer or a sequencer application running on another computer.

• If you want to control Reason Essentials from another sequencer application on the same computer, the pre-
ferred method is using ReWire (see “Routing MIDI via ReWire 2”). 
However, if the other sequencer software doesn’t support ReWire 2, the External Control Bus inputs can be an al-
ternative. In that case, you may need to use a MIDI routing application to be able to route MIDI from one program 
to the other.

You set up the External Control Bus inputs on the Advanced tab in the Preferences dialog:

D Select a separate MIDI port for each bus you plan to use.
Each bus provides 16 MIDI channels, for a total of up to 64 MIDI input channels. For example, if you have an ex-
ternal sequencer with two MIDI outputs, you connect these to two MIDI inputs on your MIDI interface and select 
these two inputs for the first two busses on the Advanced MIDI page. You will then be able to send MIDI on up to 
32 channels from the external sequencer to Reason Essentials.

D Make sure you don’t select a MIDI port that is already selected on the Control Surfaces and Keyboards page 
(or in the MIDI Clock Sync section).
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Routing MIDI to devices
Each External Control Bus can control up to 16 different Reason Essentials devices, one for each MIDI channel. To 
route a MIDI channel directly to a Reason Essentials device, proceed as follows:
1. Locate the Reason Essentials Hardware Interface at the top of the rack and click the ADVANCED MIDI button.

The Advanced MIDI Device panel is unfolded.

2. On the Advanced MIDI Device panel, click the Bus Select button for the External Control Bus you want to use 
(A, B, C or D).

3. Below the Bus Select buttons there are fields for the 16 MIDI channels. Click the arrow button for the desired 
MIDI channel and select a Reason Essentials device from the menu that appears.
Incoming MIDI data on that bus and channel will now be sent directly to the selected device. In other words, the 
master keyboard routing in the sequencer is bypassed.

Sending Controller data via MIDI
It is possible to send controller data from an external sequencer to control Reason Essentials parameters. Just set up 
your external device to transmit the correct MIDI controller messages on the right MIDI port.

To find out which MIDI Controller number corresponds to which control on each device, please see the “MIDI Imple-
mentation Chart.pdf” document.

Once you have located the controller numbers and set everything up, you can record and edit the controller data in 
the external sequencer as you normally do, and the Reason parameters will react correspondingly.

q Do not confuse this with Remote control. Remote does not require any mapping of controller numbers for sup-
ported control surfaces! See “About Remote”.

About recording Pattern Changes
As specified in the MIDI Implementation, MIDI Controller #3 can be used to switch patterns in a device. However, pat-
tern changes activated this way occur immediately (not at the end of the bar), which may or may not be what you pre-
fer.

Please, see “Recording pattern automation”, “Editing pattern automation” and “Drawing pattern automation” for infor-
mation on recording and editing pattern changes.



Chapter 21
Optimizing 
Performance
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Introduction
Reason Essentials is a program of infinite possibilities. You can create extremely complex songs, with a vast number 
of audio tracks and rack devices. While this is one of the most exciting properties of the program, it does have a 
drawback – it means that you must be careful with how you manage your computer processing power.

Each audio track and device you add in your song uses up a bit of computer processing power – the more audio 
tracks and devices, the faster the computer has to be. However, you can set up your devices to require more or less 
processing power. For example, a sound on the Subtractor synthesizer that only uses one oscillator and one filter re-
quires less processing power than one using both dual oscillators and dual filters.

Samples used in your songs also require RAM (memory) to load properly. The use of RAM can also be managed, as 
described at the end of this chapter.

When collaborating on songs with other Reason Essentials owners, you should do what you can to reduce the re-
quirements for playing back a certain song, both in terms of processing power and in terms of RAM requirements. 
Other users may not have as powerful a computer as you do!

Checking Processing Power
To the left on the Transport Panel you will find a meter labelled DSP. This indicates how much processing power is 
used at any given moment.

The DSP meter on the Transport Panel

The higher this meter goes, the higher the strain on your computer processor. You will note when your processor is 
heavily loaded that graphics will update slower. Finally, when there’s too little power left to generate audio properly, 
the sound will start to break up.

Optimization and Latency reduction
As described in “About latency” in the Audio Basics chapter, you generally want the lowest possible latency, to get 
the best response when you record and play in Reason Essentials in real time. However, selecting too low a latency 
is likely to result in playback problems (clicks, pops, dropouts, etc.). There are several technical reasons for this, the 
main one being that with smaller buffers (lower latency), the average strain on the CPU will be higher. This also 
means that the more CPU-intensive your Reason Essentials song (i.e. the more devices and audio tracks you use), 
the higher the minimum latency required for avoiding playback difficulties.

Therefore, you may need to adjust the latency. This is done differently depending on which audio cards, drivers and 
operating system you are using.

Making Buffer Size adjustments in the ASIO Control Panel (Windows)

If you are using an ASIO driver (Windows only) specifically written for the audio hardware, you can in most cases 
make settings for the hardware in its ASIO Control Panel. This panel (opened by clicking the ASIO Control Panel but-
ton in the Preferences-Audio dialog) may or may not contain parameters for adjusting the latency. Usually this is 
done by changing the number and/or size of the audio buffers - the fewer and smaller the audio buffers, the lower 
the latency. Please consult the documentation of your audio hardware and its ASIO drivers for details.
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! Raising the buffer size to eliminate audio artefacts on playback is mainly effective if you are currently using 
very small buffers, 64 to 256 samples. If the buffers are already big (1024 or 2048 samples) you will not notice 
much difference.

Making Buffer Size adjustments in the Reason Essentials Preferences dialog

If you are running Reason Essentials under Windows and are using an ASIO driver, or if you are running Reason Es-
sentials under Mac OS X and are using a Core Audio driver, you can adjust the input and output latencies on the 
Preferences – Audio tab.

D This is done by dragging the Buffer Size slider.

General procedure for reducing latency

The basic procedure for optimizing the latency is the following:
1. Open a song and start playback.

You want to choose a song that is reasonably demanding, i.e. with more than just a few tracks and devices.

2. Open the Preferences dialog.
Under Mac OS X, this is found on the Reason Essentials menu; under Windows it’s found on the Edit menu.

3. Select the Audio page and locate the Buffer Size slider.

! If you are making adjustments in the ASIO Control Panel for hardware with an ASIO driver (Windows only), you 
should make a note of the current buffer settings before changing them.

4. While the song is playing, listen closely for pops and clicks and try lowering the latency (Buffer Size).

5. When you get pops and clicks, raise the Buffer Size value a bit.

6. Close the Preferences dialog (and ASIO Control Panel, if open).

About Latency Compensation
Below the Input Latency and Output Latency rows in the Preferences-Audio dialog, you will find two items called Re-
cording Latency Compensation and External Sync Offset. These value are used internally in Reason Essentials to 
compensate for latencies when recording audio using external monitoring, and when synchronizing Reason Essen-
tials to another MIDI sequencer or similar.

Recording Latency Compensation

! Adjusting the Recording Latency Compensation parameter is never necessary when you have selected “Auto-
matic” in the Monitoring section on the Audio page in Preferences - see “Monitoring”.

Recording Latency Compensation is when the program adjusts the position of recorded audio according to the cur-
rent latency. Here's how it works:

If you're recording audio and not monitoring through Reason Essentials (e.g. monitoring directly through the audio 
card or via an external mixer), the audio you record will reach the program slightly late. This is because you play along 
with background tracks or the metronome - and you hear these delayed by the output latency. Also, the sound you re-
cord is sent to the program via the buffers in the audio hardware - it is delayed by the input latency.



OPTIMIZING PERFORMANCE450

Reason Essentials compensates this by moving the recorded audio earlier by the sum of the input+output latencies. 
This compensation is also done in "Manual Monitoring" mode, if Monitor was Off for the recorded track (when you 
started recording).

If Monitor is On, there is no Recording Latency Compensation. This is because the monitored sound will also be de-
layed, and numerous tests have shown that the performer will actually play slightly ahead to compensate for this. In 
other words, when monitoring through Reason Essentials, the performer is expected to do the Recording Latency 
Compensation himself/herself.

If you are monitoring via an external mixer, and have selected “External” in the Monitoring section on the Audio tab in 
Preferences, there might be situations where you experience that the recorded audio is generally played back too 
early - or too late - in the song. This could be because your audio card doesn’t actually have the latency values it re-
ported to Reason Essentials.

If you should experience that your audio recordings are played back too early or too late compared to the instrument 
tracks in your song, you can adjust this by editing the Recording Latency Compensation parameter:

D Click the Recording Latency Compensation spin controls to compensate for early or late playback of audio 
track recordings
If the audio appears too early during playback, adjust to a negative (-) value.

If the audio appears too late during playback, adjust to a positive value.

About External Sync Offset

The External Sync Offset parameter is there to make it possible to compensate for output latency when syncing Rea-
son Essentials to a host application. Usually, the External Sync Offset is set to the same value as the Output Latency, 
but it is possible to edit it (see “Adjusting for Latency”). Normally however, you shouldn’t need to touch this parameter.

Optimizing your computer system
In this manual we do not have the possibility to give you detailed procedures for optimizing your computer for maxi-
mum power. This is a subject that we could write complete books on. However, there are a couple of very useful 
things to check and adjust.

About using Multi-core processors

If you’re using a multi-core processor, such as a dual-core or quad-core processor, Reason Essentials will take full 
advantage of this in a very sophisticated way. Similarly, if your computer has several single-core or multi-core proces-
sors, Reason Essentials will use the full capacity of these to vastly enhance the performance.

If your computer has a multi-core processor, and/or multiple processors, Reason Essentials automatically detects 
this and automatically enables the “Use MultiCore Audio Rendering” function on the General tab in Preferences:
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About Hyper Threading Technology (single-core Pentium 4 processors)

Hyper Threading Technology (HTT) is a technology used in older single-core Intel Pentium 4 processors to simulate 
dual-core behavior by making one physical CPU appear as two logical processors. However, these two logical pro-
cessors will share FPU (Floating Point Unit). Since Reason Essentials depends heavily on the FPU to calculate and 
generate sound, there will be problems if Hyper Threading is active. 

Reason Essentials automatically disables Hyper Threading and uses only one logical processor per CPU. However, 
another program running on the computer could still be scheduled to use the other logical processor and steal re-
sources (FPU, memory bandwidth) from Reason Essentials.

! If you’re using a Pentium 4 processor computer, we recommend that you disable the Hyper Threading function 
if you’re experiencing problems.

About hard drives

Most state-of-the-art hard drives will work perfectly together with Reason Essentials. Generally, the faster hard 
drive(s) you use, the better. Most hard drives of today runs at 5.400 rpm or faster, which is sufficient for use with Rea-
son Essentials. A large hard drive is also highly recommended when working with recording software like Reason Es-
sentials. A single song with a lot of recordings in it could easily reach around 1 GB in final size. During recording and 
editing, the song file size could be a lot bigger than that, so a hard drive space of at least 20 GB is definitely recom-
mended.

General optimization tips

Finally, we’d like to share a couple of other general optimization tips:

• Quit other programs that are running at the same time as Reason Essentials.

• Remove background tasks on your computer.
This might be any background utilities you have installed as well as networking, background internet activities etc.

• Under Windows, make sure you use the latest and most efficient ASIO driver for your audio card.

• Only work on one Reason Essentials Song document at a time.
Songs that are open in the background do consume some processing power, even though they’re not playing.

• Lower the sample rate setting in the Preferences dialog.
While this also might reduce sound quality, it is a very quick and convenient way to try to play a song that your 
computer otherwise can’t handle.
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Optimizing Songs
Below follows things you can check and change to make sure your song uses as little computer processing power 
and memory as possible:

Global

• To reduce the Song file size, delete unused recordings on Audio Tracks.
This won’t affect the processing power but will reduce the Song file size, which might be desirable in many situa-
tions. See “Delete Unused Recordings”.

• Use the “Save and Optimize” function when you’re finished editing your song.
As a final step, after you have recorded and edited your song, use the “Save and Optimize” function on the File 
menu. This will remove any “empty” disk areas in the song file, making the file as small as possible - see “Saving 
and optimizing a Song”.

• Bounce Mixer Channels.
If you’re using a lot of devices in an instrument track, you could bounce the instrument track to an Audio Track. Do-
ing so makes it possible to delete the instrument track afterwards and thus reduce the processing power. See 
“Bouncing Mixer Channels”.

• Delete unused devices.
If a device isn’t actually doing anything, delete it from the rack.

• Use fewer devices.
For example, instead of using several similar reverbs as separate insert effects, replace them all with one, set up as 
a send effect on a Send FX bus in the Main Mixer. By the same token, try to use one sampler playing several dif-
ferent samples instead of numerous samplers playing one sample each.

• Don’t use stereo unless it is required.
For example, if a sampler or Dr. Octo Rex loop player is playing mono material, only connect the Left output and 
leave the Right output unconnected.

Main Mixer

• Make sure you deactivate any channel strip parameters or sections you don’t use in your song.
This could be, for example, EQ and Insert FX.

• Delete any Mix Channel devices and/or Audio Track devices you don’t use in your song.

Sample Players – NN-XT, Dr. Octo Rex and Redrum

• Only activate High Quality Interpolation when it is required.
Listen to the sound in a context and determine whether you think this setting makes any difference.

• If you are playing back a sample at a much higher pitch than it was recorded at, consider sample rate convert-
ing the actual sample file to a lower sample rate.
This will require an external sample editor with good sample rate conversion facilities.

• Try to refrain from using stereo samples.

Filters – Subtractor, NN-XT and Dr. Octo Rex

• Deactivate filters that are not used.
Observe that if the Cutoff is all the way up or the envelope is set to open the filter fully, then the filter doesn’t affect 
the sound. Conserve processing power by disabling the filter altogether.

• Where applicable, use the 12dB lowpass filter instead of the 24dB lowpass filter. 
See if you can get the same sonic result by using the 12dB filter, since it uses up less processing power.
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Polyphonic Devices – Subtractor, NN-XT, Dr. Octo Rex and Redrum

• Try making the device play fewer voices.
This can be done for example by lowering the release and setting the Polyphony setting to exactly the maximum 
number of notes played simultaneously by this device.

! Note that just lowering the polyphony setting has no effect. Unused voices do not consume processing power.

• Where applicable, try the Low Bandwidth (Low BW) setting.
This will remove some high frequency content from the sound of this particular device, but often this is not notice-
able (this is especially true for bass sounds).

Subtractor

• Try avoiding using Oscillator 2 altogether.
If you can create the sound you need with only one oscillator, this saves considerable amounts of processing 
power.

• Do not use the oscillator Phase mode if you don’t need it.
In other words, set the Oscillator Mode switches to “o”, not “*” or “–”.

• Do no activate Noise unless required.

• Do not activate Filter 2 unless required.

• Do not use FM unless required.
In other words, set the oscillator FM knob to “0” and make sure no modulation source is routed to FM.

Redrum

• Do not use the Tone feature available on channels 1, 2 and 9.
Make sure the Tone controls and their accompanying Vel knobs are set to “0” (“twelve o’ clock” position).

Mixer devices

• Avoid using stereo inputs when not required.
For example, if your sampler or Dr. Octo Rex player is playing mono material, only connect it to the Left input on a 
mixer channel. Leave the Right input unconnected.

• Do not activate EQ (Mixer 14:2 only) unless required.
If a channel doesn’t make use of EQ, make sure it’s EQ button is deactivated.

Send Effects

• When you are using mono effects as send effects, you can connect the effect returns in mono as well (discon-
nect the cable to Aux Return Right on the Main Mixer).
This is true for the following effects:

• Scream 4 Distortion

• DDL-1 Delay (provided the Pan parameter is set to center position).

• MClass effects; Equalizer, Compressor, Maximizer.



OPTIMIZING PERFORMANCE454

RAM requirements
Songs not only use up system resources in terms of processing power and hard disk space, they also require RAM 
(memory) to load at all. The amount of RAM required for loading a song, is directly proportional to the amount of sam-
ples used in the song. For example, a song only using Subtractors and effects requires very little RAM.

If you are running out of RAM try the following:

• Close other Song documents.
All open songs compete for RAM.

• Terminate other applications.
All running applications compete for the RAM available in the computer.

• Use mono samples instead of stereo ones.
Mono samples require half the amount of RAM.

• Try sample rate converting sample files to a lower sample rate.
Note that this could affect sound quality negatively. Also note that it will require an external sample editor with 
good sample rate conversion facilities.



Chapter 22
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Introduction

The Hardware Interface device is where you connect Reason Essentials to the “outside world”. This is where MIDI is 
received, and where audio signals are routed from physical inputs and to physical outputs of your audio hardware. 
Here is also where audio output signals are routed to ReWire channels. The Hardware Interface is always present at 
the top of the rack, and cannot be deleted. This chapter is meant to serve as a panel reference, describing the various 
sections of the device. How to set up your audio hardware is described in the “Audio Basics” chapter.

The Hardware Interface is normally unfolded, showing a panel with 2 Sampling Inputs, 16 Audio Inputs and 16 Audio 
Outputs and a couple of buttons.

• On the right hand side at the top of the panel are the Input Focus and Play Focus buttons - these are described 
in “Input Focus and Play Focus”.

• The Sampling Input, Audio Input and Audio Output sections feature a LED meter for each input and output 
channel.

! Remember that the Hardware Interface is where any possible audio clipping will occur in Reason Essentials. 
Keep an eye on the clipping indicator on the Transport Panel, and also on the individual meters on the Hard-
ware Interface panel. If a channel pushes the meter into the red, the level should be reduced at the source - see 
“About audio levels” in the “Audio Basics” chapter.

• The multi-color LEDs below each channel indicate the following:
Green LED: Available and used channel (cable connected to the channel jack on the rear panel).

Yellow LED: Available but unused channel (no cable connected to the channel jack on the rear panel).

Red LED: Unavailable channel but with a connected cable on the rear panel. No audio will be present on channels 
with red LEDs.

Unlit LED: Unavailable and unconnected channel (no cable connected to the channel jack on the rear panel).

• By clicking the “ADVANCED MIDI” button at the top on the panel, the Advanced MIDI Device panel is shown:

Refer to “Advanced MIDI Device” for more information.

• By clicking the “MORE AUDIO” button at the top on the panel, an additional Audio In and Out panel is shown 
for a total of 64 inputs and outputs.
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Refer to “More Audio” for more information.

• By clicking the “BIG METER” button at the top on the panel, a panel with bigger audio level meters is shown:

Refer to “The Big Meter” for more information.

About using ReWire
If you are running Reason Essentials together with a ReWire compatible host application, you can route any Reason 
Essentials device output to a ReWire channel by connecting the device to any of the audio out connectors at the 
back of the Hardware Interface. In ReWire mode, all 64 channels are available and any device output routed to a Re-
Wire channel will appear in the ReWire host application on it’s own channel. See the “ReWire” chapter for more infor-
mation.

Sampling Input section

The Sampling section features two audio inputs (L & R) to which you should route the audio signals you want to sam-
ple. There is also a Level knob and two Monitor buttons. See “Setting up for sampling” for details on how to sample.
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Advanced MIDI Device

This is opened by clicking the “ADVANCED MIDI” button on the Hardware Interface panel. The Advanced MIDI de-
vice is only used if you are controlling Reason Essentials from an external sequencer, using the External Control Bus 
inputs. Normally, you send MIDI to a track via the sequencer, by selecting the sequencer track.

You can select MIDI ports for up to four External Control Busses (on the Advanced Control page in Preferences). 
Each bus can host 16 MIDI channels, for a total of up to 64 MIDI input channels. The Advanced MIDI Device is where 
you can route each MIDI channel to a specific device in the Reason Essentials rack:
1. Select one of the External Control Busses by clicking the corresponding Bus Select button at the top of the Ad-

vanced MIDI device.

2. Pull down the device pop-up menu for a MIDI channel and select a device.
The menu lists all devices in the current song.

Now, incoming MIDI data on the selected bus and MIDI channel is sent directly to the selected device, bypassing the 
Reason Essentials sequencer. The name of the device is shown in the name field for that MIDI particular channel.

3. Try sending MIDI notes from the external sequencer, on the selected bus and MIDI channel.
The indicator below the channel's name field should light up.

See also “Advanced MIDI - The External Control Bus inputs” in the Advanced MIDI and Synchronization chapter.

More Audio
Reason Essentials supports up to 64 audio input and 64 audio output channels. The additional 48 inputs and 48 out-
puts can be found on the “More Audio” panel. 

D To view inputs 17-64 and outputs 17-64, click the “More Audio” button.

Each additional input and output features a meter and a multi-color LED indicator which will be lit in different colors 
depending on current state - see “Introduction”.
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The Big Meter

To get a better overview of the levels of a particular channel pair you can bring up the Big Meter on the Hardware 
Interface.
1. Click the “Big METER” button on the front panel.

The “Big Meter” panel shows up.

2. Select the Input or Output pairs to view in the Big Meter by clicking on the corresponding Channel Selection 
button below each Input or Output pairs. 
Alternatively, select channel by turning the Channel Selection knob.

D It’s also possible to select various Meter Modes, or combinations of Meter Modes, by clicking the Meter Mode 
button to the far left.
The available Meter Modes are:

• VU
The VU Mode simulates the behavior of analog meters and shows the RMS (Root Mean Square) value of the sig-
nal. Since the RMS value is an "average" of the signal level over time it's not suited for detecting fast transients in 
the sound. Rather, VU meters are useful for monitoring the overall loudness of the signal.

In VU Mode, the meter response is 300 ms/20 dB for both attack and release. There is no peak segment in the 
meter.

D The VU Offset can be set in 2 dB steps between -20 and 0 dB, by turning the VU Offset knob.
This setting determines how the VU dB scale relates to the Peak dB scale. If you have no specific preference in 
this matter, you don't need to change the VU Offset.

! The VU Offset setting will affect the readout of all Meters on the Main Mixer channel strips and on their corre-
sponding Rack devices.

• PPM
In PPM (Peak Program Meter) Mode, the meter response is 0 ms rise and 2.8 s/24 dB fall. The PPM Mode is per-
fect for detecting transients in the sound. There is no peak segment in the meter.

• PEAK
In PEAK Mode, the meter response is 0 ms for both rise and fall, which means that this mode provides the most 
accurate representation of the signal level over time. Since the fall time is 0 ms, it could be quite distracting to the 
eyes to watch the meters in PEAK mode. If so, the PPM Mode might be more convenient since it's equally fast at 
responding to transients, but falls more slowly. 

The peak segment (the rightmost LED segment, indicating the highest level) has a fall time according to the Peak 
Hold parameter setting (5 seconds or infinite). This allows you to more easily spot very brief level peaks.

Channel Selection buttons 
for the “Big Meter”

The “Show Big Meter” button

Clip indicators
Reset
button

Channel Selection knob 
for the “Big Meter”

Meter Mode 
button
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• VU+PEAK
In VU+PEAK Mode, the meter response is according to the VU Mode, plus a peak segment.

• PPM+PEAK
In PPM+PEAK Mode, the meter response is according to the PPM Mode, plus a peak segment.

If the audio level for the selected is, or have been, too high, the Clip indicators on the Big Meter will stay lit until you 
click the “Reset” button, or select new audio channels for the Big Meter. See “About audio levels” for more informa-
tion on how to use and work with the Big Meter.



Chapter 23
The Combinator
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Introduction

The Combinator is a special device that allows you to save and recall any combination of Reason Essentials devices 
(instruments, effects, mixers etc.) and their internal connections. A saved Combinator setup can be loaded as a patch, 
called a “Combi”. The Combinator device itself acts as a container for the devices in a Combi.

The basic idea behind the Combinator device is simple, but very powerful. Being able to save multiple devices as a 
Combi enables you to instantly recall any type of setup, however complex, as simply as loading a patch!

Some typical applications of the Combinator:

D Create split or layered multi-instruments.
Add any number of instrument devices and play them as a single layered instrument. Instrument devices in a 
Combi can also be assigned to specific keyboard/velocity zones.

D Save instrument/effect combinations.
Save an instrument together with your favorite effect(s).

D Create multi-effect devices.
You can create and save complex effect chains as Combis. 

About the Combi patch format

The Combinator saves files in the Combi (.cmb) patch format. When you load a ready-made Combi patch, all devices 
included in the Combi, their corresponding parameter settings and audio and CV connections are instantly recalled.

The Reason Essentials Soundbank includes many preset Combinator patches, divided into various categories.

There are two basic types of Combi patches; instrument and effect combis. 

D Instrument Combis contain instrument devices and generate sound.

D Effect Combis contain effect devices and are used to process sound.
These Effect Combis can e.g. be loaded as insert effects in the Main Mixer channel strips and Master Section. 
They can also be created as send effects in the Main Mixer Master Section using the “Create Effects...” command 
on the Create menu.
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Creating Combinator devices
Creating an empty Combinator device

D Add a Combinator from the Devices tab in the Tool Window.
To see the Combinator device icon, the “Other” checkbox must be ticked.

D Select “Combinator” from the Create menu.
This will create an empty Combinator. Empty Combinator devices can be used as a starting point when creating 
new Combi patches. It also allows you to browse for existing Combi patches.

Creating a Combinator by combining devices

You can create a Combinator device by combining existing devices:
1. Select two or more devices in the rack by [Ctrl]-clicking (Win) or [Shift]-clicking (Mac).

The devices do not have to be adjacent in the rack.

! Note that you should never select any Mix Channel or Audio Track devices, since this will disable the “Com-
bine” function described below.

2. Select “Combine” from the Edit menu or context menu.

This creates a Combinator device containing the devices that were selected according to the following rules:

D A sequencer track is created for the Combinator, just as when creating instrument or pattern devices.

D The new Combinator device appears at the position below the selected device that is farthest down in the rack.

D The selected devices are moved to be contained within the Combinator’s “holder”.
Their internal order is not changed. Reason Essentials attempts to autoroute the first “input device” and first “out-
put device” to the Combi To/From Devices connectors - see “About internal and external connections”. Other con-
nections are unchanged.

D Devices outside the Combi remain in the same order as before.

! Please see “Adding devices to a Combi” for details about auto-routing.

Creating a Combinator by browsing patches

You can use “Create Instrument” or “Create Effect” to create a Combinator device (just as you can any device). If you 
select a .cmb patch a Combinator will be created containing all devices and settings saved in the Combi.
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Combinator elements
In the picture below an unfolded Combinator device is shown.

The front of the Combinator consists of the following elements (from the top down):

D The narrow panel at the top is always shown, even when the whole Combinator is folded. 
It contains a display which (amongst other things) shows the name of the currently loaded Combi, and standard 
Select/Browse/Save patch buttons.

D Next is the Controller panel, which is always shown if the Combinator is unfolded. 
See “The Controller panel”.

D The Programmer panel contains settings for Key and Velocity Zone mapping as well as Modulation Routing 
settings.
The Programmer can be shown/hidden by clicking the “Show Programmer” button on the Controller panel. See 
“Using the Programmer”.

D At the bottom are the devices included in the Combi.
Devices can be shown or hidden by clicking the “Show Devices” button on the Controller panel. The empty space 
at the bottom is used for adding more devices to a Combi by drag and drop. Clicking the empty space so that the 
red Insertion line appears also makes the Combi the target container for new created devices (from the Create 
menu). See “About the Insertion line”.
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About internal and external connections
Unlike other devices, the Combinator contains both external and internal audio connections.

D External connections are used to connect a Combinator to devices outside the Combi.

D Internal connections are how devices within the Combi are connected.

External connections

D The “Combi Output L/R” connectors carry the audio output of the Combinator. 
This output connects with a device outside the Combi, normally a mixer. Internally, this output is connected to the 
“From Devices” connectors. When you create a new Combinator this output will be auto-routed to the first avail-
able mixer input channel.

D The “Combi Input L/R” connectors is the input to the Combinator (used for effect Combis only). 
Internally, this input is connected to the “To Devices” connectors.

Internal Connections

D The “From Devices L/R” inputs is where the outputs from devices in the Combi are connected.

D The “To Devices L/R” outputs connect to an input on a device in the effect Combi.

About External Routing
If an individual device in the Combi is directly connected to a device outside the Combinator, this is known as an “Ex-
ternal Routing” connection, which should generally be avoided. The reason for this is that such connections are not 
saved with the Combi patch.

D Therefore, all connections to/from a Combi should pass via the To/From Device connectors on the Combinator 
device if you wish to make the Combi self-contained.

If a Combi contains external routing connections, this is indicated both on the front and back panels of the Combina-
tor; On the front panel “External Routing” is displayed in the Patch name display, and on the back panel a LED indi-
cator is lit.

It is still possible to use a Combi with External Routing connections within the context of a song (where all routings 
are saved with the song). Just keep in mind that the external routing connections will not be part of the patch!
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How to avoid external routing connections

As explained previously, all connections to/from a Combinator device should pass via the To/From Device connec-
tors in order to make the Combi self-contained. Therefore you need to include a mixer device for Combis with more 
than 2 device outputs.

Say you were to combine three instrument devices (each with stereo outputs connected to a mixer) in order to create 
a layered or split instrument Combi. 

If you simply selected these three instrument devices (but not the mixer) and then selected “Combine”, only one of 
the devices would be auto-routed to the “From Devices” connectors, while the other two devices would have the 
same connections they had before combining.

Therefore:

D When combining several instrument devices, connect them to a mixer device and include this mixer in the 
Combi.
This way, all the instrument device outputs in the Combi can be connected to separate input channels in the mixer. 
The mixer device output can then be routed via the “From Devices” connectors and thus the Combi will be self-
contained.

Instrument devices and effects connected to a Line Mixer 6:2 within the Combi.

q The Line Mixer 6:2 is ideally suited for mixing device outputs in Combis (see “The Line Mixer 6:2”).
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Adding devices to a Combi

About the Insertion line

When the Insertion line is shown, new created devices will be added to the Combinator device. 

D To be able to select the Insertion line you have make sure that the “Show Devices” button is lit on the Combi-
nator Controller panel.

D The Insertion line is shown in the empty space at the bottom of the Combinator holder (below any devices cur-
rently in the Combi).
If the Combi doesn’t contain any devices, the empty space is located just below the Controller panel.

Showing the Insertion line

Any of the following methods will select/show the Insertion line:

• By clicking in the empty space at the bottom of the Combinator holder.

• When creating a new Combi, the Insertion line is automatically selected.

• By using the arrow keys you can step through and select each device currently in the Combi. By selecting the 
empty space, the Insertion line appears.

• Selecting “Initialize Patch” for a Combinator will clear all devices and the Insertion line appears.

D Note that showing the Insertion line automatically selects the Combinator device. However, selecting the Com-
binator will not automatically show the Insertion line.
The Insertion line remains selected until you select another device (either in the Combi or in the rack), or hide the 
devices.

Creating new devices in a Combi 
To make a Combinator the target device for created devices you have to use one of the following methods:

D Showing the Insertion line (see “Showing the Insertion line”).
If you create a device with the Insertion line showing, the new device will appear below the Insertion line, at the 
bottom of the Combi holder.

D Selecting a device in the Combi (but not the Combi itself).
When you select a device from the Create menu it will appear below the selected device (just like in the rack).

D No sequencer tracks will be automatically created for devices added to a Combi. 
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About auto-routing

The auto-routing of devices in a Combi is similar to devices in the rack:

• If a device in a Combi is selected, the new created device will appear below the selected device according to 
standard rules.

• If an effect is selected and you create a new effect device, these will be connected serially.

• If an instrument device is selected and you create an effect it will be connected as an insert effect to the instru-
ment device. 

• If a mixer is selected and you create an effect it will be connected as a mixer send effect.

• If an instrument device is selected and you create another instrument device it will be added below the se-
lected device and connected to the first available mixer input channel.

• If you hold down [Shift] and create a new device, no auto-routing will take place.

• If you hold down [Option] (Mac) or [Alt] (Windows) and create a new device, a sequencer track will be created 
for the device.

D If you add a device to an empty Combi, its output will be auto-routed to the “From Devices” connectors. For ef-
fect devices, the input will also auto-route to the “To Devices” connectors.

Adding devices using drag and drop
You can move devices in the rack that are currently outside the Combi into the Combinator holder. This works as fol-
lows:
1. If you want to add more than one device at the same time, [Ctrl]-select (Win) or [Shift]-select (Mac) the devices.

2. Click in the “handle” area of a device.
For full width devices, this is the area to the left and right of the panel (between the rack fittings); for smaller de-
vices you can click anywhere outside the actual parameters.

3. Drag the device(s) into the Combinator.
A thick red vertical line indicates where the device(s) will be positioned. Note that the red line can be to the left of 
a device (indicating that the moved device will be inserted before the other device) or to the right of a device (in-
dicating that the moved device will be inserted after the other device). You can also add devices to the empty 
space at the bottom of the Combi holder.

• No auto-routing will take place.
The existing connections to the rack will be kept, so there may be external routing connections (see “About Exter-
nal Routing”). If there are, “External Routing” will be shown the Combinator name display (and on the back of the 
Combinator a LED indicator will be lit).

• If you drag devices into the Combi with [Shift] pressed, the devices will be disconnected from the rack and 
auto-routed according to the insert position.
The routing between dragged devices will be kept. If it isn’t possible to auto-route a dragged device (e.g. if there’s 
no free mixer inputs in the Combi), the device will become unconnected.

• If you drag devices into the Combi with [Alt](Win) or [Option](Mac) pressed, the devices will be copied. No 
auto-routing takes place.
Using [Shift] at the same time will attempt to auto-route according to the same rules as described above.
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Adding devices using copy/paste
You can copy devices and paste them into a Combi. 
1. Select the devices you wish to copy as usual. 

2. Select “Copy Device” from the Edit (or context) menu.

3. Select a device in the Combi or click the empty space to show the insertion line.

4. Select “Paste Device” from the Edit (or context) menu.

D When pasting, the devices will be added below the currently selected device or the Insertion line in the Combi.
No auto-routing takes place.

D Pressing [Shift] when pasting will attempt to auto-route according to standard rules.

Adding a Combi to a Combi
Nested Combis (i.e. a Combi within a Combi) is not supported. If you open the Create menu when the Insertion line 
or a device in a Combi is selected, the Combinator item will be grayed out.

You can, however, use drag and drop or copy/paste to add a Combi to another Combi. The following then applies:

D The devices in the dragged (or pasted) Combi will be “uncombined” (i.e. the Combinator device itself will be 
removed) and the devices will be added below the insert position in the target Combi. 
Existing routing will be unchanged.

D If you press [Shift] when dragging (or pasting) the uncombined devices will be auto-routed as if it was a single 
device.
The “From Devices” Output (and “To Devices” input if applicable) used in the uncombined Combi will be auto-
routed to the target Combi, according to standard rules.

Combining two Combis
D The lower Combi will be uncombined and the devices added to the upper Combi in the rack when combining.

Existing routing will be unchanged.

Combining devices in a Combi with devices in the rack
If you combine some devices in a Combi with devices in the rack, the combined devices are removed from their orig-
inal locations and added to a new Combi (below the “original Combi).

Combi handling

Moving the entire Combi
This works much the same as for other devices in the rack. 

D Select the Combinator by clicking on the holder and drag to a new position.
An outline of the Combinator is shown when you drag, and a red line shows the insert position. All connections are 
kept.

D If you press [Shift] when dragging the Combinator will attempt to auto-route to the insert position in the rack 
according to standard rules.
The auto-routing will take into account whether it is an effect Combi or an instrument Combi.



THE COMBINATOR470

D If you press [Alt](Win) or [Option](Mac) while dragging, a copy of the Combi is created.
No Auto-routing takes place. If you press [Alt](Win) or [Option](Mac) + [Shift] the copied Combi will be auto-routed 
according to standard rules.

Moving devices within a Combi
Just as for devices in the rack, an outline of the devices is shown when you drag, and a red line shows the insert po-
sition. All connections are kept.

D If you press [Shift] when dragging, the device(s) will attempt to auto-route to the insert position according to 
standard rules.

Moving devices out of a Combi
If you move devices out of a Combi the following applies:

D The routing is unchanged, and the External Routing indicator is likely to light up.
If you press [Shift] when dragging, the device(s) will attempt to auto-route to the rack according to standard rules.

Deleting devices in a Combi
This works exactly as for devices in the rack. Select the device and then either select “Delete Devices and Tracks” 
from the Edit menu or context menu, or press [Backspace].

Uncombining devices
You can uncombine a whole Combi or selected devices within a Combi in the following way:

D If you select a Combinator and then select “Uncombine” from the Edit menu, the Combinator device will be re-
moved, and all devices contained in the Combi will be connected as a single device to the rack.
The devices previously connected to the To/From Devices connectors will now be connected to the rack in the 
same way the Combinator device was (via the Combinator output and input).

D If you uncombine a few selected devices in a Combi these will be removed from the Combi and added to the 
rack below the Combi.
Connections are unchanged, so external routing is likely to happen.

Sequencer tracks and playing Combis
When you create a Combinator device, a sequencer track is automatically created. This track is also given Master 
Keyboard Input just like standard instrument devices.

D When the Combinator track receives incoming MIDI data, this will be routed to all instrument devices in an in-
strument Combi.
This means that the devices will be layered when you play (taking default velocity and key ranges into account). 

D You can turn off Receive Note or selected Performance controller data for individual instrument devices in the 
Programmer panel. 
See “Using the Programmer” for details.
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The Controller panel

This is the main Combinator panel. Like standard instrument devices it features Pitch and Mod wheels and various 
controls. 

About the virtual controls

D The four Rotary knobs and buttons in the middle of the Controller panel are “virtual” controls that can be as-
signed to parameters and functions in devices contained in the Combi. 
These controls are by default not assigned to any parameters in new Combis. 

• You assign parameters in the Modulation Routing section of the Programmer panel (see “Using Modulation 
Routing”). 

• Movements of the virtual controls can be recorded as automation. 

• Each control can be assigned to any number of parameters.

• Clicking on the label for a Rotary or Button lets you type in an appropriate name for it.

The Pitch Bend and Modulation wheels

The Pitch and Mod wheels on the Controller panel will mirror the corresponding actions on your master keyboard, just 
like for standard instrument devices. 

D When a Combinator device has Master Keyboard input and the Combi contains several instrument devices 
these will all receive pitch bend and modulation data.
The settings in the instrument devices determines what happens when applying pitch bend or modulation. 

• For example, moving the Mod wheel could apply vibrato for one device and change the filter cutoff frequency 
for another device.

• Pitch Bend will also be applied according to individual settings in the Range field for all instrument devices in 
a Combi.

Run Pattern Devices button

This can be used to start/stop all pattern devices included in the Combi. This works exactly as pressing the Run but-
ton on the pattern device panel. The on/off status of this button is not saved with the Combi patch. Pressing play on 
the transport panel will automatically activate “Run Pattern Devices”.

q In the Reason Essentials Factory Sound Bank, Combi patches containing pattern devices have “(run)” at the 
end of their patch names.

Bypass All FX

This button allows you bypass all effect devices in a Combi. It works as follows:

• All insert effect devices in the Combi are switched to Bypass mode.

• All effects connected as send effects to a mixer device are switched off.

• Clicking this button will not affect effect devices that were bypassed or turned off already. 
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Select backdrop...

This function allows you to change the “skin” of the Controller panel. You can design your own labels for the assign-
able controls, and change the color and look of the whole panel. 

D Select the Combinator and choose “Select Backdrop...” from the Edit menu.
The Image browser opens, allowing you to select image file in the JPEG (.jpg) format.

D The dimensions of the image file should be 754 x 138 pixels.

D The knobs, buttons, patch name display and patch buttons cannot be redesigned.

D If you wish to design your own text labels for the virtual controls, you should first remove the original text la-
bels.
Click on a label, remove the current text and press [Enter].

D To remove a Backdrop, select “Remove Backdrop” from the context menu.
The original look of the Combinator panel is restored.

About template backdrops

There are template backdrops installed with the program. These have the right dimensions and serve as a good start-
ing point when creating new backdrops. The “Combi Backdrops” folder is located in the “Template Documents” folder 
within Reason Essentials’s Program folder.

Two templates are available, one in the JPEG format and the other in the Adobe Photoshop format (.psd).

D The .psd (Photoshop) template contains multiple layers, which are useful when customizing backdrops.
You have to save any backdrops created in Photoshop as JPEG files before you can use them in Reason Essen-
tials.
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Using the Programmer
The Programmer is used for key mapping and setting velocity ranges for instrument devices, and for Modulation 
Routing; assigning device parameters to the knobs and buttons on the Controller panel. 

D To show the Programmer panel, click the “Show Programmer” button on the Controller panel.
The Programmer appears below the Controller panel.

D To the left on the Programmer panel the devices in the current Combi are listed in the same order they appear 
in the Combinator holder. 
Clicking on a device in the list selects it for editing.

D The middle Key Mapping section features a keyboard with a horizontal scroll bar at the top. In the area below 
it the key range for each instrument device is shown.

D To the right is the Modulation Routing section where you can assign parameters to the controls on the Control-
ler panel.
See “Using Modulation Routing”.
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Key Mapping instrument devices
Each instrument device can have its own separate key range, the lowest and the highest key that will trigger the de-
vice. This allows you to create splits and layers for instrument devices in a Combi.
1. Make sure the Combinator track has Master Keyboard Input.

2. Select an instrument device in the Device list to the left (non-instrument devices, e.g. effects and mixers do not 
have key ranges).
The currently selected device key range is highlighted and shown as a horizontal bar under the keyboard display, 
and as note numbers in the Key Range Hi and Lo fields at the bottom of the Programmer panel. By default, the en-
tire range is selected (C -2 to G 8). Only one device at a time can be selected.

There are several ways you can change the current key range:

D By clicking in the Key Range Lo and Hi value fields and moving the mouse up or down.

D By moving the handles of the horizontal bar in the middle display. 
You may have to use the scrollbar at the top to “see” the handles.

D By dragging the horizontal bar itself you can also move entire key zones horizontally, thereby changing their 
key ranges.

3. Using either method, set the desired key range for the selected device.
When done, the device will only play back notes in the set key range.

D By setting up key ranges for devices in a Combi, you can create split instruments.
For example playing notes below C 2 could trigger a device playing a bass sound, whereas playing notes above C 
2 could trigger a device playing a pad sound. 

D Instrument devices in a Combi that share the same key range will be layered - i.e. play at the same time.
This given that no velocity ranges have been set up - see below.

D You can of course set up overlapping ranges where notes within a set key range will layer two (or more) de-
vices, but notes above and below the set range will play separate devices.

About the Transpose function

The Transpose field in the right bottom corner allows you to transpose the currently selected instrument device. It will 
not shift the key mapping, just the pitch of the selected device. Range is +/- 3 octaves, in semitone steps.
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About the keyboard

You can use the keyboard to audition selected instrument devices by pressing [Option] (Mac) or [Alt] (Windows) and 
clicking on the keys.

About the Receive Notes/MIDI Performance Controller checkboxes

In the lower left corner of the Programmer there is a Receive Notes field with a corresponding checkbox, and below 
there are checkboxes for all standard MIDI Performance controllers (Pitch Bend/Mod Wheel/Breath/Expression/
Sustain Pedal/Aftertouch). 

D These checkboxes allow you to control whether Note/MIDI Performance controller data is to be received for 
each instrument device in a Combi.

D If you deactivate the “Receive Notes” checkbox the selected device will not respond to incoming MIDI note 
messages. 
If a non-instrument device is selected this checkbox is always deactivated.

D If you deactivate any of the Performance Controllers, the corresponding controller(s) will not be received by 
the selected instrument device.
All are on by default.

Setting Velocity Ranges for instrument devices
When instrument devices are set up so that their key ranges overlap – completely or partially – you can use velocity 
switching to determine which devices should be played back depending on how hard or soft you play on your MIDI 
keyboard.

This is done by setting up velocity ranges.

Each time you press a key on your MIDI keyboard, a velocity value between 1-127 is sent to Reason Essentials. If you 
press the key softly, a low velocity value is sent and if you press it hard, a high velocity value is sent.

This velocity value determines which devices will be played and which will not.
1. Select an instrument device in the Device list to the left (non-instrument devices, e.g. effects and mixers do not 

have velocity ranges).
By default, the entire range is selected (0 - 127).

2. Click in the Velocity Range Lo and Hi value fields and move the mouse up or down to set a low and high veloc-
ity range, respectively.

3. When you have set a range, the device will only be triggered by notes within this velocity range.
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About overlapping Velocity Ranges

You can set overlapping velocity ranges. Here’s an example of how this can work:

D Device 1 has a velocity range from 1-60.

D Device 2 has a velocity range of 41-100.

D Device 3 has a velocity range of 81-127.

Now, velocity values between 41 and 60 will trigger notes from both Device 1 and Device 2. Likewise, velocity values 
between 81 and 100 will trigger sounds from Device 2 and Device 3.

About full and partial velocity ranges

You can see which devices have modified velocity ranges in the key map display:

• Devices with a full velocity range (0 - 127) are only shown with an outline.

• Devices with any other velocity range are shown as striped.

The device has a partial velocity range, which is indicated by stripes.

Using Modulation Routing
The Modulation Routing section allows you to assign any parameter or function in devices included in a Combi to any 
of the virtual Rotary and Button controls on the Controller panel. You can also control Combi Programmer parameters 
by connecting external CV modulation sources to any of the four Programmer CV Inputs on the back of the unfolded 
Programmer panel.

About Rotary and Button controls

The virtual Rotary and controls operate much like the equivalent controls on the real devices:

D A Rotary control can either smoothly change parameter values (e.g. a level control), or step through fixed val-
ues (like the Oscillator waveform spin controls on a Subtractor).
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D A Button control will switch between two set values like an on/off switch.
Worth noting is that there are buttons on several Reason devices that will step through a series of values, for ex-
ample LFO Waveform buttons. If LFO Waveform is assigned to one of the virtual Buttons you will only be able to 
switch between two of the six LFO waveforms (which waveforms is determined by the Min/Max range).

D The available range for each selected parameter is shown in the Modulation Routing Min/Max fields.
Most sliders and rotary knobs on the actual devices have the standard 0-127 or -64 to 63 range. Selectors and 
spin controls can have any value range.

About the Programmer CV Inputs

On the back of the Programmer panel are four CV Modulation Inputs for connecting external sources to modulate 
any of the parameters that are accessible in the Target section in the Programmer, see “Programmer CV Inputs”.

Assigning parameters to a control

This is done as follows:
1. Select the device you wish to assign parameters for in the device list to the left.

The name of the selected device is now shown in the Modulation Routing Device field. The Modulation Routing sec-
tion contains four columns:

D In the Source column, the four Rotary and Button controls are by default listed but each field can be changed 
to any Rotary/Button/CV Input or Performance controller by clicking the arrow and selecting from the pop-up.
The last two fields are unassigned by default.

D The pop-ups in the Target column contain all parameters for the selected device.

D Lastly in each Target pop-up list is the option to receive note data or not. 

D The Min/Max columns allow you to specify a value range for the virtual control.
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2. Click in the Target column for the Rotary or Button control you wish to assign a parameter.
On the pop-up that appears, all the available parameters for the device are listed.

3. Select the parameter you wish to assign to the control.
The parameter is now assigned, and the name of the parameter is shown in the Target column for the correspond-
ing control.

4. If you wish the selected device to receive notes this option should be checked.

5. If you move or press the assigned Rotary or Button it will now control the parameter you assigned to it.

6. You can specify a range for the parameter by clicking in the Min and Max columns and moving the mouse up 
or down.
By default the maximum available range is set.

7. If you select another device in the Device list to the left, you can assign another parameter to the same Rotary 
or Button control using the same basic method.
This means that you can create multi-function controls that operate simultaneously on several parameters. E.g. if 
you have two Subtractors and an NN-XT in a Combi you could create a “master” filter cutoff knob, that controls 
this parameter for all three devices. 
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Naming a control

When you make modulation routing assignments, you should give the associated control a descriptive name that re-
flects what it does, for example Vibrato On/Off or the name of the parameter that it controls.

This is done by clicking the label on the Controller panel and typing in new name.

CV Connections
CV connections between devices in the Combi are saved with the Combi patches. This is also true for CV connec-
tions between devices in Combi and the Combi itself - e.g. if you have connected a Matrix in the Combi to one of the 
CV inputs on the back of the Combi panel.

The following CV connectors can be found at the back of the Combinator:

Sequencer Control Inputs

The Sequencer Control CV and Gate inputs allow you to play the Combinator from another CV/Gate device (typically 
a Matrix). The signal to the CV input controls the note pitch, while the signal to the Gate input delivers note on/off 
along with velocity. 

Modulation Inputs

In this section you will find standard CV Mod Wheel and Pitch Bend modulation inputs, as well as modulation inputs 
for the four Rotary controls. 

! Parameter(s) that are assigned to a Rotary control can thus be modulated by CV, which allows you to use CV 
control for almost any Reason Essentials parameter!

Programmer CV Inputs

Here you can connect external CV modulation sources for modulating any of the Target parameters in the Program-
mer (see “Using Modulation Routing”). Next to each CV Input are one sensitivity knob and one polarity switch that 
work as follows:

• The sensitivity knobs can be used for attenuating the CV Input signal.

• The polarity switches should be used for defining the polarity of the CV Input signal.
For example, if you have connected a CV signal from an envelope generator, the switch should be set to Unipolar. 
If you are modulating from a standard LFO, the polarity switch should be set to Bipolar.
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Mixer 14:2
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Introduction

The Mixer 14:2 allows you to control the level, stereo placement (Pan), tone (EQ) and effect mix (AUX Sends) of 
each connected audio device.

If you have ever used a conventional hardware audio mixer, you will most likely find the Mixer very straightforward to 
use. It is configured with 14 (stereo) input channels, which are combined and routed to the Left and Right Master 
outputs. The vertical channel “strips” are identical and contain - from the top down - four Auxiliary Sends, an EQ sec-
tion, Mute and Solo buttons, Pan control, and a Level fader.

Every mixer parameter can of course be automated.

The Channel Strip

Each channel strip in the Mixer 14:2 contains the items listed in “Channel Strip Controls”.

AUX Sends 1-4

EQ Treble and Bass controls

EQ On/Off button

Mute (M) and Solo (S) buttons

Pan control

Channel Fader

Channel Meter

Channel Label

Pre-fader switch for AUX Send 4
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Channel Strip Controls

| Item | Description | Range

Channel Fader The channel fader is used to control the output level of each correspond-
ing channel. 
By adjusting the faders, you can set the desired mix (balance) between 
different devices connected to the Mixer. 

0 - 127 

Channel Label Each channel in the mixer that has a device connected to it, displays a 
read-only label with the name of the device to the left of the fader.

N/A

Channel Meter The meter is a graphical representation of the channel output level. If the 
signal level pushes the meter into the range of the red area, try lowering 
either the output level of the device connected to the channel, or the 
channel fader itself, to avoid distortion.

N/A

Pan Control Use this control to set the left/right position of the channel in the stereo 
field. [Command]/[Ctrl]-click the Pan knob to set Pan to the default “0” 
(center position).

-64 – 0 – 63

Mute (M) and 
Solo (S) Buttons

Clicking a channel’s Mute button silences the output of that channel. 
Click the button again to unmute the channel.
Clicking a channel’s Solo button silences all other mixer channels, so that 
you only hear the soloed channel. Several channels can be soloed at the 
same time, but if this is the case, note that soloed channels can’t be 
muted with the Mute button. To mute one of several channels in solo 
mode you simply “unsolo” it.

On/Off

EQ Treble and Bass controls The EQ Treble and Bass controls is used to cut or boost the higher and 
lower frequencies of the signal, respectively. Click on the EQ button to 
activate the EQ.
If you need more advanced EQ, you can always use a PEQ2 parametric 
EQ as an insert effect for a device.
Note also the two EQ modes - see “About the EQ modes”.

Treble: +/- 24 dB at 12 kHz.
Bass: +/- 24 dB at 80 Hz.

Auxiliary (AUX) Effect Send 1-4 The four independent AUX Sends control the amount of channel signal 
that is to be sent to other devices - typically effect processors. The effect 
output is then normally returned to the Mixer via the AUX Return inputs 
(see “The Auxiliary Return Section”) where it is mixed with the dry (non-
processed) signal. If you create an effect device when the Mixer is se-
lected, the effect is auto-routed to the first available Send/Return con-
nectors. You can then control the amount of effect that is to be applied 
to any device connected to a Mixer channel via the corresponding AUX 
Send knob. The AUX Send outputs are taken post channel fader, but you 
have the option of selecting Pre-fader mode for AUX Send 4 (by clicking 
the “P” button next to the send so that it lights up). In that mode, the send 
level is independent of the channel fader.
The sends are in stereo but can be used in mono as well. 

0 - 127
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The Mixer signal flow
The basic signal flow for a channel in the Mixer 14:2 is as follows:

Note that the Solo function is true “in-place” solo, meaning that if the channel uses Auxiliary sends routed to effect 
devices, the soloed output signal will also include the soloed channel(s) including any Aux Send effects. 

Note also that if the pre-fader send mode is activated for Aux 4 the send is tapped after the EQ and Pan controls but 
before the channel fader.

About the EQ modes

With Reason 2.5, the EQ modules in the Mixer were improved to get an even better sound and character. However, if 
you want to play back songs using the “old” EQ mode you can do that.

On the back of the Mixer 14:2 you will find a switch for this - select “Improved EQ” for the new EQ types or “Compat-
ible EQ” for the old-style EQ. The parameters are exactly the same in both cases.

FaderEQ Mute AUX Sends

Solo Master L/R Output

Effects DevicesAUX Returns 

Input

Aux 4 pre-fader 
mode

Pan
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The Auxiliary Return Section

The Auxiliary Returns provide an “extra” four stereo inputs in addition to the Mixer 14:2’s 14 stereo channels. The 
main function of Return channels is to provide inputs for connected Send effects devices. Each Aux Return channel 
has a level control, and a read-only tape label that display the name of the device connected to the Return channel.

The Master Fader

The Master L/R fader controls the summed output level of all channels in the Mixer 14:2. Use this to change the rel-
ative level of all channels, to make fade-outs etc.

Connections
All input and output connectors are as usual located on the back panel of the Mixer 14:2. Special connectors are 
used for “chaining” two or more Mixer 14:2 devices together. This is described on “Chaining several Mixer 14:2 de-
vices”.

Mixer Channel Connections

D Each mixer channel features stereo left/right inputs for connecting audio devices. 
Use the left input when manually connecting a mono signal source.

D In addition, there are two Control Voltage (CV) inputs (with associated voltage trim pots), for voltage control-
ling channel Level and Pan from other devices.
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Auxiliary (AUX) Send Out

D There are four stereo Send Out connectors, which normally are used to connect to the inputs of effect devices.
To connect a send to a mono-input device, use the Left (Mono) output.

When a Send is connected to an effects device, the corresponding AUX Send knob determines the level of the signal 
sent to the effect device for each channel. The Send Output is taken post-channel fader but you have the option of 
selecting pre-fader mode for AUX Send 4. 

D Note that some effects (for example the Comp-01 compressor or the PEQ2 parametric EQ) are effect types 
which are not designed to be used as AUX Send effects, but rather as insert effects, where the whole signal is 
passed through the effect. 
Alternatively, you could use AUX Send 4 in pre-fader mode and lower the channel fader completely.

Auxiliary (AUX) Returns

D There are four stereo Return input connectors.
These are normally connected to the left and right outputs of effect devices. 

Master Left/Right Outputs

• The Master outputs are auto-routed to the input pair of the first available Mix Channel device in the rack. 
If no Mix Channel device is available, one will be automatically created when you create a Mixer 14:2 device.

• In addition to the Master Out connectors, there is a Control Voltage (CV) input (and an associated trim pot), for 
voltage controlling the Master Level from another device.
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Chaining several Mixer 14:2 devices

Two chained Mixer 14:2 devices are connected like this, the top Mixer being the “Master” Mixer.

If you want more Mixer channels, you can chain several Mixer 14:2 devices.

D Select the existing Mixer 14:2 device and choose “Create:Mixer 14:2” from the Create menu or context menu. 
The new Mixer is automatically connected via the “Chaining Master” and “Chaining Aux” connectors of the se-
lected Mixer.

• The newly created Mixer’s Master Output is connected to the original Mixer’s Chaining Master input.
The Master Out Level for the new Mixer is now controllable from the original Mixer’s Master fader - so that this 
fader now controls the Master output level of both mixers.

• The newly created Mixer’s four stereo Aux Send outputs is connected to the original Mixer’s Chaining Aux con-
nectors.
The new Mixer will now have access to any Aux Send effects connected to the original Mixer, via the same corre-
sponding Aux Send(s).

This way, the two Mixers operate as “one”. 

! One exception is the Mute/Solo function, which is not chained. Thus, soloing a channel in one of the Mixers, 
will not mute the channels in the other Mixer.

You can create as many Mixers as you like, they will be chained in the same way, with one Mixer remaining the “mas-
ter” (i.e. it controls the Master level of all chained Mixers and supplies the Aux Send effect sources).

Partially or Non-Chained Mixers

You can also have several Mixers that are only partially or not chained at all. 

• You may for example wish to have different Aux Send effects for one Mixer. 
Then simply disconnect one or more of the Send Out to Chaining Aux connectors, and assign new Send effects.

D You could for example send the Master output of one Mixer to another Mix Channel device, instead of the 
Chaining Master inputs.
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Introduction

The Line Mixer 6:2 allows you to control the level, stereo placement (Pan) and effect mix (AUX Send) of each con-
nected audio device.

The Line Mixer is configured with 6 (stereo) input channels, which are combined and routed to the Left and Right 
Master outputs. 

Channel parameters
The channels are identical and contain an Auxiliary Send, Mute and Solo buttons, a Pan control, and a Level control:

The Auxiliary Return section
The AUX Return channels provide inputs for a connected send effect device. The Aux Return channels have a single 
level control on the front panel. 

Master level
The Master L/R fader controls the summed output level of all channels in the Mixer. Use this to change the relative 
level of all channels, to make fade-outs etc.

| Item | Description

Level control This controls the output level of each corresponding channel, allowing you to set the desired mix (balance) 
between different devices connected to the Line Mixer. 

Channel label Each channel in the mixer that has a device connected to it, displays a read-only label with the name of the 
device.

Channel meter The meter is a graphical representation of the channel output level. If the signal level pushes the meter into the 
range of the red area, try lowering either the output level of the device connected to the channel, or the Level 
control itself, to avoid distortion.

Pan control Use this control to set the left/right position of the channel in the stereo field. [Ctrl]-click (Win) or the Pan knob 
to set Pan to the default “0” (center position).

Mute (M) and 
Solo (S) Buttons

Clicking a channel’s Mute button silences the output of that channel. Click the button again to unmute the 
channel.
Clicking a channel’s Solo button silences all other mixer channels, so that you only hear the soloed channel. 
Several channels can be soloed at the same time. If this is the case, note that soloed channels can’t be muted 
with the Mute button. To mute one of several channels in solo mode you simply “unsolo” it.

Auxiliary (AUX) Effect Send The AUX Send controls the amount of channel signal that is to be sent to other devices - typically effect 
processors. The effect output is then normally returned to the Mixer via the AUX Return input where it is mixed 
with the dry (non-processed) signal. If you create an effect device when the Mixer is selected, the effect is auto-
routed to the Send/Return connectors. You can then control the amount of effect that is to be applied to any 
device connected to a Line Mixer channel via the AUX Send knob. The Send can be taken pre or post channel 
level - see “Auxiliary (AUX) Send”.
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Connections
All input and output connectors are as usual located on the back panel of the Line Mixer.

Mixer Channel Connections

D Each mixer channel features stereo left/right inputs for connecting audio devices. 
Use the left input when manually connecting a mono signal source.

D In addition, there is a Control Voltage (CV) input, for voltage controlling channel Pan from other devices.

Auxiliary (AUX) Send

D The Send connectors are used to connect to the inputs of effect devices.
To connect the send to a mono-input device, use the Left (Mono) output.

When a Send is connected to an effects device, the corresponding AUX Send knob determines the level of the signal 
sent to the effect device for each channel. 

The Send Output can be taken Pre or Post channel level by using the switch to the left of the Send connectors. 

Auxiliary (AUX) Return

These are normally connected to the left and right outputs of effect devices. 

Master Left/Right Outputs

• The Master outputs are auto-routed to the input pair of the first available Mix Channel device in the rack. 
If no Mix Channel device is available, one will be automatically created when you create a Line Mixer device.

If used in a Combi, the Master Outs are normally connected to the “From Devices” connectors on the Combinator.
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Introduction

The ID8 Instrument device is a synth module packed with great sounds - ideal for quickly creating nice complete ar-
rangements. The sounds have been extracted from various Reason devices and ReFills to guarantee supreme audio 
quality.

The Sounds
The ID8 contains 36 presets divided into nine categories, with four sounds in each category. The categories are 
these:

• Piano
The Piano category features a grand piano, an upright piano, a dance oriented piano sound and vibes.

• Electric Piano
The Electric Piano category holds two classic electric piano sounds plus a digital FM type piano and a Clav.

• Organ
The Organ category contains two classic tone-wheel organ sounds, one transistor organ sound and a pump organ.

• Guitar
The Guitar category sports an acoustic steel string guitar, a clean electric guitar, a half-acoustic jazz guitar and a 
dulcimer.

• Bass
The Bass category features one fingered and one picked electric bass, an acoustic upright bass and a synth bass.

• Strings
The Strings category holds orchestral strings, arco strings, a small string section and a choir sound.

• Brass-Wind
The Brass-Wind category features Fat Brass, Brass Section, French Horns and Flute.

• Synth
The Synth category contains two classic monophonic synth lead sounds and two characteristic polyphonic pad 
sounds, one with fast attack and one with slow.

• Drums
The Drums category sports four extensive combinations of drums and percussion instruments aimed at different 
musical styles. Each “drum kit” contains between 53 and 65 different instruments, so there is plenty to choose 
from!

See “Velocity mapping” for information about the velocity mapping of some of the sounds.

The ID8 and Standard MIDI Files
The ID8 device is used by default when you’re loading a Standard MIDI File into the Reason Essentials sequencer. 
For every MIDI track in the imported file, you will get an ID8 device loaded with a sound that resembles the original 
sound. This serves as a starting point to be able to play back the imported MIDI file. However, you could of course 
change sound or replace the ID8 with another instrument device afterwards.
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Using the ID8

Selecting Sounds
D Select Category by clicking the Up/Down buttons to the left of the Display.

D Select Sound in the selected Category by clicking on any of the A-D buttons, or by clicking on the Sound name 
in the Display.

D Click on the Category name in the ID8 Display to bring up a pop-up where you can select Category or replace 
the ID8 device with another device.

At the bottom of the pop-up, you can also choose “Browse Instruments...”. Selecting this allows you to replace the 
ID8 device with another instrument device and load a new sound in that device.
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Controlling Sounds

Parameter knobs

Each of the Sounds in the ID8 have two preset parameters assigned to the Parameter 1 and 2 knobs. The parameter 
names are shown in the small displays to the right of the corresponding knobs, and are different depending on the 
selected Sound.

Pitch Bend and Mod Wheel

To the left on the ID8 front panel are the standard Pitch Bend and Mod Wheel. The Pitch Bend range is +/- 2 semi-
tones and is the same for all sounds. The Mod Wheel is assigned a little differently depending on the selected Sound, 
but usually controls vibrato. In the Drums Category, however, the Mod Wheel has no effect, except on the Electronic 
Drums where it controls the cutoff frequency of a lowpass filter.

Performance Controllers

The sounds in the ID8 also respond to the standard Performance controllers “Sustain Pedal”, “Aftertouch”, “Expres-
sion” and “Breath Control”. The parameter assignments can be a little different depending on selected sound. How-
ever, “Sustain Pedal” always controls sustain and “Expression” always controls volume.

Velocity mapping

A lot of the sounds in the ID8 are multi-sampled. They also have several velocity layers to faithfully reproduce the 
original instruments. Some of the sounds also use different types of samples for the highest velocity layer. This 
means that instead of just sounding louder, they will also sound different. For example, the Jazz Semi Guitar as well 
as the Finger, Pick and Upright basses have glissando or sliding notes in the highest velocity layer. The Arco Strings 
have pizzicato (picked) notes in the top velocity layer.

About saving edited Sounds
Since the ID8 is designed as a “preset” sound module, there is no dedicated function for saving edited Sounds. How-
ever, any edits you have made of the parameters in a Sound are automatically stored with the song (document) when 
you save the song.

q You could also include one or several ID8 Instrument devices in a Combinator device and save the Combinator 
patch. Doing so will automatically store the settings of the ID8 Parameters in the Combinator patch. See “The 
Combinator” for more details.
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Introduction
Subtractor is an analog-type polyphonic synthesizer based on subtractive synthesis, the method used in analog syn-
thesizers. This chapter will go through all parameters of each section of Subtractor. In addition to the parameter de-
scriptions, the chapter also includes a few tips and tricks to help you get the most out of the Subtractor synthesizer.

! It is recommended that you start with default settings (an “Init Patch”) if you intend to follow the examples in 
this chapter, unless otherwise is stated. An Init Patch is created by selecting “Initialize Patch” from the Edit 
menu. If you wish to keep the current settings, save them before initializing.

The Subtractor has the following basic features:

D Up to 99 Voice Polyphony.
You can set the number of voices for each Patch.

D Dual Filters.
A combination of a multimode filter and a second, linkable, lowpass filter allows for complex filtering effects. See 
“The Filter Section”.

D Two Oscillators, each with 32 waveforms.
See “The Oscillator Section”.

D Frequency Modulation (FM). 
See “Frequency Modulation (FM)”.

D Oscillator Phase Offset Modulation.
This is an unique Subtractor feature that generates waveform variations. See “Phase Offset Modulation”.

D Two Low Frequency Oscillators (LFO’s)
See “LFO Section”.

D Three Envelope Generators.
See “Envelopes - General”.

D Extensive Velocity Control.
See “Velocity Control”.

D Extensive CV/Gate Modulation possibilities.
See “Connections”.

Loading and Saving Patches
Loading and saving patches is done in the same way as with any other Reason Essentials patch based device - see 
“Loading patches” and “Saving patches”.
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The Oscillator Section

Subtractor provides two oscillators. Oscillators are the main sound generators in Subtractor, the other features are 
used to shape the sound of the oscillators. Oscillators generate two basic properties, waveform and pitch (frequency). 
The type of waveform the oscillator produces determines the harmonic content of the sound, which in turn affects the 
resultant sound quality (timbre). Selecting a oscillator waveform is usually the starting point when creating a new 
Subtractor Patch from scratch.

Oscillator 1 Waveform

Oscillator 1 provides 32 waveforms. The first four are standard waveforms, and the rest are “special” waveforms, 
some of which are suitable for emulating various musical instrument sounds.

q It is worth noting here that all waveforms can be radically transformed using Phase offset modulation (see 
“Phase Offset Modulation”). 

D To select a waveform, click the spin controls to the right of the “Waveform” LED display. 
The first 4 basic waveforms are shown as standard symbols, and the special waveforms are numbered 5 - 32. 
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Here follows a brief description of the Subtractor waveforms:

! Please note that the descriptions of the waveforms sound or timbre is merely meant to provide a basic guide-
line, and shouldn’t be taken too literally. Given the myriad ways you can modulate and distort a waveform in 
Subtractor, you can produce extremely different results from any given waveform.

| Waveform | Description

Sawtooth This waveform contains all harmonics and produces a bright and rich sound. The Sawtooth is perhaps the 
most “general purpose” of all the available waveforms.

Square A square wave only contains odd number harmonics, which produces a distinct, hollow sound.

Triangle The Triangle waveform generates only a few harmonics, spaced at odd harmonic numbers. This produces 
a flute-like sound, with a slightly hollow character.

Sine The sine wave is the simplest possible waveform, with no harmonics (overtones). The sine wave produces 
a neutral, soft timbre.

5 This waveform emphasizes the higher harmonics, a bit like a sawtooth wave, only slightly less bright-sound-
ing.

6 This waveform features a rich, complex harmonic structure, suitable for emulating the sound of an acoustic 
piano.

7 This waveform generates a glassy, smooth timbre. Good for electric piano-type sounds.

8 This waveform is suitable for keyboard-type sounds such as harpsichord or clavinet.

9 This waveform is suitable for electric bass-type sounds.

10 This is a good waveform for deep, sub-bass sounds.

11 This produces a waveform with strong formants, suitable for voice-like sounds.

12 This waveform produces a metallic timbre, suitable for a variety of sounds.

13 This produces a waveform suitable for organ-type sounds.

14 This waveform is also good for organ-type sounds. Has a brighter sound compared to waveform 13.

15 This waveform is suitable for bowed string sounds, like violin or cello.

16 Similar to 15, but with a slightly different character.

17 Another waveform suitable for string-type sounds.

18 This waveform is rich in harmonics and suitable for steel string guitar-type sounds.

19 This waveform is suitable for brass-type sounds.

20 This waveform is suitable for muted brass-type sounds.

21 This waveform is suitable for saxophone-like sounds.

22 A waveform suitable for brass and trumpet-type sounds.

23 This waveform is good for emulating mallet instruments such as marimba.

24 Similar to 23, but with a slightly different character.

25 This waveform is suitable for guitar-type sounds.

26 This is a good waveform for plucked string sounds, like harp.

27 Another waveform suitable for mallet-type sounds (see 23-24), but has a brighter quality, good for vibra-
phone-type sounds.
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Setting Oscillator 1 Frequency - Octave/Semitone/Cent

By clicking the corresponding up/down buttons you can tune, i.e. change the frequency of Oscillator 1 in three ways:

D In Octave steps 
The range is 0 - 9. The default setting is 4 (where “A” above middle “C” on your keyboard generates 440 Hz). 

D In Semitone steps 
Allows you to raise the frequency in 12 semitone steps (1 octave).

D In Cent steps (100th of a semitone) 
The range is -50 to 50 (down or up half a semitone).

Oscillator Keyboard Tracking

Oscillator 1 has a button named “Kbd. Track”. If this is switched off, the oscillator pitch will remain constant, regard-
less of any incoming note pitch messages, although the oscillator still reacts to note on/off messages. This can be 
useful for certain applications:

D When Frequency Modulation (FM - see “Frequency Modulation (FM)”) or Ring Modulation (see “Ring Modula-
tion”) is used.
This produces enharmonic sounds with very varying timbre across the keyboard.

D For special effects and non-pitched sounds (like drums or percussion) that should sound the same across the 
keyboard.

Using Oscillator 2

You activate Osc 2 by clicking the button next to the text “Osc 2“. Setting oscillator frequency and keyboard tracking 
is identical to Oscillator 1.

28 Similar to 27, but with a slightly different character.

29 This waveform has complex, enharmonic overtones, suitable for metallic bell-type sounds.

30 Similar to 29, but with a slightly different character. By using FM and setting the Osc Mix to Osc 1, this and 
the following two waveforms can produce noise.

31 Similar to 30, but with a slightly different character.

32 Similar to 30, but with a slightly different character.

| Waveform | Description
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Adding a second oscillator enables many new modulation possibilities which can produce richer timbres. A basic ex-
ample is to slightly detune (+/– a few cents) one of the oscillators. This slight frequency offset causes the oscillators 
to “beat” against each other, producing a wider and richer sound. Also, by combining two different waveforms, and 
adding frequency or ring modulation, many new timbres can be created.

Oscillator Mix 

The Osc Mix knob determines the output balance between Osc 1 and Osc 2. To be able to clearly hear both oscilla-
tors, the “Osc Mix” knob should be set somewhere around the center position. If you turn the Mix knob fully to the left, 
only Osc 1 will be heard, and vice versa. [Command]/[Ctrl]-clicking the knob sets the Mix parameter to center posi-
tion.

Oscillator 2 Waveform
The waveform alternatives for Oscillator 2 are identical to those of Oscillator 1.

However, the Noise Generator provides a third sound generating source (in addition to the two oscillators) in Sub-
tractor, and could be regarded as an “extra” waveform for Oscillator 2, as it is internally routed to the Oscillator 2 out-
put. See below for a description of the Noise Generator.

Noise Generator

The Noise Generator could be viewed as an oscillator that produces noise instead of a pitched waveform. Noise can 
be used to produce a variety of sounds, the classic example being “wind” or “rolling wave” sounds, where noise is 
passed through a filter while modulating the filter frequency. Other common applications include non-pitched sounds 
like drums and percussion, or simulating breath noises for wind instruments. To use the Noise Generator, select an 
Init Patch and proceed as follows:
1. Turn Osc 2 off.

2. Click the button (in the Noise Generator section) to activate the Noise Generator.
If you play a few notes on your MIDI instrument you should now hear Osc1 mixed with the sound of the Noise 
Generator.

3. Turn the Mix knob fully to the right, and play a few more notes.
Now just the Noise Generator will be heard. 

D Thus, the output of the Noise Generator is internally routed to Osc 2.
If you switch Osc 2 on, the noise will be mixed with the Osc 2 waveform.
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There are three Noise Generator parameters. These are as follows:

Phase Offset Modulation
A unique feature of the Subtractor oscillators is the ability to create an extra waveform within one oscillator, to offset 
the phase of that extra waveform, and to modulate this phase offset. By subtracting or multiplying a waveform with a 
phase offset copy of itself, very complex waveforms can be created. Sounds complicated? Well, the theory behind it 
might be, but from a user perspective it is just a method of generating new waveforms from existing waveforms.

A seasoned synth programmer using Subtractor for the first time may wonder why the Subtractor oscillators (seem-
ingly) cannot provide the commonly used pulse waveform and the associated pulse width modulation (PWM). Or os-
cillator sync, another common feature in analog synthesizers. The simple answer is that Subtractor can easily create 
pulse waveforms (with PWM) and oscillator sync-sounds, and a lot more besides, partly by the use of phase offset 
modulation.

Each oscillator has it's own Phase knob and a selector button. The Phase knob is used to set the amount of phase 
offset, and the selector switches between three modes:

• Waveform multiplication (x) 

• Waveform subtraction (–) 

• No phase offset modulation (o).

| Parameter | Description

Noise Decay This controls how long it takes for the noise to fade out when you play a note. Note that this is inde-
pendent from the Amp Envelope Decay parameter, allowing you to mix a short “burst” of noise at the 
very beginning of a sound, i.e. a pitched sound that uses oscillators together with noise.

Noise Color This parameter allows you to vary the character of the noise. If the knob is turned fully clockwise, pure 
or “white” noise (where all frequencies are represented with equal energy) is generated. Turning the 
knob anti-clockwise produces a gradually less bright sounding noise. Fully anti-clockwise the noise 
produced is an earthquake-like low frequency rumble.

Level Controls the level of the Noise Generator.
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When phase offset modulation is activated, the oscillator creates a second waveform of the same shape and offsets 
it by the amount set with the Phase knob. Depending on the selected mode, Subtractor then either subtracts or mul-
tiplies the two waveforms with each other. The resulting waveforms can be seen in the illustration below.

• In example 1, we see two sawtooth waves with a slight offset. 

• Example 2 shows that subtracting one slightly offset sawtooth wave from the other, produces a pulse wave. If 
you modulate the Phase offset parameter (with for example an LFO), the result will be pulse width modulation 
(PWM).

• Example 3 shows the resulting waveform when multiplying the offset waves with each other. As you can see 
(and hear if you try it), multiplying waveforms can produce very dramatic and sometimes unexpected results.

Using phase offset modulation can create very rich and varied timbres, especially when used along with LFO or En-
velopes to modulate the phase offset.

q To get a “feel” for this concept, you could study Patches that use phase offset modulation, and maybe tweak 
some of the Phase Offset parameters to find out what happens. Try “SyncedUp” in the Polysynth category in 
the Factory Soundbank for an example of osc sync or “Sweeping Strings” (in the Pads category) for an exam-
ple of PWM.

! Note that if you activate waveform subtraction with a Phase offset set to “0” for an oscillator, the second wave-
form will cancel out the original waveform completely, and the oscillator output will be silent. If you set the 
Phase Offset knob to any other value than zero, the sound returns.

1. The two offset 
waveforms:

2. The result of 
subtraction:

3. The result of 
multiplication:

Ampl.

Ampl.

Ampl.

t.

t.

t.
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Frequency Modulation (FM)

In synthesizer-speak, Frequency Modulation, or FM, is when the frequency of one oscillator (called the “carrier”) is 
modulated by the frequency of another oscillator (called the “modulator”). Using FM can produce a wide range of har-
monic and non harmonic sounds. In Subtractor, Osc 1 is the carrier and Osc 2 the modulator. To try out some of the 
effects FM can produce, proceed as follows:
1. Select an Init Patch by selecting “Initialize Patch” from the Edit menu.

2. Activate Osc 2.
As you need both a carrier and a modulator to produce FM, turning the FM knob will not produce any effect unless 
you first activate Osc 2. For classic FM sounds, use sine wave on oscillator 1 and triangle wave on oscillator 2.

3. Use the FM knob to set the FM amount to a value of about 50.
As you can hear, the timbre changes, but the effect isn’t very pronounced yet.

4. Turn the Osc Mix knob fully to the left, so that only the sound of Osc 1 is heard.
The modulator (Osc 2) still affects Osc 1, even though the Osc 2 output is muted.

5. Now, hold down a note on your MIDI keyboard and tune Osc 2 a fifth up from the original pitch by setting the 
Osc 2 frequency “Semi” parameter to a value of 7.
As you can hear, for each semitone step you vary the Osc 2 frequency, the timbre changes dramatically. Setting 
Osc 2 frequency to certain musical intervals (i.e. fourth, fifth or octave semitone steps) produces harmonic, rich 
timbres, almost like tube distortion. Setting Osc 2 to non-musical intervals usually results in complex, enharmonic 
timbres.

q Experiment with different oscillator parameters such as phase offset modulation, changing the waveforms etc. 
and listen to how they affect the sound of frequency modulation.

Using the Noise Generator as the Modulator source

As explained earlier, the Noise Generator is internally routed to the Osc 2 output. Hence, if you deactivate Osc 2, and 
activate the Noise Generator while using FM, the noise will be used to frequency modulate Osc 1. 

q With the Noise Generators default settings, this will sound much like colored noise. But by changing (lower-
ing) the Noise Generator Decay parameter, so that the noise modulates only the attack portion of the sound 
can produce more interesting results. You could also use a combination of noise and Osc 2.
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Ring Modulation

Ring Modulators basically multiply two audio signals together. The ring modulated output contains added frequencies 
generated by the sum of, and the difference between, the frequencies of the two signals. In the Subtractor Ring Mod-
ulator, Osc 1 is multiplied with Osc 2 to produce sum and difference frequencies. Ring modulation can be used to 
create complex and enharmonic, bell-like sounds.
1. Select an Init Patch by selecting “Initialize Patch” from the Edit menu.

Save any current settings you wish to keep before initializing.

2. Activate Ring Modulation with the button in the lower right corner of the oscillator section.

3. Activate Osc 2.
You need to activate Osc 2 before any ring modulation can happen.

4. Turn the Osc Mix knob fully to the right, so that only the sound of Osc 2 is heard.
Osc 2 provides the ring modulated output.

5. If you play a few notes while varying the frequency of either oscillator, by using the Semitone spin controls, 
you can hear that the timbre changes dramatically.
If the oscillators are tuned to the same frequency, and no modulation is applied to either the Osc 1 or 2 frequency, 
the Ring Modulator won’t do much. It is when the frequencies of Osc 1 and Osc 2 differ, that you get the “true” 
sound of ring modulation.
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The Filter Section

In subtractive synthesis, a filter is the most important tool for shaping the overall timbre of the sound. The filter sec-
tion in Subtractor contains two filters, the first being a multimode filter with five filter types, and the second being a 
low-pass filter. The combination of a multimode filter and a lowpass filter can be used to create very complex filter ef-
fects.

Filter 1 Type
With this multi-selector you can set Filter 1 to operate as one of five different types of filter. The five types are illus-
trated and explained on the following pages:

• 24 dB Lowpass (LP 24)
Lowpass filters lets low frequencies pass and cuts out the high frequencies. This filter type has a fairly steep roll-
off curve (24dB/Octave). Many classic synthesizers (Minimoog/Prophet 5 etc.) use this filter type.

The darker curve illustrates the roll-off curve of the 24dB Lowpass Filter. The lighter curve in the middle represents the filter 
characteristic when the Resonance parameter is raised.
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• 12 dB Lowpass (LP 12)
This type of lowpass filter is also widely used in analog synthesizers (Oberheim, early Korg synths etc.). It has a 
gentler slope (12 dB/Octave), leaving more of the harmonics in the filtered sound compared to the LP 24 filter.

The darker curve illustrates the roll-off curve of the 12dB Lowpass Filter. The lighter curve in the middle represents the filter 
characteristic when the Resonance parameter is raised.

• Bandpass (BP 12)
A bandpass filter cuts both high and low frequencies, while midrange frequencies are not affected. Each slope in 
this filter type has a 12 dB/Octave roll-off.

The darker curve illustrates the roll-off curve of the Bandpass Filter. The lighter curve in the middle represents the filter 
characteristic when the Resonance parameter is raised.
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• Highpass (HP12)
A highpass filter is the opposite of a lowpass filter, cutting out lower frequencies and letting high frequencies pass. 
The HP filter slope has a 12 dB/Octave roll-off.

The darker curve illustrates the roll-off curve of the Highpass Filter. The lighter curve in the middle represents the filter 
characteristic when the Resonance parameter is raised.

• Notch
A notch filter (or band reject filter) could be described as the opposite of a bandpass filter. It cuts off frequencies 
in a narrow midrange band, letting the frequencies below and above through. On its own, a notch filter doesn’t re-
ally alter the timbre in any dramatic way, simply because most frequencies are let through. However, by combining 
a notch filter with a lowpass filter (using Filter 2 - see “Filter 2”), more musically useful filter characteristics can be 
created. Such a filter combination can produce soft timbres that still sound “clear”. The effect is especially notice-
able with low resonance (see “Resonance”) settings.

The darker curve illustrates the roll-off curve of the Notch Filter. The lighter curve in the middle represents the filter 
characteristic when the Resonance parameter is raised.
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Filter 1 Frequency
The Filter Frequency parameter (often referred to as “cutoff”) determines which area of the frequency spectrum the 
filter will operate in. For a lowpass filter, the frequency parameter could be described as governing the “opening” and 
“closing” of the filter. If the Filter Freq is set to zero, none or only the very lowest frequencies are heard, if set to max-
imum, all frequencies in the waveform are heard. Gradually changing the Filter Frequency produces the classic syn-
thesizer filter “sweep” sound.

! Note that the Filter Frequency parameter is usually controlled by the Filter Envelope (see “Filter Envelope”) as 
well. Changing the Filter Frequency with the Freq slider may therefore not produce the expected result.

Resonance 
The filter resonance parameter is used to set the Filter characteristic, or quality. For lowpass filters, raising the filter 
Res value will emphasize the frequencies around the set filter frequency. This produces a generally thinner sound, but 
with a sharper, more pronounced filter frequency “sweep”. The higher the filter Res value, the more resonant the 
sound becomes until it produces a whistling or ringing sound. If you set a high value for the Res parameter and then 
vary the filter frequency, this will produce a very distinct sweep, with the ringing sound being very evident at certain 
frequencies.

• For the highpass filter, the Res parameter operates just like for the lowpass filters.

• When you use the Bandpass or Notch filter, the Resonance setting adjusts the width of the band. When you 
raise the Resonance, the band where frequencies are let through (Bandpass), or cut (Notch) will become nar-
rower. Generally, the Notch filter produces more musical results using low resonance settings.

Filter Keyboard Track (Kbd)
If Filter Keyboard Track is activated, the filter frequency will increase the further up on the keyboard you play. If a low-
pass filter frequency is constant (a Kbd setting of “0”) this can introduce a certain loss of “sparkle” in a sound the 
higher up the keyboard you play, because the harmonics in the sound are progressively being cut. By using a degree 
of Filter Keyboard Tracking, this can be compensated for.
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Filter 2 
A very useful and unusual feature of the Subtractor Synthesizer is the presence of an additional 12dB/Oct lowpass 
filter. Using two filters together can produce many interesting filter characteristics, that would be impossible to create 
using a single filter, for example formant effects. 

The parameters are identical to Filter 1, except in that the filter type is fixed, and it does not have filter keyboard 
tracking.

D To activate Filter 2, click the button at the top of the Filter 2 section. 
Filter 1 and Filter 2 are connected in series. This means that the output of Filter 1 is routed to Filter 2, but both fil-
ters function independently. For example, if Filter 1 was filtering out most of the frequencies, this would leave Filter 
2 very little to “work with”. Similarly, if Filter 2 had a filter frequency setting of “0”, all frequencies would be filtered 
out regardless of the settings of Filter 1.

q Try the “Singing Synth” patch (in the Monosynth category of the Factory Sound Bank) for an example of how 
dual filters can be used.

Filter Link

When Link (and Filter 2) is activated, the Filter 1 frequency controls the frequency offset of Filter 2. That is, if you 
have set different filter frequency values for Filter 1 and 2, changing the Filter 1 frequency will also change the fre-
quency for Filter 2, but keeping the relative offset. 

q Try the “Fozzy Fonk” patch (in the Polysynth category of the Factory Sound Bank) for an example how linked 
filters can be used.

! Caution! If no filter modulation is used, and the filters are linked, pulling down the frequency of Filter 2 to zero 
will cause both filters to be set to the same frequency. If combined with high Res settings, this can produce 
very loud volume levels that cause distortion!
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Envelopes - General
Envelope generators are used to control several important sound parameters in analog synthesizers, such as pitch, 
volume, filter frequency etc. Envelopes govern how these parameters should respond over time - from the moment a 
note is struck to the moment it is released. 

Standard synthesizer envelope generators have four parameters; Attack, Decay, Sustain and Release (ADSR). 

There are three envelope generators in the Subtractor, one for volume, one for the Filter 1 frequency, and one mod-
ulation envelope which has selectable modulation destinations. 

The ADSR envelope parameters.

Attack

When you play a note on your keyboard, the envelope is triggered. This means it starts rising from zero to the maxi-
mum value. How long this should take, depends on the Attack setting. If the Attack is set to “0”, the maximum value 
is reached instantly. If this value is raised, it will take time before the maximum value is reached.

For example, if the Attack value is raised and the envelope is controlling the filter frequency, the filter frequency will 
gradually rise up to a point each time a key is pressed, like an “auto-wha” effect. 

Decay

After the maximum value has been reached, the value starts to drop. How long this should take is governed by the 
Decay parameter. 

If you wanted to emulate the volume envelope of a note played on a piano for example, the Attack should be set to 
“0” and the Decay parameter should be set to a medium value, so that the volume gradually decreases down to si-
lence, even if you keep holding the key down. Should you want the decay to drop to some other value than zero, you 
use the Sustain parameter.

Sustain

The Sustain parameter determines the level the envelope should rest at, after the Decay. If you set Sustain to full 
level, the Decay setting is of no importance since the volume of the sound is never lowered.

Attack
(time)

Decay
(time)

Sustain
(level)

Release
(time)

Key Down Key Up

Level

Time
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If you wanted to emulate the volume envelope of an organ, you theoretically only really need to use the Sustain pa-
rameter set to full level, as a basic organ volume envelope instantly goes to the maximum level (Attack “0”) and stays 
there (Decay “0”), until the key is released and the sound instantly stops (Release “0”). 

But often a combination of Decay and Sustain is used to generate envelopes that rise up to the maximum value, then 
gradually decreases to finally land to rest on a level somewhere in-between zero and maximum. Note that Sustain 
represents a level, whereas the other envelope parameters represent times.

Release

Finally, we have the Release parameter. This works just like the Decay parameter, except it determines the time it 
takes for the value to fall back to zero after releasing the key.

Amplitude Envelope

The Amplitude Envelope is used to adjust how the volume of the sound should change from the time you press a key 
until the key is released. By setting up a volume envelope you sculpt the sound’s basic shape with the four Amplitude 
Envelope parameters, Attack, Decay, Sustain and Release. This determines the basic character of the sound (soft, 
long, short etc.).

Filter Envelope

The Filter Envelope affects the Filter 1 Frequency parameter. By setting up a filter envelope you control the how the 
filter frequency should change over time with the four Filter Envelope parameters, Attack, Decay, Sustain and Re-
lease. 

Filter Envelope Amount

This parameter determines to what degree the filter will be affected by the Filter Envelope. Raising this knob’s value 
creates more drastic results. The Envelope Amount parameter and the set Filter Frequency are related. If the Filter 
Freq slider is set to around the middle, this means that the moment you press a key the filter is already halfway open. 
The set Filter Envelope will then open the filter further from this point. The Filter Envelope Amount setting affects 
how much further the filter will open.
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Filter Envelope Invert

If this button is activated, the envelope will be inverted. For example, normally the Decay parameter lowers the filter 
frequency, but after activating Invert it will instead raise it, by the same amount. 

Mod Envelope

The Mod Envelope allows you to select one of a number of parameters, or Destinations, to control with the envelope. 
By setting up a modulation envelope you control the how the selected Destination parameter should change over 
time with the four Mod Envelope parameters, Attack, Decay, Sustain and Release. 

The available Mod Envelope Destinations are as follows:

| Destination | Description

Osc 1 Selecting this makes the Mod Envelope control the pitch (frequency) of Osc 1.

Osc 2 Same as above, but for Osc 2.

Osc Mix Selecting this makes the Mod Envelope control the oscillator Mix parameter. Both oscillators must be acti-
vated for this to have any effect.

FM Selecting this makes the Mod Envelope control the FM Amount parameter. Both oscillators must be acti-
vated for this to have any effect.

Phase Selecting this makes the Mod Envelope control the Phase Offset parameter for both Osc 1 and 2. Note 
that Phase Offset Modulation (Subtraction or Multiplication) must be activated for this to have any effect.

Freq 2 Selecting this makes the Mod Envelope control the Frequency parameter for Filter 2.
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LFO Section

LFO stands for Low Frequency Oscillator. LFO’s are oscillators, just like Osc 1 & 2, in that they also generate a wave-
form and a frequency. However, there are two significant differences:

• LFOs only generate waveforms with low frequencies.

• The output of the two LFO’s are never actually heard. Instead they are used for modulating various parameters.

The most typical application of an LFO is to modulate the pitch of a (sound generating) oscillator, to produce vibrato. 
Subtractor is equipped with two LFO’s. The parameters and the possible modulation destinations vary somewhat be-
tween LFO 1 and LFO 2.

LFO 1 Parameters

Waveform

LFO 1 allows you to select different waveforms for modulating parameters. These are (from top to bottom):

Destination

The available LFO 1 Destinations are as follows:

| Waveform | Description

Triangle This is a smooth waveform, suitable for normal vibrato.

Inverted Sawtooth This produces a “ramp up” cycle. If applied to an oscillator’s frequency, the pitch would sweep up to a set point 
(governed by the Amount setting), after which the cycle immediately starts over.

Sawtooth This produces a “ramp down” cycle, the same as above but inverted.

Square This produces cycles that abruptly changes between two values, usable for trills etc.

Random Produces random stepped modulation to the destination. On some vintage synths, this is called “sample & hold”.

Soft Random The same as above, but with smooth modulation.

| Destination | Description

Osc 1&2 Selecting this makes LFO 1 control the pitch (frequency) of Osc 1 and Osc 2.

Osc 2 Same as above, but for Osc 2.

Filter Freq Selecting this makes the LFO 1 control the filter frequency for Filter 1 (and Filter 2 if linked). 

FM Selecting this makes the LFO 1 control the FM Amount parameter. Both oscillators must be activated for this to 
have any effect.

Phase Selecting this makes the LFO 1 control the Phase Offset parameter for both Osc 1 and 2. Note that Phase Off-
set Modulation (Subtraction or Multiplication) must be activated for this to have any effect.

Osc Mix Selecting this makes the LFO 1 control the oscillator Mix parameter. 
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Sync

By clicking this button you activate/deactivate LFO sync. The frequency of the LFO will then be synchronized to the 
song tempo, in one of 16 possible time divisions. When sync is activated, the Rate knob (see below) is used for set-
ting the desired time division.

Turn the knob and check the tooltip for an indication of the time division.

Rate

The Rate knob controls the LFO’s frequency. Turn clockwise for a faster modulation rate.

Amount

This parameter determines to what degree the selected parameter destination will be affected by LFO 1. Raising this 
knob’s value creates more drastic results.

LFO 2 Parameters
LFO 2 is polyphonic. This means that for every note you play, an independent LFO cycle is generated, whereas LFO 
1 always modulates the destination parameter using the same “cycle”. This can be used to produce subtle cross-
modulation effects, with several LFO cycles that “beat” against each other. This also enables LFO 2 to produce mod-
ulation rates that vary across the keyboard (see the “Keyboard Tracking” parameter below). 

Destination

The available LFO 2 Destinations are as follows:

LFO 2 Delay

This parameter is used to set a delay between when a note is played and when the LFO modulation “kicks in”. For ex-
ample, if Osc 1 & 2 is selected as the destination parameter and Delay was set to a moderate value, the sound would 
start out unmodulated, with the vibrato only setting in if you hold the note(s) long enough. Delayed LFO modulation 
can be very useful, especially if you are playing musical instrument-like sounds like violin or flute. Naturally it could 
also be used to control more extreme modulation effects and still retain the “playability” of the sound.

LFO 2 Keyboard Tracking

If LFO keyboard tracking is activated, the LFO rate will progressively increase the higher up on the keyboard you play. 
Raising this value creates more drastic results.

| Destination | Description

Osc 1&2 Selecting this makes LFO 2 modulate the pitch (frequency) of Osc 1 and Osc 2.

Phase Selecting this makes the LFO 2 modulate the Phase Offset parameter for both Osc 1 and 2. Note that 
Phase Offset Modulation (Subtraction or Multiplication) must be activated for this to have any effect. 

Filter Freq 2 Selecting this makes the LFO 2 modulate the filter frequency for Filter 2. 

Amp Selecting this makes the LFO 2 modulate the overall volume., to create tremolo-effects.
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q If the LFO is set to modulate the phase offset, LFO keyboard tracking can produce good results. For example, 
synth string pads and other sounds that use PWM (see “Phase Offset Modulation”) can benefit from this.

Rate

The Rate knob controls the LFO’s frequency. Turn clockwise for a faster modulation rate.

Amount

This parameter determines to what degree the selected parameter destination will be affected by LFO 2. Raising this 
knob’s value creates more drastic results.

Play Parameters
This section deals with two things: Parameters that are affected by how you play, and modulation that can be applied 
manually with standard MIDI keyboard controls. 

These are:

• Velocity Control

• Pitch Bend and Modulation Wheel

• Legato

• Portamento

• Polyphony

Velocity Control

Velocity is used to control various parameters according to how hard or soft you play notes on your keyboard. A com-
mon application of velocity is to make sounds brighter and louder if you strike the key harder. Subtractor features 
very comprehensive velocity modulation capabilities. By using the knobs in this section, you can control how much the 
various parameters will be affected by velocity. The velocity sensitivity amount can be set to either positive or negative 
values, with the center position representing no velocity control. 
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The following parameters can be velocity controlled:

Pitch Bend and Modulation Wheels

The Pitch Bend wheel is used for “bending” notes, like bending the strings on a guitar. The Modulation wheel can be 
used to apply various modulation while you are playing. Virtually all MIDI keyboards have Pitch Bend and Modulation 
controls. Subtractor features not only the settings for how incoming MIDI Pitch Bend and Modulation wheel mes-
sages should affect the sound. Subtractor also has two functional wheels that could be used to apply real time mod-
ulation and pitch bend should you not have these controllers on your keyboard, or if you aren’t using a keyboard at all. 
The Subtractor wheels mirror the movements of the MIDI keyboard controllers.

Pitch Bend Range

The Range parameter sets the amount of pitch bend when the wheel is turned fully up or down. The maximum range 
is “24” (=up/down 2 Octaves).

| Destination | Description

Amp This let’s you velocity control the overall volume of the sound. If a positive value is set, the volume will in-
crease the harder you strike a key. A negative value inverts this relationship, so that the volume decreases 
if you play harder, and increases if you play softer. If set to zero, the sound will play at a constant volume, 
regardless of how hard or soft you play. 

FM This sets velocity control for the FM Amount parameter. A positive value will increase the FM amount the 
harder you play. Negative values invert this relationship.

M. Env This sets velocity control for the Mod Envelope Amount parameter. A positive value will increase the enve-
lope amount the harder you play. Negative values invert this relationship.

Phase This sets velocity control for the Phase Offset parameter. This applies to both Osc 1 & 2, but the relative 
offset values are retained. A positive value will increase the phase offset the harder you play. Negative val-
ues invert this relationship.

Freq 2 This sets velocity control for the Filter 2 Frequency parameter. A positive value will increase the filter fre-
quency the harder you play. Negative values invert this relationship.

F. Env This sets velocity control for the Filter Envelope Amount parameter. A positive value will increase the en-
velope amount the harder you play. Negative values invert this relationship.

F. Dec This sets velocity control for the Filter Envelope Decay parameter. A positive value will increase the Decay 
time the harder you play. Negative values invert this relationship.

Osc Mix This sets velocity control for the Osc Mix parameter. A positive value will increase the Osc 2 Mix amount 
the harder you play. Negative values invert this relationship.

A. Attack This sets velocity control for the Amp Envelope Attack parameter. A positive value will increase the Attack 
time the harder you play. Negative values invert this relationship.
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Modulation Wheel

The Modulation wheel can be set to simultaneously control a number of parameters. You can set positive or negative 
values, just like in the Velocity Control section. The following parameters can be affected by the modulation wheel:

Legato
Legato works best with monophonic sounds. Set Polyphony (see below) to 1 and try the following:

D Hold down a key and press another key without releasing the previous.
Notice that the pitch changes, but the envelopes do not start over. That is, there will be no new “attack”. 

D If polyphony is set to more voices than 1, Legato will only be applied when all the assigned voices are “used 
up”.
For example, if you had a polyphony setting of “4” and you held down a 4 note chord, the next note you played 
would be Legato. Note, however, that this Legato voice will “steal” one of the voices in the 4 note chord, since all 
the assigned voices were already used up!

Retrig
This is the “normal” setting for playing polyphonic patches. That is, when you press a key without releasing the previ-
ous, the envelopes are retriggered, like when you release all keys and then press a new one. In monophonic mode, 
Retrig has an additional function; if you press a key, hold it, press a new key and then release that, the first note is 
also retriggered.

Portamento (Time)
Portamento is when the pitch “glides” between the notes you play, instead of instantly changing the pitch. The Porta-
mento knob is used to set how long it takes for the pitch to glide from one pitch to the next. If you don’t want any Por-
tamento at all, set this knob to zero.

| Parameter | Description

F. Freq This sets modulation wheel control of the Filter 1 Frequency parameter. A positive value will increase the 
frequency if the wheel is pushed forward. Negative values invert this relationship.

F. Res This sets modulation wheel control of the Filter 1 Resonance parameter. A positive value will increase the 
resonance if the wheel is pushed forward. Negative values invert this relationship.

LFO 1 This sets modulation wheel control of the LFO 1 Amount parameter. A positive value will increase the 
Amount if the wheel is pushed forward. Negative values invert this relationship.

Phase This sets modulation wheel control of the Phase Offset parameter for both Osc 1 and 2. Note that Phase 
Offset Modulation (Subtraction or Multiplication) must be activated for this to have any effect. 

FM This sets modulation wheel control of the FM Amount parameter. A positive value will increase the FM 
amount if the wheel is pushed forward. Negative values invert this relationship. Both oscillators must be 
activated for this to have any effect.
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Setting Number of Voices - Polyphony

This determines the polyphony, i.e. the number of voices a Subtractor Patch can play simultaneously. This can be 
used to make a patch monophonic (=a setting of “1”), or to extend the number of voices available for a patch. The 
maximum number of voices you can set a Subtractor Patch to use is 99. In the (unlikely) event you should need more 
voices, you can always create another Subtractor!

! Note that the Polyphony setting does not “hog” voices. For example, if you have a patch that has a polyphony 
setting of ten voices, but the part the patch plays only uses four voices, this won’t mean that you are “wasting” 
six voices. In other words, the polyphony setting is not something you need to consider much if you want to 
conserve CPU power - it is the number of voices actually used that counts.

About the Low Bandwidth button
This can be used to conserve CPU power. When activated, this function will remove some high frequency content 
from the sound of this particular device, but often this is not noticeable (this is especially true for bass sounds).

External Modulation

Subtractor can receive common MIDI controller messages, and route these to various parameters. The following MIDI 
messages can be received:

• Aftertouch (Channel Pressure)

• Expression Pedal

• Breath Control

If your MIDI keyboard is capable of sending Aftertouch messages, or if you have access to an Expression Pedal or a 
Breath controller, you can use these to modulate parameters. The “Ext. Mod” selector switch sets which of these 
message-types should be received.

These messages can then be assigned to control the following parameters:

| Destination | Description

F. Freq This sets External modulation control of the Filter 1 Frequency parameter. A positive value will increase 
the frequency with higher external modulation values. Negative values invert this relationship.

LFO 1 This sets External modulation control of the LFO 1 Amount parameter. A positive value will increase the 
LFO 1 amount with higher external modulation values. Negative values invert this relationship.
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Connections

Flipping the Subtractor around reveals a plethora of connection possibilities, most of which are CV/Gate related. Us-
ing CV/Gate is described in the chapter “Routing Audio and CV”.

Audio Output
This is Subtractor’s main audio output. When you create a new Subtractor device, this is auto-routed to the first avail-
able channel on the audio mixer.

Sequencer Control
The Sequencer Control CV and Gate inputs allow you to play the Subtractor from another CV/Gate device (typically 
a Matrix or a Redrum). The signal to the CV input controls the note pitch, while the signal to the Gate input delivers 
note on/off along with velocity.

! For best results, you should use the Sequencer Control inputs with monophonic sounds.

Amp This let’s you control the overall volume of the sound with external modulation. If a positive value is set, 
the volume will increase with higher external modulation values. A negative value inverts this relation-
ship.

FM This sets External modulation control of the FM Amount parameter. If a positive value is set, the FM 
amount will increase with higher external modulation values. A negative value inverts this relationship. 
Both oscillators must be activated for this to have any effect.

| Destination | Description
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Modulation Inputs
! Remember that CV connections will not be stored in the Subtractor patch, even if the connections are to/from 

the same Subtractor device! 

These control voltage (CV) inputs (with associated voltage trim pots), can modulate various Subtractor parameters 
from other devices, or from the modulation outputs of the same Subtractor device. These inputs can control the fol-
lowing parameters:

• Oscillator Pitch (both Osc 1 & 2).

• Oscillator Phase Offset (both Osc 1 & 2).

• FM Amount

• Filter 1 Cutoff

• Filter 1 Res

• Filter 2 Cutoff

• Amp Level 

• Mod Wheel

Modulation Outputs
The Modulation outputs can be used to voltage control other devices, or other parameters in the same Subtractor de-
vice. The Modulation Outputs are:

• Mod Envelope

• Filter Envelope 

• LFO 1

Gate Inputs
These inputs can receive a CV signal to trigger the following envelopes. Note that connecting to these inputs will 
override the normal triggering of the envelopes. For example, if you connected an LFO output to the Gate Amp input, 
you would not trigger the amp envelope by playing notes, as this is now controlled by the LFO. In addition you would 
only hear the LFO triggering the envelope for the notes that you hold down. The following Gate Inputs can be se-
lected:

• Amp Envelope

• Filter Envelope

• Mod Envelope



Chapter 28
NN-XT Sampler
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Introduction
The NN-XT Sampler lets you sample or load samples and create multi-sample patches by mapping samples across 
the keyboard. The sound can then be modified by a comprehensive set of synth-type parameters. The NN-XT has an 
number of advanced features, for example:

• Support for SoundFonts.
Presets and samples from SoundFont banks can be loaded and used in the NN-XT (see “Loading SoundFonts”).

• 8 stereo output pairs.
This makes it possible to route different samples to different mixer channels for individual effect processing (see 
“Out”).

• The possibility to create layered sounds. 
This is done by mapping several samples across the same keyboard range (see “Creating layered sounds”).

• The possibility to create sounds that only play over certain velocity ranges, velocity switched key maps and ve-
locity crossfading.
See “Setting velocity range for a Zone”.

• Key maps with individual synth parameter settings for each sample.
See “Synth parameters”.

Sampling in NN-XT
The sampling procedure is generic for all devices that can sample (NN-XT and Redrum). The sampling and sample 
editing procedures are described in detail in the “Sampling” chapter.

D To sample your own sound and automatically load it into the NN-XT device, click the Sample button.

Refer to the “Sampling” chapter for details on how to set up and use the sampling feature.
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Panel overview

The main panel
When the NN-XT is added to the rack, you will initially only see the main panel.

The NN-XT main panel.

The main panel is where you load complete sample patches. It also contains the “global controls”. These are controls 
that affect and modify the sound of entire patches rather than the individual key zones.

The Remote Editor panel
To show/hide the remote editor panel, use the fold/unfold arrow at the bottom left.

The remote editor panel is where you load individual samples, create key maps, modify the sound of the samples with 
synth parameters etc.

! The main panel of the NN-XT can be folded like any other Reason Essentials device. Note that folding the main 
panel will also fold the remote editor regardless of its current state.

Remote 
Editor 
Fold/Unfold 
button
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Loading complete Patches and REX files
As previously alluded, you can load complete sample patches as well as individual samples into the NN-XT.

• A patch is a complete “sound package”. It contains information about all the samples used, assigned key 
zones, associated panel settings etc. Loading a sample patch is done by using the patch browser on the main 
panel, and works in the same way as with any other Reason device.

The patch browser button on the main panel.

For general instructions on how to load and save patches, please see “Loading patches” and “Saving patches”.

• Loading separate samples is done in a similar way, but via the sample browser on the remote editor panel. If 
you load samples, map them across keyboard ranges and set up the sound the way you want it, you can save 
your settings as a Patch for easy access later.

The sample browser button on the remote editor.

More about loading samples later in this chapter.

Loading NN-XT Patches
NN-XT Patches are patches made specifically for the NN-XT. Reason Essentials ships with a large number of NN-
XT Patches in the Factory Sound Bank. NN-XT Patches have the extension “.sxt”.

Loading NN19 Patches
Reason Essentials doesn’t feature the NN19 sampler device but its patches (with the extension “.smp”) can be 
opened in NN-XT instead.

Loading SoundFonts
The SoundFont format was developed by E-mu systems in collaboration with Creative Technologies. It is a standard-
ized data format containing wavetable synthesized audio and information on how it should be played back in wavet-
able synthesizers - typically on audio cards. The SoundFont format is an open standard so there is a vast amount of 
SoundFont banks and SoundFont compatible banks developed by third parties.

Loading SoundFonts is no different from loading NN-XT Patches. As with NN-19 Patches, the NN-XT does its best 
to map all the SoundFont settings to NN-XT parameters.

You can load SoundFont presets by using the patch browser, and single SoundFont samples by using the sample 
browser.
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Loading complete REX files as Patches
REX Files are files created in the ReCycle program. This is an application created by Propellerhead Software, used 
for slicing up music loops and enabling them to be played back in any tempo. In Reason, REX files are primarily used 
in the Dr. Octo Rex loop player, but they can be used in the NN-XT as well. Possible extensions are “.rx2”, “.rcy” and 
“.rex”.

When loading a REX file, each slice in the file is assigned to one key, chromatically. All parameters are set to default 
settings.

When using REX files in the Dr. Octo Rex loop player, it is possible to make a track play the slices in order to recreate 
the original loop. To do the same in the NN-XT requires a few extra steps.
1. Use the patch browser to load the REX file into an NN-XT sampler.

2. Create a Dr. Octo Rex loop player and load the same REX file into a Loop Slot of this device.

3. Use the Copy Loop To Track feature on the Dr. Octo Rex to create playback data (a group) on the track as-
signed to the Dr. Octo Rex.

4. Move that group to the track that plays the NN-XT and play it back from there.

5. Delete the Dr. Octo Rex loop player.
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Using the main panel
All of the controls on the main panel are used for globally modifying certain parameters for all of the samples in a 
patch, by the same amount.

! Movements of the parameters on the main panel can be recorded as automation. However, controls on the re-
mote editor panel (described later) can not!

The following is a description of the controls and parameters on the main panel.

The Pitch and Modulation wheels

Most MIDI keyboards come equipped with Pitch Bend and Modulation wheels. The NN-XT features settings for how 
incoming MIDI Pitch Bend and Modulation wheel messages should affect the sound. The wheels on the NN-XT will 
also mirror the movements of the wheels on your MIDI keyboard.

If you don’t have Pitch Bend or Modulation controls on your keyboard, or if you aren’t using a keyboard at all, you can 
use the two fully functional wheels on the NN-XT to apply real time modulation and pitch bend.

• The Pitch Bend wheel is used for “bending” the played notes up and down to change their pitch - much like 
bending the strings on a guitar or other string instrument. The Pitch Bend Range is set on the remote editor 
panel (see “Pitch Bend Range”).

• The Modulation wheel can be used for applying modulation to the sound while you’re playing. It can also be 
used for controlling a number of other parameters, as described in “The Modulation controls”.

The External Control wheel

This section can be used in three ways:

Receiving MIDI controller messages from external sources

NN-XT can receive common MIDI controller messages, and route these to various parameters. You use the “Source” 
selector switch to determine which type of message should be received:

• Aftertouch (Channel Pressure)
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• Expression Pedal

• Breath Control

If your MIDI keyboard is capable of sending aftertouch messages, and/or if you have connected an expression pedal 
or a breath controller to it, you can use these to modulate NN-XT parameters. Which parameters should be modu-
lated is set in the remote editor panel (see “The Modulation controls”).

Recording MIDI controller messages with the wheel

The wheel in the external control section can be used for recording any or all of the three MIDI controller message 
types into the Reason Essentials sequencer. If your MIDI keyboard isn’t capable of sending aftertouch messages or 
you don’t have access to an expression pedal or a breath controller, you can use the wheel instead. 

This is done just as with any other automation recording, see “Recording performance controller automation”.

High Quality Interpolation

This switch turns High Quality Interpolation on and off. When it is activated, the sample pitch is calculated using a 
more advanced interpolation algorithm. This results in better audio quality, especially for samples with a lot of high 
frequency content.

• High Quality Interpolation uses more computer power - so if you don’t need it, it’s a good idea to turn it off! Lis-
ten to the sounds in a context and determine whether you think this setting makes any difference.
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Global Controls

All of these knobs change the values of various parameters in the remote editor panel and affect all loaded samples. 
Thus they can be used for quickly adjusting the overall sound.

The knobs are bi-polar, which means that when they are centered, no parameter change is applied. By turning them 
to the right you increase the corresponding value, and by turning them to the left, you decrease the value.

Again, the movements of these parameters can be recorded as automation. This is done just as with any other auto-
mation recording, see “Recording parameter automation”.

The controls are, from left to right:

Filter

These two knobs each control a parameter of the filter (see “The Filter section”). Note that the filter must be on for 
these to have any effect.

• Frequency
This changes the cutoff frequency of the filter. 

• Resonance
This changes the resonance parameter of the filter, meaning - the filter characteristic, or quality.

Amp Envelope

These three knobs control the Amplitude Envelope (see “The Amplitude Envelope”) in the following way:

• Attack
This changes the Attack value of the Amplitude Envelope. That is, how long it should take for the sound to reach 
full level after you press a key on your keyboard.

• Decay
This changes the Decay value of the Amplitude Envelope. Decay determines how long it should take for the sound 
to go back to the sustain level after it has reached full value (see “The Amplitude Envelope”) and the key that trig-
gered the sound is still being pressed.

• Release
This changes the Release value of the Amplitude Envelope. Release works just like Decay with the exception that 
it determines how long it should take for the sound to become silent after the key has been released.

Mod Envelope

This knob controls the Decay value of the Modulation Envelope (see “The Modulation Envelope”). Also see above 
for a brief description of Decay.

Master Volume

This controls the main volume out from the NN-XT. Turn the knob to the right to increase the volume.
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Overview of the Remote Editor panel
It is in the Remote Editor Panel that the main NN-XT action is going on, especially if you’re creating your own 
patches. The remote editor is dominated by the key map display, and this is also the part on which we will concentrate 
to begin with.

The Key Map display
The key map display consists of a number of separate areas that let you do different things. To help you navigate the 
key map display, these areas are described below.

The Info area

This displays the following information about the currently selected sample: Sample rate, mono/stereo information, 
bit resolution and file size.

The Sample area

This area displays the names of the samples in each zone. It also allows you to change the order of the zones by 
clicking and dragging them up and down.

The Group area

This area does not show any information. However, by clicking in it, you can instantly select all the zones that belong 
to a certain group. See “Working with Grouping” for information on how to create groups.

The Keyboard area

Aside from the fact that is a guideline for setting up key ranges, it is also used for setting the root keys of, and audi-
tioning loaded samples. See “About the Root Key” and “Auditioning samples” respectively for more information.

The Tab Bar area

This area gives you a visual indication of the key range of a selected zone. By clicking and dragging the “handles” at 
the key range boundaries, you can resize the key ranges, and by clicking in between the handles, you can move the 
key ranges without changing their length.

The Info 
area

The Sample 
area

The Group 
area

The Keyboard area The Tab Bar area

The Key Range area

The Scrollbars
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The Key Range area

This area in the middle of the key map display is where you keep track of all the zones and the relationship between 
them. You can also move and resize the zones just like in the Tab Bar area, as described above.

The Scrollbars

There are both horizontal and vertical scrollbars that work just like regular scrollbars. Whenever there is more infor-
mation in the key map display than what fits on a “single screen”, you can use the scrollbars to reveal it. Either click 
on the arrows or click and drag the scrollbar handles.

Sample parameters

This area shows the current values of basic parameters you can set for zones, such as root key, play mode, output 
etc. The parameters are changed by using the knobs directly below the key map display.

Group parameters

These parameters are adjusted on a per group basis (see “Group parameters” for more information on groups). Most 
of them relate to performance or playing style.
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Synth Parameters

The bulk of the parameters on the remote editor are used for adjusting the sound of the samples by applying filtering, 
envelope shaping, modulation (like vibrato and tremolo) and so on. We call these the synth parameters, since they are 
to a large extent identical to those on a regular synthesizer.

About Samples and Zones
For a clear understanding of the terminology used when describing the various operations that can be performed in 
the key map display, it is important to clarify the distinction between a sample and a zone:

• A Sample is a piece of audio that can be loaded into the NN-XT and played back.

• A Zone could be viewed as a “container” for a loaded sample.

All loaded samples are placed in “Zones” in the key map display. You can then organize the zones as you please, and 
make various settings such as key- and velocity ranges separately for each zone.

In other words, the settings you make are actually performed on the zones, but affect the samples in them. Hence, 
when we talk about making settings for a zone, it is synonymous with making settings for a sample - the sample that 
the zone contains.

• Two or more zones can play the same sample, but with different parameter settings, making them sound com-
pletely different.

• A zone can be empty, playing no sample at all.
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Selections and Edit Focus
Almost all operations in the remote editor are performed on one or more selected zones or on the zone with edit fo-
cus. Several zones can be selected at once, but only one zone at a time can have edit focus.

This is important since:

• Editing operations that can be performed on several zones (like deleting), always apply to the selected zones.

• Editing operations that can be performed on one zone only, always apply to the zone with edit focus.

• The front panel always shows the settings for the zone with edit focus.

Here no zone is selected.

Here the middle zone is selected but does not have edit focus.

Here the middle zone has edit focus but is not selected. Notice the thicker border and the additional handles in the key range area.

Here the middle zone is selected and has edit focus.

Here, all three zones are selected, but the middle one has edit focus.
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Selecting Zones
D To select a zone, click on it.

Clicking on a zone will also automatically give it edit focus.

You can also select multiple zones in several ways:

D By holding down [Shift], or [Ctrl](Win) or [Cmd](Mac) and clicking on the zones you wish to select.
This way you can select several non-contiguous zones. You can also deselect a selected zone by clicking on it 
again.

D By holding down [Ctrl](Win) or [Cmd](Mac) and pressing [A]. 
This will select all of the zones in the key map display. To deselect all zones, click in an unoccupied area in the 
Sample column or the key map area.

D By clicking and dragging a selection box in the key map area.

Note that the zones don’t have to be completely encompassed by the selection box. The selection box only have to 
intersect parts of the zones to include them in the selection.

Making a selection box like this....

...will select these zones:
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Selecting zones via MIDI

You can also select zones via your MIDI keyboard. By clicking the button marked “Select zones via MIDI” above the 
key map display so that it lights up, you enable selection via MIDI.

This way, you can select a zone and give it edit focus by pressing a key that lies within the zone’s key range (see later 
in this chapter for information about setting up key ranges).

In this case, this zone can be selected by pressing any key between C2 - C3 on your MIDI keyboard.

Note also, that selection via MIDI is velocity sensitive. Zones may have specific velocity ranges. This means that they 
won’t be played unless the key that triggers the zone is played with a certain velocity. The same rules apply when se-
lecting via MIDI, only zones that meet the velocity criteria will be selected. Read more about setting up velocity ranges 
on “Setting velocity range for a Zone”.

Selecting All Zones in a Group

The concept of zone groups is fully introduced on “Working with Grouping”. For now we will only describe how to se-
lect all samples that belong to the same group:

Clicking in the 
Group column...

...selects all zones 
in the group
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Moving Edit Focus

Moving Edit Focus

A zone can be given edit focus independently of selection:

D When you click on an unselected zone, it both gets selected and gets edit focus.

D When you select several zones using [Shift], or [Ctrl](Win) or [Cmd](Mac), the one you select last always gets 
edit focus.

D To set edit focus to a zone when several zones are already selected, click on it without holding down any mod-
ifier keys.
This way, you can move edit focus between the selected zones freely without deselecting any of them.

Adjusting parameters

Adjusting Synth parameters
The synth parameters are the ones that occupy the bulk of the remote editor panel (see “Synth Parameters”). 
Changes you make to synth parameters always apply to all selected zones.

D The panel always shows the settings for the zone with edit focus.
More about this below.

D To make adjustments to one zone, select it (which also gives it edit focus) and adjust the parameter on the 
front panel.

D To set several zones to the same value, select them and adjust the parameter.
All zones will be set to the same value for the parameter you adjusted. 

Adjusting Group parameters
Group parameters apply to a group. That is, they are settings that are shared by all zones in a group.

D To make adjustments to one group, select one or more zones that belong to the group, and adjust the param-
eter on the front panel.

D To set several groups to the same value, select at least one zone in each group you want to adjust, and adjust 
the parameter.
All groups will be set to the same value. More about this below.

About “Conflicting” parameters

Often you will find yourself in a situation where you select multiple zones and parameter settings differ between 
them. This is quite normal. For example, you will often find yourself making adjustments to for example level and fil-
tering to balance the sound between several samples across the keyboard. However, if you have multiple selections 
this can sometimes lead to confusion: Enter the NN-XT’s “conflicting parameters” indication:
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Whenever two or more selected zones have conflicting parameter settings, NN-XT will notify you about this by show-
ing a small “M” (for multiple) symbol, next to the parameter.

In this example, Level and Spread have conflicting settings.

D The controls on the panel always show the setting for the zone with edit focus.

D By clicking your way through the zones within the selection, you can see the settings for each zone.

D If you adjust a parameter, all selected zones will be set to the same value for this parameter.

You can put this functionality to good use when checking how a patch has been created and when checking that 
your own settings are consistent through the various zones.

Sample parameters
The Sample parameters allow you to specify various properties for one or several selected zones, such as tuning, key 
and velocity ranges.

D To set several zones to the same value, select them and adjust the parameter.
All zones will be set to the same value for the parameter you adjusted.

Copying parameters between zones

You can easily copy parameter settings from one zone to any number of other zones. Proceed as follows:
1. Select all the zones you want to involve in the operation.

By this we mean the zone with the settings you wish to copy, and the zone(s) to which you want to copy the set-
tings.

2. Make sure the zone that contains the settings you want to copy has edit focus.

3. Pull down the Edit menu or the NN-XT context menu and select “Copy Parameters to Selected Zones”.
All the selected zones will now get the exact same parameter settings.

! Observe that this only applies to the synth parameters (see “Synth parameters”). Sample parameters (root 
key, velocity range etc.) can not be copied.
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Managing Zones and Samples

Creating a Key Map
When you add an NN-XT sampler to the rack, its key map display is always empty. That is, it contains no samples.

To create a new key map, proceed as follows:
1. Either click the Browse Samples button, select Browse Samples from the Edit menu or select Browse Samples 

from the NN-XT’s context menu.
This will bring up the regular file browser.

The Browse Samples button.

2. Select the sample or samples that you want to load in the browser and click “OK”.
The selected sample(s) are loaded into the NN-XT.

When new samples are loaded into the NN-XT they have the following properties:

• Each sample is placed in its own zone.

• Each zone spans a key range of five octaves on the keyboard - C1 to C6.

• All the newly added sample(s)/zones are automatically selected.

• The first added zone gets edit focus.

A key map with four newly added samples.

Setting Root Notes and Key Ranges

The next step after loading the samples is most likely to adjust the key range, root note and tuning of the samples, so 
that they play sensibly across the key range. There are many ways of doing this, described in “Working with Key 
Ranges” and onwards. However, we will here briefly describe a procedure for quickly creating a complete key map 
out of a set of loaded samples.

This example assumes that the samples you load is a set of multisamples for a pitched instrument (like guitar, piano, 
flute etc.).
1. Load the samples.

2. Use “Select All” on the Edit menu to select all the loaded samples.

3. Use “Set Root Notes from Pitch Detection” to automatically set up the root notes (pitches) for the samples.

4. Select “Automap Zones” from the Edit menu.

All selected zones are automatically arranged into a basic key map. You can now proceed with adjusting the synth 
parameters on the front panel to shape the sound!
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About file formats and REX slices
The NN-XT can import various types of samples:

• Standard Wave files 
These have the extension “.wav”. This is the standard audio file format for the PC platform. Any audio or sample 
editor, regardless of platform, can read and create audio files in Wave format. Any sample rate and practically any 
bit resolution is supported.

• Standard AIFF files 
These have the extension “.aif” and this is the standard audio file format for the Mac platform. Again, any audio ed-
itor can read and create audio files in this format. Any sample rate and practically any bit resolution is supported.

• SoundFont samples
This is a standardized data format containing wavetable synthesized audio and information on how it should be 
played back in wavetable synthesizers - typically on audio cards. SoundFont banks are hierarchically organized into 
different categories: User Samples, Instruments, Presets etc. The NN-XT lets you load single samples from within 
a Soundfont bank.

• REX file slices
A slice is a snippet of sound in a REX File (see “Loading complete REX files as Patches”). To import a REX slice, 
browse to a REX file and open it as if it was a folder. The browser will then display the slices as files inside that 
“folder”. In the rest of this manual, when we refer to importing samples, all that is said applies to REX slices as well.

Adding more samples to the Key Map
You can add additional samples to an existing key map way described above.
1. Make sure that no already loaded sample has edit focus.

If you don’t, there’s a risk that the selected sample will be replaced, see below. To remove the edit focus, click in an 
unoccupied area in the Sample column or the key map area. 

2. Open the Sample Browser.

3. Select the sample(s) you want to load in the browser and click “OK”.
The new sample(s) are added to the key map.

Replacing a sample
To replace the sample in a zone, proceed as follows:
1. Make sure the zone has edit focus and do one of the following:

D Click the Browse Samples button.

D Select Browse Samples from the Edit menu or the NN-XT context menu.

D Double click in the zone.
Any of these methods will open the standard file browser in which you can select a new sample for the zone.

2. Select one and only one sample in the Sample Browser.
If you select more than one sample in the browser the samples you load will not replace the one with edit focus. 
They will instead be added below it.
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Quick browsing through samples
If you want to quickly browse through a number of samples, for example to see which one of them would fit best in a 
certain context, proceed as follows:
1. Set up the zone as desired and make sure it has edit focus:

2. Use the arrow buttons in the Browse Samples section to select the next/previous sample in the directory.

Removing samples
D To remove a sample from a zone, select it by clicking on it and then select “Remove Samples” from the Edit 

menu or the NN-XT context menu.
This will remove the sample from the zone, leaving it empty. Note that you can remove the samples from several 
selected zones at the same time.

Auditioning samples
You can audition the loaded samples in two ways:

D By pressing [Alt](Win) or [Option](Mac) and clicking a sample in the sample column.
The mouse pointer will take on the shape of a speaker symbol when you move it over the sample column.

Clicking a sample will play it back at its root pitch (see “About the Root Key”). Furthermore, the sample will play 
back in its unprocessed state. That is, without any synth-parameters applied (see “Synth parameters”).

D By pressing [Alt](Win) or [Option](Mac) and clicking a sample in the keyboard column.
The difference here is that you will hear the sample at the pitch corresponding to the key you clicked and with any 
and all processing applied. The click mimics a key played with velocity 100. Also note that this may trigger several 
samples, depending on whether they are mapped across the same or overlapping key ranges, and the velocity 
range settings (see “Setting up Key Ranges” and “Setting velocity range for a Zone” respectively).

Adding empty Zones
You can add empty zones to a key map. Empty zones are treated just like zones containing samples, in that they are 
automatically selected, gets edit focus and are assigned a five octave key range when they are first created. How-
ever, you can only add one zone at a time. It is also possible to resize, move and edit empty zones in the same way as 
zones containing samples.

D To add an empty zone, pull down the Edit menu or the NN-XT context menu and select “Add Zone”.
An empty zone is added below any existing zones in the key map. An empty zone is indicated with the text “**No 
Sample**”.

After you have added an empty zone, you can assign a sample to it, just as when Replacing a Sample, or when Quick 
Browsing, as described above.

Duplicating Zones
You can duplicate any number of already existing zones (containing samples or empty). 
1. Select the zone(s) you want to copy.

2. Pull down the edit menu or the NN-XT context menu and select “Duplicate Zones”.
The selected zones will now be copied and automatically inserted below the last one in the key map display. 

The duplicated zones will contain references to the same samples as the original zones. They will also have the exact 
same key ranges and parameter settings.
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Using Copy and Paste

The Copy Zones function on the Edit menu allows you to copy all selected zones to the clipboard. Selecting Paste 
Zones from the Edit menu will paste the zones into the selected NN-XT device, below the existing zones.

This is a handy way to transfer zones (complete with all settings) from one NN-XT device to another.

Removing Zones
To remove one or several zones, select them and do one of the following:

D Press [Delete] or [Backspace] on the computer keyboard.

D Select “Delete Zones” from the Edit menu or the NN-XT context menu.

When removing zones, you will remove any samples in them as well.

Rearranging Zones in the List
D To move a zone to another position in the list, click on it in the samples column and drag up or down.

An outline shows you where the zone will appear when you release the mouse button.

Working with Grouping

About Groups
Grouping has two purposes:

D To allow you to quickly select a number of zones that “belong together.”
For example if you have created a layered sound consisting of piano and strings, you could put all string samples 
in one group and all piano samples in one group. Then you can quickly select all piano samples and make an ad-
justment to them by trimming a parameter.

D To group zones that need to share group settings together.
For example, you may want to set a group to legato and monophonic mode and add some portamento so that you 
can play a part where you slide between notes.

Note that there is always at least one group, since the zones you create are always grouped together by default.

Creating a Group
1. Select the zones you want to group together.

The zones don’t have to be contiguous in order to be grouped. Regardless of their original positions in the samples 
column, they will all be put together in succession.
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2. Select “Group Selected Zones” from the Edit menu or the NN-XT context menu.
The zones are grouped.

Moving a Group to another position in the List
D Click on the group in the Groups column and drag up or down with the mouse button pressed.

An outline of the group you move is superimposed upon the display to help you navigate to the desired position.

Dragging a group to a new position.

3. Release the mouse button at the desired position.
The group and all its zones appear at the new position.

Moving a Zone from one Group to another
This is done just as when rearranging samples in the list, as described on the previous page. The only difference is 
that you drag the zone from one group to another.

Selecting these zones and grouping them...

...will create these two groups instead of the original one large group.
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Selecting a Group and/or Zones in a Group
D Clicking on a group in the groups column selects the group and all the zones in the group.

D Clicking on a zone in the samples column selects the group (and that zone).

The Group Parameters
There are a few parameters on the front panel that apply specifically to groups. see “Group parameters” for details.

Working with Key Ranges

About Key Ranges
Each zone can have its own separate key range, the lowest and the highest key that will trigger the sample. 

A good example of use for this is when sampling a certain instrument. Sampling of a piano for example is usually per-
formed by making several recordings of different notes at close intervals, and then mapping these samples to sepa-
rate, contiguous, fairly narrow key ranges. This concept is called multi-sampling.

The reason for this is that if one single sample is played across the entire keyboard, it will most likely sound very un-
natural when played too far from its original pitch, since the amount you can transpose a sound without negatively af-
fecting its timbre is very limited.

Setting up Key Ranges
You can adjust the key range of zones in a number of ways:

By Dragging the Zone Boundary Handles

1. Select the zone in the Key Range area.

2. Point and click on one of the handles that appear at each end.
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3. Drag the handle left/right.
Dotted lines extend from the edges of the zones up to the keyboard area. These lines give you a visual indication 
of which keys the key range will encompass. There is also an alphanumerical indication at the bottom left of the 
display.

4. Repeat the procedure with as many zones as you wish, to create a complete key map.

By using the Lo Key and Hi Key controls

Directly below the key map area you will find the sample parameters. These are used for changing various parame-
ters that affect how the zones are played back. They can affect single or multiple selected zones. In the middle of the 
sample parameters area are two knobs called “Lo Key” and Hi Key”.

These can be used for setting the low key and the high key of a zone’s key range. 
1. Make sure the zone which you want to set the key range for is selected.

2. Use the Lo Key/Hi Key knobs to change the key range.
Check the display right above the knobs for an indication of the key. You can also keep an eye on the lines extend-
ing from the zone edges to the keyboard area.

Setting key ranges for multiple zones

You can set key ranges for multiple selected zones simultaneously. This can only be done by using the Lo and Hi Key 
controls. It works as follows:

Clicking and dragging the high key boundary handle of a zone with the default key range of C1 - C6...

...to change the key range to C1 - C2.



NN-XT SAMPLER546

D If you have three selected zones that each have different high keys and then turn the Hi Key knob, they will all 
automatically get the same High Key value as the zone with edit focus.
In other words, if the selected zone with edit focus has the high key set to C4, and you change this to D4 by turn-
ing the Hi Key knob, all other selected zones will also be extended to D4 as the High Key.

D If any selected zone’s low key setting is higher than the edit focused zone’s high key before turning the Hi Key 
knob, the zone range will be scaled down to one semitone, starting from the low key setting.
The high key can naturally never be set to a value lower than one semitone above its low key setting - the zone 
would otherwise disappear!

D The inverse is also true - i.e. turning the Lo Key knob for several selected zones will apply the edit focused low 
key setting to all selected zones.
A low key can never be set higher than one semitone below the high key in a zone, so if the edit focused zone has 
a low key above the high key of another zone, the other zone will be scaled to the minimum semitone range.

By Dragging the Zone Boundary Handles on the Tab Bar

As previously described, the area directly below the keyboard area is called the tab bar. This shows the key range for 
the currently selected zone, and also contains boundary handles. 

Dragging a boundary handle on the tab bar.

These handles can be used much to the same effect as when dragging the boundary handles in the key map display. 
However, the handles on the tab bar can change the key range of multiple zones at the same time.

The following applies:

• The tab bar shows the key range for the zone with edit focus.
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• Dragging the boundary handles for that zone will also simultaneously change the key range for a number of 
surrounding zones if:

D The high key or low key (depending on which handle you drag) of the other zones are the same as the zone 
with edit focus.

D The other zones are adjacent to the zone with edit focus.

! Note that it doesn’t matter whether the other zones are selected or not. They will be affected anyway.

In the example in the picture above, the zone in the middle has edit focus. Its left handle (the low key) is placed dif-
ferently from any of the other zones, but all of the zones have the same high key setting. This means that...

• Dragging the left handle will only move the low key position of the zone with edit focus (the pictures show be-
fore and after dragging).

• Dragging the right handle will move the high key position for all of the zones at the same time, since they all 
have the same high key position (again, the picture shows before and after dragging).



NN-XT SAMPLER548

Moving Zones by Dragging the Zone Boxes

You can also move entire zones horizontally, thereby changing their key ranges.
1. Select all the zones you want to move.

You can move several zones simultaneously.

2. Point on any of the selected zones, and press the mouse button.

3. Drag left/right and release the mouse button.

Dragging multiple zones.

Moving Zones by Dragging in the Tab Bar

You can also move a zone by dragging anywhere between the zone boundary handles on the tab bar. When you do, 
the surrounding zones will be affected just as when dragging the boundary handles in the tab bar (see above).

This can be used to “slide” a zone in relation to its surrounding zones, as the picture example below shows (before 
and after dragging).

About the Lock Root Keys function

Normally, when you move zones (as described above), the root note of the zone(s) you move will change accordingly. 
In other words, the zone(s) will be transposed. If this is not desired, you can activate the Lock Root Keys function prior 
to moving the zone(s) by clicking on the button above the key map display.

Moving zones without changing their root notes can be used for some interesting effects, since it will completely 
change the timbre of the sample(s) as they are played back.
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About the Solo Sample function

The Solo Sample function lets you play a selected sample over the entire keyboard and disregarding any velocity 
range assigned to the sample. All other loaded samples are temporarily muted.

This is useful if you for example want to check how far up and down from its root key a sample can be played on the 
keyboard before starting to sound “unnatural”. The solo sample function can therefore be useful as a guide for setting 
up key ranges, as described in “Setting up Key Ranges”.
1. Select one and only one zone, or - if you have a selection of multiple zones - make sure the one you want to 

hear has edit focus.

2. Activate Solo Sample by clicking on the button so that it lights up.

3. Play the MIDI keyboard
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Sorting Zones by Note
The Edit menu and the NN-XT context menu contains an item called “Sort Zones by Note”. This option lets you auto-
matically sort the selected zones in descending order according to their key ranges.

When you invoke this option, the selected zones will be sorted from top to bottom in the display starting with the one 
with the lowest range.

Note however, that the sorting is done strictly on a group basis. That is, only zones that belong to the same group can 
be sorted in relation to each other.

Before sorting and after.

If two zones have the same key range, they are sorted by velocity range.
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Setting Root Notes and Tuning

About the Root Key
All instrument sounds have an inherent pitch. When playing a sample of such a sound on the keyboard, the keys you 
play must correspond to that pitch. For example, you may have recorded a piano playing the key “C3”. When you map 
this onto the NN-XT key map, you must set things up so that the sampler plays back the sample at original pitch 
when you press the key C3.

This is done by adjusting the root note.

D Many samples files from different sources already have a set root key in the file. If they do, the root key will be 
correctly set automatically when you load the sample into a zone.

D However if the sample doesn’t have a root note stored in the file, (if you for example have recorded it yourself) 
you will need to adjust it

Setting the Root Note manually
To set the root key for a zone, proceed as follows:

D Make sure the zone has edit focus (for example by clicking on it), and do one of the following:

D Use the knob marked “Root” in the sample parameter area below the display.
Turning it to the right will raise the pitch of the root key. The selected key is displayed alphanumerically directly 
above the knob, and you can also look at the keyboard area for a visual indication (see below).

D Press [Ctrl](Win) or [Cmd](Mac) and click on the desired root key in the keyboard area.
The set root key is shaded so you can easily distinguish it.

Tuning samples manually 
In addition to setting the root note, you may need to fine tune your samples, in order for them to match other instru-
ments and/or each other:

D Make sure the zone has edit focus (for example by clicking on it).

D Use the knob marked “Tune” in the sample parameter area.
This allows you to tune each sample in a key map by +/– half a semitone (-50 – 0 – 50).
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Setting the Root Note and Tuning using pitch detection
The NN-XT features a pitch detection function to help you set the root keys. This is useful if you for example load a 
sample that you haven’t recorded yourself, and you don’t have any information about its original pitch.

Proceed as follows:
1. Select all the zones you want to be subject to pitch detection.

2. Pull down the Edit menu or the NN-XT context menu and select “Set Root Notes from Pitch Detection”.
The samples in all the selected zones will now be analyzed, and the detected root keys will automatically be set for 
you.

! Note that for this to work properly, the samples must have some form of perceivable pitch. If it is sampled 
speech, or a snare drum for example, it probably doesn’t have any discernible pitch.

About changing the pitch of samples
The procedures above should be used to make sure the samples are consistently pitched across the keyboard, and 
that they all match an absolute reference (for example A 440 tuning).

If you need to tune the samples to match other material, or to get a certain effect (for example detuning two sounds 
against each other for a chorus effect) you should use the Pitch section among the synth parameters, not the sample 
tuning parameters.

Using Automap
The automap function can be used as a quick way of creating a key map, or as a good starting point for further ad-
justments of a key map.

Automap works under the assumption that you intend to create a key map for a complete instrument, for example a 
number of samples of a piano, all at different pitches.
1. Load the samples you want to Automap.

Now you have three options:

D Trust that the root note information in the files is already correct.

D Manually adjust the root notes (and tuning) for all the samples.

D Use “Set Root Notes from Pitch Detection” to automatically set up the root notes.

2. Select all zones you want to automap.

3. Select Automap Zones from the Edit menu or the NN-XT context menu.

All the selected zones will now be arranged automatically in the following way:

D The zones will be sorted in the display (from top to bottom - lowest key first) according to the root keys.

D The zones will be assigned key ranges according to the root keys.
The key ranges are set up so that the split between two zones is exactly in the middle between the zones’ root 
notes. If two zones have the same root key they will be assigned the same key range.

Automapping zones chromatically

D This Edit menu item will give each zone a key range of one semitone (i.e. one key), starting from C2 and up-
wards.
The function does not take root key into account. It simply places each selected sample on successive keys ac-
cording the position in the sample list (from the top down).
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Layered, crossfaded and velocity switched sounds

Creating layered sounds
You can set things up so that two or more zones have overlapping key ranges - either completely or partially. This way 
you can create layered sounds, i.e. different samples that are played simultaneously when you press a key on your 
keyboard.

In the picture above, you can see a set of piano samples at the top, mapped across the key range.

Below these are a set of string samples that also span the entire key range.

Whenever you play a key within this keyboard range, the sound produced will be a combination of the piano and the 
string sample.

In addition, in the example above, the user has arranged the piano samples into one group and the string samples in 
another. This is convenient since it allows for quick selection of the entire piano map, for example for balancing its 
level against the strings.

About velocity ranges
When zones are set up so that their key ranges overlap – completely or partially – you can use velocity switching and 
crossfading to determine which zones should be played back depending on how hard or soft you play on your MIDI 
keyboard.

This is done by setting up velocity ranges, with or without crossfading.

Each time you press a key on your MIDI keyboard, a velocity value between 1-127 is sent to Reason Essentials. If you 
press the key softly, a low velocity value is sent and if you press it hard, a high velocity value is sent.

This velocity value determines which samples will be played and which will not.

Let’s say for example that you’ve mapped three different zones across the same key range:

• Zone 1 has a velocity range from 1-40.
This means that the sample in it will be triggered by velocity values between 1-40.

• Zone 2 has a velocity range of 41-80.
The sample in this zone will be played back by velocity values between 41-80.
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• Zone 3 has a velocity range of 81-127.
The sample in this zone will be triggered by all velocity values above 80.

Overlapping velocity ranges

Let’s change the values above slightly:

• Zone 1 has a velocity range from 1-60.

• Zone 2 has a velocity range of 41-100.

• Zone 3 has a velocity range of 81-127.

Now, velocity values between 41 and 60 will trigger samples from both Zone 1 and Zone 2. Likewise, velocity values 
between 81 and 100 will trigger sounds from Zone 2 and Zone 3.
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About full and partial velocity ranges

You can see which zones have modified velocity ranges in the key map display:

• Zones with a full velocity range (0 - 127) are only shown with an outline.

• Zones with any other velocity range are shown as striped.

The top zone has a full velocity range (1-127), and the lower zone has a partial velocity range (any other range), which is indicated 
by stripes

Sorting Zones by velocity values

The Edit menu and the NN-XT context menu contain an item called “Sort Zones by Velocity”. This option lets you au-
tomatically sort the selected zones in the display in descending order according to their set low or high velocity val-
ues.

When you invoke this option, the selected zones will be sorted from top to bottom starting with the one with the high-
est “Lo Vel “value.

Note however, that the sorting is done strictly on a group basis. That is, only zones that belong to the same group can 
be sorted in relation to each other.

If two zones have the same velocity range, they are sorted by key range.

Setting velocity range for a Zone
To set up a velocity range for a zone, proceed as follows:
1. Select one or more zones that you want to adjust.

2. Use the knobs marked “Lo Vel” and “High Vel” in the sample parameter area to set the desired low- and high 
velocity values.

Adjusting the “Lo Vel” value for a zone.

“Lo vel” is the lowest velocity value that should trigger the sample in the zone - i.e. if a key is pressed so softly that the 
velocity is lower than this value, the sample will not be played. 

“Hi vel” is the highest velocity value that should trigger the sample, which means that if a key is pressed so hard that 
the velocity is higher than this value, the sample will not be played.

About Crossfading Between Zones
At the bottom right in the sample parameter area are two knobs marked “Fade In” and “Fade Out”. These are primarily 
used for setting up velocity crossfades for smooth transitions between overlapping zones. In order to set up cross-
fades you adjust the fade out and fade in values for the overlapping zones.
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Crossfading Between two Sounds

An example:

• Two zones are both set to play in the full velocity range of 1-127.

• Zone 1 has a fade out value of 40.
This means that this zone will play at full level with velocity values below 40, With higher velocity values, it will grad-
ually fade out.

• Zone 2 has a fade in value of 80.
This has the effect that as you play velocity values up to 80, this zone will gradually fade in. With velocity values 
above 80, it will play at full level.

Another example:

Crossfading can be used to only fade in or fade out a certain sound. One common example is to set things up so that 
one sound plays the entire velocity range and another is faded in only at high velocity values.

• Zone 1 is set to play the entire velocity range with no crossfade.

• Zone 2 is set to play the velocity range 80 to 127, with a fade in value of 110.
This means that this zone will start fading in from velocity values 80 and will play at full level in the velocity range 
110 to 127.

This can be used for example to add a rimshot to a regular snare sound or a harder attack to a softer violin sample.
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Setting crossfading for a Zone

Manually

To set up a crossfade for a zone, proceed as follows:
1. Select one or more zones that you want to adjust.

2. Use the knobs marked “Fade In” and “Fade Out” in the sample parameter area, to set the desired values.

q You can change the values with finer precision by pressing [Shift] while turning the knobs, and you can reset 
the standard values by pressing [Command] (Mac)/[Ctrl] (Windows) and clicking on the knobs.

Automatically

If you find it tedious to manually set up crossfades between zones, NN-XT can do it for you! The Edit menu and the 
NN-XT context menu contain an item called “Create Velocity Crossfades”.
1. Set up the zones so that their velocity ranges overlap, as desired.

2. Select the zones.
You can select as many zones as you wish, not just one pair of overlapping zones.

3. Select “Create Velocity Crossfades” from the Edit menu.
NN-XT will analyze the overlapping zones and automatically set up what it deems to be appropriate fade in and 
fade out values for the zones.

D This operation will not work if both zones have full velocity ranges.
At least one of the zones must have a partial velocity range (see “About full and partial velocity ranges”).

D This operation will not work if the zones are completely overlapping.

Using Alternate

About the Alternate function

At the bottom right in the sample parameters area is a knob marked “Alt”. It only has two states - On and Off. This is 
used for semi-randomly alternating between zones during playback.

There are several practical uses for this. Here follows two examples:

• Layering several recordings of the same snare drum. By alternating between them you get a more natural rep-
etition.

• Layering string up- and down strokes. By alternating you get the realistic effect of switching between the two 
directions of the stroke.
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You can layer as many sounds as you will and the algorithm switches between them in a way that provides as little 
repetition as possible.

To set up an alternating set of zones, proceed as follows:
1. Set up the zones so that they overlap completely or partially.

2. Select them all.

3. Set “Alt” to On for all the zones.
Now, the program will automatically detect how to alternate between the zones, depending on their overlap.

Sample parameters

The Sample parameter area is found below the screen. They allow you to adjust parameters for one or several se-
lected zones. Adjusting a parameter with multiple zones selected, will set the parameter to the same value for all se-
lected zones. Below follows a run-down of the various parameters:

Root Note and Tune
These parameters are described in “Setting Root Notes and Tuning”.

Sample Start and End
By turning the knobs you offset the start and end positions, so that they will play back more or less of a sample’s 
waveform. Typical examples of use for this would be:

• Removing unwanted portions from samples.
This could be anything from noise to “dead air” at the beginning or end of a sample.

• To create variations out of a single sample.
These controls can be used to pick out any section of a recording for use as a sample.

• Together with velocity sample start control.
You can for example increase Sample Start and then apply negative velocity modulation to Sample Start. Then, the 
harder you play the more you will hear of the attack portion of the sound.

q If you hold down [Shift] when adjusting these parameters, the adjustment is in single frames (samples).

Loop Start and End
A sample, unlike the cycles of an oscillator for example, is a finite quantity. There is a sample start and end. To get 
samples to play for as long as you press down the keys on your keyboard, they need to be looped. For this to work 
properly, you have to first set up two loop points which determine the part of the sample that will be looped.

The instrument samples in the sound banks included with Reason are already looped. The same will be true for most 
commercial sample libraries. However, if you need to, you can use these controls to adjust the looping.

• The size and position of the loop – in the sample – is determined by two parameters, Loop Start (the beginning 
of the loop) and Loop End (the end point of the loop).

• The NN-XT then keeps repeating the section between the Loop Start and Loop end until the sound has de-
cayed to silence.
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Play Mode
By using this knob you can select one of the following loop modes for each zone:

• FW
The sample in the zone will play only once, without looping.

• FW-LOOP
The sample will play from the sample start point to the loop end point, jump back to the loop start point and then 
loop infinitely between the start and end loop points. This is the most common loop mode.

• FW - BW
The sample will play from the sample start point to the loop end point, then from the loop end point to the loop start 
point (backwards), and then loop infinitely forwards-backwards between the start and end loop points.

• FW-SUS
This works like FW-LOOP with the exception that it will only loop as long as the key is held down. As you release 
the key, the sample will play to the absolute end of the sample, that is beyond the boundaries of the loop.

This means that the sound may have a short natural release even if the release parameter is raised to a high value 
(which is not true for “FW-LOOP”, where the release parameter always controls the length of the sound after the 
key is released).

• BW
The sample will play only once - from the end to the beginning - without looping.

Lo Key and Hi Key
These parameters are described in “Setting up Key Ranges”.

Lo Vel and Hi Vel
These parameters are described in “About velocity ranges”.

Fade In and Fade Out
These parameters are described in “About Crossfading Between Zones”.

Alt
This parameter is described in “About the Alternate function”.

Out
The NN-XT features eight separate stereo output pairs (see “Audio Output”). For each zone, you can decide which of 
these output pairs to use. Thus, if you have created a key map consisting of eight zones, each of these can have a 
separate stereo output from NN-XT, and can then be routed to a separate mixer channel if you so wish.

D To select which output a selected zone should be directed to, use the knob marked “Out” in the sample param-
eter area.
The output pairs are indicated above the button.

! Note that you still have to route the outputs the way you want them on NN-XT’s back panel. If you assign a 
zone to an output pair other than 1-2 (which is the default) no connections or auto routing are made. You have 
to do that manually.
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A Stereo example

One possible way of utilizing this would be to create a drum kit. In this case you could load up to eight different stereo 
drum samples, assign them to separate outputs, route each to a separate mixer channel and then use the mixer to set 
levels and pan, add send effects etc.

Using a stereo output as two mono outputs

If, on the other hand, you are using mono samples, you can use one stereo pair as a two separate outputs, effectively 
giving you a total of 16 separate outputs.
1. Assign two zones to the same output.

2. Us the Pan control to pan one of the zones hard left and the other hard right.

3. Connect each of the two outputs in the stereo pair to a separate mixer channel.

Group parameters

The group parameters are located at the top left on the remote editor panel. These are parameters that in various 
ways are directly related to playing style.

Group parameters apply to a group, that is they are settings that are shared by all zones in a group.

D To make adjustments to one group, select one or more zones that belong to the group, and adjust the param-
eter on the front panel.

D To set several groups to the same value, select at least one zone in each group you want to adjust, and adjust 
the parameter on the front panel.

Key Poly
This setting determines the number of keys that you can play simultaneously (the polyphony). The maximum number 
is 99 and the minimum is 1, in which case the group will be monophonic.

Users of other samplers may want to note that the polyphony often means setting the number of voices that should 
be able to play. The NN-XT is different in this aspect, since the polyphony setting instead determines the number of 
keys, regardless of how many voices each key plays.

The Group Mono button

The Group Mono button beside the Key Poly section can be used to quickly set a group to play monophonically re-
gardless of the polyphony setting. E.g. if you have a group with open and closed hi hats, you can switch this on so that 
an open hi hat is automatically muted when you play a closed hi hat.

Group Mono overrides the Key Poly setting - except when playing the same note. 



NN-XT SAMPLER 561

So you can play your open hi-hat repeatedly without the sound cutting itself off. When you play the closed hi-hat, this 
cuts off the open hi-hat.

Note that activating this button is not the same as setting polyphony to 1. E.g., it can not be used for Legato or mono 
Retrig (see “Legato and Retrig”). 

Legato and Retrig

Legato

Legato works best with monophonic sounds. Set Key Poly (see above) to 1 and try the following:

D Hold down a key and then press another key without releasing the previous.
Notice that the pitch changes, but the envelopes do not start over. That is, there will be no new “attack”. 

D If Key Poly is set to more voices than 1, Legato will only be applied when all the assigned keys are “used up”.
For example, if you had a polyphony setting of “4” and you held down a 4 note chord, the next note you played 
would be Legato. Note, however, that this Legato key will “steal” one of the keys in the 4 note chord, as all the as-
signed keys were already used up!

Retrig

Retrig is the “normal” setting for playing polyphonic patches. That is, when you press a key without releasing the pre-
vious, the envelopes are triggered, like when you release all keys and then press a new one. In monophonic mode, 
Retrig has an additional function; if you press a key, hold it, press a new key and then release that, the first note is 
also retriggered.

LFO 1 Rate
This is used for controlling the rate of LFO 1 if it is used in “Group Rate” mode. In that case, this knob will take pre-
cedence over the rate parameter in the LFO 1 section. See “The LFOs” for detailed information about this.

Portamento
This is used for controlling portamento - a parameter that makes the pitch glide between the notes you play, rather 
than changing the pitch instantly as soon as you hit a key on your keyboard. By turning this knob you set how long it 
should take for the pitch to glide from one note to the next as you play them. 

In legato mode, there will only be any portamento when actually playing legato (tied) notes.

With the knob turned all the way to the left, portamento is disabled.
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Synth parameters

The Modulation controls

As previously described, the Modulation wheel (and the External Control wheel) can be used for controlling various 
parameters. These controls allow you to define which parameters the wheels should modulate and to what extent.

D Below each of the knobs are the letters “W” and “X”.
These are used for selecting the source that should control the parameter, and represent the “Modulation Wheel” 
and the “External Control wheel” respectively.

D By clicking on any of the letters, you decide which source should control the parameter. 
You can select either, both or none. When a letter is “lit”, the corresponding source is set to control the parameter.

D By turning the knobs, you decide how much the modulation and/or external control wheel should modulate 
the corresponding parameter.

Note that all of the control knobs are bi-polar, which means that they can be set to both positive and negative values. 
Positive values are set by turning the knobs to the right, and negative values are thus set by turning the knobs to the 
left:

• Setting them to positive values means that the value of the controlled parameter will be raised if the source 
wheel is pushed forward.

• Setting them to negative values means that the value will be lowered when a wheel is pushed forward.

• Keeping the knobs in the center position means that no modulation control is applied. 

There is one exception to these rules, and that is the LFO 1 Amt control, which works in a slightly different way. See 
below for more information about this.

The following parameters can be modulated:

F.Freq

This sets modulation control of the Filter’s cutoff frequency (see “The Filter section”).

Mod Dec

This sets modulation control of the Decay parameter in the Modulation Envelope (see “The Modulation Envelope”).
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LFO 1 Amt

This determines how much the amount of modulation from LFO 1 is affected by the Modulation wheel and/or the Ex-
ternal Controller wheel. It does this by “scaling” the amounts set with the three destination knobs in the LFO 1 section 
(Pitch, Filter and Level, see “The LFOs”). We’ll explain this with an example:

To use the Modulation Wheel to increase pitch modulation (vibrato), proceed as follows:
1. Turn the Mod Wheel all the way down, so that no modulation is applied.

2. Activate the “W” button for LFO 1 Amt in the Modulation section.

3. Set the corresponding knob to “12 o’clock” (zero).

4. Set up LFO 1 so that as much vibrato is applied as you want it to be when the Modulation wheel is turned all 
the way up.

5. Increase LFO 1 Amt until you hear as much vibrato as you want it to be when the wheel is turned all the way 
down.
If you turn LFO 1 Amt all the way up, there will be no vibrato at all when the wheel is all the way down.

To instead use the Modulation wheel to decrease vibrato, process as follows:
1. Turn the Mod Wheel all the way down, so that no modulation is applied.

2. Activate the “W” button for LFO 1 Amt in the Modulation section.

3. Set the corresponding knob to “12 o’clock” (zero).

4. Set up LFO 1 so that as much vibrato is applied as you want it to be when the Modulation wheel is turned all 
the way down.

5. Turn the Modulation wheel all the way up.

6. Decrease LFO 1 Amt until you hear as much vibrato as you want it to be when the wheel is turned all the way 
up.
If you turn LFO 1 Amt all the way down, there will be no vibrato at all when the wheel is all the way up.

F.Res

This sets modulation control of the Resonance parameter in the Filter (see “The Filter section”).

Level

This sets the amount of amplitude envelope modulation of each zone’s level. The level set here will be the level of the 
highest point of the Amp Envelope.

LFO 1 Rate

This sets modulation control of the Rate parameter in LFO 1 (see “The LFOs”).
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The Velocity controls

Velocity is used for controlling various parameters according to how hard or soft you play notes on your keyboard. A 
typical use of velocity control is to make sounds brighter and louder if you strike a key harder. By using the knobs in 
this section, you can control if and how much the various parameters will be affected by velocity. 

Just like the modulation controls, all of the velocity control knobs are bi-polar, and can be set to both positive and 
negative values.

• Setting them to positive values means that the value of the controlled parameter will be raised the harder you 
play.

• Setting them to negative values means that the value will be lowered the harder you play.

• Keeping the knobs in the center position means that no velocity control is applied. 

The following parameters can be velocity controlled:

F.Freq

This sets velocity control of the Filter’s cutoff frequency (see “The Filter section”).

Mod Dec

This sets velocity control of the Decay parameter in the Modulation Envelope (see “The Modulation Envelope”).

Level

This sets velocity control of the Amp Envelope.

Amp Env Attack

This sets velocity control of the Attack parameter in the Amplitude Envelope (see “The Amplitude Envelope”).

Sample Start

This sets velocity control of the Sample Start parameter (see “Sample Start and End”), so that it will be offset for-
wards or backwards, according to how hard or soft you play.

This allows you to control how much of the attack portion of the sample you hear when playing harder or softer.

To be able to make use of negative values for this parameter, you must increase the sample parameter Sample Start.
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The Pitch section

This section contains various parameters related to controlling the pitch, or frequency, of the zones. 

Pitch Bend Range

This lets you set the amount of pitch bend, i.e. how much the pitch changes when your turn the pitch bend wheel fully 
up or down. The maximum range is +/- 24 semitones (2 Octaves).

Setting the pitch

Use the three knobs marked “Octave”, “Semi” and “Fine” to change the pitch of the sample(s):

• Octave
This changes the pitch in steps of one full octave. The range is -5 – 0 – 5.

• Semi
This lets you change the pitch in semitone steps. The range is -12 – 0 – 12 (2 octaves).

• Fine
This changes the pitch in cents (hundredths of a semitone). The range is -50 – 0 – 50 (down or up half a semi-
tone).

K. Track

This knob controls Keyboard Tracking of the pitch.

• In the center position, each key represents a semitone This is the normal setting.

• When turned all the way down, all keys play the same pitch. This can be useful for percussion like timpani 
where you might want to play the same pitch from a range of keys.

• When turned all the way up, each key on the keyboard shifts the pitch one octave.
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The Filter section

Filters can be used for shaping the character of the sound. The filter in NN-XT is a multimode filter with six different 
filter types.

D To activate/deactivate the filter, click the On/Off button in the top right corner.
When the filter is activated, the button is lit.

Filter mode

To select a filter mode, either click the Mode button in the bottom right corner or click directly on the desired filter 
name so that it lights up:

• Notch
The notch filter is used for cutting off frequencies in a narrow frequency range around the set cutoff frequency, 
while letting the frequencies below and above through.

• HP 12
This is a highpass filter with a 12 dB/Octave roll-off slope. A highpass filter cuts off low frequencies and lets high 
frequencies pass. That is, frequencies below the cutoff frequency are cut off and frequencies above it pass 
through.

• BP 12
This is a bandpass filter with a 12 dB/Octave roll-off slope. A bandpass filter could be viewed as the opposite of 
a notch filter. It cuts off both the high and the low frequencies, while frequencies in the band range pass through.

• LP 6 
This is a lowpass filter with a gentle, 6 dB/Octave slope. A lowpass filter is the opposite of a highpass filter. It lets 
the low frequencies through and filters out the high frequencies. This filter has no Resonance.

• LP 12
This is a lowpass filter with a 12 dB/Octave roll-off slope.

• LP 24
This is a lowpass filter with a fairly steep roll-off slope of 24 dB/Octave.
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Filter controls

The following filter controls are available:

• Freq
This is used for setting the filter cutoff frequency. The cutoff frequency determines the limit above or below which 
frequencies will be cut off depending on the selected filter type. In the case of a lowpass filter for example, fre-
quencies below the cutoff frequency will be allowed to pass through, while frequencies above it will be cut off. The 
farther to the right you turn the knob, the higher the cutoff frequency will be.

q It is very common to modulate filter frequency with the modulation envelope, as described in “The Modulation 
Envelope”.

• Res
Technically, this knob controls feedback of the output signal from the filter, back to its input. Acoustically it empha-
sizes frequencies around the cutoff frequency. For a lowpass filter for example, increasing Res will make the 
sound increasingly more hollow until the sound starts “ringing”. If you set a high value for the Res parameter and 
then vary the filter frequency, this will produce a classic synthesizer filter sweep.

For the notch and bandpass filter types, the Resonance setting instead adjusts the width of the band. That is, the 
higher the resonance setting, the narrower the band will be where frequencies are cut off (notch) or let through 
(Bandpass).

• K. Track
This lets you activate and control keyboard tracking of the filter frequency. If keyboard tracking is activated, the set 
cutoff frequency of the filter will change according to the notes you play on your keyboard. That is, if you play notes 
higher up on the keyboard, the filter frequency will be raised and vice versa.

When the knob is set to its center position, filter frequency is adjusted so that the harmonic content remains con-
stant across the keyboard.

Keyboard tracking is deactivated by default (the knob all the way to the left). This means that the filter frequency 
will remain unchanged regardless of where on the keyboard you play.

The Modulation Envelope

The Modulation Envelope parameters let you control how certain parameters, or destinations, should change over 
time - from the moment a note is struck to the moment it is released again. 

The destinations you can use are: 

• Pitch

• Filter frequency
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Parameters

The following are the available controlling parameters:

• Attack
When you press a key on your keyboard, the envelope is triggered. The attack parameter then controls how long 
it should take before the controlled parameter (pitch or filter) reaches the maximum value, when you press a key. 
By setting attack to a value of “0”, the destination parameter would reach the maximum value instantly. By raising 
the attack parameter, the value will instead slowly “slide” up to its maximum.

• Hold
This is used for deciding how long the controlled parameter should stay at its maximum value before starting to 
decrease again. This can be used in combination with the Attack and Decay parameters to make a value reach its 
maximum level, stay there for a while (hold) and then start dropping gradually down to the sustain level.

• Decay
After the maximum value for a destination has been reached and the Hold time has expired, the controlled param-
eter will start to gradually drop down to the sustain level. How long it should take before it reaches the sustain level 
is controlled with the Decay parameter. If Decay is set to “0”, the value will immediately drop down to the sustain 
level.

• Sustain
The Sustain parameter determines the value the envelope should drop back to after the Decay. If you set Sustain 
to full level however, the Decay setting doesn’t matter since the value will never decrease.

A combination of Decay and Sustain can be used for creating envelopes that rise up to the maximum value, then 
gradually decrease to, and stay on a level somewhere in-between zero and maximum. 

• Release
This works just like the Decay parameter, with the exception that it determines the time it takes for the value to fall 
back to zero after the key is released.

• Delay
This is used for setting a delay between when a note is played and when the effect of the envelope starts. That is, 
the sound will start unmodulated, and the envelope will kick in after you have kept the key(s) pressed down for a 
while. Turn the knob to the right to increase the delay time. If the knob is set all the way to the left, there will be no 
delay.

• Key To Decay
By using this, you can cause the value of the Decay parameter (see above) to be offset depending on where on 
your keyboard you play. If you turn the knob to the right the decay value will be raised the higher up you play, and 
turning the knob to the left will lower the decay value the higher up you play. With the knob in the center position, 
this parameter is deactivated.

Destinations

The following are the available Mod Envelope destinations:

• Pitch
This will make the envelope modulate the pitch, as set in the Pitch section (see “The Pitch section”). Turn the knob 
to the right to raise the pitch and to the left to lower the pitch. In the middle position, pitch will not be affected by 
the envelope.

• Filter
This will make the envelope modulate the cutoff frequency of the Filter (see “The Filter section”). Turn the knob to 
the right to increase the frequency and to the left to lower the frequency. In the middle position, the envelope will 
have no effect on the cutoff frequency.
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The Amplitude Envelope

The Amplitude Envelope parameters let you control how the volume of a sound should change over time - from the 
moment a note is struck to the moment it is released again.

Parameters

Most of the Amplitude Envelope parameters are identical to those of the Modulation Envelope. So for a detailed de-
scription of the following parameters, please refer to the modulation envelope section in “The Modulation Envelope”:

• Attack

• Hold

• Decay

• Sustain

• Release

• Delay

• Key To Decay

The following are the parameters that are unique for the Amp Envelope section:

• Level
This knob sets the level of the zone. Turn it to the right to raise the level.

• Spread and Pan modes
These two parameters are used for controlling the stereo (pan) position of the sound. The Spread knob deter-
mines the sound’s width in the stereo image (how far left – right the notes will be spread out). If this is set to “0”, 
no spread will take place. The Mode selector switch is used for choosing which type of spread you want to apply:
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• Pan
This controls the stereo balance of the output pair to which a zone is routed. In the middle position, the signal ap-
pears equally strong on the left and right channel in a stereo pair. By turning the knob to the left or right, you can 
change the stereo balance.

Note that if you for instance turn the Pan knob all the way to the left, you cause the signal to be output from the left 
channel of the stereo pair only.

You can use this to treat a stereo output as two independent mono outputs, if required.

See “Out” for information on routing zones to output pairs.

The LFOs

NN-XT features two Low Frequency Oscillators - LFO 1 and LFO 2. “Normal” oscillators generate a waveform and a 
frequency, and produce sound. Low frequency Oscillators on the other hand, also generate a waveform and a fre-
quency, but there are two major differences: 

• LFOs only generate sounds of a low frequency.

• LFOs don’t produce sound, but are instead used for modulating various parameters.

The most typical use of an LFO is to modulate the pitch of a sound (generated by an oscillator or - in the case of NN-
XT - a sample), to produce vibrato.

About the Difference between LFO 1 and LFO 2

There are two fundamental differences between LFO 1 and LFO 2:

• LFO 2 is always key synced, that is, each time you press a key, the LFO waveform starts over from scratch. LFO 
1 can be switched between key synced and non-key synced modes.

• LFO 2 only has one waveform, triangle.

The following parameters are available for the LFOs:

| Mode | Description

Key This will make the pan position shift gradually from left to right, the higher up on the keyboard you play.

Key 2 This will make the pan position shift from left to right and then back again from right to left in a sequence of eight keys. 
Playing 4 adjacent semitones thus makes the pan position gradually go from left to right. The next 4 higher semitone notes 
will then change the pan position from right to left in the same way, and this cycle will then be repeated.

Jump This will make the pan position jump between left and right each time a note is played.
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Rate (LFO 1 and 2)

This knob controls the frequency of the LFO. For a faster modulation rate, turn the knob to the right. The Rate knob 
of LFO 1 is also used for setting the timedivision when synchronizing the LFO to the song tempo (see below).

Delay (LFO 1 and 2)

This can be used for setting a delay between when a note is played and when the LFO modulation starts kicking in 
(gradually). This way, you can make the sound start unmodulated, and then have the LFO modulation start after you 
have kept the key(s) pressed down for a while. 

Turn the knob to the right to increase the delay time.

Mode (LFO 1 only)

This lets you set the “operation mode” for the LFO. Click the button to switch between the available modes:

• Group Rate
In this mode, the LFO will run at the rate set for its group in the group section, rather than at the rate set here (see 
“Group parameters”). This way, all zones in the group will have the exact same modulation rate.

• Tempo Sync
In this mode, the LFO will be synchronized to the song tempo, in one of 16 possible time divisions.

! When tempo sync is activated, the Rate knob is used for selecting the desired timedivision. Turn the Rate knob 
and observe the tool tip for an indication of the timedivision.

• Free Run
In free run mode, the LFO simply runs at the rate set with the Rate parameter. Furthermore, if Key Sync is deacti-
vated, the modulation cycle will not be retriggered each time you press a key - it will run continuously.

Waveform (LFO 1 only)

Here, you select which type of waveform should be used for modulating the destination parameters.

Click the button to switch between the following waveforms:

! LFO 2 always uses a triangle waveform.

Key Sync (LFO 1 only)

By activating key sync, you “force” the LFO to restart its modulation cycle each time a key is pressed.

! Note that LFO 2 always uses Key Sync.

| Waveform | Description

Triangle This is a smooth waveform, suitable for normal vibrato.

Inverted Sawtooth This produces a “ramp up” cycle. If applied to an oscillator’s frequency, the pitch would sweep up, 
after which the cycle immediately starts over.

Sawtooth This produces a “ramp down” cycle, the same as above but inverted.

Square This produces cycles that abruptly change between two values, usable for trills etc.

Random Produces random stepped modulation to the destination. Some vintage analog synths called this 
feature “sample & hold”.

Soft Random The same as above, but with smooth modulation.
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Destinations for LFO 1

The following parameters can be modulated by LFO 1: 

• Pitch
This will make the LFO modulate the pitch, for vibrato, trills, etc. It can be set to -2400 to 0 to +2400 cents which 
equals 4 octaves. The set pitch will change up and down by this amount, with each modulation cycle. Turning the 
knob to the right will make the modulation cycle start above the set pitch, while turning it to the left will invert the 
cycle. Keeping this in the middle position means that the pitch will not be affected by the LFO.

• Filter
This will make the LFO modulate the cutoff frequency of the Filter, for auto-wah effects, etc. The positive/negative 
effect is the same as for pitch.

• Level
This will make the LFO modulate NN-XT’s output level, for tremolo effects, etc. The positive/negative effect is the 
same as for pitch.

Destinations for LFO 2

The following parameters can be modulated by LFO 2:

• Pan
This makes the LFO modulate the pan position of a zone. The sound will move back and forth in the stereo field. 
Turning the knob to the left makes the sound move from left to right, and turning it to the right thus makes it move 
from right to left. The middle position provides no modulation at all.

• Pitch
Just like for LFO 1 (see above), this makes LFO 2 modulate the pitch. The range is also the same as for LFO 1.

Connections
On the back panel of NN-XT are a number of connectors. Many of these are CV/Gate related. Using CV/Gate is de-
scribed in the chapter “Routing Audio and CV”.

Sequencer Control
The Sequencer Control CV and Gate inputs allow you to play the NN-XT from another CV/Gate device (typically a 
Matrix or a Redrum). The signal to the CV input controls the note pitch, while the signal to the Gate input delivers note 
on/off along with velocity.
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Modulation Input
These control voltage (CV) inputs (with associated voltage trim pots), can modulate various NN-XT parameters from 
other devices. These inputs can control the following parameters:

• Oscillator Pitch

• Filter Cutoff Frequency

• Filter Resonance

• LFO 1 Rate

• Master Volume

• Pan

• Modulation Wheel

• Pitch Wheel

Gate Input
These inputs can receive a CV signal to trigger the following envelopes:

• Amplitude Envelope

• Modulation Envelope 

Note that connecting to these inputs will override the normal triggering of the envelopes. For example, if you connect 
a Matrix Gate Out to the Gate In Amp Envelope, you would not trigger the amp envelope by playing notes, as this is 
now controlled by the Matrix Gate Out. In addition you would only hear the Gate Out triggering the envelope for the 
notes that you hold down.

Audio Output
There are 16 audio output jacks on the NN-XT’s back panel - eight separate stereo pairs. When you create a new 
NN-XT device, the first output pair (1L & 2R) is auto-routed to the first available channel on the audio mixer. 

The other output pairs are never automatically routed. If you wish to use any of the other output pairs, you have to 
manually connect them to the desired device - typically a Mix Channel device. The basics on Routing is described in 
“Routing Audio and CV”.

! Note that when you use any other output pair than the first, you also have to route one or more zones to it if 
you want it to actually output sound, since all zones by default are routed to outputs 1 & 2. How to route zones 
to other outputs is described in the “Out” section.
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Chapter 29
Dr. Octo Rex 
Loop Player
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Introduction

The Dr. Octo Rex Loop Player is the successor to the trusty Dr. Rex Loop Player, introduced in Reason Version 1. The 
Dr. Octo Rex can hold up to eight different REX loops at once, in eight pattern memories, and allows you to switch 
between loops and slices in very flexible ways. The Dr. Octo Rex Loop Player is fully backwards compatible with the 
discontinued Dr. Rex device. This means that all REX loops that previously used Dr. Rex devices in your songs will 
now open and play back in Dr. Octo Rex devices instead. The loops will sound exactly the same as they did in Dr. Rex.

The Dr. Octo Rex Loop Player is capable of playing back and manipulating files created in ReCycle, another product 
created by Propellerhead Software. ReCycle is a program designed especially for working with sampled loops. By 
“slicing” an audio loop and making separate samples of each beat, ReCycle makes it possible to change the tempo of 
loops without affecting the pitch and to edit the loop as if it was built up of individual sounds.

ReCycled Loops
To fully understand Dr. Octo Rex you need to understand what it means to ReCycle a drum loop. Imagine that you 
have a sample of a drum loop that you want to use in a track you are working on. The loop is 144 BPM and your track 
is 118 BPM. What do you do? You can of course lower the pitch of the loop, but that will make the loop sound very 
different, and if the loop contains pitched elements they will no longer match your song. You can also time stretch it. 
This won’t alter the pitch, but will make the loop sound different. Usually it means that you loose some “punch” in the 
loop. 

Instead of stretching the sample, ReCycle slices the loop into little pieces so that each drum hit (or whatever sound 
you are working with) gets its own slice. These slices can be exported to an external hardware sampler or saved as a 
REX file to be used in Reason Essentials. When the loop has been sliced you are free to change the tempo any way 
you want. You can also create fills and variations since the slices can be moved around in the sequencer.
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About REX file formats
Dr. Octo Rex can read REX files in the following formats:

• REX (.rex) 
This is the file format generated by previous versions of ReCycle (Mac platform).

• RCY (.rcy) 
This is the file format generated by previous versions of ReCycle (PC platform).

• REX 2 (.rx2) 
This is the ReCycle file format for both Mac and PC platforms generated by ReCycle version 2.0. One of the dif-
ferences between the original REX format and REX2, is that the REX2 format supports stereo files.

! Unlike the Dr. Rex device, Dr. Octo Rex can also load and save the device panel settings in a special Patch for-
mat (.drex). The REX file(s) and the Dr. Octo Rex panel settings are also saved in the Song file just like every 
other patch in the song.

Loading and saving Dr. Octo Rex patches
Loading and saving Dr. Octo Rex patches is done in the same way as in other patch based devices - see “Loading 
patches” and “Saving patches”.

Dr. Octo Rex patches can consist of up to eight separate REX loops. When you load an Dr. Octo Rex patch, the REX 
loop(s) will be automatically loaded in the Loop Slots with their names shown in the display(s) below each button.

About the Dr. Octo Rex patch format
Dr. Octo Rex patches (.drex) contains all panel and synth parameter settings as well as references to all (up to eight) 
REX loops. The actual REX files are not contained in the patch but must be available separately on the computer.
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Playing Loops
1. Make sure the Enable Loop Playback button is on (lit).

2. Click the desired Loop Slot button.

3. Play back the loop by clicking the Run button.
The loop in the selected Loop Slot will play back repeatedly in the tempo set on the Transport Panel. If you change 
the tempo, the loop tempo will follow.

D You can also play the loop once via MIDI, by using the D0 key.

D To check out the loop(s) together with other device sequencer data and patterns already recorded, click the se-
quencer Play button.
The loops will automatically play back in perfect sync with the sequencer.

Switching playback between Loop Slots
Switching playback between loops in different Loop Slots is just like switching a Pattern in a Redrum device, for ex-
ample.
1. Activate the Enable Loop Playback button on the Dr. Octo Rex device.

2. Click the Run button - or start sequencer playback.

3. Click another Loop Slot button to switch loop.
Selecting Loop Slots that have no loops loaded will result in silence.

The Trig Next Loop function

The Trig Next Loop function determines how long Dr. Octo Rex waits after a Loop Slot button (or a key) is pressed 
before it actually “gates in” or triggers the loop. This allows for different “precision” when switching between running 
loops:

D Activate the Bar button to make the loops switch at the next bar of the current loop.

D Activate the Beat button to make the loops switch at the next beat of the current loop.

D Activate the 1/16 button to make the loops switch at the next 1/16th note of the current loop.

Switching Loops using Pattern Automation in the sequencer

Switching between Loop Slots can be automated, by using Pattern Automation in the main sequencer.

! When using Pattern Automation, the Trig Next Loop function described above is disregarded - the switching 
between Loop Slots is instantaneous.

Refer to “Pattern automation recording details” for details about Pattern Automation.

! When you use the Pencil tool to draw Pattern Automation clips and select Pattern in the Inspector, the Bank 
selection is of no importance since Dr. Octo Rex doesn’t make use of Banks.
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Triggering playback and selecting Loop Slots from a MIDI keyboard

It’s also possible to control playback, stop and Loop Slot selection in real-time by pressing different keys on a MIDI 
keyboard. By pressing the keys E0 to B0 you select Loop Slot 1-8 and start playback of the corresponding loop. The 
loop(s) will play back continuously, one loop at a time, until you press the D#0 key to stop playback, or click the Run 
button or Stop in the main sequencer. The time between key press and Loop Slot switching is determined by the Trig 
Next Loop function, see “The Trig Next Loop function”.

! Note that the Enable Loop Playback button must be on.

The picture shows what keys should be pressed to select and play Loop Slot and to stop loop playback:

• To maintain backwards compatibility with Dr. Rex, the D0 key can be used to play back the REX loop in the 
Loop Slot that currently has Note To Slot focus (see “Note To Slot”).
The loop is played back once (single-shot) and cannot be stopped during this time.

Adding Loops
To add one or several (up to 8) loops into the Dr. Octo Rex Loop Player, proceed as follows:
1. Unfold the Loop Editor panel.

2. Select the Loop Slot you wish to add the (first) REX loop to.

3. Open the REX Loop browser by clicking the folder button to the left of the Loop Slot buttons.
Alternatively, select “Browse Loops...” from the Edit menu or the device context menu.

4. In the browser, locate and select the desired loop(s).
You can listen to the loops before loading by using the Preview function in the browser.

D To select several loops, hold down [Ctrl](Win)/[Cmd](Mac) and click.
To select a range of loops, hold down [Shift] while clicking the last file.

5. Click Open to load the selected file(s) in the Loop Slot(s).

! If you have selected and opened several loops, the first loop will load in the selected Loop Slot and the rest will 
load in consecutive Loop Slots.

! Loading new REX files will replace any files currently in the slots.

C0 D0

Lo
op

 s
to

p
S

lo
t 1

 p
la

y

S
lo

t 2
 p

la
y

S
lo

t 4
 p

la
y

S
lo

t 6
 p

la
y

S
lo

t 8
 p

la
y

S
lo

t 3
 p

la
y

S
lo

t 5
 p

la
y

S
lo

t 7
 p

la
y



DR. OCTO REX LOOP PLAYER580

Loading Loops “On the Fly”
Another practical method for checking out loops, is to load them “on the fly”, i.e. during playback. This is especially 
useful if you want to check out a number of loops against other sequencer data and patterns previously recorded. 
Proceed as follows:
1. Activate the Enable Loop Playback button on the Dr. Octo Rex device and start sequencer playback.

The REX loops and the sequencer are synced.

2. Now load a new REX file by using the Browser in one of the usual ways.
After a brief silence, the new file is loaded, and sync is maintained.

3. Repeat step 2 as necessary until you have found a suitable loop.

D If you are trying out loops within the same folder, the quickest ways to select a new loop is to use the arrow 
keys next to the loop name display.
Or, you can click in the loop name display and select a new loop from the pop-up menu that appears.

Removing Loops
D To remove a loop from a Loop Slot, select “Remove Loop” from the Edit menu or device panel context menu.

Cut/Copy and Paste Loops between Loop Slots
To cut or copy a loop from one Loop Slot and paste into another, proceed as follows:
1. Click the button of the Loop Slot that contains the loop you want to cut or copy.

2. Select “Cut Loop” or “Copy Loop” from the Edit menu or panel context menu.

! You have to context-click on the panel (not any button or knob) to access the correct context menu.

3. Click the destination Loop Slot button and select “Paste Loop” from the Edit menu or panel context menu.
Now, you can edit the slices of the pasted loop as desired, see “Slice handling”.

Playing individual Loop Slices
Besides playing back entire REX Loops using the Run function (or Play in the sequencer), it’s also possible to play in-
dividual slices of a loop from a MIDI master keyboard. This way you can use the Dr. Octo Rex almost like a traditional 
sampler, playing separate slices from separate keys.

The slices are automatically distributed in semitone steps, with the first slice on MIDI note C1, the second slice on 
C#1 and so on, with one note for each slice. The note range differs depending on how many slices the REX Loop 
contains. 

D Define which REX Loop to control from the MIDI master keyboard by selecting the desired Loop Slot with the 
Note To Slot knob:

The range is 1-8 corresponding to Loop Slots 1-8. Selected Slot is indicated with a lit LED.
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Creating sequencer notes
The individual slices in a REX loop can be transferred as separate MIDI notes to tracks in the sequencer. This makes 
it possible to have detailed control over every single sample in a REX loop. Proceed as follows to create sequencer 
notes from the slices:
1. Select the sequencer track associated with the Dr. Octo Rex device.

2. Set the left and right locators to encompass the section you want to fill with REX notes.

3. Select the Loop Slot that contains the REX loop you want to copy to the sequencer track.

4. Click the Copy Loop To Track button.

Now, the program will create clips containing a note for each slice of the REX loop in the selected Loop Slot, posi-
tioned according to the timing of the slices. The notes will be distributed in semitone steps, with the first note on C1, 
the second on C#1 and so on, with one note for each slice.

In addition to the created notes, the Note To Slot parameter (see “Note To Slot”) is copied into the clips as a Perfor-
mance Controller. This way, Dr. Octo Rex will always know which Note Slot the generated notes originated from and 
will thus automatically play back the loop slices from the correct Loop Slot.

The loop clips in Arrange Mode.
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...and in the Edit Mode, with the Note To Slot parameter as a Performance Controller at the bottom.

5. Disable the Enable Loop Playback parameter.

This is because you probably don’t want the loop playback to be controlled by the regular Run function but from 
note playback in the sequencer. If the Enable Loop Playback parameter is on, there will be double notes during 
playback from the sequencer.

Activating playback in the sequencer will now play back the notes on the sequencer track. These in turn will play back 
the slices of the REX loop in the Loop Slot defined by the Note To Slot parameter, in the correct order and with the 
original timing maintained. Now the fun begins!

• If the space between the Left and Right locators is greater than the length of the REX loop, the clips will be re-
peated on the note lane.

The REX loop is 1 bar long and the space between the locators is 4 bars, thus the clip is repeated four times on the note lane.
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• The Copy Loop To Track function always creates an exact number of complete clips, meaning that the last clip 
may “stick out” after the right locator.

Here, the REX loop is 4 bars long. Since there are only two bars between the locators, the clip will stick out after the right 
locator.

! If you are using the Alt function for slices in the REX loop, these slices will output different note numbers each 
time you use the Copy Notes To Track function. See “About the Alt parameter” for details.

q If you like, you can manually resize the clip to two bars by clicking and dragging the right clip handle. The last 
two bars of the clip will then be masked and won’t play (see “Resizing (masking) clips”).

• You can change the groove in the loop by quantizing or moving notes.

• You can transpose notes to change the order of the slices on playback.

• You can use the Alter Notes function (see “Moving notes with the “Alter Notes” function”) to scramble the 
loop notes - without destroying the original loop timing.

• You can remove and draw new notes, creating any kind of variation.

• You can use the User Groove function to apply the rhythmic feel of the loop to notes on other sequencer 
tracks.

For details about editing in the sequencer, see the “Note and Automation Editing” chapter.

! Note that if you have created sequencer notes from a REX file in one Loop Slot, selecting another Loop Slot 
with another REX loop could make the playback sound awkward. This is because the notes generated from the 
original REX loop will in most situations not correspond to the slices in the other REX loops. However, in some 
situations this could produce really interesting results so don’t be afraid to experiment.

• You can automate Loop Slot selection using the Notes To Slot function, see “Note To Slot”.

You can also export the REX file as a MIDI file, as described in “Export REX as MIDI File...”.
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Slice handling

Selecting Slices

A selected slice is indicated by being highlighted in the waveform display. To select a slice, use one of the following 
methods:

D By clicking in the waveform display.
If you hold down [Alt](Win) or [Option](Mac) and click on a slice in the waveform display, it will be played back. The 
pointer takes on the shape of a speaker symbol to indicate this.

D By using the “Slice” knob below the waveform display.

D Via MIDI.
If you activate “Select Slice Via MIDI”, you can select and “play” slices using your MIDI keyboard. Slices are always 
mapped to consecutive semitone steps, with the first slice always being on the “C1” key.

D If you play back a loop with “Select Slice via MIDI” option activated, each consecutive slice is selected in the 
waveform display as you play the keys.
You can edit parameters during playback.

Editing individual Slices
There are two basic methods you can use to edit individual slices in Reason Essentials:

• In the Waveform display of the Dr. Octo Rex device.
This is used for making playback settings for a slice.

• In the Sequencer.
Here you can edit the notes that play the slices. There is a special REX edit lane for editing REX slice notes, with 
the notes indicated by the slice numbers instead of by pitches. Editing notes in the sequencer is described in the 
“Note and Automation Editing” chapter.
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Editing in the Waveform Display

Here you are able to edit several parameters for each slice, by first selecting the slice and then using the knobs be-
low the waveform display. If you want to edit a single parameter for several slices at once, a more convenient way 
would be to use the Slice Edit Mode, see “The Slice Edit Mode”. The following slice parameters can be set:

! If you have made settings to any of the parameters listed above, these will be lost if you load a new REX file 
into that Loop Slot.

About the Alt parameter

The Alt parameter in the waveform display can be used to create a more “live” feel to your Rex loops by alternating 
samples within each individual Alt group. For example, if you assign all snare hit slices in the loop to the Alt 1 group, 
the snare samples will be selected and played back randomly each time these slices appear in the loop. Then, you 
could assign all hi-hat slices to the Alt 2 group and so on. The result will be a loop that plays back differently every cy-
cle.

In the example below, slices 3 and 6 have been assigned to the same Alt group. Here, we have used the Copy Loop 
To Track function five times to generate notes from the loop slices, just so you can see the note distribution. As you 
can see, slices 3 and 6 have been distributed randomly for each loop cycle:

This randomization within each Alt group also occurs when you play back the REX loop using the Run function - and 
when you use Pattern Automation in the main sequencer.

| Parameter | Description

Pitch Allows you to transpose each individual slice in semitone steps, over a range of more than eight octaves.

Pan The stereo position of each slice.

Level The volume of each slice. The default level is 100.

Decay Allows you to shorten individual slices.

Rev Allows you to play back individual slices reversed (backwards)

F.Freq Allows you to modify the Filter (cutoff) Frequency of individual slices. This value is added to, or subtracted 
(if negative) from the FREQ value of the synth panel, see “Filter Frequency”.

Alt Allows you to assign slices to an Alternate group (1-4). Slices assigned to any of these four Alt groups will 
be played pack in a random fashion within each group, see “About the Alt parameter”. 

Output Allows you to assign individual slices to separate audio outputs (1-8). If the REX loop is in stereo, there is 
also an option to select individual output pairs (1+2, 3+4, 5+6 or 7+8) for individual slices.
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The Slice Edit Mode
A very convenient way of editing several slices at once is to work in Slice Edit Mode. In Slice Edit Mode, you can edit 
one parameter at a time for all slices in the loop.
1. Click the Edit Slice Mode button.

The waveform display switches to show the REX loop in Slice Edit Mode.

2. Select the parameter you want to edit by clicking on its name below the REX loop.
The parameters that can be selected are: Pitch, Pan, Level, Decay, Reverse, Filter Frequency, Alt Group and Out-
put.

Here, we have selected the Pitch parameter.

3. Edit the Pitch value for each individual slice by clicking, or drawing across several slices, in the display.

Now, the Pitch parameter can be edited for all slices in a single sweep.

D To reset the selected parameter to its default value for one or several slices, hold down [Ctrl](Win) or 
[Cmd](Mac) and click on the desired slice(s), or draw across the slices in the waveform display.

4. When you are finished with one parameter, select another parameter and repeat the procedure by drawing val-
ues for the slices in the waveform display.

! If you have made settings to any of the parameters listed above, these will be lost if you load a new REX file 
into that Loop Slot.
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Dr. Octo Rex panel parameters

Pitch and Mod wheels

The Pitch wheel to the left is used for “bending” the pitch up or down. The Mod wheel can be used to apply various 
modulation while you are playing the loop(s). Virtually all MIDI keyboards have Pitch Bend and Modulation controls. 
Dr. Octo Rex also has two “wheels” on the panel that could be used to apply real time modulation and pitch bend 
should you not have these controllers on your keyboard, or if you aren’t using a keyboard at all. The wheels mirror the 
movements of the corresponding MIDI keyboard controllers.

The Pitch bend range and Mod destination parameters are set on the synth parameter panel, see “Pitch Bend Range” 
and “Mod. Wheel”.

Trig Next Loop

The Trig Next Loop parameter determines the timing when switching between Loop Slots See “The Trig Next Loop 
function”.

Note To Slot

The Notes To Slot knob set to Slot 1

The Note To Slot knob controls which Loop Slot is currently controlled from the MIDI master keyboard, or by any re-
corded sequencer notes. The Loop Slot which currently has “note input” is indicated with a lit LED.
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The Note To Slot parameter can also be automated. This means you could switch between Loop Slots for every sin-
gle sequencer note if you like. This opens up for very interesting “beat mangling” experiments. In the example below 
the Note To Slot parameter has been automated to switch between the REX loops in the five first Loop Slots:

Automation of the Note To Slot parameter to automatically switch between Loop Slots

In the picture above slice 1 is played from Loop Slot 1, slices 2 and 3 from Loop Slot 2, slice 4 and 5 from Loop Slot 
3, slice 6 from Loop Slot 2 and so on.

Loop Slot buttons

The eight Loop Slot buttons are located in the center of the front panel. You can load one REX loop per Slot. Loading 
REX loops are done from the Loop Editor panel, see “Select Loop & Load Slot”.

D Click a Loop Slot button to select its REX loop for playback.
Play back the REX loop in the selected Loop Slot by clicking the Run button (or Play in the main sequencer).

! Note that selecting a Loop Slot only selects the corresponding REX loop for playback using the Run function 
(see “Enable Loop Playback and Run”) or Play from the main sequencer. Which Loop Slot the master keyboard 
or sequencer notes control is defined with the Note To Slot button, see “Note To Slot”.
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Enable Loop Playback and Run

D Click the Enable Loop Playback button to make it possible to play back the REX loops using the Run button or 
Play function in the main sequencer.
If the Enable Loop Playback button is off, clicking Run or Play in the sequencer won’t play back the loops. This can 
be useful if you only want to control the individual slices of the REX loops from a master keyboard or from re-
corded notes in the main sequencer.

Volume

The Master Volume parameter acts as a general volume control for the loops in all Loop Slots.

Global Transpose

Set the global transposition of the loops in all Loop Slots by using the Global Transpose spin control. You can raise 
or lower the pitch in 12 semitone steps (+/– 1 octave).

• The Global Transpose value can also be controlled via MIDI, by pressing a key between C-2 and C0 (with C-1 
resetting the Global Transpose value to zero).
This way you can also record transposition changes in the sequencer as parameter automation.
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Dr. Octo Rex synth parameters
The Dr. Octo Rex synth parameters are used for shaping and modulating the sound of the REX loops. These param-
eters are familiar synth parameters, similar to the ones in the Subtractor synthesizer and the NN-XT sampler. It is im-
portant to remember that these parameters do not alter the REX files in any way, only the way they play back. 

! Most of the synth parameters are global, in the sense that they will affect all slices in the REX files as well as 
all REX loops in all eight Loop Slots.

! All Dr. Octo Rex synth panel settings are stored in the Song (and in the Dr. Octo Rex patch file if you choose to 
save the settings as a patch).

Select Loop & Load Slot

D Click any of the eight Select Loop & Load Slot buttons to select a loaded REX loop for editing, or to load a new 
REX file to.
If no loop is already present in the selected Loop Slot, the Waveform Display will be blank. Otherwise, the display 
shows a graphical readout of the REX loop and info (name, original loop tempo, number of bars and signature).

D Click the Follow Loop Playback button to “synchronize” the Select Loop & Load Slot buttons to the Loop Slot 
buttons on the front panel.
This way, the currently playing loop will always be displayed in the Waveform Display. If you’re using Pattern Auto-
mation in the sequencer, where the Slots are switched during playback, you might want to deactivate the Follow 
Loop Playback function to make it easier to edit a specific loop.

Refer to “Adding Loops” for info on how to load REX files and to “Editing in the Waveform Display” for info about ed-
iting the REX loop.

Loop Transpose

D Set the transposition of individual loops in the Dr. Octo Rex by using the Loop Transpose knob to the bottom 
left on the panel, or by clicking on the keyboard display below the knob. 
You can raise or lower the pitch in 12 semitone steps (+/–1 octave). 

q It’s also possible to set a global transpose value that affects all REX loops equally, see “Global Transpose”.
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Loop Level
D Set the individual levels for the loops in the Loop Slots with the Loop Level knob.

This lets you match the levels of the loops in the 8 Loop Slots.

Oscillator section

For a REX file, the audio contained in the slices are what oscillators are for a synthesizer, the main sound source. The 
following settings can be made in the Osc Pitch section of the Dr. Octo Rex:

Env. A

This parameter determines to what degree the overall pitch of all the REX files will be affected by the Filter Envelope 
(see “Filter Envelope”). You can set negative or positive values here, which determines whether the envelope curve 
should raise or lower the pitch.

Oct and Fine - Setting the overall Pitch

You can change the overall pitch of all REX files in the 8 Loop Slots in three ways:

D In octave steps.
This is done using the Oct knob. The range is 0 - 8, with “4” as default.

D In semitone steps.
This is done by using Global Transpose controls, see “Global Transpose”.

D In cents (hundredths of a semitone).
The range is -50 to 50 (down or up half a semitone).

q To transpose individual REX loops, use the Loop Transpose parameter, see “Loop Transpose”.

! To tune an individual slice in a REX loop, select it and use the Pitch parameter below the waveform display, 
see “Editing in the Waveform Display”.

Mod. Wheel

The Modulation wheel can be set to simultaneously control a number of parameters. You can set positive or negative 
values, just like in the Velocity Control section. The following parameters can be affected by the modulation wheel:

| Parameter | Description

F. Freq This sets modulation wheel control of the filter frequency parameter. A positive value will raise the fre-
quency if the wheel is pushed forward. Negative values invert this relationship.



DR. OCTO REX LOOP PLAYER592

Velocity section

Velocity is usually used to control various parameters according to how hard or soft you play notes on your keyboard. 
A REX file does not contain velocity values on its own. And when you create sequencer track data by applying the 
“Copy Loop To Track” function, all velocities are set to a default value of “64”. As velocity information is meant to re-
flect variation, having them all set to the same value is not meaningful if you wish to velocity control Dr. Octo Rex pa-
rameters.

There are basically two ways you can apply “meaningful” velocity values to REX files:

• After creating track data, you can edit velocity values in the Velocity Lane in the sequencer.

• You can play slices in real time on your keyboard. The resulting data will have velocity values reflecting how 
the notes were struck when you played.

When velocity values have been adjusted, you can control how much the various parameters will be affected by ve-
locity. The velocity sensitivity amount can be set to either positive or negative values, with the center position repre-
senting no velocity control. 

The following parameters can be velocity controlled:

The Filter Section

Filters are used for shaping the overall timbre of all REX files in all 8 Loop Slots. The filter in Dr. Octo Rex is a multi-
mode filter with five filter modes.

F. Res This sets modulation wheel control of the filter resonance parameter. A positive value will increase the 
resonance if the wheel is pushed forward. Negative values invert this relationship.

F. Decay This sets modulation wheel control for the Filter Envelope Decay parameter. A positive value will increase 
the decay if the wheel is pushed forward. Negative values invert this relationship.

|  Parameter | Description

F. Env This sets velocity control for the Filter Envelope Amount parameter. A positive value will increase the en-
velope amount with higher velocity values. Negative values invert this relationship.

F. Decay This sets velocity control for the Filter Envelope Decay parameter. A positive value will increase the De-
cay time with higher velocity values. Negative values invert this relationship.

Amp This let’s you velocity control the overall volume of the file. If a positive value is set, the volume will in-
crease with higher velocity values. 

| Parameter | Description
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D Activate or deactivate the filter completely by clicking the Filter On button.
The filter is active when the button is lit.

Mode

With this selector you can set the filter to operate as one of five different types of filter. These are as follows:

• Notch
A notch filter (or band reject filter) could be described as the opposite of a bandpass filter. It cuts off frequencies 
in a narrow midrange band, letting the frequencies below and above through. 

• High-Pass (HP12)
A highpass filter is the opposite of a lowpass filter, cutting out lower frequencies and letting high frequencies pass. 
The HP filter slope has a 12 dB/Octave roll-off.

• Bandpass (BP 12)
A bandpass filter cuts both high and low frequencies, while midrange frequencies are not affected. Each slope in 
this filter type has a 12 dB/Octave roll-off.

• 12 dB Lowpass (LP 12)
This type of lowpass filter is also widely used in classic analog synthesizers (Oberheim, early Korg synths, etc.). It 
has a gentler slope (12 dB/Octave), leaving more of the harmonics in the filtered sound compared to the LP 24 fil-
ter.

• 24 dB Lowpass (LP 24)
Lowpass filters lets low frequencies pass and cuts out the high frequencies. This filter type has a fairly steep roll-
off curve (24dB/Octave). Many classic synthesizers (Minimoog/Prophet 5 etc.) used this filter type.

Filter Frequency

The Filter Frequency parameter (often referred to as “cutoff”) determines which area of the frequency spectrum the 
filter will operate in. For a lowpass filter, the frequency parameter could be described as governing the “opening” and 
“closing” of the filter. If the Filter Freq is set to zero, none or only the very lowest frequencies are heard, if set to max-
imum, all frequencies in the waveform are heard. Gradually changing the Filter Frequency produces the classic syn-
thesizer filter “sweep” sound.

! Note that the Filter Frequency parameter is usually controlled by the Filter Envelope (see “Filter Envelope”) as 
well. Changing the Filter Frequency with the Freq slider may therefore not produce the expected result.

Resonance

The filter resonance parameter affects the character of the filter sound. For lowpass filters, raising the resonance will 
emphasize the frequencies around the set filter frequency. This produces a generally thinner sound, but with a 
sharper, more pronounced filter frequency “sweep”. The higher the resonance value, the more resonant the sound be-
comes until it produces a whistling or ringing sound. If you set a high value for the resonance parameter and then vary 
the filter frequency, this will produce a very distinct sweep, with the ringing sound being very evident at certain fre-
quencies.

• For the highpass filter, the resonance parameter operates just like for the lowpass filters.

• When you use the Bandpass or Notch filter, the resonance setting adjusts the width of the band. 
When you raise the resonance, the band where frequencies are let through (Bandpass), or cut (Notch) will become 
narrower. Generally, the Notch filter produces more musical results using low resonance settings.
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Envelope section
Envelope generators are used to control several important sound parameters in analog synthesizers, such as pitch, 
volume, filter frequency etc. In a conventional synthesizer, envelopes govern how these parameters should respond 
over time - from the moment a note is struck to the moment it is released. In the Dr. Octo Rex device however, the en-
velopes are triggered each time a slice is played back.

There are two envelope generators in the Dr. Octo Rex, one for volume, and one for the filter frequency (and/or 
pitch). Both have the standard four parameters; Attack, Decay, Sustain and Release.

Please refer to “Envelopes - General” in the Subtractor chapter for a description of the basic envelope parameters.

Amplitude Envelope

The Amp Envelope governs how the volume of each slice should change over time, from the time it is triggered (the 
slice note starts) until the slice note ends. This can be used to make a loop more distinct (by having a snappy attack 
and a short decay time) or more spaced-out (by raising the attack time).

Filter Envelope

The Filter Envelope can be used to control two parameters for all REX loops in the 8 Loop Slots; filter frequency and 
overall loop pitch. By setting up a filter envelope you control how the filter frequency and/or the pitch should change 
over time for each slice.

The Amount parameter determines to what degree the filter frequency will be affected by the Filter Envelope. The 
higher the Amount setting, the more pronounced the effect of the envelope on the filter.

q Try lowering the Frequency slider and raising Resonance and Envelope Amount to get the most effect of the 
filter envelope!
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LFO section

LFO stands for Low Frequency Oscillator. LFOs are oscillators in the sense that they generate a waveform and a fre-
quency. However, there are two significant differences compared to normal sound generating oscillators:

• LFOs only generate waveforms with low frequencies.

• The output of the two LFOs are never actually heard. Instead they are used for modulating various parameters.

The most typical application of an LFO is to modulate the pitch of a (sound generating) oscillator or sample, to pro-
duce vibrato. In the Dr. Octo Rex device, you can also use the LFO to modulate the filter frequency or panning.

Waveform

LFO 1 allows you to select different waveforms for modulating parameters. These are, from top to bottom:

Destination

The available LFO Destinations are as follows:

Sync

By clicking the SYNC button you activate/deactivate LFO sync. The frequency of the LFO will then be synchronized 
to the song tempo, in one of 16 possible time divisions. When sync is activated, the Rate knob (see below) is used for 
setting the desired time division.

| Waveform | Description

Triangle This is a smooth waveform, suitable for normal vibrato.

Inverted
Sawtooth

This produces a “ramp up” cycle. If set to control pitch (frequency), the pitch would sweep up to a set point (governed by 
the Amount setting), after which the cycle immediately starts over.

Sawtooth This produces a “ramp down” cycle, the same as above but inverted.

Square This produces cycles that abruptly changes between two values, usable for trills etc.

Random Produces random stepped modulation to the destination. Some vintage analog synths called this feature “sample & hold”.

Soft Random The same as above, but with smooth modulation.

| Destination | Description

Osc Selecting this makes LFO control the pitch (frequency) of the REX file.

Filter Selecting this makes the LFO control the filter frequency. 

Pan Selecting this makes the LFO modulate the pan position of the REX file, i.e. it will move the sound from 
left to right in the stereo field.
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Turn the knob and check the tooltip for an indication of the time division.

Rate

The Rate knob controls the LFO’s frequency. Turn clockwise for a faster modulation rate.

Amount

This parameter determines to what degree the selected parameter destination will be affected by the LFO 1, i.e. the 
amount of vibrato, filter wah or auto-panning.

Pitch Bend Range

The Pitch Bend Range parameter sets the amount of pitch bend when the wheel is turned fully up or down. The max-
imum range is 24 semitones (=up/down 2 Octaves).

Setting number of voices - polyphony

This determines the polyphony, i.e. the number of voices, or slices, Dr. Octo Rex can play simultaneously. For normal 
loop playback, it is worth noting that slices sometimes “overlap”. Therefore, it is recommended that you use a polyph-
ony setting of about 3-4 voices when playing REX files. If you are “playing” slices via MIDI, the polyphony setting 
should be set according to how many overlapping slices you want to have.

! Note that the Polyphony setting does not “hog” voices. For example, if you are playing a file that has a polyph-
ony setting of ten voices, but the file only uses four voices, this doesn’t mean that you are “wasting” six voices. 
In other words, the polyphony setting is not something you need to consider if you want to conserve CPU 
power - it is only the number of voices actually used that counts.
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Audio Quality settings
Dr. Octo Rex features two parameters that provide ways of balancing audio quality vs. conservation of computer 
power. The parameters are called “High Quality Interpolation” and “Low Bandwidth” and are located to the right on 
the rear panel:

High Quality Interpolation

When High Quality Interpolation is active, the loop file playback is calculated using a more advanced interpolation al-
gorithm. This results in better audio quality, especially for loops with a lot of high frequency content.

• High Quality Interpolation uses more computer power - if you don’t need it, it’s a good idea to turn it off.
Listen to the loop in a context and determine whether you think this setting makes any difference.

Low Bandwidth

This will remove some high frequency content from the sound, but often this is not noticeable (this is especially true 
if you have “filtered down” your loop). Activating this mode will save you some extra computer power, if needed.

Connections

On the rear panel of Dr. Octo Rex you will find the connectors. The left part of the panel houses a number of CV/Gate 
inputs and outputs. Using CV/Gate is described in “Routing Audio and CV”.

Modulation Inputs
These control voltage (CV) inputs (with trim pots), allow you to modulate various Dr. Octo Rex parameters from other 
devices (or from the modulation outputs of the Dr. Octo Rex device itself). The following CV inputs are available:

• Master Volume

• Mod Wheel

• Pitch Wheel

• Filter Cutoff

• Filter Resonance

• Osc Pitch
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Modulation Outputs
The Modulation outputs can be used to voltage control other devices, or other parameters in the Dr. Octo Rex device 
itself. The Modulation Outputs are:

• Filter Envelope
The Filter Envelopes in Dr. Octo Rex are polyphonic (one per voice). Only the filter envelope of voice 1 is output 
here.

• LFO

Gate Inputs
These inputs can receive a CV/gate signal to trigger the two envelopes. Note that connecting to these inputs will 
override the “normal” triggering of the envelopes. For example, if you connected an LFO CV output on another device 
to the Gate Amp input on the Dr. Octo Rex, the amplitude envelope would not be triggered by the incoming MIDI 
notes to the Dr. Octo Rex device, but by the LFO CV signal. In addition you would only hear the LFO triggering the en-
velope for the slices that were playing at the moment of the trigger.

• Amp Envelope

• Filter Envelope

Gate Output
This outputs a gate signal for each triggered slice in the loop.

Slice Outputs
To the right of the modulation inputs and outputs are the eight individual slice audio outputs. You can assign individ-
ual slices to any of these outputs as described in “Editing in the Waveform Display”.

Main Outputs
To the right are the main left and right audio outputs. When you create a new Dr. Octo Rex device, these are auto-
routed to the first available channel on the audio mixer. 



Chapter 30
Redrum Drum 
Computer



REDRUM DRUM COMPUTER600

Introduction

At first glance, Redrum looks styled after pattern-based drum machines, like the legendary Roland 808/909 units. In-
deed, it does have a row of 16 step buttons that are used for step programming patterns, just like the aforementioned 
classics. There are significant differences, however. Redrum features ten drum “channels” that can each be loaded 
with an audio file, allowing for completely open-ended sound possibilities. Don’t like the snare - just change it. Com-
plete drum kits can be saved as Redrum Patches, allowing you to mix and match drum sounds and make up custom 
kits with ease.

In addition, Redrum also has sampling capability. This means that you can sample your own sounds straight into each 
of the ten drum channels with just a click of a button!

Sampling in Redrum
The sampling procedure is generic for all devices that can sample (NN-XT and Redrum). The sampling and sample 
editing procedures are described in detail in the “Sampling” chapter.

D To sample your own sound and automatically load it into a drum channel in the Redrum device, click the Sam-
ple button for the desired drum channel.

Refer to the “Sampling” chapter for details on how to set up and use the sampling feature.
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About file formats
Redrum reads two basic types of files:

Redrum Patches

A Redrum patch (Windows extension “.drp”) contains all settings for all ten drum sound channels, including file refer-
ences to the used drum samples (but not the actual drum samples themselves). Switching patches is the same as se-
lecting a new drum kit.

Drum Samples

Redrum can read and play back sample files of the following formats:

• Wave (.wav)

• AIFF (.aif)

• SoundFonts (.sf2)

• REX file slices (.rx2, .rex, .rcy)

• Any standard bit depth

• Any standard sample rate

• Stereo or Mono

Wave and AIFF are the standard audio file formats for the PC and Mac platforms, respectively. Any audio or sample 
editor, regardless of platform, can read and create audio files in at least one of these formats, and some of them in 
both formats.

SoundFonts are an open standard for wavetable synthesized audio, developed by E-mu systems and Creative Tech-
nologies.

SoundFont banks store wavetable synthesized sounds, allowing users to create and edit multi-sampled sounds in 
special Soundfont editing programs. The sounds can then be played back in wavetable synthesizers, typically on au-
dio cards. The samples in a SoundFont are stored hierarchically in different categories: User Samples, Instruments, 
Presets etc. The Redrum allows you to browse and load single SoundFont samples, not entire soundfonts.

REX files are files created in ReCycle – a program designed for working with sampled loops. It works by “slicing” up 
a loop and making separate samples of each beat, which makes it possible to change the tempo of loops without af-
fecting the pitch and to edit the loop as if it was built up of individual sounds. The Redrum lets you browse REX files 
and load separate slices from it as individual samples.
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Using patches
When you create a new Redrum device it is loaded with a default kit. If you like you can program a pattern and play 
back using the default kit - or you can load another Redrum patch (or create one from scratch, by loading individual 
drum samples). A Redrum patch contains settings for the ten drum sound channels, complete with file references to 
the drum samples used.

! Redrum patterns are not part of the patch! If you want to save Redrum patches complete with patterns, create 
a Combinator containing the Redrum and save the Combi patch.

Loading a patch
To load a patch, use one of the following methods:

D Use the browser to locate and open the desired patch.
To open the browser, select “Browse Redrum Patches” from the Edit menu or device context menu, or click the 
folder button in the patch section on the device panel.

D Once you have selected a patch, you can step between all the patches in the same folder by using the arrow 
buttons next to the patch name display.

D If you click on the patch name display on the device panel, a pop-up menu will appear, listing all patches in the 
current folder.
This allows you to quickly select another patch in the same folder, without having to step through each one in turn.

Checking the sounds in a patch
There are two ways you can listen to the sounds in a patch without programming a pattern:

D By clicking the Trigger (arrow) button at the top of each drum sound channel.

D By playing the keys C1 to A1 on your MIDI keyboard.
C1 plays drum sound channel 1 and so on. See also “Using Redrum as a sound module”.

Both these methods play back the drum sample for the corresponding drum sound channel, with all settings for the 
sound applied.
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Creating a new patch
To create a patch of your own (or modify an existing patch), you use the following basic steps:
1. Click the folder button for a drum sound channel.

The Redrum sample browser opens.

2. Locate and open a drum sample.
You will find a large number of drum samples in the Factory Sound Bank (in the folder Redrum Drum Kits/xclusive 
drums-sorted). You can also use any AIFF, Wave, SoundFont sample or REX file slice for this.

3. Make the desired settings for the drum sound channel.
The parameters are described in “Redrum parameters”.

4. Repeat steps 1 and 3 for the other drum sound channels.

5. When you’re satisfied with the drum kit, you can save the patch by clicking the Floppy Disk button in the patch 
section on the device panel.
Note however, that you don’t necessarily need to save the patch - all settings are included when you save the 
song.

Loading REX file slices

Loading slices from within a REX file is done much in the same way as loading “regular” samples:
1. Open the sample browser as described above.

2. Browse to a REX file.
Possible extensions are “.rx2”, “.rex” and “.rcy”.

3. Select the file and click “Open”.
The browser will now display a list of all the separate slices within the REX file.

4. Select the desired slice and click open.
The slice is loaded into the Redrum.

Creating an empty patch
To “initialize” the settings in the Redrum, select “Initialize Patch” from the Edit menu or the device context menu. This 
removes all samples for all drum sound channels, and sets all parameters to their default values.

Programming patterns

Pattern basics
Redrum contains a built-in pattern sequencer. Unlike the main sequencer in Reason Essentials, the Redrum se-
quencer repeatedly plays back a pattern of a specified length. The typical analogy in the “real world” is a drum ma-
chine which plays drum patterns, usually one or two bars in length.
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Having the same pattern repeat throughout a whole song may be fine in some cases, but most often you want some 
variations. The solution is to create several different patterns and program pattern changes (automatic switching from 
one pattern to another) at the desired positions in the song.

How the Redrum pattern sequencer integrates with the main sequencer

The built-in pattern sequencer in the Redrum interacts with the main Reason Essentials sequencer in the following 
ways:

D The tempo set on the transport panel is used for all playback.
If the Tempo track (see “Recording tempo automation”) is used, Redrum will follow this.

D If you start playback for the main sequencer (on the transport panel), the Redrum will automatically start as 
well (provided the pattern sequencer hasn’t been disabled - see below).

D You can mute and solo Redrum tracks in the sequencer.
If the Redrum has a track in the sequencer and you mute this track, Redrum will automatically be muted as well. 
This is indicated by a Mute indicator on the device panel. If there are several note lanes on the Redrum track, their 
respective mute status will not be indicated on the device panel.

This Redrum device is muted.

D You can also run Redrum separately (without starting the main sequencer) by clicking the Run button on the 
device panel.
This starts the built-in pattern sequencer in the device. To stop playback, click the Run button again or click the 
Stop button on the Transport panel.

The Run button on the Redrum.

D If you are running Redrum separately and start playback of the main sequencer, the pattern device will auto-
matically restart in sync with the sequencer.

D Pattern changes can be controlled by pattern change events in the main sequencer.
In other words, you can record or create pattern changes in the main sequencer, and have them occur at the cor-
rect position on playback.
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D The sound sources can also be played by the main sequencer, or via MIDI.
You can combine the built-in pattern playback with playback from the main sequencer or via MIDI. For example, 
this allows you to add variations or fills to a basic pattern.
It is also possible to disable the pattern sequencer totally, converting the device to a pure sound module. This is 
done by deactivating the Enable Pattern Section switch.

Selecting patterns

The Redrum has 32 pattern memories, divided into four banks (A, B, C, D).

The Bank and Pattern buttons for the Redrum pattern sequencer.

D To select a pattern in the current bank, click on the desired Pattern button (1-8).
If you like, you can assign computer key commands and/or MIDI messages to pattern selection.

D To select a pattern in another bank, first click the desired Bank button (A, B, C, D) and then click the Pattern 
button.
Nothing happens until you click the Pattern button.

D If you select a new pattern during playback, the change will take effect on the next downbeat (according to the 
time signature set in the transport panel).
If you automate pattern changes in the main sequencer, you can make them happen at any position - see “Record-
ing pattern automation”.

D Note that you cannot load or save patterns - they are only stored as part of a song.
However, you can move patterns from one location to another (even between songs) by using the Cut, Copy and 
Paste Pattern commands. 

Pattern tutorial
If you are unfamiliar with step programming patterns, the basic principle is very intuitive and easy to learn. Proceed as 
follows:
1. Load a Redrum patch, if one isn’t already loaded.

2. Make sure an empty pattern is selected.
If you like, use the Clear Pattern command on the Edit menu or device context menu to make sure.
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3. Make sure that the “Enable Pattern Section” and the “Pattern” buttons are activated (lit).

4. Press the “Run” button.
There will be no sound, as no pattern steps have been recorded yet. But as you can see, the LEDs over the Step 
button light up consecutively, moving from left to right, and then starts over. Each Step button represents one 
“step” in the Pattern. 

5. Select a Redrum channel, by clicking the “Select” button at the bottom of the channel.
The button lights up, indicating that this channel and the drum sound it contains is selected.

6. While in Run mode, press Step button 1, so that it lights up.
The selected sound will now play every time Step 1 is “passed over”.

7. Clicking other Step buttons so they light up will play back the selected sound as the sequencer passes those 
steps.
Clicking on a selected (lit) step button a second time removes the sound from that step and the button goes dark 
again. You can click and drag to add or remove steps quickly.

8. Select another Redrum channel to program steps for that sound.
Selecting a new sound or channel also removes the visual indications (static lit buttons) of step entries for the pre-
viously selected sound. The step buttons always show step entries for the currently selected sound.

9. Continue switching between sounds, and programming steps to build your pattern.
Note that you can erase or add step entries even if Run mode isn’t activated.

Setting pattern length
You may want to make settings for Pattern length, i.e the number of steps the pattern should play before repeating:

D Use the “Steps” spin controls to set the number of steps you wish the pattern to play.
The range is 1 to 64. You can always extend the number of steps at a later stage, as this will merely add empty 
steps at the end of the original pattern. You could also make it shorter, but that would (obviously) mean that the 
steps “outside” the new length won’t be heard. These steps aren’t erased though; if you raise the Steps value 
again, the steps will be played back again.
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About the “Edit Steps” Switch

If you set the pattern length to more than 16 steps, the pattern steps following after the 16th won’t be visible, al-
though they will play back. To view and be able to edit the next 16 steps, you have to set the Edit Steps switch to 17-
32. To see and edit steps beyond 32 you set the switch to 33-48, and so on.

Setting pattern resolution

Redrum always follows the tempo setting on the transport panel, but you can also make Redrum play in different 
“resolutions” in relation to the tempo setting. Changing the Resolution setting changes the length of each step, and 
thereby the “speed” of the pattern.

Step dynamics 
When you enter step notes for a drum sound, you can set the velocity value for each step to one of three values: 
Hard, Medium or Soft. This is done by setting the Dynamic switch before entering the note.

The color of the step buttons reflect the dynamics for each step. Soft notes are light yellow, Medium notes are orange and Hard 
are red.

D When the Medium value is selected, you can enter Hard notes by holding down [Shift] and clicking.
In the same way, you can enter Soft notes by holding down [Option] (Mac) or [Alt] (Windows) and clicking. Note 
that this doesn’t change the Dynamic setting on the device panel - it only affects the notes you enter.

D When you use different dynamics, the resulting difference in the sound (loudness, pitch, etc.), is governed by 
the “VEL” knob settings for each drum channel (see “Redrum parameters”). 
If no velocity amount is set for a drum channel, it will play back the same, regardless of the Dynamic setting.

D To change the dynamics for an already programmed step, set the switch to the dynamic value you wish to 
change it to and click on the step.

! Note that if you are triggering Redrum via MIDI or from the main sequencer, the sounds will react to velocity 
like any other audio device. The Dynamic values are there to offer velocity control when using the built-in pat-
tern sequencer.
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Pattern Shuffle
Shuffle is a rhythmic feature, that gives the music a more or less pronounced swing feel. It works by delaying all six-
teenth notes that fall in between the eighth notes. You can activate or deactivate shuffle individually for each Redrum 
pattern by clicking the Shuffle button on the device panel.

The amount of shuffle is set globally with the Global Shuffle control in the ReGroove Mixer - see “The ReGroove 
Mixer”.

Flam

A flam is when you double-strike a drum, to create a rhythmic or dynamic effect. Applying flam to a step entry will add 
a second “hit” to a drum sound. The flam amount knob determines the delay between the two hits.

To add a flam drum note, proceed as follows:
1. Activate flam by clicking the Flam button.

2. Click on a step to add a note (taking the Dynamic setting into account as usual).
A red LED is lit above the step to indicate that flam will be applied to that step.

3. Use the Flam knob to set the desired amount of flam.
The flam amount is global for all patterns in the device.

D To add or remove flam to or from an existing step note, click directly on the corresponding flam LED.
You can also click and drag on the LEDs to add or remove several flam steps quickly.

D Applying flam to several consecutive step entries is a quick way to produce drum rolls.
By adjusting the Flam knob you can create 1/32 notes even if the step resolution is 1/16, for example.
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The Pattern Enable switch

If you deactivate the “Pattern” button the pattern playback will be muted, starting at the next downbeat (exactly as if 
you had selected an empty (silent) pattern). For example, this can be used for bringing different pattern devices in 
and out of the mix during playback.

q You can also mute Redrum devices in the sequencer using the Mute button for the track connected to the Re-
drum. If you do so, this will mute the Redrum output instantly, and the Mute indicator on the Redrum panel 
lights up. Note that all tracks connected to this Redrum device must be muted for this to work.

The Mute indicator

The Enable Pattern Section switch

If this is off, Redrum will function as a pure “sound module”, i.e. the internal Pattern sequencer is disengaged. Use this 
mode if you wish to control Redrum exclusively from the main sequencer or via MIDI (see “Using Redrum as a sound 
module”).



REDRUM DRUM COMPUTER610

Pattern functions
When a Redrum device is selected, you will find some specific pattern functions on the Edit menu (and on the device 
context menu):

Chaining patterns
When you have created several patterns that belong together, you most probably want to make these play back in a 
certain order. This is done by recording or inserting pattern changes into the main sequencer. See “Recording pattern 
automation”.

| Function | Description

Shift Pattern Left/Right These functions move all notes in the pattern one step to the left or right.

Shift Drum Left/Right The Shift Drum functions move all notes for the selected drum channel (the channel for 
which the Select button is lit) one step to the left or right. 

Randomize Pattern Creates a random pattern. Random patterns can be great starting points and help you get 
new ideas.

Randomize Drum Creates a random pattern for the selected drum sound only - the notes for the other 
drum sound channels are unaffected.

Alter Pattern The Alter Pattern function modifies the selected pattern by “shuffling” the current pattern 
notes and redistributing them among the drum sounds at random. This creates a less 
chaotic pattern than the “Randomize Pattern” function.
Note that there must be something in the pattern for the function to work on - using an 
Alter function on an empty pattern will not do anything.

Alter Drum Works like the “Alter Pattern” function, but affects the selected drum sound only.
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Converting Pattern data to notes in the main sequencer
You can convert Redrum Patterns to notes in the main sequencer. This allows you to edit the notes freely, create vari-
ations or use Groove quantizing.

The “Copy Pattern to Track” function

This function useful when you have created a single pattern in the Redrum device and want to render individual note 
events on the sequencer track. You could also use this if you e.g. have created a drum pattern and want to have the 
pattern play back some other type of device.

Proceed as follows:
1. Set the Left and Right Locators to encompass the section you want to “fill” with the notes in the pattern.

You may want to make sure that the space between the locators is a multiple of the pattern length, to avoid “cut-
ting off” the pattern.

2. Select the device in the rack and select “Copy Pattern to Track” from the Edit menu or the device context menu.
The pattern is converted to a single note clip on the track (see the notes below). If the space between the locators 
is greater than the pattern length, the pattern will be repeated in the clip to fill up the space.

An internal Redrum drum pattern converted to note events on the track

When you use the “Copy Pattern to Track” function with the Redrum, you should note the following:

• The notes will have the pitch of the corresponding drum sound (see “Using Redrum as a sound module”) and 
the velocity depending on the “Dynamic” parameter value in the device.
“Soft” notes get velocity 30, “Medium” notes get velocity 80 and “Hard” notes get velocity 127.

• You probably want to turn off the “Enable Pattern Section” switch on the Redrum device panel.
Otherwise, the drum sounds will be double-triggered during playback (by the pattern section itself, and by the ren-
dered notes on the sequencer track).

The “Convert Pattern Automation to Notes” function

If you have recorded or drawn pattern changes on a Redrum track, you can have the whole track converted to notes, 
in the following way:
1. Select the track with the pattern automation.

2. Select “Convert Pattern Automation to Notes” from the Edit menu or the context menu for the track.
For each pattern clip, the corresponding pattern is converted to note clips on the track (following the same rules as 
for the “Copy Pattern to Track” function). The track will play back just the same as when you played the pattern de-
vice with the pattern changes.

D After the operation, the Pattern Select lane is switched off.
The “Enable Pattern Section” button on the device is automatically turned off.
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Redrum parameters

Drum sound settings
Redrum features ten drum sound channels that can each be loaded with a Wave or AIFF sample or a sample from a 
SoundFont bank. Although they are basically similar, there are three “types” of drum sound channels, with slightly dif-
ferent features. This makes some channels more suitable for certain types of drum sounds, but you are of course free 
to configure your drum kits as you like.

On the following pages, all parameters will be listed. If a parameter is available for certain drum sound channels only, 
this will be stated.

Mute & Solo

At the top of each drum sound channel, you will find a Mute (M) and a Solo (S) button. Muting a channel silences its 
output, while Soloing a channel mutes all other channels. Several channels can be muted or soloed at the same time.

You can also use keys on your MIDI keyboard to mute or solo individual drum sounds in real time. 

D The keys C2 to E3 (white keys only) will mute individual drum channels starting with channel 1.
The sounds are muted for as long as you hold the key(s) down.

D The keys C4 to E5 (white keys only) will solo individual drum channel, starting with channel 1.
The sounds are soloed for as long as you hold the key(s) down.

This is a great way to bring drum sounds in and out of the mix when playing Reason Essentials live. You can also re-
cord the drum channel Mutes in the main sequencer, just like any other controller (see “Recording parameter auto-
mation”).

The Effect Sends (S1 & S2)

On the back panel of Redrum you will note two audio connections labeled “Send Out” 1 and 2. When you create a 
Redrum device, these will by default be auto-routed to the first two “Chaining Aux” inputs on the Mixer device (pro-
vided that these inputs aren’t already in use).

C2 C3 C4 C5

1 2 3 4 5 6 7 8 9 10 1 2 3 4 5 6 7 8 9 10

Mute Solo
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This feature allows you to add effects to independent drum sounds in the Redrum.

D Raising the S1 knob for a drum sound channel will send the sound to the first send effect connected to the 
mixer.
Similarly, the S2 knob governs the send level to the second send effect in the mixer.

D Note that there must be send effects connected to the AUX Sends and Returns in the mixer for this to work.

D Also note that if Redrum is soloed in the Mixer the effect sends will be muted.

D Another way to add independent effects to drum sounds is to use the independent drum outputs.
See “Connections”.

Pan

Sets the Pan (stereo position) for the channel.

D If the LED above the Pan control is lit, the sound uses a stereo sample.
In that case, the Pan control serves as a stereo balance control.

Level and Velocity

The Level knob sets the volume for the channel. However, the volume can also be affected by velocity (as set with the 
Dynamic value, or as played via MIDI). How much the volume should be affected by velocity is set with the “Vel” knob.

D If the Vel knob is set to a positive value, the volume will become louder with increasing velocity values.
The higher the Vel value, the larger the difference in volume between low and high velocity values.

D A negative value inverts this relationship, so that the volume decreases with higher velocity values.

D If the Vel knob is set to zero (middle position), the sound will play at a constant volume, regardless of the ve-
locity.
When Vel is set to zero, the LED above the knob goes dark.

Length and the Decay/Gate switch

The Length knob determines the length of the drum sound, but the result depends on the setting of the Decay/Gate 
switch:

D In Decay mode (switch down), the sound will decay (gradually fade out) after being triggered. The decay time is 
determined by the Length setting.
In this mode, it doesn’t matter for how long a drum note is held (if played back from the main sequencer or via 
MIDI) - the sound will play the same length for short notes as for long notes. This is the traditional “drum machine” 
mode.
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D In Gate mode (switch up), the sound will play for the set Length, and then be cut off.
Furthermore, if a sound set to Gate mode is played from the main sequencer, from a CV/Gate device or via MIDI, 
the sound will be cut off when the note ends or after the set Length, depending on which comes first. Or in other 
words, the sound plays for as long as you hold the note, but the Length setting serves as the maximum length for 
the sound.
There are several uses for the Gate mode:

• For “gated” drum sounds, when the tail of the sound is abruptly cut off as an effect.

• For when you want to use very short sounds, and don’t want them to “lose power” by being faded out.

• For when you play the Redrum from the sequencer or via MIDI, with sounds for which the length is important 
(e.g. when using the Redrum as a sound effects module).

! Audio samples sometimes contain a “loop”, which is set by editing the audio in a sample editor. This loop re-
peats a part of the sample to produce sustain as long as you hold down a note. Drum samples usually don’t 
contain loops, but who is to say that Redrum should only play drum samples? 
Note that if a sample contains a loop, and Length is set to maximum, the sound will have infinite sustain, in 
other words it will never become silent, even if you stop playback. Decreasing the Length setting solves this 
problem. 

Pitch

Sets the pitch of the sound. The range is +/- 1 octave.

D When the pitch is set to any other value than 0, the LED above the knob lights up to indicate that the sample 
isn’t played back at its original pitch.

Pitch Bend

By setting the Bend knob to a positive or negative value, you specify the start pitch of the sound (relative to the Pitch 
setting). The pitch of the sound will then be bent to the main Pitch value. Thus, selecting a positive Bend value will 
cause the pitch to start higher and bend down to the original Pitch, and vice versa.

D The Rate knob determines the bend time - the higher the value, the slower the bend.

D The Vel knob determines how the Bend amount should be affected by velocity.
With a positive Vel value, higher velocity results in wider pitch bends.

D The Bend and Vel knobs have LEDs that light up when the functions are activated (i.e. when a value other than 
zero is selected).

! Pitch bend is available for drum sound channels 6 and 7 only.
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Tone

The Tone knob determines the brightness of the drum sound. Raising this parameter results in a brighter sound. The 
Vel knob determines whether the sound should become brighter (positive Vel value) or darker (negative Vel value) 
with higher velocity.

D The Tone and Vel knobs have LEDs that light up when the functions are activated (i.e. when a value other than 
zero is selected).

! The Tone controls are available for drum sound channels 1, 2 and 10 only.

Sample Start

The Start parameter allows you to adjust the start point of the sample. The higher the Start value, the further the start 
point is moved “into” the sample. If you set the Start Velocity knob to a positive amount, the sample start point is 
moved forward with higher velocities. A negative Start Velocity amount inverts this relationship.

D When Start Velocity is set to any other value than zero, the LED above the knob lights up.

D A negative Start Velocity amount is only useful if you have set the Start parameter to a value higher than 0.
By raising the Start value a bit and setting Start Velocity to a negative value, you can create rather realistic velocity 
control over some drum sounds. This is because the very first transients in the drum sound will only be heard when 
you play hard notes.

! The Sample Start settings are available for drum sound channels 3-5, 8 and 9.

Global settings

Channel 8 & 9 Exclusive

If this button is activated, the sounds loaded into drum channels 8 and 9 will be exclusive. In other words, if a sound 
is played in channel 8 it will be silenced the moment a sound is triggered in channel 9, and vice versa. 

The most obvious application for this feature is to “cut off” an open hi-hat with a closed hi-hat, just like a real one 
does.
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High Quality Interpolation

When this is activated, the sample playback is calculated using a more advanced interpolation algorithm. This results 
in better audio quality, especially for drum samples with a lot of high frequency content.

D High Quality Interpolation uses more computer power - if you don’t need it, it’s a good idea to turn it off!
Listen to the drum sounds in a context and determine whether you think this setting makes any difference.

Master Level

The Master Level knob in the top left corner of the device panel governs the overall volume from Redrum.

Using Redrum as a sound module
The drum sounds in Redrum can be played via MIDI notes. Each drum sound is triggered by a specific note number, 
starting at C1 (MIDI note number 36):

This allows you to play Redrum live from a MIDI keyboard or a MIDI percussion controller, or to record or draw drum 
notes in the main sequencer. If you like, you can combine pattern playback with additional drum notes, such as fills 
and variations. However:

! If you want to use Redrum purely as a sound module (i.e. without pattern playback) you should make sure that 
the “Enable Pattern Section” button is deactivated (see “The Enable Pattern Section switch”), otherwise the 
Redrum pattern sequencer will start as soon as you start the main sequencer.

C1 C2

1

2

3

4

5 6

7

8

9

10
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Connections

On the back of the Redrum you will find the following connections:

For each drum sound channel:

Other

| Connection | Description

Audio Outputs There are individual audio outputs for each drum sound channel, allowing you to route a drum sound to 
a separate channel in the mixer, possibly via insert effects, etc. 
For mono sounds, use the “Left (Mono)” output (and pan the sound using the Pan control in the mixer).
When you use an individual output for a sound, the sound is automatically excluded from the master 
stereo output.

Gate Out This sends out a gate signal when the drum sound is played (from a pattern, via MIDI or by using the 
Trigger button on the device panel). This lets you use the Redrum as a “trig sequencer”, controlling 
other devices.
The length of the gate signal depends on the Decay/Gate setting for the sound: In Decay mode, a 
short “trig pulse” is sent out, while in Gate mode, the gate signal will have the same length as the drum 
note.

Gate In Allows you to trigger the sound from another CV/Gate device. All settings apply, just as when playing 
the drum sound conventionally.

Pitch CV In Lets you control the pitch of the drum sound from another CV device.

| Connection | Description

Send Out 1-2 Outputs for the send signals controlled with the S1 and S2 knobs.

Stereo Out This is the master stereo output, outputting a mix of all drum sounds (except those for which you use 
individual outputs).
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The MClass effects
The MClass effects package consists of four effect devices, which are available as separate devices from the Create 
menu and from the Devices tab in the Tool Window. There are also a number of Mastering Combi patches available 
in the Effects folder in the Reason Essentials Factory Sound Bank. These mastering patches consist of all four 
MClass device types, patched together and organized as Combinator patches. The Mastering Combis are perfect to 
use as Master Insert FX in the Main Mixer to process the final mix. The individual MClass effects are as follows:

• The MClass Equalizer - this has low and high shelving bands, two fully parametric bands and a low cut “anti-
rumble” switch. See “The MClass Equalizer”.

• The MClass Stereo Imager - this can be used to control the stereo width for the high and low frequency ranges 
separately. See “The MClass Stereo Imager”.

• The MClass Compressor - this single band compressor features sidechain input and program-adaptive release. 
See “The MClass Compressor”.

• The MClass Maximizer is a special limiter tailored for loudness maximizing without risk of clipping. See “The 
MClass Maximizer”.

Common effect device parameters

While the specific parameters for the MClass effect devices are described below, some features and procedures are 
common to all effect devices. Please, refer to “Common effect device features” for information about the Input meter, 
the Bypass/On/Off switch and Signal Flow Graphs on the effect devices.
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The MClass Equalizer

The MClass Equalizer consists of two independent, fully parametric bands plus high and low shelving bands and a lo 
cut switch. 

This is most often used as an insert effect, in mono or stereo.

Activating the separate EQ bands

The separate bands are organized as vertical strips on the panel, in the following order (from left to right): Lo Cut/Lo 
Shelf/Parametric 1/Parametric 2/Hi Shelf. 

You activate the separate bands by clicking the button at the top of each strip (none of the bands are activated by de-
fault).

Lo Cut 

The Lo Cut switch will simply cut frequencies below 30 Hz (by 12 dB/Octave). This is useful for removing low fre-
quency “rumble”.

q When you are using the MClass Equalizer with a compressor or Maximizer, activating the Lo Cut switch pre-
vents subsonic sound from “topping” the compressor/limiter, and allows them to operate as efficiently as pos-
sible.

Parametric 1-2 parameters

A parametric equalizer will boost or cut frequencies around the selected frequency. The following parameters are 
available for both the parametric bands:

| Parameter | Description

Frequency This determines the center frequency of the EQ, i.e. at which frequency the level should be de-
creased or increased. The range is 39 Hz to 20 kHz.

Gain Specifies how much the level of the selected frequency range should be boosted or cut. The gain 
range is ±18 dB.

Q This governs the width of the affected area around the set center frequency. The higher the value, 
the narrower the affected frequency range.
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Lo/Hi Shelf parameters

A shelving equalizer will boost or cut frequencies below or above the selected frequency.

The following parameters are available for the Lo/Hi Shelf bands:

About the graphic display

The graphic display to the left in the device panel shows the frequency response curve as set by the EQ parameters. 
This gives a visual feedback and helps you tailor the EQ settings.

The MClass Stereo Imager

The MClass Stereo Imager splits the signal into two frequency bands; “Hi” and “Lo” and allows you to widen or narrow 
the stereo image of each band. A typical application of the Stereo Imager is to widen the higher frequencies and nar-
row the lower frequencies. This will make the bass end “tight” whilst “opening up” the higher frequencies.

This is most often used as an insert effect in stereo. 

! The MClass Stereo Imager does not create stereo from mono input! For the device to work properly it must 
connected with stereo in/out, and the input signal must contain a stereo audio signal.

Parameters

The following parameters are available:

| Parameter | Description

Frequency Frequencies below (Lo Shelf) or above (Hi Shelf) the selected frequency will be boosted or cut.
• The Lo Shelf range is 30 Hz to 600 Hz.
• The Hi Shelf range is 3 kHz to 12 kHz.

Gain Specifies how much the level should be boosted or cut. The gain range is ±18 dB.

Q This governs the slope of the shelving curve. The higher the value, the steeper the curve slope. High 
Q settings will also produce a “bump” in the opposite cut/boost direction at the set frequency. 

| Parameter | Description

X-Over 
Frequency

This determines the crossover frequency between the Hi and Lo band. Range is 100 Hz - 6 kHz. Frequen-
cies below this will be affected by the Lo Width setting; frequencies above will be affected by the Hi Width 
setting.

Lo Width This adjusts the stereo width for the Lo band. Turn anti-clockwise to narrow the stereo width (i.e. to make 
it more “mono”), and clockwise to widen the stereo image. Center position means no change from original 
signal. The “Active” LED indicates whether Low Width is activated or not. Note that for the Lo band, it is 
more common to narrow the stereo image, as the low frequency content in a mix is usually mixed center 
and can become less defined if widened.

Hi Width This adjusts the stereo width for the Hi band. Turn anti-clockwise to narrow the stereo width (i.e. to make 
it more “mono”), and clockwise to widen the stereo image. Center position means no change from original 
signal. The “Active” LED indicates whether Hi Width is activated or not.

Solo switch This allows you to listen to the Lo and Hi bands separately, for reference purposes. “Normal” is the stan-
dard operating mode.
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Connections

Apart from standard L/R inputs and outputs, there are also “Separate” L/R outputs on the back panel. The Separate 
outputs can either carry the Lo or Hi band output, which is set by the switch beside the outputs. These outputs can 
be used to apply processing separately to either the Lo or Hi band.

q If you set the Solo switch to “Lo” and the Separate output switch to “Hi”, the device will operate as a basic 
crossover filter, delivering the Lo band signal from the main output and the Hi band signal from the Separate 
out.

The MClass Compressor

This is a single-band compressor capable of everything from subtle compression to aggressive pumping effects. Like 
all dynamics processors it is best used as an insert effect. 

The features include “soft-knee” compression for more musical and unobtrusive compression, program-adaptive re-
lease time and a sidechain input for de-essing and other dynamics processing. Additionally, you have a CV output, al-
lowing you to have the amount of gain reduction control other Reason Essentials parameters.

Parameters:

| Parameter | Description

Input Gain The Input Gain controls the ”drive” of the compression. This determines how much compression the signal will have in 
conjunction with the Threshold. Range: ±12 dB.

Threshold This sets the level at which onset of compression occurs. When the input level is below the Threshold setting the sig-
nal is unaffected. When the input level exceeds the threshold, compression kicks in. 
In practice, this means that the lower the Threshold setting (and the higher the Input Gain), the more compression will 
be applied. Range: -36 dB to 0 dB

Soft Knee Normally signals above the threshold will be compressed immediately at whatever ratio is set. This can be very notice-
able, especially when using high compression ratios. When Soft Knee is activated, the onset of compression will be 
more gradual, producing a less drastic result.

Ratio This lets you specify the amount of gain reduction applied to the signals above the set threshold. The Ratio can be set 
from 1:1 (no reduction) to ∞:1 (Infinite).

Gain meter This shows the amount of gain reduction (in dB).

Solo Sidechain This allows you to monitor the signal connected to the sidechain input (see below).

Attack This governs how quickly the compressor will apply its effect when signals rise above the set threshold. If you raise this 
value, the response will be slower, allowing more of the signal to pass through the compressor unaffected. Typically, 
this is used for preserving the attacks of the sounds. Range: 1ms to 100ms.

Release When the signal level drops below the set threshold, this determines how long it takes before the compressor lets the 
sound through unaffected. Set this to short values for intense, “pumping” compressor effects, or to longer values for a 
smoother change of the dynamics. Range: 50ms to 600ms.

Adapt 
Release

When this is used, set Release to the time you want for short peaks - when longer peaks occur, the Release time is au-
tomatically increased.

Output Gain This controls the output gain and can be used to compensate for the gain reduction caused by compression. Range: 
±12 dB.
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About the Sidechain inputs

D When a signal is connected to the Sidechain inputs, it is this signal that will trigger the compression.
This signal is not passed to the compressor output, and will thus not be heard (unless Sidechain Solo is activated). 

D The signal connected to the normal L/R inputs is the signal that will be processed by the compressor (as 
usual).

Here follows two examples of how you can use sidechain processing:

Example 1 - using the Sidechain inputs to create ducking effects

“Ducking” is when the level of one signal is reduced by the presence of another signal. A typical application is to au-
tomatically lower the level of a musical bed when a voice-over starts, and to automatically bring the level up when the 
voice-over stops. To set this up, we can name the musical bed in the example “Device A”, and the voice-over “Device 
B”. Proceed as follows:
1. Connect Device A and Device B to separate channels on a mixer device.

In this example the signal produced by Device A should be continuous, and the signal produced by Device B 
should be intermittent, i.e. it should contain both silent passages and signal passages.

2. Select Device A and then select an MClass compressor from the Create menu.
The effect will be auto-routed as an insert effect to Device A.

3. Connect a Send on the mixer device to the Sidechain inputs on the MClass compressor.
As soon as anything is connected to the Sidechain inputs, the “Active” indicator lights up on the device panel. The 
compressor will no longer react to the signal produced by Device A.

4. Turn up the corresponding AUX Send level for Device B on the mixer.
This means that the Device B signal now feeds both the mixer's input, and the sidechain input on the compressor, 
which in turn triggers the gain reduction.

5. If you now start playback of both devices, the level of Device A will be lowered whenever Device B sounds, and 
be raised again when Device B stops.
The amount of gain reduction, how quickly it lowers the level, and the time it take for the level to return to normal 
again is determined by the corresponding Gain/Threshold/Ratio and Attack/Release parameters.

Example 2 - using the Sidechain inputs to create frequency sensitive compression

By inserting an equalized signal to the sidechain inputs you can make the compression more or less sensitive to a 
certain frequency range. A typical application of this is “de-essing” - where harsh “S”-sounds in vocal material is re-
duced or eliminated. 

Frequency sensitive compression is set up as follows:
1. Hold down [Shift] and create an instrument device.

Pressing [Shift] means no auto-routing connections to/from the device are made.

2. Hold down [Shift] and create a MClass Equalizer.

3. Hold down [Shift] and create a MClass Compressor.

4. Create a Spider Audio Merger and Splitter device.

5. Connect the outputs of the instrument device to the A and B inputs on the Spider.
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6. Route one pair of the split outputs of the Spider to the MClass Equalizer inputs.

7. Route the Equalizer outputs to the Sidechain inputs on the MClass Compressor.

8. Route another pair of the split outputs of the Spider to the MClass Compressor.
Now, the compressors normal audio inputs are fed the unprocessed signal, and the sidechain inputs are fed the 
equalized signal.

9. Next, route the outputs of the Compressor to inputs on a mixer device.

10.Activate the Solo Sidechain button on the compressor’s front panel.
You will now only hear the equalized signal. 

11.Now use the parameters on the MClass Equalizer to boost the frequencies you wish should trigger the gain re-
duction and cut the frequencies you wish to avoid triggering the gain reduction.
You can use rather extreme eq settings - the signal will not be heard when Solo Sidechain is deactivated anyway. 
E.g. for de-essing you should separate and boost the offending “S” frequencies as much as possible.

12.Deactivate Solo Sidechain when you have finished tweaking the equalizer.
Now, the compressor will be more sensitive to the frequency area you tuned in with the equalizer, and thus react 
more to these frequencies. Note, however, that the whole signal will still be compressed - not just the boosted fre-
quencies - so in case of de-essing you should usually use fast Attack and Release settings so that the gain reduc-
tion does not affect the rest of the program too much.

CV Outs

On the back of the MClass Compressor you can find a “Gain Reduction” CV out connector. This can be used to mod-
ulate other parameters with the amount of gain reduction applied by the compressor. This means that the compres-
sor works as an envelope follower. You could for example have the audio signal level control pan in a mixer or a synth 
parameter.
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The MClass Maximizer

This is a loudness maximizer, a special type of limiter which can significantly raise the perceived loudness of a mix 
without risk of hard clipping distortion. Features include a 4 ms look ahead function for “brick wall” limiting and a Soft 
Clip function.

The MClass Maximizer should be used as an insert effect, and is designed to be placed at the end of the signal chain 
between the mixed final output and the Hardware Interface.

Parameters

| Parameter | Description

Input Gain The Input Gain sets the basic volume of a mix. If this is set very high, you should use Look 
Ahead mode or the Soft Clip function to eliminate the risk of hard clipping distortion. Range: 
±12 dB.

Limiter On/Off This turns the Limiter section on or off.

Look Ahead On/Off If activated, this will introduce a very short delay (4 ms) to the signal. This delay is used to de-
tect peaks in the signal before they actually occur. If high peaks are detected the limiter is 
“ready for them” and gain reduction is applied to transparently control the peaks.

Attack
(Fast/Mid/Slow)

This governs how quickly the Limiter will apply its effect. If set to Fast with Look Ahead acti-
vated (and the Output Gain is set to 0 dB) you will get “brick wall” limiting - no signal peaks 
over 0 dB will pass.

Release
(Fast/Slow/Auto)

This determines how long it takes before the Limiter lets the sound through unaffected. If 
Auto is activated, the Release time will automatically adapt to the program material.

Output Gain This controls the output gain and should normally be set to 0 dB.

Soft Clip On/Off If this is activated, it also acts a 0 dB brick wall limiter but in a slightly different way. The signal 
will be “soft-clipped” which adds a pleasant, warm sounding distortion to the signal. It can be 
used simply to get this effect, or as a safeguard against hard clipping distortion if Look Ahead 
with Mid or Slow attack settings are used (or if Look Ahead is deactivated).

Soft Clip Amount This controls the amount of soft-clipping distortion. Note that if Soft Clip is on but the 
Amount is set to zero, the distortion will be like hard clipping, and thus less pleasing to the 
ear.

Output level meter
(Peak/VU)

This is a more detailed meter than found on the mixer. You can switch the meter characteris-
tics between Peak (faster response to peaks) and VU mode (average levels).
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Introduction

The Line 6 Guitar Amp at the top and the Line 6 Bass Amp at the bottom

The Line 6 Guitar Amp and Bass Amp are amplifier and speaker cabinet simulators based on the renowned model-
ling algorithms developed by Line 6. The two devices feature accurate simulations of five of the most coveted vintage 
amplifier and cabinet models, that you can freely mix and match. Setting up a great amp tone for your guitar or bass 
is easy, regardless of what type of sound you are looking for.

In addition, if you have a Line 6 device with a USB connection (POD etc.) hooked up to your computer you can also 
use any of the Amp/Cab models in that particular device from within the Line 6 Amps - see “Additional Line 6 Amp 
Models”.

The Line 6 Guitar Amp and Bass Amp are virtually identical as they share the same Amp/Cabinet algorithms as well 
as most of the parameters. However, the preset patches for each device are geared towards processing either guitar 
or bass, respectively, and there are a few other slight parameter differences.

In this chapter the two devices will be described together using the collective name “Line 6 Amps”. Where parame-
ters differ between the two devices this will be duly noted. 

About the Amp Tones patch format
Patches (or “Amp Tones”) are saved with the file extension “.l6t”. Although they use the same file extension, Guitar 
Amp Tones and Bass Amp Tones are different patch types and a saved patch always belongs to the Amp type (Gui-
tar or Bass) it was saved with.

Loading patches is described in “Selecting Patches (Amp Tones)”. Saving patches is done in the same way as for 
other effect devices - see “Saving patches”.

! The Line 6 Amp devices in Reason Essentials will always save Tones in the Pod Farm 2 format. These Tones 
cannot be opened for editing in Pod Farm 1 - you need to use Pod Farm 2 or later.

Basic usage
The Line 6 Amps can be used to process any signal but are best used “live”, i.e. as insert effects on the Audio Track 
Channel that a live instrument is connected to, so that you can monitor the effect as you play and record.

When recording electric guitar or bass, the basic tonal character of the amp/cabinet very much affects how the in-
strument responds, which in turn affects your playing. The Line 6 Amps allow you to set up a good basic tone with a 
minimum of fuss so you can start recording straight away!
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Using a “real” amp requires that you set up the amp tone exactly right prior to recording, as you have very limited 
means of changing it afterwards. But as Insert FX are transparent in Reason Essentials (i.e. they are not a part of the 
recorded signal) you can tweak the tone, change Amp model etc., as much as you like after recording, right up to the 
creation of the final mixdown audio file (or Mixer Channel bouncing).

Important note about using the Line 6 amps as insert effects

• To use a Line 6 Amp as an insert fx when you're recording an audio track, you need to monitor through Reason 
Essentials (see “Monitoring”) - otherwise you won't hear the sound of the Line 6 Amp during recording.
For this to feel comfortable you will want as low latency as possible (see “Buffer Size settings”). With good audio 
hardware and drivers, you can usually get down to a latency of a few milliseconds, which is about the same delay 
you'd get standing a meter from a real guitar amplifier.

Front panel
The Line 6 Amps front panel can be divided into two main sections; the display area with Patch/Amp/Cabinet selec-
tors and a set of standard amplifier tone controls to the right. The Amp parameters (tone controls) are described in 
“Amp Parameters”.

In addition, the Guitar Amp has Pedal controls for Volume and Wah (see “Pedal controls (Guitar Amp only)”), and the 
Bass Amp features a compressor (see “Compressor (Bass Amp only)”).

Common effect device parameters

While the specific parameters for the Line 6 Amps are described later in this chapter, some features and procedures 
are common to all effect devices. Please, refer to “Common effect device features” for information about the Input 
meter, the Bypass/On/Off switch and Signal Flow Graphs on the Line 6 Amps.
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Using the Line 6 Amps

Selecting Patches (Amp Tones)
Amp Tones contain all panel settings as saved. There are many available Amp Tones in the Sound Bank Effects 
folder, divided into Guitar Amp Tone and Bass Amp Tone categories. As mentioned previously, these are different 
patch types and are not compatible.

D To load an Amp Tone, click on the Browse Patch button to open the Patch Browser.

In the Patch Browser you can preview available Amp Tones before loading them.

D You can also click on the patch name in the Amp display and select Amp Tones in the currently used folder di-
rectly from the list.

Alternatively, select “Open Browser” and choose Amp Tone using the Patch Browser. In the Patch Browser you 
can preview available Amp Tones before loading them.

D You can also click the Up/Down arrow buttons to the right of the Amp Tone name to step through the currently 
used folder and select a new Amp Tone.

q Line 6 software such as POD Farm comes with a huge number of Tones, by default installed in the Documents 
folder of your user account. The majority of these Tones can be loaded in Reason Essentials' Line 6 Amp de-
vices! If a loaded Tone refers to an Amp or effect model that you don't have access to, it will be substituted - 
see “About “Missing Models” and the “Replace” function”."
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Selecting Amp and Cabinet model
There are five basic Amp models to choose from; three Guitar Amp models and two Bass Amp models. Each Amp 
model has an associated “matching” Cabinet model, although this relationship is not fixed - you can use any amp with 
any cabinet. For general model descriptions see “About the Amp/Cabinet models”.

Selecting Amp model

D To switch Amp model, click in the middle row of the display and select a model from either the Guitar Amp or 
Bass Amp model sub-menus.

D You can also use the Amp selector buttons to the right of the display to step through all the available Amp 
models.

When you change Amp model the following applies:

• Changing Amp model also automatically changes the Cabinet to the default model for the selected Amp.
You can however freely change Cabinet model for any selected Amp - see below.

• Amp parameter settings are also reset to their default settings for the selected Amp.
Changing the Amp model alters the tone drastically so the Amp parameters will usually have to be tweaked as 
Amp parameter settings for one Amp model are not necessarily suitable for a different model. The default Amp pa-
rameter settings are optimized for each Amp model.

• In case you have made unsaved changes to any Amp parameters and then change the Amp model these pa-
rameters remain unchanged.
This protects you from accidentally losing any unsaved parameter settings when changing Amp model. Alterna-
tively, if you want to keep parameter settings static when switching between Amp models you can simply manually 
set these parameters without saving them first. Note that if “No Amp” is selected all Amp parameters are reset to 
default values. 

• Any automated Amp parameters will remain automated (i.e. unchanged) when switching Amp model.

Selecting Cabinet model

You can use any Cabinet with any selected Amp model.

D To switch Cabinet model, click in the bottom row of the display and select a model from either the Guitar or 
Bass Cabinet model folders.

D You can also use the Cabinet selector buttons to the right to step through all the available models.
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About the Amp/Cabinet models
The Amp models are listed together with the default Cabinet models but remember that amps & cabs can be com-
bined in any configuration. And don’t feel bound by the Guitar/Bass categories - e.g. try a guitar amp with a bass cab-
inet for a bass, or use any other mix of Amp/Cab/instrument you like!

The following Amp and Cabinet models are available:

Amp Parameters
The Amp parameters are used to tweak the selected amp tone. The following controls are found in this section:

Additional parameters

Pedal controls (Guitar Amp only)

Wah and Volume are pedal control parameters. The “Wah” (a resonant filter), and “Volume” (or swell) parameters are 
used to change tone and volume, respectively. Any suitable Remote control surface (e.g. a MIDI pedal) can be used 
to record pedal expression live if you so wish. There are also CV control inputs for these parameters.

D Activate both the Volume and Wah controls by clicking the “On” button.

| Amp Model | Description | Cabinet

1964 Blackface ‘Lux
(Guitar Amp)

This versatile amp can generate warm, clean tones with a subtle 
crunch which makes it perfect for a variety of styles ranging from 
rootsy blues to sparkly pop.

1x12 1964 Blackface ‘Lux/
Single speaker combo cabinet.

1968 Plexi Lead 100
(Guitar Amp)

Based on one of the best amps ever produced. The signum sound is 
rich crunch with excellent dynamic response. if you’re looking for 
classic rock tone, look no further. 

4x12 1968 Green 25s/
4x12 cabinet with classic speakers.

2001 Treadplate Dual
(Guitar Amp)

This is a high gain amp with a cutting tone. From clean to meltdown, 
this amp delivers.

4x12 2001 Treadplate/
Modern style 4x12 cabinet.

1974 Rock Classic
(Bass Amp)

300 Watt powerhouse amp with awesome punch and big sound. The 
amp of choice for many rock bassists.

8x10 Classic/
Big cabinet with rock solid bass.

1968 Flip Top
(Bass Amp)

This relatively small (25 Watts) amp is based on one the world’s most 
popular studio amps. 

1x15 Flip Top/
Closed back cabinet design with a single 15” 
speaker. Great, tight bass tone.

| Parameter | Description

Drive control This controls the input gain. The higher the Drive value, the more crunch you get.

Bass/Middle/Treble controls 
(Guitar Amp)
Bass/Lo Mid/Hi Mid/Treble controls 
(Bass Amp)

These are tone controls which you can use to cut or boost the bass, midrange and high frequencies, 
respectively. 
The Bass Amp has both Lo and Hi Mid controls which give you more control over the important mid-
range frequencies.

Presence control (Guitar Amp only) Presence usually provides a boost of high frequencies, helping the sound cut through the mix. 

Volume Controls the master volume of the Amp.



LINE 6 AMPS 633

Compressor (Bass Amp only)

This is a fixed ratio compressor optimized to “tighten up” the bass sound, i.e. to even out levels and increase punch 
and sustain. The Threshold control sets the level at which the onset of compression occurs. In practice, this means 
that the lower the Threshold setting, the more compression will be applied.

D Activate the Compressor by clicking the “On” button.

Additional Line 6 Amp Models
If you have a Line 6 USB hardware device connected to your computer, you can access all the Amp and Cabinet 
model in this device from within the Line 6 Guitar/Bass Amp in Reason Essentials. The additional amp/cab models 
will be listed together with the standard models and are selected and tweaked in the same way!

For the additional amp models to be available in Reason Essentials, two conditions must be met:

• If it's the first time you use the Line 6 hardware with the computer, you need to authorize the computer.
Run the Line 6 Monkey application and follow the instructions. The Line 6 Monkey application can be downloaded 
from http://www.line6.com.

• The Line 6 hardware must have a “Propellerhead” software option installed.
New hardware comes with this option pre-installed - if not, just run the Line 6 Monkey application and follow in-
structions.

! if you are using an iLok key containing a license for POD Farm or POD Farm Platinum, all the licensed amp 
models will automatically be available in Reason Essentials - you don't have to perform any additional down-
loads or authorizations.

You can also use Amp Tones created with other Line 6 devices (including effect models) in the Line 6 Amps. In the 
case of effects these will be heard but you will not be able to change parameter settings in Reason Essentials. You 
can, however, use software such as Line 6 POD Farm to change settings and then save it as an Amp Tone which can 
be used in the Line 6 Amps.

Line 6 hardware also feature various Preamp models which can be selected as Amp models in the Line 6 Amps. You 
may not have access to all parameters in Reason Essentials as these models have different Amp Parameters, but you 
can use the Line 6 POD Farm to make settings in the same way as with effects.

• The Line 6 Amp devices in Reason Essentials load Tones of the Pod Farm 1 or Pod Farm 2 format.

• The Line 6 Amp devices in Reason Essentials will always save Tones in the Pod Farm 2 format. These Tones 
cannot be opened for editing in Pod Farm 1 - you need to use Pod Farm 2 or later.
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About “Missing Models” and the “Replace” function

If you’re opening a patch or a Song where additional Line 6 Amp Models are used, and you don’t have any Line 6 
hardware connected to your computer - or if you have Line 6 hardware connected, but the Patch or Song uses mod-
els from an optional Model Pack that haven't been installed in your hardware - the “Missing Line 6 Models” alert is 
shown:

D Click “OK” to open the Song with the additional Amp Model temporarily replaced by a default Amp Model.
The Song opens with default Line 6 Amp Models instead. On the Line 6 Amp device(s), the “Missing Models” indi-
cator is lit to indicate that you’re currently using a replacement Amp Model. 

As long as you don't change the model selection or click the “Replace” button (see below), you can go on working 
with the song and save it as usual. The information about the missing models is retained - if you later open the 
song with the right Line 6 hardware connected, the correct models will be used again.

If you want to permanently replace the missing Amp Model with the default model, you can easily do that.

D Click the “Replace” button to permanently replace the missing Amp Model with the currently used default one.
The “Missing Models” indicator goes off and the Amp Model has been permanently replaced by the default model.

Connections

• Both Line 6 Amps have Left/Right inputs and outputs.

• The Line 6 Guitar Amp also has CV inputs for controlling the Pedal parameters (Volume and Wah).

q For rhythmic auto-wah effects, try connecting the LFO CV output on a Subtractor to the Wah CV input on the 
Line6 Guitar Amp!
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The RV7000 Advanced Reverb

The RV7000 is a high quality reverb processor. It features nine different reverb and echo algorithms, ranging from 
rooms and halls to special effects. Since the RV7000 comes with a number of useful reverb presets, you could simply 
select one and tweak the most important parameters on the main panel - or you could use the Remote Programmer 
panel to fine-tune the reverb in great detail.

The RV7000 also contains an equalizer and a gate section. Both of these are for processing the actual reverb sound, 
making it possible to get virtually any kind of reverb character, including gated reverb.

About the Patch format

Like the Scream 4 device, the RV7000 features programmable effect presets. In the Factory Sound Bank you will 
find a number of preset Patches which can be used as they are or provide you with a good starting point for further 
tweaking.

Patches use the Windows file extension “*.RV7”. Loading and saving Patches is done in the same way as for instru-
ment devices.

Connections

Typically you connect the RV7000 as a send effect, as this allows you to use it for processing several different mixer 
channels. However, it’s also possible to use it as an insert effect - use the Dry/Wet control on the main panel to ad-
just the balance between the dry, unprocessed sound and the reverb. Note:

D The RV7000 is a true stereo reverb, which means that it will use the stereo input information when processing 
both channels (without summing the input channels).
It’s also possible to use it as a mono in - stereo out effect. Which type of connection to use (mono or stereo in) de-
pends on the material. If the audio sources are in mono (or in stereo but with no important difference between the 
left and right channel) using a mono input is sufficient.

D If you want to use RV7000’s Reverse reverb effect, you should consider connecting it as an insert effect or us-
ing a Send on the Mixer, with Pre-fader mode selected (and the channel fader lowered).
This is because you typically don’t want to hear the dry sound when using the Reverse effect. See “The Gate sec-
tion”.

The main panel

The RV7000 main panel.

When you create an RV7000, only the main panel will be shown. This contains a section for handling patches, on/off 
buttons for the EQ and Gate sections, the most important reverb parameters and a dry/wet mix control. To select a 
reverb patch and make coarse adjustments, this is all you need.
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The remote programmer

Clicking the arrow button next to the “cable slot” on the main panel brings up the remote programmer panel.

This is where you make detailed settings for the reverb. Note:

• The Edit Mode button to the left determines which section to make settings for, Reverb, EQ or Gate.

• Settings are made with the eight dials around the graphic display. The functions of the dials differ depending 
on the selected Edit Mode and the selected reverb algorithm. Next to each dial, the display shows the name 
and value of the corresponding parameter.

• Not all modes and algorithms use all eight dials. If a dial isn’t used in the selected mode, nothing will be shown 
next to it in the display.

• You cannot make settings in the graphic display itself - this is for showing a graphic representation of the se-
lected reverb.
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Reverb algorithms and parameters

Common effect device parameters

While the specific parameters for the RV7000 effect device are described below, some features and procedures are 
common to all effect devices. Please, refer to “Common effect device features” for information about the Input meter, 
the Bypass/On/Off switch and Signal Flow Graphs on the effect device.

About the main panel parameters

On the main panel you find three parameters that are available for all algorithms:

Selecting an algorithm

You select a reverb algorithm in the remote programmer panel:
1. Click the remote programmer arrow button on the main panel to display the remote programmer panel.

2. Make sure the Edit Mode button is set to Reverb.

3. Use the top left dial to select a reverb algorithm.
The selected algorithm is shown in the display next to the dial.

| Parameter | Description

Decay This governs the length of the reverb or the feedback if an echo algorithm is selected.

HF Damp Controls how quickly the high frequencies should decay in the reverb. Raise it to gradually remove high 
frequencies, making the reverb sound warmer and less bright.

HI EQ This is a high-shelving EQ that works much like a typical treble control on a mixer or amplifier. Lower the 
setting for a softer reverb sound or raise it to get more high frequencies.
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Here’s a quick overview of the nine algorithms - for details and parameter descriptions, see below.

Small Space

This algorithm places the sound in a small enclosed space, ranging from a tiny resonant body to a room. The param-
eters are:

Room

Emulates a medium-sized room, with the following parameters:

| Algorithm | Description

Small Space Emulates a small enclosed space (a small room or a resonant body).

Room Emulates a room with adjustable shape and wall character.

Hall Emulates a hall.

Arena Emulates a large arena, with separate pre-delay for the left, right and center reverbs.

Plate Emulates a classic plate reverb.

Spring Emulates a spring reverb, as used in e.g. guitar amplifiers.

Echo An echo effect with gradually diffusing echo repeats. Can be synced to Reason Essentials’s tempo.

Multi Tap A multi-tap delay with four different delay lines and tempo sync.

Reverse A reverse reverb that “pushes” the dry sound to appear after the reverb. The result is a backwards reverb 
leading up to the direct sound.

| Parameter | Description

Size The size of the emulated space.

Mod Rate The reverb can be randomly modulated for a more even sound (or for special effects). This parameter 
sets the rate of modulation (the amount is set with Mod Amount).

Room Shape Select from four different room shapes, affecting the character of the reverb.

LF Damp Controls how quickly the low frequencies should decay in the reverb. Raise it to gradually remove low 
frequencies, making the reverb sound “thinner” and less boomy.

Wall Irreg Adjusts the positioning of the emulated walls in the small space. The lowest setting emulates two di-
rectly opposed walls while higher settings emulate more walls and angles, for a more complex reso-
nance.

Predelay Sets the predelay time, i.e. the delay between the source signal and the start of the reverb.

Mod Amount Sets how much the reverb will be modulated. Use fairly low settings when emulating real rooms and 
resonant bodies, and higher settings for special effects.

| Parameter | Description

Size The size of the emulated room.

Diffusion At low Diffusion settings, you will hear the individual reverb “bounces” more clearly, while higher set-
tings produce a more “smeared”, dense and even reverb.

Room Shape Select from four different room shapes, affecting the character of the reverb.

ER->Late The first “answers” in the reverb are called early reflections (ER) and are typically more pronounced 
than the actual reverb tail. This parameter sets the time between the early reflections and the reverb 
tail. This is set as a percentage - the actual delay time depends on the Size setting.

ER Level Adjusts the level of the early reflections. “0” is normal level.

Predelay Sets the predelay time, i.e. the delay between the source signal and the start of the early reflections 
and reverb.

Mod Amount Sets how much the reverb will be modulated. Moderate modulation gives a natural, less static sound.
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Hall

Emulates a hall. The parameters are the same as for the Room algorithm above (but the Hall algorithm offers larger 
Size settings).

Arena

Emulates the ambience in an arena or concert hall, with long pre-delay times (separate for left, right and center):

Plate

A classic plate reverb, excellent for vocals for example. The parameters are:

Spring

An emulation of a spring reverb as can be found in guitar amplifiers, organs, etc. The spring reverb has the following 
parameters:

| Parameter | Description

Size The size of the emulated arena or hall.

Diffusion At low Diffusion settings, you will hear the individual reverb “bounces” more clearly, while higher set-
tings produce a more “smeared”, dense and even reverb.

Left Delay The predelay time for the left side of the reverb.

Right Delay The predelay time for the right side of the reverb.

Stereo Level Adjusts the level of the left and right sides of the reverb. “0” is normal level.

Mono Delay The predelay time for the mono (center) reverb signal.

Mono Level Adjusts the level of the mono (center) reverb signal. “0” is normal level.

| Parameter | Description

LF Damp Controls how quickly the low frequencies should decay in the reverb. Raise it to gradually remove low 
frequencies, making the reverb sound “thinner” and less boomy.

Predelay Sets the predelay time, i.e. the delay between the source signal and the start of the reverb.

| Parameter | Description

Length Sets the length of the simulated spring.

Diffusion At low Diffusion settings, you will hear the individual reverb “bounces” more clearly, while higher set-
tings produce a more “smeared”, dense and even reverb.

Disp Freq When sending a signal to a real-life spring reverb, the initial transient will produce a quick, character-
istic sweeping tonal noise. This is because different frequencies in the sound are delayed by different 
amounts (a phenomenon called dispersion). This parameter controls the frequency of that sound.

LF Damp Controls how quickly the low frequencies should decay in the reverb. Raise it to gradually remove low 
frequencies, making the reverb sound “thinner” and less boomy.

Stereo (on/off) Determines whether the output of the spring reverb should be in mono or stereo.

Predelay Sets the predelay time, i.e. the delay between the source signal and the start of the early reflections 
and reverb.

Disp Amount Sets the amount of dispersion effect (see Disp Freq above).
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Echo

This is an advanced echo effect, with diffusion controls and tempo sync. When Echo is selected, the Decay control on 
the main panel controls the echo feedback (the number of echo repeats). The parameters are:

Multi Tap

The Multi Tap delay produces up to four different delays with separate delay times, panning and level. The whole set 
of four delay taps can then be repeated at a given rate. Again, the Decay control on the main panel controls the feed-
back (the number of repeats for the whole multi tap set). All delay times can be tempo synced.

Note: this algorithm is handled a bit differently since you make separate settings for each delay tap:

• The parameters to the left of the display are common for all taps.

• You use the Edit Select parameter in the top right corner to select which tap to make settings for - the three 
parameters below affect the currently selected tap.

Tap 2 selected for editing.

| Parameter | Description

Echo Time Sets the time between each echo. 
When Tempo Sync (see below) is off, the echo time is set in milliseconds (10 - 2000 ms); when 
Tempo Sync is on you set the echo time as a number of 1/16 notes or 1/8 triplet notes, in relation to 
the current song tempo.

Diffusion When this is set to 0, the echo will sound as a standard delay with clear, precise repeats. Raising the 
Diffusion setting will introduce additional echoes very close to the “main” echo repeats, causing a 
“smeared” echo sound. This will also expand the echo stereo image.

Tempo Sync Determines whether the echo time should be freely set (“off”) or synchronized to Reason Essentials’s 
tempo (“on”).

LF Damp Controls how quickly the low frequencies should decay in the echoes. Raise it to gradually remove low 
frequencies.

Spread Adjusts the spacing of the additional echoes added by the Diffusion parameter. For a very smeared 
echo (sound more like a reverb), set both Diffusion and Spread to their maximum values.

Predelay Sets an additional delay time before the first echo repeat.
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• You can also set Edit Select to “Repeat Tap” - this is where you specify the repeat time for the whole multi tap 
“package”.
With short Repeat times, the first tap may be repeated before the last tap has sounded. This can be used to create 
very complex multiple delay effects.

The common parameters (to the left) are:

When Tap 1 - 4 is selected with the Edit Select parameter, you can make the following settings for the selected delay 
tap:

When Repeat Tap is selected with the Edit Select parameter, there is only one parameter to the right in the display:

| Parameter | Description

Tempo Sync Determines whether the delay times and repeat times should be freely set (“off”) or synchronized to 
Reason Essentials’s tempo (“on”).

Diffusion Raising the Diffusion setting will introduce additional echoes very close to the “main” repeats, caus-
ing a “smeared” delay sound.

LF Damp Controls how quickly the low frequencies should decay in the echoes. Raise it to gradually remove 
low frequencies.

| Parameter | Description

Tap delay Sets the delay - the time from the source signal to the tap. 
When Tempo Sync is off, the delay time is set in milliseconds (10 - 2000 ms); when Tempo Sync 
is on you set the delay as a number of 1/16 notes or 1/8 triplet notes, in relation to the current 
song tempo.

Tap level Adjusts the level of the selected tap.

Tap pan Adjusts the pan of the selected tap.

| Parameter | Description

Repeat Time Sets the time between each repeat of the whole multi tap set. The number of repeats is set with the 
Decay control on the main panel.
When Tempo Sync is off, the repeat time is set in milliseconds (10 - 2000 ms); when Tempo Sync 
is on you set the repeat time as a number of 1/16 notes or 1/8 triplet notes, in relation to the cur-
rent song tempo.
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Reverse
The Reverse reverb algorithm in RV7000 is special in that it actually “moves” the source audio as well. Sounds fed 
into the Reverse reverb are “sampled”, a reverse reverb is created and played back and finally the “sampled” original 
sound is played back. For example, if you feed a snare drum hit into the Reverse reverb, you will hear a rising “back-
wards” reverb, followed by the snare drum hit.
Therefore, you probably don’t want to hear the first, original (dry) sound. There are two ways to set this up:

D Connect the RV7000 as an insert effect and make sure the Dry/Wet control on the main panel is set fully to 
“Wet”.

D Connect the RV7000 as a send effect using one of the Sends on the Mixer, activate the Prefader (PRE) switch 
for the send and lower the mixer fader completely for the source signal.
That way, the signal will be sent to the reverb but the dry sound from the Mixer channel isn’t heard. Again, the Dry/
Wet control should be set to “Wet”.

Note that with this algorithm, raising the Decay setting on the main panel will make the reverse reverb start earlier 
and build up under a longer time. Similarly, the HF Damp parameter affects how fast the high frequencies are built up 
in the reverse reverb. In the remote panel, the Reverse algorithm has the following parameters:

| Parameter | Description

Length This sets the time from when the source signal is fed into the reverb until it is played back again. It 
is during this time you will hear the reverse reverb, as shown in the display.
The time can be set in milliseconds or as note values, depending on whether Tempo Sync is off or 
on.
Note: As stated above, the Decay setting determines the length of the actual reverse reverb - in es-
sence how soon it starts after the source signal. But of course, the reverse reverb cannot start be-
fore the original source signal! If you set Decay to a longer time than the Length setting, the 
reverse reverb will start abruptly, immediately when the source signal is fed into the reverb. If this 
sounds complicated, just take a look at the RV7000 display and try the settings - you will soon see 
how it works.
Note also that very high Length settings demand a lot of processor power. This can be reduced by 
adjusting the Density parameter, see below.

Density Density governs the “thickness” of the Reverse effect. If this parameter is turned down to zero, the 
effect produces individual delays rather than a dense “wash”, which can be used as a special effect. 
Worth noting is that if Density is set to around 50%, this can considerably reduce the CPU load 
without altering the sound of the effect too much. Exactly how much the Density parameter can be 
reduced without altering the sound depends on the source material.

Rev Dry/Wet Sets the balance between the “moved” source signal (“dry”, low values) and the reverse reverb 
(“wet”, high values).

Tempo Sync Determines whether the Length setting should be freely set (“off”) or synchronized to Reason Es-
sentials’s tempo (“on”).
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The EQ section

The equalizer in RV7000 affects the wet reverb sound only and is used for shaping the character of the reverb. There 
are two EQ bands, one for low frequencies (shelving) and one full-range parametric EQ.

D To activate the EQ, click the EQ Enable button on the main panel so that the indicator lights up.

D To make EQ settings, select “EQ” with the Edit Mode button to the left in the remote programmer panel.

D In this mode, the remote programmer display shows a frequency curve, indicating the settings you make with 
the EQ parameters.

The parameters are:

D Remember that you have a third EQ band at your disposal - the HI EQ parameter on the main panel.
The reason why this is on the main panel and not in the EQ section is simply that it’s a setting you may want to ad-
just often, without having to open the remote programmer panel.

| Parameter | Description

Low Gain The amount of cut or boost of the low-shelving filter.

Low Freq The frequency below which the Low Gain cut or boost is applied.

Param Gain The amount of cut or boost for the parametric EQ.

Param Freq The center frequency of the parametric EQ, e.g. at which frequency the level should be decreased or 
increased.

Param Q This governs the width of the affected area around the set center frequency. The higher the value, the 
narrower the affected frequency range.
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The Gate section

The Gate section allows you to create gated reverb effects with a lot of options and possibilities. You can either trig-
ger the gate from the source audio signal or via MIDI or CV. 

When triggering the gate from the source audio signal, it works like this:

• The gate “listens” to the source (dry) signal and opens whenever the signal reaches a certain threshold level.

• The reverb sound is sent through the gate - when the gate is closed you won’t hear the reverb.

• When the source signal level drops below the threshold level, the gate closes after a time that depends on the 
Hold parameter and the level of the source signal (see the parameter table).

D If you need the gate to be open for an exact duration (time), you should trigger it via MIDI or CV.
In audio trigger mode, the actual gate time will vary depending on the source signal.

When triggering the gate via MIDI or CV, it works like this:

• The reverb sound is sent through the gate - when the gate is closed you won’t hear the reverb.

• Whenever the gate receives any MIDI note (sent to the RV7000) or a gate signal (connected to the Gate Trig CV 
input on the back of the RV7000), the gate opens for the duration of the note or gate signal.

Note:

D To activate the Gate, click the Gate Enable button on the main panel so that the indicator lights up.

D To make Gate settings, select “Gate” with the Edit Mode button to the left in the remote programmer panel.

D In this mode, the remote programmer display shows two meters - one showing the signal level (with an indica-
tion of the threshold level) and one showing the status of the gate.
This is useful for checking what happens, how the gate triggers, etc.
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The parameters for the Gate section are:

CV Inputs

On the back of the RV7000 you find three CV inputs. These are:

| Parameter | Description

Threshold When Trig Source is set to “Audio”, this determines the audio signal level at which the gate opens. If 
you raise this setting, only very loud sounds will open the gate.

Decay Mod This modulates the reverb Decay parameter so that the decay time is lowered when the gate closes. 
When this is set to zero, no decay modulation happens - this means that if the gate is closed and then 
opened again, you may hear “previous” reverb tails that are still ringing. If you raise the Decay Mod 
setting, the decay will automatically be lowered when the gate is closed, eliminating this effect.

Trig Source Determines whether the gate should be triggered by audio or MIDI/CV, as described above.

High Pass A high-pass filter that affects the audio that triggers the gate (only active when Trig Source is set to 
“Audio”). If you raise this setting, sounds with low frequencies only will not open the gate. Note that 
this setting doesn’t affect the sound of the reverb, only the triggering mechanism.

Attack Determines how long it takes for the gate to open after a triggering signal has been received.

Hold This parameter is only active when Trig Source is set to “Audio”. Hold affects how quickly the gate 
closes, in the following way:
Internally, the gate is controlled by an envelope follower that analyzes the source signal level and gen-
erates a “level CV signal” accordingly. This signal is compared to the Threshold level to determine 
whether the gate should be opened or closed. The Hold parameter affects how quickly the envelope 
follower responds when the source signal level drops - you could say that this is the decay control for 
the envelope follower. The higher the Hold setting, the longer it will take for the envelope follower sig-
nal to drop below the threshold level and close the gate. But the resulting time also depends on the 
source signal level - with a loud signal, it will take longer time for the envelope follower to drop to the 
threshold level. Therefore, the actual gate time depends both on the Hold setting and on the charac-
ter of the source audio.

Release Determines how long it takes for the gate to close after the Hold time.

| Parameter | Description

Decay Controls the reverb decay or echo/delay feedback via CV.

HF Damp Controls the HF Damp parameter on the main panel.

Gate Trig Used for triggering the Gate section with a gate signal. The length of the gate signal determines the 
length of the gated reverb.
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Scream 4 Sound Destruction Unit

Scream 4 is a very versatile stereo in/out sound destruction device, capable of warping any sound literally beyond 
recognition, but also capable of producing more subtle musical effects. Scream 4 features a wide range of algorithms 
for distortion and sound mangling which can be combined with an EQ and a resonant “Body” section to provide ev-
erything you need to add an edge to your sounds. This effect is most often used as an insert effect.

About the Patch format

Unlike most of the other effect devices, Scream 4 features programmable effect presets. Included are a number of 
factory Patches which can be used as they are or provide you with a good starting point for further tweaking.

Patches use the Windows file extension “*.SM4”. Loading and saving Patches is done in the same way as for instru-
ment devices.

Parameters
Scream 4 contains three main sections; Damage (distortion and other types of sound destruction), Cut (EQ) and 
Body (places the sound in a resonant environment - can serve as anything from a cabinet emulator to a wah-wah to 
completely new special effects) which can be switched on or off independently. The parameters in each section are 
as follows:

Common effect device parameters

While the specific parameters for the Scream 4 effect device are described below, some features and procedures are 
common to all effect devices. Please, refer to “Common effect device features” for information about the Input meter, 
the Bypass/On/Off switch and Signal Flow Graphs on the effect device.

Damage section controls

The “Damage” section is where you specify the basic sound mangling algorithm and make settings to inflict the de-
sired amount of damage to the sound. There are ten basic algorithms to chose from, ranging from classic distortion 
effects to digital-sounding warping and modulation effects.
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There are five controls in this section, with the following functions:

Description of the various Damage Type algorithms

Here follows a basic description of the ten Damage Types available, and what parameters the P1/P2 knobs control 
for each type:

| Parameter | Description

Damage button This switches the Damage section on or off.

Damage Control knob This controls the input gain which in turn determines the amount of damage inflicted. The 
higher the value, the more destruction!
When raising the Damage Control you may need to lower the Master level to maintain the 
same output level (and vice versa).

Damage Type knob This selects the type of effect - see the table below for a description of the available 
damage methods.

P1/P2 knobs The functionality of these knobs vary according to the selected Damage Type - see the 
table below for a description.

| Type | Description

Overdrive This produces an analog-type overdrive effect. Overdrive is quite responsive to varying dynamics. Use 
lower Damage Control settings for more subtle “crunch” effects. 
- The P1 knob controls the basic tone of the effect. Turn clockwise for a brighter sound.
- The P2 knob controls Presence. Presence boosts frequencies in the high midrange before the distortion 
stage which in turn affects the character of the distortion. Turn clockwise for more Presence boost.

Distortion Similar to Overdrive, but produces denser, thicker distortion. The distortion is also more “even” across the 
Damage Control range compared to Overdrive.
- The P1/P2 knobs control Tone and Presence, respectively - see Overdrive for a description.

Fuzz Fuzz produces a bright and distorted sound even at low Damage Control settings.
- The P1/P2 knobs control Tone and Presence, respectively - see Overdrive for a description.

Tube This emulates tube distortion. 
- The P1 knob controls Contour, which is somewhat like a high pass filter, changing the tone and character 
of the distortion.
- The P2 knob controls Bias, which changes the “symmetry” of the tube distortion. Setting this to the min-
imum or maximum value will produce asymmetrical distortion (typical of a real-life tube amplifier), while a 
12 o’clock setting will produce symmetrical distortion (odd harmonics only).

Tape This emulates the soft clipping distortion produced by magnetic tape saturation and also adds compres-
sion which adds “punch” to the sound.
- The P1 knob controls Speed, which simulates tape running at different speeds. The higher the Speed 
setting the more of the original high frequency material in the signal. Turn clockwise for a brighter sound.
- The P2 knob controls the amount of Compression. Turning the knob clockwise increases the compres-
sion ratio.

Feedback This effect combines distortion in a feedback loop which can produce many interesting and sometimes 
unpredictable results. Feedback is basically when a sound source is fed back to itself. An open micro-
phone picking up sound from a nearby loudspeaker that is also being used to amplify sound from the mi-
crophone will produce a feedback loop with the associated typical howling. For this effect the Damage 
Control knob controls the gain of the feedback loop.
- The P1 knob controls Size, which could be described as the “length” (i.e. the distance between the micro-
phone and the loudspeaker in the above example) of the feedback loop. 
- The P2 knob controls Frequency, which for this effect determines which overtones will “howl”.

Modulate Modulate first multiplies the signal with a filtered and compressed version of itself, and then adds distor-
tion. This can produce resonant, ringing distortion effects.
- The P1 knob controls Ring, which is the resonance of the filter. Turn clockwise for more pronounced 
ringing effects.
- The P2 knob controls Frequency, which is the filter frequency. Turn clockwise to raise the filter frequency 
which generally produces a sharper, more piercing effect.
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Cut section (EQ)

The sliders in the Cut section are tone controls, allowing you to cut or boost the level by up to 18dB in the low, mid 
and high frequency areas. The Cut section is activated with the Cut button above the sliders.

Move the slider from the middle upwards to boost the level, and from the middle downwards to cut the level of the 
corresponding frequency area.

Body section

The Body section is just what it says - it places the sound in a resonant “body”. Depending on the settings, the result 
can be similar to a speaker cabinet simulator, an auto-wah effect, or effects with no real-world counterpart. The sec-
tion is based on 5 basic body types, which simulate how a sound is affected by different physical enclosures. The size 
and resonance of the Body types can be changed, and the section also features an envelope follower.

Warp Warp distorts and multiplies the incoming signal with itself.
- The P1 knob controls Sharpness. Lower values will produce a soft, compressed distortion, while higher 
values produces more harmonics and a sharper sound.
- An effect of multiplying a signal with itself is that the fundamental pitch is removed from the signal, leav-
ing overtones only. The P2 knob controls Bias - raise this to reintroduce the fundamental pitch in the 
sound.

Digital Lo-fi anyone? This reduces the bit resolution and sample rate for raw and dirty sounds or for emulating 
vintage digital gear.
- The P1 knob controls (bit) Resolution. If the knob is turned fully to the right there is no bit reduction, fully 
the left the resolution is 1-bit.
- The P2 knob controls the sample rate. If the knob is turned fully to the right the sample rate is not re-
duced; turning it to the left gradually reduces the sample rate.

Scream Similar to Fuzz, but with a bandpass filter with high resonance and gain settings placed before the distor-
tion stage. 
- The P1 knob controls the basic tone of the effect. Turn clockwise for a brighter sound.
- The P2 knob controls the filter frequency. The high resonance setting of the filter makes it suitable for 
wah-wah effects.

| Type | Description
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The Body parameters are as follows:

About the envelope follower

The Body section features an envelope follower for dynamic control of the Scale parameter. The envelope follower 
analyzes the amplitude of the incoming signal and changes the Scale setting accordingly - the louder the incoming 
signal the higher the value of the Scale parameter. The operating frequency (or size) range is set with the Scale pa-
rameter, and the envelope follower amount is set with the Auto parameter. A typical use for this is auto-wah effects 
- try Body Type “B” for a pronounced wah effect.

• On the back of the Scream 4 you will find an Auto CV output - this delivers the CV signal from the envelope fol-
lower, allowing you to dynamically control parameters in other devices.

About the Master level control

The Master level control should be used when you need to increase or decrease the output level, while retaining the 
basic character of the effect. It can also be used to balance the level between the distorted sound and the “clean” 
(unprocessed) sound if the effect is to be switched in and out in the mix.

If the output level is too high, turning down the Damage Control setting would lower the output, but it would also 
change the character of the distortion, as would changing eq or presence settings.

Simply lowering the mixer channel level (for the channel that Scream 4 is connected to) would also work of course, 
but this would also mean that the level difference between the unprocessed and processed sound would increase. 

So if the clip indicator lights up on the Transport, or if the distorted sound is too loud compared to the normal sound, 
the solution is to lower the Master output level.

As pointed out elsewhere in the manual, audio out clipping (indicated by the red clip indicator lighting up on the 
Transport Panel) can only happen in the Reason Essentials Hardware Interface. In other words, you never have to 
worry about levels passed internally from device to device. However, bear in mind that if you use high Master output 
settings (or a lot of boost in the Cut section) Scream 4 can quite easily cause audio out clipping - and that is most 
likely not a distortion effect you want! 

| Parameter | Description

Body button This switches the Body section on or off.

Body Type knob This is used to select one of the five available Body types (A-E). 

Body Reso knob This simulates the resonance of the selected Body. Turning the knob clockwise gives a more 
resonant effect.

Body Scale The Body Scale parameter could be said to control the “size” of the Body. Note that this is “in-
verted” - turning the knob clockwise reduces the emulated size.

Auto knob Determines the amount of envelope follower effect on the Scale parameter - see below.
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CV inputs and outputs

On the back of the Scream 4 you will find CV inputs for controlling the following four parameters:

D Damage Control
Use this for dynamically changing the amount of damage effect.

D P1
The use for this depends on the selected Damage Type. For example, if the Feedback effect is selected, this will 
control the Size parameter - connect it to the CV Out on a Matrix or synth LFO for strange, flanger-like sweeps.

D P2
The use for this depends on the selected Damage Type. For example, if the Scream effect is selected, this will 
control the Frequency parameter, producing a distorted wah wah sound.

D Scale
Lets you control the Scale parameter in the Body section from another CV source, for wah wah-like effects, etc.

In addition, you find a CV output from the “Auto” (envelope follower) function in the Body section. By connecting this 
to a CV input for a parameter in another device, the level of the signal going into the Scream 4 will affect that param-
eter. See below for an example on how to use this.
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Screamy tips and tricks
Don’t restrict yourself to using Scream 4 as a basic distortion stompbox, but try it in as many ways as possible - you 
may be surprised to find how often Scream 4 can add power, warmth and color to your sounds. Here are some ex-
amples:

Creating a heavy drum sound

Scream 4 is ideal for processing drums. Try connecting it as an insert effect to a Redrum device and experiment with 
the Damage Types and settings. 

• For classic distorted drums, try the Tube, Tape or Distortion algorithms.

• The Scream algorithm is excellent for a really raw body or industrial drum sound.

• For more weird, synth-like effects, try the Modulation or Warp effects.

Remember that you don’t have to route the whole drum kit through the Scream device - sometimes it may be better 
to route the individual outputs from the bass drum, snare and/or toms to a Spider Audio Merger (see “Spider Audio 
Merger & Splitter”), connect the merged output of the Spider to the Scream 4 and route this to a separate channel in 
the Mixer. That way, hi-hats, cymbals and similar are unprocessed.

Warming up a mix with the Tape effect

If you find your mixes a bit sterile, the Tape algorithm is excellent for providing some warmth and gentle distortion:
1. Create a Scream 4 device and connect it between the main outputs of the Mixer and the Audio Hardware Inter-

face.

2. Set the Damage Type to Tape.
Make sure the Cut and Body sections are turned off.

3. Start with a low Damage Control setting and P1 (Speed) and P2 (Compression) at 12 o’clock.

4. Play back your mix and adjust the settings.
Raise the Damage Control for more tape saturation distortion, adjust P1 to get the desired brightness and raise P2 
if you want a more controlled, compressed sound. If you like, you could also activate the Cut section and use the 
three-band EQ to further adjust the sound.

Using the Body section as a sound enhancer/phaser/wah

Nothing stops you from using the Body section on its own, without Damage. Try this:
1. Create a sampler device (e.g. an NN-XT) and select an electric piano patch.

2. Select the sampler and create a Scream 4.
It is added as an insert effect between the NN-XT and Mix Channel.

3. Turn off the Damage section and instead activate the Body section.

You will find that this adds a resonant character to the sound, which will make it more “alive” and help it stand out in 
a mix. You should experiment with the Body settings to find the character that suits you best. You could also activate 
the Cut section- if you e.g. find the sound too bassy, just lower the “Lo” slider a bit.

4. Now flip the rack around and connect the CV out from the sampler’s LFO to the Scale CV input on the Scream 
4.
As you can hear, the Scale is modulated by the LFO.

5. Adjust the amount of Scale modulation with the pot next to the CV input on the back of the Scream 4, and the 
speed (and waveform) of the modulation in the LFO section on the sampler device.
With this type of modulation setup, it’s easy to get lush, dreamy phaser effects. For a more wah wah-like sound, se-
lect Body type B and raise the Reso and Scale settings.
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Emulating vintage digital gear

The first generations of digital instruments (drum machines, synths and samplers) used 8 or 12 bit sampling and pro-
cessing, at low sample rates. This “lo-fi” sound is still in high demand, e.g. in hip-hop and R’n’B. Try this:
1. Connect a Scream 4 as an insert for a Redrum, with a suitable kit selected.

2. Set Damage Type to Digital and turn P1 and P2 fully right.

3. Play back and lower P1 (bit depth) and P2 (sample rate) to get the sound you want.
You may also want to use the Cut section to emphasize or cut frequencies in the sound.

Scream 4 sample rate issue

Some of the algorithms on the Scream 4 Distortion device do not have the expected effect when running Reason Es-
sentials at a sample rate lower than 14 kHz (or exporting to a sample rate lower than 14 kHz). Please use a higher 
sample rate if your song contains Scream devices.



Chapter 35
Half-Rack Effects
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Common effect device features
While the specific parameters for each effect device are described below, some features and procedures are com-
mon to all effect devices:

The Input meter

This shows the level of the incoming audio signal, giving you an indication of which devices are active, connected and 
playing. However, you don’t need to worry about clipping in effect devices, even if the meter goes into the red.

The Power/Bypass switch

This is located in the upper left corner of each effect device. The switch has three modes, according to the following 
figure:

About making settings

You adjust effect parameters using the regular editing techniques.

q A quick way to reset the parameters to their default values is to hold down [Ctrl](Win) or [Cmd](Mac) and click 
the corresponding knob.

About Connections

• All effect devices have stereo inputs and outputs, and can be connected as send effects or as insert effects.
However, some effects are best used as one of these only. This is stated for each effect on the following pages. 
See also the section about the signal flow graphs below.

• Most of the effect devices have one or several CV inputs on the back panel.
These allow you to control various effect parameters in real-time, from another device in the rack. See “Routing CV 
and Gate signals” for details about routing CV.

| Mode | Description

Bypass In this mode, the input signal is passed directly to the audio output, without being affected by the effect device. 
This is useful when the effect device is connected as an insert effect, and you want to compare the effect 
sound with the dry sound.

On This is the default mode, in which the device processes the incoming signal.

Off In this mode, the effect device is turned off and neither dry nor effect sound is sent out. This is useful when the 
device is connected as a send effect and you want to turn it off temporarily.
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The Signal Flow graphs

On the back of each effect device, you will find two or three small “graphs”. These indicate how the effect device han-
dles mono and stereo signals, depending on the connections. The selection of graphs for a device tells you how it 
should be used, according to the following rules:

| Graph | Description

Can be connected as a mono-in, mono-out device. 
(Of course, all effect devices can be connected in mono. However, if this graph isn’t shown for a device, this 
means that a mono-in, mono-out connection may not give the proper results).

Can be connected as a mono-in, stereo-out device. This means that the device creates some sort of stereo ef-
fect (e.g. a reverb) or a mono effect that can be panned.

If you connect both inputs and outputs in stereo, the two sides will be processed independently (dual mono pro-
cessing).

If you connect both inputs and outputs in stereo, the two sides are summed before the effect processing. How-
ever, the actual effect is in stereo (and the dry signal will remain in stereo, if it is passed through the effect).

“True stereo” processing, or “stereo in - stereo out” processing. When you connect the inputs in stereo, each 
channel in the effect uses the signal information from both inputs. However, the inputs are not summed - the 
two channels are processed differently.
This mode is available on the RV7000 Advanced Reverb - see “RV7000 Advanced Reverb”.
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DDL-1 Digital Delay Line

This is a mono delay (where the output can be panned in stereo) that can be synchronized to the song tempo. The 
delay can be used as a send effect or an insert effect. 

Parameters

CV Inputs

The following CV inputs are available on the back panel of the device:

D Pan CV.
This allows you to control the panning of the delay signal. Connect an LFO to this for moving delay effects, or use 
a Matrix pattern to simulate random delay panning.

D Feedback CV.
This allows you to control the amount of feedback (the number of delay repeats) from another device. Useful for 
dub-type echoes on certain beats or notes only.

Switching between Unit modes

When you switch between the two Unit modes (Steps and MS), the following rules apply:

D If you switch from Steps mode to MS mode, the delay will be set to the same actual delay time as was used in 
the Steps mode.
This means that you can set up an exact rhythmic delay in Steps mode, and then switch to MS mode to adjust it 
slightly. 

D If you switch from MS mode to Steps mode, the delay is reset to the previously used Steps value.

| Parameter | Description

Delay time The display to the left on the device panel shows the delay time, either as note value steps (based on the sequencer 
tempo and the Step Length parameter) or in milliseconds, depending on the setting of the Unit switch. 
The maximum delay time is two seconds (2000 ms) while the maximum number of steps is 16. 
Note that if the tempo is low, you may reach the maximum delay time at a lower number of steps than 16 (in which 
case raising the steps value will not make any difference).

Unit This is where you select whether you want a tempo-based delay (“Steps” mode) or a free time delay (“MS” mode).
In the Steps mode, you specify the delay time in note value-based steps. This means that if you change the tempo in 
the transport panel, the delay will maintain its rhythmic relation to the music (provided that the resulting delay time 
doesn’t reach the maximum value). This mode is useful for creating rhythmic patterns.
If you change the tempo when using the delay in MS mode, the delay time will remain the same.
See also the note about switching Unit modes below.

Step length Governs whether each step in Steps mode should be a sixteenth note (1/16) or an eighth triplet note (1/8T).

Feedback Determines the number of delay repeats.

Pan Pans the delay effect to the left or to the right.

Wet/Dry If you are using the delay as an insert effect, you use this parameter to adjust the balance between the unprocessed 
audio signal (dry) and the delay effect (wet). 
If the delay is used as a send effect, this should be set all the way to wet only, since you can control the balance by us-
ing the AUX send controls in the Mixer.
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CF-101 Chorus/Flanger

The CF-101 is a combined chorus and flanger effect. It adds depth and movement to the sound by adding a short 
modulated delay to the audio signal. The delayed signal is then mixed with the original (either in the effect device or 
manually by you - see below). The CF-101 can be used as an insert or send effect.

Parameters

CV Inputs

The following CV inputs are available on the back panel of the device:

D Delay CV.
Allows you to control the delay time from another device. This may give best results if you turn off the LFO modu-
lation in the device (turn LFO Mod Amount to zero). For example, by controlling the delay parameter from a Matrix, 
you can create “stepped flanger” effects, in sync with the tempo.

q If you use the Delay CV input for “playing” the feedback tone, note that a higher delay value gives a lower 
pitch.

D Rate CV.
Lets you control the rate of the modulating LFO from another device.

About Stereo and Mono connections

The CF-101 can be connected using mono or stereo inputs, as shown by the graphs on the back panel. Note the fol-
lowing:

D A “moving” stereo effect is only obtained when you use a mono input and stereo outputs.
With a stereo input, the two sides are processed in parallel, maintaining the stereo image of the original sound.

| Parameter | Description

Delay This is a manual control for the delay time used to create the chorus/flanger effect. Usually, flanger-type effects use fairly 
short delay times while chorus-type effects use medium long delays.

Feedback This governs the amount of effect signal fed back to the input, which in turn affects the intensity and character of the ef-
fect. Turning this to the extreme left (negative feedback) or right (positive feedback) produces different flanger effects 
with a pronounced resonance “tone”, while keeping it in between produces a more gentle chorus effect.

LFO Rate This is the frequency of the LFO modulating the delay time. The higher the value, the faster the sound will oscillate.

LFO Sync This button lets you activate/deactivate LFO sync. When it is activated, the frequency of the LFO is synchronized to the 
song tempo, in one of 16 possible time divisions. The LFO Rate knob is then used for setting the desired time division. 
Turn the knob and check the tooltip for an indication of the time division.

LFO Mod Amount This determines the depth of the LFO modulation, i.e. by how much the delay time should be modulated. If you set this to 
0, the effect will be “frozen” (most effective if you add some feedback).

Send Mode This determines whether the delayed signal and the dry signal should be mixed in the effect device or not. If you use CF-
101 as an insert effect, you should turn this off - the device will then output a mix of the dry signal and the modulated de-
lay signal.
If you use the device as a send effect, you should activate Send mode. Then, the device will only output the modulated de-
lay signal, allowing you to mix it with the dry signal using the AUX send controls in the mixer. See also the note below 
about using the CF-101 as a vibrato effect!
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D When you are using a mono input and stereo outputs, there will only be a stereo effect if the internal LFO is 
used.
If you turn LFO Mod Amount to zero, both stereo outputs will carry the same signal (mono). This is because the 
“fake stereo” effect is produced by inverting the modulation for one of the output channels.

Tip: Using the CF-101 as a vibrato effect

The Send mode is intended for when using the CF-101 as a send effect. In this mode, the device will only output the 
modulated delay signal - you get the actual “chorusing” by mixing this signal with the dry, unprocessed signal in the 
Mixer.

However, if you activate Send mode while using the device as an insert effect, the result will be a pitch modulated 
version of the original sound - in short, a vibrato effect. Along with a little feedback, this can be used for special ef-
fects.
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Spider Audio Merger & Splitter

The Spider Audio Merger & Splitter is not an effect device, but a utility. It has two basic functions:

D To merge up to four audio input signals into one output.

D To split one audio input signal into four outputs.

There are no controls on the front panel of this device, only signal indicators.

Merging audio

On the back panel of the Spider are several audio connectors. The left half of the panel contains four stereo audio in-
put connectors, and to the right of these, one merged stereo output. 

D The principle is simple; all audio signals connected to any of the four inputs will be merged and output via the 
output connectors.
If you connect a mono signal (to a L/Mono input, with nothing connected to the corresponding R input) it will be 
output on both merged outputs. This way you can merge stereo and mono signals freely.
If you connect a signal to the R input only (with nothing connected to the corresponding L/Mono input) it will be 
output on the R output only.

Practical uses of merging audio

There are many practical uses of merging audio signals together, for example:

D Process several audio signals through the same insert effect(s).
Perhaps you want to process certain channels in a mix through the same insert FX processor. You can also set up 
a chain of insert effects and process the merged signals.

D Sub-grouping signals.
It may be practical to control several audio signals using only one channel strip in the Mixer.

Merged signal outputsFour audio input pairs
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Splitting audio

The right half of the back panel contains two signal splitters, labeled “A (L)” and “B (R)”. The two splitters work inde-
pendently, in the following way: 

D The signal fed to the input connector will be simultaneously output by all four outputs.
For splitting stereo signals you simply use both splitters with “A” for the left channel and “B” for the right channel.

Practical uses of splitting audio

There are many practical uses of splitting audio signals - here are a few examples:

D Create “pseudo” stereo effects from mono signals.
For example, you could route the mono output of a Subtractor to the Spider and then send two split outputs (from 
the same row) to different effects and on to different Mixer channels panned left and right.

D Switch between (or mix) different variations of the same signal (parallel processing).
This is a neat way of applying “spot effects” in a mix. An instrument output is split and sent to three different com-
binations of insert effect processing. The outputs from the three effects are routed to separate channels in the 
Mixer, which could in turn have different send effects, eq, etc. You then have three different variations of the same 
signal that can be easily switched in and out of the mix for drastic sonic changes - or combined for huge layered 
sounds.

Four split output pairsAudio inputs
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Spider CV Merger & Splitter

The Spider CV Merger & Splitter is not an effect device, but a utility. It has two basic functions:

D To provide one merged CV output from up to four CV input sources.

D To split CV or Gate inputs into several outputs.
Two inputs, A and B, are provided, each with four outputs, where one of the outputs will invert the polarity of the 
control signal. One reason for having two splitable inputs is to make it possible to split Gate and Note CV, to con-
trol several instrument devices with one Matrix for example.

There are no controls on the front panel of this device, only CV signal indicators. The four horizontal indicators light 
up to indicate signals connected to the corresponding merge input. The two indicators to the right indicate signals 
connected to the corresponding split inputs.

Merging CV

On the back panel of the Spider there are several CV connectors. The left half of the panel contains four CV/Gate in-
put connectors with associated trimpots, and to the right of these, one merged CV output. 

D The merged CV output will produce a CV signal that represents the “sum” of all connected CV inputs.

A few things to note:

• Gate CV signals typically trigger notes or envelope cycles and are normally routed to a Gate input. 

• CV signals typically control note pitch or for modulating parameters and are typically routed to CV Note or 
Modulation inputs.

There are no strict rules involved, but the facts mentioned above means that it is generally better to stick to using ei-
ther Gate CV signals or CV signals but not a mixture when merging. simply because the CV/Gate signals usually go 
to different input destinations.

For instance, merging Note CV and Gate CV from a Matrix does not make much sense if you want to use Matrix to 
play melodic patterns via the Sequencer Control inputs of an instrument device. There would only be one merged out-
put whereas the instrument device would need a separate Gate and Note CV signal to work properly. 

Four CV inputs with 
trim controls

The merged CV 
signal output.
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Practical uses of merging CV

The practical applications of merging CV are perhaps less obvious compared to splitting CV. But there are numerous 
applications for a merged CV control output, a few of which are listed below:

D You can create interesting modulation effects by merging several Modulation outputs from LFO’s and other 
CV modulation sources.
For example, merging the Modulation outputs from several LFO’s would produce a “mixed modulation” output. This 
merged output signal could be likened to a “super LFO” capable of generating several modulation cycles simulta-
neously, each with a different waveform and modulation rate! In addition to this, by using the trim control for each 
CV input, you have full control over the amount of modulation applied by each LFO.

The above example could of course also include Curve CV outputs from a Matrix, or in short any CV Modulation 
output.

D Create an “arpeggiator” using two Matrix devices and the Spider CV Merger & Splitter.

By merging the Note CV output from one Matrix with a Curve CV output of another Matrix, you can transpose the Ma-
trix pattern in real-time, a bit like an arpeggiator.
1. Create a Subtractor and a Matrix device.

Connect the Matrix Note and Gate CV outputs to the Subtractor Sequencer CV and Gate inputs, respectively.

2. Program a pattern for the Matrix.
In the following text this is referred to as “Matrix 1”.
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3. Now create a Spider CV and a second Matrix device and connect them as in the picture below.

Note that the Note CV output from Matrix 1, and the Curve CV output of Matrix 2 should be connected to the Spider. The 
merged output is connected to the Sequencer Control Note CV input on the Subtractor.

4. On the Spider CV, turn the trimpot for the input connected to the Note CV output fully to the right.
This setting will retain the correct pitch relationship for the notes played by the pattern.

5. On the Spider CV, turn the trimpot for the input connected to the Curve CV output to “32”.
This will produce a Curve CV output that corresponds to semitone steps.
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6. Set the Curve type switch to “Bipolar” on the back of the second Matrix (Matrix 2).

7. Flip the rack around so that the front panels are showing, and make the following settings for the “Matrix 2”:

• Set the number of steps to “1”.

• Set the Curve/Keys switch to “Curve”. 

8. Adjust the Matrix 2 curve for step 1 (the only step used) so that it is in the middle of the bipolar curve as the pic-
ture shows.

9. If you now activate Play from the transport, the pattern you programmed for Matrix 1 is played back. By care-
fully adjusting the Matrix 2 Curve step 1 up or down the Matrix 1 pattern is transposed in semitone steps.
By programming different values for the “pattern” played by Matrix 2 and saving them in different pattern locations, 
you can use the Pattern selectors to transpose the Matrix 1 pattern to different keys!

Splitting CV

On the right half of the back panel you will find two split inputs “A” and “B”, each with four output connectors. The sig-
nal connected to a Split input will be output by all four corresponding outputs, where one is inverted.

Practical uses of splitting CV

There are many practical uses of splitting CV signals - here are a few examples:

D Connecting the CV Note and CV Gate outputs from a Matrix to Split Input A and B, allows you to connect the 
Matrix to several instrument devices.
Simply route the CV and Gate outputs to the corresponding Sequencer Control CV/Gate inputs on the instrument 
devices. Although this could also be done by copying the Matrix Pattern data to several sequencer tracks and rout-
ing the outputs to the desired devices, the advantage by using Split is if you are editing Matrix pattern data this will 
be immediately be reflected in all the connected devices, without any copy/paste operations.

D Splitting modulation outputs from LFO’s, Curve CV data etc. allows you to apply modulation from one source 
to several parameters.
By using the inverted output, you can create interesting modulation crossfades, where one parameter value rises 
and another parameter value is lowered for example.

Two CV Split Inputs (A & B)

Each of the two Split inputs provide four 
Split outputs. The lower right Split out-
puts will produce an inverted CV signal.
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Introduction

The Matrix is a pattern-based device. Matrix doesn’t generate sound on its own, but has to be connected to another 
instrument device. It basically works by sending pattern data in the form of Note CV (pitch) and Gate CV (note on/off 
plus velocity) or Curve CV (for general CV parameter control) signals to a device or device parameter. The patterns 
can be up to 32 steps, and there are 32 memory locations for storing pattern data. The Matrix is monophonic and can 
control one voice in an instrument device.

Unlike most other devices in Reason Essentials, the user interface of the Matrix is not modeled on any existing hard-
ware equivalent. The hardware devices that could be said to have similar functionality are analog step sequencers, 
which usually had rows of knobs that controlled the note pitch and gate values for each step.

About the three Output types

Note and Gate CV values.

The Matrix can produce three types of output: Curve CV, Note (Key) CV and Gate CV. 

• Note CV normally controls note pitch. 
When connected to an instrument device Sequencer Control input, the values correspond to semitone steps.

• Gate CV represents a note-on/off value, plus a level value (that could be likened to velocity).

Both of these two outputs are typically connected to the Sequencer Control Gate and CV inputs on a compatible in-
strument device. For example, if you create a Matrix with either a synthesizer (Subtractor) or a sampler (NN-XT) se-
lected, they will be auto-routed in this way, and will control one voice in the device.

Gate values are entered here

Note values are entered here
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• Curve CV is a separate pattern, programmed separately from the Note/Key and Gate CV.

Curve CV values (upper window).

This is useful for programming CV curves that control other parameters other than note pitch (although you could do 
this too). This way you could control the note pitch and triggering from the Key and Gate outputs for a device, then 
add a second independent pattern using the Curve CV output that could control filter cutoff for example.

It should be stressed that all three outputs can be used in any number of ways. For example, you could use the Gate 
CV to trigger a drum in Redrum, or let the Curve CV control the feedback parameter of a delay, etc.

Programming patterns

Pattern basics
Matrix contains a built-in pattern sequencer. Unlike the main sequencer in Reason Essentials, the Matrix sequencer 
repeatedly plays back a pattern of a specified length. The typical example in the “real world” (as well as in Reason Es-
sentials) is a drum machine which plays drum patterns, usually one or two bars in length.

Having the same pattern repeat throughout a whole song may be fine in some cases, but most often you want some 
variations. The solution is to create several different patterns and program pattern changes (automatic switching from 
one pattern to another) at the desired positions in the song.

How the Matrix pattern sequencer integrates with the main Sequencer

The built-in pattern sequencer in the Matrix interacts with the main Reason Essentials sequencer in the following 
ways:

• The tempo set on the transport panel is used for all playback.
If the Tempo track (see “Recording tempo automation”) is used, Matrix will follow this.

• If you start playback for the main sequencer (on the transport panel), the Matrix will automatically start as well 
(provided the pattern sequencer hasn’t been disabled - see below).

• You can mute and solo Matrix tracks in the sequencer.
If the Matrix has a track in the sequencer and you mute this track, Matrix will automatically be muted as well. This 
is indicated by a Mute indicator on the device panel. If there are several note lanes on the Matrix track, their re-
spective mute status will not be indicated on the device panel.

D You can also run Matrix separately (without starting the main sequencer) by clicking the Run button on the de-
vice panel.
This starts the built-in pattern sequencer in the device. To stop playback, click the Run button again or click the 
Stop button on the Transport panel.
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• If you are running Matrix separately and start playback of the main sequencer, the pattern device will automat-
ically restart in sync with the sequencer.

• Pattern changes can be controlled by a pattern lane in the main sequencer.
In other words, you can record or create pattern changes in the main sequencer, and have them occur at the cor-
rect position on playback.

Selecting Patterns

The Matrix has 32 pattern memories, divided into four banks (A, B, C, D).

The Bank and Pattern buttons for the Matrix pattern sequencer.

D To select a pattern in the current bank, click on the desired Pattern button (1-8).

D To select a pattern in another bank, first click the desired Bank button (A, B, C, D) and then click the Pattern 
button.
Nothing happens until you click the Pattern button.

The pattern change takes effect on the next downbeat according to the time signature set in the transport panel or 
on the transport track.

The Pattern Enable switch

The Pattern Enable switch.

Next to the Bank and Pattern buttons you will find an additional switch, which is normally activated. If you click this to 
turn it off, the pattern playback will be disabled, starting at the next downbeat - exactly as if you had selected an 
empty (silent) pattern. For example, this can be used for bringing Matrix patterns in and out of the mix during play-
back.

Steps

Matrix patterns consist of a number of discrete steps. For each step, you can enter a note, a CV value and a Curve 
value. When you run the pattern, each step will be played back in turn and will play a sound or send out the informa-
tion programmed for this step. If you have ever used a drum machine, this will be obvious to you.
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Clearing a Pattern

To clear (empty) a pattern, select it and use the Clear Pattern command on the Edit menu or device context menu.

! Note that clearing a pattern doesn’t affect the pattern length, resolution or shuffle settings!

Using Cut, Copy and Paste

By using the Cut, Copy and Paste Pattern commands on the Edit menu or device context menu, you can move or du-
plicate patterns. The following rules apply:

D Copy Pattern makes a copy of the currently selected pattern and places the copy on the clipboard.

D Cut Pattern moves the currently selected pattern to the clipboard.
This is the same as first performing Copy Pattern and then Clear Pattern.

D Paste Pattern copies the pattern on the clipboard to the selected pattern location in the selected device.
This overwrites the selected pattern with the one on the clipboard.

Transferring patterns between Reason Essentials songs

If you want to copy patterns between different Reason Essentials songs, you use copy and paste:
1. Open both songs.

2. Select the pattern you want to copy.

3. Select Copy Pattern from the Edit menu or the device context menu.
You can also hold [Ctrl](Win) or [Cmd](Mac) and press [C] to copy.

4. Make the other song active.
This is done by clicking in the song window or by selecting the song from the Windows menu.

5. Select the bank and pattern location to which you want to copy the pattern.
Note that any pattern already stored in that location will be overwritten!

6. Select Paste Pattern from the Edit menu or the device context menu.
You can also hold [Ctrl](Win) or [Cmd](Mac) and press [V] to copy.
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Tutorial
The programming procedure of the Matrix is to input note and gate values into the upper and lower fields of the pat-
tern window respectively. You can input values by clicking or dragging in the pattern window. Proceed as follows:
1. Create a Subtractor synth.

You don’t have to use the Subtractor device to use the Matrix, in fact you don’t have to use an instrument device 
at all, but for this basic tutorial we will use a “standard” setup.

2. With the Subtractor selected, create a Matrix Pattern Sequencer.
The Matrix Note and Gate CV outputs will now be auto-routed to Subtractors Sequencer Control Gate and CV in-
puts, as you can see if you flip the rack around.

3. Make sure that the switch to the left of the pattern window is set to “Keys” position.
As you can see, there are two rows of red rectangles. The one with horizontal rectangles at the bottom of the up-
per field in the pattern window represent note pitch, for each step in a pattern. At the moment they are all set to 
the same note pitch. The row of vertical rectangles in the lower field represent Gate velocity values - currently 
these are all set to a velocity value of 100 for all steps.
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4. Click inside the upper grid section of the Matrix pattern window.
An orientation line is displayed in the grid to make it easier for you to find the desired note, and the red rectangles 
are placed according to where you click. You can drag to input continuous note values.

5. Click and drag in the lower area of the pattern window.
You can create vertical Gate velocity strips of varying heights. The higher the strip, the higher the velocity value. 

6. Press the Play button on the Matrix.
The pattern you “programmed” in the previous steps is now repeated. At the top of the pattern window, a red rect-
angle indicates every step of the pattern.

D If you now click or drag in the upper grid section with the pattern playing, you can hear how the note pitches 
change.
The note pitch corresponds to the keyboard printed to the left of the pattern window, in a one octave range, and as 
previously mentioned, an orientation line is visible when clicking or dragging, making it easy to find the note pitch 
on the keyboard.

D If you now click or drag in the lower gate section while the pattern is playing, you can hear how the timbre and 
volume changes. 

D If you drag some of the vertical rectangles down so that they disappear from view, the corresponding steps of 
the pattern are completely silenced.

D By using the 5-way switch below the “Keys/Curve” switch you can input notes in other octave ranges (over five 
octaves).
Note that there can only be one note for each step in the pattern.

7. By using a combination of the methods described in the above steps, you can program suitable note values for 
each step, decide which steps should be played and set their velocity with the gate values.
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Using Curve Patterns
Curve patterns are independent patterns that can be applied separately to the note pattern programmed in “Keys” 
mode. If you switch the Keys/Curve switch to “Curve”, the note, but not the gate steps, disappear from view, and 
leaves the upper area of the pattern window empty. You can now start programming a curve pattern. Proceed as fol-
lows:
1. Draw a curve, using the same method as for notes or gates.

As you can see, the Curve pattern looks like large vertical gate steps. 

D If you play the pattern, nothing has changed, i.e. the pattern sounds exactly like it did before the Curve pattern 
was drawn.
This is because the Curve CV output hasn’t been connected to any parameter yet.

2. Flip the rack around so you can see the back panel of the Matrix.

3. Connect the Curve CV output to the Filter Cutoff Modulation Input on the Subtractor.
Now the curve pattern controls the filter frequency of the Subtractor.

q If the effect isn’t very noticeable, try raising the filter Q parameter, and lowering the filter frequency.

D The Curve CV output can be connected to any device CV or Modulation input.
Actually, Curve CV signals can also produce Gate triggers (used for triggering samples or envelopes for example). 

D A Gate trigger is produced for each curve pattern step that follows a value of “0”. 
If you look at the picture below, steps 2,4 and 6 will produce a trigger, because steps 1, 3 and 5 are set to zero, but 
the rest of the pattern would not.

About Unipolar and Bipolar Curves

On the back panel of the Matrix you will find a switch, allowing you to select between “Unipolar” or “Bipolar” Curves. 
The difference is as follows:

D A unipolar curve has values starting from “0” and up. 
“0” is the value produced by all steps when they are “empty” (not visible). Unipolar is the default setting of this 
switch when a new Matrix is created.

Unipolar curve
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D A bipolar curve is divided in the “middle”, with the middle representing a value of “0”.
The curve reflects this. If no curve has been drawn and you switch to bipolar mode, all steps go from the bottom up 
to the middle of the scale printed to the left of the pattern window. Thus, all steps are at “0”, and the curve can be 
drawn both up and down from the middle.

Bipolar curve

Bipolar curves are essential in some instances. If you want to use the Matrix to CV control the Pan parameter for a 
mixer channel for example, a unipolar curve would start at zero - which for Pan equals center position. This means 
that you would only be able to use the curve to pan in one direction from this center position. A bipolar curve however, 
will have the zero value in the middle, allowing you to draw pan curves in both directions. Bipolar curves can also be 
used for controlling parameters with positive and negative values.

Setting Pattern Length

You may want to make settings for Pattern length, i.e. the number of steps the pattern should play before repeating:

D The “Steps” spin controls are used to set the number of steps you wish the pattern to play.
The range is 1 to 32. You can always extend the number of steps at a later stage, as this will merely add empty 
steps at the end of the original pattern. You could also make it shorter, but that would (obviously) mean that the 
steps you remove won’t play back. The steps you remove aren’t erased though, if you set the step number back 
again, anything recorded in the previously removed step locations will be played back.

Using Tied Notes
If you activate “Tie” to the left of the Gate pattern window, you can create longer notes (eighth notes, quarter notes 
etc.). A quick way to draw tied gates is to hold down [Shift] when you input the gate values.

Entering tied gate values.

D Each step that has one tied gate value will be twice the length compared to a normal step.
Tied gate steps are indicated by being twice as wide in the pattern window.

D If two or more notes of the same pitch are tied together, the result will be even longer notes. 

Tied notes are also essential if you want to create typical TB-303 “Acid”-type lead lines - see “Programming “Acid 
Style” lead lines”.



MATRIX PATTERN SEQUENCER676

Setting Pattern Resolution
Matrix always follows the tempo setting on the transport panel, but you can also make Matrix play in different tempo 
“resolutions” in relation to the tempo setting.

Pattern Shuffle
Shuffle is a rhythmic feature, that gives the music a more or less pronounced swing feel. It works by delaying all six-
teenth notes that fall in between the eighth notes.

Straight sixteenth note pattern (viewed in the sequencer).

The same sixteenth note pattern with shuffle applied.

In Reason Essentials, you can activate or deactivate shuffle individually for each pattern in a pattern device. However, 
the amount of shuffle is set globally with the Global Shuffle control in the ReGroove Mixer. The ReGroove Mixer is 
described in “The ReGroove Mixer”.

The Shuffle on/off switch in Matrix and the Pattern Shuffle control on the transport panel.

Pattern Mute
If you deactivate the “Pattern” button above the Pattern select buttons, the pattern playback will be muted, starting at 
the next downbeat (exactly as if you had selected an empty (silent) pattern). For example, this can be used for bring-
ing different pattern devices in and out of the mix during playback.

If you mute the Matrix track in the sequencer, it is muted instantly and the Mute indicator lights up on the panel. Note 
that all tracks connected to the Matrix must be muted for this to work. 
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Pattern Functions
When a pattern device is selected, you will find some specific pattern functions on the Edit menu (and on the device 
context menu).

Shift Pattern Left/Right

The Shift Pattern functions move the notes and corresponding gate values in a pattern one step to the left or right.

Shift Pattern Up/Down

! This function does not alter the Curve CV. This is because the values produced by the Curve CV do not neces-
sarily correspond to semitone note steps at all.

The Shift Pattern functions will transpose all the notes in a pattern one semitone up or down. 

Randomize Pattern

The Randomize Pattern function create random patterns. These can often be great starting points and help you get 
new ideas. Both Note, Gate and Curve CV values will be created.

Alter Pattern

The Alter Pattern function modifies existing patterns. Note that there must be something in the pattern for the func-
tion to work on - using an Alter function on an empty pattern will not do anything.

! Note that Randomize and Alter affects both the Gate, Note and Curve CV!

Chaining Patterns
When you have created several patterns that belong together, you will most probably want to make these play back 
in a certain order. 

D Simply activate record for the track with the Matrix as the destination in the sequencer and use the Pattern and 
Bank buttons to determine the playback order as the Song is playing. 
The Patterns play to the end before changing, so you won’t have worry too much over the “timing” of the pattern 
changes you input manually. When you are done, the sequencer track will contain pattern change data, and the 
patterns will automatically switch according to the order set while recording. More on recording pattern changes 
on “Recording pattern automation”.

D An alternative way to do this is editing directly in the Pattern Edit lane in the sequencer.
Editing in the Pattern lane is described in the Sequencer chapter.
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Converting Pattern data to notes in the main sequencer
You can convert Matrix Patterns to notes in the main sequencer. This allows you to edit the notes freely, create vari-
ations or use Groove quantizing.

The “Copy Pattern to Track” function

This function is useful when you have created a single pattern in the Matrix device and want to render individual note 
events on a sequencer track. 

! Curve patterns cannot be converted to sequencer data! Only the note pattern and the gate values will be con-
verted.

Proceed as follows:
1. Set the Left and Right Locators to encompass the section you want to “fill” with the notes in the pattern.

You may want to make sure that the space between the locators is a multiple of the pattern length, to avoid “cut-
ting off” the pattern.

2. Select the track you wish to copy the rendered notes to.
You should not copy the notes to the Matrix track, but to the track for the device controlled by the Matrix (since the 
Matrix doesn’t produce any sound in itself). You can also copy the notes to any other instrument track if you like.

3. Select the Matrix device in the rack and select “Copy Pattern to Track” from the Edit menu or the device con-
text menu.
The pattern is converted to a single note clip on the track, with Note and Gate (Velocity) values. If the space be-
tween the locators is greater than the pattern length, the pattern will be repeated in the clip to fill up the space.

When you use the “Copy Pattern to Track” function with the Matrix, you should note the following:

• A note will be created for each pattern step which has a Gate value greater than zero. 
The notes will have the pitch according to the key CV value for the step, and the velocity according to the Gate 
value.

! The Curve CV is not copied.

• You may want to disconnect or even remove the Matrix device after performing this function.
This is because you probably don’t want both the Matrix and the sequencer notes to play the device at the same 
time and thus cause “note doubling”.

q The procedure above copies a single pattern to notes in the sequencer. If you have automated pattern 
changes, you can copy a complete pattern track to notes, taking all pattern changes into account.

The “Convert Pattern Automation to Notes” function 

If you have recorded or drawn pattern automation on a Matrix track, you can have the whole track converted to notes, 
in the following way:
1. Select the track with the pattern automation.

2. Select “Convert Pattern Automation to Notes” from the Edit menu or the context menu for the track.
For each pattern clip, the corresponding pattern is converted to note clips on the track (following the same rules as 
for the “Copy Pattern to Track” function). The track will play back just the same as when you played the pattern de-
vice with the pattern changes.

D After the operation, the Pattern Select lane is switched off.
The Pattern (Enable) button on the device is automatically turned off.

D When you use this with a Matrix, you need to move the note clips to the track of an instrument device (typically 
the device to which the Matrix is connected).
This is because the Matrix doesn’t make any sound itself.
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Example usage
As mentioned previously, the Matrix is a very flexible device. Here follows a few examples of how you can use the 
Matrix Pattern Sequencer.

Using the Matrix for modulation
You can effectively use the Matrix as a modulation source, much like an LFO. Just like the LFOs in Reason Essen-
tials’ instrument devices, the Matrix can generate modulation that is synchronized to tempo, which has many advan-
tages. Proceed as follows:
1. Create a Synthesizer (e.g. a Subtractor).

2. Create a Matrix Pattern Sequencer, or if one already exists, set it to an empty pattern.

3. Flip the rack around and disconnect the Gate and Note CV outputs.
Gate/Note CV is not used in this example

4. Flip the rack around and connect the Curve CV output on the Matrix back panel to the “Amp Level” Modulation 
input on the synthesizer.
This parameter is used for modulating the output level (volume) of the synthesizer. Volume modulation is often re-
ferred to as Tremolo. You can use a unipolar curve (see “About Unipolar and Bipolar Curves”) for this example.

5. Flip the rack back again, and switch the Matrix to display the Curve pattern window.

6. Draw a curve like the one shown in the illustration below.
If you use fewer or more steps than16 (as shown in the picture), just draw the curve so that it roughly matches the 
shape in the picture.

7. Activate Click on the Transport Panel.

8. Select the track that is routed to the synthesizer, so that you can play it from your MIDI keyboard.

9. Activate Play on the transport panel, and hold a chord down on your keyboard.
You should now hear the volume being modulated by the Curve pattern.

10.While still in play mode, you can use the Resolution knob to change the modulation “rate” in relation to the 
tempo.
For each clockwise resolution step the modulation speed is doubled and vice versa, but it will always stay in sync 
with the tempo.
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Programming “Acid Style” lead lines
By “acid style” lead lines we mean patterns that use a combination of Legato and slide (or portamento) effects to pro-
duce the widely used hypnotic “wavy” sound produced by the original Roland TB-303, and recreated in the Propeller-
head Software product ReBirth. To approximate this typical sound using Reason Essentials, proceed as follows:
1. Create a Synthesizer (Subtractor).

2. Create a Matrix Pattern Sequencer, or if one already exists, set it to an empty pattern.

3. Make sure that the Note and Gate CV outputs are connected to the synthesizers Sequencer Control CV and 
Gate inputs, respectively.

4. For Subtractor, select either Init Patch, or use the “TB Synth” patch in the Monosynth category of the Reason 
Essentials Factory Sound Bank. 

D If you use an Init patch, it is important that you make the following settings:

• Set Polyphony to “1”.

• Switch Trigger Mode to “Legato”.

• Set Portamento to a value around “50”.

5. Create a pattern in Matrix, and keep it playing back.

D If “Tie” (see “Using Tied Notes”) now is activated for a step, the note will be tied to the next and the pitch will 
continuously “glide” to the pitch of the following step.
Please note that Tie should be activated on the note you wish to slide from, and not the note you slide to.

D If you have several tied notes, one after the other, they will play as one long legato phrase. This can be used to 
create “wavy” lead lines with pitch bend effects.

6. Experiment with different Note, Tie and Gate values.
If you have ever used a TB-303 or ReBirth, you should now begin to get the hang of how you can create patterns 
in that particular style by using the Matrix together with a synthesizer.

q Adding a DDL-1 (delay), and a Scream 4 (distortion) effect device will make it sound even more “ReBirth”-like, 
but of course you are also able to get a much wider range of timbres by utilizing Reason Essentials’ other 
sound and modulation capabilities.

Triggering samples
The Gate CV output can be used to trigger samples, either in Redrum or in the NN-XT Sampler.

D Connect the Matrix Gate CV out to the Gate (Sequencer Control) in on the NN-XT or to one of the individual 
Gate Channel inputs of Redrum.
Gate values will now trigger the sample on each step with Gate values above “0”.



Chapter 37
Menu and Dialog 
Reference
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Reason Essentials menu (Mac OS X)
About Reason Essentials...

This menu item opens up a dialog that informs you about the version of the program and the people behind it.

Manage Authorizations

This menu item launches the Authorizer, which is needed for communication with the Ignition Key. Clicking the 
“Launch Browser” button will launch your default web browser and bring you to the Propellerhead account web page. 
From this web page, you can log in and manage your Authorizations.

Preferences...

This menu item opens up the Preferences dialog. See “Preferences – General”, “Preferences – Audio”, “Preferences 
– Control Surfaces”, “Preferences – Advanced”, “Preferences - Keyboard” and “Preferences - Language (Windows)” 
for detailed descriptions about the functions and settings in this dialog.

Services

The Reason Essentials menu contains the standard Mac OS X Services item. Please consult the Macintosh Help for 
descriptions about these.

Show/Hide

These are the standard Mac OS X Hide/Show options which lets you choose what to view.

Quit Reason Essentials

This allows you to quit the program. If there are any documents open with unsaved changes you will be asked 
whether you want to save those changes before quitting.
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File menu
New

When you select this, a new song appears. The exact contents of this song is determined by your Preferences set-
tings (see “Default Song”).

New from Template

On the sub-menu you can create a new song based on the selected Template Song. The selected Template Song 
appears in a new document window. 

On Windows platforms, the document will be named “Document n” where “n” is an incremental number. 

On Mac OS X platforms, the document will be named “untitled n” where “n” is an incremental number. 

You can then save your song with a new name. See “Creating a new Song from a template” for more details.

Open...

! The “Open...” item is only available if you run Reason Essentials in Authorized Mode (see “Registering and au-
thorizing Reason Essentials”).

To open a Song, proceed as follows:
1. Pull down the File menu and select Open.

The Reason Essentials song browser window appears.

2. Use the browser to navigate to the desired folder on disk or within a ReFill.

3. When you have located the song file, select it and click Open (or double click on the file).
The song appears in its own document window.

q You can have several songs open at the same time if you like. This allows you to copy and paste audio, note 
and automation clips, tracks, devices, mixer channels and patches between songs. However, all open songs 
consume some memory and performance, so you may want to close songs you don’t need.

See “Opening a Reason Essentials Song” for more details.

Open Demo Song

! The “Open Demo Song” item replaces the “Open...” item if you run Reason Essentials in Demo Mode (see 
“Running Reason Essentials in demo mode”).

D Choose the Demo Song to open by selecting it from the sub-menu that appears.
The song appears in its own document window.

See “Opening a Reason Essentials Demo Song” for more information.

Close

D Select “Close” to close the active window.
If the window is a song document window and has unsaved changes, you will be asked whether you want to save 
those changes.

Closing the last open song document window will quit Reason Essentials (Windows only).
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Save

This saves the active song document to disk.

• If the song document hasn’t yet been saved, the “Save As” dialog appears, requesting you to enter a file name 
and specify a location for the file on disk (see “Save As...”).

• If the document has already been saved at least once, the document will simply be saved without any ques-
tions.

Save As...

This saves the active song document to disc. A standard Save As dialog appears requesting you to enter a file name 
and specify a location for the file on disk. The “Save As” command will also automatically optimize the song file size 
when applicable (see “Save and Optimize”).

q You can also set things up so that any samples used in the song are included in the song file itself by specify-
ing self-contained settings (see “About Self-Contained Songs”).

Save and Optimize

When you record audio in the sequencer, the recordings are stored in your song document. If you remove recordings 
in your song, there might be “empty” areas left in the document, similar to a fragmented hard disk. To “defragment” 
the song document, and thus reduce the file size, you can use the “Save and Optimize” command. 

See “Saving and optimizing a Song” for more details.

Song Information...

This brings up a dialog that allows you to add contact information and comments etc. about your song.

See “Including Song Information” for information.

Song Self-contain Settings...

If you want to open your song on another computer, or send it to another Reason Essentials user, you would also 
have to bring all samples and REX files used by the devices in the Song. To make this easier, Reason Essentials al-
lows you to create “self-contained” songs. A self-contained song contains not only the references to the used sam-
ples and REX files, but also the files themselves. By selecting the “Song Self-Contain Settings”, you can choose what 
files to include in your song.

See “About Self-Contained Songs” for more information.

Import Audio File...

Selecting “Import Audio File...” brings up the Import Audio File dialog. In this dialog you can select WAV, AIFF or REX 
files to import to audio tracks in Reason Essentials.

See “Importing audio to the sequencer” for more information.

Import MIDI File...

Reason Essentials can import standard MIDI files (SMF). This allows you to import MIDI data to Reason Essentials 
from other applications. Selecting “Import MIDI Files...” brings up the MIDI File Browser dialog from which you can se-
lect MIDI files to import to instrument tracks in Reason Essentials.

See “Importing Standard MIDI Files” for more information.
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Export MIDI File...

Reason Essentials can export standard MIDI files (SMF). Selecting “Export MIDI Files...” brings up the Export MIDI File 
dialog from which you can export all instrument tracks and automation tracks from the Reason Essentials sequencer 
as a Standard MIDI File (SMF).

See “Exporting Standard MIDI Files” for more information.

Export Insert FX Patch...

This item is available for a selected Audio Track device, Mix Channel device or their corresponding channel strips in 
the Main Mixer. Selecting “Export Insert FX Patch” brings up the Save Insert FX Patch dialog from which you can 
save the Insert FX patch used in the selected Audio Track/Mix Channel device as a Combinator (*.cmb) Patch File.

Save Device Patch As...

This item is available for a selected device that can save patches. The menu item name reflects the type of device se-
lected (for example “Save Combinator Patch As...”).

Even though the device settings are stored in the song, you may want to save any settings you have made for a de-
vice as a separate patch file. This allows you to use the patch in other songs, and lets you try out other patches in your 
song without risking to lose your original sound.

• The different types of patch files have different file extensions.
These are:

“.cmb” (Combinator patch files)

“.zyp” (Subtractor patch files)

“.sxt” (NN-XT patch files)

“.drp” (Redrum patch files)

“.drex (Dr. Octo Rex patch files)

“.rv7” (RV7000 patch files)

“.sm4” (Scream 4 patch files)

“.l6t” (Line 6 Amp Tone)

• If you have selected a patch, modified it and want to save it with the modifications, you could either save a sep-
arate, modified version of the patch (with a new name) or simply overwrite the old patch file on disk.
As usual, you will be asked whether you really want to replace the existing patch file.

q You can also save a patch by clicking the floppy disk button on the device panel.

q You can save a patch under the same name and location (without having the save dialog appear) by holding 
down [Alt](Win) or [Option](Mac) and clicking the floppy disk button on the device panel. Note that this over-
writes the original patch!

Export Song/Loop as Audio File...

When you have created a complete song, you will want to mix it down to a WAV or AIFF audio file to make it playable 
for other people (who don’t use Reason Essentials). You can either export the whole song, or only the loop (the re-
gion between the left and right locator in the sequencer).

See “Exporting Songs or parts of Songs” for more information.
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Bounce Mixer Channels...

Bouncing Mixer Channels basically means “recording” the audio outputs from individual Audio Track Channels and/
or Mix Channels to audio files. The audio files can then be saved to disk or placed on new Audio Tracks in your song.

See “Bouncing Mixer Channels” for information on how to bounce mixer channels.

Export REX as MIDI File...

This item is only available if a Dr. Octo Rex device is selected in the rack. If you have loaded a REX file into a Dr. Octo 
Rex device and wish to play back the loop via MIDI (typically from another sequencer), proceed as follows:
1. Select the Dr. Octo Rex device in the rack.

2. Select “Export REX as MIDI File...” from the File menu.

3. Save the MIDI File to disk.

4. In the other application, open the MIDI file you just created.

5. Set up the other application to play back the MIDI File on the correct MIDI Output and MIDI Channel (the out-
put and channel on which the Dr. Octo Rex device receives data).

Exit (Windows)

This allows you to quit and exit the program. If there are any song documents open with unsaved changes you will be 
asked whether you want to save those changes before quitting.



MENU AND DIALOG REFERENCE 687

Edit menu
Undo

Virtually any actions in Reason Essentials can be undone. This includes creation, deletion and reordering of devices 
in the rack, parameter value adjustments, recording and editing in the sequencer and tempo/time signature adjust-
ments. You can undo up to 30 actions.

! Sequencer Transport commands are not “undoable”.

D To undo the latest action, select “Undo” from the Edit menu or hold [Ctrl](Win) or [Cmd](Mac) and press [Z].
The action to be undone is indicated next to the Undo command on the Edit menu. For example, if your latest ac-
tion was to delete some device(s) from the rack, the Edit menu will say “Undo Delete Devices”.

See “Undo and Redo” for more detailed information.

Redo

D To redo an undone action (“undo the undo operation”), select “Redo” from the Edit menu or hold [Ctrl](Win) or 
[Cmd](Mac) or and press [Y].
The action to be redone is indicated next to the Redo command on the Edit menu. You can undo/redo up to 30 
actions.

See “Undo and Redo” for more detailed information.

Cut/Cut Tracks and Devices/Cut Channels and Tracks

This command takes the selected item(s), removes them and places them on the clipboard (an invisible storage loca-
tion) from where they can later be pasted in.

Cutting applies to devices/channels and their sequencer tracks, sequencer clips, notes and automation points.

! If “Auto-group Devices and Tracks” is selected in the Options menu, all devices in the Device Group will be cut 
- see “About Device Groups”.

Copy/Copy Tracks and Devices/Copy Channels and Tracks/Copy Patch

This command takes the selected item(s), copies them and places the copies on the clipboard (an invisible storage 
location) from where they can later be pasted in.

Copying applies to devices/channels and their sequencer tracks, sequencer clips, notes, automation points and de-
vice patches. Also individual Kong Drum patches can be copied and pasted from one selected pad to another.

! If “Auto-group Devices and Tracks” is selected in the Options menu, all devices in the Device Group will be 
copied - see “About Device Groups”

Paste/Paste Tracks and Devices/Paste Channels and Tracks/Paste Patch

This command takes the items that you have cut or copied to the clipboard and pastes them back into the document.

• When you paste a sequencer track, its device will be pasted at the same time (and vice versa, if the device has 
a track).
Pasted tracks and devices are inserted below the currently selected track in the track list and below the selected 
device in the rack, respectively.

! If “Auto-group Devices and Tracks” is selected in the Options menu, all devices in the Device Group will be 
pasted - see “About Device Groups”.

If nothing is selected, the pasted items will appear at the bottom of the track list/rack.



MENU AND DIALOG REFERENCE688

• If you copy and paste several devices, the connections between these are preserved.

D If you hold down [Shift] when you paste a device, Reason Essentials will attempt to auto-route it.
For example, [Shift]-pasting an instrument device typically connects it to the first free Mix Channel device input(s) 
above it in the rack.

D You can also paste the device(s), channel(s) and track(s) into another song, including all sequencer data and 
device settings.

• When you paste sequencer clips, they appear at the song position, on their original track(s).
If you have deleted the original tracks, or if you paste into another Reason Essentials song document, the clip will 
be pasted at the song position on the selected track (if the track type is the same as the original). Otherwise new 
tracks will be created. If the clip is a note clip, a new ID8 instrument track will be created.

• Notes or automation points will be pasted at the song position on the selected track (if the track types are 
compatible).

Delete/Delete Tracks and Devices/Delete Channels and Tracks

This menu item is used for deleting selected items. If you delete a sequencer track with this menu item (then called 
“Delete Tracks and Devices”), its device is also deleted.

! If “Auto-group Devices and Tracks” is selected in the Options menu, an alert appears asking you if you want to 
delete only the selected device or the entire Device Group - see “About Device Groups”.

Delete Tracks

This deletes the currently selected sequencer track(s) without removing the corresponding rack device(s) or mixer 
channels.

Duplicate Tracks and Devices/Duplicate Channels and Tracks

This creates a duplicate of the selected device and track, or channel and track, complete with all parameters and re-
cordings/events. The duplicated items will appear below the selected device and track, respectively.

! If “Auto-group Devices and Tracks” is selected in the Options menu, all devices in the Device Group will be du-
plicated - see “About Device Groups”.

Select All/Select All Devices/Select All Tracks/Select All Channels

This selects all devices in the rack, all tracks in the track list, all channels in the Main Mixer, or all clips or all notes or 
automation points in an open clip. The result depends on which area (rack, track list, Main Mixer etc.) has focus. This 
is indicated by a thin frame around an area in the document window. 

D To set focus to the desired area, click somewhere in it.

You can use this menu item to quickly apply a command to all items you are working on, for example deleting all de-
vices in the rack (select Select All Devices and then press [Delete]) or for Quantizing all notes in an open clip (select 
Select All and then click the Quantize button in the Tool window).

Select All in Device Group

This will select all devices within the selected device’s Device Group. See “About selecting all devices in a Device 
Group”.
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Sort Selected Device Groups

This function should be used if you want to rearrange devices, channel strips or sequencer tracks according to the or-
der of the current selection. For example, if you want to rearrange the rack devices according to the current se-
quencer track order, you can select all sequencer tracks and then choose “Sort Selected Device Groups” to rearrange 
the rack devices. See “About the “Sort Selected Device Groups” function” for more examples.

Auto-route Device

Auto-routing is when devices’ audio and CV/gate connections are automatically routed according to default rules. 
Auto-routing is normally performed when:

• A new device is created.

• Moving, duplicating or pasting devices with [Shift] pressed.

However, if a device is already in the rack, you can “force” it to be auto-routed by selecting it and then select this 
menu item.

For more information about auto-routing rules, see “Automatic routing”.

Disconnect Device

This disconnects all audio and CV/gate connections from the selected device(s).

Combine/Uncombine

D By selecting several devices in the rack and selecting “Combine”, a Combinator device will be created contain-
ing the selected devices.

D By selecting the Combinator (or one or several devices contained in a Combinator) and then selecting “Un-
combine” will remove the devices from the Combinator and into the rack.
In case the whole Combinator is selected, this will be removed and the devices it contains will be moved into the 
rack.

See “The Combinator” for more details.

Copy/Paste Channel Settings (Main Mixer channel strips)

This function allows you to copy and paste the parameters of different sections of a Main Mixer channel strip and 
paste into another channel strip. The available parameter groups are:

• EQ

• Insert FX
This will copy the entire Effect Combi patch (with all Combinator devices included)

• FX Sends
This will only copy the FX Send parameters in the channel strip - not any FX devices or patches.

• All
This will copy all channel strip parameters, including any Insert FX devices.

Clear Insert FX

This disconnects and removes all Insert FX devices of a selected Mix Channel or Audio Track device in the rack, or 
of a selected channel in the Main Mixer. See “Deleting Insert effects” for more details.
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Reset All Channel Settings (Main Mixer channel strips)

This will reset all channel strip parameters to their default values. Any Insert FX Combinator patches will be removed.

Initialize Patch

Sometimes it is useful to start with a “clean slate” when creating a synth sound, a drum kit or a sampler patch. This is 
done by selecting Initialize Patch from the device context menu or Edit menu. This sets all parameters to “standard” 
values. Initializing NN-XT or Redrum devices will also remove samples from the device, allowing you to start from 
scratch.

Cut Pattern

Moves the current pattern in the selected Redrum or Matrix to the clipboard. The pattern is then cleared.

Copy Pattern

Copies the current pattern in the selected Redrum or Matrix to the clipboard.

Paste Pattern

Copies the pattern on the clipboard to the current pattern location in the selected Redrum or Matrix device. This over-
writes the current pattern with the one on the clipboard. Note that this can be used to transfer patterns between dif-
ferent Reason Essentials songs.

Clear Pattern

This menu item clears (empties) the current pattern on the selected pattern device (Redrum or Matrix).

Browse Patches.../Browse Insert FX Patches...

This menu item allows you to select a new Patch for a device or an Insert FX Patch for a selected channel strip. The 
menu item reflects which device is selected - in other words, you must select the device for the corresponding 
Browse Patches item to appear on the Edit menu.

When you select the menu item, the Browser dialog appears, allowing you to locate and select the patch, on disk or 
within a ReFill.

When you select a patch, the device’s parameters will be set according to the values stored in the patch, and the 
name of the patch will be shown in the patch name display. As with any change you make, this operation can be un-
done.

! Any parameter adjustments you make on the device panel after selecting a patch will not affect the actual 
patch file (for this you need to re-save the patch).

• If referenced samples are missing
Patches for the Redrum, Combinator (if any sampler devices are part of the Combi), NN-XT and Dr. Octo Rex de-
vices contain references to samples. Just like patches, samples can be independent files on the hard disk or ele-
ments within a ReFill or a SoundFont. However, if sample files have been moved or renamed after a patch was 
saved, the sample file references in the patch will not be accurate.

If this is the case when you select a patch, the program will tell you so. You can then choose to either manually lo-
cate the missing files, to have the program search for them in all stored locations and ReFills or to proceed without 
the missing sounds.
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Browse Loops...

This menu item is used to add a loop to the selected Dr. Octo Rex Loop Slot. Files to be imported can be in REX, RCY 
or RX2 file format. 

Loading a new REX file will replace any currently loaded file in the selected Loop Slot.

Browse Samples...

This menu item lets you load samples into the devices that use them; Redrum and NN-XT. The following sample for-
mats can be loaded:

• Wave (.wav)
This is the standard audio format for the PC platform.

• AIFF (.aif)
This is the standard audio format for the Mac platform.

• SoundFont samples (.sf2)
This is an open standard format for wavetable synthesized audio, developed by E-mu systems and Creative Tech-
nologies.

• REX file slices (.rx2, .rex, .rcy)
REX files are music loops created in the ReCycle program. This program “slices” up loops into multiple samples. 
These samples - or slices - can be loaded into the devices mentioned.

Redrum:

To use this menu item to load a new drum sound into Redrum, proceed as follows:
1. Select a channel in the drum machine, by clicking its Select button.

2. Select Browse Samples.
The Redrum sample browser opens.

3. Navigate to a location containing any of the sample formats listed above, select one and click Open.

NN-XT:

This menu item is used for adding one or more sample(s) to a key zone in the NN-XT:
1. Make sure the Remote Editor panel is folded out, by clicking the small arrow in the bottom left corner.

If the remote editor panel is folded in, you will only be able to browse for NN-XT patches.

2. Use the sample browser to add one or several sample(s).
The sample(s) will be placed in separate zones and mapped across the same key range.

D If a zone is selected when you browse for samples, the sample will be loaded into that zone, replacing any pre-
vious sample. 
Replacing samples this way is only possible when you load a single sample.

Delete Sample/Remove Sample

Redrum:

D To remove a sample from a Redrum drum machine, select its drum sound channel and then select “Delete 
Sample” from the Edit menu.
The sample is removed from the drum sound channel and from sample memory.
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NN-XT:

D To remove a sample from an NN-XT Sampler’s memory, select the zone it belongs to, and then select “Remove 
Samples” from the Edit menu.
The sample is removed from the zone and from sample memory. The zone still remains though. To delete a zone, 
you must use the option “Delete Zones”.

Reload Samples

This menu item is used with the NN-XT sampler. When you select this, any changes you have made on a loaded sam-
ple using the sample parameters (root key, loop settings, etc.) are immediately undone, and the settings revert back 
to the original.

Add Zone

This menu item is used with the NN-XT sampler. It is used for adding an empty zone to the key map. An empty zone 
can be resized, moved and edited in the same way as zones that contain samples.

An empty zone is indicated with the text “**No Sample**”. After you have added an empty zone, you can assign a sam-
ple to it.

Copy Zones

This menu item is used with the NN-XT sampler. It copies the selected zone(s), and all of its settings - including ref-
erences to any sample it may contain - and places it in the clipboard buffer. You can then select “Paste Zones” to cre-
ate a new zone that is an exact replica of the copied zone(s). Note that copying/pasting zones can also be performed 
between separate NN-XT devices.

Paste Zones

This menu item is used with the NN-XT sampler. If you have used the “Copy Zones” command, with any number of 
selected zones, you can create exact duplicates of these by using the “Paste Zones” command. The pasted zones will 
then be added below any existing zones in the key map.

Duplicate Zones

This menu item is used with the NN-XT sampler. It lets you duplicate any number of already existing zones (contain-
ing samples or empty).
1. Select the zone(s) you want to copy.

2. Select “Duplicate Zones”.
The selected zones will now be copied and automatically inserted below the last one in the key map display. 

The duplicated zones will contain references to the same samples as the original zones. They will also have the exact 
same key ranges and parameter settings.

Delete Zones

This menu item is used with the NN-XT sampler. Selecting this option will remove both the selected zones, and any 
samples they may contain.

Select All Zones

This menu item is used with the NN-XT sampler. This option will automatically select all zones in a key map.
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Copy Parameters to Selected Zones

This menu item is used with the NN-XT sampler. It lets you easily copy parameter settings from one zone to any num-
ber of other zones. Proceed as follows:
1. Select all the zones you want to involve in the operation.

By this we mean the zone with the settings you wish to copy, and the zone(s) to which you want to copy the set-
tings.

2. Make sure the zone that contains the settings you want to copy has edit focus by clicking on it.
Focus is indicated by a thick border.

3. Select “Copy Parameters to Selected Zones”.
All the selected zones will now get the exact same parameter settings.

! Observe that this only applies to the synth parameters (LFOs, envelopes etc.). Sample parameters (root key, 
velocity range etc.) can not be copied.

Sort Zones by Note

This menu item is used with the NN-XT sampler. This option lets you automatically sort the selected zones within a 
Group in descending order according to their key ranges. When you invoke this option, the selected zones will be 
sorted from top to bottom in the display starting with the one with the lowest range. If two or more zones have the 
same key range, they are instead sorted by velocity range.

Sort Zones by Velocity

This menu item is used with the NN-XT sampler. This option lets you automatically sort the selected zones within a 
Group in descending order according to their set low or high velocity values.

When you invoke this option, the selected zones will be sorted from top to bottom starting with the one with the high-
est “Lo Vel “value.

If two or more zones have the same velocity range, they are instead sorted by key range.

Group Selected Zones

This menu item is used with the NN-XT sampler. It lets you put any number of selected zones together in a group.

Grouping zones is good for two things:

D To allow you to quickly select a number of zones that “belong together.”
For example if you have created a layered sound consisting of piano and strings, you could put all string samples 
in one group and all piano samples in one group. Then you can quickly select all piano samples and make an ad-
justment to them by trimming a parameter.

D To group zones that need to share group settings together.
For example, you may want to set a group to legato and monophonic mode and add some portamento so that you 
can play a part where you slide between notes.

Proceed as follows:
1. Select the zones you want to group together.

The zones don’t have to be contiguous in order to be grouped. Regardless of their original positions in the samples 
column, they will all be put together in succession.

2. Select “Group Selected Zones”.
The zones are grouped.

Note that there is always at least one group, since the zones you create are always grouped together by default.
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Set Root Notes from Pitch Detection

This menu item is used with the NN-XT sampler. All instrument sounds have an inherent pitch. When playing a sam-
ple of such a sound on the keyboard, the keys you play must correspond to that pitch. For example, you may have re-
corded a piano playing the key “C3”. When you map this onto the NN-XT key map, you must set things up so that the 
sampler plays back the sample at original pitch when you press the key C3, and this is done by adjusting the root 
note.

The NN-XT features a pitch detection function to help you set the root keys of loaded samples. This is useful if you 
for example load a sample that you haven’t recorded yourself, and you don’t have any information about its original 
pitch.

Proceed as follows:
1. Select all the zones you want to be subject to pitch detection.

2. Select “Set Root Notes from Pitch Detection”.
The samples in all the selected zones will now be analyzed, and the detected root keys will automatically be set for 
you.

! Note that for this to work properly, the samples must have some form of perceivable pitch. If it is sampled 
speech, or a snare drum for example, it probably doesn’t have any discernible pitch.

Automap Zones

This menu item is used with the NN-XT sampler. The automap function can be used as a quick way of creating a key 
map, or as a good starting point for further adjustments of a key map.

Automap works under the assumption that you intend to create a key map for a complete instrument, for example a 
number of samples of a piano, all at different pitches.
1. Load the samples you want to Automap.

Now you have three options:

D Trust that the root note information in the files is already correct.

D Manually adjust the root notes (and tuning) for all the samples.

D Use “Set Root Notes from Pitch Detection” to automatically set up the root notes.

2. Select all zones you want to automap.

3. Select Automap Zones.

All the selected zones will now be arranged automatically in the following way:

D The zones will be sorted in the display (from top to bottom - lowest key first) according to the root keys.

D The zones will be assigned key ranges according to the root keys.
The key ranges are set up so that the split between two zones is exactly in the middle between the zones’ root 
notes. If two zones have the same root key they will be assigned the same key range.

Automap Zones Chromatically

This menu item is used with the NN-XT sampler. It will map the selected zones chromatically (one zone per semitone) 
from C2 and up. This is useful if you are mapping non-pitched material (e.g. drum or percussion samples) and want 
one sample per key. Before you select Automap Zones Chromatically, you may want to adjust the order of the zones, 
since this determines which zone is mapped to which key.
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Create Velocity Crossfades

This menu item is used with the NN-XT sampler. This is used for automatically setting up velocity crossfades for 
smooth transitions between overlapping zones. To set up crossfades, you adjust the fade out and fade in values for 
the overlapping zones.

An example:

D Two zones are both set to play in the full velocity range of 1-127.

D Zone 1 has a fade out value of 40.
This means that this zone will play at full level with velocity values below 40, With higher velocity values, it will grad-
ually fade out.

D Zone 2 has a fade in value of 80.
This has the effect that as you play velocity values up to 80, this zone will gradually fade in. With velocity values 
above 80, it will play at full level.

Instead of manually setting up a crossfade, you can let NN-XT do it for you. Proceed as follows:
1. Set up the zones so that their velocity ranges overlap, as desired.

2. Select the zones.
You can select as many zones as you wish, not just one pair of overlapping zones.

3. Select “Create Velocity Crossfades”.
NN-XT will analyze the overlapping zones and automatically set up what it deems to be appropriate fade in and 
fade out values for the zones.

Note the following important points:

D This operation will not work if both zones have full velocity ranges.
At least one of the zones must have a partial velocity range (see page 274).

D This operation will not work if the zones are completely overlapping.

Copy Loop to Track

This menu item is used for the Dr. Octo Rex loop player device. To be able to make your REX loop start at the same 
time as other sequencer or pattern data, you “convert” the slices in the loop to note clips in the sequencer:
1. Select the sequencer track for the Dr.Rex device.

2. Set the locators to encompass the section you want to fill with REX clips.
You may want to make sure that this area doesn’t contain any note clips already, to avoid overlapping clips.

3. Select desired Loop Slot in the Dr. Octo Rex player.

4. Pull down the Edit menu and select “Copy Loop to Track”.
Now, the program will create a note for each slice, positioned according to the timing of the slices. The notes will 
be laid out in semitone steps, with the first note on C1, the second on C#1 and so on, with one semitone for each 
slice. If the range between the locators is longer than the loop length, the loop notes will be repeated to fill out the 
loop.

Now you can reorder, overdub onto, and otherwise edit the note data on the edit lanes in the sequencer.
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Copy Pattern to Track

This menu item is used for the Redrum drum machine and Matrix pattern sequencer. It converts the selected pattern 
to notes on a sequencer track. Proceed as follows:
1. Select a sequencer track.

When working with a Redrum, you want to select the track for the Redrum device. For the Matrix, you would typi-
cally select the track for the Matrix’ target device (the instrument device to which the Matrix is connected). This is 
because the Matrix itself produces no sound, so the notes won’t do any good on the Matrix track.

2. Set the locators to the desired range or length.
If the range set is longer than the pattern(s), the data will be repeated to fit the range.

3. Select the pattern device.

4. Pull down the Edit menu and select “Copy Pattern to Track”.
Note clips will be created between the left and right locators, according to the selected pattern.

! When copying Matrix patterns, only the Gate and Keys values will be included!

D If you copied a Redrum pattern, you may want to turn off the “Enable Pattern Section” before playing back the 
new track data.
Otherwise, both the main sequencer and the pattern sequencer will play the drum sounds, simultaneously.

D If you copied a Matrix pattern, you may want to disconnect the Matrix (or even remove it), to avoid having both 
the Matrix and the sequencer notes playing at the same time.

D If you have automated pattern changes for your pattern device, you can render all patterns to notes in one go, 
using the “Convert Pattern Track to Notes” menu item instead.
See “Convert Pattern Automation to Notes”.

Shift Pattern Left/Right

These menu items are used for Redrum and Matrix.

The Shift Pattern functions move the notes in a pattern one step to the left or right. 

Shift Drum Left/Right

These menu items are used for Redrum.

The Shift Drum functions move the notes for the selected instrument one step to the left or right.

Shift Pattern Up/Down

These menu items are used for the Matrix.

The Shift Pattern functions will transpose all the notes in a pattern one semitone up or down.

! This function does not alter the Curve CV.

Randomize Pattern

This menu item is used for the Redrum and Matrix.

The Randomize Pattern function create random patterns. These can often be great starting points and help you get 
new ideas.

! Note that for the Matrix, Randomize affects both the Gate, Note and Curve CV!
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Randomize Drum

The Randomize Drum functions creates random patterns for the selected drum sound channel in the Redrum drum 
machine.

Alter Pattern

This menu item is used for the Redrum and Matrix.

The Alter Pattern function modifies existing patterns. Note that there must be something in the pattern for the func-
tion to work on - using an Alter function on an empty pattern will not do anything.

! Note that for the Matrix, Alter affects both the Gate, Note and Curve CV!

Alter Drum

This function modifies existing patterns for the selected drum sound in Redrum. Note that there must be something 
in the pattern for that channel for the function to work - using an Alter function on an empty pattern will not do any-
thing.

Create Track for.../Delete Track for...

A rack device can have one sequencer track or no sequencer track. Instrument devices are by default created to-
gether with a sequencer track, while effect devices, mixers etc. are created without tracks.

D If a device without sequencer track is selected, this menu item is called “Create Track for [device name]”. 
Select it to create an empty sequencer track for the device.

D If the selected device has a sequencer track already, this menu item is called “Delete Track for [device name]”. 
It will remove the sequencer track and all its contents, but leave the device.

Go To Track for

D With a device selected in the rack, select “Go To Track for [device name]” to bring the corresponding se-
quencer track for the device into view.

Insert Bars Between Locators

! The sequencer must have edit focus for this item to become available.

This function inserts an empty area between the locators in the main sequencer. All events after the left locator are 
moved to the right to “make room” for the inserted area. See “Inserting bars” for more information.

Remove Bars Between Locators

! The sequencer must have edit focus for this item to become available.

This function removes all material between the locators in the main sequencer. All events after the right locator are 
moved to the left to “fill out” the gap after the removed section. See “Removing bars” for more information.

Bounce Clip to New Sample (Audio Clips)

It’s possible to bounce an Audio Clip to a new Song Sample. You could then edit the sample in the Edit Sample win-
dow and then load into a sampler device for playback. See “Bounce Clip(s) to New Sample(s)”.
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Bounce Clip to Disk (Audio Clips)

This function allows you to export a selected audio clip as a WAV or AIFF file to disk. See “The “Bounce Clip to Disk” 
function”.

Bounce Clip to New Recording (Audio Clips)

This function allows you to export the recording of a selected audio clip to an additional Comp Row. See “Bounce 
Clip(s) to New Recording(s)”.

Enable/Disable Stretch (Audio Clips)

This function lets you decide if a selected audio clip should stretch and follow tempo changes in the song. When dis-
abled, the audio clip doesn’t follow the song tempo. When enabled, the audio clip is stretched and follows the song 
tempo of the sequencer. See “About tempo changes and tempo automation of audio tracks”.

Delete Unused Recordings (Audio Clips)

This function deletes all recordings that are not used in the selected clip - or anywhere else in the song. By using this 
function, the file size of the song can be reduced. See “Delete Unused Recordings”.

Heal Clip Safe Clips (Audio Clips)

This function heals all selected audio clips that are affected by the Clip Safe function in Propellerhead Balance. See 
“Recording using the Clip Safe function in Propellerhead Balance”.

! This function is only available when recording audio using the Propellerhead Balance audio interface!

Delete Clip Safe Audio (Audio Clips)

This function deletes the Clip Safe signal from selected audio clips. The clips revert to being ordinary clips (no clipped 
waveform indication, and no healing button). See “Recording using the Clip Safe function in Propellerhead Balance”.

! This function is only available when recording audio using the Propellerhead Balance audio interface!

Normalize Clips (Audio Clips)

This function increases the overall audio level of selected Audio Clip(s) so that the loudest peak touches 0 dB. See 
“Normalizing Clips”.

Reverse Clips (Audio Clips)

This function reverses selected Audio Clip(s) and plays them back backwards, from the end to the start. See “Revers-
ing Clips”.

Convert Pattern Automation to Notes

If you have recorded or drawn pattern changes on a Redrum or Matrix track, you can have the whole track converted 
to notes:
1. Select the track with the pattern changes.

2. Select “Convert Pattern Automation to Notes” from the Edit menu or the context menu for the track.
For each pattern clip, the corresponding pattern is converted to note clips on the track (following the same rules as 
for the “Copy Pattern to Track” function). The track will play back just the same as when you played the pattern de-
vice with the pattern changes.
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D After the operation, the Pattern Select lane is switched off.
“Enable Pattern Section” (Redrum) and the Pattern Enable switch (Matrix) are automatically turned off.

D When you use this with a Matrix, you need to move the note clips to the track of an instrument device (typically 
the device to which the Matrix is connected).
This is because the Matrix doesn’t make any sound itself.

Commit to Groove

This function is available if the track list has focus and one or several note lanes on the selected track have ReGroove 
Mixer channels assigned. 

Commit to Groove will move all notes (on all note lanes on the selected track) to their grooved positions and then re-
set the groove settings to “No Channel” for the note lanes. In other words, this makes the groove “permanent” - the 
track will play back exactly as before, but you can now view and edit the grooved notes.

Parameter Automation...

The parameter automation dialog allows you to add or remove automation lanes for the selected sequencer track.

D The checkboxes to the left determine if a lane is shown or not.
To add a lane, activate its checkbox.

D The Automated column indicates if there is automation data (clips) on the lane.
If you deactivate the checkbox for an automated parameter, this will delete the automation data. This is indicated 
by the automation symbol with the trash can.

D If the “Show Frequently Used Only” checkbox is activated, only the more common automation parameters are 
listed.
To see all parameters, deactivate the checkbox.

New Note Lane

Adds a new note lane to the selected track(s). This is the same as clicking the “+ Lanes” button above the track list.
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Merge Note Lanes on Tracks

If there is more than one note lane on the selected track, this menu item will merge all note clips on all lanes into a 
single lane.

D If there are several clips containing the same performance controllers (e.g. mod wheel) on the same positions 
in the song, only the performance controller data from the topmost lane will be kept.
This is the same rule as during playback - performance control data in the topmost lane has priority.

Get Groove From Clip

This requires that a single note clip is selected. The function will look at the notes in the clip and extract a groove 
from these. You can apply this groove to other note lanes or save it as a groove patch for later use.
1. Create or record a rhythmic note “pattern” of some kind.

You may for example record a drum pattern, or use the notes playing the slices in a REX loop. 

q For the groove to be useful in most common music styles, it’s recommended that the note clip is an exact num-
ber of bars in length - preferably 1, 2, 4 or maybe 8 bars.

2. Open the ReGroove Mixer from the transport panel and select a channel for editing (by clicking its Edit button).
This is where your custom groove will end up - choose an unused channel if you don’t specifically want to replace 
a groove.

3. With the note clip selected, select “Get Groove From Clip” from the Edit menu or sequencer context menu.
The groove is assigned to the ReGroove Mixer channel as “User”. By selecting that ReGroove Mixer channel for 
other note lanes, you can make the music fit with your custom groove.

4. Select the Groove tab in the Tool window.
Here you can adjust how the groove should affect note timing, velocity and length and also save the groove as a 
ReGroove Patch (including the settings of the sliders in the window).

Read more in “The ReGroove Mixer”.

Join Clips

This requires that more than one clip is selected on the same lane. Join Clips will join the selected clips together.

! If note or automation clips contain masked-out events in the range between the clips, these events will be de-
leted. Also, if note or automation clips overlap, any hidden events are deleted - see “Joining clips”.

• If joined audio clips contain masked recordings, these will not be deleted but moved and masked on a new 
Comp Row - see “About joining audio clips”.

Mute Clips/Unmute Clips

If there are one or several unmuted clips selected, this menu item is called “Mute Clips”. Muted clips (shown with an-
gled stripes and dimmed borders) will not play back but can be edited and arranged as usual.

If only muted clips are selected, the menu item is called “Unmute Clips”. The keyboard shortcut for Mute/Unmute 
Clips is [M].

Crop Events to Clips

Notes or automation events can be positioned outside the start or end of a clip. For example, this would happen if you 
have resized a clip after recording. Notes outside the clip become masked and won’t be heard on playback, but you 
can view and edit them if you open the clip.

Selecting “Crop Events To Clips” removes all such outside events from the selected clip(s). If tracks are selected in 
the track list, this function is performed on all clips on the selected track(s). See “About masked recordings and 
events” for more details.
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Add Labels to Clips/Remove Labels from Clips

This allows you to name the selected clips.

D Clips with name labels (and their lanes) are shown slightly taller, to make room for the labels.

D If you select “Add Labels to Clips” with a single clip selected, this adds an “untitled” label and opens a text box 
for editing the label.
If you have several clips selected, the “untitled” label will be added to all selected clips. To edit the names of the 
clips, you need to double click each label.

D If all selected clips have labels already, the menu item is called “Remove Labels from Clips”.

See “Naming clips” for more information.

Clip Color

Allows you to select a color for the selected clip(s). See “Coloring clips” for more details.

Track Color

Allows you to select a color for the selected track(s). The selected color is shown in the track list and will be assigned 
to all new clips you create on the track. However, clips that are already on the track will not be affected - to change 
color of existing clips, select the clips and use the “Clip Color” setting.

q If “Auto-color New Sequencer Tracks” is activated on the Options menu, tracks will get colors assigned auto-
matically when they are created.

See “Coloring tracks”.

Adjust Alien Clips to Lane

If an automation clip has been moved to a lane for a parameter with a different range (for example if you cross-
browse to another device type), it will be shown as alien and won’t play back.

Depending on the data, you may be able to fix this by selecting the clip and selecting “Adjust Alien Clips to Lane”. 
This scales the automation data in the clip to fit the range of the current lane.

! If it’s not possible to scale the data, an alert will appear to tell you this.

See “About alien clips” for more information.

Quantize Notes

In Reason Essentials, you use the Quantize function in the following way:
1. Select the notes you want to quantize.

You can select notes inside an open note clips, or one or several closed note clips (to quantize all notes within the 
clips). Selecting one or several tracks will quantize all notes in all clips on all note lanes on these tracks.

2. Bring up the Tool window and select the Sequencer Tools tab.

3. Set the quantize value (the Value pop-up menu in the Quantize section).
This determines to which note values the notes will be moved when you quantize. For example, if you select 1/16, 
all notes will be moved to (or closer to) the closest sixteenth note position.

4. Select a value from the Amount pop-up menu.
This is a percentage, governing how much each note should be moved. If you select 100%, notes will be moved all 
the way to the closest Quantize value positions; if you select 50%, notes will be moved half-way, etc.
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5. If you like, you can make the quantization less exact by adding a Random value.
This is a random deviation range in ticks. If this is set to 10, the quantized notes will be randomly distributed in a 
range of +/- 10 ticks around the quantize value grid.

6. Click the Apply button, select “Quantize Notes” from the Edit menu or hold down [Ctrl](Win) or [Cmd](Mac) 
and press [K].
The notes are quantized.

Edit Keyboard Control Mapping...

This menu command is available when Keyboard Control Edit Mode is selected. It will open a dialog where you can 
assign a Keyboard Control for a selected parameter. See “Editing Keyboard Control” for more information.

Clear Keyboard Control Mapping

This menu command is available when Keyboard Control Edit Mode is selected. It will remove the Keyboard Control 
mapping for a selected assigned parameter. See “Editing Keyboard Control” for more information.

Clear All Keyboard Control Mappings for Device

This menu command is available when Keyboard Control Edit Mode is selected. It removes all keyboard mapping you 
have set up for the selected device. See “Editing Keyboard Control” for more information.

Edit Remote Override Mapping...

This menu command is available when Remote Override Edit Mode has been activated on the Options menu. It opens 
a dialog where you can assign a Remote Override for the selected parameter. See “Remote Override mapping”.

Clear Remote Override Mapping

This menu command is available when Remote Override Edit Mode has been activated on the Options menu. It will 
remove the Remote Override mapping for a selected assigned parameter. See “Remote Override mapping”.

Clear All Remote Override Mappings for Device

This menu command is available when Remote Override Edit Mode has been activated on the Options menu. It re-
moves all Remote Override mapping you have set up for the selected device. See “Remote Override mapping”.

Copy/Paste Remote Override Mappings

These menu commands are available when Remote Override Edit Mode has been activated on the Options menu. 
You can use them to copy override mappings from one device and paste them into a device of the same type.

If the device you paste into is in the same song as the device you copied from, the operation will replace the existing 
overrides. See “Remote Override mapping”.
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Preferences – General

Mouse Knob Range

This lets you adjust the response sensitivity of the various knobs in Reason Essentials when manipulating them with 
the mouse. A higher sensitivity gives a higher degree of precision. You can choose between Normal, Precise and 
Very Precise.

Automation Cleanup Level

The Automation Cleanup setting reduces the number of automation points when you record or draw automation. Ad-
just this setting if you find that recording or drawing results in too many or too few automation points.
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• This can also be done manually from the Tool window (Sequencer Tools tab) - see “The “Automation Cleanup” 
function in the Tool Window”.

Trigger Notes while Editing

When this is selected, transposing notes, by manually moving them with the Selection Tool, will make the notes trig-
ger - and sound. This is useful since you will hear when the notes reach the correct pitches.

Reduce Cable Clutter Setting

The selected alternative determines how cables on the back of the rack should be displayed when “Reduce Cable 
Clutter” is selected on the Options menu:

D Select “Show For Selected Devices Only” to only display the cables for selected devices.
All other (non-selected) devices will have “transparent” cables to make it easier to distinguish the cables of se-
lected devices.

D Select “Hide Auto-Routed Cables” to only display manually routed cables.
All devices with auto-routed cables will have “transparent” cables to make it easier to distinguish the manually 
routed cables.

D Select “Hide All Cables” to hide all auto-routed and manually routed cables.
All cable connections on devices will be indicated with colored dots in the jacks, and no cables will be displayed.

See “Cable appearance” for more details.

Cable Animation

Cables in Reason Essentials are animated in a lifelike fashion when flipping the Rack and making connections. 
Should you so wish, you can choose to disable the cable movement animation by deactivating this checkbox.

Show Parameter Value Tool Tip

Normally, if you hold the mouse pointer over a parameter on a device panel for a moment, a Tool Tip appears display-
ing the name and the current value of the parameter. If you uncheck this option, Tool Tips will not be displayed.

Show Automation Indication

If a parameter is automated in the sequencer, this is by default indicated by a green frame around the parameter on 
the device panel. If you uncheck this option, automation will not be indicated.

Default Song

It’s possible to specify a certain song document which will automatically open as a “template” each time you select 
“New” from the File menu. The Default Song could be an empty document, a song you have created earlier, or a fac-
tory made Template song. See “Setting up the Default Song” for information on how to select Default Song.

Load Last Song On Startup

Checking this automatically opens the last saved song each time you launch Reason Essentials.

D Tick the checkbox to open the last saved song the next time you launch Reason Essentials.
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CPU Usage Limit

Reason Essentials is a very powerful program which was designed to be as light on processing power as possible - 
without compromising on sound quality. Nevertheless, the more devices and audio processing functions you use in 
your song, the more of your computer’s resources it will use.

The CPU Usage Limit setting allows you to set a limit on how much of the CPU (computer processor) that should be 
used for creating audio. The remaining capacity is reserved for the user interface and the graphics.

Set this so that you feel comfortable using the program, even when a very demanding song document is played back.

Load Default Sound in New Devices

When this is activated and you create a new device (of a device type that supports patches), a default patch will be 
loaded. This way you can be sure that a new device generates sound right away. The default sound will also deter-
mine the default location in the Factory Sound Bank when you browse for patches for the new device.

If you turn this off, new devices will be initialized - parameters are reset to their default values and no samples are 
loaded in sample-based devices.

! Note that “Sound” also implies patches for effect devices such as the RV7000, the Line 6 Amps and Scream 4.

Use MultiCore Audio Rendering

Reason Essentials fully supports MultiCore Audio Rendering. This means that if your computer has multiple CPU 
cores (dual-core or quad-core, for example), or multiple CPUs, Reason Essentials takes advantage of this to signifi-
cantly enhance the performance. If your computer has a multi-core CPU, or multiple CPUs, MultiCore Audio Render-
ing is active by default.

See “Audio Basics” for more information on how Reason Essentials handles audio.

Self-contain Samples When Loading From Disk

When this is activated, any samples you load into a sampler device from disk will automatically become self-contained 
and saved together with the rest of the song data when you save your Song.
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Preferences – Audio

Master Tune

This lets you adjust the global tuning in Reason Essentials. Standard tuning is “middle A” at 440 Hz. You can adjust 
this by +/- 100 cents. The Master Tune setting affects the tuning of all sound sources in Reason Essentials, includ-
ing the Tuner function on the Audio Tracks. It also affects the tuning of the Redrum and Dr. Octo Rex loop player.

! Note that the Master Tune setting does not affect the pitch of the audio on audio tracks!

Audio Card Driver – Windows

This menu lists all the available Audio Card Drivers on your system, and lets you select which one Reason Essentials 
should use. Which option to select depends on the audio hardware:



MENU AND DIALOG REFERENCE 707

• If you are using audio hardware for which there is a specific ASIO driver, you should select this. 
With an ASIO driver written specifically for the audio hardware you will get lower latency (see below), support for 
higher sampling frequencies (up to 192 kHz in 24 bit/32 bit float resolution), and possibly better support for addi-
tional hardware features such as multiple outputs.

• If there is no specific ASIO driver, you could select a generic ASIO driver for the audio hardware.

! Reason Essentials requires that the audio card uses an ASIO driver on Windows systems, if you want to use 
both audio in and audio out. Direct X and MME drivers only support audio out.

Audio Device – Mac OS X

This menu lists all the available Audio Devices on your system, and lets you select which one Reason Essentials 
should use. Which option to select depends on the audio hardware:

• If you are using audio hardware for which there is a specific Core Audio driver, you should select this.
With a Core Audio driver written specifically for the audio hardware you will get lower latency (see below), support 
for higher sampling frequencies (up to 192 kHz in 24 bit/32 bit float resolution), and possibly better support for 
additional hardware features such as multiple outputs.

Sample Rate

Reason Essentials handles all internal audio processing in 32-bit floating point resolution, with 64-bit summing in the 
mix bus in the Main Mixer Master Section. However, the resolution of the input and output audio is determined by the 
hardware audio interface. That is, if you have a 24-bit audio card, Reason Essentials will record and output audio in 
24-bit resolution, and if you have a 20-bit audio card, audio will be recorded and played back in 20-bit resolution.

The Sample Rate can be specified on the Audio tab in the Preferences dialog. See “Sample Rate settings for record-
ing and playback” for more details.

Buffer Size

The Buffer Size determines the Input and Output Latency of the audio. Generally, the smaller the Buffer Size, the 
lower the latency. However, too low a Buffer Size setting could result in clicks, pops, dropouts, etc. in the audio. 
Therefore, the Buffer Size should be set to an “optimal” value rather than to the lowest value. See “Buffer Size set-
tings” for more information.

Input and Output Latency

The Input latency is the delay between when the audio is “sent” from a connected microphone or instrument and 
when it’s received and detected by Reason Essentials. Output latency is the delay between when audio is “sent” from 
Reason Essentials and when you actually hear it. The latencies in an audio system depends on the audio hardware, 
its drivers and their settings.

When you select a driver, its latency values are automatically reported by the audio card and displayed in the Prefer-
ences-Audio dialog. Depending on the audio hardware and the driver, you may be able to adjust these values:

• If you are using an ASIO driver specifically written for the audio hardware under Windows, you can in most 
cases make settings for the hardware by clicking the Control Panel button. 
This opens the hardware’s ASIO Device Control Panel, which may or may not contain parameters for adjusting the 
latency. Usually this is done by changing the number and/or size of the audio buffers - the smaller the audio buf-
fers, the lower the latency. Please consult the documentation of your audio hardware and its ASIO drivers for de-
tails!
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OK, so why not just set the latency to the lowest possible value? The problem is that selecting too low a latency is 
likely to result in playback problems (clicks, pops, dropouts, etc.). There are several technical reasons for this, the 
main one being that with smaller buffers (lower latency), the average strain on the CPU will be higher. This also 
means that the more CPU-intensive your Reason Essentials song (i.e. the more tracks and devices you use), the 
higher the minimum latency required for avoiding playback difficulties.

See “About latency” for more information.

Recording Latency Compensation

If you are monitoring via an external mixer, and have selected “External” in the “Monitoring” section on the “Audio” 
page in Preferences (see “Monitoring”), there might be situations where you experience that the recorded audio is 
generally played back too early - or too late - in the song. This could be because the latency values reported to Rea-
son Essentials by the audio card were not completely accurate.

If you should experience that your audio recordings are played back too early or too late compared to the instrument 
tracks in your song, you can adjust this by editing the Recording Latency Compensation parameter.

See “Recording Latency Compensation” for information.

External Sync Offset

This control should normally only be adjusted when synchronizing Reason Essentials to an external MIDI Clock.

Because of the latency problem, you might need to adjust Reason Essentials’s playback in relation to the sync mas-
ter, so that they are in perfect time. The tempo will not differ between the two, but Reason Essentials might play 
ahead or behind the other application. You might need to adjust this. However, this is something you only need to do 
once. The setting is stored with your other preferences, so you don’t need to adjust it again.

See “Adjusting for Latency” for more information.

Active Input and Output Channels

This displays the number of audio input and output channels the currently selected audio hardware supports. If your 
audio card has multiple inputs and/or outputs, and an audio driver that supports this is selected, the “Channels...” but-
ton will be enabled. Clicking this will bring up a window with check boxes for all available inputs and outputs. By tick-
ing these boxes, you are able to select which input and/or output channels should be active.

Active inputs and outputs will be also indicated with yellow and green LEDs in the Reason Essentials Hardware In-
terface - see “How Reason Essentials communicates with your audio hardware”.
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Clock Source (ASIO Only)

If you are using an ASIO driver for your audio hardware, you have the possibility of selecting a Clock Source. This is 
used for determining the source to which audio playback should synchronize its sample rate. If you have an audio 
card and a driver that supports it, you can choose to synchronize to external sources.

Control Panel

If you have selected an ASIO or Core Audio driver, this button brings up a control panel window specifically for that 
audio hardware. This may contain buffer settings, routing options, synchronization alternatives etc.

Monitoring

In the Monitoring section you can choose how you want monitoring of the input signals to work on audio tracks.

D Select “Automatic” to automatically monitor the input signals on all record enabled audio tracks when record-
ing and when the sequencer is stopped.
Record enabling of audio tracks is done by clicking the Record Enable button on the track in the track list - see 
“Record enabling”.

! Note that if you have selected “Standard” in the “Master Keyboard Input” section on the “Keyboards and Con-
trol Surfaces” page in Preferences (see “The Master Keyboard Input setting”), selecting an audio track also 
automatically record enables it - and consequently enables monitoring in “Automatic” mode.

D Select “Manual” to manually activate monitoring by clicking the Monitor button on the track in the track list.

D Select “External” if you are monitoring directly through your audio interface outputs (and not via the Reason 
Essentials application) - or via an external mixer.
In “External” mode it’s not possible to monitor in Reason Essentials.

Play in Background

When this is activated, Reason Essentials will not “release its grip” on the audio hardware when another application 
is active.

• The advantage is that Reason Essentials will keep playing while you work in the other application.

• The disadvantage is that other audio applications may not be able to play any audio, depending on the type of 
driver used.
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Preferences – Control Surfaces

This is where you set up your MIDI hardware; keyboards and control surfaces. 

D The “Attached Surfaces” list in the middle shows the currently added surfaces/MIDI keyboards.
Selecting a surface in the list allows you to edit its settings or delete it from the list, by clicking the corresponding 
“Edit” or “Delete” button.

D Clicking the “Auto-detect Surfaces” button will scan for connected control surfaces. 
This requires a USB connection or a two-way MIDI connection. Note that not all control surfaces support auto-de-
tection - but you can always add control surfaces manually.

D If you have surfaces added in the “Attached Surfaces” list that you do not wish to use with Reason Essentials, 
you can uncheck the “Use with Reason Essentials” checkbox.
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D The “Use No Master Keyboard” button allows you to disable MIDI note input in the sequencer.
The surface designated as Master Keyboard cannot be locked to a specific device - it always follows the se-
quencer Master Keyboard Input. By selecting the Master Keyboard surface in the Attached Surfaces list and click-
ing this button allows you use Surface locking, although you will not be able to play the device. See “Locking a 
surface” in the Remote chapter for details.

Adding or editing a Control Surface

To add a control surface, click the “Add” button to open the Control Surfaces dialog. If you want to edit the settings 
for an existing control surface, click the “Edit” button. Then proceed as follows:
1. Select the manufacturer of your control surface from the Manufacturer pop-up menu.

If you can’t find it on the menu, see below. 

2. Select the model of your control surface from the Model pop-up menu.
If you can’t find it on the menu, see below.

3. An image of the selected control surface model is shown, often along with some information text - read this 
carefully.
For some control surfaces, you need to select a specific preset to use the surface with Reason Essentials - this is 
noted here.

4. Use the MIDI Input pop-up to select the input port to which you have connected the surface.
If in doubt, you can click the “Find” button and then tweak a control or play a key on the control surface to have 
Reason Essentials find the correct input port for you.

• Some control surfaces may have more than one MIDI Input pop-up menu.
You need to select ports on all MIDI Input pop-up menus.

• Some control surfaces will have a MIDI Output pop-up menu.
In some cases this is labeled “Optional” - then you don’t have to make a selection. In other cases, a MIDI Output is 
required. This is the case if the control surface uses MIDI feedback - motor fader, displays, etc.

5. If you like, you can rename your control surface in the Name field.

6. Click OK to add the surface.

D Depending on the surface model, alerts may appear, reminding you to select a specific preset etc.
In some cases, Reason Essentials can restore a preset in the control surface to factory settings for you. If so, you 
will be informed about this.

Finally you return to the Control Surfaces Preferences page, where your added surface is now listed.



MENU AND DIALOG REFERENCE712

If your control surface model isn’t listed

If you can’t find your control surface listed on the Manufacturer or Model pop-up menus when you try to add it, this 
means that there’s no native support for that model. However, the program supports generic keyboards and control-
lers. Here’s what to do:

D Select “Other” on the Manufacturer pop-up menu and then select one of the three options on the Model pop-
up menu.

or, if the Manufacturer is listed but not your specific model:

D Select one of the three “Other” options on the Model pop-up menu:

In both cases, the options are:

• MIDI Control keyboard
Select this is you have a MIDI keyboard with programmable knobs, buttons or faders. You need to set up your con-
trol surface so that the controllers send the correct MIDI CC messages, depending on which Reason Essentials 
device you want to control - check out the MIDI Implementation Chart in the Reason Essentials documentation. If 
your control surface has templates or presets for different Reason 2.5 devices, these can be used.

• MIDI Control Surface
Select this if you have a MIDI controller with programmable knobs, buttons or faders (but without keyboard). 
Again, you need to set your controllers to send the right MIDI CCs.

• MIDI Keyboard (No Controls)
Select this is you have a MIDI keyboard without programmable knobs, buttons or faders. This is used for playing 
only (including performance controllers such as pitch bend, mod wheel, etc.) - you cannot adjust Reason Essen-
tials device parameters with this type of control surface.

q Under the “Other” Manufacturer, there are also two options called “MIDI Keyboard Multichannel” and “MIDI 
Controller Multichannel”. Use these if the controls on your keyboard/control surface send the same MIDI mes-
sage but on different MIDI channels. Read more in “Adding a control surface or keyboard” in the Remote chap-
ter.

After selecting a model, proceed with selecting MIDI input as described above.

About the Master Keyboard

One of the control surfaces can be the Master Keyboard. This is like any other control surface, but it must have a key-
board and it cannot be locked to a specific Reason Essentials device (in other words, it always follows the MIDI input 
to the sequencer). This is the surface you use to play the instrument devices in Reason Essentials.

D The first surface with a keyboard that is added (or found by auto-detect) is automatically selected to be the 
Master Keyboard.
This is shown in the Attached Surfaces list on the Preferences page.

D If you want to use another surface as Master Keyboard, select it in the list and click the “Make Master Key-
board” button.
There can only be one Master Keyboard.

D If you don’t want to use any Master Keyboard at all, select the current Master Keyboard surface and click the 
same button (which is now labeled “Use No Master Keyboard”).

The Master Keyboard Input setting

This determines how you set Master Keyboard Input in the sequencer: to which track and device the Master Key-
board should be directed (which track to play from your keyboard):

• In “Standard” mode, the selected track automatically gets Master Keyboard Input.
This way you can just click anywhere on a track in the track list to select it for playing (or use the arrow keys to 
step up and down in the track list).
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• In “Separated” mode, you need to click directly on the device icon to the left in the track list to set Master Key-
board Input.
This is useful if you’re working with multiple selections in the track list, or if you want to select different tracks for 
editing without changing which device you play from your keyboard.

• Master Keyboard Input is indicated by a red border around the device icon in the track list.
On instrument tracks, a small keyboard is also shown below the device icon. On other track types, a small control 
surface is shown below the device icon.
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Preferences – Advanced

External Control Bus Inputs

The External Control inputs provide up to 64 MIDI input channels divided into four buses, each with 16 channels.

• These MIDI inputs are for individual control of Reason Essentials Devices from an external sequencer.
This could be an external hardware sequencer or sequencer software that is installed on the same computer as 
Reason Essentials. See the chapter “Synchronization and Advanced MIDI” for more details.

MIDI Clock Sync

Using MIDI Clock, you can slave (synchronize) Reason Essentials to external devices (tape recorders, drum ma-
chines, stand alone sequencers, workstations etc.) and other computer programs running on the same or another 
computer. MIDI Clock is a very fast “metronome” signal which can be transmitted via MIDI. As part of the MIDI Clock 
standard there are also instructions for Start, Stop and locating to sixteenth note positions.

D By first selecting the appropriate MIDI input using the MIDI Clock pop-up and then selecting “MIDI Clock Sync” 
on the Options menu, Reason Essentials is made ready to receive MIDI Clock sync. 
See the “Synchronization and Advanced MIDI” chapter for more information.



MENU AND DIALOG REFERENCE 715

Scratch Disk Folder

Here you can select where you want to locate the Scratch Disk Folder. The Scratch Disk Folder is a temporary stor-
age for recorded audio files before they have been manually saved in a song document file. By default, Reason Es-
sentials places the Scratch Disk folder in the system temp folder in your home directory. You can manually change 
the Scratch Disk folder location if you like. See “Changing Scratch Disk folder location” for more information. 
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Preferences - Keyboard

In this section you can specify what computer keyboard keys should be used for the On-Screen Piano Keys function.

D To change key assignment, click on a key in the window and then press another available key on the computer 
keyboard to assign it.

q Since many keyboard keys are already “locked” to other functions and commands in Reason Essentials, it’s 
not really applicable to reassign all the actual “play” keys. It’s more useful to reassign the Octave and Velocity 
(numeric) keys.

D Click the Reset to Defaults button to revert to the preset keyboard keys assignment.

See the “On-screen Piano Keys” chapter for information on how to use the On-screen Piano Keys.
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Preferences - Language (Windows)

Language (Windows only)

Reason Essentials is localized to several different languages. The language setting affects menus, dialogs, tool tips 
and some display texts, but generally not the texts on the device panels. If you run Reason Essentials under Windows, 
you can select preferred language on this page.

! Note that you need to restart Reason Essentials for a language change to take effect.

! Under Mac OS X, Reason Essentials will use the language selected in the operating system.
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Create menu
Create Audio Track

Select this to create a new audio track in the sequencer, its associated Audio Track Device in the rack with its corre-
sponding channel strip in the Main Mixer. The audio track, device and channel strip will be automatically named “Au-
dio Track n”, where “n” is an incremental number. 

You could then rename the track, device and channel strip afterwards if you like - see “Naming tracks”.

Create Instrument.../Create Effect...

Selecting this will open the Patch Browser, where you can browse for patches, regardless of the device type. De-
pending on which menu item you selected, the browser will be set to show instrument patches or effect patches only.

D Selecting a patch in the browser will automatically create a device of the corresponding type in Reason Essen-
tials, with the selected patch loaded.

Instruments/Effects/Other

D To create a new device, select the desired item from one of the sub-menus. 
Depending on what type of device you create, the result can be different. See “Creating devices” for a complete 
description of what happens when you create different device types.
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Options menu
Internal Sync/MIDI Clock Sync/ReWire Sync

These three options are used to specify which type of tempo synchronization you want to use:

• Internal Sync
When this is activated, the program is not synchronized to any external source. It plays in the tempo set on the 
Transport Panel.

• MIDI Clock Sync
When this is activated, the program is synchronized to external MIDI Clock, as set up in the Preferences dialog. 
The tempo setting on the Transport Panel is of no relevance; Reason Essentials plays in the tempo of the incom-
ing MIDI Clock signals. See “Synchronization and Advanced MIDI” for more details.

• ReWire Sync
When this is activated, Reason Essentials is synchronized to another application via ReWire. This is not a setting 
that you can activate yourself, it is automatically enabled when the program is in ReWire slave mode. See “ReWire” 
for more details.

Enable Keyboard Control

When this is activated, the computer’s keyboard keys can be used to control devices, as set up with the Keyboard 
Control Edit feature. See “Editing Keyboard Control” for more information.

Keyboard Control Edit Mode

D To get an overview of which parameters are keyboard controllable select “Keyboard Control Edit Mode” from 
the Options menu. 
Each device you select will show a yellow arrow symbol next to every parameter that can be assigned.

D If you click on an assignable parameter to select it, you can then select “Edit Keyboard Control Mapping” from 
the Edit menu.
This opens a dialog allowing you to select a key command for that parameter.

You may use any key or a combination of [Shift] + any key.

D Simply press the key (or key combination) you wish to use to remote control the parameter.
The “Key Received” field momentarily indicates that it is “learning” the keystroke(s), and then the dialog displays 
the name of the key you have pressed. If [Shift] was used, the box beside the word Shift in the dialog is ticked. 

You can also double-click on the arrow for an assignable parameter to set up keyboard control:

D A rotating yellow rectangle appears, indicating Learn mode. Press the key (or key combination) you wish to 
use to remote control the parameter.
The rotating stops and the rectangle will now display the key or key combination you used.

! Note that the transport panel uses the numeric keypad for various commands. If you assign a parameter to a 
single numeric key, the corresponding transport functionality will be overridden!

D Another way to assign keyboard control commands is to have “Keyboard Control Edit Mode” deselected on 
the Options menu, and to right-click (Win) or [Ctrl]-click (Mac) the parameter you wish to keyboard control.
This opens a pop-up menu, where one of the options will be “Edit Keyboard Control Mapping”. Selecting this opens 
the Keyboard Control dialog. Thus, you do not have to enable/disable Edit mode from the Options menu if you 
know that a parameter is assignable.

! If you try to assign a key control that is already in use, you will get an alert asking if you wish to change the cur-
rent assignment.

See “Editing Keyboard Control” for more information.
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Remote Override Edit Mode

All supported control surface devices have “standard remote mappings” for each Reason Essentials device. If you 
wish to override this standard mapping, you can do so in the following way:
1. To get an overview of which parameters can be assigned remote overrides, select “Remote Override Edit 

Mode” from the Options menu. 
Each device you select will show a blue arrow symbol beside every parameter that can be assigned a remote over-
ride. Standard mappings are marked with yellow knob symbols (only shown when the device has MIDI input). As-
signed overrides are marked with a lightning bolt symbol.

2. If you click on an assignable parameter to select it (selected parameters are orange in color), you can then se-
lect “Edit Remote Override Mapping...” from the Edit menu.
This opens a dialog where you can assign override mappings.

3. Make sure that the “Learn from Control Surface Input” box is ticked.

4. Simply turn the knob (or slider etc.) that you wish to use to assign Remote Override for the parameter.
The “MIDI Received” field momentarily flickers as you turn the knob, and then the dialog shows the control surface 
device and the control you used. 

You can also make override mappings manually:

D Select a device from the Control Surface pop-up in the dialog, and then select a control from the Control pop-
up.
On the Control pop-up, all the controls on the selected control surface are listed.

5. Click “OK” to exit the dialog.
The selected parameter is now tagged with a lightning bolt symbol, indicating Remote Override mapping.

6. To exit Remote Override Edit mode, deselect it from the Options menu.
You do not always have to use this method - see below.

If Remote Override Edit Mode is enabled on the Options menu, mapped parameters are “tagged”, and the arrow indi-
cators show the assignable parameters. In this mode, however, you cannot operate Reason Essentials normally. Re-
mote Override Edit mode is primarily for overview of available parameters and the current assignments.

D Another way to assign keyboard remote commands is to have “Remote Override Edit Mode” deselected on the 
Options menu, and to simply right-click (Win) or [Ctrl]-click (Mac) the parameter you wish to control.
This opens a pop-up menu, where one of the options will be “Edit MIDI Remote Override Mapping”. Selecting this 
opens the “Edit Remote Override Mapping” dialog. Thus, you do not have to select Edit mode from the Options 
menu if you already know that a parameter is assignable.

See “Remote Override mapping” for more information.

Additional Remote Overrides...

Selecting this opens a dialog with remote functions that cannot be assigned using Remote Override Edit mode, such 
as switching target tracks, Undo/Redo etc.

See “Additional Remote Overrides...” for details.

Surface Locking...

This opens a dialog where you can lock a control surface to a specific device.

This means that the locked device is always “tweakable”, regardless of which track has MIDI input in the sequencer. 
This enables you to play and record notes for one device and at the same time control parameters for another device 
from a control surface. 

For example, you could lock a control surface to control the main mixer, so you can always control overall levels while 
playing/tweaking other devices.
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D The Master Keyboard device cannot be locked!
If you select the Master Keyboard in the Preferences, you can click the “Use No Master Keyboard” button. You can 
then lock this control surface to a device and use its controllers to tweak parameters, but you will not be able to 
play the device.

D Each control surface can be locked to one device at a time (but you can lock several control surfaces to the 
same device).
This locked device will always be controlled by the selected control surface, until you unlock the device or lock the 
surface to another device. You can lock as many devices you wish, as long as you have enough control surfaces.

D Locked devices can use remote overrides, just like unlocked devices.
In other words, even if a device is locked to a control surface, some parameters could be overridden so they are 
controlled by another control surface, or some controls on the locked surface could be override-mapped to an-
other device.

See the “Locking a surface” for more details.

Toggle Rack Front/Rear

This switches the rack view between the front and rear panels. A quicker way to do this is to press [Tab].

Reduce Cable Clutter

If there are many connections in Reason Essentials, the cables can sometimes obscure the view, making it difficult to 
read the text printed on the back panels of the devices. Cables can be displayed in “normal” mode and in “Reduced 
Cable Clutter” mode.

D Select “Reduce Cable Clutter” on the Options menu to “hide” the cables according to the setting you have 
made in the “Appearance” section on the “General” page in Preferences.

See “Cable appearance” for information on how to use this function.

Auto-group Devices and Tracks

A Device Group is a series of interconnected devices that “belong together”. A Device Group could, for example, be 
an instrument device connected via an effect device to a Mix Channel device. With the “Auto-group Devices and 
Tracks” option selected, moving/cutting/copying/duplicating and pasting a device in a device group will perform the 
operation on all devices in the device group.

See “About Device Groups” for more details.

Show Navigators

Selecting “Show Navigators” will show all navigators in the Reason Essentials windows. These include the Mixer Nav-
igator and Channel Strip Navigator in the Main Mixer, the Rack Navigator in the rack as well as the Track Navigator 
and Song Navigator in the sequencer.

Deselecting the “Show Navigators” option will hide all navigators.

Follow Song

When this is activated, the sequencer Arrangement and Edit Panes will automatically scroll along with the song posi-
tion pointer on playback. When this item is deactivated, the Arrangement and Edit Panes will remain stationary.
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Keep Events in Clip while Editing

This function determines how note and automation events behave if they are drawn, moved or pasted outside the 
boundaries of the open clip in Edit mode in the sequencer.

• With “Keep Events in Clip while Editing” selected, events drawn, moved or pasted outside the boundaries of 
the open clip will still belong to the original clip - but will be masked.

• With the “Keep Events in Clip while Editing” deselected, the open clip will expand to contain the drawn, moved 
or pasted events - or, if this is not possible, the events will be placed in an existing, or new, clip.

See “About drawing notes outside an open clip”, “About moving notes outside or between clips” and “Pasting events 
outside an open clip” for detailed examples.

Auto-color Tracks and Channels

When this option is activated, a color will automatically be assigned to a new sequencer track or mixer channel when 
you create it. Any new clips created on a track will get the same color as the track.

Record Automation into Note Clip

With this option activated, any device parameter automation will be automatically recorded into the note clips as “Per-
formance Controllers” instead of on separate Parameter Automation Lanes.

Number of Precount Bars

Here you select the number of pre-count bars to use when the “Pre” button on the Transport Panel is on. When you 
record in the sequencer with the “Pre” button active, the recording will begin after the set number of precount bars.

D Select “One”, “Two”, “Three” or “Four” bars from the sub-menu that appears.

Enter/Exit Edit Mode

This allows you to toggle the sequencer between Arrange Mode and Edit Mode.
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Window menu (Windows version)
Stay on top

When this is activated, the Reason Essentials window will always stay on top of other program’s windows.

View Main Mixer

Selecting this, or pressing [F5], will maximize the Main Mixer area and bring it into view.

View Racks

Selecting this, or pressing [F6], will maximize the Rack area and bring it into view.

View Sequencer

Selecting this, or pressing [F7], will maximize the Sequencer area and bring it into view.

Detach/Attach Main Mixer

Selecting this, or pressing [Ctrl]+[F5], will detach the Main Mixer from the Song document window, and open it in a 
separate window. When the Main Mixer is detached, the menu item text changes from Detach to Attach. Selecting 
this will then reattach the Main Mixer to the Song document window again.

Detach/Attach Rack Window

Selecting this, or pressing [Ctrl]+[F6], will detach the Rack from the Song document window, and open it in a sepa-
rate window. When the Rack is detached, the menu item text changes from Detach to Attach. Selecting this will then 
reattach the Rack to the Song document window.

View All

Selecting this, or pressing [Ctrl]+[F7], will reattach any separate windows to the Song document window and show all 
areas equally sized.

Show/Hide Tool Window

Selecting this, or pressing [F8], will show or hide the floating Tool window. This contains the Device Palette tab (for 
creating new devices), the Sequencer Tools tab (for editing sequencer data), the Groove Settings tab (for fine-tuning 
and saving ReGroove patches) and the Song Samples tab for editing and managing the samples in the song.

Show/Hide On-screen Piano Keys

Selecting this, or pressing [F4], will show or hide the floating On-screen Piano Keys window. See “On-screen Piano 
Keys” for information on how to use the On-screen Piano Keys window.

Show/Hide Recording Meter

Selecting this, or pressing [F3], will show or hide the floating Recording Meter Window. See “The Recording Meter 
Window” for more information.
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Open Song Windows list

This lists all open song document windows. Selecting one makes it the active window. If songs have detached areas 
in separate windows, these will be included as separate items in the Open Documents list. The currently active win-
dow is indicated with a tick to the left of the window name:

In the picture above, the “AllAnalog.ree (Mixer)” window is the currently active window, and consequently the 
“AllAnalog.ree” song is the currently active song. The Mixer and Rack areas of this song are currently detached in 
separate windows. The asterisks (*) to the right of some of the windows show that the song currently contains un-
saved edits.
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Window menu (Mac OS X version)
Minimize

This minimizes the selected song document window.

Zoom

This toggles the selected window between the default and the user defined size and position, according to the Apple 
guidelines. For detached Mixer and rack windows, the default state equals maximized across the screen.

Bring All to Front

This will bring all open Reason Essentials windows in front of any other open application’s window(s).

View Main Mixer

Selecting this, or pressing [F5], will maximize the Main Mixer area and bring it into view.

View Racks

Selecting this, or pressing [F6], will maximize the Rack area and bring it into view.

View Sequencer

Selecting this, or pressing [F7], will maximize the Sequencer area and bring it into view.

Detach/Attach Main Mixer

Selecting this, or pressing [Cmd]+[F5], will detach the Main Mixer from the Song document window, and open it in a 
separate window. When the Main Mixer is detached, the menu item text changes from Detach to Attach. Selecting 
this will then reattach the Main Mixer to the Song document window again.

Detach/Attach Rack Window

Selecting this, or pressing [Cmd]+[F6], will detach the Rack from the Song document window, and open it in a sepa-
rate window. When the Rack is detached, the menu item text changes from Detach to Attach. Selecting this will then 
reattach the Rack to the Song document window.

View All

Selecting this, or pressing [Cmd]+[F7], will reattach any separate windows to the Song document window and show 
all areas equally sized.

Show/Hide Tool Window

Selecting this, or pressing [F8], will show or hide the floating Tool window. This contains the Device Palette tab (for 
creating new devices), the Sequencer Tools tab (for editing sequencer data), the Groove Settings tab (for fine-tuning 
and saving ReGroove patches) and the Song Samples tab for editing and managing the samples in the song.
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Show/Hide On-screen Piano Keys

Selecting this, or pressing [F4] will show or hide the floating On-screen Piano Keys window. See “On-screen Piano 
Keys” for information on how to use the On-screen Piano Keys window.

Show/Hide Recording Meter

Selecting this, or pressing [F3], will show or hide the floating Recording Meter Window. See “The Recording Meter 
Window” for more information.

Open Song Windows list

This lists all open song document windows. Selecting one makes it the active window. If songs have detached areas 
in separate windows, these will be included as separate items in the Open Documents list. The currently active win-
dow is indicated with a tick to the left of the window name:

In the picture above, the “untitled 3” window is the currently active window, and consequently also the currently active 
song. The Mixer and Rack areas of this song are currently detached in separate windows and Minimized, as indicated 
by the symbols to the left. The round dots to the left of some of the windows show that the song currently contains 
unsaved edits.
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Help menu
Reason Essentials Help...

This menu item opens up the on-line Help system. The Help system opens up in the Propellerhead Help Viewer ap-
plication, which is a custom html viewer. The Reason Essentials Help contains detailed information about all functions 
in Reason Essentials. You can choose to browse for information, either from the Table of Contents (TOC), Index or 
Search tabs in the Help system.

Tutorials on the Propellerhead Webpage...

Selecting this item will open up your default web browser and direct you the Reason Essentials Video Tutorials page 
on the Propellerhead web site.

Download more Demo Songs...

This takes you to our archives of song files that you can download and use.

Download more Template Songs...

This takes you to our archives of song files that you can download and use.

Go to the Propellerhead Website...

This takes you to the main entrance on the Propellerheads web site.

Check for Updates...

This will take you to a page where you can check for recent updates.

Manage Authorizations (Windows only)

This menu item brings up the Authorizer Helper Application. Clicking the “Launch Browser” button will launch your 
default web browser and bring you to the Propellerhead account web page. From this web page, you can log in and 
manage your Authorizations.

Get more Line 6 Amps...

This item takes you to the Line 6 web site where you can purchase and download more Amp Tones to the Line 6 
Amp devices in Reason Essentials.

About Reason Essentials (Windows only)

This menu item opens up a dialog that informs you about the version of the program and the people behind it.
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A
Active Input Channels (in Preferences) 708
Active Output Channels (in Preferences) 708
Add Labels To Clips 166, 701
Additional Remote Overrides... 431

Assigning 432
Adjust Alien Clips to Lane 164, 701
ADSR 512
Advanced MIDI (Hardware Interface) 445
Advanced MIDI Device (Hardware Interface) 458
Alien Clips 164
Alt

On Audio Tracks 131
On Instrument Tracks 142

Alt Button (Transport Panel) 111
Alt Group (Dr. Octo Rex) 585
Alter

Pattern (Redrum) 610
Alter Notes (Tool Window function) 230
Alter Pattern (Matrix) 677
Alternate Tools 106
Anchor Point (ReGroove Mixer) 402
Appearance (Cables) 303
ASIO Control Panel 449
Assigned Samples 391
Attach Main Mixer

Mac OS X Version 725
Windows Version 723

Attach Rack Window
Mac OS X Version 725
Windows Version 723

Audio
Formats 364
Importing to Sample-based Devices 366
Importing to Sequencer Track 365

Audio Clipping 65

Audio Clips
Adding Crossfades 196
Adding Cuts 195
Adding Segments 196
Bounce Clip(s) to New Recording(s) 199
Bounce Clip(s) to New Sample 191
Changing Comp Row Assignments 198
Closing 178
Comping 200
Deleting Cuts 197
Editing Fades 155, 156
Editing Levels 155, 156
Importing Audio to... 366
Joining 169
Matching to Tempo 204
Moving Cuts 197
Moving Single Notes/Drum Hits 205
Normalising 192
Opening 177
Reversing 193
Scale to Tempo 193

Audio Hardware 60
Audio In (to Application) 60
Audio Input List (Audio Tracks) 95
Audio Levels 65
Audio Out (from Application) 60
Audio Quality 61
Audio Settings 62
Audio Track Channel Strip 313
Audio Track Device 313
Audio Tracks

Creating 86
Monitoring 125
Mono or Stereo 86, 123
Record Enabling 117
Recording 128

From Mix Channels 133
In Loop Mode 130
Mixdown 135
Over Existing Clips 132

Recovering 360
Selecting Audio Inputs 123
Setting Input Levels 124
Setting Up 123

Auditioning
Patches (in Browser) 291
Samples (in Browser) 291

Auto-color Tracks and Channels 722
Auto-group Devices and Tracks 264, 265, 268
Automap Zones 552, 694
Automap Zones Chromatically 694
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Automation
Deleting Events 247
Drawing Events 246
Editing 243
Editing in Arrange Mode 243
Editing in Edit Mode 245
Matching 259
Showing in Device Panels 704
Tempo 253
Time Signature 254

Deleting Clips 256
Moving, Resizing and Duplicating Clips 255

Automation As Perf Ctrl 145
Automation Cleanup

About 249
In Preferences 249
Tool Window function 249

Automation Cleanup Level 703
Automation Clips

Opening 214
Automation Override Reset 148
Auto-route Device 307
Auto-routing 305

Audio Input Signals 305
CV/Gate Signals 307
Effect Devices 306
Instrument Devices 306

B
Back Panel (Rack) 308
Bars

Inserting (in the Sequencer) 173
Removing (in the Sequencer) 173, 174

BELL mode (EQ in the Main Mixer) 322
Big Waveform Zoom Mode 39
Bipolar Curves (Matrix) 674
Bounce

Audio Clips 371
Mixer Channels 369

Bounce Clip to Disk 371
Bounce Clip(s) to New Recording(s) (Audio Clips) 199
Bounce Clip(s) to New Sample (Audio Clips) 191
Bring All to Front (Mac OS X) 725
Browse Loops 691
Browse Patches 690
Browse Samples 691
Browser

About 281
Favorites Lists 288
Locations and Favorites 288
Search 294

Buffer Size
Settings 63
Slider 449

Bypass/On/Off Switch (on Effect Devices) 656
C
Cables

Appearance 303
Automatic Routing 305
Checking Connections 304
Color 305
Connecting by Dragging 309
Connecting using Pop-up Menus 309
Deactivating Animation 704
Disconnecting 310
Hiding and Showing 303
Manual Routing 308
Scroll to Connected Device 304

Calc Indicator 254, 364, 368
CF-101 Chorus/Flanger 659
Channel 8 & 9 Exclusive 615
Channel Strips

Sort Selected Device Groups 270
Chorus 659
Clear All Keyboard Remote 702
Clear Insert FX 334
Clear Keyboard Control Mapping 702
Click

Button 109
Level 109, 121

Click and Pre-count 120
Clip Color 166, 701
Clip Level Handle (Audio Clips) 180
Clip Overview

Audio Clips 179
Note Clips 216

Clip Safe (with Propellerhead Balance Interface) 124
Clipping (Audio) 65
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Clips
About Overlapping... 165
Adjust Alien Clips to Lane 164
Alien 164
Coloring 166
Creating 220
Cropping 700
Cut, Copy and Paste 165
Deleting 157
Duplicating 165
Duplicating Parts of Clips 168
Joining 168, 700
Length Display (Inspector) 155
Level and Fades in Audio Clips 156
Masking Recordings or Events in... 159
Match Values 171
Moving 163
Muting 170, 700
Naming 166, 701
Nudging 163
Position Display (Inspector) 155
Remove Label from... 166
Renaming 166
Repeating 166
Resizing 158
Scaling Tempo 161
Selecting 154

Multiple 155
Selecting with the Arrow Keys 156
Splitting 167

Clock Source (Preferences - Audio) 709
Close (Songs) 353, 683
Combi Patches 462
Combinator

Adding Devices 467
Bypass All FX 471
Combining Devices 463
Creating 463
Creating by Browsing Patches 463
Creating New Devices 467
External Routing 465
Insertion Line 467
Internal CV Connections 479
Key Mapping 474
Receive Notes 475
Run Pattern Devices 471
Select Backdrop 472
Setting Velocity Ranges for Devices 475
Uncombining Devices 470
Using Modulation Routing 476
Using the Programmer 473

Commit to Groove 413, 699

Comp Mode (Audio Clips) 179, 180
Comp Row 180, 181

Adjusting Level 189
Adjusting Recording Offset 190
Cut, Copy and Paste 189
Deleting 187
Duplicating 188
Level Matching 210
Moving 188
Playing Back in Single Mode 186
Selecting in Comp Mode 187

Comp Row Handle (Audio Clips) 180
Comp Row Level Fader (Audio Clips) 180
Compatible EQ (Mixer 14-2) 484
Comping Audio 200
Context Menus 46

For Channels Strips 48
For Devices 47
For Parameters 46
For the Main Mixer 49
For the Rack 49
For the Sequencer 49

Control Panel (Preferences - Audio) 709
Control Surfaces

Adding and setting up 710
Convert Pattern Automation to Notes 253

Matrix 678
Redrum 611

Copy Channel Settings 319
Copy Devices and Tracks 271
Copy Loop to Track 695
Copy Loop To Track (Dr. Octo Rex) 581
Copy Parameters to Selected Zones 693
Copy Patch 279
Copy Pattern 671
Copy Pattern to Track 696

Matrix 678
Redrum 611

Copy Zones 542
CPU Usage Limit 63, 705
Create Audio Track 86
Create Audio Track (Create Menu Item) 718
Create Effect 293
Create Effect... (Create Menu Item) 718
Create Instrument 293
Create Instrument... (Create Menu Item) 718
Create Menu 718
Create Send FX 335
Create Track for... 697
Create Velocity Crossfades 695
Crop (Edit Sample Window) 386
Crop Events to Clips 161, 700



INDEX 733

Cross-browsing
Patches 292
Samples and REX files 293

Crossfade Loop 390
Crossfades (Audio Clips) 203

Adding 196
Matching 210

CS 124
Curve (Matrix) 674

About 668
Cut Crossfade Zones (Audio Clips) 181
Cut Devices and Tracks 271
Cut Handles (Audio Clips) 181
Cut Lines (Audio Clips) 181
Cut Pattern 671
Cut Row (Audio Clips) 181
Cut Tool (Audio Clips) 104, 185
Cuts

Adding (Audio Clips) 195
Deleting (Audio Clips) 197
Moving (Audio Clips) 197

CV
About 302
Merging 663
Routing 310
Splitting 666
Trim Knobs 310
vs. Gate 674

D
DDL-1 Delay Line 658
Decay/Gate Switch 613
Default Song 354, 704
Delay 658
Delete Track for... 697
Delete Unused Recordings (Audio Clips) 190
Demo Mode 23
Demo Songs

Opening 352
Detach Main Mixer

Mac OS X Version 725
Windows Version 723

Detach Rack Window
Mac OS X Version 725
Windows Version 723

Device Groups
About 263
Cut, Copy and Paste 271
Duplicating 271
Sort Selected Device Groups 270

Devices
Creating 265
Cut, Copy and Paste 271
Deleting 268
Deleting with their Tracks 90
Device Groups 263
Disconnecting 310
Duplicating 271
Duplicating and Copying with their Tracks 91
Folding/Unfolding 41, 273
Moving to a New Rack Column 270
Naming 272
Re-ordering in the Rack 268
Routing 305
Selecting 267
Sort Selected Device Groups 270

Direct Out (on Mix Channel and Audio Track Devices) 
344
Disable Stretch (Audio Clips) 254
Disconnect

Cables 310
Device 307, 310

Distortion
Scream 4 648

Dither (Audio Export) 367, 371
Download ReFill 298
Dr. Octo Rex

About 576
Adding REX Loops 579
Copy Loop To Track 581
Editing Slices 584
Panel Parameters 590
Playing from Sequencer 581
Playing REX Loop Slices 580
Playing REX Loops 578

Drum Edit Mode (Note Clips) 219
Dub

On Instrument Tracks 141
Dub Button (Transport Panel) 111
Duplicate Devices and Tracks 271, 688
Dynamics 607
E
Edit Focus 325
Edit Menu 687
Edit Mode

For Audio Clips 176
For Automation Clips 212
For Note Clips 212

Edit Remote Override Mapping 428
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Editing
Buttons 41
Buttons (Multi Mode) 42
Display Values 42, 43, 44
Faders and Sliders 40
Knobs 40

Effect Combi Patches 332
Effects

Creating 293
Recording with... 345

Empty (Default Song) 704
Enable Keyboard Control (Remote) 433
Enable Loop Playback (Dr. Octo Rex) 589
Enable Pattern Section 611
Enable Pattern Section (Redrum) 609
Enter Edit Mode 722
Envelopes 512
EQ

Main Mixer 322
Mixer 14-2 483
RV7000 Advanced Reverb 644

Eraser Tool 104
Exit (Windows) 686
Exit Edit Mode 722
Explode 239
Export Insert FX patch 685
Export Loop as Audio File 367
Export MIDI File 361, 685
Export REX as MIDI File 686
Export Song as Audio File 367
Ext Mod (Subtractor) 520
External Sync Offset 443, 450
F
Factory Sound Bank 280
Fade Handles (Audio Clips) 180
Fade In/Out (Edit Sample Window) 387
Fade In/Out Displays (Audio Clips) 155
Fade In/Out Handles (Audio Clips) 156
Fast Forward Button (Transport Panel) 110
Favorite Lists (Browser) 288
File Formats 299
Filter

Dr. OctoRex 592
NN-XT 566
Subtractor 507

Flam (Redrum) 608
Flanger 659
FM 505
Folding/Unfolding Device Panels 41
Follow Song 721

G
Gain Knob (Main Mixer) 322
Gate

About 302
Programming in Matrix 673
Routing 310
vs. CV 674

Gate (Matrix) 668
Gate (RV7000 Advanced Reverb) 645
Gate mode (Redrum) 613
Get Groove From Clip 700
Global Shuffle 402
Go To Left/Right Locator (Transport Panel) 112
Go To Track for... 697
Groove

Assigning to Note Lanes 410
Committing to 699
Creating from Clips 414
Extracting 700
Factory Patches 416
Making Permanent 413
Mixer Parameters 401
Settings in Tool Window 407

Group Selected Zones 693
Groups

NN-XT 542
H
Hardware Device 60
Hardware Interface 456
Help 727
Help Menu 727
Hide All Cables 304
Hide Auto-Routed Cables 304
Hide On-screen Piano Keys

Mac OS X Version 726
Windows Version 723

Hide Recording Meter
Mac OS X Version 726
Windows Version 723

Hide Tool Window
Mac OS X Version 725
Windows Version 723

High Quality Interpolation
NN-XT 529
Redrum 616

Host Application (ReWire) 437
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I
ID8 Instrument Device 494

Controlling Sounds 496
Selecting Sounds 495

Ignition Key
Authorizing 20

Ignition Key hardware
Running Reason Essentials with... 22

Import Audio File... 365
Import MIDI File 360
Improved EQ (Mixer 14-2) 484
Init patch

Redrum 603
Subtractor 498

Initialize Patch 280, 690
Input Focus Button (Hardware Interface) 445
Input Level

Setting for Audio Track 124
Input Meter (Audio Tracks) 95
Input Meter (Effect Devices) 656
Insert Bars Between Locators 173, 697
Insert FX

Adding 331
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